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Note
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IBM FileNet Business Process Manager (product number 5724-R76), and to all subsequent releases and
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modifications until otherwise indicated in new editions.
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About this document

This document provides installation and upgrade information about IBM FileNet P8 Platform, 
which includes Application Engine (AE), Content Engine (CE), and Process Engine (PE). 

NOTE Installations that use Workplace XT as the web-based client instead of AE must refer to the   
IBM FileNet Workplace XT Installation and Upgrade Guide for Workplace XT information when 
topics in this document are about AE.

Topics in this document apply specifically to FileNet P8 Platform installation tasks. Information 
about preparing the FileNet P8 Platform environment before you start these installation tasks is in 
the Plan and Prepare Your Environment for IBM FileNet P8 document. 

To download these documents from the IBM FileNet support Web site, see “Access IBM FileNet 
documentation, compatibility matrices, and fix packs” on page 20.

Intended audience
This document is intended for software professionals who will install the FileNet P8 applications. 
Installation by an IBM FileNet Certified Professional (FCP) is recommended. For more information 
about the FCP program, contact your IBM service representative.
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Typographical conventions
This document uses the following typographical conventions:

Convention Usage Example

Bold Platform-specific headings Start the application server.

WebSphere®

Refer to IBM WebSphere documentation for 
more information.

WebLogic

Refer to BEA WebLogic documentation for 
more information.

Gray bold Clickable items, such buttons, 
and tabs.

Click OK.

Menu paths or breadcrumb 
trails.

Select Start > Settings > Control Panels > 
Display > Screen Saver. 

Italics Variables that require user-
supplied values

The calculation is: number of object stores * 
16 + number of concurrent users.

Document titles You are reading the IBM FileNet P8 Platform 
Installation and Upgrade Guide.

Monospace Text that has to be typed by 
the user 

Copy the file by entering the following 
command:

COPY filename

Code samples Find the following text in the web.xml file:

<context-param><param-name>uploadDir</
param-name><param-value>/opt/FileNet/AE/
Upload1</param-value> </context-param>

Display text, such as prompts 
and error messages

Are you sure you want to delete this 
object?
You do not have permission to delete this 
object.

Elements such as filenames, 
properties, classes and so on, 
whose meaning might get 
confused in regular text. 

Open the filed file.

Enter a value for the new property.

Select the senior class.
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Acronyms
This document uses the following IBM FileNet product names and acronyms. 

“Text with 
quotation 
marks”

User-interface fields that do 
not use initial capitalization 
and document headings 
referenced within a document

See the “Part number” field for the part 
number.

For more information, see “Typographical 
conventions” on page 14. 

UPPERCASE Case-sensitive text, where 
uppercase text is required.

Copy the file by entering the following 
command:

COPY filename

Product Name Acronyms

Application Engine AE

Content Engine CE

Content Search Engine CSE

Enterprise Manager EM

Global Configuration Data GCD

Image Services Resource Adapter ISRA

Process Engine PE

Rendition Engine RE

Convention Usage Example
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About IBM FileNet documentation
By default, this document is distributed as part of the IBM FileNet P8 help system, but it is also 
available as a downloadable document from the IBM support Web site. Newer versions of IBM 
FileNet P8 documentation are sometimes re-released with other events, such as fix pack releases 
or documentation refreshes. To ensure that you have the latest revision of a document, compare 
the document part number of your document to the document part number of the document that is 
posted on the support Web site: 

www.ibm.com/support/docview.wss?rs=3278&uid=swg27010422

For example, the last two digits of “GC31-5585-05” indicate that the specified document has been 
revised five times after the original publishing, which is designated by 00.

Copy Web documents into the help system and make them searchable 
The IBM FileNet P8 help system is designed so that you can download updated copies of this 
document and copies of other IBM FileNet documents into the IBM FileNet P8 help system and 
index them so that they can be retrieved by a search in the help system. However, to search the 
IBM FileNet P8 help system, it must be installed as a Web site on a Web server that supports 
Java™ applications. 

For more information, see:

• “Other available documentation” on page 18

• “Install IBM FileNet P8 Platform documentation” on page 22

• “Update documentation search index” on page 26

Links to additional information
To help you locate additional information about a topic, this document includes links to:

• Other locations in this document

• External Web sites 

• Topics in the FileNet P8 help system

Because this document is included in the default FileNet P8 help system, the links to the FileNet 
P8 help topics work only when you view this document from within the help system. If you view 
this document from outside of the help system, the links to FileNet P8 help topics do not work.
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Gather reference documentation
Following are two tables with information about the IBM FileNet P8 documents that are available 
as part of the FileNet P8 release. To download these documents from the IBM FileNet support 
Web site, see “Access IBM FileNet documentation, compatibility matrices, and fix packs” on page 20. 

Installation reference documents
Consider having one or more of the following documents (or help topics) nearby for reference 
purposes during the installation of IBM FileNet P8 Platform. 

Document or help topic name... Refer to this document...

Plan and Prepare Your Environment for 
IBM FileNet P8

To confirm the target environment is ready for a 
FileNet P8 installation or upgrade. 

IBM FileNet Workplace XT Installation 
and Upgrade Guide

For information about how to install and upgrade 
Workplace XT in a FileNet P8 environment.

IBM FileNet P8 Hardware and Software 
Requirements

To confirm that the target environment has at least 
the minimum supported levels of software from 
independent software providers.

IBM FileNet P8 Compatibility Matrix To confirm that the version of FileNet P8 to be 
installed is compatible with at least the minimum 
supported levels of other FileNet products that are 
or will be used with FileNet P8.

IBM FileNet P8 Release Notes To familiarize yourself with the new features and 
known issues associated with the FileNet P8 
release.

IBM FileNet P8 Non-English Support 
Guide

For information about how FileNet P8 supports non-
English environments.

IBM FileNet P8 High Availability 
Technical Notice

For information about how to set up FileNet P8 
using clusters, farms and other high-availability 
software and hardware.

IBM FileNet P8 Performance Tuning 
Guide

For critical tuning information required to make 
deployments of all sizes and levels of complexity 
work efficiently before going into production. 

Attention This guide provides many specific 
recommendations for making performance-related 
choices that are either difficult or impossible to 
change once the system goes into production.

IBM FileNet P8 Troubleshooting Guide For troubleshooting tips associated with a FileNet 
P8 Installation. 
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Other available documentation
Review the list of remaining FileNet P8 documents that you can download from the FileNet 
support Web site.   

IBM FileNet P8 help topic: 
Administration > Enterprise-wide 
Administration > FileNet P8 Security > 
Users and Groups

For a complete list of the user and group roles, 
accounts, and responsibilities required to install, 
configure, and maintain a FileNet P8 system.

IBM FileNet P8 help topic: 
Administration > Enterprise-wide 
Administration > Shutdown and Startup

For information about how to shut down and start 
up FileNet P8 and any expansion products. 

Document name Refer to this document...

IBM FileNet P8 System Overview For a technical summary of the FileNet P8 
architecture, including a overview of features and 
capabilities.

IBM FileNet P8 Disaster Recovery 
Technical Notice

For information about potential options and solutions 
involved in a FileNet P8 disaster recovery plan.   

IBM FileNet P8 Process Task Manager 
Advanced Usage Technical Notice

For information about properties found under the 
Advanced tab in Process Task Manager.

IBM FileNet P8 Version Tools 
Technical Notice

For information about the set of versions tools that are 
installed with FileNet P8 Platform and that identify the 
levels of Application Engine, Content Engine, and 
Process Engine in a FileNet P8 environment.

IBM FileNet P8 Security Help Extract For security-related information from the FileNet P8 
help system in PDF format. 

IBM FileNet Rendition Engine 
Installation and Upgrade document

For information about how to install and upgrade 
Rendition Engine in a FileNet P8 environment. 

IBM FileNet P8 eForms Installation 
and Upgrade Guide

For information about how to install and upgrade 
eForms in a FileNet P8 environment.

IBM FileNet Connector for SharePoint 
Web Parts Installation and Upgrade 
Guide

For information about how to install and upgrade IBM 
FileNet Connector for SharePoint Web Parts in a 
FileNet P8 environment.

IBM FileNet Connector for SharePoint 
Document Libraries Installation and 
Upgrade Guide

For information about how to install and upgrade IBM 
FileNet Connector for SharePoint Document Libraries 
in a FileNet P8 environment.

Document or help topic name... Refer to this document...
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IBM FileNet P8 Portlets for 
WebSphere Installation and Upgrade 
Guide

For information about how to install and upgrade 
FileNet P8 Portlets for WebSphere in a FileNet P8 
environment.

IBM FileNet Process Analyzer 
Installation and Upgrade Guide

For information about how to install and upgrade 
Process Analyzer in a FileNet P8 environment.

IBM FileNet Process Simulator 
Installation and Upgrade Guide

For information about how to install and upgrade 
Process Simulator in a FileNet P8 environment.

IBM FileNet Records Manager 
Installation and Upgrade Guide

For information about how to install and upgrade 
Records Manager in a FileNet P8 environment.

IBM FileNet Business Activity Monitor 
Installation and Configuration Guide

For information about how to install and configure 
Business Activity Monitor in a FileNet P8 environment.

IBM FileNet Content Federation 
Services Installation and Upgrade 
Guide

For information about how to install and upgrade 
Content Federation Services in a FileNet P8 
environment.

IBM FileNet Content Federation 
Services for Image Services Planning 
and Configuration Guide

For information about how to configure Image 
Services for document federation. 

IBM FileNet Content Federation 
Services for Content Manager 
OnDemand Planning and 
Configuration Guide

For information about how to configure Content 
Manager for OnDemand for document federation. 

IBM FileNet Content Management 
Widgets Installation Guide

For information about how to install Content 
Management Widgets in a FileNet P8 environment.

Document name Refer to this document...
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Autonomy K2 software documentation for configuring the FileNet P8 Content 
Search Engine
Autonomy (formerly Verity) K2 software, which underlies the optional CSE component, installs 
with a large body of documentation that is not included in the general FileNet P8 documentation. 

For details on how to access this documentation, see the "Configure Content Engine for Content-
Based Retrieval" topic in the IBM FileNet P8 Platform Installation and Upgrade Guide.

Access IBM FileNet documentation, compatibility matrices, and fix 
packs
To access documentation, compatibility matrices, and fix packs for IBM FileNet products: 

1. Navigate to the Product Documentation for FileNet P8 Platform support page.
(http://www.ibm.com/support/docview.wss?rs=3247&uid=swg27010422).

2. Select a PDF or a Doc Link, whichever is appropriate.

Customer support
For information about contacting customer support: 

1. Navigate to the FileNet Product Family support page: 
(http://www-01.ibm.com/software/data/content-management/filenet-product-family/support.html). 

2. Click IBM FileNet Support Communications, or search for a particular support topic under 
“Enter search terms”. 

Feedback
Your feedback helps us to provide quality information. Send your comments about this publication 
or any other IBM FileNet documentation by e-mail to comments@us.ibm.com. Be sure to include 
the name of the product, the version number of the product, and the name and part number of the 
book (if applicable). If you are commenting on specific text, include the location of the text (for 
example, a chapter and section title, a table number, a page number, or a help topic title).
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Install and configure IBM FileNet P8 Platform

This section contains the following tasks:

• “Install IBM FileNet P8 Platform documentation” on page 22

• “Install and configure Content Engine” on page 29

• “Install and configure Content Search Engine” on page 142

• “Install and configure Process Engine” on page 171

• “Install and configure Application Engine” on page 206

• “Configuration and startup tasks” on page 253

• “Optional installation tasks” on page 272
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Install IBM FileNet P8 Platform documentation
Do the tasks in this section to install the IBM FileNet P8 documentation. See the following topics 
and tasks:

• “Installation considerations” on page 23

• “Overview of Procedures” on page 24

• “Install the core IBM FileNet P8 Platform documentation” on page 24

• “Install expansion-products, custom, and auxiliary documentation” on page 25

• “Update documentation search index” on page 26

• “Complete and verify the documentation installation” on page 28
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Task 1: Install IBM FileNet P8 Platform documentation 
(All)
This task covers the installation and, if necessary, search-related indexing of your IBM FileNet P8 
Platform documentation.

Installation considerations
Install the documentation for IBM FileNet P8 Platform and its expansion products on a supported 
web application server (for example, WebSphere, WebLogic, or JBoss). This will enable you to

• Access online help from within any IBM FileNet P8 applications (for example, Workplace, 
Enterprise Manager, and Process Task Manager).

• Use the full-text search feature.

Optionally, you can also install and index auxiliary documentation that is available solely on the 
IBM Web site (for example, the IBM FileNet P8 Release Notes). Installing and indexing makes the 
auxiliary documentation easier to access and includes it in the IBM FileNet P8 Platform 
documentation search functionality. For a complete list of such documentation, see "Gather 
auxiliary documentation" in the Plan and Prepare Your Environment for IBM FileNet P8 guide.

NOTES 

For all Web Servers

• You can collocate the IBM FileNet P8 documentation on an application server with either 
Application Engine or Content Engine server components installed.

• To ensure proper documentation search functionality, make sure that JavaScript support is 
enabled on each user browser client. 

• Depending on your operating system and application server levels, your options might be 
slightly different from the options documented in the provided examples.

• Re-index the IBM FileNet P8 documentation any time you install (or reinstall) the core IBM 
FileNet P8 Platform documentation AND add on any expansion products or auxiliary 
documentation. 

• You can use multipart root directories (for example, /docs/ecm_help) if your application 
server supports them.

• You can download a refresh of the documentation from the IBM Information Management support 
page on www.ibm.com.

For WebSphere

• IBM FileNet P8 documentation must be installed as a WAR file (ecm_help.war). You cannot 
install as an EAR file because the internal documentation search engine might not function as 
expected.
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For WebLogic and JBoss

• You cannot install the IBM FileNet P8 help files as WAR or EAR files because the internal 
documentation search engine might not function as expected.

• A valid Java SDK must be available for the WebLogic and JBoss application servers.

• Unpack the ecm_help.war file or use the ecm_help flat file structure to install the IBM FileNet 
P8 documentation.

Overview of Procedures
Perform the following steps in order unless otherwise directed:

• “Install the core IBM FileNet P8 Platform documentation” on page 24 -- Begin here if you are 
installing the IBM FileNet P8 Platform documentation for the first time, or reinstalling the IBM 
FileNet P8 Platform documentation. 

• “Install expansion-products, custom, and auxiliary documentation” on page 25 -- Begin here if you 
have already installed the core IBM FileNet P8 Platform documentation and need to add on 
the documentation for IBM FileNet expansion products (for example, Process Analyzer, 
Process Simulator, IBM FileNet P8 eForms, Content Federation Services, or IBM FileNet 
Records Manager). Optionally, you could also add auxiliary documentation that you 
downloaded from the IBM support site, or documentation that you customized.

• “Update documentation search index” on page 26 -- Perform this procedure only after you have 
installed documentation for all of your expansion products. If you install the core IBM FileNet 
P8 Platform documentation only, which has a pre-configured search index, you can skip this 
procedure. This section also provides information about planning for disaster recovery of the 
installed IBM FileNet P8 Platform documentation. 

• “Complete and verify the documentation installation” on page 28 -- After you have installed the core 
IBM FileNet P8 Platform documentation, added on documentation for your expansion 
products, and regenerated the search index, use this procedure to verify the installation.

Install the core IBM FileNet P8 Platform documentation
This procedure establishes the core web application for documentation associated with the IBM 
FileNet P8 Platform. It assumes that your application server is already installed and operational.

To install the core IBM FileNet P8 Platform documentation

1. Access the IBM FileNet P8 Platform Documentation installation software and perform the 
following actions, depending on your application server type:

WebSphere

a. Copy the IBM FileNet P8 ecm_help.war file from the IBM FileNet P8 documentation 
package to the local hard disk drive.

b. From the administrative console, select Applications > Install a New Application. 

c. Enter the Local Path location or Browse to the ecm_help.war file. 
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d. Enter a Context Root, then click Next and follow all WebSphere installation screens. 

NOTE The Context Root (for example, ecm_help) and installation directory can be user-
defined. Substitute your actual values when prompted if you do not want to take the 
WebSphere default values.

e. Save your changes to the WebSphere Master Configuration.

WebLogic

a. Unpack the IBM FileNet P8 ecm_help.war file or copy the entire ecm_help directory 
structure from the IBM FileNet P8 documentation package to the local hard disk drive.

b. From the WebLogic administrative console, install a new web application for the IBM FileNet 
P8 Platform documentation.

JBoss

a. From the IBM FileNet P8 documentation package, perform one of the following actions to 
create a deployable ecm_help.war directory on the JBoss application server:

– Unpack the ecm_help.war file to the ecm_help.war directory.

OR

– Copy the ecm_help directory to the JBoss application server and rename it 
ecm_help.war.

2. Continue as follows:

• To add documentation for any IBM FileNet P8 expansion product or any auxiliary documentation, 
continue with “Install expansion-products, custom, and auxiliary documentation” on page 25.

• If you have no further documentation to install, continue with “Complete and verify the 
documentation installation” on page 28.

Install expansion-products, custom, and auxiliary documentation
Use the procedure in this topic to install documentation for expansion products, such as FileNet 
P8 eForms and FileNet Content Federation Services, onto an existing IBM FileNet P8 Platform 
documentation server. You can also install documentation you have customized.

Optionally, you can install auxiliary documentation that is available solely on the IBM 
(www.ibm.com) Web site. For example, the Web site provides the IBM FileNet P8 Release Notes, 
the IBM FileNet P8 Troubleshooting Guide, and others. 

If you do not have additional documentation to add on, skip to the procedure “Complete and verify 
the documentation installation” on page 28.

To install expansion product documentation

1. Determine the expansion product documentation location, either on local media source or 
network location. For most expansion products, use the Documentation package included as 
part of the particular software product.
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2. Stop the IBM FileNet P8 Platform ecm_help documentation application. For WebLogic and 
WebSphere Application Server, use the administrative console. For JBoss, shut down the JBoss 
application server. Verify that no processes are accessing the documentation web application. 

3. For all web application servers: Copy all directories and files below the expansion product 
ecm_help directory to the core IBM FileNet P8 Platform documentation location (ecm_help). 

NOTE You can copy the documentation for more than one expansion product documentation 
set to the documentation application server. The result is one ecm_help directory structure 
containing the core documentation set and one or more sets of expansion product 
documentation files.

4. Download the latest web-posted updates of planning and preparation, installation and upgrade 
guide PDF files for the IBM FileNet P8 Platform and various expansion products. 

Note Check the Documentation page on the IBM Information Management support page on 
www.ibm.com for the latest versions of these guides. See also, “Access IBM FileNet 
documentation, compatibility matrices, and fix packs” on page 20 for details.

5. Repeat these steps for each of your expansion products, custom applications, and auxiliary 
documentation. 

6. Go on to the procedure in the following topic, “Update documentation search index” on page 26.

Update documentation search index
You must update the documentation search index when the following conditions apply:

• You have installed expansion-products or auxiliary documentation.

• You have previously installed expansion products or auxiliary documentation, and you refresh 
the core IBM FileNet P8 Platform documentation. 

If neither of these conditions apply, skip to the procedure in the following topic, “Complete and verify 
the documentation installation” on page 28.

NOTE Every time you update the documentation search index, a backup copy of the files in the 
existing Index/core subdirectory is automatically copied to the Index/IndexOld subdirectory. 
You can reapply these backed-up files to the core subdirectory (after first moving or deleting the 
files created there) if you need to return to the previous indexed state.

To update the documentation search index 

1. If the IBM FileNet P8 Platform documentation application (ecm_help) is running, stop it. Verify 
that no processes are accessing the IBM FileNet P8 Platform documentation application.

NOTE Add all expansion-products and auxiliary documentation that you intend to use before 
updating the search index. Otherwise, you might have to repeat this procedure if you install 
additional documentation later.

2. Open a terminal or command prompt on the application server. From the command line, 
navigate to the search subdirectory under the application root directory, for example, 
ecm_help.
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3. Modify the search-indexing script file that is appropriate for your operating system as follows:

UNIX®

Add execute permissions (chmod 755) on the indexFiles.sh file because it is set to read-only 
in the documentation package.

Windows®

Set permissions on the indexFiles.bat file, because it is set to read-only in the documentation 
package.

4. Using a text editor, open the search-indexing script file that is appropriate for your operating 
system:

UNIX

indexFiles.sh

Windows

indexFiles.bat

5. If necessary for your environment, set the JAVA_HOME variable in the script file with the path to 
your Java Run Time Environment (JRE) installation location.

NOTE The Java JRE installation subdirectory can be user-defined, so substitute your actual 
location, as appropriate.

6. Save your changes and close the text editor.

7. From the ecm_help/search directory, run the updated search-indexing script file that is 
appropriate for your server operating system: 

UNIX

indexFiles.sh

Windows

indexFiles.bat

NOTE As you run the search-indexing script file, you might notice periodic Parse Abort errors. 
You can ignore these error conditions, as they are benign and do not affect the overall 
indexing process.

(Optional) Prepare for disaster recovery or easy redeployment

• Now that you have built your complete IBM FileNet P8 Platform documentation location 
(ecm_help), you can regenerate the ecm_help.war file using the ecm_help directory structure 
that contains your core IBM FileNet P8 Platform documentation and all added-on IBM FileNet P8 
expansion products. This regenerated ecm_help.war file could then be placed into safe disaster 
recovery storage or used to quickly bring additional FileNet P8 Platform documentation servers 
online.
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Complete and verify the documentation installation
Perform this procedure after you have installed and reindexed (for installations with add-on 
documentation) the IBM FileNet P8 documentation on the application server.

To complete and verify the documentation installation 

1. From your application server, start the IBM FileNet P8 documentation (ecm_help) application.

2. In a web browser, enter the URL for your web environment, using your documentation server 
name, and port number, as in these examples:

WebSphere

http://yourdocserver:9080/ecm_help/

WebLogic

http://yourdocserver:7001/ecm_help/

JBoss

http://yourdocserver:8080/ecm_help/

If the installation was a success, the help system displays.

NOTE Make a note of the URL for your application server. Use it as the documentation URL for 
the IBM FileNet P8 components. Specify this URL either while running installation programs or 
later in the site preferences settings (for example, in Workplace or FileNet Workplace XT).

3. Click the Search link on the Help Directory toolbar. The documentation Search page opens.

4. Enter a value for your Search query and run the query.

5. Select one of the Search query result links. The associated help page opens.
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Install and configure Content Engine
To set up Content Engine, do the following tasks:

1. “Install Content Engine” on page 30

2. “Install FileNet Enterprise Manager” on page 34

3. “Install Content Engine software updates” on page 36

4. “Install ECM Centera SDK library files” on page 102

5. “Configure Content Engine instances” on page 37

6. “Install the latest Content Search Engine Client files on Content Engine servers” on page 74

7. “Install the latest Process Engine Client files on Content Engine servers” on page 75

8. “Deploy Content Engine instances” on page 78

9. “Install Tivoli Storage Manager client and add native API library paths (WebSphere)” on page 95

10. “Install Tivoli Storage Manager client and add native API library paths (WebLogic)” on page 97

11. “Install Tivoli Storage Manager client and add native API library paths (JBoss)” on page 100

12. “Complete Content Engine post-deployment steps” on page 106

13. “Establish the FileNet P8 domain and Global Configuration Data (GCD)” on page 109

14. “Create the data sources for an object store” on page 117

15. “Create the initial object store” on page 133

16. “Verify the Content Engine installation” on page 140
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Task 1: Install Content Engine
Use the procedure in this task to interactively or silently install the Content Engine components 
shown in the following table. Note that some of the components can be installed only on Windows-
based machines.

Install .NET Clients software only on machines where you intend to run either the FileNet 
Enterprise Manager administrative client or your own customized client application to administer 
Content Engine.

The Content Engine Upgrader is required only to upgrade Content Engine and Content Search 
Engine data from an earlier version.

The FileNet Deployment Manager is an optional component that you can use to move one IBM 
FIleNet P8 environment into another, such as moving a test system into a production environment. 
See Application Deployment > Get Started with FileNet Deployment Manager for details.

To install Content Engine

1. Log on as ce_install_user to the application server machine where you are going to install 
Content Engine software.

If you are installing Content Engine in a managed environment rather than a single-server 
environment, the application server must be the WebSphere Deployment Manager node or the 
WebLogic Administrator node.

2. Navigate to the Content Engine software package in the installation media.

3. (Red Hat Linux® only) On the machine where you are going to run the Content Engine 
installation program, install the shared library libstdc++.so.5:

a. Navigate to the Red Hat 5 installation software.

b. Install the package compat-libstdc++-33-3.2.3-61.i386.rpm, which contains the 
necessary shared library libstdc++.so.5.

4. Begin the Content Engine installation, choosing either the interactive or silent steps below, For 
information on the Content Engine parameter values to specify in the installation, see 

Component Required Platform

Content Engine Server UNIX or Windows

Configuration Manager UNIX or Windows

.NET Clients (including FileNet 
Enterprise Manager)

Windows only

Content Engine Upgrader Windows only

FileNet Deployment Manager Windows only
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“Installation and Upgrade Worksheet” in Plan and Prepare Your Environment for IBM FileNet 
P8.

• To install interactively:

i. With the Data > Filter > AutoFilter command enabled, perform the following steps to see 
only the installation properties you must specify for the current task:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select “CE Installer” for your operating system.

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Installation, Upgrade."

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

ii. To start the installation wizard, run one of the following commands, depending on your 
operating system:

iii. Complete the wizard using the following table:

Platform Command

AIX® P8CE-4.5.0-AIX.BIN

HPUX P8CE-4.5.0-HPUX.BIN

HPUXi P8CE-4.5.0-HPUXI.BIN

Linux P8CE-4.5.0-LINUX.BIN

Solaris P8CE-4.5.0-SOL.BIN

Windows P8CE-4.5.0-WIN.EXE

zLinux P8CE-4.5.0-ZLINUX.BIN

In this screen... Perform this action...

Welcome Click Next to proceed with the installation.

NOTE Click Previous at any time to make changes in previous 
screens. Click Cancel to exit the program.

Software License 
Agreement

Review and accept the license agreement, and then click 
Next.
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• To install silently:

i. With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to see only the 

Choose 
Components

(Windows only)

Set the Install Set value to Content Engine and choose the 
components you want to install:

• Content Engine Server

Installs Content Engine Server and Configuration 
Manager software.

• .NET Clients and FileNet Enterprise Manager

Installs the components to administer Content Engine 
from this machine.

• Tools

Installs Configuration Manager, Deployment Manager, 
and Content Engine Upgrader.

Click Next to continue.

Choose Install Path Specify the directory where you want to install Content 
Engine. If the directory (or its parent) doesn’t exist, the 
program will create it. Click Next to continue.

Specify 
Documentation 
URL

Optionally specify the URL for the IBM FileNet P8 
documentation that you deployed in “Install IBM FileNet P8 
Platform documentation (All)” on page 23, and then click Next.

Alternatively, you can specify the URL (after you have created 
the FileNet P8 domain in “Establish the FileNet P8 domain and 
Global Configuration Data (GCD)” on page 109) using FileNet 
Enterprise Manager, as follows:

.NET API COM 
Compatibility Layer 
(CCL) URL

(Windows only)

Specify a URL for the .NET API COM Compatibility Layer if 
you intend to configure CCL for a custom COM-based FileNet 
P8 application, and then click Next.

Review Pre-
Installation 
Summary

Verify your component selections, and click Install to start 
installing software.

Installation 
Complete

Click Done.

In this screen... Perform this action...
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installation properties you must specify for the Content Engine silent-installation 
program:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select CE Installer.

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Installation."

– Click the AutoFilter drop-down arrow in the “File Hosting the Value (if any)” column 
header and select ce_silent_install.txt.

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

ii. Open the CE_silent_install.txt file in the software package for editing.

iii. Set the parameter values in the CE_silent_install.txt file for your site.

iv. Run one of the following commands in the software package, depending on your 
operating system:

5. After the installation finishes (and you have clicked Done if you installed interactively), check for 
errors in the Content Engine error log file ce_install_path/ce_install_log_4_5_0.txt, 
where ce_install_path is the installation path to Content Engine. You can locate the errors by 
searching the file for the following strings:

• Warnings

• NonFatalErrors

• FatalErrors

Platform Command

AIX P8CE-4.5.0-AIX.BIN -f CE_silent_install.txt -i silent

HPUX P8CE-4.5.0-HPUX.BIN -f CE_silent_install.txt -i silent

HPUXi P8CE-4.5.0-HPUXI.BIN -f CE_silent_install.txt -i silent

Linux P8CE-4.5.0-LINUX.BIN -f CE_silent_install.txt -i silent

Solaris P8CE-4.5.0-SOL.BIN -f CE_silent_install.txt -i silent

Windows P8CE-4.5.0-WIN.EXE -f CE_silent_install.txt -i silent

zLinux P8CE-4.5.0-ZLINUX.BIN -f CE_silent_install.txt -i silent
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Task 2: Install FileNet Enterprise Manager
If you did not install FileNet Enterprise Manager on the Content Engine server machine in “Install 
Content Engine” on page 30, you can install it now on the same Windows server or on some other 
Windows machine.

Microsoft .NET Framework 2.0 and Web Services Enhancements 3.0 must already be installed on 
the machine where you intend to install FileNet Enterprise Manager.

NOTE You cannot install FileNet Enterprise Manager on a UNIX machine.

To install FileNet Enterprise Manager 

1. On the machine where you will install FileNet Enterprise Manager, log on as a member of the 
Local Administrators group or the Power Users group.

2. Access the Content Engine software package.

3. Start the FileNet Enterprise Manager installation. For information on parameter values, see 
“Installation and upgrade worksheet” on page 229 in Plan and Prepare Your Environment for IBM 
FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls), perform the following steps to quickly see 
only the installation properties you must specify for the Content Engine installation 
program:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select CE installer.

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Installation."

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

• To install interactively:

i. Run the following command in the software package:

P8CE-4.5.0-Win.exe

ii. Complete the installation program wizard using the following table:

In this screen... Perform this action...

Welcome Click Next to proceed with the installation.

NOTE Click Previous at any time to make changes in previous 
screens. Click Cancel to exit the program.

Software License 
Agreement

Review and accept the license agreement, and then click 
Next.
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• To install silently:

i. Open the CE_silent_install.txt file in the software package for editing.

ii. Set the parameter values in the CE_silent_install.txt file for your site. Be sure to 
set the CHOSEN_INSTALL_FEATURE_LIST parameter value to:

DotNetClients,AdminTools

iii. Save your edits.

iv. Run the following command in the software package:

P8-CE-4.5.0-WIN.EXE -f CE_silent_install.txt -i silent

Choose 
Components

Set the Install Set value to Content Engine, select the check 
boxes for .NET Clients and FileNet Enterprise Manager, and 
clear all the other check boxes. Click Next to continue.

Choose Install Path Specify the directory where you want to install FileNet 
Enterprise Manager. If the directory (or its parent) doesn’t 
exist, the program will create it. Click Next to continue.

Specify 
Documentation 
URL

Optionally specify the URL for the IBM FileNet P8 
documentation that you deployed in “Install IBM FileNet P8 
Platform documentation (All)” on page 23, and then click Next.

.NET API COM 
Compatibility Layer 
(CCL) URL

Specify a URL for the .NET API COM Compatibility Layer if 
you intend to configure CCL for a custom COM-based FileNet 
P8 application, and then click Next.

Review Pre-
Installation 
Summary

Verify your component selections, and click Install to start 
installing FileNet Enterprise Manager.

Installation 
Complete

Click Done.

In this screen... Perform this action...
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 3: Install Content Engine software updates
To install the Content Engine software updates

36

IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE

Task 3: Install Content Engine software updates
Perform the procedure in this topic for each Content Engine instance to install software updates, 
fix packs, or interim fixes.

If no Content Engine software updates are available, skip to “Configure Content Engine instances” on 
page 37.

To install the Content Engine software updates

1. For instructions on how to obtain the latest Content Engine software updates, see “Access IBM 
FileNet documentation, compatibility matrices, and fix packs” on page 20.

2. Open the readmes for the Content Engine software updates and perform the installation 
procedures in the readmes on each Content Engine instance.

If you installed an instance into a managed environment, perform the procedure on the 
Deployment Manager node (WebSphere) or the Administrator node (WebLogic).



Task 4: Configure Content Engine instances 37
Task 4: Configure Content Engine instances
You will configure and deploy all of your Content Engine application instances with the new 
Configuration Manager tool. Configuration Manager prepares the Content Engine application for 
deployment on the application server. A single Content Engine application application instance 
equates to one deployed applcation on your application server. 

You first provide and apply information about your Content Engine application environment, and 
then later deploy the application. You can configure multiple instances before deploying any of 
them, or you can configure and deploy one instance at a time. This topic provides the 
configuration steps for one instance. Repeat the steps as need for additional  instances in your 
environment.

You use Configuration Manager to configure the following information for the Content Engine 
application instance:

• Application server properties

• Java Database Connectivity (JDBC) data source properties

• Directory service (LDAP) provider

• Content Engine bootstrap properties

TIPS

• (WebSphere only) For best results, configure no more than one Content Engine instance in a 
WebSphere profile.

• Use the command line version of Configuration Manager if either of these conditions is true:

– Your system is Novell SUSE Linux Enterprise 9. You can configure Content Engine only 
with the command line.

– You need an accessible software version of Configuration Manager for people with 
disabilities to use.

• To avoid having to perform the Content Engine deployment task multiple times, perform the 
deployment after you install the Process Engine Client files. Configuration Manager can 
deploy a Content Engine application any time after you configure the other properties for your 
environment. However, you must also perform the deployment task after you install or update 
the Process Engine Client files on the Content Engine server. The Process Engine Client files 
are required if you set up Process Engine in your IBM FileNet P8 environment.
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Delete existing data sources as needed
One of the tasks you will run in Configuration Manager is to create data sources for the Global 
Configuration Database (GCD) and for object stores. You will do this either with the graphical user 
interface (using the Configure JDBC Data Sources task) or the command line interface (using the 
ConfigureJDBC task).

Configuration Manager will not create a new data source with the same name as that of an 
existing data source. If you want to reuse the name of an existing data source for the GCD or for 
an object store, manually delete the existing data source before creating the new data source. 
Refer to your application server documentation for more information.

Grant permissions to the Configuration Manager user
complete the following procedure to grant the file and directory permissions required by 
config_mgr_user, the user who will run Configuration Manager. For details on required accounts and 
related permissions, see “Accounts for Content Engine” on page 71 in Plan and Prepare Your 
Environment for IBM FileNet P8.

To grant permissions to the Configuration Manager user

1. Log on to the application server where you installed Content Engine as ce_install_user. For 
details on required accounts and related permissions, see “Accounts for Content Engine” on 
page 71 in Plan and Prepare Your Environment for IBM FileNet P8.

2. Grant config_mgr_user execute permission (UNIX) or read & execute permission (Windows) on 
the executable file of the interface of Configuration Manager you intend to use:

• To enable use of the graphical user interface, grant permission to one of the following files in the 
ce_install_path/tools/configure/CMUI directory, where ce_install_path is the 
path in which you installed Content Engine:

UNIX

cmui

Windows

cmui.exe

• To enable use of the command line interface, grant permission to one of the following files in the 
ce_install_path/tools/configure directory, where ce_install_path is the path in 
which you installed Content Engine:

UNIX 

configmgr.sh

Windows 

configmgr.bat
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 4: Configure Content Engine instances
Configure instances using the graphical user interface

39
3. Grant write permission to the directory where you want Configuration Manager to place the 
configuration XML files it will generate.

If you are not going to specify this directory when you run Configuration Manager, grant write 
permission on the default directory, ce_install_path/tools/configure and all its 
files and subdirectories.

4. Log off the Content Engine application server, and log back on as config_mgr_user, the 
Configuration Manager user.

5. Continue with one of the following topics:

• “Configure instances using the graphical user interface” on page 39

• “Configure instances using the command line interface” on page 65

Configure instances using the graphical user interface
In this subtopic you will configure a Content Engine application on an application server using the 
graphical user interface version of Configuration Manager. Use the information in your installation 
worksheet to specify the values for the parameters required to configure Content Engine. For more 
information, see “Installation and upgrade worksheet” on page 229 of Plan and Prepare Your 
Environment for IBM FileNet P8.

For more information on the properties and values that you enter in Configuration Manager, roll 
your mouse over the property name to view the tool tip help for the property. Refer to the appendix 
“Configuration Manager user interface reference” on page 645 for complete information on using the 
graphical user interface.

To set the GUI password save option (optional)

• By default, Configuration Manager does not save passwords that you enter in the graphical 
user interface. That is, each time you start Configuration Manager and open a saved profile, 
you will need to specify any passwords required by the tasks and for the application server 
properties. For more information on password handling and how to change the password save 
setting, see “Handling passwords in Configuration Manager” on page 643.

To start Configuration Manager

Complete one of the following steps, depending on the operating system that runs on the machine 
where you installed Content Engine:

UNIX

• Run the following command:

ce_install_path/tools/configure/CMUI/cmui

where ce_install_path is the location where Content Engine server software is installed.
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Windows

• Complete one of the following actions:

– Double-click the FileNet Configuration Manager desktop shortcut. 

– Select Start > All Programs > IBM FileNet P8 Platform > FileNet Configuration Manager. 

– Run ce_install_path\tools\configure\CMUI\cmui.exe.

where ce_install_path is the location where Content Engine server software is installed.

To create a configuration profile

1. Refer to your installation worksheet to specify the values for the properties required for your new 
profile. For more information, see “Installation and upgrade worksheet” on page 229 of Plan and 
Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), complete the following actions to quickly see only the 
properties you must specify for Configuration Manager:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select CM: Set Application Server properties.

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify Setup Type contains "Installation".

• Click the AutoFilter drop-down arrow in all other column headers and select (All).
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2. Start the Create New Configuration Profile wizard by selecting File > New Configuration Profile.

In this screen... Perform this action...

Configuration Profile 
Information

• Provide the following information for the profile:

– Enter a name for the profile. The name must be valid as 
a directory name for your operating system. 
Configuration Manager will create a directory with the 
profile name for storing the configuration files 
associated with this profile. For more information of 
profiles, see “Configuration profile concepts” on page 639 in 
the Configuration Manager reference appendix.

– Specify the directory for the profile. Either type in the full 
path to the profile directory or click Browse to locate the 
directory. The default path is 
ce_install_path/tools/configure/profiles, 

where ce_install_path is the location where Content 
Engine is installed.

• Click Next.

• Choose an application server type for the profile. Select 
WebSphere, JBoss, or WebLogic, and then click Next.

If you click Finish instead of Next, you will need to come 
back later to supply the required application server 
properties before you can run the configuration tasks.

• Continue at one of the following screens:

– “Set Application Server Properties for WebSphere” on 
page 42

– “Set Application Server Properties for JBoss” on page 43

– “Set Application Server Properties for WebLogic” on page 43
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Set Application Server 
Properties for 
WebSphere

This screen is displayed only if you selected WebSphere in the 
previous screen. 

• Provide the following information for the application server:

– Select the application server version from the list.

– Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the 
directory. 

– Enter the application server administrator user name. 
Use the directory service user account that has been 
assigned the application server administrative role. This 
account is used to manage the application server 
domain/profile, to configure the data sources and 
connection pools for the Global Configuration Database 
(GCD), and to deploy the Content Engine application. If 
Administrative Security is already enabled, use an 
existing administrative user account.

– Enter the application server administrative password. 
The password will be encrypted for you. For more 
information on passwords, see “Handling passwords in 
Configuration Manager” on page 643.

– Enter the application server SOAP port number.

– Enter the name of the WebSphere application server 
cell where Content Engine will be deployed.

– If you have already configured WebSphere to use 
certificates, clear the “Do not use SSL certificates for 
server communications” check box. Otherwise, leave the 
check box selected. 

IMPORTANT  If you select this check box, your 
WebSphere settings for communicating with other 
servers, such as Application Engine, will be changed.

• Click Next.

• Continue with “Select the tasks that you want included in the 
Configuration Profile” on page 44.

In this screen... Perform this action...
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Set Application Server 
Properties for JBoss

This screen is displayed only if you selected JBoss in the 
previous screen. 

• Provide the following information for the application server.

– Select the application server version from the list.

– Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the 
directory. 

– Enter the name of the JBoss application server name 
where Content Engine will be deployed.

• Click Next.

• Continue with “Select the tasks that you want included in the 
Configuration Profile” on page 44.

Set Application Server 
Properties for WebLogic

This screen is displayed only if you selected WebLogic in the 
previous screen.

• Provide the following information for the application server:

– Select the application server version from the list.

– Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the 
directory. 

– Enter the application server administrator user name. 
Use the directory service user account that has been 
assigned the application server administrative role. This 
account is used to manage the application server 
domain/profile, to configure the data sources and 
connection pools for the Global Configuration Database 
(GCD), and to deploy the Content Engine application. If 
Administrative Security is already enabled, use an 
existing administrative user account.

– Enter the application server administrative password. 
The password will be encrypted for you. For more 
information on passwords, see “Handling passwords in 
Configuration Manager” on page 643.

– Enter the application server SOAP port number.

– Enter the machine name or the IP address of the local 
host for the application server host. 

– Enter the fully qualified path to the WebLogic application 
server user projects directory, or click Browse to locate 
the directory.

In this screen... Perform this action...
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The profile you created is displayed as an icon in the profile pane (left-hand pane), along with  
icons for the tasks you selected.

To configure a Content Engine instance using the Configuration Manager graphical user interface

You will complete the configuration tasks in this procedure to prepare the Content Engine 
application instance for deployment on the application server. You will complete the deploy task 
later in “Deploy Content Engine instances” on page 78.

You can perform the configuration tasks in any order, and you do not need to complete work on 
one configuration task before starting another. You can save your edits, switch between tasks, 
close the tasks, and reopen tasks as needed. 

1. Start or stop the application server, depending on its type:

WebSphere and WebLogic

Start the application server if it is not already running.

JBoss

Stop the application server.

2. Refer to your installation worksheet to specify the values for the properties required for Step 3 
through Step 5. For more information, see “Installation and upgrade worksheet” on page 229 of 
Plan and Prepare Your Environment for IBM FileNet P8.

Set Application Server 
Properties for WebLogic 
(continued)

– Enter the WebLogic application server domain name 
where Content Engine will be deployed.

– Enter the name of the WebLogic application server 
name where Content Engine will be deployed.

• Click Next.

• Continue with “Select the tasks that you want included in the 
Configuration Profile” on page 44.

Select the tasks that you 
want included in the 
Configuration Profile

• Select the tasks that you want to include in this profile. For a 
new Content Engine installation, you need to complete all 
four configuration tasks: 

– Configure JDBC Data Sources

– Configure LDAP

– Configure Bootstrap

– Deploy Application.

• Click Finish to create the profile and save the application 
server properties.

In this screen... Perform this action...
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HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), complete the following actions to quickly see only the 
properties you must specify for Configuration Manager:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select one of these Configuration Manager options:

– CM: Configure JDBC Data Sources

– CM: Configure LDAP

– CM: Configure Bootstrap Properties

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify Setup Type contains "Installation".

• Click the AutoFilter drop-down arrow in all other column headers and select (All).

3. Provide property values for the JDBC data sources for the Global Configuration Database 
(GCD).

a. If your configuration profile is not open in Configuration Manager, open the profile you 
created earlier in “To create a configuration profile” on page 40.

b. Right-click Configure JDBC Data Sources in the profile pane, and select Edit Selected Task. 

c. Provide the property values for your database, using the appropriate table for your database 
type:

DB2® for Linux, UNIX, Windows

In this field... Provide this information...

JDBC driver name Select “DB2 Universal JDBC Driver” from the list. The 
remaining properties and values that you need to supply for 
your data source configuration depend on the type of driver 
that you select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the Global Configuration Database (GCD) 
tablespace or database. For example, FNGCDDS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the Global Configuration Database (GCD) tablespace 
or database. For example, FNGCDDSXA.

Database server name The host name of the machine where the database software 
is installed.

Database port number The port number used by the DB2 database instance in 
which you create tablespaces for the Global Configuration 
Database (GCD) and object stores.

Database name The name of the Global Configuration Database (GCD) 
database. 
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DB2 for z/OS®

Database user name The name of the DB2 Global Configuration Database (GCD) 
tablespace user.

Database password The password for the DB2 Global Configuration Database 
(GCD) tablespace user. The tool encrypts the password for 
you.

Enter the password again in the Confirm field.

JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the Global 
Configuration Database (GCD) and do not want the 
Configuration Manager tool to create them for you, leave 
this field blank and clear the Task enabled check box.

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the Global 
Configuration Database (GCD) and do not want the 
Configuration Manager tool to create them for you, leave 
this field blank and clear the Task enabled check box.

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step e. The default is 
enabled.

In this field... Provide this information...

JDBC driver name Select “DB2 for z/OS Universal JDBC Driver” from the list. 
The remaining properties and values that you need to supply 
for your data source configuration depend on the type of 
driver that you select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the Global Configuration Database (GCD) 
tablespace or database. For example, FNGCDDS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the Global Configuration Database (GCD) tablespace 
or database. For example, FNGCDDSXA.

In this field... Provide this information...
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Database server name The host name of the machine where the database software 
is installed.

Database port number The port number used by the DB2 database instance in 
which you create tablespaces for the Global Configuration 
Database (GCD) and object stores.

Database name The name of the Global Configuration Database (GCD) 
database instance name. 

Database user name The name of the DB2 Global Configuration Database (GCD) 
tablespace user.

Database password The password for the DB2 Global Configuration Database 
(GCD) tablespace user. The tool encrypts the password for 
you.

Enter the password again in the Confirm field.

JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the Global 
Configuration Database (GCD) and do not want the 
Configuration Manager tool to create them for you, leave 
this field blank and clear the Task enabled check box.

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the Global 
Configuration Database (GCD) and do not want the 
Configuration Manager tool to create them for you, leave 
this field blank and clear the Task enabled check box.

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step e. The default is 
enabled.

In this field... Provide this information...
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MS SQL Server

In this field... Provide this information...

JDBC driver name Select “Microsoft® JDBC Driver 2005” from the list. The 
remaining properties and values that you need to supply for 
your data source configuration depend on the type of driver 
that you select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the Global Configuration Database (GCD) 
tablespace or database. For example, FNGCDDS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the Global Configuration Database (GCD) tablespace 
or database. For example, FNGCDDSXA.

Database server name The host name of the machine where the database software 
is installed.

Database port number The port number used by the SQL Server database instance 
in which you create databases for the Global Configuration 
Database (GCD) and object stores.

Database name The name of the Global Configuration Database (GCD) 
database for SQL Server.

Database user name The name of the SQL Server user with administrative rights 
to the Global Configuration Database (GCD) database.

Database password The password for the SQL Server user with administrative 
rights to the Global Configuration Database (GCD) 
database. The tool encrypts the password for you.

Enter the password again in the Confirm field.

JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the Global 
Configuration Database (GCD) and do not want the 
Configuration Manager tool to create them for you, leave 
this field blank and clear the Task enabled check box.
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Oracle

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the GCD and 
do not want the Configuration Manager tool to create them 
for you, leave this field blank and clear the Task enabled 
check box.

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step e. The default is 
enabled.

In this field... Provide this information...

JDBC driver name Select “Oracle JDBC Driver” from the list. The remaining 
properties and values that you need to supply for your data 
source configuration depend on the type of driver that you 
select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the Global Configuration Database (GCD) 
tablespace or database. For example, FNGCDDS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the Global Configuration Database (GCD) tablespace 
or database. For example, FNGCDDSXA.

Database server name The host name of the machine where the database software 
is installed.

Database port number The port number used by the Oracle database instance in 
which you create tablespaces for the Global Configuration 
Data (GCD) and object stores.

Database name The SID of the Oracle database containing the Global 
Configuration Database (GCD) tablespace.

Database user name The name of the Oracle Global Configuration Database 
(GCD) tablespace owner.

Database password The password for the Oracle Global Configuration Database 
(GCD) tablespace owner. The tool encrypts the password 
for you.

Enter the password again in the Confirm field.

In this field... Provide this information...
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JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the GCD and 
do not want the Configuration Manager tool to create them 
for you, leave this field blank and clear the Task enabled 
check box.

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the GCD and 
do not want the Configuration Manager tool to create them 
for you, leave this field blank and clear the Task enabled 
check box.

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step e. The default is 
enabled.

In this field... Provide this information...
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Oracle RAC

In this field... Provide this information...

JDBC driver name Select “Oracle JDBC Driver (RAC support)” from the list. The 
remaining properties and values that you need to supply for 
your data source configuration depend on the type of driver 
that you select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the Global Configuration Database (GCD) 
tablespace or database. For example, FNGCDDS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the Global Configuration Database (GCD) tablespace 
or database. For example, FNGCDDSXA.

Database server name 
RAC node 1

The host name of the machine where the database software 
is installed for node 1.

Database port number 
RAC node 1

The port number used by the Oracle database instance in 
which you create tablespaces for the Global Configuration 
Data (GCD) and object stores.

Database server name 
RAC node 2

The host name of the machine where the database software 
is installed for node 2.

Database port number 
RAC node 2

The port number used by the Oracle database instance in 
which you create tablespaces for the Global Configuration 
Data (GCD) and object stores.

Database service name The SID of the Oracle database containing the Global 
Configuration Database (GCD) tablespace.

Oracle RAC retries The number of retries for Oracle RAC.

Oracle RAC delay The amount of delay for Oracle RAC.

Database user name The name of the Oracle Global Configuration Database 
(GCD) tablespace owner.

Database password The password for the Oracle Global Configuration Database 
(GCD) tablespace owner. The tool encrypts the password 
for you.

Enter the password again in the Confirm field.
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d. Select File > Save to save your changes.

e. Apply the JDBC property settings by right-clicking Configure JDBC Data Sources in the 
profile pane, and select Run Task. Running the configuration task can take a few minutes. 
The task execution status messages are displayed in the Console pane below the JDBC 
properties.

TIP  You can check the completion status of a task by right-clicking Configure JDBC Data 
Sources in the profile pane, and select Check Task Status.

f. Close the Configure JDBC Data Sources task pane.

NOTE  In this step, you created the Global Configuration Database (GCD) data sources. You 
will create the initial object store data sources later in “Create the data sources for an object 
store” on page 117.

4. Provide property values for the LDAP provider:

a. Right-click Configure LDAP in the profile pane, and select Edit Selected Task. 

b. Provide the property values for your LDAP provider, using the appropriate table for your 
provider.

JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the Global 
Configuration Database (GCD) and do not want the 
Configuration Manager tool to create them for you, leave 
this field blank and clear the Task enabled check box.

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the GCD and 
do not want the Configuration Manager tool to create them 
for you, leave this field blank and clear the Task enabled 
check box.

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step e. The default is 
enabled.

In this field... Provide this information...
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Tivoli® Directory Server

In this field... Provide this information...

Directory service 
provider type

Select “Tivoli Directory Server” from the list. The remaining 
properties and values that you need to supply for your LDAP 
configuration depend on the type of provider that you select.

Directory service server 
host name

The directory server host name. The short name, full name, 
or IP address of the system that hosts the directory service. 

Directory service port 
number

The port number configured on the directory server host for 
communicating with the directory server.

Directory service bind 
user name

The fully qualified distinguished name of the LDAP bind 
user for authenticating to Tivoli Directory Server.

Directory service bind 
user password

The password used by the LDAP bind user to authenticate 
to the directory server. The tool encrypts the password for 
you.

Enter the password again in the Confirm field.

User base distinguished 
name

The fully qualified distinguished name of the container for 
starting a user search in Tivoli Directory Server. For example, 
ou=FileNet,dc=FNCE.

User filter The filter used by the bind user when searching for users in 
a directory server. For example, (cn={0}).

Group base 
distinguished name

JBoss only. The distinguished name of the container for 
starting a group search in a directory server. For example, 
cn=users,dc=mydomain.

Group filter The filter used by the bind user when searching for groups 
in a directory server. For example, (member={1}).

User name attribute WebSphere and WebLogic. The attribute by which a user 
logs on to Tivoli Directory Server. For example, cn.

Group attribute An attribute in a Tivoli Directory Server entry that identifies 
the group. For example, cn.

Administrative console 
user name

WebSphere only. A user account that has access to log on 
to the application server administration console. If your site 
uses a Federated LDAP registry, this account name must be 
a unique user across all federated realms. 

WebSphere LDAP 
repository type

WebSphere only. The WebSphere Application Server LDAP 
repository type. Valid values are: StandaloneLDAP / 
FederatedLDAP.
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Federated Repository 
virtual realm name

WebSphere only. The name of the WebSphere Application 
Server Federated Repositories virtual realm.  The default 
name is defaultWIMFileBasedRealm.

Overwrite existing 
repository

WebSphere only. Select this check box to overwrite any 
existing LDAP repository entries. Clear this check box to 
preserve any existing LDAP repository entries. This setting 
is valid only when the Standard deployment type is selected 
for the WebSphere LDAP repository type field. The default is 
clear (do not overwrite).

Set as current active 
user registry

WebSphere only. This setting specifies whether to set the 
LDAP repository as the active user registry. When set to 
true, the LDAP information will be used to configure the 
active user registry.

Script WebSphere and WebLogic. The fully qualified path to the 
LDAP configuration task script. The task script filename 
depends on the application server type selected.

WebSphere Application Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWSLDAP.tcl  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWSLDAP.tcl.

WebLogic Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWLLDAP.py  or  
c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWLLDAP.py.

Temporary Directory WebSphere and WebLogic. The fully qualified path to a 
temporary directory to be used by the configuration task. 
For example, /opt/FileNet/ContentEngine/tools/
configure/tmp  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp.

SSL enabled WebSphere and WebLogic. This setting specifies whether 
Secure Sockets Layer (SSL) is enabled or disabled. Select 
the check box to enable SSL. Clear the check box to  
disable SSL. The default is disabled.

In this field... Provide this information...
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 4: Configure Content Engine instances
To configure a Content Engine instance using the Configuration Manager graphical user interface

55
Active Directory

Kerberos support JBoss only. Select the Kerberos support check box if 
Kerberos authentication is used. Clear the check box if 
Kerberos authentication is not used. The default is Kerberos 
not supported.

Task enabled Select the Task enabled check box to execute the configure 
LDAP task later in Step d. The default is enabled.

In this field... Provide this information...

Directory service 
provider type

Select “Active Directory” from the list. The remaining 
properties and values that you need to supply for your LDAP 
configuration depend on the type of provider that you select.

Directory service server 
host name

The directory server host name. The short name, full name, 
or IP address of the system that hosts the directory service. 

Directory service port 
number

The port number configured on the directory server host for 
communicating with the directory server.

Directory service bind 
user name

The fully qualified distinguished name of the LDAP bind 
user for authenticating to Active Directory.

Directory service bind 
user password

The password used by the LDAP bind user to authenticate 
to the directory server. The tool encrypts the password for 
you.

Enter the password again in the Confirm field.

User base distinguished 
name

The fully qualified distinguished name of the container for 
starting a user search in Active Directory. For example, 
ou=FileNet,dc=FNCE.

User filter The filter used by the bind user when searching for users in 
Active Directory. For example, (sAMAccountName={0}).

Group base 
distinguished name

JBoss only. The distinguished name of the container for 
starting a group search in a directory server. For example, 
cn=users,dc=mydomain.

Group filter The filter used by the bind user when searching for groups 
in a directory server. For example, (member={1}).

User name attribute WebSphere and WebLogic. The attribute by which a user 
logs on to Tivoli Directory Server. For example, cn.

Group attribute An attribute in a Tivoli Directory Server entry that identifies 
the group. For example, cn.

In this field... Provide this information...
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Administrative console 
user name

WebSphere only. A user account that has access to log on 
to the application server administration console. If your site 
uses a Federated LDAP registry, this account name must be 
a unique user across all federated realms. 

WebSphere LDAP 
repository type

WebSphere only. The WebSphere Application Server LDAP 
repository type. Valid values are: StandaloneLDAP / 
FederatedLDAP.

Federated Repository 
virtual realm name

WebSphere only. The name of the WebSphere Application 
Server Federated Repositories virtual realm.  The default 
name is defaultWIMFileBasedRealm.

Overwrite existing 
repository

WebSphere only. Select this check box to overwrite any 
existing LDAP repository entries. Clear this check box to 
preserve any existing LDAP repository entries. This setting 
is valid only when the Standard deployment type is selected 
for the WebSphere LDAP repository type field. The default is 
clear (do not overwrite).

Set as current active 
user registry

WebSphere only. This setting specifies whether to set the 
LDAP repository as the active user registry. When set to 
true, the LDAP information will be used to configure the 
active user registry.

Script WebSphere and WebLogic. The fully qualified path to the 
LDAP configuration task script. The task script filename 
depends on the application server type selected.

WebSphere Application Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWSLDAP.tcl  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWSLDAP.tcl.

WebLogic Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWLLDAP.py  or  
c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWLLDAP.py.

Temporary Directory WebSphere and WebLogic. The fully qualified path to a 
temporary directory to be used by the configuration task. 
For example, /opt/FileNet/ContentEngine/tools/
configure/tmp  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp.

In this field... Provide this information...
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 4: Configure Content Engine instances
To configure a Content Engine instance using the Configuration Manager graphical user interface

57
ADAM or AD LDS

SSL enabled WebSphere and WebLogic. This setting specifies whether 
Secure Sockets Layer (SSL) is enabled or disabled. Select 
the check box to enable SSL. Clear the check box to  
disable SSL. The default is disabled.

Kerberos support JBoss only. Select the Kerberos support check box if 
Kerberos authentication is used. Clear the check box if 
Kerberos authentication is not used. The default is Kerberos 
not supported.

Task enabled Select the Task enabled check box to execute the configure 
LDAP task later in Step d. The default is enabled.

In this field... Provide this information...

Directory service 
provider type

Select “ADAM or AD LDS” from the list. The remaining 
properties and values that you need to supply for your LDAP 
configuration depend on the type of provider that you select.

Directory service server 
host name

The directory server host name. The short name, full name, 
or IP address of the system that hosts the directory service. 

Directory service port 
number

The port number configured on the directory server host for 
communicating with the directory server.

Directory service bind 
user name

The fully qualified distinguished name of the LDAP bind 
user for authenticating to ADAM or AD LDS.

Directory service bind 
user password

The password used by the LDAP bind user to authenticate 
to the directory server. The tool encrypts the password for 
you.

Enter the password again in the Confirm field.

User base distinguished 
name

The fully qualified distinguished name of the container for 
starting a user search in ADAM or AD LDS. For example, 
ou=FileNet,dc=FNCE.

User filter The filter used by the bind user when searching for users in 
a directory server. For example, (cn={0}).

Group base 
distinguished name

JBoss only. The distinguished name of the container for 
starting a group search in a directory server. For example, 
cn=users,dc=mydomain.

Group filter The filter used by the bind user when searching for groups 
in a directory server. For example, (member={1}).

In this field... Provide this information...
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User name attribute WebSphere and WebLogic. The attribute by which a user 
logs on to Tivoli Directory Server. For example, cn.

Group attribute An attribute in a Tivoli Directory Server entry that identifies 
the group. For example, cn.

Administrative console 
user name

WebSphere only. A user account that has access to log on 
to the application server administration console. If your site 
uses a Federated LDAP registry, this account name must be 
a unique user across all federated realms. 

WebSphere LDAP 
repository type

WebSphere only. The WebSphere Application Server LDAP 
repository type. Valid values are: StandaloneLDAP / 
FederatedLDAP.

Federated Repository 
virtual realm name

WebSphere only. The name of the WebSphere Application 
Server Federated Repositories virtual realm.  The default 
name is defaultWIMFileBasedRealm.

Overwrite existing 
repository

WebSphere only. Select this check box to overwrite any 
existing LDAP repository entries. Clear this check box to 
preserve any existing LDAP repository entries. This setting 
is valid only when the Standard deployment type is selected 
for the WebSphere LDAP repository type field. The default is 
clear (do not overwrite).

Set as current active 
user registry

WebSphere only. This setting specifies whether to set the 
LDAP repository as the active user registry. When set to 
true, the LDAP information will be used to configure the 
active user registry.

Script WebSphere and WebLogic. The fully qualified path to the 
LDAP configuration task script. The task script filename 
depends on the application server type selected.

WebSphere Application Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWSLDAP.tcl  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWSLDAP.tcl.

WebLogic Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWLLDAP.py  or  
c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWLLDAP.py.

In this field... Provide this information...
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eDirectory

Temporary Directory WebSphere and WebLogic. The fully qualified path to a 
temporary directory to be used by the configuration task. 
For example, /opt/FileNet/ContentEngine/tools/
configure/tmp  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp.

SSL enabled WebSphere and WebLogic. This setting specifies whether 
Secure Sockets Layer (SSL) is enabled or disabled. Select 
the check box to enable SSL. Clear the check box to  
disable SSL. The default is disabled.

Kerberos support JBoss only. Select the Kerberos support check box if 
Kerberos authentication is used. Clear the check box if 
Kerberos authentication is not used. The default is Kerberos 
not supported.

Task enabled Select the Task enabled check box to execute the configure 
LDAP task later in Step d. The default is enabled.

In this field... Provide this information...

Directory service 
provider type

Select eDirectory from the list. The remaining properties and 
values that you need to supply for your LDAP configuration 
depend on the type of provider that you select.

Directory service server 
host name

The directory server host name. The short name, full name, 
or IP address of the system that hosts the directory service. 

Directory service port 
number

The port number configured on the directory server host for 
communicating with the directory server.

Directory service bind 
user name

The fully qualified distinguished name of the LDAP bind 
user for authenticating to eDirectory.

Directory service bind 
user password

The password used by the LDAP bind user to authenticate 
to the directory server. The tool encrypts the password for 
you.

Enter the password again in the Confirm field.

User base distinguished 
name

The fully qualified distinguished name of the container for 
starting a user search in eDirectory. For example, 
ou=FileNet,dc=FNCE.

User filter The filter used by the bind user when searching for users in 
a directory server. For example, (cn={0}).

In this field... Provide this information...
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Group base 
distinguished name

JBoss only. The distinguished name of the container for 
starting a group search in a directory server. For example, 
cn=users,dc=mydomain.

Group filter The filter used by the bind user when searching for groups 
in a directory server. For example, (member={1}).

User name attribute WebSphere and WebLogic. The attribute by which a user 
logs on to Tivoli Directory Server. For example, cn.

Group attribute An attribute in a Tivoli Directory Server entry that identifies 
the group. For example, cn.

Administrative console 
user name

WebSphere only. A user account that has access to log on 
to the application server administration console. If your site 
uses a Federated LDAP registry, this account name must be 
a unique user across all federated realms. 

WebSphere LDAP 
repository type

WebSphere only. The WebSphere Application Server LDAP 
repository type. Valid values are: StandaloneLDAP / 
FederatedLDAP.

Federated Repository 
virtual realm name

WebSphere only. The name of the WebSphere Application 
Server Federated Repositories virtual realm.  The default 
name is defaultWIMFileBasedRealm.

Overwrite existing 
repository

WebSphere only. Select this check box to overwrite any 
existing LDAP repository entries. Clear this check box to 
preserve any existing LDAP repository entries. This setting 
is valid only when the Standard deployment type is selected 
for the WebSphere LDAP repository type field. The default is 
clear (do not overwrite).

Set as current active 
user registry

WebSphere only. This setting specifies whether to set the 
LDAP repository as the active user registry. When set to 
true, the LDAP information will be used to configure the 
active user registry.

In this field... Provide this information...
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Sun Java Directory Server

Script WebSphere and WebLogic. The fully qualified path to the 
LDAP configuration task script. The task script filename 
depends on the application server type selected.

WebSphere Application Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWSLDAP.tcl  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWSLDAP.tcl.

WebLogic Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWLLDAP.py  or  
c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWLLDAP.py.

Temporary Directory WebSphere and WebLogic. The fully qualified path to a 
temporary directory to be used by the configuration task. 
For example, /opt/FileNet/ContentEngine/tools/
configure/tmp  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp.

SSL enabled WebSphere and WebLogic. This setting specifies whether 
Secure Sockets Layer (SSL) is enabled or disabled. Select 
the check box to enable SSL. Clear the check box to  
disable SSL. The default is disabled.

Kerberos support JBoss only. Select the Kerberos support check box if 
Kerberos authentication is used. Clear the check box if 
Kerberos authentication is not used. The default is Kerberos 
not supported.

Task enabled Select the Task enabled check box to execute the configure 
LDAP task later in Step d. The default is enabled.

In this field... Provide this information...

Directory service 
provider type

Select “Sun Java Directory Server” from the list. The 
remaining properties and values that you need to supply for 
your LDAP configuration depend on the type of provider that 
you select.

In this field... Provide this information...
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Directory service server 
host name

The directory server host name. The short name, full name, 
or IP address of the system that hosts the directory service. 

Directory service port 
number

The port number configured on the directory server host for 
communicating with the directory server.

Directory service bind 
user name

The fully qualified distinguished name of the LDAP bind 
user for authenticating to Sun Java Directory Server.

Directory service bind 
user password

The password used by the LDAP bind user to authenticate 
to the directory server. The tool encrypts the password for 
you.

Enter the password again in the Confirm field.

User base distinguished 
name

The fully qualified distinguished name of the container for 
starting a user search in Sun Java Directory Server. For 
example, ou=FileNet,dc=FNCE.

User filter The filter used by the bind user when searching for users in 
a directory server. For example, (cn={0}).

Group base 
distinguished name

JBoss only. The distinguished name of the container for 
starting a group search in a directory server. For example, 
cn=users,dc=mydomain.

Group filter The filter used by the bind user when searching for groups 
in a directory server. For example, (member={1}).

User name attribute WebSphere and WebLogic. The attribute by which a user 
logs on to Tivoli Directory Server. For example, cn.

Group attribute An attribute in a Tivoli Directory Server entry that identifies 
the group. For example, cn.

Administrative console 
user name

WebSphere only. A user account that has access to log on 
to the application server administration console. If your site 
uses a Federated LDAP registry, this account name must be 
a unique user across all federated realms. 

WebSphere LDAP 
repository type

WebSphere only. The WebSphere Application Server LDAP 
repository type. Valid values are: StandaloneLDAP / 
FederatedLDAP.

Federated Repository 
virtual realm name

WebSphere only. The name of the WebSphere Application 
Server Federated Repositories virtual realm.  The default 
name is defaultWIMFileBasedRealm.

In this field... Provide this information...
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Overwrite existing 
repository

WebSphere only. Select this check box to overwrite any 
existing LDAP repository entries. Clear this check box to 
preserve any existing LDAP repository entries. This setting 
is valid only when the Standard deployment type is selected 
for the WebSphere LDAP repository type field. The default is 
clear (do not overwrite).

Set as current active 
user registry

WebSphere only. This setting specifies whether to set the 
LDAP repository as the active user registry. When set to 
true, the LDAP information will be used to configure the 
active user registry.

Script WebSphere and WebLogic. The fully qualified path to the 
LDAP configuration task script. The task script filename 
depends on the application server type selected.

WebSphere Application Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWSLDAP.tcl  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWSLDAP.tcl.

WebLogic Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWLLDAP.py  or  
c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWLLDAP.py.

Temporary Directory WebSphere and WebLogic. The fully qualified path to a 
temporary directory to be used by the configuration task. 
For example, /opt/FileNet/ContentEngine/tools/
configure/tmp  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp.

SSL enabled WebSphere and WebLogic. This setting specifies whether 
Secure Sockets Layer (SSL) is enabled or disabled. Select 
the check box to enable SSL. Clear the check box to  
disable SSL. The default is disabled.

Kerberos support JBoss only. Select the Kerberos support check box if 
Kerberos authentication is used. Clear the check box if 
Kerberos authentication is not used. The default is Kerberos 
not supported.

Task enabled Select the Task enabled check box to execute the configure 
LDAP task later in Step d. The default is enabled.

In this field... Provide this information...
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c. Select File > Save to save your changes.

d. Apply the LDAP property settings by right-clicking Configure LDAP in the profile pane, and 
select Run Task. Running the configuration task can take a few minutes. The task execution 
status messages are displayed in the Console pane below the LDAP properties.

TIP  You can check the completion status of the task by right-clicking Configure LDAP in 
the profile pane, and select Check Task Status.

e. Close the Configure LDAP task pane.

5. Provide property values for Content Engine bootstrap.

a. Right-click Configure Bootstrap Properties in the profile pane, and select Edit Selected 
Task. 

b. Provide the bootstrap property values, using the following table.

In this field... Provide this information...

Content Engine EAR 
path

The fully qualified path to the Content Engine EAR file that 
was installed by the Content Engine installation program. For 
example, /opt/FileNet/ContentEngine/lib/Engine-ws.ear  or  
c:\Program Files\FileNet\ContentEngine\lib\Engine-ws.ear.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the Global Configuration Database (GCD) 
tablespace or database. For example, FNGCDDSXA.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the Global Configuration Database (GCD) tablespace 
or database. For example, FNGCDDSXA.

Bootstrapped EAR 
directory

The name of a subdirectory that will store the EAR file that 
contains the Content Engine bootstrap information. The 
bootstrap information is needed for creating the GDC and 
for starting Content Engine. Specify the directory relative to 
the ce_install_path/lib directory. For example, to specify /
opt/FileNet/ContentEngine/lib/bootstrap, enter "bootstrap".

Bootstrap user name The name of a directory server user that accesses the 
Global Configuration Database (GCD) data sources. Use 
only the short name of the bind user defined by the LDAP 
user attribute. For example, 'administrator'.

Bootstrap password The password for the directory server user that accesses the 
Global Configuration Data (GCD) data sources. The tool 
encrypts the password for you.
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c. Select File > Save to save your changes.

d. Apply the bootstrap property settings by right-clicking Configure Bootstrap Properties in the 
profile pane, and select Run Task. Running the configuration task can take a few minutes. 
The task execution status messages are displayed in the Console pane below the bootstrap 
properties.

TIP  You can check the completion status of the task by right-clicking Configure Bootstrap 
Properties in the profile pane, and select Check Task Status.

e. Close the Configure Bootstrap task pane.

6. Continue at “Install the latest Content Search Engine Client files on Content Engine servers” on 
page 390.

Configure instances using the command line interface
In this subtopic you will configure a Content Engine Server instance on a given application server 
using the command-line version of Configuration Manager. Configuring a Content Engine instance 
involves four major steps, which are documented in detail in the procedural subtopics that follow. 
You must repeat all these steps to configure each Content Engine Server instance:

1. Generate the configuration XML files that contain the properties and values used to perform 
various tasks required to configure the environment for a Content Engine instance. See 
“Generate the configuration XML files for a Content Engine instance” on page 66.

Master key A word or phrase of any length that is used to encrypt 
sensitive GCD entries. The tool encrypts the password for 
you.

The master key is used to configure the GCD settings for 
the Content Engine bootstrap settings. Store the master key 
in a secure location, as it is not retrievable. You will have to 
specify it later any time you access the GCD with 
applications built with non-FileNet APIs. 

Web Services HTTP port The Content Engine Web Services HTTP port number. The 
Content Engine Web Service (CEWS) is an industry 
standards-conformant SOAP interface to the FileNet 
Content Engine. It allows applications to access most of the 
functionality available through the Content Engine APIs. 
The default is 9080. For a cluster deployment, this port 
number must be the same value on each server in the 
cluster. 

Task enabled Select the Task enabled check box to execute the configure 
bootstrap task in Step d.The default is enabled.

In this field... Provide this information...
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2. Edit the configuration XML files by inserting your site’s properties and values. See “Edit the 
configuration XML files for a Content Engine instance” on page 69. 

3. Execute the configuration XML files you edited. See “Execute the configuration XML files for a 
Content Engine instance” on page 70.

4. Check that the configuration XML files that you executed have resulted in a correct configuration 
of the Content Engine instance. See “Check the completion status of Content Engine configuration 
tasks” on page 72.

If you are deploying multiple Content Engine instances on the same machine, you will need to 
generate, edit, and deploy a complete set of configuration files for each instance. Store the 
configuration files for each instance in a separate directory.

You can navigate through the steps above by generating all the configuration XML files before 
editing, executing, or verifying any of them; or you can generate, edit, execute, and verify one file 
at a time.

TIP The following subtopic refers to Configuration Manager as configmgr. When you run the tool, 
substitute configmgr.sh (on UNIX) or configmgr.bat (on Windows) in place of configmgr, 
depending on your operating system.

Generate the configuration XML files for a Content Engine instance
The following table lists the configuration XML files that you will generate using Configuration 
Manager:

File Name Description

configurejdbc.xml Settings for configuring JDBC connections to the databases 
used by Content Engine. You will need to generate, edit, and 
execute the configure the JDBC task once for the data source 
for the Global Configuration Data (GCD) and once for the data 
source for each object store.

configureldap.xml Settings for connecting to and searching within a directory 
server

configurebootstrap.xml Settings for creating the Global Configuration Data (GCD) and 
starting Content Engine

deployapplication.xml Settings for deploying a Content Engine instance

configureapplicationserver.xml Parent file of the above listed configuration XML files that 
points to each configuration file. This file is created only if you 
generate all the configuration files at once instead of 
individually.

applicationserver.xml Settings for the application server, including the location of 
the application server software and the name of the server. 
This file is generated when any other configuration file is 
generated (either all at once or individually) and is used by all 
of the configuration tasks.
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You can generate the configuration XML files, in either of two ways:

• Run the tool multiple times, generating one configuration XML file at a time.

• Run the tool once to generate a “parent” file, configureapplicationserver.xml, and 
automatically generate all the configuration XML files. The parent file points to the individual 
configuration XML files.

Running the tool also generates the applicationserver.xml file (used in several configuration 
tasks). Subsequent executions of the tool will not overwrite applicationserver.xml.

To generate configuration XML files

1. Set the current directory to ce_install_path/tools/configure.

2. At the command prompt, run Configuration Manager to generate the configuration XML files all 
at once (Step a) or one at a time (Step b).

See “Configuration Manager command-line reference” on page 695 for details on Configuration 
Manager syntax.

a. To generate all the configuration files at once with a parent configuration file, run the 
following command. Do not type any line breaks when you type the command.

configmgr generateConfig -appserver app_server_type -db db_type 
-ldap ldap_type -deploy deploy_type -task ConfigureApplicationServer -path mypath

where:

app_server_type is WebSphere, WebLogic, or JBoss.

db_type specifies the type of database to be used by Content Engine and must be one of 
the following: mssql, oracle, oracle_rac, db2, or db2zos.

ldap_type specifies the type of directory service repository Content Engine uses for 
authenticating users and must be one of the following: activedirectory, adam, edirectory, 
sunjava, or tivoli. The adam option applies to both Microsoft ADAM and AD LDS. 

deploy_type  specifies the type of Content Engine deployment. The value must be one of 
the following: standard, cluster, or netdeploy (network deployment). Specify standard if 
you are deploying Content Engine to a standalone (that is, a server that is neither 
managed nor clustered) WebSphere, WebLogic, or JBoss application server. Specify 
cluster if you are deploying Content Engine to a WebSphere, WebLogic, or JBoss 
application server cluster. Specify netdeploy if you are deploying Content Engine to a 
managed WebSphere application server instance (using Network Deployment for 
managing individual servers that are not necessarily in a cluster).

-path mypath is optional and specifies the path to where the generated configuration XML 
files will be placed. If you are deploying multiple Content Engine instances on the same 
machine, you will need to specify a separate directory for each instance.

For example, the following command generates all the configuration XML files for a 
standard WebSphere deployment using Tivoli Directory Server and DB2 in the  
ce_install_path/tools/configure/wstdb2 path:
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configmgr generateConfig -appserver WebSphere -db db2 -ldap tivoli 
-deploy standard -task ConfigureApplicationServer -path wstdb2

Continue at “Edit the configuration XML files for a Content Engine instance” on page 69.

b. To generate a single configuration XML file, run the command in one of the following 
substeps:

• To generate the configurejdbc.xml file:

configmgr generateConfig -appserver app_server_type -db db_type 
-ldap ldap_type -deploy deploy_type -task ConfigureJDBC -path mypath

• To generate the configureldap.xml file:

configmgr generateConfig -appserver app_server_type -db db_type 
-ldap ldap_type -deploy deploy_type -task ConfigureLDAP -path mypath

• To generate the configurebootstrap.xml file:

configmgr generateConfig -appserver app_server_type -db db_type 
-ldap ldap_type -deploy deploy_type -task ConfigureBootstrap -path mypath

where:

app_server_type is WebSphere, WebLogic, or JBoss.

db_type specifies the type of database to be used by Content Engine and must be one of 
the following: mssql, oracle, oracle_rac, db2, or db2zos.

ldap_type specifies the type of directory service repository Content Engine uses for 
authenticating users and must be one of the following: activedirectory, adam, edirectory, 
sunjava, or tivoli. The adam option applies to both Microsoft ADAM and AD LDS. 

deploy_type  specifies the type of Content Engine deployment. The value must be one of 
the following: standard, cluster, or netdeploy (network deployment). Specify standard if 
you are deploying Content Engine to a standalone (that is, a server that is neither 
managed nor clustered) WebSphere, WebLogic, or JBoss application server. Specify 
cluster if you are deploying Content Engine to a WebSphere, WebLogic, or JBoss 
application server cluster. Specify netdeploy if you are deploying Content Engine to a 
managed WebSphere application server instance (using Network Deployment for 
managing individual servers that are not necessarily in a cluster).

-path mypath is optional and specifies the path to where the generated configuration XML 
files will be placed. If you are deploying multiple Content Engine instances on the same 
machine, you will need to specify a separate directory for each instance.

Repeat Step b to generate one of the other configuration XML files, or continue at “Edit the 
configuration XML files for a Content Engine instance” on page 69. 

You will eventually need to generate each of the configuration XML files to configure a 
Content Engine instance.
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Edit the configuration XML files for a Content Engine instance
Complete the following procedure for each file you generated in “Generate the configuration XML 
files for a Content Engine instance” on page 66 to insert your site’s properties and values. Use the 
information in your worksheet to specify the values for the parameters required to configure Content 
Engine. For more information, see “Installation and upgrade worksheet” on page 229 of Plan and 
Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following actions to quickly see only the 
properties you must specify for Configuration Manager:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select one of these Configuration Manager options:

– CM: Set Application Server properties

– CM: Configure JDBC Data Sources

– CM: Configure LDAP

– CM: Configure Bootstrap Properties

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify: Setup Type contains "Upgrade".

• Click the AutoFilter drop-down arrow in all other column headers and select (All).

To edit values in the configuration XML files

1. Use a text editor or XML editor to open one of the following configuration XML files that you 
generated in “Generate the configuration XML files for a Content Engine instance” on page 66:

• configurejdbc.xml

• configureldap.xml

• configurebootstrap.xml

• applicationserver.xml

If you generated all the files at once with the ConfigureApplicationServer task in “Generate the 
configuration XML files for a Content Engine instance” on page 66, you will also have generated the 
deployapplication.xml file. You will open this file for editing in “Deploy Content Engine 
instances” on page 78.

2. Make the following changes to each XML configuration file:

a. Replace each occurrence of ****INSERT VALUE**** with a value appropriate for your site. 
Refer to the descriptions in the file for more information.

b. Verify that the default values for the remaining properties are correct for your site. 

NOTE If you previously specified values in the configureldap.xml file to add a realm 
to a federated repository, and want to put an additional realm in the repository, replace the 
previous values with the values for the additional realm.
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c. Set the <TaskEnabled> value to true in any configuration XML file you edit if you want to run 
the configuration task in “Execute the configuration XML files for a Content Engine instance” on 
page 70.

3. (Optional, WebSphere only) If you have previously created XA and non-XA data sources that 
you want to use for the Global Configuration Data (GCD) database, make the following edits:

a. In the configurejdbc.xml file, set the <TaskEnabled> value to false to avoid creating 
another pair (XA and non-XA) of data sources.

b. In the configurebootstrap.xml file, set the <JDBCDataSourceXAFileName> and 
<JDBCDataSourceFileName> values to the XA and non-XA JNDI names, respectively, 
associated with the Global Configuration Database (GCD) database.

4.  (Optional) Encrypt any passwords that you need to insert into the file by running the password 
encryption utility (see “To encrypt a password for Configuration Manager” on page 700), and then 
copy the encrypted value into the file. It is a best practice to encrypt the passwords for the 
following accounts:

• The application server administrator account used in applicationserver.xml

• The database administrator account used in configurejdbc.xml

• The LDAP provider service principal account used in configureldap.xml

• The master key—a word or phrase for encrypting sensitive FileNet P8 Global Configuration Data 
(GCD) entries—used in configurebootstrap.xml.

IMPORTANT  Any password you do not encrypt will be stored and sent as clear text.

5. Save your edits.

6. Continue at one of the following procedures:

• Repeat Step 1 through Step 5 of this procedure for any other configuration XML file that you have 
not yet edited. 

• Continue at “Execute the configuration XML files for a Content Engine instance” on page 70 to 
execute a configuration XML file(s) you have edited.

• Return to “Generate the configuration XML files for a Content Engine instance” on page 66 to 
generate additional configuration XML files.

Execute the configuration XML files for a Content Engine instance
After you have generated and edited the configuration XML files for a Content Engine instance, 
you need to apply the settings by executing the tasks. 

• Any task with the <TaskEnabled> element value set to false will not run (see Step 2 on page 69 
in “To edit values in the configuration XML files” on page 69).

• If you are executing tasks for a profile that was created or edited in the Configuration Manager 
GUI, verify that the XML files contain values for the required passwords. See “Handling 
passwords in Configuration Manager” on page 643 for more information.
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To execute the configuration XML file settings

1. Start or stop the application server, depending on its type:

WebSphere and WebLogic

Start the application server if it is not already running.

JBoss

Stop the application server.

2. Set the current directory to ce_install_path/tools/configure.

3. At the command prompt, run Configuration Manager to execute the configuration XML files all at 
once (Step a) or one at a time (Step b). See “Configuration Manager command-line reference” on 
page 695 for command syntax details.

When running the tool, the -path mypath parameter is optional and specifies where you 
placed the configuration XML file. If you do not specify a path, the file must be in 
ce_install_path/tools/configure/profiles.

a. To execute all the configuration files at once with a parent configuration file, run the following 
command.

configmgr execute -task ConfigureApplicationServer -path mypath

where -path mypath is optional and specifies the path to the generated configuration XML 
files. 

NOTES 

• To execute all tasks at once, you must have generated all the files at once with the 
ConfigureApplicationServer task in “Generate the configuration XML files for a Content 
Engine instance” on page 66.

• If you did not enable the deployment task in the deployapplication.xml file, the tool 
will display an informational message indicating that the deployment did not occur. In 
which case, you will complete the deployment in “Deploy Content Engine instances” on 
page 78.

b. To execute a single configuration XML file, type and run the command in one of the following 
substeps. You can execute the files in any order.

• To execute the configurejdbc.xml file:

configmgr execute -task ConfigureJDBC -path mypath

• To execute the configureldap.xml file:

configmgr execute -task ConfigureLDAP -path mypath

• To execute the configurebootstrap.xml file:

configmgr execute -task ConfigureBootstrap -path mypath

where -path mypath is optional and specifies the path to the generated configuration XML 
files. 
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TIP  If you generated a complete set of XML files, but want to execute the files individually, 
you only need to execute the three files listed above. You cannot execute the 
applicationserver.xml file or the ConfigureApplicationServer.xml file. The values 
in the applicationserver.xml file are used to identify the application server for the 
other execution tasks. The ConfigureApplicationServer.xml file is a parent file that 
lists the tasks to execute when you execute all the configuration files at once.

Repeat Step b to execute one of the other configuration XML files, or continue at “Check the 
completion status of Content Engine configuration tasks” on page 72. 

You will eventually need to execute each of the configuration XML files to complete the 
configuration of a Content Engine instance.

IMPORTANT You must run the ConfigureJDBC task at least 2 times to configure the 
minimum data sources. First enter the Global Configuration Database (GCD) data source 
values, save, and run the task. Then, enter the object store data source values, save, and 
run the task again. You will need to edit and run the ConfigureJDBC task once for each 
additional object store.

4. Continue at “Check the configuration status of a Content Engine instance” on page 93.

Check the completion status of Content Engine configuration tasks
Use the procedure in this subtopic to verify that one or more Content Engine configuration tasks 
that you executed in “Execute the configuration XML files for a Content Engine instance” on page 70 
have completed. You can check the status of all the tasks you executed or just check individual 
tasks.

Checking the completion status does not validate the information in the XML files.

To check the status of a Content Engine configuration

1. At the command prompt, run Configuration Manager to check the status of the configuration 
tasks all at once (Step a) or one at a time (Step b).

When running the tool, the -path mypath parameter is optional and specifies where you 
placed the configuration XML file. If you do not specify a path, the file must be in 
ce_install_path/tools/configure/profiles.

See “Configuration Manager command-line reference” on page 695 for command syntax details.

a. To check the status of all the configuration tasks at once, run the following command:

configmgr checkStatus -task ConfigureApplicationServer -path mypath

NOTE To check the status of all tasks at once, you must have generated all the files at 
once with the ConfigureApplicationServer task in “Generate the configuration XML files for a 
Content Engine instance” on page 66.

Continue at Step 3.
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b. To check the completion status of a single configuration task, run the tool in one of the 
following substeps. 

• To check the status of the ConfigureJDBC task using the configuration file in the 
specified path:

configmgr checkStatus -task ConfigureJDBC -path mypath

• To check the status of the ConfigureLDAP task using the configuration file in the 
specified path:

configmgr checkStatus -task ConfigureLDAP -path mypath

• To check the status of the ConfigureBoostrap task using the configuration file in the 
specified path:

configmgr checkStatus -task ConfigureBootstrap -path mypath

If you performed Step b, repeat the step to check the status of any other configuration tasks you have 
executed; otherwise, continue at Step 2.

2. Continue at one of the following procedures, as needed; otherwise, continue at Step 3.

• If you have any other configuration tasks to execute, continue at “Execute the configuration XML 
files for a Content Engine instance” on page 70.

• If you have any other configuration XML files to generate, continue at “Generate the configuration 
XML files for a Content Engine instance” on page 66.

• If you want to add a realm to a federated repository, continue at “Edit the configuration XML files for 
a Content Engine instance” on page 69.

3. Continue at “Install the latest Content Search Engine Client files on Content Engine servers” on 
page 390.
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Task 5: Install the latest Content Search Engine Client 
files on Content Engine servers
To install the latest Content Search Engine Client files, perform the following procedure for each 
Content Engine instance you configured in “Configure Content Engine instances” on page 37.

To install the latest Content Search Engine Client files

1. Locate the Content Search Engine fix pack software for your Content Engine platform. For 
example, if Content Engine runs on Windows, locate the fix pack software that runs on Windows. 
For instructions on how to obtain the latest Content Search Engine Client files, see “Access IBM 
FileNet documentation, compatibility matrices, and fix packs” on page 20.

2. Open the readme file for the latest IBM FileNet P8 Content Search Engine 4.5.0 fix pack and 
perform the installation procedures in the Content Search Engine Client section of the file.

3. Continue at “Install the latest Process Engine Client files on Content Engine servers” on page 75.
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Task 6: Install the latest Process Engine Client files on 
Content Engine servers
To install the Process Engine Client files, perform the following steps on all application server 
machines where Content Engine Server is to be deployed. Except where noted, these steps apply 
to WebSphere, WebLogic, and JBoss.

To install the Process Engine Client files

1. On the machine where Content Engine is to be deployed, log on as ce_install_user.

2. Locate the Process Engine Client install software. The version of the Process Engine client 
software must match the version of Process Engine software.

3. Expand the (TAR or ZIP) Process Engine Client install software.

4. Install the software, either interactively or silently. 

For both interactive and silent installs, refer to the appropriate information from your 
installation worksheet while performing the following steps. For information on the Process 
Engine parameter values, see “Installation and upgrade worksheet” on page 229 in Plan and 
Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to quickly see only the 
installation properties you must specify for the Process Engine client installation program:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select PE Client installer.

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify: Setup Type contains "Installation."

• Click the AutoFilter drop-down arrow in all other column headers and select (All).

To run the program interactively, perform the following steps. To install silently, see page 77.

a. From the table below, run the command appropriate for your operating system, and follow 
the wizard instructions:

Operating System Install Program

AIX P8PE-CLIENT-4.5.0-AIX.BIN

HPUX P8PE-CLIENT-4.5.0-HPUX.BIN

HPUXi P8PE-CLIENT-4.5.0-HPUXI.BIN

Linux P8PE-CLIENT-4.5.0-LINUX.BIN

Solaris P8PE-CLIENT-4.5.0-SOL.BIN

Windows P8PE-CLIENT-4.5.0-WIN.EXE

zLinux P8PE-CLIENT-4.5.0-ZLINUX.BIN
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b. Complete the Process Engine client install screens, as follows:

In this screen... Perform this action...

Welcome to Process 
Engine Client Installer

Click Next to proceed with the installation.

NOTE Click Previous at any time to make changes in 
previous screens. Click Cancel to exit the program.

Specify Installation 
Location

Choose the destination directory for Process Engine Client 
log files and uninstallation files. Accept the default location 
or click Browse to change the location. 

Select FileNet P8 
Applications

Select Content Engine as the product for which you would 
like to install Process Engine Client files.

Click Next to continue.

Specify the EAR file to 
update

Specify the bootstrapped Content Engine EAR file to update 
with the new Process Engine client files. The default path in 
the installer does not point to the correct path for the 
boostrapped EAR file. Change the path in the installer to 
point to the bootstrapped EAR file. Default paths to the 
bootstrapped EAR files are:

UNIX

/opt/FileNet/ContentEngine/lib/bootstrap_dir

Windows

C:\Program Files\FileNet\ContentEngine\lib\bootstrap_dir

where bootstrap_dir is the directory that contains the 
bootstrap EAR file.

Specify the file that was bootstrapped during Configuration 
Manager configuration steps.

Valid options for the EAR file are:

• Engine-jb.ear

• Engine-jbc.ear

• Engine-wl.ear

• Engine-ws.ear
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To run the program silently, perform the following steps:

a. In the expanded install software, open the file PEClient_silent_install.txt and edit it 
as follows:

i. Change the Variable_CheckboxCE line to the following:

-V Variable_CheckboxCE="true"

ii. Save your edit.

b. From the table below, run the command appropriate for your operating system to perform the 
silent install:

Content Engine 
Installation Path

Enter the full path to the Content Engine installation 
location. The defaults are as follows:

UNIX

/opt/FileNet/ContentEngine

Windows

C:\Program Files\FileNet\ContentEngine

Click Next to continue.

Stop running BPM 
software

If the installer detects running BPM software components, 
click Next to stop the software and continue with the 
installation.

Review Pre-Installation 
Summary 

Verify your component selections, and click Install to start 
installing Process Engine Client.

Operating System Install Program

AIX P8PE-CLIENT-4.5.0-AIX.BIN -silent -options 
"PEClient_silent_install.txt" 

HPUX P8PE-CLIENT-4.5.0-HPUX.BIN -silent -options 
"PEClient_silent_install.txt" 

HPUXi P8PE-CLIENT-4.5.0-HPUXI.BIN -silent -options 
"PEClient_silent_install.txt"

Linux P8PE-CLIENT-4.5.0-LINUX.BIN -silent -options 
"PEClient_silent_install.txt" 

Solaris P8PE-CLIENT-4.5.0-SOL.BIN -silent -options 
"PEClient_silent_install.txt" 

Windows P8PE-CLIENT-4.5.0-WIN.EXE -silent -options 
"PEClient_silent_install.txt" 

zLinux P8PE-CLIENT-4.5.0-ZLINUX.BIN -silent -options 
"PEClient_silent_install.txt" 

In this screen... Perform this action...
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Task 7: Deploy Content Engine instances
To deploy one or more instances of Content Engine, complete the procedures in this topic after 
you have completed the configuration tasks in “Configure Content Engine instances” on page 37.

Complete the procedures in one of the following subtopics:

• “Deploy instances using the Configuration Manager graphical user interface” on page 78

• “Deploy instances using the Configuration Manager command line interface” on page 90

Use the command line version of Configuration Manager if either of these conditions is true:

– Your system is Novell SUSE Linux Enterprise 9. You can configure Content Engine only 
with the command line.

– You need an accessible software version of Configuration Manager for people with 
disabilities to use.

Deploy instances using the Configuration Manager graphical user 
interface
Use the procedure in this subtopic to deploy a Content Engine Server instance on an application 
server using the Configuration Manager’s graphical user interface. Use the information in your 
installation worksheet to specify the values that are required to configure Content Engine. For more 
information, see “Installation and upgrade worksheet” on page 229 of Plan and Prepare Your 
Environment for IBM FileNet P8.

For more information on the properties that you set in the Configuration Manager, roll your mouse 
over the property name to view the tool tip help for the property. Refer to the appendix 
“Configuration Manager user interface reference” on page 645 for complete information on using the 
graphical user interface.

To deploy a Content Engine instance using the Configuration Manager graphical user interface

1. Log on to the application server where you installed the Content Engine software as 
config_mgr_user, the Configuration Manager user. For details on required accounts and related 
permissions, see “Accounts for Content Engine” on page 71 in Plan and Prepare Your Environment 
for IBM FileNet P8.

2. Start Configuration Manager by completing one of the following steps:

UNIX

ce_install_path/tools/configure/CMUI/cmui

 where ce_install_path is the path to the Content Engine Server software.
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Windows

Complete one of the following actions:

• Double-click the FileNet Configuration Manager desktop shortcut. 

• Select Start > All Programs > IBM FileNet P8 Platform > FileNet Configuration Manager. 

• Run ce_install_path\tools\configure\CMUI\cmui.exe.

 where ce_install_path is the path to the Content Engine Server software.

3. Refer to your installation worksheet to specify the values for the properties required for your new 
profile. For more information, see “Installation and upgrade worksheet” on page 229 of Plan and 
Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), complete the following actions to quickly see only the 
properties you must specify for Configuration Manager:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select “CM: Deploy Application”.

• Click the AutoFilter drop-down arrow in all other column headers and select (All).

4. Select File > Open Configuration Profile.  

5. In the Open Configuration Profile wizard, enter the path to the profile for the Content Engine 
instance that you configured in “Configure Content Engine instances” on page 37, or click Browse 
to locate the profile directory, and then click Finish.

6. Right-click the Deploy Application task in the profile pane (left pane), and select Edit Selected 
Task.

7. Provide the property values for your deployment, using the appropriate table for your 
deployment type:

WebSphere Standard 

In this field... Provide this information...

Deployment type Select “Standard” from the list. The remaining properties that are 
displayed depend on the type of deployment that you select.
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Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
ws.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
ws.ear

Content Engine 
Application name

The Content Engine application name as it will appear in the 
application server (for example, in an administration console). 
The application name is subject to application server naming 
constraints. For WebSphere Application Server, each 
application in a cell must have unique name. The default is 
FileNetEngine. 

Application server name The name of the WebSphere Application Server where Content 
Engine will be deployed.

Application server node The name of the WebSphere Application Server node where 
Content Engine will be deployed.

Script The fully qualified path to the deploy configuration task script. 
The task script filename depends on the application server type 
selected. For example: 

UNIX

/opt/FileNet/ContentEngine/tools/configure/
scripts/deployWSApplication.tcl

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s\deployWSApplication.tcl

In this field... Provide this information...
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Temporary directory The fully qualified path to a temporary directory to be used by 
the configuration task. For example:

UNIX

/opt/FileNet/ContentEngine/tools/configure/tmp 

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp

Task enabled Select the Task enabled check box to execute the deploy 
application task later in Step 9. The default is disabled.

Continue with Step 8 on page 90.

In this field... Provide this information...
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WebSphere Cluster 

In this field... Provide this information...

Deployment type Select “Cluster” from the list. The remaining properties that are 
displayed depend on the type of deployment that you select.

Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
ws.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
ws.ear

Content Engine 
Application name

The Content Engine application name as it will appear in the 
application server (for example, in an administration console). 
The application name is subject to application server naming 
constraints. For WebSphere Application Server, each 
application in a cell must have unique name. The default is 
FileNetEngine. 

Application server cluster 
name

The name of the WebSphere Application Server cluster where 
Content Engine will be deployed.

Script The fully qualified path to the deploy configuration task script. 
The task script filename depends on the application server type 
selected. For example: 

UNIX

/opt/FileNet/ContentEngine/tools/configure/scripts
/deployWSApplication.tcl

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\deployWSApplication.tcl
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WebSphere Network Deployment 

Temporary directory The fully qualified path to a temporary directory to be used by 
the configuration task. For example:

UNIX

/opt/FileNet/ContentEngine/tools/configure/tmp 

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp

Task enabled Select the Task enabled check box to execute the deploy 
application task later in Step 9. The default is disabled.

Continue with Step 8 on page 90.

In this field... Provide this information...

Deployment type Select “Network Deployment” from the list. The remaining 
properties that are displayed depend on the type of deployment 
that you select.

Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
ws.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
ws.ear

Content Engine 
Application name

The Content Engine application name as it will appear in the 
application server (for example, in an administration console). 
The application name is subject to application server naming 
constraints. For WebSphere Application Server, each 
application in a cell must have unique name. The default is 
FileNetEngine. 

Application server name The name of the WebSphere Application Server where Content 
Engine will be deployed.

In this field... Provide this information...
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JBoss Standard 

Application server node The name of the WebSphere Application Server node where 
Content Engine will be deployed.

Script The fully qualified path to the deploy configuration task script. 
The task script filename depends on the application server type 
selected. For example: 

UNIX

/opt/FileNet/ContentEngine/tools/configure/scripts
/deployWSApplication.tcl

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\deployWSApplication.tcl

Temporary directory The fully qualified path to a temporary directory to be used by 
the configuration task. For example:

UNIX

/opt/FileNet/ContentEngine/tools/configure/tmp 

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp

Task enabled Select the Task enabled check box to execute the deploy 
application task later in Step 9. The default is disabled.

Continue with Step 8 on page 90.

In this field... Provide this information...

Deployment type Select “Standard” from the list. The remaining properties that are 
displayed depend on the type of deployment that you select.

In this field... Provide this information...
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Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
jb.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
jb.ear

Kerberos support This setting specifies whether Kerberos 
authentication is used. Select the Kerberos support 
check box if Kerberos authentication is used. Clear 
the check box if Kerberos authentication is not 
used. The default is Kerberos not supported.

Task enabled Select the Task enabled check box to execute the deploy 
application task later in Step 9. The default is disabled.

In this field... Provide this information...
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JBoss Cluster 

WebLogic Standard 

In this field... Provide this information...

Deployment type Select “Cluster” from the list. The remaining properties that are 
displayed depend on the type of deployment that you select.

Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
jbc.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
jbc.ear

Kerberos support This setting specifies whether Kerberos 
authentication is used. Select the Kerberos support 
check box if Kerberos authentication is used. Clear 
the check box if Kerberos authentication is not 
used. The default is Kerberos not supported.

Task enabled Select the Task enabled check box to execute the deploy 
application task later in Step 9. The default is disabled.

Continue with Step 8 on page 90.

In this field... Provide this information...

Deployment type Select “Standard” from the list. The remaining properties that are 
displayed depend on the type of deployment that you select.
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Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
wl.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
wl.ear

Content Engine 
Application name

The Content Engine application name as it will appear in the 
application server (for example, in an administration console). 
The application name is subject to application server naming 
constraints. For WebSphere Application Server, each 
application in a cell must have unique name. The default is 
FileNetEngine. 

Script The fully qualified path to the deploy configuration task script. 
The task script filename depends on the application server type 
selected. For example: 

UNIX

/opt/FileNet/ContentEngine/tools/configure/scripts
/deployWLApplication.py

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\deployWLApplication.py

Temporary directory The fully qualified path to a temporary directory to be used by 
the configuration task. For example:

UNIX

/opt/FileNet/ContentEngine/tools/configure/tmp 

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp

In this field... Provide this information...
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Task enabled Select the Task enabled check box to execute the deploy 
application task later in Step 9. The default is disabled.

Continue with Step 8 on page 90.

In this field... Provide this information...
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WebLogic Cluster 

In this field... Provide this information...

Deployment type Select “Cluster” from the list. The remaining properties that are 
displayed depend on the type of deployment that you select.

Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
wl.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
wl.ear

Content Engine 
Application name

The Content Engine application name as it will appear in the 
application server (for example, in an administration console). 
The application name is subject to application server naming 
constraints. For WebSphere Application Server, each 
application in a cell must have unique name. The default is 
FileNetEngine. 

Script The fully qualified path to the deploy configuration task script. 
The task script filename depends on the application server type 
selected. For example: 

UNIX

/opt/FileNet/ContentEngine/tools/configure/scripts
/deployWLApplication.py

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\deployWLApplication.py
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8. Select File > Save.

9. Right-click the Deploy Application task in the left pane, and select Run Task.

Running the deploy task may take a few minutes. The task execution status messages are 
displayed in the Console pane below the deploy application properties.

10. Continue at “Complete Content Engine post-deployment steps” on page 106.

Deploy instances using the Configuration Manager command line 
interface
Use the procedure in this subtopic to deploy a Content Engine Server instance on an application 
server using the Configuration Manager’s command-line interface. Deploying a Content Engine 
Server instance involves four major steps:

1. Generate the deploy-application XML file, deployapplication.xml. See “Generate the 
deployapplication.xml file” on page 91.

2. Edit the deployapplication.xml file by inserting your site’s values. See “Edit the configuration 
files for a Content Engine instance” on page 91.

3. Execute the deployapplication.xml file. See “Execute the deployapplication.xml file for a 
Content Engine instance” on page 93.

4. Check that the deployapplication.xml file has resulted in a correct deployment of the 
Content Engine instance. See “Check the configuration status of a Content Engine instance” on 
page 93.

If you are deploying multiple Content Engine instances on the same machine, you must generate, 
edit, and execute a deployapplication.xml file for each instance. Store each 
deployapplication.xml file in a separate directory.

Temporary directory The fully qualified path to a temporary directory to be used by 
the configuration task. For example:

UNIX

/opt/FileNet/ContentEngine/tools/configure/tmp 

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp

Task enabled Select the Task enabled check box to execute the deploy 
application task later in Step 9. The default is disabled.

Continue with Step 8 on page 90.

In this field... Provide this information...
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NOTE This subtopic refers to the Configuration Manager tool as configmgr. When you run the tool, 
substitute configmgr.sh (on UNIX) or configmgr.bat (on Windows) in place of configmgr, 
depending on your operating system.

Generate the deployapplication.xml file
The deployapplication.xml file is created when you generate all files at once or when you 
generate the XML files for a single task using the -task DeployApplication switch. If you did not 
create the deployapplication.xml file in “Configure Content Engine instances” on page 37, 
complete the following procedure for the Content Engine instance you are deploying; otherwise, 
skip to “To edit the values in the configuration XML files” on page 91.

To generate the deployapplication.xml file

1. Log on to the application server machine as config_mgr_user, the user who will run 
Configuration Manager. For details on required accounts and related permissions, see 
“Accounts for Content Engine” on page 71 in Plan and Prepare Your Environment for IBM 
FileNet P8.

2. Set the current directory to ce_install_path/tools/configure, where:

ce_install_path is the path where you installed Content Engine.

3. Run the following command without carriage returns to generate the applicationserver.xml file 
and the deployapplication.xml file:

configmgr generateConfig -appserver app_server_type -deploy deploy_type 
-task DeployApplication -path mypath

where:

app_server_type specifies the type of application server: WebSphere, WebLogic, or JBoss.

deploy_type indicates one of the following deployment types: standard, cluster, or netdeploy 
(network deployment). The netdeploy value applies only to Content Engine deployment on 
WebSphere.

-path mypath is optional and specifies the path for the XML files. If you do not specify a path, 
the files will be placed in the ce_install_path/tools/configure/profiles directory.

If you are deploying multiple Content Engine instances on the same machine, you must 
specify a separate path for each instance.

See “Configuration Manager command-line reference” on page 695 for configmgr syntax details.

Edit the configuration files for a Content Engine instance
Complete the following procedure to insert your site’s values into the configuration XML files.

To edit the values in the configuration XML files

1. If you have not already edited the applicationserver.xml file in “Configure Content Engine 
instances” on page 37, set the application server property values for your site.

a. Use a text editor or XML editor to open the applicationserver.xml file.
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b. Edit the values in the applicationserver.xml file as appropriate for your site. Refer to 
the descriptions in the file and to the values in your installation worksheet. For more 
information, see “Installation and upgrade worksheet” on page 229 of Plan and Prepare Your 
Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls), complete the following steps to quickly see 
only the installation properties you must specify for deploying Content Engine:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select “CM: Set Application Server Properties.”

• Click the AutoFilter drop-down arrow in all other column headers and select (All).

c. Save your edits.

2. Set the deployment property values for your site.

a. Use a text editor or XML editor to open the deployapplication.xml file.

b. Edit the values in the deployapplication.xml file as appropriate for your site. Refer to 
the descriptions in the file and to the values in your installation worksheet. For more 
information, see “Installation and upgrade worksheet” on page 229 of Plan and Prepare Your 
Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls), complete the following steps to quickly see 
only the installation properties you must specify for deploying Content Engine:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select “CM: Deploy Application.”

• Click the AutoFilter drop-down arrow in all other column headers and select (All).

In particular, complete the following substeps as applicable:

i. By default, the value inside the <TaskEnabled> element in the 
deployapplication.xml file is set to false. For deployment to occur, set the value to 
true.

ii. Verify that the default parameter values are correct for your site.

iii. (WebSphere only) Specify values for the following XML element values that apply to your 
deployment type:

• For standard deployment or network deployment, specify values for 
<applicationservername> and <applicationservernode>

• For cluster deployment, specify values for <applicationservername>, 
<applicationservernode>, and <applicationserverclustername>

iv. Save your edits.

3. Continue at “Execute the deployapplication.xml file for a Content Engine instance” on page 93.
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Execute the deployapplication.xml file for a Content Engine instance
Complete the procedure in this subtopic to execute the settings in the deployapplication.xml 
file.

To execute the deployapplication.xml file settings

1. Set the current directory to ce_install_path/tools/configure, where:

ce_install_path is the path where you installed Content Engine server software.

2. At the command prompt, run Configuration Manager to execute the deployapplication.xml 
file.

NOTE If you did not enable the deployment task in the deployapplication.xml file, the tool 
will display an informational message indicating that the deployment did not occur.

configmgr execute -task DeployApplication -path mypath

The -path mypath entry is optional and specifies the path where you placed 
deployapplication.xml. If you do not specify a path, the file must be in the following 
directory:

ce_install_path/tools/configure/profiles

If you are deploying multiple Content Engine instances on the same machine, you will need to 
specify a separate path to the deployapplication.xml file for each instance.

See “Configuration Manager command-line reference” on page 695 for configmgr syntax details.

3. Continue at “Check the configuration status of a Content Engine instance” on page 93.

Check the configuration status of a Content Engine instance
Use the procedure in this subtopic to check all the tasks, or just the one you executed in “Edit the 
configuration files for a Content Engine instance” on page 91.

To check the status of a Content Engine configuration

1. At the command prompt, run the following command to check the status of the deploy 
application task:

configmgr checkStatus -task DeployApplication -path mypath

The -path mypath entry is optional and specifies the path where you placed the 
deployapplication.xml file. If you do not specify a path, the file must be in the 
ce_install_path/tools/configure/profiles directory. See “Configuration Manager 
command-line reference” on page 695 for configmgr syntax details.

2. Continue at one of the following topics:

• If the Content Engine instance is deployed in a JBoss cluster, continue at “Deploy Content Engine 
to additional JBoss servers in a cluster” on page 94.

• If you have more Content Engine instances to deploy, continue at “Generate the 
deployapplication.xml file” on page 91.
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• If you have no more Content Engine instances to deploy, “Complete Content Engine post-
deployment steps” on page 106.

Deploy Content Engine to additional JBoss servers in a cluster
Use the following procedure to a deploy a Content Engine Server instance on each additional 
JBoss server in your cluster.

CAUTION Because JBoss clusters communicate state over multicast, it is critical that you 
configure clusters for Content Engine to segregate multicast traffic from each other and from other 
JBoss clusters. You can find instructions regarding JBoss cluster configuration at 
http://www.jboss.com.

To deploy Content Engine Server on additional JBoss servers in a cluster

1. Leave Content Engine deployed on the application server where you installed it.

2. Copy the following files from the initial Content Engine instance to each JBoss node you are 
setting up:

• All data source (JBoss_HOME/server/all/deploy/*-ds.xml) files created as part of the 
configuration process.

NOTE Depending on how you installed JBoss, there might be data source files not created 
by Configuration Manager, such as hsqldb-ds.xml, in the same location. Do not copy 
these files. 

• JBoss_HOME/server/all/deploy/Engine-ds.xml

• The JDBC driver in JBoss_HOME/server/all/lib

• JBoss_HOME/server/all/conf/login-config.xml

• JBoss_HOME/server/all/deploy/Engine-jbc.ear

NOTE Clustered JBoss instances are deployed from the “all” directory and not the “default” 
directory. You can find instructions regarding JBoss cluster configurations at 
http://www.jboss.com.

3. Start or restart the JBoss application server.

4. Verify that the server.log file located in the JBOSS_home/server/all/log directory lists 
deployment of the WAR or EAR file you used. If it does, then the deployment of Content Engine 
Server is successful.

5. Continue at one of the following topics:

• If you have any more Content Engine Server instances to deploy, continue at “Execute the 
deployapplication.xml file for a Content Engine instance” on page 93

• If you have no more Content Engine Server instances to deploy, continue at “Complete Content 
Engine post-deployment steps” on page 106.
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Task 8a: Install Tivoli Storage Manager client and add 
native API library paths (WebSphere)
If Tivoli Storage Manager fixed content devices will be in your IBM FileNet P8 environment, 
complete the following procedures on each application server where Content Engine is deployed. 

To install Tivoli Storage Manager client

1. Download the Tivoli Storage Manager client software from the IBM Support site http://www-
01.ibm.com/support/docview.wss?uid=swg24019757.

2. Complete the platform-specific installation instructions included with each Tivoli Storage 
Manager client download package.

(UNIX only) Record the path where you install Tivoli Storage Manager client because you will 
need to specify the path as the DSMI directory when you create a Tivoli fixed content device in 
FileNet Enterprise Manager. If you are installing Tivoli Storage Manager client on multiple 
UNIX hosts, the installation path must be the same on each host. 

On AIX, install Tivoli Storage Manager client at /usr/tivoli/tsm/client/ba/bin.

To copy the Tivoli Storage Manager API library files to additional servers

• If you are running a Content Engine server farm, copy the entire tsm100 directory structure 
from the Content Engine installation directory to each of the servers in the farm. It is a best 
practice to use the same directory structure on each server in the farm. The following are 
example paths:

UNIX

/opt/FileNet/ContentEngine/tsm100

Windows

C:\Program Files\FileNet\ContentEngine\tsm100

To create a shared library definition for Tivoli Storage Manager native API library files

1. Log on to the WebSphere administrative console.

2. Create a shared library definition according to the type of deployment (standalone or clustered), 
the version of WebSphere, and the operating system on which WebSphere runs. For the 
detailed procedure on creating the shared library, visit this web site:

http://www-01.ibm.com/software/webservers/appserv/was/library/

a. Specify a Node scope for the library.

b. In a server farm, if you installed the tsm100 directory in different locations, choose Server 
scope and add a Shared Library entry for each server in your server farm.

c. Provide a name for the shared library, for example TSMAPLIB.
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d. In the Classpath field, specify the full path to the TsmJavaApi.jar file (substituting your 
own path if it differs from the default shown here for your operating system):

UNIX

/opt/FileNet/ContentEngine/tsm100/TsmJavaApi.jar

Windows

C:\Program Files\FileNet\ContentEngine\tsm100\TsmJavaApi.jar

e. In the Native Library Path, specify the full path to the tsm100 directory (substitute your own 
path if it differs from the ones shown below):

UNIX

/opt/FileNet/ContentEngine/tsm100

Windows

C:\Program Files\FileNet\ContentEngine\tsm100

f. Save your changes to the master configuration.

g. Navigate to the FileNetEngine application and click the Shared library references link.

h. Under the Available box, select the shared library you created earlier (for example, 
TSMAPILIB) and click the right arrow to move it to the Selected box.

i. Click OK twice to return to the FileNetEngine page and save changes to the master 
configuration.
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Task 8b: Install Tivoli Storage Manager client and add 
native API library paths (WebLogic)
If Tivoli Storage Manager fixed content devices will be in your IBM FileNet P8 environment, 
complete the following procedures on each application server where Content Engine is deployed. 

To install Tivoli Storage Manager client

1. Download the Tivoli Storage Manager client software from the IBM Support site http://www-
01.ibm.com/support/docview.wss?uid=swg24019757.

(UNIX only) Record the path where you install Tivoli Storage Manager client because you will 
need to specify the path as the DSMI directory when you create a Tivoli fixed content device in 
FileNet Enterprise Manager. If you are installing Tivoli Storage Manager client on multiple 
UNIX hosts, the installation path must be the same on each host. 

On AIX, install Tivoli Storage Manager client at /usr/tivoli/tsm/client/ba/bin.

To copy the Tivoli Storage Manager API library files to additional servers

• If you are running a Content Engine server farm, copy the entire tsm100 directory structure 
from the Content Engine installation directory to each of the servers in the farm. It is a best 
practice to use the same directory structure on each server in the farm. The following are 
example paths:

UNIX

/opt/FileNet/ContentEngine/tsm100

Windows

C:\Program Files\FileNet\ContentEngine\tsm100

To create a shared library definition for Tivoli Storage Manager native API library files

1. Open in an edit window the WebLogic script that sets up the domain environment. The following 
are example paths to this script:

UNIX

/opt/bea/user_projects/domains/base_domain/bin/setDomainEnv.sh

Windows

C:\bea\user_projects\domains\base_domain\bin\setDomainEnv.cmd

2. Edit the WebLogic script by adding the lines shown below before the line in which the 
WL_HOME variable is set. Substitute your version identifier in place of weblogic92 as 
appropriate. There is no carriage return after any line that ends with ‘/’ or ‘\’.

AIX

TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
LIBPATH=${LIBPATH}:${TSMAPILIB}
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EXT_POST_CLASSPATH=${EXT_POST_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export LIBPATH EXT_POST_CLASSPATH
WL_HOME="/opt/bea/weblogic92"
export WL_HOME

HP-UX

TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
SHLIB_PATH=${SHLIB_PATH}:${TSMAPILIB}
EXT_POST_CLASSPATH=${EXT_POST_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export SHLIB_PATH EXT_POST_CLASSPATH
WL_HOME="/opt/bea/weblogic92"
export WL_HOME/opt/bea/user_projects/domains/base_domain/bin/
setDomainEnv.sh

Linux

TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
LD_LIBRARY_PATH=${LD_LIBRARY_PATH}:${TSMAPILIB}
EXT_POST_CLASSPATH=${EXT_POST_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export LD_LIBRARY_PATH EXT_POST_CLASSPATH
WL_HOME="/opt/bea/weblogic92"
export WL_HOME

Solaris

TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
LD_LIBRARY_PATH=${LD_LIBRARY_PATH}:${TSMAPILIB}
EXT_POST_CLASSPATH=${EXT_POST_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export LD_LIBRARY_PATH EXT_POST_CLASSPATH
WL_HOME="/opt/bea/weblogic92"
export WL_HOME

Solaris (64-bit)

TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
LD_LIBRARY_PATH_64=${LD_LIBRARY_PATH_64}:${TSMAPILIB}
EXT_POST_CLASSPATH=${EXT_POST_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export LD_LIBRARY_PATH_64 EXT_POST_CLASSPATH
JAVA_OPTIONS="${JAVA_OPTIONS} -d64"
export JAVA_OPTIONS
WL_HOME="/opt/bea/weblogic92"
export WL_HOME

Windows

set TSMAPILIB=C:\Program Files\FileNet\ContentEngine\tsm100
set PATH=%PATH%;%TSMAPILIB%
set EXT_POST_CLASSPATH=%EXT_POST_CLASSPATH%;%TSMAPILIB%\TsmJavaApi.jar
set WL_HOME=C:\bea\weblogic92

3. If you are using WebLogic Node Manager to start and stop WebLogic Managed Servers in a 
clustered environment, you must enable Node Manager to use the appropriate start script:

a. Open for editing the node manager configuration file WL_HOME/common/nodemanager/
nodemanager.properties.

b. Set the StartScriptEnabled property to true (default is false).

c. Set the StartScriptName to match the script name used by Node Manager to start the 
managed server, depending on your operating system:
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UNIX

StartScriptName=startManagedWebLogic.sh

Windows

StartScriptName=startManagedWebLogic.cmd

NOTE If the managed server is not on the same machine as the WebLogic Administration 
Server and you have an alternate script matching the name of the Managed Server in the 
domain bin directory, make sure to specify that script name instead of the more generic 
"startManagedWebLogic" script.

4. Save your edits in nodemanager.properties and restart the Node Manager.
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 8c: Install Tivoli Storage Manager client and add native API library paths (JBoss)
To install Tivoli Storage Manager client

100
Task 8c: Install Tivoli Storage Manager client and add 
native API library paths (JBoss)
If Tivoli Storage Manager fixed content devices will be in your IBM FileNet P8 environment, 
complete the following procedures on each application server where Content Engine is deployed. 

To install Tivoli Storage Manager client

1. Download the Tivoli Storage Manager client software from the IBM Support site http://www-
01.ibm.com/support/docview.wss?uid=swg24019757.

(UNIX only) Record the path where you install Tivoli Storage Manager client because you will 
need to specify the path as the DSMI directory when you create a Tivoli fixed content device in 
FileNet Enterprise Manager. If you are installing Tivoli Storage Manager client on multiple 
UNIX hosts, the installation path must be the same on each host. 

On AIX, install Tivoli Storage Manager client at /usr/tivoli/tsm/client/ba/bin.

To copy the Tivoli Storage Manager API libraries to additional servers

• If you are running a Content Engine server farm, copy the entire tsm100 directory structure 
from the Content Engine installation directory to each of the servers in the farm. It is a best 
practice to use the same directory structure on each server in the farm. The following are 
example paths:

UNIX

/opt/FileNet/ContentEngine/tsm100

Windows

C:\Program Files\FileNet\ContentEngine\tsm100

To create a shared library definition for Tivoli Storage Manager native API library files

1. Open in an edit window the JBoss startup script that sets up the domain environment:

UNIX

run.sh

Windows

run.bat

2. Edit the startup script by adding the following lines at the start of the script:

• AIX

TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
LIBPATH=${LIBPATH}:${TSMAPILIB}
JBOSS_CLASSPATH=${JBOSS_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export LIBPATH JBOSS_CLASSPATH
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• HP-UX

TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
SHLIB_PATH=${SHLIB_PATH}:${TSMAPILIB}
JBOSS_CLASSPATH=${JBOSS_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export SHLIB_PATH JBOSS_CLASSPATH

• Linux

TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
LD_LIBRARY_PATH=${LD_LIBRARY_PATH}:${TSMAPILIB}
JBOSS_CLASSPATH=${JBOSS_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export LD_LIBRARY_PATH JBOSS_CLASSPATH

• Solaris

TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
LD_LIBRARY_PATH=${LD_LIBRARY_PATH}:${TSMAPILIB}
JBOSS_CLASSPATH=${JBOSS_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export LD_LIBRARY_PATH JBOSS_CLASSPATH

• Solaris (64-bit)

TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
LD_LIBRARY_PATH=${LD_LIBRARY_PATH}:${TSMAPILIB}
JBOSS_CLASSPATH=${JBOSS_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export LD_LIBRARY_PATH JBOSS_CLASSPATH
JAVA_OPTS="${JAVA_OPTS} -d64"
export JAVA_OPTS

• Windows

set TSMAPILIB=C:\Program Files\FileNet\ContentEngine\tsm100
set PATH=%PATH%;%TSMAPILIB%
set JBOSS_CLASSPATH=%JBOSS_CLASSPATH%;%TSMAPILIB%\TsmJavaApi.jar
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Task 9: Install ECM Centera SDK library files
If you intend to use Centera fixed content devices in your IBM FileNet P8 environment, complete 
the  procedures in this task to install ECM Centera SDK library files on each Content Engine 
Server machine. The Content Engine 4.5 software package or latest fix pack includes a Centera 
directory that contains the supported Centera SDK files you must install.

To install EMC Centera SDK version 3.2 library files

1. Log on to the Content Engine Server machine with a user account that has the appropriate 
permissions to create folders and install files.

2. As shown in the following table, copy the appropriate Centera directory from the Content Engine 
software package or fix pack to a location on the Content Engine Server machine, such as the 
UNIX /tmp directory or Windows C:\Temp directory:.

3. On the Content Engine Server machine, open the install subdirectory of the Centera directory 
you copied.

4. Run the following installer script that corresponds to the operating system on the Content 
Engine Server machine. On UNIX, the installer script will prompt you for the installation path on 
the command line, for example, C:\Centera_SDK. install directory. On Windows, specify the 
install path on the command line, such as C:\Centera_SDK.

UNIX

install.sh

Windows

install.bat installation_path

Operating System Directory To Be Copied

AIX, Solaris, Windows Copy the entire Centera directory

Linux Depending on your version of gcc, copy one of 
the following directories:

Centera/gcc3.3

Centera/gcc4

HP-UX 11i v1 (11.11) Copy Centera/11i-v1-11.11

HP-UX 11i v2 (11.23) Copy Centera/11iv1-11.23
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The installer script creates both 32-bit and 64-bit library directories, and puts them in a default 
installation directory, depending on your operating system (as shown in the following table). 
Accept or change the default when prompted by the script.

5. When prompted by the installer script, accept or change the default installation locations for 
ECM Centera SDK library files.

To configure EMC Centera SDK environment variables for version 3.2

1. In the Content Engine installation package or fix pack], locate the Centera sample setup script 
file for your operating system:

UNIX

setCenteraLibPath.sh

Windows

setCenteraLibPath.bat

2. Modify the sample setup script as indicated in the following table.

The CENTERA_LIB_PATH variable must include the sample script file subdirectory, not just 
the installation directory that you designated in the previous procedure.

For example, if you have a 64-bit AIX system, and you change the destination installation path 
(install_path in the table that follows) from:

/usr/local/Centera_SDK (the default)

to:

/usr/local/Centera/SDK3.2.607

then change the installation path of the AIX script to:

/usr/local/Centera/SDK3.2.607/lib/64

Operating 
System

Subdirectories of extracted 
EMC Centera SDK Directory

Description

AIX, 
Solaris, 
and 
Windows

lib lib has the native 
library files that are to 
be installed.

Linux ../gcc3.3/lib

../gcc4/lib

HP-UX ../11i-v1-11.11/lib

HP-UXi ../11i-v1-11.13/lib
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Note that the actual location is appended with either lib/32 or lib/64 because the 
installation script creates both 32-bit and 64-bit library directories, and places them inside the 
lib directory. 

Operating System Script Revisions

AIX From:

CENTERA_LIB_PATH=/usr/local/Centera_SDK/lib/32
LIBPATH=$LIBPATH:$CENTERA_LIB_PATH
export LIBPATH

to:

CENTERA_LIB_PATH=install_path/lib/32
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$CENTERA_LIB_PATH
export LD_LIBRARY_PATH

or:

CENTERA_LIB_PATH=install_path/lib/64
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$CENTERA_LIB_PATH
export LD_LIBRARY_PATH

Solaris From:

CENTERA_LIB_PATH=/opt/Centera_SDK/lib/32
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$CENTERA_LIB_PATH
export LD_LIBRARY_PATH

to:

CENTERA_LIB_PATH=install_path/lib/32
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$CENTERA_LIB_PATH
export LD_LIBRARY_PATH

or:

CENTERA_LIB_PATH=install_path/lib/64
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$CENTERA_LIB_PATH
export LD_LIBRARY_PATH

Linux From:

CENTERA_LIB_PATH=/usr/local/Centera_SDK/lib/32 
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$CENTERA_LIB_PATH
export LD_LIBRARY_PATH

to:

CENTERA_LIB_PATH=install_path/lib/32
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$CENTERA_LIB_PATH
export LD_LIBRARY_PATH

or:

CENTERA_LIB_PATH=install_path/lib/64
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$CENTERA_LIB_PATH
export LD_LIBRARY_PATH
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3. Copy the modified script text into one of the application server startup scripts shown in the 
following table, or save the updated script and call it from the application server startup script.

HP-UX
HP-UXi

From:

CENTERA _LIB_PATH=/opt/Centera_SDK/lib/32 
SHLIB_PATH=$SHLIB_PATH:$CENTERA_LIB_PATH 
export SHLIB_PATH

to:

CENTERA _LIB_PATH=install_path/lib/32
SHLIB_PATH=$SHLIB_PATH:$CENTERA_LIB_PATH 
export SHLIB_PATH

or:

CENTERA _LIB_PATH=install_path/lib/64
SHLIB_PATH=$SHLIB_PATH:$CENTERA_LIB_PATH 
export SHLIB_PATH

Windows From:

set CENTERA _LIB_PATH=C:\Centera_SDK\lib\32
set PATH=%PATH%;%CENTERA_LIB_PATH%

to:

set CENTERA_LIB_PATH=install_path\lib\32
set PATH=%PATH%;%CENTERA_LIB_PATH%

or:

set CENTERA_LIB_PATH=install_path\lib\64
set PATH=%PATH%;%CENTERA_LIB_PATH%

Application Server Startup Script (UNIX) Startup Script (Windows)

WebSphere setupCmdLine.sh setupCmdLine.cmd

WebLogic setDomainEnv.sh setDomainEnv.cmd

JBoss run.sh run.cmd

Operating System Script Revisions
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Task 10: Complete Content Engine post-deployment 
steps
Before you can put an IBM FileNet P8 system into production, you must perform one of the 
following post-deployment procedures in this topic, depending on your application server type:

• “To complete post-deployment steps (WebSphere)” on page 106

• “To complete post-deployment steps (WebLogic)” on page 107

• “To complete post-deployment steps (JBoss)” on page 107

Then perform the procedure “To verify the deployment of Content Engine” on page 107.

To complete post-deployment steps (WebSphere)

1. If you are using federated user repositories, perform the following substeps; otherwise, continue 
at Step 2.

a. Using the WebSphere administrative console, navigate to Security > Secure administration, 
applications, and infrastructure and click Configure.

b. If you have not already done so, specify a unique user (short name) for the Primary 
administrative user name.

NOTE This name must exist in one of the realms and must be unique.

c. Specify the Server user identity. You can specify Automatically generated server identity, or 
specify one that exists in one of the repositories.

NOTE This name must exist in one of the realms and must be unique.

d. Save your changes to the master configuration.

2. Use the WebSphere administrative console to adjust the following security settings:

a. Enable administrative security, if it is not already enabled, and application security before 
creating a FileNet P8 domain.

To enable WebSphere application or administrative security, you must do so manually. The 
deployment of Content Engine does not enable or check these settings.

b. Disable Java2 security so that Content Engine will not be able to start and process requests.

3. Restart the WebSphere application server where Content Engine is deployed in one of the 
following ways, depending on your deployment type:

• For a standalone server, stop and start the application server.

• For a WebSphere network deployment, stop and start the application server where Content 
Engine is deployed, including the Deployment Manager and all managed nodes.

• For a cluster, stop and start the cluster.

4. Continue at “To verify the deployment of Content Engine” on page 107.
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To complete post-deployment steps (WebLogic)

1. Restart the WebLogic application server (to reinitialize the WebLogic cache) where Content 
Engine is deployed, as follows:

• For a standalone server, stop and start the application server.

• For a cluster, stop and start the cluster.

2. Continue at “To verify the deployment of Content Engine” on page 107.

To complete post-deployment steps (JBoss)

1. If your directory server type is Windows Active Directory, perform the following substeps; 
otherwise continue at Step 2:

a. Make a backup of JBOSS_HOME/server/all/conf/login-config.xml file

b. Open the login-config.xml for editing.

c. Locate the following line inside the scope of the <login-module> XML element at the 
beginning of the file:

<login-module code="org.jboss.security.auth.spi.LdapExtLoginModule”
              flag="sufficient">

d. Add the following line immediately after the line you located in Step c:

<module-option name="java.naming.referral">follow</module-option>

e. Save your edit.

2. Stop and start the JBoss application server.

3. Continue at “To verify the deployment of Content Engine” on page 107.

To verify the deployment of Content Engine

1. Browse to the following web page:

 http://server:port/FileNet/Engine

where:

server is the host name of the machine where Content Engine Server is deployed.

port is the HTTP port used by the application server where Content Engine Server is deployed. 
Example web page addresses are shown in the following table:

Application Server Type Web Page Address

WebSphere  http://server:9080/FileNet/Engine

WebLogic  http://server:7001/FileNet/Engine

JBoss  http://server:8080/FileNet/Engine
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NOTE It is a best practice to bookmark the Web page address in your browser.

2. Verify your installation by checking the following information on the Web page:

a. The value for the Startup Message key, which shows the Content Engine build and version 
(for example, dap440.001.008), must match the build and version in the ce_install_path/
ContentEngine/ce_version.txt file.

b. The value for the Process Engine key, which shows the Process Engine Client build and 
version (for example, pui410.010), must match the build and version in the pe_client 
_install_path/version.txt file, where pe_client_install_path is the path to the 
directory where you installed the Process Engine Client files.

c. The values for JDBC driver, server instance, operating system, etc. must match the values 
you chose when planning the IBM FileNet P8 installation.

3. If you want to deploy another Content Engine instance on the application server, continue at 
“Configure Content Engine instances” on page 37.

4. Continue at one of the following topics:

• If you have not already installed FileNet Enterprise Manager, continue at “Install FileNet Enterprise 
Manager” on page 34.

• If you have a working FileNet Enterprise Manager available, continue at “Establish the FileNet P8 
domain and Global Configuration Data (GCD)” on page 109.
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Task 11: Establish the FileNet P8 domain and Global 
Configuration Data (GCD)
With Content Engine installed and deployed, you will use Enterprise Manager to create a FileNet 
P8 domain. You can also use Enterprise Manager to set a URL to the IBM FileNet P8 online help 
if you did not do so when you ran the Content Engine installation program.

To create a FileNet P8 domain

NOTE If you run Enterprise Manager as a limited user account, you cannot update the Base URL 
for the FileNet P8 Platform help files field in the General tab of the Enterprise Manager properties 
dialog box.

1. Start Enterprise Manager by double-clicking the FileNet Enterprise Manager Administration Tool 
icon on the desktop, or by choosing Start > All Programs > IBM FileNet P8 Platform > FileNet 
Enterprise Manager Administration Tool.

2. Work through the screens in the following table. The initial values displayed in the screens are 
default values that you must change to match your site. Refer to your installation worksheet for 
the values for your site. For information, see “installation and upgrade worksheet” in Plan and 
Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to quickly see only the 
installation properties you must specify for the Create FileNet P8 domain wizard:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select “EM: Create FileNet P8 domain.”

– Click the AutoFilter drop-down arrow in the "Setup Type" column header and select 
"Installation."

– Click the AutoFilter drop-down arrow in all the other column headers and select (All).

In this screen... Perform this action...

FileNet P8 
Logon

Click Add to create a FileNet domain.

NOTE For subsequent logons to Enterprise Manager, you can access an 
existing FileNet P8 domain by clicking Connect.
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3. Continue at “To configure directory service authentication” on page 111.

Add Domain 
Configuration

Provide the following information, and then click OK.

• Nickname - A name (not part of any credentials) for connecting to 
Content Engine.

• Connection - http

• Server - The host name of the machine where the Deployment 
Manager (WebSphere) or Administrative Server (WebLogic) runs.

NOTE In a non-managed application server environment (such as a 
JBoss cluster, or a standalone WebSphere or WebLogic), specify the 
host name for just one of the application servers. You can configure 
Enterprise Manager connections to the other non-managed 
application servers.

• Port - The port number appropriate for you application server. For 
example:

– 9080 (WebSphere)

– 7001 (WebLogic)

– 8080 (JBoss)

NOTE In a non-managed application server environment (such as a 
JBoss cluster, or a standalone WebSphere or WebLogic), specify the 
port number for just one of the application servers.

• Path - wsi/FNCEWS40MTOM

• URL - http://server:port/wsi/FNCEWS40MTOM where server and port 
are the values you specified above.

• Username - The value you specified for the bootstrap user name in 
Configuration Manager (see ce_bootstrap_admin in Plan and Prepare 
Your Environment for IBM FileNet P8).

• Password - The password for the bootstrap user.

• Remember password - Select the check box if you want to avoid 
typing the password each time you log on as the bootstrap user. (The 
password will be encrypted.)

• Use integrated login - Select the check box if you want Kerberos 
authentication for the bootstrap user.

In this screen... Perform this action...
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To configure directory service authentication

NOTE For multi-realm authorization, run the Create a Directory Configuration wizard once for each 
realm. Refer to FileNet P8 Administration > Enterprise-wide Administration > FileNet P8 Security > How 
to > Configure for multiple realms.

1. In the FileNet P8 Logon dialog box, select the FileNet P8 domain you created in “To create a 
FileNet P8 domain” on page 109 and click Connect.

2. In the FileNet P8 Domain Logon dialog box, type the user name and password to log on to the 
FileNet P8 domain.The Create a Directory Configuration wizard appears. 

NOTE If the wizard detects an error, check the application server log file on the machine where 
Content Engine is deployed:

3. Work through the Create a Directory Configuration wizard screens in the following table. The 
initial values displayed in the screens are default values that you must change to match your 
site.

The configuration parameters required by the Create a Directory Configuration wizard are in 
many cases the same as those you provided to Configuration Manager when you configured 
LDAP in “Configure Content Engine instances” on page 37.

If you have installed IBM FIleNet P8 help, refer also to the topic for your directory service 
within the IBM FileNet P8 help topic System Administration > Enterprise-wide Administration > 
FileNet P8 Security > Directory service providers.

Refer to your installation worksheet for the values for your site. For information, see 
“installation and upgrade worksheet” in Plan and Prepare Your Environment for IBM FileNet 
P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to quickly see only the 
installation properties you must specify for the Create a Directory Configuration wizard:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select “EM: Create a Directory Configuration.”

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Installation”.

– Click the AutoFilter drop-down arrow in all the other column headers and select (All).

Application 
Server Type

Path to log file

WebSphere WAS_install_path/AppServer/profiles/profile_name/logs/
server_name/SystemOut.log

WebLogic WLS_install_path/user_projects/domains/domain_name/
servers/server_name/logs/server_name.log

JBoss JBOSS_DIST/server/server_name/log/server_name.log
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In this screen... Perform this action...

Welcome Click Next to proceed.

Select Type and 
Name Directory 
Configuration

Provide the following information, and then click Next.

• Type - The type of directory server you specified in Configuration 
Manager

• Display Name - A name (unique across all FileNet P8 domains in a 
forest) for the new directory configuration

• Existing Names - The names of existing directory configurations 
within the domain to help you choose a unique display name.

Select General 
Directory 
Configuration 
Properties

Provide the following information, and then click Next.

• Host - The name or IP address of the host where the Windows domain 
controller is installed. In a forest environment, the Windows domain names 
must be distinct if name you specify must be unique within each.

• Port - The LDAP port number (389, by default).

• Directory Service User - Fully qualified distinguished name of 
ce_service_user, the directory service bind user you specified when you 
configured LDAP using Configuration Manager.

• Password - Password of the directory service user.

• Is SSL Enabled - True or False.

The following parameters apply only to Active Directory:

• Connection Timeout - Specifies the Active Directory Service provider 
connection timeout in milliseconds. The default is 500 milliseconds. If the 
connection is across a WAN, consider increasing the value.

• Return Name as DN - Specifies format in which Active Directory 
returns user or group names:

– True - Return in Distinguished Name format

– False - Return in User Principal Name format (default choice)
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Select User 
Directory 
Configuration 
Properties

Provide the following information, and then click Next.

• Base DN - Base distinguished string to use in LDAP user searches.

• User Search Filter - LDAP search filter for finding user names.

• User Display Name Attribute - The display name for a user object 
generated by the authentication provider:

Active Directory, Active Directory LDS, IBM Tivoli Directory 
Server, Novell eDirectory

cn (by default)

Sun Java System Directory Server

uid 

User Short Name Attribute - The name you use to log in:

Active Directory

samAccount

Active Directory, Active Directory LDS, IBM Tivoli Directory 
Server, Novell eDirectory

cn

Sun Java System Directory Server

uid 

In this screen... Perform this action...
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4. In the Configure New Domain Permissions message box, click OK to acknowledge that the 
directory configuration is complete but remains in restricted mode. The Configure New Domain 
Permissions wizard automatically starts (if you are in Enterprise Manager for the first time and 
have not defined any GCD administrators). Continue at “To configure permissions for a FileNet P8 
domain” on page 114.

To configure permissions for a FileNet P8 domain

1. Work through the screens in the Configure New Domain Permissions wizard, as shown in the 
following table.

Select Group 
Directory 
Configuration 
Properties

Provide the following information, and then click Next.

• Group Base DN - Base distinguished string to use in LDAP group 
searches.

• Group Search Filter - LDAP search filter for finding group names.

• Group Display Name Attribute - cn, by default.

• Group Short Name Attribute - cn, by default.

• Group Membership Search Filter - The search filter for group membership 
queries.

The following parameter applies to Active Directory only:

• Search Cross Forest Group Membership:

– True - Enables cross-forest group membership searches.

– False - Disables such searches (the default).

The following parameter applies to all directory server types but has no effect for 
Active Directory LDS, which does not support cross-domain memberships:

• Restrict membership to configured realms:

– Select the check box to limit group lookups, such that a user’s 
group memberships in unconfigured realms are ignored.

– Clear the check box to prevent a user with memberships in 
unconfigured realms from logging on because the system cannot 
look up all the group memberships of the user).[Deleted the 
following (last) paragraph in this table cell.]

Completing the 
Create a 
Directory 
Configuration 
Wizard

Click Finish.

In this screen... Perform this action...
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For information on the GCD administrators, see “Installation and upgrade worksheet” in Plan 
and Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to quickly see only the 
installation properties you must specify for the Configure New Domain Permissions wizard:

– Click the AutoFilter drop-down arrow in the “Installation or Configuration Program” 
column header, and select “EM: Configure New Domain Permissions.”

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Installation”.

– Click the AutoFilter drop-down arrow in all the other column headers and select (All).

2. In the Configure New Domain Permissions message box, click OK.

3. Continue at one of the following procedures:

• If you set a URL to the IBM FileNet P8 online help when you installed Content Engine, continue at 
“To set the Statement Cache Size value for the GCD database” on page 116.

• If you did not set a URL to the IBM FileNet P8 online help and want to do so now, continue at “To 
set a URL to the IBM FileNet P8 online help” on page 115.

To set a URL to the IBM FileNet P8 online help

1. In Enterprise Manager, right-click the Enterprise Manager root node in the tree view and choose 
Properties.

2. In the Base URL for the FileNet P8 Platform help files box of the General tab, specify the URL of 
the IBM FileNet P8 online help that you deployed in “Install IBM FileNet P8 Platform documentation 
(All)” on page 23. For example,

http://servername:port/ecm_help.war

In this screen... Perform this action...

Welcome Click OK to proceed.

Specify 
Domain 
Administrators

Click Add to load the Select Users and Groups dialog box that lets you add 
users and groups to the list of GCD administrators.

(Optional) Click Remove to remove the Content Engine system user 
(ce_bootstrap_admin in Plan and Prepare Your Environment for IBM 
FileNet P8).

Click Next.

Completing the 
New Domain 
Permissions 
Wizard

Click Finish.
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where:

servername is the name of the host where you deployed IBM FileNet P8 help.

port is the port number used by the application server where you deployed IBM FileNet P8 help.

3. Continue at “To set the Statement Cache Size value for the GCD database” on page 116.

To set the Statement Cache Size value for the GCD database

If you are using Microsoft SQL Server 2005 JDBC Driver or Oracle JDBC Driver, you need to set 
the Statement Cache Size parameter value to 0 for each data source you created to access the 
GCD database, as shown in the following steps:

1. Access the page containing the Statement Cache Size parameter:

WebSphere

Navigate to the WebSphere administrative console page containing the field Statement Cache 
Size property. For example, in WebSphere 6.1.x, navigate to Resources > JDBC Providers > 
JDBC_provider > Data sources > data_source > WebSphere Application Server data source 
properties.

WebLogic

Navigate in the tree view of WebLogic Administration Console to FNCEDomain > Services > 
JDBC > Data Sources > Data_Source_Name > Connection Pool.

2. Set the Statement Cache Size to 0 and save your change.
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Task 12:  Create the data sources for an object store
Each object store in your site requires its own distributed (XA) and non-distributed (non-XA) JDBC 
data sources. When you completed “Configure Content Engine instances” on page 37, you created 
the JDBC data sources for the Global Configuration Database (GCD). Complete either of the 
procedures in this topic to use Configuration Manager to create the pair (XA and non-XA) of data 
sources for the initial object store. (You can use the same procedures to create data sources for 
subsequent object stores.)

For each additional object store, you must create an another pair of data sources, using the 
procedures in this topic. You can create these data sources after you have confirmed your Content 
Engine configuration.

NOTE Configuration Manager will not create a new data source with the same name as that of an 
existing data source. If you want to reuse the name of an existing data source for an object store, 
manually delete the existing data source before creating the new data source. Refer to your 
application server documentation for more information.

Refer to the information in your installation worksheet to complete the procedures in this topic. For 
more information, see “Installation and upgrade worksheet” on page 229 of Plan and Prepare Your 
Environment for IBM FileNet P8.

To create the data sources using the graphical user interface to Configuration Manager

1. If you have not done so already, log on to the machine where you installed Content Engine as 
ce_install_user. For details on required accounts and related permissions, see “Accounts for 
Content Engine” on page 71 in Plan and Prepare Your Environment for IBM FileNet P8.

2. Start the GUI version of Configuration Manager by running one of the following commands, 
depending on the operating system on the machine where you installed Content Engine:

UNIX

ce_install_path/tools/configure/CMUI/cmui

Windows

Complete one of the following actions:

• Double-click the FileNet Configuration Manager desktop shortcut. 

• Select Start > All Programs > IBM FileNet P8 Platform > FileNet Configuration Manager. 

• Run ce_install_path\tools\configure\CMUI\cmui.exe.

3. Refer to your installation worksheet to specify the values for the properties required for your new 
object store data source profile. For more information, see “Installation and upgrade worksheet” on 
page 229 of Plan and Prepare Your Environment for IBM FileNet P8.
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HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), complete the following actions to quickly see only the 
properties you must specify for Configuration Manager:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select one of these Configuration Manager options:

– CM: Set Application Server properties

– CM: Configure JDBC Data Sources

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify: Setup Type contains "Installation."

• Click the AutoFilter drop-down arrow in all other column headers and select (All).
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4. Start the Create New Configuration Profile wizard by choosing File > New Configuration Profile 
or by clicking the wizard icon in the tool bar.

In this screen... Complete this action...

Configuration Profile 
Information

• Provide the following information for the profile:

– Enter a name for the profile. The name must be valid as 
a directory name for your operating system. 
Configuration Manager will create a directory with the 
profile name for storing the configuration files 
associated with this profile. For more information of 
profiles, see “Configuration profile concepts” on page 639 in 
the Configuration Manager reference appendix.

– Specify the path for the profile. Either type in the full path 
to the profile directory or click Browse to locate the 
directory. The default path is ce_install_path/tools/
configure/profiles, where ce_install_path is the 
location where Content Engine is installed.

• Choose an application server type for the profile. Select 
WebSphere, JBoss, or WebLogic.

• Click Next.

If you click Finish instead of Next, you will create a default 
profile instead of a profile for just the Configure JDBC task. 
You will need to come back later to supply the required 
application server properties before you can run the 
configure JDBC task. 

• Continue at one of the following screens:

– “Set Application Server Properties for WebSphere” on 
page 120

– “Set Application Server Properties for JBoss” on page 121

– “Set Application Server Properties for WebLogic” on 
page 122
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Set Application Server 
Properties for 
WebSphere

This screen is displayed only if you selected WebSphere in the 
previous screen. 

• Provide the following information for the application server:

– Select the application server version from the list.

– Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the 
directory. 

– Enter the application server administrator user name. 
Use the directory service user account that has been 
assigned the application server administrative role. This 
account is used to manage the application server 
domain/profile, to configure the data sources and 
connection pools for the object store, and to deploy the 
Content Engine application. If Administrative Security is 
already enabled, use an existing administrative user 
account.

– Enter the application server administrative password. 
The password will be encrypted for you. For more 
information on passwords,  see “Handling passwords in 
Configuration Manager” on page 643.

– Enter the application server SOAP port number.

– Enter the name of the WebSphere application server 
cell where Content Engine will be deployed.

– If you have already configured WebSphere to use 
certificates, clear the “Do not use SSL certificates for 
server communications” check box. Otherwise, leave the 
check box selected. 

NOTE  Selecting this check box will change your 
WebSphere settings for communicating with other 
servers, such as Application Engine.

• Click Next.

• Continue with “Select the tasks that you want included in the 
Configuration Profile” on page 122.

In this screen... Complete this action...
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Set Application Server 
Properties for JBoss

This screen is displayed only if you selected JBoss in the 
previous screen. 

• Provide the following information for the application server:

– Select the application server version from the list.

– Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the 
directory. 

– Enter the name of the JBoss application server name 
where Content Engine will be deployed.

• Click Next.

• Continue with “Select the tasks that you want included in the 
Configuration Profile” on page 122.

In this screen... Complete this action...
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Set Application Server 
Properties for WebLogic

This screen is displayed only if you selected WebLogic in the 
previous screen.

• Provide the following information for the application server:

– Select the application server version from the list.

– Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the 
directory. 

– Enter the application server administrator user name. 
Use the directory service user account that has been 
assigned the application server administrative role. This 
account is used to manage the application server 
domain/profile, to configure the data sources and 
connection pools for the object store, and to deploy the 
Content Engine application. If Administrative Security is 
already enabled, use an existing administrative user 
account.

– Enter the application server administrative password. 
The password will be encrypted for you. For more 
information on passwords,  see “Handling passwords in 
Configuration Manager” on page 643.

– Enter the application server SOAP port number.

– Enter the machine name or the IP address of the local 
host for the application server host. 

– Enter the fully qualified path to the WebLogic application 
server user projects directory, or click Browse to locate 
the directory.

– Enter the WebLogic application server domain name 
where Content Engine will be deployed.

– Enter the name of the WebLogic application server 
name where Content Engine will be deployed.

• Click Next.

• Continue with “Select the tasks that you want included in the 
Configuration Profile” on page 122.

Select the tasks that you 
want included in the 
Configuration Profile

• Select only the Configure JDBC Data Sources task. Clear 
the check box for all other tasks. 

• Click Finish to create the profile and save the application 
server properties.

In this screen... Complete this action...
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The profile you create will be displayed as an icon in the profile pane (left-hand pane), along 
with the Configure JDBC Data Sources icon.

5. Provide property values for the JDBC data sources for the object store.

a. Right-click Configure JDBC Data Sources in the profile pane, and select Edit Selected Task. 

b. Provide the property values for your database, using the appropriate table for your database 
type:

DB2® for Linux®, UNIX®, Windows®

In this field... Provide this information...

JDBC driver name Select “DB2 Universal JDBC Driver” from the list. The 
remaining properties and values that you need to supply for 
your data source configuration depend on the type of driver 
that you select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the object store tablespace or database. 
For example, FNOS1DS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the object store tablespace or database. For example, 
FNOS1DSXA.

Database server name The host name of the machine where the database software 
is installed.

Database port number The port number used by the DB2 database instance in 
which you create tablespaces for the object stores.

Database name The name of the object store database. 

Database user name The name of the DB2 object store tablespace user.

Database password The password for the DB2 object store tablespace user. The 
tool encrypts the password for you.

Enter the password again in the Confirm field.

JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the object store. The file name must end with -ds.xml. For 
example, os1-ds.xml. 
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DB2® for z/OS®

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the object store. The file name must end with -ds.xml. For 
example, os1-ds.xml. 

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step 6. The default is 
enabled.

In this field... Provide this information...

JDBC driver name Select “DB2 for z/OS Universal JDBC Driver” from the list. 
The remaining properties and values that you need to supply 
for your data source configuration depend on the type of 
driver that you select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the object store tablespace or database. 
For example, FNOS1DS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the GCD tablespace or database. For example, 
FNOS1DSXA.

Database server name The host name of the machine where the database software 
is installed.

Database port number The port number used by the DB2 database instance in 
which you create tablespaces for the GCD and object 
stores.

Database name The name of the GCD database instance name. 

Database user name The name of the DB2 GCD tablespace user.

Database password The password for the DB2 GCD tablespace user. The tool 
encrypts the password for you.

Enter the password again in the Confirm field.

In this field... Provide this information...
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JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the GCD. The file name must end with -ds.xml. For 
example, gcd-ds.xml. 

If you have already created data sources for the GCD and 
do not want the Configuration Manager tool to create them 
for you, leave this field blank and clear the Task enabled 
check box.

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the GCD. The file name must end with -ds.xml. For 
example, gcd-ds.xml. 

If you have already created data sources for the GCD and 
do not want the Configuration Manager tool to create them 
for you, leave this field blank and clear the Task enabled 
check box.

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step 6. The default is 
enabled.

In this field... Provide this information...
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MS SQL Server

In this field... Provide this information...

JDBC driver name Select “Microsoft JDBC Driver 2005” from the list. The 
remaining properties and values that you need to supply for 
your data source configuration depend on the type of driver 
that you select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the GCD tablespace or database. For 
example, FNOS1DS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the GCD tablespace or database. For example, 
FNOS1DSXA.

Database server name The host name of the machine where the database software 
is installed.

Database port number The port number used by the SQL Server database instance 
in which you create databases for the GCD and object 
stores.

Database name The name of the GCD database for SQL Server.

Database user name The name of the SQL Server user with administrative rights 
to the GCD database.

Database password The password for the SQL Server user with administrative 
rights to the GCD database. The tool encrypts the password 
for you.

Enter the password again in the Confirm field.

JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the GCD. The file name must end with -ds.xml. For 
example, gcd-ds.xml. 

If you have already created data sources for the GCD and 
do not want the Configuration Manager tool to create them 
for you, leave this field blank and clear the Task enabled 
check box.
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Oracle

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the GCD. The file name must end with -ds.xml. For 
example, gcd-ds.xml. 

If you have already created data sources for the GCD and 
do not want the Configuration Manager tool to create them 
for you, leave this field blank and clear the Task enabled 
check box.

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step 6. The default is 
enabled.

In this field... Provide this information...

JDBC driver name Select “Oracle JDBC Driver” from the list. The remaining 
properties and values that you need to supply for your data 
source configuration depend on the type of driver that you 
select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the GCD tablespace or database. For 
example, FNOS1DS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the GCD tablespace or database. For example, 
FNOS1DSXA.

Database server name The host name of the machine where the database software 
is installed.

Database port number The port number used by the Oracle database instance in 
which you create tablespaces for the Global Configuration 
Data (GCD) and object stores.

Database name The SID of the Oracle database containing the GCD 
tablespace.

Database user name The name of the Oracle GCD tablespace owner.

Database password The password for the Oracle GCD tablespace owner. The 
tool encrypts the password for you.

Enter the password again in the Confirm field.

In this field... Provide this information...
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 12: Create the data sources for an object store
To create the data sources using the graphical user interface to Configuration Manager

128
Oracle RAC

JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the GCD. The file name must end with -ds.xml. For 
example, gcd-ds.xml. 

If you have already created data sources for the GCD and 
do not want the Configuration Manager tool to create them 
for you, leave this field blank and clear the Task enabled 
check box.

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the GCD. The file name must end with -ds.xml. For 
example, gcd-ds.xml. 

If you have already created data sources for the GCD and 
do not want the Configuration Manager tool to create them 
for you, leave this field blank and clear the Task enabled 
check box.

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step 6. The default is 
enabled.

In this field... Provide this information...

JDBC driver name Select “Oracle JDBC Driver (RAC support)” from the list. The 
remaining properties and values that you need to supply for 
your data source configuration depend on the type of driver 
that you select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the object store tablespace or database. 
For example, FNOS1DS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the object store tablespace or database. For example, 
FNOS1DSXA.

Database server name 
RAC node 1

The host name of the machine where the database software 
is installed for node 1.

Database port number 
RAC node 1

The port number used by the Oracle database instance in 
which you create tablespaces for the object stores.

Database server name 
RAC node 2

The host name of the machine where the database software 
is installed for node 2.

In this field... Provide this information...
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c. Select File > Save to save your changes.

6. Apply the JDBC property settings by right-clicking Configure JDBC Data Sources in the profile 
pane, and select Run Task. Running the configuration task can take a few minutes. The task 
execution status messages are displayed in the Console pane below the bootstrap properties.

TIP  You can check the completion status of a task by right-clicking Configure JDBC Data 
Sources in the profile pane, and select Check Task Status.

7. Repeat Step 4 through Step 6 for each additional object store in your environment. Each object 
store requires a separate data source.

8. (Oracle and JBoss only) Continue at “To edit XA data source XML files” on page 132.

9. (WebSphere only) Stop and start WebSphere Application Server.

10. Continue at “Create the initial object store” on page 133.

Database port number 
RAC node 2

The port number used by the Oracle database instance in 
which you create tablespaces for the object stores.

Database service name The SID of the Oracle database containing the object store 
tablespace.

Oracle RAC retries The number of retries for Oracle RAC.

Oracle RAC delay The amount of delay for Oracle RAC.

Database user name The name of the Oracle object store tablespace owner.

Database password The password for the Oracle object store tablespace owner. 
The tool encrypts the password for you.

Enter the password again in the Confirm field.

JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the object store. The file name must end with -ds.xml. For 
example, os1-ds.xml. 

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the object store. The file name must end with -ds.xml. For 
example, os1-ds.xml.

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step 6. The default is 
enabled.

In this field... Provide this information...
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To create the data sources using the command-line interface to Configuration Manager

1. If you have not done so already, log on to the machine where you installed Content Engine as 
ce_install_user. For details on required accounts and related permissions, see “Accounts for 
Content Engine” on page 71 in Plan and Prepare Your Environment for IBM FileNet P8.

2. Set the current directory to ce_install_path/tools/configure, where:

ce_install_path is the path where you installed Content Engine.

3. Generate the configurejdbc.xml file and the applicationserver.xml file by running the 
following command:

configmgr generateConfig -appserver app_server_type -db db_type -ldap 
ldap_type -deploy deploy_type -task ConfigureJDBC -path mypath

where:

app_server_type is WebSphere, WebLogic, or JBoss.

db_type specifies the type of database to be used by Content Engine and must be one of the 
following: mssql, oracle, oracle_rac, db2, or db2zos.

ldap_type specifies the type of directory service repository Content Engine uses for 
authenticating users and must be one of the following: activedirectory, adam, edirectory, 
sunjava, or tivoli. The adam option applies to both Microsoft ADAM and AD LDS. 

deploy_type  specifies the type of Content Engine deployment. The value must be one of the 
following: standard, cluster, or netdeploy (network deployment). Specify standard if you are 
deploying Content Engine to a standalone (that is, a server that is neither managed nor 
clustered) WebSphere, WebLogic, or JBoss application server. Specify cluster if you are 
deploying Content Engine to a WebSphere, WebLogic, or JBoss application server cluster. 
Specify netdeploy if you are deploying Content Engine to a managed WebSphere application 
server instance (using Network Deployment for managing individual servers that are not 
necessarily in a cluster).

-path mypath is optional and specifies the path to where the generated configuration XML files 
will be placed. If you are deploying multiple Content Engine instances on the same machine, 
you will need to specify a separate directory for each instance.

4. Use a text editor or XML editor to open the applicationserver.xml file and edit it as follows:

a. Refer to the appropriate parameter information from your installation and upgrade worksheet 
for the following steps. For information on the parameter values, see “Installation and 
upgrade worksheet” on page 229 in Plan and Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls), complete the following steps to quickly see 
only the installation properties you must specify for your application server:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select “CM: Set Application Server properties.”

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Installation."
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• Click the AutoFilter drop-down arrow in all other column headers and select (All).

b. Replace each occurrence of ****INSERT VALUE**** with a value appropriate for your site. 
Refer to the descriptions in the file for more information.

c. Verify that the default values for the remaining properties are correct for your site. 

d. (Optional) Encrypt the password for the application server administrative user by running the 
password encryption utility (see “Encrypt passwords” on page 700), and then copy the 
encrypted value into the file. 

CAUTION Any password you do not encrypt will be stored and sent as clear text.

e. Save your edits.

5. Use a text editor or XML editor to open the configurejdbc.xml file and edit it as follows:

a. Refer to the appropriate parameter information from your installation and upgrade worksheet 
for the following steps. For information on the parameter values, see “Installation and 
upgrade worksheet” on page 229 in Plan and Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls), complete the following steps to quickly see 
only the installation properties you must specify for creating JDBC data sources:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select “CM: Create JDBC data sources.”

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Installation."

• Click the AutoFilter drop-down arrow in all other column headers and select (All).

b. Replace each occurrence of ****INSERT VALUE**** with a value appropriate for your site. 
Refer to the descriptions in the file for more information.

c. Verify that the default values for the remaining properties are correct for your site. 

d. Set the <TaskEnabled> value to true so you can run the configuration task in Step 6.

e. (Optional) Encrypt the password for the user of the database associated with the data 
sources you are creating by running the password encryption utility (see “Encrypt passwords” 
on page 700), and then copy the encrypted value into the file. 

CAUTION Any password you do not encrypt will be stored and sent as clear text.

f. Save your edits.

6. Execute the configurejdbc.xml file by running the following command:

configmgr execute -task ConfigureJDBC -path mypath

where -path mypath is optional and specifies the path to the configureJDBC.xml file.

7. Check the completion status by running the following command:

configmgr checkStatus -task ConfigureJDBC -path mypath

where -path mypath is optional and specifies the path to the configureJDBC.xml file.
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8. Repeat Step 3 through Step 7 for each additional object store in your environment. Each object 
store requires a separate data source.

9. (Oracle and JBoss only) Continue at “To edit XA data source XML files” on page 132.

10. (WebSphere only) Stop and start WebSphere Application Server.

11. Continue at “Create the initial object store” on page 133.

To edit XA data source XML files

Configuration Manager puts the following <mbean> tag into the XML file for each XA data source 
it creates when the database type is Oracle and the application server type is JBoss:

<mbean code="org.jboss.resource.adapter.jdbc.vendor.OracleXAExceptionFormatter"
    name="jboss.jca:service=OracleXAExceptionFormatter">
<depends optional-attribute name="TransactionManagerService">

jboss:service=TransactionManager
</depends>

</mbean>

At this point, if you have created an XA data source for the GCD in “Configure Content Engine 
instances” on page 37 and have not manually created any XA data sources, only one XA data source 
XML file contains an <mbean> tag.

Because exactly one XA data source XML file must contain an <mbean> tag, you need to remove 
the tag from the XML file for the XA data source you have just created in this topic, or for any XA 
data source you create later; otherwise, you will not be able to create an associated object store.

Complete the following steps to remove the <mbean> tag from the XA data source XML file:

1. Navigate to the directory containing all the XA data source XML files. For example, if JBoss is 
installed on a UNIX machine and the JBoss server name is server1, the directory is typically 
JBOSS_HOME/server/server1/deploy.

2. Find the XML file for the XA data source you created in this topic and open it for editing. For 
example, if the XA data source is named FNDS1, the XML file name is FNDS1XA-ds.xml.

3. Find and delete the <mbean> tag from the XML file.

4. Save your edits.

5. Continue at “Create the initial object store” on page 133.
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Task 13:  Create the initial object store
In this task you will create the initial object store. If you have not already done so, perform the 
following preparation before starting the Create an Object Store wizard.

• Set up the initial storage area for the object store (see “Prepare storage areas for object stores” 
on page 56 in Plan and Prepare your Environment for FileNet P8).

• Install the latest Content Engine service pack, as indicated in “Install Content Engine software 
updates” on page 36.

• Create XA and non-XA data sources for the object store, as indicated in “Create the data 
sources for an object store” on page 117).

• Read the FileNet P8 help topic System Administration > Content Engine Administration > Object 
stores > Concepts

NOTES

• The Create Object Store wizard will fail if you try to assign a new object store to a database/
tablespace that is not completely empty.

• For each additional object store you intend to create, you must first create XA and a non-XA 
data sources, as indicated in “Create the data sources for an object store” on page 117.

• To create an additional object store, you can perform the procedure in this topic again, or the 
one in the FileNet P8 help topic System Administration > Content Engine Administration > Content 
Engine Wizard Help > Create Object Store.

• Once an object store is created, you can refine its definition and add content to it.

To create an object store

1. Start Enterprise Manager by double-clicking the FileNet Enterprise Manager desktop icon, or by 
choosing Start > All Programs > FileNet P8 Platform > Enterprise Manager.

2. In the FileNet P8 Logon screen, select the FileNet P8 domain in which you will create an object 
store, and then click Connect.

3. In the tree view, right-click the Object Stores container and choose New Object Store to start the 
Create an Object Store wizard.

4. Work through the wizard screens. For information on parameter names and values you will 
specify when running the wizard, see “Installation and upgrade worksheet” on page 229 in Plan 
and Prepare Your Environment for IBM FileNet P8. For additional details, click Help in the 
wizard screens.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls), perform the following steps to quickly see 
only the installation properties you must specify for the Create Object Store wizard:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select “EM: Create Object Store.”
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– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Installation."

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

In this screen... Perform this action...

Welcome Click Next to proceed with creating an object store.

Name and 
Describe the 
Object Store

Type the display name for the object store. The symbolic name and 
description are entered automatically as you type the display name, 
but you can edit them before leaving this screen. Click Next.

NOTE The symbolic name, used for internal programmatic purposes, 
must contain only ASCII characters and must begin with an alphabetic 
character.

Specify the Data 
Sources

Specify the JNDI names associated with the data sources for your 
database, as follows:

• JNDI Data Source Name: The data source that binds the non-XA 
connection pool to the database/tablespace.

• JNDI XA Data Source Name: The data source that binds the XA 
connection pool to the database/tablespace.

Click Next.

Specify the 
default Content 
Store

Click one of the following to specify the default location for the content 
of the object store, and then click Next. If you clicked

• Database Storage Area – continue at “Specify object store 
administrators” on page 138

• File Storage Area – continue at “Specify File Storage Area Directory” 
on page 135

• Fixed Storage Area – continue at “Fixed Storage Area” on page 135
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Specify File 
Storage Area 
Directory

Type, or browse (Windows only) to, the path name of an empty 
directory to contain the file storage area:

Windows - Specify the UNC of the network share to contain the file 
storage area. If you browse to the path name, be sure to omit the drive 
letter when you specify the UNC.

UNIX - Specify the path to the file storage area:

• Local: <hfs_mount>/ecmdata/file_stores/obj_store_name

• Remote: <nfs_mount>/ecmdata/file_stores/obj_store_name

NOTE Refer to “IT Administrator Tasks > Prepare storage areas for 
object stores > Configure file servers for file storage areas > users and 
groups” in Plan and Prepare your Environment for FileNet P8 for 
information on the permissions required on the directory where your 
file storage area will be created.

Click Next and continue at “Specify object store administrators” on 
page 138.

Fixed Storage 
Area

If you specified Fixed Storage Area as your default Content Store, 
choose a fixed content device from the drop-down list, specify the 
staging area path, and click Next.

The items in the drop-down list are those fixed content devices that 
have been configured in the P8 domain's Fixed Content Devices page.

If your fixed content device type is

• EMC Centera, continue at “EMC Centera” on page 136

• FileNet Image Services continue at “FileNet Image Services” on 
page 136

• NetApp SnapLock, continue at “NetApp SnapLock” on page 137

In this screen... Perform this action...
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EMC Centera Specify the information for the Centera device type:

• Default retention period:

Select one of the settings for retention period. Content whose 
retention period has not yet expired cannot be deleted. Your 
selection will override the fixed content device's own retention 
setting, unless you select the "Same as..." (which uses the fixed 
content device's own setting). Note that the expiration date only 
indicates when content can be deleted; it does not carry out the 
deletion.

• No minimum (default): Content may be deleted at any time 
(retention period is zero). 

• Infinite (content can never be deleted): Content can never be 
deleted (retention period is infinitely long). 

• Same as the retention period of the fixed content device: Use the 
default value of the fixed content device itself. 

• User defined: Use the controls to set a retention period

Continue at “Specify object store administrators” on page 138.

FileNet Image 
Services

Specify the information for the FileNet Image Services device type:

• IS Document Class

Displays the Image Services document class that was selected as 
the default at the time the IS Fixed Content Device was created.

• Use default

Select to use the default document class.

• Selected below

Select to query the IS server for a list of eligible document classes 
that will appear in the drop-down list. Select one of the classes. If 
you use this option and change the default setting, map this IS 
document class to an object store document class if documents 
will be captured by IS and exported to Content Engine.

Continue at “Specify object store administrators” on page 138.

In this screen... Perform this action...
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NetApp SnapLock Specify the information for the NetApp SnapLock device type:

• Default retention period 

Select one of the settings for retention period. You cannot delete 
content whose retention period has not yet expired. Note that the 
expiration date only indicates when content can be deleted; it does 
not carry out the deletion.

• Minimum

The creation time of each document + the minimum retention value 
specified for the fixed content device.

• Maximum

The creation time of each document + the maximum retention 
value specified for the fixed content device.

• Default

The creation time of each document + the default retention value 
specified for the fixed content device.

• User defined

The creation time of each document + the value specified in the 
edit box. Note that this must be between the minimum and 
maximum retention values.

Continue at “Specify object store administrators” on page 138.

In this screen... Perform this action...
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Specify object 
store 
administrators

An object store administrator can log on to Enterprise Manager, has 
administrative (add/delete/change) access to the object store, and is 
in security lists on objects. The initial object-store administrators list 
includes the account that creates the object store.

To add object store administrators to the list, do the following:

a. Click Add....

b. In the Select Users and Groups screen, specify object type, 
realm, and search criteria as needed, and then click Find to 
display a list from which to select object store administrators.

c. Select a single item, or press and hold the CTRL (or SHIFT) key, 
and use the left mouse button to select multiple items (or the 
first and last of a range of items).

d. Release the CTRL (or SHIFT) key and click OK.

To remove object store administrators from the list, do the following:

a. Select a single item, or press and hold the CTRL (or SHIFT) key, 
and use the left mouse button to select multiple items (or the 
first and last of a range of items).

b. Release the CTRL (or SHIFT) key and click OK.

When your list is complete, click Next and continue at “Specify Initial 
User Groups” on page 139.

NOTE  If you specify an empty list, the wizard automatically adds 
#AUTHENTICATED-USERS, which gives all network users in the 
authentication realm administrative access to the object store (for 
example, under Windows authentication, all accounts in Domain 
Users).

In this screen... Perform this action...
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Specify Initial 
User Groups

User groups have non-administrative (browse directories and read 
documents) access to the object store. Specify the initial list of groups, 
as follows:

To add user groups to the list, do the following:

a. Click Add....

b. In the Select Users and Groups screen, specify object type, 
realm, and search criteria as needed, and then click Find to 
display a list from which to select user groups.

c. Select a single item, or press and hold the CTRL (or SHIFT) key, 
and use the left mouse button to select multiple items (or the 
first and last of a range of items).

d. Release the CTRL (or SHIFT) key and click OK.

To remove user groups from the list, do the following:

a. Select a single item, or press and hold the CTRL (or SHIFT) key, 
and use the left mouse button to select multiple items (or the 
first and last of a range of items).

b. Release the CTRL (or SHIFT) key and click OK.

When your list is complete, click Next.

NOTE  If you specify an empty list, the wizard automatically adds 
#AUTHENTICATED-USERS, which gives non-administrative access to 
all network users in the authentication realm.

Completing the 
Create an Object 
Store Wizard

Review your selections and click Finish to create the object store. 
When the status displayed in the Object Store Create Status window 
shows that the object store has been successfully created, click OK.

In this screen... Perform this action...
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 14: Verify the Content Engine installation
To verify the Content Engine installation

140
Task 14:  Verify the Content Engine installation
Perform the following procedure to verify that Enterprise Manager can successfully access the 
object store you created in “Create the initial object store” on page 133. Perform the procedure also 
for each subsequent object store you create.

The procedure verifies that you can carry out the following operations in Enterprise Manager:

• Create folders and documents.

• Check documents in and out.

To verify the Content Engine installation

1. In Enterprise Manager, create a subfolder as follows:

a. Expand the Object Stores container and expand the node for the object store you just 
created.

b. Right-click the icon of the folder labeled Root Folder, and select New Sub Folder to start the 
Create New Folder wizard.

c. Enter the folder name, click Create.

2. Create a document as follows:

a. Expand the Root Folder container.

b. Right-click the subfolder you just created, and select New Document. 

c. Enter the Document Title (for example, Coffee Bean.bmp), click With content, and click 
Next.

d. Click Browse/Add to select a file (for example, c:\windows\Coffee Bean.bmp), click 
Open, and then click Create. 

NOTE The new containment name should be Coffee Bean with a major version of 1.

3. Check out a document as follows:

a. Right-click the document object (Coffee Bean.bmp) you just created, and select Exclusive 
Check Out (Default). Note the version number of the document as you check it out.

b. Navigate to the folder where you want the checked-out document to reside and click Open.

c. Click Yes to edit the file.

d. Make some change to the file and save it.

e. Close the application you used to edit the file.

4. Check in a document, as follows:

a. Right-click the document object (Coffee Bean.bmp) you just edited, and select Check In. 

b. In the File Name field, click Browse/Add.

c. Select the file you have checked out (e.g., Coffee Bean.bmp) and click Open.
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d. Click Check In.

e. Right-click the document object you just checked in and click the Versions tab of the 
Properties dialog box. You should now see the Major Version field change once the 
document is checked in. Note that the version number has been incremented.

To enable Enterprise Manager to display file storage area status

The Windows user who logged on to Enterprise Manager as a FileNet P8 user and then created a 
file storage area will see the status of the file storage area as online, and will be able to add 
content to it. All other Windows users, even if logged on to Enterprise Manager as the same 
FileNet P8 user who created the file storage area, will see its status as offline, and thus will not be 
able to add content to it.

• To make file storage areas visible and accessible to a Windows logon user, do one of the 
following:

– Add the user to the directory security of the file storage area with the following 
permissions: Modify, Read & Execute, List Folder Contents, Read, and Write.

– As a member of the Local Administrators group, add the Windows logon user to a group 
account, as explained in the IBM FileNet P8 help topic FileNet P8 Administration > 
Enterprise-wide Administration > FileNet P8 Security > Authorization > Storage area security.
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Install and configure Content Search Engine
This section contains the following major topics:

• “Install Content Search Engine” on page 143

• “Configure Content Search Engine” on page 152

• “(optional) Install additional locales” on page 159

• “Create a Content Search Engine collections directory” on page 162

• “Configure Content Engine for content-based retrieval” on page 165

• “Verify the Content Search Engine installation” on page 170
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Task 1: Install Content Search Engine
Use this procedure to install and configure IBM FileNet P8 Content Search Engine, an optional 
component based on the Autonomy K2 product.

Overview

The Autonomy K2 software must be installed on each machine that is part of your Content Search 
Engine configuration. You must designate one machine in the configuration as the Master 
Administration Server. The Master Administration Server can be used as a standalone Content 
Search Engine, or additional K2 Administration Servers can be added. All K2 Administration 
servers are configured and controlled through the K2 Dashboard of the Master Administration 
server.

The Autonomy K2 software that underlies IBM FileNet P8 Content Search Engine has many 
inherent features that you might want to configure that are not discussed in the IBM FileNet 
documentation. For details, see the Autonomy documentation that is installed with the Autonomy 
K2 Master Administration Server located at:

http://Master Administration Server hostname:9990/verity_docs/

The Autonomy documentation set is not searchable from the IBM FileNet P8 Help but it does have 
its own internal index and search functionality.

CAUTION  Although the K2 Dashboard provides you with documentation for, and direct interfaces 
to, the K2 collections, IBM FileNet requires that you use Enterprise Manager to manage 
collections associated with Content Search Engine index areas (for example, to add and remove 
index areas).

NOTES

• Autonomy K2 was previously known as Verity, and you will see Verity still used in many of the 
interfaces described in the following procedures.

• If your Content Engine runs on Windows, then the machines in your Content Search Engine 
configuration must run on Windows. If your Content Engine runs on UNIX, then the machines 
in your Content Search Engine configuration must run on UNIX, but it to doesn’t have to be the 
same UNIX type.

• Where machine name variables are required, IP addresses will not validate. A valid name 
must be entered.

• If you unimport the style set, the original files will be deleted from your system. In this 
scenario, if you wish to re-import the style set, you will need to recover it from your installation 
package. In order to avoid this situation, you can either enter a unique name for the Style Set 
Alias during the initial Content Search Engine (Autonomy K2) installation, or make a backup 
copy of the original style set. If you enter a unique name for the style set during installation, 
ensure you use that name when you configure Content Engine for Content-Based Retrieval.

• Stop word files can be used to increase performance by about 30%. You can put a file named 
style.stp into the stylefiles directory to list words you do not want full-text indexed (for 
example, short words such as a, the, and). However, using a stop word file also prevents 
searching on these words. See the K2 documentation for more details. To create a stop word 
file you can typically copy a file named vdk30.stp from either the main K2 install directory or 
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the foreign language locales package over to the main stylefile directory, and then rename it to 
style.stp. You must do this copy operation before you create collections.

Indexing is case-sensitive, so the style.stp file should include capitalized versions of words in 
the stop word list in addition to the lower-case version. For example, use “the”, “The” and 
“THE” if you think all of these would be encountered on a search.

Install Content Search Engine on Windows
Install the Autonomy K2 software on each machine in your Content Search Engine configuration. 
You must complete a K2 Master Administration Server software installation before you can add 
any additional K2 Administration Server installations. The Master Administration Server’s 
dashboard is the central control point for configuring all additional Administration Servers that are 
part of the Content Search Engine configuration.

You must designate each installation as either a Master Administration Server software 
installation or an Administration Server software installation.

CAUTION Only one K2 Master Administration Server can be installed for each Content Engine 
Domain.

To install Autonomy K2 on Windows

1. Access the host machine and log on as k2_os_user. For details on required accounts and related 
permissions, see “Accounts for Content Search Engine” on page 92 in Plan and Prepare Your 
Environment for IBM FileNet P8.

NOTE  Ensure k2_os_user has administrator privileges on this machine.

2. Set the JAVA_HOME environment variable as follows:

a. Open the System control panel.

b. Click the Advanced tab.

c. Click Environment Variables.

d. Click New under System Variables.

e. Set the variable information as follows:

Variable name: JAVA_HOME

Variable value: Java (JDK) install path

NOTE  The installer will not allow you proceed with the installation until the JAVA_HOME 
environment variable is set.

3. Start the Content Search Engine installation, choosing either the interactive or silent steps 
below, For information on the Content Search Engine parameter values to specify in the 
installation, see “Installation and Upgrade Worksheet” in Plan and Prepare Your Environment 
for IBM FileNet P8.

HINT  With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls), perform the following steps to quickly see only 
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the installation properties you must specify for the Content Search Engine installation 
program:

– Click the AutoFilter drop-down arrow in the "FileNet P8 Component” column header 
and select CSE (Windows).

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header, and select CSE Installer.

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

• To install interactively:

i. Access the IBM FileNet Content Search Engine installation package and execute the 
P8CSE-4.5.0-WIN.EXE file. 

ii.  Complete the installation program wizard using the following table:

In this screen... Perform this action...

JAVA_HOME Not 
Set

This screen will appear only if you have not set the 
JAVA_HOME environment variable on the machine.

Click Cancel to exit the installation program and set the 
required environment variable.

NOTE  The installer will not allow you to continue until you set 
the environment variable.

Click Next to continue.

JAVA_HOME for K2 
Server

Enter the path to the supported Java (JDK) installation and 
click Next to continue.

Welcome Click Next to proceed with the installation.

NOTE Click Previous at any time to make changes in previous 
screens. Click Cancel to exit the program.

Software License 
Agreement

Review and accept the license agreement.

Click Next to continue.

Specify Content 
Search Engine 
Installation Path

Specify the directory in which you want to install Content 
Search Engine. The installation program will create any 
specified directories that do not already exist.

Click Next to continue.

Select Autonomy 
K2 Server Type

Choose whether to install a Master Administration Server 
(required for first-time installation) or an Administration 
Server.

Click Next to continue.
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• To install silently

i. Access the IBM FileNet Content Search Engine installation package and edit the 
CSE_silent_install.txt file to reflect the appropriate responses for your installation.

ii. Launch the Content Search Engine installer by executing the following command:

P8CSE-4.5.0-WIN.EXE -f CSE_silent_install.txt -i silent

NOTE  The following two Autonomy K2 services will be installed and started on your machine 
after the installation is complete:

• Verity K2 6.2.1 Administration Server service.

• Verity K2 Administration Web Server service (Tomcat server).

4. Review the following Content Search Engine log files for installation errors. The files are located 
in the verity directory of the install path:

• cse_install_path\verity\cse_install_log_4_5_0.txt

• cse_install_path\verity\vconfig.log

5. Continue at “Configure Content Search Engine” on page 152.

Specify 
Administration 
Server Information

This screen will appear only if you selected Administration 
Server on the Select Autonomy K2 Server Type screen.

Enter the host name and port for the Administration Server.

Click Next to continue.

Specify Master 
Administration 
Server Information

Enter the host name and server port for the Master 
Administration Server.

NOTE  If you are installing a K2 Administration Server, the 
Master Administration Server must already be installed.

Click Next to continue.

K2 Operating 
System User 
Account

Enter the k2_os_user login information and the name of the 
Verity domain on which this K2 server communicates with the 
Content Engine.

Click Next to continue.

Review Pre-
installation 
Summary

Verify your component selections, and click Install to start 
installing software.

Install Complete Click Done to complete the installation.

In this screen... Perform this action...
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Install Content Search Engine on UNIX
You must install the K2 Master Administration Server software first. The Master Administration 
Server’s dashboard is the central control point for configuring Content Search Engine for single-
server or multi-server installations.

You must designate each installation as either a Master Administration Server software 
installation or an Administration Server software installation.

CAUTION Only one K2 Master Administration Server can be installed for each Content Engine 
domain.

To install Content Search Engine on UNIX

NOTE  Most processes for the Autonomy K2 software will run as k2_os_user. However, the 
vspget process must run as root. For details on required accounts and related permissions, see 
“Accounts for Content Search Engine” on page 92 in Plan and Prepare Your Environment for IBM 
FileNet P8.

1. Access the host machine and log on as a user with root privileges.

2. Enter the following commands to set the vspget program’s setuid bit such that the service runs 
as root:

chown root /verity install path/k2/_platform/bin/vspget

chmod u+s /verity install path/k2/_platform/bin/vspget 

Replace _platform with the following directory, according to your environment: 

3. Log off the machine.

4. Log on to the machine as k2_os_user.

5. Set the following environment variable and place the entry in the .profile file for 
k2_os_user.

JAVA_HOME=java_(JDK)_install_path/jdkversion

export JAVA_HOME

6. Start the Content Search Engine installation using your Installation and Upgrade Worksheet. For 
information on the Content Search Engine parameter values, see “Installation and Upgrade 
Worksheet” in Plan and Prepare Your Environment for IBM FileNet P8.

Platform Directory

HPUX _hpux

AIX _rs6k43

Solaris _ssol26

Linux _ilnx21
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HINT  With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls), perform the following steps to quickly see only 
the installation properties you must specify for the Content Search Engine installer:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select CSE Installer.

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Installation."

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

• To install interactively (X-Terminal must be installed):

i. Access the IBM FileNet Content Search Engine installation package and execute the 
appropriate installation program:

ii.  Complete the installation program wizard using the following table:

Platform Command

HPUX P8CSE-4.5.0-HPUX.BIN

AIX P8CSE-4.5.0-AIX.BIN

Solaris P8CSE-4.5.0-SOL.BIN

Linux P8CSE-4.5.0-LINUX.BIN

In this screen... Perform this action...

JAVA_HOME Not 
Set

This screen will appear only if you have not set the 
JAVA_HOME environment variable on the machine.

Click Cancel to exit the installation program and set the 
required environment variable.

NOTE  The installer will not allow you to continue until you set 
the environment variable.

JAVA_HOME for K2 
Server

Enter the path to the supported Java (JDK) installation and 
click Next to continue.

Welcome Click Next to proceed with the installation.

NOTE Click Previous at any time to make changes in previous 
screens. Click Cancel to exit the program.

Software License 
Agreement

Review and accept the license agreement.\

Click Next to continue.
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• To install silently

i. Access the IBM FileNet Content Search Engine installation package and edit the 
CSE_silent_install.txt file to reflect the appropriate responses for your 
installation.

ii. Execute one of the following commands, based on your operating system:

Specify Content 
Search Engine 
Installation Path

Specify the directory in which you want to install Content 
Search Engine. The installation program will create any 
specified directories that do not already exist.

Click Next to continue.

Select Autonomy 
K2 Server Type

Choose whether to install a Master Administration Server 
(required for first-time installation) or an Administration 
Server.

Click Next to continue.

Specify 
Administration 
Server Information

This screen will appear only if you selected Administration 
Server on the Select Autonomy K2 Server Type screen.

Enter the host name and server port for the Administration 
Server.

Click Next to continue.

Specify Master 
Administration 
Server Information

Enter the host name and server port for the Master 
Administration Server.

NOTE  If you are installing a K2 Administration Server, the 
Master Administration Server must already be installed.

Click Next to continue.

K2 Operating 
System User 
Account

Enter the k2_os_user log in information and click Next to 
continue.

Review Pre-
installation 
Summary

Verify your component selections, and click Install to start 
installing software.

Install Complete Click Done to complete the installation.

Platform Command

HPUX P8CSE-4.5.0-HPUX.BIN -f CSE_silent_install.txt -i silent

AIX P8CSE-4.5.0-AIX.BIN -f CSE silent install.txt -i silent

In this screen... Perform this action...
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NOTE  The following two Autonomy K2 services will be installed and started on your machine 
after the installation is complete:

• Verity K2 6.2.1 Administration Server service.

• Verity K2 Administration Web Server service (Tomcat server).

7. Review the following Content Search Engine log files for installation errors. The files are located 
in the verity directory of the install path:

• cse_install_path/verity/cse_install_log_4_5_0.txt

• cse_install_path/verity/vconfig.log

8. Set the following environment variables and place the entries in the .profile file for 
k2_os_user.

HP-UX

PATH=$PATH:/verity_install_path/k2/_hpux/bin

export PATH

SHLIB_PATH=$SHLIB_PATH:/verity_install_path/k2/_hpux/bin

export SHLIB_PATH

AIX

PATH=$PATH:/verity_install_path/k2/_rs6k43/bin

export PATH

LIBPATH=$LIBPATH:/verity_install_path/k2/_rs6k43/bin

export LIBPATH

Solaris

PATH=$PATH:/verity_install_path/k2/_ssol26/bin

export PATH

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/verity_install_path/k2/_ssol26/bin

export LD_LIBRARY_PATH

Linux

PATH=$PATH:/verity_install_path/k2/_ilnx21/bin

export PATH

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/verity_install_path/k2/_ilnx21/bin

export LD_LIBRARY_PATH

Linux P8CSE-4.5.0-LINUX.BIN -f CSE_silent_install.txt -i 
silent

Solaris P8CSE-4.5.0-SOL.BIN -f CSE_silent_install.txt -i silent

Platform Command
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To start or stop the Autonomy K2 Services on UNIX

To manually start or stop the Autonomy K2 services, use the following commands, according to 
your environment:

HP-UX

Start services:

nohup /verity_install_path/k2/_hpux/bin/k2adminstart &

Stop services:

/verity_install_path/k2/_hpux/bin/k2adminstop

AIX

Start services:

nohup /verity_install_path/k2/_rs6k43/bin/k2adminstart &

Stop services:

/verity_install_path/k2/_rs6k43/bin/k2adminstop

Solaris

Start services:

nohup /verity_install_path/k2/_ssol26/bin/k2adminstart &

Stop services:

/verity_install_path/k2/_ssol26/bin/k2adminstop

Linux

Start services:

nohup /verity_install_path/k2/_ilnx21/bin/k2adminstart &

Stop services:

/verity_install_path/k2/_ilnx21/bin/k2adminstop
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 2: Configure Content Search Engine
To configure Content Search Engine

152
Task 2: Configure Content Search Engine
Use this procedure to configure services required on the K2 Master Administration Server, and on 
additional Administration Servers you may install for IBM FileNet P8 Content Search Engine. All 
servers are configured through the Master Administration Server Dashboard.

NOTES 

• When naming servers you create with this procedure, it is a best practice to indicate the type 
of server you’ve created. Otherwise, when you configure Content Engine through the 
Enterprise Manager, determining which server is which could be confusing. For example, use 
server_name_broker to indicate a Broker Server service.

• Ensure you carefully record the server names, ports and settings that you define. Much of the 
following information will be required later when you configure the IBM FileNet P8 Content 
Engine for Content-Based Retrieval later in this guide.

• A range of ports is recommended in the Verity K2 Dashboard for each service you create. You 
do not have to choose a port number from within that range.

• Repeat the related step in the procedure below to add additional services. Some guidelines 
must be adhered to when adding additional services:

– Multiple brokers can be assigned, so that if one goes down the others will be used. 
However, each broker must have all K2 Servers (search servers) attached that are needed 
to access collections (index areas). The Content Engine Server will not call multiple 
brokers and merge the results.

– If you add additional Index Servers and K2 Servers (search servers), they will not be 
activated until you enable them through Enterprise Manager. See “Configure Content Engine 
for content-based retrieval” on page 165 for details.

– Each K2 Administration Server must contain a Ticket Server for Content Engine.

– For good stability and performance, Broker Servers must be attached to local Ticket 
Servers for security on each machine.

To configure Content Search Engine

1. Configure the Autonomy K2 Dashboard to use SSL security. The Autonomy K2 Dashboard web 
application, by default, uses a non-SSL web site and sends username and password information 
in plain text. For information on how to modify your Tomcat web applications to use SSL, access 
the following address:

 http://tomcat.apache.org/tomcat-5.5-doc/ssl-howto.html

2. Access the K2 Dashboard by launching your browser and entering:

http://Master Administration Server hostname:9990/verity_dashboard/main.jsp
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Use the appropriate values from your installation and upgrade worksheet for the procedures 
that follow.  For more information, see “Installation and upgrade worksheet” on page 229 of Plan 
and Prepare Your Environment for IBM FileNet P8.

HINT  With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to quickly see only the required 
properties:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select “K2 Dashboard”.

– Optional: click the AutoFilter drop-down arrow in the "FileNet P8 Component" column 
header and select “CSE (UNIX)” or “CSE (Windows)", depending on your operating 
system type.

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

3. Create a K2 Index Server, as follows:

a. Click K2 Index Servers under System View.

b. Click Add a K2 Index Server on the K2 Index Server Summary page.

c. Enter the following information on the Configure basic settings for the new K2 Index Server 
page:

• Service Alias: K2 Index Server Alias

• Port: 9960 - 9979 (suggested range)

d. Click Next to continue with the installation.

e. Enter the following information on the Configure threads for the K2 Index Server page:

• Synchronous Threads: 25

• Asynchronous Threads: 3

• Access Type: Authorized Administrator

f. Click Finish to continue with the installation.

4. Set the Index Server logging properties:

a. Click the Index Server, Under System View, that you want to adjust.

b. Click Edit Properties under Actions.

c. Click the Logging tab.

d. For Status Log Nominal Size, enter the following value:

9000 kilobytes

e. Click Modify.
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5. Create a K2 Broker Server:

a. Click K2 Brokers under System View.

b. Click Add a K2 Broker on the K2 Broker Summary page.

c. Enter the following information on the Configure basic settings for the new K2 Broker page:

• Service Alias: K2 Broker Server Alias

• Port: 9900 - 9909 (suggested range)

d. Click Finish.

6. Create a K2 Server (search server) and attach the Broker:

a. Click K2 Servers under System View.

b. Click Add a K2 Server under Actions on the K2 Server Summary page.

c. Enter the following information on the Configure basic settings for the new K2 Server page:

• Service Alias: K2 Server (search server) Alias

• Port: 9920 - 9949 (suggested range)

d. Click Next.

e. Click Next on the Set security options for this service page.

f. Enter the following information on the Attach to K2 Brokers page:

• Select the K2 Brokers that will provide access to this service: Select the K2 Broker you 
created in step 3 from the drop-down menu, server_name_broker.

g.  Click Finish.

7. Import the IBM FileNet Styleset.

a. Click Collections under System View.

b. Click Manage Style Sets under Actions on the Collection Summary page.

c. Click Import on the Manage Style Sets page (top right).
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d. Enter the following information on the Import page:

• Style Set Alias: FileNet_FileSystem_PushAPI

• Gateway Type: --Auto-detect--

• Source Administration Server. If multiple servers are installed, choose the server to 
which you will import the Styleset.

• Source Path:

Windows

install_path\verity\data\stylesets\FileNet_FileSystem_PushAPI

UNIX

 install_path/verity/data/stylesets/FileNet_FileSystem_PushAPI

e. Click Import.

NOTE  The K2 Dashboard displays a notification that the StyleSet Editor web application 
cannot be accessed. This message can be ignored as it relates to a function that is not used 
by IBM FileNet Content Search Engine.

8. Create a K2 Ticket Server.

a. Click K2 Ticket Servers under System View.

b. Click Add a K2 Ticket Server under Actions on the K2 Ticket Server Summary page.

c. Enter the following information on the Configure basic settings for the new K2 Ticket Server 
page:

• Service Alias: K2 Ticket Server Alias

• Port: 9910 - 9919 (recommended range)

d. Click Next.

e. Enter the following information on the Configure the login module to use with this K2 Ticket 
Server page:

• Select which Login Module type to use with this K2 Ticket Server:

NOTE  LDAP Ticket Servers are not currently supported.

– Windows

– UNIX

• Default Domain (Windows only): Enter the domain on which this K2 Server is 
authenticated. 

f. Click Next.
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g. Enter the following information on the Configure the persistent store module to use with this 
K2 Ticket Server page:

• Select the Persistent Store Module type to use with this K2 Ticket Server: Choose File 
and Memory.

h. Click Finish.

i. (Windows only) Specify local login settings:

i. Click Edit Properties.

ii. Click Windows Login Module.

iii. Check Use Local Credentials:.

iv. Check Enable Built-in Groups.

v. Click Modify.

9. Set Autonomy K2 Administration Security.

a. Click the K2 Ticket Server you created.

b. Click Manage Administration Security under Actions.

c. Enter the following information on the Manage Administration Security page:

• Select a K2 Ticket Server to configure for administration security: From the drop-down 
menu, select the K2 Ticket Server you just created.

• User Name: Enter the k2_os_user. For UNIX installs, this is the user you logged in as to 
run the installation. For details on required accounts and related permissions, see 
“Accounts for Content Search Engine” on page 92 in Plan and Prepare Your Environment 
for IBM FileNet P8.

• Password: Enter the authentication password.

• Default Domain (Windows only): Enter the domain on which this user and K2 Server 
are authenticated.

d. Click Modify.

The K2 software will authenticate the user based on the information you entered. If the 
check fails, an error message will indicate what failed and request that you re-enter the 
information.

If administrator access is successful, Autonomy K2 will close the Dashboard and require 
that you log on again as the Dashboard Administrator to complete the configuration.

10. Launch the K2 Dashboard and log on.
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11. Restart K2 services:

a. Under Notifications on the K2 Dashboard Home page, a number of servers are listed as 
requiring a restart. Click Start/Stop this Service to access the settings page and follow the 
instructions listed there. You must perform either a Quick Restart or a Full Restart.

b. Click Home in the top-left corner of the page after each restart to view the remaining 
notifications. Repeat the process until there are no notifications remaining.

12. Enable additional K2 Admin Users (optional).

a. From the K2 Dashboard home page, click Administration Servers.

b. Click Manage K2 Administrative Users.

c. Click Add User on the Manage K2 Administrative Users page.

d. Enter the name of an authenticated user on the directory service that you want to make a K2 
Administrator and click Add.

13. Enable security on the K2 services you have created.

a. From the K2 Dashboard home page, click K2 Ticket Servers.

b. Click your ticket server server_name_ticket_server.

c. Click Manage K2 Broker/K2 Server Security in the Services Secured by this K2 Ticket 
Server section of the page (bottom right).

d. Click the K2 Servers button on the Manage K2 Broker/K2 Server Security page.

e. Click the service you just created which is listed in the window on the right to enable 
security.

CAUTION  If you have a multi-server configuration, numerous services, installed on other 
machines, will be listed also. Select only the service to which you want to attach a broker. 
Brokers must be attached to local ticket servers for Content Search Engine.

f. Click the K2 Brokers button on the Manage K2 Broker/K2 Server Security page.

g. Click the Broker in the window on the right that you want to attach to the local K2 ticket 
server you selected above.

h. Click Modify to save your changes.

14. Restart K2 services, as follows:

a. Click Home in the top left corner of the page.

b. Under Notifications on the Verity K2 Dashboard Home page, a number of servers are listed 
as requiring a restart. Click Start/Stop this Service to access the settings page and follow 
the instructions listed there. You must perform either a Quick Restart or a Full Restart.

Click Home in the top left corner of the page after each restart to view the remaining 
notifications. Repeat the process until there are no notifications remaining.
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To configure services on Administration Servers

Use this procedure to create and configure services on specific Content Search Engine machines 
(Administration Servers), other than the Master Administration Server. Services for all machines 
in your Content Search Engine configuration are configured through the Master Administration 
Server Dashboard.

1. Click Administration Servers under System View.

2. Click the Administration Server to which you want to add services.

3. Click Add a Service under K2 Services on this Administration Server.

4. Select the service you want to add.

5. Follow the instructions and guidelines for the appropriate service in the To configure Content 
Search Engine procedure above to complete the service addition.
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Task 3: (optional) Install additional locales
Complete this procedure only if you require locales other than English.

NOTES

• The panels in the Locales installer indicate that the installer is only compatible with Autonomy 
K2 version 6.2.0. However, the Locales installer is compatible with version 6.2.1, the version 
you installed with IBM FileNet Content Search Engine 4.5.

• On one of the installer panels, you will be asked to select your installed version of Autonomy 
K2 from a dropdown menu. Select K2 6.2.0 as the valid entry.

CAUTION  Although the Locales installer offers the option of installing to a location other than the 
Verity install location, do not choose this option. For Content Search Engine, you must install the 
locales to the k2 directory of the Autonomy K2 installation path.

Windows

1. Access the Autonomy K2 Master Administration Server machine and log on as k2_os_user.

2. Copy the P8CSE450WIN.zip file from the installation package to the machine and extract the 
contents to a local directory.

3. Stop the Autonomy K2 services.

a. Access Component Services.

b. Stop the Verity K2 Administration Server service and the Verity K2 Administration Web 
Server service.

4. Create a directory in the following specific location (default drive shown):

C:\Program Files\Common 
Files\InstallShield\Universal\WinVersion\x86\host_name\Gen1\_vpddb

a. Replace WinVersion with one of the following valid options:

• Windows XP

• Windows 2000

• Windows Server 2003

• Windows Vista (this option also includes Windows 2008)

b. Replace host_name with the name of the Master Administration Server machine.

For example:

C:\Program Files\Common Files\InstallShield\Universal\Windows 
2003\x86\myMachine\Gen1\_vpddb
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5. Locate the vpd.script file in the K2 install directory and open it in a text editor. Make the following 
modifications in the file:

• Replace the instance of <K2InstallDir> with the K2 install directory. For example:

C:\Program Files\FileNet\ContentEngine\verity

• Replace the instance of <myHostName> with the Master Administration Server machine name. 

• Replace the instance of <WinVersion> with the same option you chose in step 4 above. 

6. Copy the vpd.script file to the directory location you created in step 4 above.

7. Navigate to the decompressed Locales installer location and execute the setupwin32.exe 
file.The installer will locate the K2 installation and start, based on the settings you completed 
above.

NOTE  The following license key is required:

2UV4MPT-2KPEQBJ-1D6A6KT-2KPE6KT-2KPE6KS

8. Start the Verity K2 services after the installation is complete.

UNIX

1. Access the Autonomy K2 Master Administration Server machine and log on as k2_os_user.

2. Copy the appropriate compressed file for your platform from the installation package to the 
machine and extract the contents to a local directory. For example:

P8CSE450AIX.tar.gz

3. Stop the Autonomy K2 services.

a. Access opt/verity/appserver/bin

b. Use the following command, according to your environment:

HP-UX

/verity_install_directory/k2/_hpux/bin/k2adminstop

AIX

/verity_install_directory/k2/_rs6k43/bin/k2adminstop

Solaris

/verity_install_directory/k2/_ssol26/bin/k2adminstop

Linux

/verity_install_directory/k2/_ilnx21/bin/k2adminstop

4. Prepare your system with the following environment variable: 

VERITY_CFG=/opt/verity/k2/common/verity.cfg 

export VERITY_CFG
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5. Navigate to the decompressed Locales installer location and execute the setupUNIX_type.bin. 
For example:

setupaix.bin

NOTE  The following license key is required:

2UV4MPT-2KPEQBJ-1D6A6KT-2KPE6KT-2KPE6KS

6. Start the Verity K2 services after the installation is complete.
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Task 4: Create a Content Search Engine collections 
directory
Use this procedure to configure the storage location and related security for your K2 collections.

Collections directory requirements
CAUTION  Contrary to information outlined in the Autonomy-supplied documentation set, remote 
collections are not supported for use with IBM FileNet Content Search Engine. Collections must 
be written locally to the Autonomy K2 server. Using a remote-mounted disk that is accessed via the 
network (NFS, PCNFS, or CIFS) will cause stability problems under load and corrupt your 
collections. Any existing configurations that contain non-local collections directories must be re-
configured.

To create a collections directory

For performance reasons, create one collections directory for each index area you create in IBM 
FileNet P8 Content Engine. Each collections directory you create must be set to provide proper 
security access as outlined below. The path to both the collections directory and collections temp 
directory must be entered in the index area properties when you create the index area. 

Security and communication between Autonomy K2, Content Engine, and the collections directory 
is handled through the user accounts and permissions provided to those accounts. For details on 
required accounts and related permissions, see “Accounts for Content Search Engine” on page 92 in 
Plan and Prepare Your Environment for IBM FileNet P8.

For detailed information on security, see the IBM FileNet P8 help topic System Administration > 
Enterprise-wide Administration > FileNet P8 Security > Authorization > Security for integrated components 
and third-party products > Autonomy K2 Server > Security for Autonomy K2 Server.

1. Create a directory on the Autonomy K2 machine in which you will store collections. Set 
permissions to allow read, write and execute permissions to k2_os_user.

NOTE  This path must be local to the index server that will be assigned to write collections.

2. Create a temp directory on the Autonomy K2 machine on which you created the collections 
directory. The temp directory will be used by the K2 Index Server and Content Engine Server 
during operations.

NOTE  This path must be visible to both the Content Engine and the Content Search Engine 
servers. If the K2 Master Administration Server and Content Engine are not installed on the 
same machine, they both must be on a network-mounted file system.

3. Record the collections directory path in the Autonomy K2 configuration file.

Windows

a. Open the following K2 configuration file in a text editor (default path shown):

C:\Program Files\filenet\contentengine\verity\k2\common\verity.cfg
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b. Modify the next available alias settings by adding the collections path, where new collections 
will be written. For example, change alias6, mapping6, and dirmode6 to the following:

alias6=path1

mapping6=C:\Collections_Directory

dirmode6=wr

UNIX

a. Open the following K2 configuration file in a text editor (default path shown):

/opt/verity/k2/common/verity.cfg

b. Modify the next available alias settings by adding the collections path. For example, change 
alias6, mapping6, and dirmode6 to the following:

alias6=path1

mapping6=/Collections_Directory_Path

dirmode6=wr

NOTE  The Collections_Directory_Path must be a local path and not a mount point.

4. Set file storage area access. Each file storage area that will be full text indexed must be 
accessible by the Autonomy K2 server that will perform the full-text indexing. Permissions on the 
file store must be set the same as the permissions on the collections directories, allowing both 
the Content Engine Operating System User and the K2 Operating System User to access them. 
The names of the file store directories must also be the same on each server that accesses 
those directories.

If Content Engine and Autonomy K2 are installed on separate machines, then the file store 
must be accessible to both the Content Engine and the Autonomy K2 servers. For Windows, 
the file store path must be a UNC path name accessible to the Autonomy K2 machine. For 
UNIX, the file store must be NFS-mounted on the Autonomy K2 machine with the same name 
as it appears on all other machines.

Windows-specific options

You can configure a read-only Autonomy K2 Administration server which will remotely read 
collections (note that you cannot have a second K2 Administration server that writes the 
collections). To do this, you must map a drive on the read-only Administration server to the file 
system on the Autonomy K2 machine that writes collections.

To do this, share the Autonomy K2 machine’s collections drive (for example, D:\) as some name 
other than D$, because you can't set permissions on D$. For example, set it as DDrive.

Map the D:\ drive on the read-only Autonomy K2 machine to \\servername\DDrive.

Now D:\collections on the read-only Autonomy K2 machine references the same file system as 
the D:\ drive on the Autonomy K2 machine that writes the collections.

By default, the k2admin.exe program on the read-only Autonomy K2 machine runs as a Windows 
service. This is a problem because Windows services can not mount mapped drives.
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One solution to this problem is to run the k2admin.exe program from a command line instead, so 
that it doesn’t run as a Windows service. To launch the service manually from a command line on 
a default installation, execute the following command:

C:\Program Files\verity\k2_61\k2\_nti40\bin\k2admin.exe" -cfg "C:\Program 
Files\verity\k2_61\k2\common\verity.cfg

NOTE Only the Verity K2 6.1.1 Administration Server service (k2admin.exe) must be started this 
way. The Verity Administration Web Server may be left as a Windows service.

Another solution is to use a tool like the srvany.exe program (supplied as part of the Windows 
Resource kit) to run a .cmd file that first maps the drives, and then issues the command above to 
start the k2admin.exe service. The command to map drives, using the above example, is:

net use D: \\servername\DDrive

There are also third-party products available that function the same as the svrany.exe program.

Although the svrany.exe program will start the service correctly, it cannot stop the service. You 
must use the Autonomy rcadmin command line tool to stop the service, or use TaskManager and 
stop all the processes that start with the prefix k2.

To use the Autonomy rcadmin program from a command line:

1. Access a command line and type the following command:

rcadmin

2. Enter the following command to log on:

login k2_os_user

3. Enter the following command to initiate the shutdown:

adminsignal

4. Enter one of the following responses to the Type of Signal query:

• 2 - Shutdown

• 3 - WS Refresh

• 4 - Restart all servers
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Task 5: Configure Content Engine for content-based 
retrieval
This task covers use of Enterprise Manager to configure an index area and enable the content-
based retrieval (CBR) feature provided by the IBM FileNet P8 Content Search Engine. 

For more detail on content-based retrieval and Content Engine, see the IBM FileNet P8 help topic 
Configure CBR found at FileNet P8 Administration > Content Engine Administration > content-based 
retrieval > How to... > Configure CBR.

NOTES

• Before you complete the procedures in this topic, ensure the IBM FileNet P8 Content Search 
Engine has been installed and configured on at least one server (In effect, this means you 
have already installed and configured an Autonomy K2 Master Administration Server).

• Numerous K2 security accounts are referenced within this procedure. For details on required 
accounts and related permissions, see the Specify IBM FileNet P8 Accounts topic.

• Various server names and related ports assigned during the installation and configuration of 
Autonomy K2 will be required during this procedure. If you do not have a record of the servers 
created and the ports that have been assigned, log on to the Autonomy K2 dashboard to 
obtain the information necessary.

• If you unimport the style set, the original files will be deleted from your system. In this 
scenario, if you wish to re-import the style set, you will need to recover it from your installation 
disk. In order to avoid this situation, you can either enter a unique name for the Style Set Alias 
during the initial Content Search Engine (Autonomy K2) installation, or make a backup copy of 
the original style set. If you entered a unique name for the style set during installation, ensure 
you use that Style Set Alias name for this procedure.

• Where machine name variables are required, IP addresses will not validate. In these cases, 
you must enter the host name for the machine.

To configure Content Engine for content-based retrieval

1. Launch Enterprise Manager and log on as the GCD Administrator.

2. Create a Verity Domain Configuration (VDC).

a. Right-click Enterprise Manager [domain] in the Enterprise Manager tree and select 
Properties.

b. Click the Verity Domain Config. tab.
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c. Enter the following K2 Master Administration Server access information:

• Host Name - the name of the host of the K2 Master Administration Server.

• Port - the K2 Master Administration Server port.

• User Domain - the authentication domain in which your K2 services are installed.

• User Group - K2 Security Group.

• Verity Username - K2 Security User.

• Password - the K2 Security User password.

d. Click Create Configuration to create a Verity Domain Configuration object.

3. Assign a K2 Broker Server:

a. Click the Verity Server tab.

b. From the Brokers AVAILABLE pane, select the broker and click Add to move the server to 
the Brokers Selected pane.

c. Click OK.

NOTE  You can assign multiple Broker Servers to a K2 Administration Server, primarily for 
failover. If one Broker Server goes down, then K2 can switch to another. In this configuration, 
you must ensure that all Search Servers required to access K2 Collections (index areas) are 
attached to each Broker Server. Be aware that a given Content Engine server will neither call 
multiple Broker Servers nor merge associated search results. See the appropriate steps of the 
Configure Content Search Engine task for instructions on how to create Broker Servers and 
assign Search Servers.

4. Enter a CBR Locale.Choose one of the following locales which are installed by default with the 
Autonomy K2 Content Search Engine software:

• uni (multi-language and slower indexing)

• englishv (enhanced word-stemming and faster indexing)

• english (limited capabilities and very fast indexing)

If you click the Set to Default button, uni will be set as the CBR Locale.

CAUTION To ensure you understand how the K2 product uses locales and how your choice 
affects performance and indexing options, review the Verity Locale Configuration Guide which 
is part of the Autonomy-supplied documentation set. To access the Verity Locale Configuration 
Guide:

i. Open the Autonomy K2 Dashboard and click Help.

ii. Click Library (top right of the screen) to access the Autonomy K2 product guides. Each 
guide is available in HTML or PDF format.

a. Right-click the Object Store for which you want to enable indexing and select Properties.

b. Click the Locale tab.

c. Enter a valid Autonomy K2 locale for CBR.
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5. Create an index area. Launch the Create an Index Area wizard:

a. In the tree view, expand the Object Stores container.

b. Right-click the object store to which you want add an index area and select New > Index 
Area.

c. Complete the Create an Index Area wizard using the following table:

In this screen... Perform this action...

Welcome Click Next to proceed with the index area creation.

NOTE Click Back at any time to make changes in previous 
screens. Click Cancel to exit the wizard.

Select Index Area 
Site

From the list of available sites, select the site to which the 
index area you are creating will be associated

Click Next to continue.

Name and Describe 
the Index Area

Enter a name and description for the new index area.

Click Next to continue.

Enter Index Area 
Verity Directories

Enter the following Content Search Engine information:

• For Template Type, enter the following:

FileNet_FileSystem_PushAPI

• Verity collections directory path, stated as local to the 
CSE machine on which it resides. For example:

Windows

C:\collections

UNIX

opt/collections

• Verity temp directory path, stated as local to the CSE 
machine on which it resides. For example:

Windows

C:\tempdir

UNIX

opt/tempdir

Click Next to continue.

Select Verity 
Search Servers

From the list of available search servers, select at least one 
server to be used for this index area.

Click Next to continue.
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For more information on creating indexes, see the IBM FileNet P8 help topic FileNet P8 
Administration > Content Engine Administration > content-based retrieval > How to... > Create Verity 
index area.

6. Enable CBR for class definitions by activating the CBR Enable flag of the class you want 
available for CBR, as follows:

a. Right-click the class you want to configure in the Enterprise Manager tree and click 
Properties.

b.  Select CBR Enabled and click OK.

7. Enable CBR for the class properties you want available for CBR, as follows:

a. Right-click the class you want to configure and click Properties.

b. Click the Property Definitions tab.

c. Click the string property you want to enable for CBR indexing and click Edit.

d. Check CBR Enabled and click OK.

To enable additional K2 Index Servers and Search Servers

If you add additional K2 Index Servers or Search Servers to an existing configuration, you must 
enable them through Enterprise Manager to utilize them.

1. Log on to Enterprise Manager as the GCD Administrator and expand the Enterprise Manager 
tree.

2. Open the Index Area folder.

3. Right-click the index area that you want to add the new services to and select Properties.

4. Enable the new Search Servers as follows:

a. Click Edit Search Servers.

b. In the Search Servers Available pane, highlight any servers you want to enable for this index 
area and click Add to add the server to the Search Servers Selected list.

c. Click OK to save the settings and enable the new servers.

Select Verity Index 
Servers

From the list of available index servers, select at least one 
server to be used for this index area.

Click Next to continue.

Completion Screen Review the entries you have selected for this index area and 
click Finish to complete the wizard and create the index area 
with the options you specified.

In this screen... Perform this action...
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5. Enable the new Index Servers as follows:

a. Click Edit Index Servers.

b. In the Index Servers Available pane, Highlight any servers you want to enable for this index 
area and click Add to add the server to the Index Servers Selected list.

c. Click OK to save the settings and enable the new servers.
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Task 6: Verify the Content Search Engine installation
To verify that the Content Search Engine installation and configuration succeeded, perform the 
following procedure.

To verify the Content Search Engine installation

1. In Enterprise Manager, access the Root Folder and open a subfolder that contains a (nonempty) 
text document.

2. Right-click a document and select All Tasks > Index for Content Search.

A Notice should indicate that a content search index Job was created successfully.

3. Right-click the object store node for the document you set to index for content search and select 
All Tasks > Index Jobs Management.

4. In the Index Jobs Manager, check to see that the Job Status indicates the job has terminated 
normally. If the Job Status indicates an abnormal termination, check the 
p8_server_trace.log in application server directory in the FileNet directory.

NOTE  Depending on the size of the job, it may take a few minutes for the indexing job to 
complete. If the Job Status indicates that the indexing is in progress, wait a few minutes to 
give the job time to complete.
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Install and configure Process Engine
This section contains the following major topics:

• “Install Process Engine” on page 172

• “Install Process Engine software updates” on page 196

• “Install the latest Content Engine Client files on Process Engine servers” on page 197

• “Configure Process Task Manager” on page 201

• “Complete post-installation Process Engine configuration (Windows only)” on page 203
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Task 1: Install Process Engine
Use a procedure in this topic to install Process Engine software either interactively or silently.  A 
number of configuration steps follow the execution of the Process Engine installation program.   

You will find references to logging on as the root and fnsw users within the following procedures. 
For all UNIX operating systems, the root user must run in the Bourne or Korn shell and the fnsw 
user must run in the Korn shell.  

CAUTION Before starting the Process Engine installation, verify that you have completed the steps 
in the To configure the /etc/hosts file section in the Plan and Prepare Your Environment for IBM 
FileNet P8 guide.

To verify the database connection

Use the procedures in this topic to verify the ability to connect to the database. Execute these 
steps on the database server or the client according to whether the database is local to or remote 
from Process Engine.

To verify the Process Engine database connection (Oracle)

Take the following steps to verify that the Oracle database instance used by Process Engine is 
accessible. How you log on to sqlplus will vary, depending upon how you will choose to execute 
the SQL scripts.  This procedure will verify that you can connect to the Oracle database in the 
same way the Process Engine installation program will.  Make whatever corrections are necessary 
before proceeding.  

1. Execute the following at a command prompt:

su - oracle -c "sqlplus"

2. Enter one of the following commands at the SQLPlus prompt, as follows:

• If the Process Engine pre-installation SQL scripts will be run from the Process Engine installation 
program by prompting for the sys password, type the following command:

sys/password as sysdba 

• If the SQL scripts will be run from the Process Engine installation program by using operating 
system authentication, type the following command:

/ as sysdba 

3. At the prompt, enter the following SQL command:

SQL> select instance_name, host_name, version from v$instance;

The following represents an example of the information returned:

INSTANCE_NAME

----------------

HOST_NAME

----------------------------------------------------------------
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VERSION

-----------------

p8dbshr
HQVWBUCS
10.2.0.2.0

where: 

p8dbshr is the instance ORACLE_SID.

hqvwbucs is the database server name.

10.2.0.2 is the Oracle server version.

To verify the Process Engine database connection (DB2) 

Verify the connection to the DB2 Process Engine database by executing the following commands 
to start a command line processor.

1. Start the command line processor, as follows:

Windows

At a command prompt, start the DB2 Command Line Processor by typing the following command:

db2cmd

and, at the subsequently displayed prompt, enter the following command:

db2

UNIX

Log on as the client instance owner and execute the following at a command prompt:

db2

2. At the DB2 prompt, enter the following command indicating either the database alias or the 
instance name:

connect to database_alias or instance_name user f_sw using f_sw password

where:

database_alias is the Process Engine DB2 for Linux, UNIX and Windows database alias for 
remote databases. For local databases, use the database name. 

instance_name is the Process Engine DB2 for z/OS database name 

f_sw is the Process Engine runtime user, either the default f_sw user or the assigned alias

f_sw password is the runtime user’s password. 

DB2 will display the database connection information.
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The following example shows the database connection command and the information 
returned:

db2 => connect to pedbinst user f_sw using fswpassword

Database Connection Information

Database server        = DB2/AIX64 9.1.0
SQL authorization ID  = F_SW
Local database alias  = PEDBINST

In this example, the database alias is pedbinst, the user is f_sw, and the f_sw user password 
is fswpassword.

To verify the Process Engine database connection (SQL Server)

Take the following steps to verify that the SQL Server database instance used by Process Engine is 
accessible. You will need to know both the Process Engine database and filegroup names. Make whatever 
corrections are necessary before proceeding. 

In this example, the database is VWdb and the filegroup name is vwdata_fg. Both the database name and 
filegroup name must match what was defined when the database MS SQL server was installed and 
configured.

1. Log on as a member of the local Administrators group or a user with equivalent permissions. The user 
you log on as must also be a database administrator.  If the database is remote, the SQL 
connection must also be a trusted connection. 

2. At a command prompt, enter:

osql -E -D DSN

where DSN is the ODBC data source name 

This command puts Process Engine into osql interactive mode.

3. At the osql prompt, enter:

1> use VWdb
2> go

where VWdb is the Process Engine database name 

This command verifies that the Process Engine database has been created. If you get another prompt 
with no error, you are attached to that database. 

4. Verify that the correct Process Engine filegroup was created. At the osql prompt, enter:

1> select substring(groupname,1,20) from sysfilegroups where groupname = 'defined filegroup'
2> go

where defined filegroup is the default filegroup 

A listing of the Process Engine filegroups will display, for example: 

___________

vwdata_fg
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To install the Process Engine software interactively 

1. Log on to the server as follows:

UNIX

Log on to the server as the root user.  If you plan to run the SQL scripts from the Process Engine 
installation program, the user you log on as must also be a database administrator.

Windows 

Log on as a member of the local Administrators group or a user with equivalent permissions, or as a 
Windows domain user as defined in Specify IBM FileNet P8 accounts in the Plan and Prepare Your 
Environment for IBM FileNet P8 guide.. If you plan to run the SQL scripts from the Process Engine 
installation program, the user you log on as must also be a database administrator.  

2. Access the Process Engine software package. 

3. From the console, launch the appropriate P8PE-4.5.0-platform.bin or .exe installation 
program.

NOTE  (Windows) To run the Process Engine installation from disk, you must copy the 
installation files to a disk volume where 8.3 name generation is enabled, or if 8.3 name 
generation is disabled, you must copy the installation to a path that uses only short (8.3) 
names.

When running from disk, either interactively or silently, be aware that the Process Engine 
installation program has a 64-character path limitation when the path is expressed in 8.3 
format. This limitation applies to the IMSInst subdirectory. For example, the original path is:

\\server08\Software\InstallationDisks\FileNet\Release P8 
4.5.0\ProcessEngine\Windows\IMSInst

When expressed in 8.3 format the path might be:

\\server08\Software\INSTAL~1\FileNet\RELEAS~1.0\PROCES~1\Windows\IMSInst

This compressed path is 73 characters long, exceeding the 64-character limit.

4. (UNIX) Wait for files to finish unpacking.

5. Complete the Process Engine installation screens using the appropriate information from your 
configuration worksheet.

HINT  With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to quickly see only the 
installation properties you must specify for the Process Engine installer:

a. Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column 
header and select PE installer.

b. Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify: Setup Type contains "Installation."   
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6. Complete the Process Engine Setup screens, as follows:

In this screen... Perform this action...

Welcome to Process 
Engine Setup

Click Next on the Welcome screen to proceed with the 
installation.

License Agreement Review and accept the license agreement.

Specify the 
Documentation URL

Enter the Documentation URL, which is where the IBM FileNet 
P8 Platform Documentation is installed. Your entry must be in 
the following format:

http://docserver:port#/ecm_help

where: 

docserver is the name of the Java web server.
port# is the port number.
ecm_help is the root folder of the documentation web site. You 
can use multi-part root folders. 
(for example, /docs/ecm_help) if your application server 
supports them.

Specify Installation 
Location for Common 
Files 

Choose the destination directory for configuration files that will 
be shared with other IBM FileNet P8 components. Accept the 
default location or click Browse to change the location.

Specify Installation 
Location for Program 
Files

(Windows only)

Indicate the installation location for the executable files.  This is 
the drive where the \FNSW directory will be created.  Select a 
local drive in a cluster configuration.

Specify Installation 
Location for Data Files

(Windows only)

Indicate the installation location for the configuration and data 
files.  This is the drive where the \FNSW_LOC directory will be 
created.  Select a shared drive in a cluster configuration.

Specify Network 
Clearinghouse Domain 
Name 

Enter domain name:organization, where:

• The maximum length of your domain name entry does not 
exceed 19 characters.

• The maximum length of your organization entry does not 
exceed 19 characters.

• Both your domain name and organization entries contain only 
alphanumeric characters and underscores.

A typical convention is to enter your PE machine name:your 
company name. If the machine name or company name include 
hyphens, replace them with underscores in your entry.
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7. Depending on the type and location of the database you selected above, continue at one of the 
following procedures:

• “To complete local or remote SQL Server database screens (Windows only)” on page 178  

• “To complete remote Oracle database screens” on page 179

• “To complete local Oracle database screens” on page 181.

• “To complete remote DB2 database screens” on page 184

• “To complete local DB2 database screens” on page 185

Configure the Hosts file This is a reminder screen to verify that you have configured the 
hosts file or DNS table before proceeding. Do not continue with 
the installation unless you have completed that configuration.  
See To configure the /etc/hosts file section in the Plan and 
Prepare Your Environment for IBM FileNet P8 guide for details.

Specify the Database 
Location

Indicate whether the database will be local or remote.

Specify the Database 
Type

Indicate whether the database will be:

• Oracle

• SQL Server

• DB2 

In this screen... Perform this action...
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To complete local or remote SQL Server database screens (Windows only)

Complete the Process Engine Setup screens that are specific to local or remote SQL Server 
databases, as follows: 

In this screen... Perform this action...

Specify Execution Mode 
for SQL Server Scripts

The SQL Server pre-install scripts must be run by Setup or 
manually.  These scripts create database users and passwords 
for FileNet P8 and create stored procedures.  Please select one 
of the options listed below.  If you select the prompted password 
option, the next screen will ask you for the SQL Server sa 
password.  If you select the silent option, your SQL Server 
database must allow operating system authentication.  

Select from the following options:

• I have already run the pre-install scripts manually.

• I want to run the scripts with a prompted password.

• I want to run the scripts silently using OS authentication.

Validation of the SQL Server connection will also occur if you 
choose to run the scripts now, either with a prompted password 
or using operating system authentication. No validation of the 
database connection will be done if you indicate that you have 
already run the SQL scripts manually.

NOTE If the scripts set the default passwords, leave the 
password fields blank at the prompts on the Specify Passwords 
screen that follows.

Specify the SQL Server 
System Administrator 
Password

NOTE This screen only 
appears if you indicated 
that you want to run the 
SQL scripts with a 
prompted password.

Enter the SQL Server sa password.
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To complete remote Oracle database screens

Complete the Process Engine Setup screens that are specific to remote Oracle databases, as 
follows:

Specify SQL Server 
Configuration 
Parameters

Enter the following information:

• ODBC data source name 

• Database name

• Filegroup name

NOTE You might notice a slight delay before the next Setup 
screen displays if you chose to run the SQL Scripts from the 
setup program. Validation of the database connection will be 
done after clicking Next on this screen. If validation is 
successful you will see the next screen. If validation fails, an 
error will be returned and you must resolve the problem before 
proceeding. No validation of the database connection will be 
done if you indicate that you have already run the SQL scripts 
manually.

Specify SQL Server 
Version

Indicate whether you will be using SQL Server 2000 or SQL 
Server 2005 for the Process Engine database.

In this screen... Perform this action...

Specify Execution Mode 
for Oracle Scripts

(Windows only)

The Oracle pre-install SQL scripts must be run by setup or 
manually.  These scripts create database users and passwords 
for FileNet P8 and create stored procedures.  Please select one 
of the options listed below.  If you select the prompted password 
option, the next screen will ask you for the Oracle Sys 
password.  If you want to run the scripts silently, your Oracle 
database server must allow operating system authentication.  

Select from the following options:

• I have already run the pre-install scripts manually.

• I want to run the scripts with a prompted password.

• I want to run the scripts silently using OS authentication.

NOTE If the scripts set the default passwords, leave the 
password fields blank at the prompts on the Specify Passwords 
screen that follows.

In this screen... Perform this action...
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Specify the Oracle SYS  
Password

(Windows only)

NOTE This screen  
appears only if you 
indicated that you want 
to run the scripts with a 
prompted password.

Enter the Oracle SYS password.

Specify Oracle 
Configuration 
Parameters

Enter the appropriate values for the following Oracle 
parameters.

• The Oracle Home path you enter refers to the local Oracle 
installation directory.

• The Oracle User Name (UNIX only)

• The Oracle DBA OS group name (UNIX only)

Specify Remote Oracle 
Configuration 
Parameters

Enter the following Oracle database configuration parameters.  

• Global Database Name (as identified in the tnsnames.ora 
file)

• Temporary Tablespace Name

Default value is VWTEMP_TS

• Data Tablespace Name

Default value is VWDATA_TS

• Index Tablespace Name

Default value is VWINDEX_TS

Enter the optional tablespace to be used by Process Engine for 
indexes. The data tablespace will be used if no index 
tablespace is designated.

CAUTION No whitespace characters are allowed in the Index 
tablespace name field. 

If you created more than one data and optional index 
tablespace indicate the default tablespace names.

Specify Oracle Version Oracle version 9i, 10g, and 11g are supported.  Indicate which 
version of Oracle software to use on the database server for 
Process Engine.  

NOTE The Oracle versions must be the same on the client and 
server.

In this screen... Perform this action...
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To complete local Oracle database screens

Complete the Process Engine Setup screens that are specific to local Oracle databases, as 
follows:

Specify Execution Mode 
for Oracle Scripts

(UNIX only)

A series of SQL scripts must be executed.  You could have 
already run the scripts manually before starting Process Engine 
Setup.  If you did not run them manually, you need to indicate 
how you want to run them now.  You can run them as the Oracle 
SYS user or as another user who can be authenticated through 
the operating system.  

• I have already run the pre-install scripts manually.

• I want to run the scripts in an xterm window.

• I want  to run the scripts silently using operating system 
authentication.  

NOTE If the scripts set the default passwords, leave the 
password fields blank at the prompts on the Specify Passwords 
screen that follows.

In this screen... Perform this action...

Specify Execution Mode 
for Oracle Scripts

(Windows only)

The Oracle pre-install SQL scripts must be run by setup or 
manually.  These scripts create database users and passwords 
for FileNet P8 and create stored procedures.  Please select one 
of the options listed below.  If you select the prompted password 
option, the next screen will ask you for the Oracle Sys 
password.  If you want to run the scripts silently, your Oracle 
database server must allow operating system authentication.  

Select from the following options:

• I have already run the pre-install scripts manually.

• I want to run the scripts with a prompted password.

• I want to run the scripts silently using OS authentication.

NOTE If the scripts set the default passwords, leave the 
password fields blank at the prompts on the Specify Passwords 
screen that follows.

In this screen... Perform this action...
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Specify the Oracle SYS  
Password

(Windows only)

NOTE This screen only 
appears if you indicated 
that you want to run the 
SQL scripts with a 
prompted password.

Enter the Oracle SYS password.

Specify Oracle 
Configuration 
Parameters

Enter the appropriate values for the following Oracle 
parameters.

• The Oracle Home path you enter refers to the local Oracle 
installation directory.

• The Oracle User Name (UNIX only)

• The Oracle DBA OS group name (UNIX only)

Specify Local Oracle 
Configuration 
Parameters

Enter the following Oracle database configuration parameters.  

• Oracle SID

• Temporary Tablespace Name

Default value is VWTEMP_TS

• Data Tablespace Name

Default value is VWDATA_TS

• Index Tablespace Name

Default value is VWINDEX_TS

Enter the optional tablespace to be used by Process Engine for 
indexes. The data tablespace will be used if no index 
tablespace is designated.

CAUTION No whitespace characters are allowed in the Index 
tablespace name field. 

If you created more than one data and optional index 
tablespace indicate the default tablespace names.

Specify Oracle Version Oracle versions 9i, 10g and 11g are supported.  Indicate which 
version of Oracle software to use on the database server for 
Process Engine.  

NOTE The Oracle versions must be the same on the client and 
server.

In this screen... Perform this action...
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 1: Install Process Engine
To complete local Oracle database screens

183
Specify Execution Mode 
for Oracle Scripts

(UNIX only)

A series of SQL scripts need to be executed.  You could have 
already run the scripts manually before starting Process Engine 
Setup.  If you did not run them manually, you need to indicate 
how you want to run them now.  You can run them as the Oracle 
SYS user or as another user who can be authenticated through 
the operating system.  

• I have already run the pre-install scripts manually.

• I want to run the scripts in an xterm window.

• I want  to run the scripts silently using operating system 
operating system authentication. 

NOTE If the scripts set the default passwords, leave the 
password fields blank at the prompts on the Specify Passwords 
screen that follows.

In this screen... Perform this action...
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To complete remote DB2 database screens 

In this screen... Perform this action...

Specify DB2 Platform Both remote z/OS and DB2 for Linux, UNIX and Windows 
databases are supported. Indicate whether the remote DB2 
database resides on a z/OS server or not.  If it is not z/OS it 
configured as DB2 for Linux, UNIX, and Windows.

Specify DB2 
Configuration 
Parameters

NOTE This screen only 
appears if the database 
platform is DB2 for Linux, 
UNIX and Windows.

Enter the following DB2 database parameters for the Process 
Engine database and tablespace. All fields must have values. 

• Database Alias Name

Default value is VWdb

• Data Tablespace Name

Default value is VWDATA_TS

• Index Tablespace Name

Default value is VWINDEX_TS

• Blob Tablespace Name

Default value is VWBLOB_TS

Specify DB2 
Configuration 
Parameters

NOTE This screen only 
appears if you indicated 
the remote database is 
on z/OS.

Enter the following DB2 database parameters for the Process 
Engine database. All fields must have values.

• Database Name

Default value is PEDBASE

• Instance Alias Name

Default value is PEInstance. This is the instance created on 
the Process Engine client, used to connect to the remote 
database.

• Local DB2 Instance Owner Name (UNIX only)

Default value is fnsw. This is the DB2 client instance created 
on the Process Engine server.

Specify DB2 Version

NOTE This prompt only 
appears only of the 
database is on DB2 for 
Linux, UNIX and 
Windows.

Select either version 8 or 9.
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To complete local DB2 database screens 

To complete final Process Engine Setup screens

Complete the screens to finalize the Process Engine installation, as follows:

In this screen... Perform this action...

Specify DB2 
Configuration 
Parameters

Enter the following DB2 parameters for the Process Engine 
database and tablespace. All fields must have values. 

• Database Alias Name

Default value is VWdb

• Local DB2 Instance Owner Name (UNIX only)

Default value is fnsw

• Data Tablespace Name

Default value is VWDATA_TS

• Index Tablespace Name

Default value is VWINDEX_TS 

• Blob Tablespace Name

Default value is VWBLOB_TS

Specify DB2 Version Select either version 8 or 9.

In this screen... Perform this action...

Determine Administrative 
User and Group Aliasing 
Method

Determine whether FileNet default operating system and 
database users and groups will be used, or if you want to define 
aliases for these users and groups.  

• Yes, configure aliases

• No, use actual account names for aliases
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Specify Administrative 
User and Group Aliases

NOTE This screen is only 
presented if you chose to 
configure aliases. 

Indicate the alias you want to create for each of the following 
users and groups.

• FNADMIN OS group

• FNUSR OS group

• FNOP OS group

• FNSW OS user

• f_sw DB user

• f_maint DB user

NOTES For Oracle and SQL Server databases, these are 
database users. For DB2, these are operating system users.  

If you ran SQL scripts for SQL Server or Oracle manually before 
starting Process Engine Setup, the aliases here for f_sw and 
f_maint must match the users specified as runtime and 
maintenance users.  

(Windows only) If you are logged on as a domain user for this 
installation the fnadmin, fnop and fnuser groups and the fnsw 
user, or aliases for them have already been defined on this 
server.  Assign the same alias here as was defined earlier.

The f_sw and f_maint users should be dedicated users for IBM 
FileNet use.

(Windows only) The default password for the fnsw user (or its 
alias) will be set and must not be changed until Process Engine 
installation is complete.  “To reset administrative user passwords” 
on page 189 for information on changing the fnsw password and 
associated changes to Windows services.

SQL Script Passwords

NOTE This screen 
appears only if you 
selected an option to 
have setup run the SQL 
scripts.

You have selected an option to have setup run the pre-install 
SQL scripts.  Setup needs to know if you have changed the 
default passwords that are specified in these script files.

Select from the following options:

• I have not changed the default FileNet passwords specified 
in the SQL scripts

• I have changed the default FileNet passwords specified in 
the SQL scripts

If you have changed the default passwords in the SQL scripts 
you will be prompted to enter those passwords on a later 
screen.  

In this screen... Perform this action...
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8. (Windows) Setup will run a number of steps but to complete the installation the computer must 
be restarted.  When prompted, select Yes, restart my computer and click Finish. 

9. (Windows) When the system restarts, log on using the same account you used in Step 1 on page 
175. After you log on, Process Engine Setup will continue. Click Next to continue the installation. 

If installation fails at this point, correct the errors that caused the failure and run the post-boot 
setup program by navigating to the Process Engine\IMSInst install folder and executing:

setup.exe  -postboot  

Specify Passwords 

NOTE This screen 
appears after Specify 
Administrative User and 
Group Aliases if you 
choose to define aliases.

Specify the passwords for the f_sw and f_maint users (or their 
aliases). 

For DB2 these are operating system users and the values here 
must match the passwords already assigned to these users. 

For Oracle and SQL Server these are database users. The 
passwords entered here must match the passwords created 
when the Oracle or SQL scripts were executed.  

If default passwords were created when the scripts ran for 
Oracle or SQL Server databases, leave these fields blank.  

Specify Device File 
Names

(HP-UX and Solaris only)

Enter the full pathname for the device files for the fn_SEC_DB0 
and fn_SEC_RL0 volumes.

Please Read the 
Summary Information 
Below

Verify your selections, and click Install to install Process 
Engine.

xterm Window 

(UNIX only)

NOTE This window 
displays if you chose to 
run the SQL scripts in an 
xterm window.

Enter the SYS password for Oracle. 

Completing the Setup 
wizard

Windows

Click Finish to complete the Process Engine installation.

UNIX

Click Finish to complete the Process Engine installation and 
then as prompted, log off and log back in as fnsw or the alias 
you defined

In this screen... Perform this action...
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NOTE  Not all error conditions can be resolved in this way.  It might be necessary to uninstall 
the Process Engine software and re-run Setup. 

10. (Windows) When the dialog box informs you that Process Engine has been successfully 
installed, click Finish.

11. (UNIX) Monitor /fnsw/local/logs/wizard to check the progress of the installation since the 
installation program will run for several minutes,and its progress, though displayed, might not 
visibly advance for an extended period of time.

12. (UNIX) A number of log files might be generated by the installation. Check for an .log files 
generated when the installation program executed. The files could be in any of the following 
locations, depending upon whether the installation was successful or had errors, and where the 
installation encountered errors. Correct any errors or failures indicated before proceeding to the 
next step.

• /fnsw/local/logs/PE (if the install completes successfully) 

• /fnsw/tmp_installer (if the install has errors)

• /fnsw/local/logs/wizard and other subdirectories under /fnsw/local/logs

13. (Windows) A number of log files might be generated by the installation. Check for an .log files 
generated when the installation program executed. The files could be in any of the following 
locations, depending upon whether the installation was successful or had errors, and where the 
installation encountered errors. Correct any errors or failures indicated before proceeding to the 
next step.

• C:\Program Files\FileNet\PE\PE450_setup.log

• C:\Program Files\FileNet\PE 

• C:\FNSW  

• Windir\mini_installer.log, Windows Event logs, and log files under \FNSW_LOC\logs  

14. (UNIX) Log off as the root user and log on as fnsw (or the alias).    

15. Proceed to “Proceed to “To reset administrative user passwords” on page 189.” on page 189.        

To install the Process Engine software silently (UNIX)

Complete the following procedures to silently install Process Engine. 

1. Log on to the server as follows:

UNIX

Log on to the server as the root user.  If you plan to run the SQL scripts from the Process Engine 
installation program, the user you log on as must also be a database administrator.

Windows 

Log on as a member of the local Administrators group or a user with equivalent permissions, or as a 
Windows domain user as defined in Specify IBM FileNet P8 accounts in the Plan and Prepare Your 
Environment for IBM FileNet P8 guide.. If you plan to run the SQL scripts from the Process Engine 
installation program, the user you log on as must also be a database administrator.  
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2. Access the Process Engine software package. 

3. Edit the PE_silent_install.txt file to reflect the appropriate responses for your installation.  
All passwords in the response file must be encrypted. See “Encrypt passwords” on page 700 for 
information on use of the password encryption tool.  

4. Save the edited response file to your temporary directory. 

5. Navigate to the temporary directory on the local disk.

6. Open a command prompt and start the appropriate  installation program:

P8PE-4.5.0-platform.bin or .exe -silent -options PE_silent_install.txt  

(Windows) The Process Engine installation program will reboot the server, after which it will 
continue with the post-boot operations.

7. (Windows) A number of log files might be generated by the installation. Check for an .log files 
generated when the installation program executed. The files could be in any of the following 
locations, depending upon whether the installation was successful or had errors, and where the 
installation encountered errors. Correct any errors or failures indicated before proceeding to the 
next step.

• C:\Program Files\FileNet\PE\PE450_setup.log

• C:\Program Files\FileNet\PE 

• C:\FNSW  

• Windir\mini_installer.log, Windows Event logs, and log files under \FNSW_LOC\logs  

8. (UNIX) Monitor /fnsw/local/logs/wizard to check the progress of the installation since the 
installation program will run for several minutes,and its progress, though displayed, might not 
visibly advance for an extended period of time.

9. (UNIX) A number of log files might be generated by the installation. Check for an .log files 
generated when the installation program executed. The files could be in any of the following 
locations, depending upon whether the installation was successful or had errors, and where the 
installation encountered errors. Correct any errors or failures indicated before proceeding to the 
next step.

• /fnsw/local/logs/PE (if the install completes successfully) 

• /fnsw/tmp_installer (if the install has errors)

• /fnsw/local/logs/wizard and other subdirectories under /fnsw/local/logs

10. (UNIX) Log off as the root user and log on as fnsw (or the alias).    

11. Proceed to “To reset administrative user passwords” on page 189. 

To reset administrative user passwords

Process Engine installation automatically creates several internally required local users. For 
Oracle and SQL Server databases, if default users and passwords were configured, Process 
Engine installation also creates several database users. Because these users are created with 
default passwords, it is a best practice to reset the passwords for these users. The following table 
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 1: Install Process Engine
To verify the connection to the Process Engine database

190
lists the users created, the level of system access each user has, and the tool used to change the 
password. See the IBM FileNet Image Services documentation for instructions on using the 
referenced tools:

To verify the connection to the Process Engine database

Verify the ability to connect to the Process Engine database using the run-time user name and  
password.  

User Name User Type Description How to modify

f_sw Database 
(Oracle. SQL) OS 
user for DB2

Has DBA privileges. Used 
as the Process Engine 
run-time user.

Execute Xdbconnect. 
See steps below.

f_maint Database 
(Oracle, SQL) OS 
user for DB2

Has DBA privileges. Used 
for RDBMS maintenance.

Execute Xdbconnect. 
See steps below.

fnsw or alias

NOTE  The 
default password 
for fnsw is 
BPMtemp1pzwd. 
If you change the 
password for the 
services at this 
point, stop and 
restart both 
services.

Operating System Primary Process Engine 
user. Used to execute 
Process Engine software 
and services.

Windows After you 
change the password 
for the fnsw user, you 
must also use the 
Windows Services 
tool to update the Log 
On tab for the IMS 
ControlService and 
the Process Engine 
Services Manager 
because the fnsw 
user is used to start 
these services. 

NOTE Process 
Engine activity will 
cease if the fnsw 
user’s password 
expires.

SysAdmin SEC (internal 
Process Engine 
security software)

Primary administrator 
user for IBM FileNet 
software tools.

Execute Xapex -> 
Security 
Administration. Log 
on as SysAdmin.

FieldService SEC Used internally by 
Process Engine software.

Operator SEC Used internally by 
Process Engine software.
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1. Restart the Process Engine software by executing the following at a command prompt:

initfnsw -y restart

2. Initiate the connection to the database. At a command prompt, execute:

vwcemp –l

where the -l option displays the currently configured connection to the Content Engine

If the connection is successful, you will receive a message indicating that the Content Engine has 
not been configured yet.  Because there are no security settings configured, the above command 
should return a message similar to “The Process Engine's connection to the Content Engine has 
not been configured….”

Unsuccessful connection to the database will return an exception.  

If the connection is not successful, there could be a mismatch between the password entered for 
the f_sw user during Process Engine installation and the password created by execution of the 
SQL scripts (Oracle) or for the operating system runtime user (DB2).  

To determine if a failure to connect to the database is due to a password mismatch, use the steps 
in “To set the f_maint and f_sw passwords” on page 191.

To set the f_maint and f_sw passwords 

For added security, Process Engine stores an encrypted version of the passwords for the f_sw and 
f_maint users, or their aliases, in a file called rdbup.bin. This is in addition to passwords for 
these users in the Oracle or SQL Server database, or on the operating system where DB2 is 
installed.  The encrypted password and the database (Oracle or SQL Server) or operating system 
(DB2) user’s passwords must match. 

To verify that the passwords match, use the following procedure to start the Xdbconnect utility.  
Xdbconnect works only if the passwords in the encrypted file and the database match.  

Use the following procedure to change the passwords for the f_maint and f_sw users after 
installing the Process Engine software. For Oracle and SQL Server databases, both the encrypted 
file and the database passwords will be updated.  For DB2, only the encrypted file will be updated.   

1. Start the Database Server Connect application by executing the following:

Xdbconnect -r

2. Log on as SysAdmin. The default password is SysAdmin.

3. Change the primary password for the users f_sw and f_maint (or their alias) to match the 
database password (Oracle and SQL Server) or operating system user’s password (DB2).

4. Exit the application. 

To re-enable Oracle Password Complexity Verification

If, as directed earlier, you disabled the the Oracle Password Complexity Verification feature prior 
to installing Process Engine, you can now re-enable it.
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(Optional: Oracle databases only) To remove fnsw user from the Oracle database administrators 
group (UNIX)

Process Engine installation creates a user that is no longer required after installation is complete. 
Remove the fnsw (or the alias) user from the Oracle Database Administrators group.

(Optional; Oracle database only) To remove fnsw and oracle users from the ORA_DBA group 
(Windows)

Remove the fnsw (or its alias) and oracle users from the ORA_DBA group. Process Engine 
installation creates these users, which are no longer required after installation is complete. 

To restore any custom modifications for root and fnsw users (UNIX) 

Process Engine installation creates a new versions of a number of files. If the previous versions of 
these files contained any custom settings, edit the new files for the fnsw and root users 
accordingly. Saved files are in .filename.old.nn, where nn is a sequential number. The latest 
saved version will be in the highest numbered file.  The following files are modified by the Process 
Engine installation program:

.Xdefaults

.Xresources

.dbxinit

.dtprofile

.env

.login

.mwmrc

.xinitrc

.profile

.cshrc

To verify the /etc/services file settings (UNIX)

1. Log on as the root user and check the /etc/services file to verify the following parameters:

ALL UNIX
tms                32768/tcp
cor                 32769/tcp
nch                32770/udp
fn_trapd         35225/udp

AIX only
smux             199/tcp                         # snmpd smux port  
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Solaris only
fn_snmpd  161/udp

HP-UX only
snmp           161/udp  snmpd        # Simple Network Management Protocol Agent 
snmp-trap    162/udp  trapd          # Simple Network Management Protocol Traps  

2. If necessary, add the parameters to the file and save the changes.

To verify the /etc/services file settings (Windows)

1. Log on as the Administrator user and check the 
\Windows\system32\drivers\etc\services file to verify the following parameters:

tms              32768/tcp
cor               32769/tcp
nch              32770/udp
fn_snmpd     161/udp
fn_trapd       35225/udp

2. If necessary, add the parameters to the file and save the changes.

To modify the integrity level for executables (Windows 2008)

Modify the mandatory integrity level of the Image Services executables to High. Complete the 
following procedure:

1. Open a command prompt with Administrative privileges.

2. Change the current directory to installLocation\fnsw\bin.

3. Execute the following command:

icacls  *.exe  /setintegritylevel  H

To redirect log messages to the Image Services error log (Windows) 

Enable the redirection of log messages to the Image Services error log. This redirection will log 
message to the Image Services error log as well as to the default Windows Event Log. By 
enabling this redirection, you will be able to monitor the progress of the database object upgrade 
in a command window. 

To enable the redirection, change the LogToFiles value from 0 to 1 for the following registry key.

32-bit Windows

HKEY_LOCAL_MACHINE>SOFTWARE>FileNET>IMS>CurrentVersion

64-bit Windows 

HKEY_LOCAL_MACHINE\SOFTWARE\WoW6432Node\FileNet\IMS\CurrentVersion
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To clean up before starting Process Engine (UNIX)  

1. Log on as fnsw.

2. Execute:

killfnsw -DAyS

3. Execute:

ipcs -a 

4. Verify there is no entry with 0x464 pattern. If there are any entries with this pattern, use ipcrm to 
remove them.

To edit the /etc/inittab file (UNIX)

By default, the Process Engine software starts automatically when you restart the server and 
needs its database started beforehand. If the database is not automatically started on server 
restart, edit the /etc/inittab file on the Process Engine machine to comment out the autostart 
of Process Engine. The following are examples of changes to make.

AIX 

Change:

rcfnsw:2:once:/etc/rc.initfnsw 2>&1 | alog -tboot > /dev/console 2>&1

to read:

#rcfnsw:2:once:/etc/rc.initfnsw 2>&1 | alog -tboot > /dev/console 2>&1

HP-UX

Change:

rcfn:2:once:/etc/rc.initfnsw 2>&1 | alog -tboot > /dev/console 2>&1

to read:

#rcfn:2:once:/etc/rc.initfnsw 2>&1 | alog -tboot > /dev/console 2>&1

Solaris

Change:

fn:3:wait:/bin/sh /etc/rc.initfnsw </dev/console >/dev/console 2>&1

to read:

#fn:3:wait:/bin/sh /etc/rc.initfnsw </dev/console >/dev/console 2>&1
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To edit the pe_start file (HP-UX)

If the value for the maxdsiz kernel parameter is > 1GB, edit the pe_start file. 

Change:

nohup /usr/ccs/lbin/dldd32 2>&1 >/dev/null    

to read:

nohup /usr/ccs/lbin/dldd32 +a 0x70000000 2>&1 >/dev/null

Proceed to “Install Process Engine software updates” on page 196.
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Task 2: Install Process Engine software updates
Perform the procedure in this topic for the Process Engine to install software updates (mod 
release, fix pack, or interim fix). 

If there are no Process Engine software updates to be installed, skip to “Install the latest Content 
Engine Client files on Process Engine servers” on page 197.

To install the Process Engine software updates

1. To obtain the latest Process Engine software updates, and to determine whether additional 
interim fixes are needed, contact your service representative.

2. Open the readmes for the Process Engine software updates and perform the installation 
procedures in the readmes on the Process Engine.

3. Proceed to “Install the latest Content Engine Client files on Process Engine servers” on page 197.
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Task 3: Install the latest Content Engine Client files on 
Process Engine servers
To install the 4.5 release or fix pack version Content Engine Client files, perform the following 
procedures on all Process Engine servers. Except where noted, these steps apply to WebSphere, 
WebLogic, and JBoss.

To install the Content Engine Client files

Refer to the appropriate information from your installation worksheet while performing the following 
steps. For information on the Content Engine parameter values, see ““Installation and upgrade 
worksheet” on page 229 in Plan and Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to quickly see only the 
installation properties you must specify for the Content Engine installation program:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select CE Client installer.

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify: Setup Type contains "Installation."

• Click the AutoFilter drop-down arrow in all other column headers and select (All).

1. To download the latest software updates, and to determine which of these updates may be 
required for use with other components and expansion products, contact your service 
representative.

2. Log on to the server where Process Engine is installed as fnsw with these permissions:

• Read and write permission to a temporary directory, such as temp (Windows) or tmp (UNIX), on 
the machine where Process Engine is installed

• Execute permission on the Content Engine Client install software

The default password for fnsw was  BPMtemp1pzwd.

3. Verify that there is a current backup of Process Engine.  

4. Copy the Content Engine Client install software from the Content Engine installation software to 
the temporary directory, and unzip the software package. The version of the installation software 
must match the version of Content Engine.

• To install the Content Engine client interactively:

i. Access the IBM FileNet Content Engine client update software.
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ii. Run one of the commands in the table below, CE_version is the version of Content Engine 
you intend to run, for example, 4.5.0..

iii. Complete the installation program wizard, using the following table. 

Operating System Install Program

AIX P8CE-CLIENT-CE_version-AIX.BIN

HPUX P8CE-CLIENT-CE_version-HPUX.BIN

HPUXi P8CE-CLIENT-CE_version-HPUXI.BIN

Linux P8CE-CLIENT-CE_version-LINUX.BIN

Solaris P8CE-CLIENT-CE_version-SOL.BIN

Windows P8CE-CLIENT-CE_version-WIN.EXE

zLinux P8CE-CLIENT-CE_version-ZLINUX.BIN

In this screen... Perform this action...

Welcome Click Next to proceed with the Content Engine Client 
installation.

NOTE Click Back at any time while running the Content Engine 
Client installer to make changes in any previous screens. Click 
Cancel to exit the Content Engine Client installer.

Specify Content 
Engine Client 
Installation Path

Specify the complete path where you want the Content Engine 
Client program files installed. The defaults are as follows:

UNIX

/opt/FileNet/Content Engine

Windows

C:\Program Files\FileNet\CEClient

Click Next to continue.

Select FileNet P8 
Applications

Select Process Engine, and click Next to continue.

Process Engine 
Installation Path

Enter the full path to the Process Engine installation location. 
The defaults are as follows:

UNIX

/FNSW

Windows

C:\FNSW

Click Next to continue.
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Content Engine 
Application 
Server

Select the Content Engine application server type from the list. 
Valid choices are: 

• WebSphere

• WebLogic

• JBoss

Click Next to continue.

Specify URLS for 
EJB Transport

(This screen will 
not display during 
an upgrade.)

Specify the URLS for the Content Engine Enterprise Java Bean 
(EJB) API.

• Content Engine Client Software URL

The URL for the Content Engine Web Services client API. 
This URL will contain the WcmApiConfig.properties file, 
which is required for applications to communicate with 
Content Engine Server, regardless of whether they use the 
EJB or Web Services transport method.

The default is: cemp:iiop//CEServer:2809/FileNet/Engine

• Content Engine upload URL

The upload URL is used for internal processes during EJB 
transport activities.

The default is: cemp:iiop//CEServer:2809/FileNet/Engine

• Content Engine download URL

The download URL is used for internal processes during 
EJB transport activities.

The default is: cemp:iiop//CEServer:2809/FileNet/Engine

Click Next to continue.

Specify URL for 
WSI Transport

The URL for the Content Engine Web Services client API. 
The API contains the WcmApiConfig.properties file, which is 
required for applications to communicate with Content 
Engine Server, regardless of whether they use the EJB or 
Web Services transport method.

The default is: 
cemp:http://CEServer:9080/wsi/FNCEWS40DIME/

Click Next to continue.

Review 
Pre-Installation 
Summary 

Verify your component selections, and click Install to start 
installing Content Engine Client.

In this screen... Perform this action...
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• To install the Content Engine client files silently:

i. Make a back up copy of the CEClient_silent_install.txt input file.

ii. Open the silent input file in a text editor. Follow the instructions in the silent input file to 
edit the file to reflect the appropriate responses for your update.

iii. Navigate to the path containing the Content Engine Client installation program, and run 
one of the commands in the following table to perform the silent install, where:

CE_version is the version of Content Engine you intend to run, for example, 4.5.0.

 path is the path that contains the installation program.

5.

Operating 
System

Install Program

AIX P8CE-CLIENT-CE_version-AIX.BIN -f path/CECLIENT.AIX/  
CEClient_silent_install.txt -i silent

HPUX P8CE-CLIENT-CE_version-HPUX.BIN -f path/CEClient.HPUX/ 
CEClient_silent_install.txt -i silent

HPUXi P8CE-CLIENT-CE_version-HPUXI.BIN -f path/CEClient.HPUXI/
CEClient_silent_install.txt -i silent

Linux P8CE-CLIENT-CE_version-LINUX.BIN -f path/CEClient.Linux/
CEClient_silent_install.txt -i silent

Solaris P8CE-CLIENT-CE_version-SOL.BIN -f path/CEClient.Solaris/
CEClient_silent_install.txt -i silent

Windows P8CE-CLIENT-CE_version-WIN.EXE -f path\CEClient.Windows\ 
CEClient_silent_install.txt -i silent

zLinux P8CE-CLIENT-CE_version-ZLINUX.BIN -f path/CEClient.zLinux/
CEClient_silent_install.txt -i silent
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Task 4: Configure Process Task Manager
Complete this task to start the Process Task Manager and set initial configuration parameters. 

To start the Process Task manager and software on the Process Engine 

1. Log onto Process Engine as a member of fnadmin. 

2. Start the Process Task Manager, as follows: 

Windows 

Select Start > Programs > FileNet P8 Platform > Process Engine > Process Task Manager.

UNIX 

Enter vwtaskman at the command prompt. The terminal should support X Windows and the 
DISPLAY environment variable should be set.

3. Click your Process Engine server in the left-hand pane.

4. If the Process Engine software is not already running, start it by choosing Start from the Action 
menu.

5. Select the Process Engine in the feature pane and click the Security tab to configure the 
Security settings. 

Provide the service username, Content Engine URI, Administrator Group, and Configuration 
Group identified on your installation worksheet. See the IBM FileNet P8 help topic FileNet P8 
Administration > Enterprise-wide Administration > Process Task Manager > Process Engine > 
Configure Process Engine > Security for details on the user and groups.  

NOTE The service username should be entered as a short name. 

6. Click the General tab and make sure all settings are correct. Click Apply if any changes have 
been made.

After all parameters have been entered, click Apply and restart the Process Service when 
prompted.  If errors are returned, additional information is available in: 

Windows 

\fnsw_loc\logs\TM_daemon\PEDirectoryServerConnectionDebug.txt

UNIX 

/fnsw/local/logs/TM_daemon/PEDirectoryServerConnectionDebug.txt

7. Right-click on the Regions folder, select New to create a new region. See the IBM FileNet P8 
help topic FileNet P8 Administration > Content Engine Administration > Isolated Regions> Concepts 
for information on isolated regions.

8. Select the General subtab and fill in the region number.

9. Indicate whether region recovery will be enabled for this region.  If you will be using region 
recovery: 
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a. Enable region backups.

b. Identify the tablespaces or filegroups to be used by the region.

10. Click the Security subtab to set a region password.

NOTE The password must match the password that you will enter later when you create a 
Process Engine Region in “Create a Process Engine isolated region” on page 259.

11. After all parameters have been entered, click OK 

12. When prompted by Process Task Manager to start the software, click OK. Process Task 
Manager will start the software automatically by executing:  

initfnsw -y restart

To verify connection to the Process Engine database

• Check the database connection from Process Engine by executing the following command. 
This will also verify that security settings were saved to the database. At a command prompt, 
execute:

vwcemp –l

where the -l option displays the currently configured connection to the Content Engine

If the security settings were saved, the above command returns the information you entered in 
the Process Engine Task Manager.

If there are no security settings saved, the above command returns a message indicating that 
the Process Engine’s connection to the Content Engine has not been configured.

Proceed to “Complete post-installation Process Engine configuration (Windows only)” on page 203.
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Task 5: Complete post-installation Process Engine 
configuration (Windows only)
Use the procedure in this task to enable Process Engine to use the largest available contiguous 
free memory area for shared memory allocations. Unless you perform this procedure, at some 
point during normal execution the system will not allocate shared memory and will cease to 
function correctly.

In the following steps, you will use vwtool to get the address for the largest free memory block and 
use that address to create a new registry DWORD. The new registry DWORD you will create is 
StartShmAddress. You will then verify that address by running ipc_tool.

To configure contiguous free memory for Process Engine (Windows only)

1. At a command prompt, enter vwtool. When prompted, enter the service username you provided 
when completing the steps in “Configure Process Task Manager” on page 201.

2. Use the processmap command to find the largest contiguous free memory area, as in:

<vwtool:1>processmap

vwtool returns the following:

Process Id (CR=this vwtool process):

Press Return (CR) to get the process map for this process, as in the following example, where 
the process ID is 2592. Continue to press Return to scroll through the output. The information 
you want is near the end of the information displayed:

C:\FNSW\BIN\vwtool.exe (ID:2592)

Address    Attrib         Size    Owner
=======    ======           ====     =====

00000000   Free          65536
00010000   Private       12288
00013000   Free          53248
00020000    Private         4096

…….(pages of memory addresses omitted here)

7FFDE000   Private        4096
7FFDF000   Private        4096
7FFE0000    Private        65536

C:\FNSW\BIN\vwtool.exe (ID:2592)

Biggest FREE block found: 453873664 bytes at address 0x4B577000 there are 
potentially 440128 Kb available for shared memory allocation by the PE server. 
Rounded up to a 64K boundary, for use as a registry entry StartShmAddress, best free 
block address 0x4B580000.

In this example, 0x4B580000 is the address you will need in the next step. In some cases you 
might see only the line referencing the largest free block because the value is already at a 64K 
boundary.
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3. Start regedit from the Windows > Start > Run command and perform the following steps to 
create a DWORD value for StartShmAddress, using the address noted in step 2.

a. Navigate to the following folder, as appropriate for your operating system: 

32-bit OS

HKEY_Local_Machine\Software\FileNet\IMS\CurrentVersion\ 

64-bit OS

HKEY_Local_Machine\Software\WOW6432Node\FileNet\IMS\CurrentVersion\ 

b. Right click on CurrentVersion and select New > DWORD Value.

c. Create a new DWORD value named:  

StartShmAddress 

d. Enter or verify the following in the Edit DWORD Value Screen:

Value name =  StartShmAddress

Value data = address of largest free memory block  

From the example above the value will be 4B580000.

Base = hexadecimal.

e. Click OK.  

f. Exit from regedit.

4. Restart the Process Engine software by entering the following at a command prompt:

initfnsw -y restart

5. Verify the setting you just applied for the shared memory address by executing the following at a 
command prompt:

ipc_tool -A

The following is an example of the information that is returned.  

Image Services software shared memory segment limit: 129 segments
Current configured segment size: 0x01000000 bytes (16 MB)
Before allocating shared memory for Image Services, the SysV library
performs a test to determine the system shared memory limit.  This test
can be used as a reference for performance tuning.  The test results vary
depending on the amount of memory in use by other processes.  The actual
amount of shared memory available during operation may be less.  The test
results are:

   Successfully attached to 27 segments
   Successfully obtained 432 MB of shared memory

The following table displays the number of shared memory segments currently
in use by Image Services.  Segment #0 (called the address manager) is small.
The other segment(s) contain the actual Image Services data.  Note that
running ipc_tool will force the creation of segments #0 and #1 even when no
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other Image Services process is up.
Shared Memory Address Manager Information

    Address     Shm id          Creator

Enter <space> to continue, 'q' to quit:

  0 0x4b580000  Global\FNSHM_464d0000  Shared address manager

  1 0x4c580000  Global\FNSHM_464a0000  FileNet server software

Total Image Services shared memory allocated: 16 MB

(This does not include segment #0)

NOTE The first shared memory address above 0x4B580000 is the value you would check for 
this example.

6. Exit ipc_tool. If the shared memory address is correct, proceed to the next installation task. If 
the value is not correct, verify Step 1 - Step 4 above before proceeding.
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Install and configure Application Engine
To set up Application Engine, do the following:

1. Install Application Engine. Do Task 1 on page 207.

2. Install Application Engine Software Updates. Do Task 2 on page 218.

3. Install Content Engine Client file updates. Do Task 3 on page 219.

4. Install Process Engine Client file updates. Do Task 4 on page 224.

5. Configure Application Engine. Do one of the following:

• Task 5a on page 228 (WebSphere)

• Task 5b on page 237 (WebLogic)

• Task 5c on page 243 (JBoss)

6. Deploy Application Engine. Do one of the following:

• Task 6a on page 246 (WebSphere)

• Task 6b on page 249 (WebLogic)

• Task 6c on page 251 (JBoss)
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Task 1: Install Application Engine
This topic includes Application Engine installation instructions for all supported application 
servers and operating systems. 

NOTES 

• If you plan to install and use the IBM FileNet Workplace XT product, you do not need to install 
Application Engine.

• Before installing Application Engine, check the latest version of the IBM FileNet P8 4.5 
Release Notes for known issues that might impact this software installation. To download this 
guide from the IBM support page, see “Access IBM FileNet documentation, compatibility matrices, 
and fix packs” on page 20.

• Make sure your installation location meets the requirements specific for Application Engine 
outlined in the IBM FileNet P8 Hardware and Software Requirements. To download this guide 
from the IBM support page, see “Access IBM FileNet documentation, compatibility matrices, and fix 
packs” on page 20.

• Consider whether changing your deployment type is likely.

As a best practice, choose to install Application Engine as if you intend to deploy an EAR file, 
rather than a WAR file, because this choice will produce both an EAR and a WAR file. If you 
decide to change your deployment type from EAR to WAR later, you will be able to use the 
WAR file from the original installation, rather than having to uninstall and reinstall Application 
Engine. 

• (Highly Available installations) To install Application Engine in a web farm or clustered 
environment, follow the instructions in the IBM FileNet P8 Platform High Availability Technical 
Notice. That document outlines the required HA install procedure and references this guide for 
detailed installation and deployment instructions. To download this guide from the IBM support 
page, see  “Access IBM FileNet documentation, compatibility matrices, and fix packs” on page 20.

• To ensure proper functionality and performance install only one instance of Application Engine  
per application server (or virtual machine or WebSphere LPAR). You can, however, deploy 
multiple instances of a single Application Engine version per application server. For details, 
see “Deploy multiple Application Engine instances” on page 295. 

• Before logging on to Workplace for the first time, at least one object store must exist on the 
Content Engine to hold the site preferences. See “Create the initial object store” on page 133 for 
more information.

• If you run the installer to upgrade Application Engine, the installer verifies that the currently 
installed version of Application Engine can be upgraded. See “Prepare for Application Engine 
upgrade” on page 544 for more information. 

• You can install a new Application Engine 4.0.2 server within an existing 4.0.x FileNet P8 
environment if your Content Engine is at version 401.006 or later and your Process Engine is 
at 403-000.001 or later. The Content Engine and Process Engine client files you install on the 
Application Engine must match the version of your Content Engine and Process Engine.
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To install the Application Engine software

1. Log on to the application server, as appropriate for your operating system:

UNIX

Log on as a user with read, write, and execute access to the directory where you plan to install 
Application Engine. 

Windows

Log on as a member of the local Administrators group or a user with equivalent permissions.

2. Start the installation process. 

• To install Application Engine interactively:

i. Access the IBM FileNet Application Engine 4.0.2 installation software. 

ii. Launch the appropriate setup program as specified in the following table, and continue 
with Step 3 on page 209.

• To install Application Engine silently:

i. Locate the IBM FileNet Application Engine 4.0.2 installation software package, and copy 
the appropriate AE_silent_input.txt file to a local directory.

ii. Follow the instructions in the silent input file to edit the file to reflect the appropriate 
responses for your installation. 

For information on parameter values, see “Installation and upgrade worksheet” on 
page 229 in Plan and Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping  worksheet file (p8_worksheet.xls), perform the following actions to quickly 
see only the installation properties you must specify for the Application Engine 
installation program:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration 
Program" column header and select AE Installer.

Platform Command

AIX P8AE-4.0.2.0-AIX.bin

HPUX P8AE-4.0.2.0-HPUX.bin

HPUXi P8AE-4.0.2.0-HPUX64.bin

Linux P8AE-4.0.2.0-LINUX.bin

Solaris P8AE-4.0.2.0-SOL.bin

Windows P8AE-4.0.2.0-WIN.exe

zLinux P8AE-4.0.2.0-ZLINUX.bin
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– Click the AutoFilter drop-down arrow in all other column headers and select 
(All).

IMPORTANT  If you are modifying the silent input file to perform an upgrade from AE 
3.5.x to AE 4.0.2 you must modify all instances of AE_install_path in the script as 
follows:

UNIX

Change ../FileNet/AE to ../FileNet

Windows

Change ..\FileNet\AE to ..\FileNet

Change ..\\Filenet\\AE to ..\\FileNet

iii. From a command prompt, navigate to and run the installer:

UNIX

./P8AE-4.0.2.0-operating system.bin -options path_to_edited_input_file/
AE_silent_input.txt -silent

Windows

P8AE-4.0.2.0-Win.exe -options path_to_edited_input_file\AE_silent_input.txt -
silent

NOTE  When installing Application Engine remotely on UNIX, run the installer with the 
standard input stream redirected from /dev/console, for example: 

rsh remote-machine -n P8AE-4.0.2.0-AIX.bin -options AESilentScriptUNIX.txt -
silent < /dev/console 

If you do not add the redirect, the silent intaller will fail with a "process not attached to 
terminal" message and the usage message for the "who" command. 

iv. Continue with Step 4. 

3. Complete the Application Engine Installer screens. For information on parameter values, see 
“Installation and upgrade worksheet” on page 229 in Plan and Prepare Your Environment for IBM 
FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping     
worksheet file (p8_worksheet.xls), perform the following actions to quickly see only the     
installation properties you must specify for the Application Engine installation program:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select AE Installer.

• Click the AutoFilter drop-down arrow in all other column headers and select (All).
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Use the parameters from your installation preparation tasks to complete the installer screens, 
as follows:

In the screen for... Perform this action...

Reading the license 
agreement

NOTE  This screen does 
not appear during a re-
install or an upgrade.

Review and accept the license agreement.

Specifying the 
installation path

For the Installation path field, enter or browse to the location 
where you want to install the Application Engine software 
AE_install_path, or accept the default location:

UNIX

/opt/FileNet/AE/

Windows

C:\Program Files\FileNet\AE\

The installation program installs the Application Engine 
software in this path.

NOTES 

• The installer will use the AE_install_path to place a 
number of other files in default locations. See:

– “Specifying the configuration directory path” on page 214

– “Specifying the log file location” on page 215. 

– “Configuring user token security” on page 216

• On an upgrade the default AE_install_path will be:

UNIX

/opt/FileNet/

Windows

C:\Program Files\FileNet\

• If you select a custom install path, follow the same directory 
structure as seen in a typical install and retain 
the /FileNet/AE part of the path.
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Verifying upgrade

NOTE  This screen 
appears only during an 
upgrade.

The Setup program detects supported older versions of 
Application Engine. 

If the installer reports that no supported version of Application 
Engine exists on your server or if you don’t want to upgrade 
your Application Engine at this time, click Cancel to exit Setup. 

Choosing an application 
server

Select the application server and version from the drop-down 
lists. These choices must match your Content Engine 
application server.

Configuring Content 
Engine API settings

Configure the Content Engine API settings, as follows:

a. Transport method

Select EJB (Enterprise Java Beans) from the drop down 
list.

b. Content Engine Client software URL:

Replace the sample server name and port number 
(CEserver:2809) with the Content Engine server name 
and port number for your Content Engine server.

NOTE To verify the correct port to use, navigate to the 
ports section on the application server where Content 
Engine is deployed and check the 
BOOTSTRAP_ADDRESS port.

NOTE To change the Content Engine name later, or to 
connect to a different Content Engine, edit the 
WcmApiConfig.properties file. For information, see 
the IBM FileNet P8 help topic  FileNet P8 Administration > 
Application Engine Administration > Key configuration files 
and logs.

c. Content Engine upload URL

Replace the sample server name and port number 
(CEserver:2809) with the Content Engine server name 
and port number to use when uploading document 
content to the Content Engine server.

d. Content Engine download URL

Replace the sample server name and port number 
(CEserver:2809) with the Content Engine server name 
and port number for your Content Engine server from 
which to download document content.

In the screen for... Perform this action...
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Choosing deployment file 
type and creation time

Choose to have the wizard create the WAR or EAR file during 
the installation process, or to wait until later.

• Choose Generate a .ear file for deployment if your server 
can deploy an EAR file. Specify an application name for the 
EAR file deployment. The default is Workplace.

• Choose Generate a .war file for deployment if your server 
can deploy a WAR file. 

• Choose Do not generate a deployment file at this time if you 
have additional installation and configuration to perform 
(such as installing Content Engine and Process Engine 
client files and configuring the application server) that will 
require another generation of the WAR or EAR file.

NOTE If you decide to deploy Application Engine as a WAR file 
and later decide to redeploy as an EAR file you must uninstall 
Application Engine and then reinstall the application, selecting 
EAR file deployment. For information, see “Consider whether 
changing your deployment type is likely.” on page 207.

Choosing the 
authentication method

Select the authentication method for use at your site.

• Application-managed authentication uses authentication 
specific to the application and does not share credentials.

• Container-managed authentication provides the ability to 
use single sign-on (SSO) capabilities to share credentials 
between Application Engine and custom applications.

When you select Container-Managed Authentication, Setup 
installs a sample log-in application, and modifies the 
web.xml file to support SSO. You will need to perform 
additional configuration for SSO after Setup is finished.

In the screen for... Perform this action...
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Specifying the 
documentation URL

Enter the documentation server URL, which is where the IBM 
FileNet P8 Platform Documentation is installed.

Your entry must be in the following format:

http://docserver:port#/ecm_help/

where: 

docserver is the name of the Java application server.

port# is the port number.

ecm_help is the root folder of the documentation website. You 
can use multi-part root folders (for example, /docs/ecm_help) 
if your application server supports them.

See “Install IBM FileNet P8 Platform documentation (All)” on page 23 
for more information. 

NOTE For information on how to reconfigure the documentation 
URL after installation is completed, see the IBM FileNet P8 help 
topic  FileNet P8 Administration > Application Engine Administration 
> Key configuration files and logs >  Bootstrap properties.

In the screen for... Perform this action...
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Specifying the 
configuration directory 
path

Accept the default location or browse to the location where you 
want to store the configuration files.

The default location for the configuration files is in a separate 
Config directory one level up from the AE_install_path 
directory selected earlier.

Default location of the configuration directory:

UNIX

/opt/FileNet/Config/

Windows

C:\Program Files\FileNet\Config\

CAUTION  A UNC admin share (for example, \\server\C$) for 
a shared location is not supported. You can use an ordinary file 
share.

NOTES 

• If you select a custom install location, follow the same 
directory structure as seen in a typical install and retain the 
/FileNet/Config/AE part of the path.  

• The configuration files for an EAR file deployment, a web 
farm, or a clustered environment must be located in a 
shared folder that is accesible by all copies of the 
Workplace application. For more information, see the IBM 
FileNet P8 Platform High Availability Technical Notice. To 
download this guide from the IBM support page, see “Access 
IBM FileNet documentation, compatibility matrices, and fix packs” 
on page 20.

Specifying the upload 
location

Provide the upload directory path.

The upload directory is the directory used by Workplace to 
store temporary copies of files uploaded to Workplace. 

Accept the default option or browse for a directory to hold the 
temporary upload files.

CAUTION  A UNC admin share (for example, \\server\C$) for 
a shared upload directory location is not supported. You can 
use an ordinary file share.

In the screen for... Perform this action...
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Specifying the download 
location

Provide the download directory path.

The download directory is the directory used by Workplace to 
store temporary copies of  files downloaded from Workplace. 

Accept the default option or browse for a directory to hold the 
temporary download files.

CAUTION  A UNC admin share (for example, \\server\C$) for 
a shared download directory is not supported. You can use an 
ordinary file share.

Specifying the log file 
location

Provide the Log files directory path.

The Log file path is the directory used by the installer to store 
the app_engine_install_log_4_0_2.txt log file. 

Accept the default option or browse for a directory.

The default location for the log files is in a separate Logs 
directory one level up from the AE_install_path directory 
selected earlier.

Default location of the logs directory:

UNIX

/opt/FileNet/AE/Logs/

Windows

C:\Program Files\FileNet\AE\Logs\

NOTE  If you select a custom install location, follow the same 
directory structure as seen in a typical install and retain 
the /FileNet/Logs part of the path.  

In the screen for... Perform this action...
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Configuring user token 
security

Configure user token security.

a. If needed, select the check box to create maximum 
strength keys.

By default the installer creates limited strength keys.

b. Enter the number of keys to use, from 1-100. 

NOTE  Security generally increases with the number of 
keys used.

c. Make a note of the user token crypto key path.

The UTCryptoKeyFile.properties file contains the 
user token cryptography key used by IBM FileNet P8 
applications to launch into each other without the need 
for additional login. 

The default location for the User Token Crypto Key file is 
in a separate Authentication directory one level up 
from the AE_install_path directory selected earlier.

Default location of the Authentication directory:

UNIX

/opt/FileNet/Authentication/

Windows

C:\Program Files\FileNet\Authentication\

NOTE  If you select a custom install location it is 
recommended to follow the same directory structure as 
seen in a typical install and retain the /FileNet/
Authentication part of the path.  

CAUTION For multiple applications to pass user tokens to each 
other, each participating application must use the same 
encryption key file. Copy the UTCryptoKeyFile.properties 
file installed with Application Engine to all servers that are 
hosting a token-sharing application.

For information, see the IBM FileNet P8 Developer Help topic 
Developer Help > Workplace Integration and Customization 
Introduction > User Tokens > Configuring Applications to Use Tokens.

Verifying your installation 
selections

Review the list of selections you have made. You may need to 
scroll to see all selections.

Starting the installation Review the installation summary, and click Install.

In the screen for... Perform this action...
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4. View the app_engine_install_log_4_0_2.txt file located, located in AE_install_path/
AE/Logs.

Verify that no errors or failures were logged. Look for the ERROR designation at the start of a 
line. Correct any errors before you proceed.

5. (Optional, UNIX only) Set the the P8TASKMAN_HOME system environment variable.

The Process Engine Client installer will set this variable for you. If you want to specify a 
different location for the client files, you can do so by setting the P8TASKMAN_HOME system 
variable. The default value set by the PE Client installer is:

P8TASKMAN_HOME=AE_install_path/CommonFiles

6. Continue with Task 2 “Install Application Engine software updates” on page 218.

Completing Application 
Engine setup

Click Finish to complete the installation.

In the screen for... Perform this action...
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Task 2: Install Application Engine software updates
Install any fix packs and interim fixes required for Application Engine.

To install the Application Engine software updates

1. To download the latest software updates, and to determine which of these updates may be 
required for use with other components and expansion products, contact your support 
representative.

2. Open the readmes for any subsequent fix packs or interim fixes (typically optional) and perform 
the installation procedures provided.

3. Install the latest updates for the Content Engine Client and Process Engine Client files using the 
subsequent tasks.
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Task 3: Install the latest Content Engine Client files on 
Application Engine servers
To install the 4.5 release or fix pack version Content Engine Client files, perform the following 
procedures on all Application Engine servers. Most steps apply to both new installations and 
updates. However, some noted steps apply only to updates of the Content Engine Client files to a 
previously configured Application Engine installation. Except where noted, these steps apply to 
WebSphere, WebLogic, and JBoss.

To install the Content Engine Client files

Refer to the appropriate information from your installation worksheet while performing the 
following steps. For information about the Content Engine parameter values, see “Installation and 
upgrade worksheet” on page 229 in Plan and Prepare Your Environment for IBM FileNet P8.

HINT Verify that the Data > Filter > AutoFilter command is enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls). Do the following steps to quickly see only the 
installation properties you must specify for the Content Engine installation program:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select CE Client installer.

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify: Setup Type contains "Installation."

• Click the AutoFilter drop-down arrow in all other column headers and select (All).

1. To download the latest software updates, and to determine which of these updates might be 
required for use with other components and expansion products, contact your service 
representative.

2. Log on to the server where Application Engine is installed as any user who has the following 
permissions:

• Read and write permission to a temporary directory, such as temp (Windows) or tmp (UNIX), on 
the machine where Application Engine is installed

• Execute permission on the Content Engine Client install software

3. (For update installations only) Verify that there is a current backup of the Application Engine. 

4. Copy the Content Engine Client install software from the Content Engine installation software to 
the temporary directory. The version of the install software must match the version of Content 
Engine.

5. Expand the (TAR or ZIP) Content Engine Client install software within the temporary directory.

6. (For update installations only) Close all instances of Workplace and any other Application 
Engine client applications. From the application server administrative console, stop and 
undeploy Application Engine.

WebSphere

Stop and undeploy the FileNet Application Engine application.
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WebLogic

Stop and undeploy the FileNet Application Engine application.

JBoss

Execute the shutdown command.

7. (WebLogic only) Manually delete the following application server cache directories, substituting 
your domain name in place of mydomain:

WebLogic UNIX

/opt/bea/user_projects/domains/mydomain/servers/AdminServer/tmp/_WL_user/
app_engine

/opt/ bea/user_projects/domains/mydomain/servers/.wlnotdelete

/opt/bea/user_projects/domains/mydomain/servers/AdminServer/cache/
EJBCompilerCache

WebLogic Windows

C:\bea\user_projects\domains\mydomain\servers\AdminServer\tmp\_WL_user\app_
engine

C:\bea\user_projects\domains\mydomain\servers\.wlnotdelete

C:\bea\user_projects\domains\mydomain\servers\AdminServer\cache\EJBCompiler
Cache

8. Start the Content Engine Client install process.

• To install the Content Engine Client interactively:

i. Navigate to the IBM FileNet Content Engine Client software in the temporary directory.

ii. Run one of the commands in the following table, where CE_version is the version of 
Content Engine you intend to run, for example, 4.5.0.

Operating System Install Program

AIX P8CE-CLIENT-CE_version-AIX.BIN

HPUX P8CE-CLIENT-CE_version-HPUX.BIN

HPUXi P8CE-CLIENT-CE_version-HPUXI.BIN

Linux P8CE-CLIENT-CE_version-LINUX.BIN

Solaris P8CE-CLIENT-CE_version-SOL.BIN

Windows P8CE-CLIENT-CE_version-WIN.EXE

zLinux P8CE-CLIENT-CE_version-ZLINUX.BIN
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iii. Complete the installation program wizard, using the following table. 

In this screen... Perform this action...

Welcome Click Next to proceed with the Content Engine Client 
installation.

NOTE Click Back at any time while running the Content Engine 
Client installer to change any previous entries. Click Cancel to 
exit the Content Engine Client installer.

Specify Content 
Engine Client 
Installation Path

Specify the complete path where you want the Content Engine 
Client program files installed. The defaults are as follows:

UNIX

/opt/FileNet/CEClient

Windows

C:\Program Files\FileNet\CEClient

Click Next to continue.

Select FileNet P8 
Applications

Select Application Engine, and click Next to continue.

Application 
Engine 
Installation Path

Enter the full path to the Application Engine installation 
location. The defaults are as follows:

UNIX

/opt/FileNet/AE

Windows

C:\Program Files\FileNet\AE

Click Next to continue.

Content Engine 
Application 
Server

Select the Content Engine application server type from the list. 
Valid choices are: 

• WebSphere

• WebLogic

• JBoss

Click Next to continue.
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Specify URLS for 
EJB Transport

Specify the URLS for the Content Engine Enterprise JavaBeans 
(EJB) API.

• Content Engine Client Software URL

The URL for the Content Engine Web Services client API. 
This URL contains the WcmApiConfig.properties file. 
Applications require this file to communicate with Content 
Engine Server through the EJB method or the Web Services 
transport method.

The default is: cemp:iiop//CEServer:2809/FileNet/Engine

• Content Engine upload URL

The upload URL is used for internal processes during EJB 
transport activities.

The default is: cemp:iiop//CEServer:2809/FileNet/Engine

• Content Engine download URL

The download URL is used for internal processes during 
EJB transport activities.

The default is: cemp:iiop//CEServer:2809/FileNet/Engine

Click Next to continue.

Specify URL for 
WSI Transport

The URL for the Content Engine Web Services client API. 
The API contains the WcmApiConfig.properties file. 
Applications require this file to communicate with Content 
Engine Server, either with the EJB method or the Web 
Services transport method.

The default is: 
cemp:http://CEServer:9080/wsi/FNCEWS40DIME/

Click Next to continue.

Create 
Deployment File

Specify whether the installer creates the deployment file for 
your application. If you have additional configuration to perform, 
you can create the deployment file manually later on. Select 
one of the following choices:

• Have the installer create the file.

• Create the file later.

Click Next to continue.

Review Pre-
Installation 
Summary 

Verify your component selections, and click Install to start 
installing Content Engine Client.

In this screen... Perform this action...
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• To install the Content Engine Client files silently:

i. Make a backup copy of the CEClient_silent_install.txt input file, located in the 
software directory.

ii. Open CEClient_silent_install.txt in a text editor. Follow the instructions in the 
silent input file to edit the entries to reflect the appropriate responses for your install or 
update.

iii. Navigate to the path containing the Content Engine Client installation program. From 
that directory, run one of the commands in the following table to perform the silent 
install, where:

CE_version is the version of Content Engine you intend to run, for example, 4.5.0.

 path is the path that contains the installation program.

Continue at “Install the latest Process Engine Client files on Application Engine servers” on page 224.

Operating 
System

Install Program

AIX P8CE-CLIENT-CE_version-AIX.BIN -f path/CECLIENT.AIX/ 
CEClient_silent_install.txt -i silent

HPUX P8CE-CLIENT-CE_version-HPUX.BIN -f path/CEClient.HPUX/ 
CEClient_silent_install.txt -i silent

HPUXi P8CE-CLIENT-CE_version-HPUXI.BIN -f path/CEClient.HPUXI/
CEClient_silent_install.txt -i silent

Linux P8CE-CLIENT-CE_version-LINUX.BIN -f path/CEClient.Linux/
CEClient_silent_install.txt -i silent

Solaris P8CE-CLIENT-CE_version-SOL.BIN -f path/CEClient.Solaris/
CEClient_silent_install.txt -i silent

Windows P8CE-CLIENT-CE_version-WIN.EXE -f path\CEClient.Windows\ 
CEClient_silent_install.txt -i silent

zLinux P8CE-CLIENT-CE_version-ZLINUX.BIN -f path/CEClient.zLinux/
CEClient_silent_install.txt -i silent
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 4: Install the latest Process Engine Client files on Application Engine servers
To install the Process Engine client files

224
Task 4: Install the latest Process Engine Client files on 
Application Engine servers
To install the Process Engine Client files, perform the following steps on all Application Engine 
servers.

For both interactive and silent installs, refer to the appropriate information from your installation 
worksheet while performing the following steps. For information on the Process Engine parameter 
values, see “Installation and upgrade worksheet” on page 229 in Plan and Prepare Your Environment 
for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to quickly see only the 
installation properties you must specify for the Process Engine client installation program:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select PE Client installer.

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify: Setup Type contains "Installation."

• Click the AutoFilter drop-down arrow in all other column headers and select (All).

To install the Process Engine client files

1. On the machine where Application Engine is to be deployed, log on as any user who has the 
following permissions:

• Read and write permission to a temporary directory, such as temp (Windows) or tmp (UNIX), on 
the machine where Application Engine is installed

•  Execute permission on the Process Engine Client install software

2. Copy the Process Engine Client install software from the Process Engine installation software to 
the temporary directory. The version of the install software must match the version of Process 
Engine. 

3. Expand the (TAR or ZIP) Process Engine Client install software within the temporary directory. 
The jre.tar file that is packaged with the Process Engine Client installer must be in the same 
directory as the Process Engine Client installer when the installer is run.

4. The expanded install software contains the Process Engine Client install program specific to the 
operating system on the machine where Application Engine is deployed. Run the program either 
interactively (using the install wizard) or silently.

To run the program interactively, run one of the commands in the table below, follow the wizard 
instructions, and then continue at step 5:  

Operating System Install Program

AIX P8PE-CLIENT-4.5.0-AIX.BIN

HPUX P8PE-CLIENT-4.5.0-HPUX.BIN

HPUXi P8PE-CLIENT-4.5.0-HPUXI.BIN
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5. Complete the Process Engine client installer screens, as follows:

Linux P8PE-CLIENT-4.5.0-LINUX.BIN

Solaris P8PE-CLIENT-4.5.0-SOL.BIN

Windows P8PE-CLIENT-4.5.0-WIN.EXE

zLinux P8PE-CLIENT-4.5.0-ZLINUX.BIN

In this screen... Perform this action...

Welcome to Process 
Engine Client Installer

Click Next to proceed with the installation.

NOTE Click Previous at any time to make changes in previous 
screens. Click Cancel to exit the program.

Specify Installation 
Location

Choose the destination directory for Process Engine Client log 
files and uninstallation files. Accept the default location or click 
Browse to change the location.  

Select FileNet P8 
Applications

Select Application Engine as the product for which you would 
like to install Process Engine Client files.

Click Next to continue.

Application Engine 
Installation Path

Enter the full path to the Application Engine installation 
location. The defaults are as follows:

UNIX

/opt/FileNet/AE

Windows

C:\Program Files\FileNet\AE

Click Next to continue.

Specify the URL for the 
Component Manager

Enter the URL that the Component Manager uses to connect to 
the Content Engine using Web Services transport. The default 
is:

http://CEServer:port/wsi/FNCEWS40DIME/

Operating System Install Program
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To run the program silently, perform the following steps:

a. In the expanded install software, open the file PEClient_silent_install.txt and edit it 
as follows:

i. Change the Variable_CheckboxAE line to the following:

-V Variable_CheckboxAE="true"

ii. Run one of the commands in the following table to perform the silent install:

Specify the 
Documentation URL

Enter the URL where the IBM FileNet P8 Platform 
Documentation is installed. Use the following format:

http://docserver:port#/ecm_help

where: 

docserver is the name of the Java web server.
port# is the port number.
ecm_help is the root folder of the documentation web site. You 
can use multi-part root folders, for example, /docs/ecm_help, 
if your application server supports them.

Specify when to create 
the deployment file

Indicate whether to create the WAR or EAR deployment file now 
or later. If you have additional configuration to perform, you can 
create the deployment file manually later. 

Stop running BPM 
software

If the installer detects running BPM software components, click 
Next to stop the software and continue with the installation.

Review Pre-Installation 
Summary 

Verify your component selections, and click Install to start 
installing Process Engine Client.

Operating 
System

Install Program

AIX P8PE-CLIENT-4.5.0-AIX.BIN -silent -options 
"PEClient_silent_install.txt" 

HPUX P8PE-CLIENT-4.5.0-HPUX.BIN -silent -options 
"PEClient_silent_install.txt" 

HPUXi P8PE-CLIENT-4.5.0-HPUXI.BIN -silent -options 
"PEClient_silent_install.txt"

Linux P8PE-CLIENT-4.5.0-LINUX.BIN -silent -options 
"PEClient_silent_install.txt" 

Solaris P8PE-CLIENT-4.5.0-SOL.BIN -silent -options 
"PEClient_silent_install.txt" 

In this screen... Perform this action...
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Configure Application Engine using the instructions for you application server type: 

• “Configure Application Engine (WebSphere)” on page 228

• “Configure Application Engine (WebLogic)” on page 237

• “Configure Application Engine (JBoss)” on page 243

Windows P8PE-CLIENT-4.5.0-WIN.EXE -silent -options 
"PEClient_silent_install.txt" 

zLinux P8PE-CLIENT-4.5.0-ZLINUX.BIN -silent -options 
"PEClient_silent_install.txt" 

Operating 
System

Install Program
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Task 5a: Configure Application Engine (WebSphere)
To use the Application Engine web application (Workplace), you must first configure the 
application to work with your application server. Use the following procedures to configure 
Workplace. Not all procedures apply to all installations. Do the procedures that apply to your 
installation in the order presented here.

To edit web.xml for container-managed authentication or SSO

NOTE  Perform this procedure only if your site uses WebSphere with container-managed 
authentication or Single Sign-On (SSO). If you are using SSO, you must perform additional 
configuration steps as directed at the end of this procedure. 

1. Make a back-up copy of web.xml.

AE_install_path/Workplace/WEB-INF/web.xml

2. Edit web.xml.

NOTE  Text in bold in the following examples indicates changes made to the original web.xml 
file.

a. Search for the parameter challengeProxyEnabled and set it to false.

  <param-name>challengeProxyEnabled</param-name> 
  <param-value>false</param-value> 

b. Search for the first instance of <web-resource-collection>, and uncomment the url-pattern 
as noted in the file comments. 

<web-resource-collection>
<web-resource-name>action</web-resource-name>
<description>Define the container secured resource</description>
<url-pattern>/containerSecured/*</url-pattern>

      <!--

           Uncomment this section if all resources that require credentials 
must be secured in order to obtain a secured Thread.  If using WebSphere, 
this section must be
           uncommented.
--> Move this commenting tag here from just before the </web-resource- 
collection> closing tag below.

<url-pattern>/containerSecured/*</url-pattern>
<url-pattern>/</url-pattern>
<url-pattern>/author/*</url-pattern>
<url-pattern>/Browse.jsp</url-pattern>
<url-pattern>/eprocess/*</url-pattern>
<url-pattern>/Favorites.jsp</url-pattern>
<url-pattern>/GetPortalSitePreferences.jsp</url-pattern>
<url-pattern>/GetTokenSignIn.jsp</url-pattern>
<url-pattern>/GetUserInformation.jsp</url-pattern>
<url-pattern>/GetUserToken.jsp</url-pattern>
<url-pattern>/HomePage.jsp</url-pattern>
<url-pattern>/IntegrationWebBasedHelp.jsp</url-pattern>
<url-pattern>/is/*</url-pattern>
<url-pattern>/operations/*</url-pattern>
<url-pattern>/portlets/Author/edit.jsp</url-pattern>
<url-pattern>/portlets/Author/portlet.jsp</url-pattern>
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<url-pattern>/portlets/Browse/edit.jsp</url-pattern>
<url-pattern>/portlets/Browse/portlet.jsp</url-pattern>
<url-pattern>/portlets/ExternalUrl/edit.jsp</url-pattern>
<url-pattern>/portlets/ExternalUrl/portlet.jsp</url-pattern>
<url-pattern>/portlets/GroupPageDesign.jsp</url-pattern>
<url-pattern>/portlets/GroupPageSettings.jsp</url-pattern>
<url-pattern>/portlets/Inbox/edit.jsp</url-pattern>
<url-pattern>/portlets/Inbox/portlet.jsp</url-pattern>
<url-pattern>/portlets/MultiPagesDesign.jsp</url-pattern>
<url-pattern>/portlets/OrganizePages.jsp</url-pattern>
<url-pattern>/portlets/PortalPageDesign.jsp</url-pattern>
<url-pattern>/portlets/PortalPageInfo.jsp</url-pattern>
<url-pattern>/portlets/PortletAlias.jsp</url-pattern>
<url-pattern>/portlets/PortletSettings.jsp</url-pattern>
<url-pattern>/portlets/PreviewAndSetup.jsp</url-pattern>
<url-pattern>/portlets/PublicQueue/edit.jsp</url-pattern>
<url-pattern>/portlets/PublicQueue/portlet.jsp</url-pattern>
<url-pattern>/portlets/QuickSearch/edit.jsp</url-pattern>
<url-pattern>/portlets/QuickSearch/portlet.jsp</url-pattern>
<url-pattern>/portlets/Workflows/edit.jsp</url-pattern>
<url-pattern>/portlets/Workflows/portlet.jsp</url-pattern>
<url-pattern>/properties/*</url-pattern>
<url-pattern>/redirect/*</url-pattern>
<url-pattern>/regions/*</url-pattern>
<url-pattern>/Search.jsp</url-pattern>
<url-pattern>/select/*</url-pattern>
<url-pattern>/SelectReturn.jsp</url-pattern>
<url-pattern>/Tasks.jsp</url-pattern>
<url-pattern>/UI-INF/*</url-pattern>
<url-pattern>/utils/*</url-pattern>
<url-pattern>/WcmAdmin.jsp</url-pattern>
<url-pattern>/WcmAuthor.jsp</url-pattern>
<url-pattern>/WcmBootstrap.jsp</url-pattern>
<url-pattern>/WcmCloseWindow.jsp</url-pattern>
<url-pattern>/WcmDefault.jsp</url-pattern>
<url-pattern>/WcmError.jsp</url-pattern>
<url-pattern>/WcmJavaViewer.jsp</url-pattern>
<url-pattern>/WcmObjectBookmark.jsp</url-pattern>
<url-pattern>/WcmPortletHelp.jsp</url-pattern>
<url-pattern>/WcmPortletSearch.jsp</url-pattern>
<url-pattern>/WcmQueueBookmark.jsp</url-pattern>
<url-pattern>/WcmSignIn.jsp</url-pattern>
<url-pattern>/WcmSitePreferences.jsp</url-pattern>
<url-pattern>/WcmUserPreferences.jsp</url-pattern>
<url-pattern>/WcmWorkflowsBookmark.jsp</url-pattern>
<url-pattern>/wizards/*</url-pattern>
<url-pattern>/Author/*</url-pattern>
<url-pattern>/axis/*.jws</url-pattern>
<url-pattern>/Browse/*</url-pattern>
<url-pattern>/ceTunnel</url-pattern>
<url-pattern>/CheckoutList/*</url-pattern>
<url-pattern>/downloadMultiTransferElement/*</url-pattern>
<url-pattern>/ExternalUrl/*</url-pattern>
<url-pattern>/findRecordTarget</url-pattern>
<url-pattern>/formCallback/*</url-pattern>
<url-pattern>/getAnnotSecurity/*</url-pattern>
<url-pattern>/getCEAnnotations/*</url-pattern>
<url-pattern>/getContent/*</url-pattern>
<url-pattern>/getForm/*</url-pattern>
<url-pattern>/getISAnnotations/*</url-pattern>
<url-pattern>/getISAnnotSecurity/*</url-pattern>
<url-pattern>/getISContent/*</url-pattern>
<url-pattern>/getMultiContent/*</url-pattern>
<url-pattern>/getPreview</url-pattern>
<url-pattern>/getProcessor/*</url-pattern>
<url-pattern>/getRealms/*</url-pattern>
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<url-pattern>/getUsersGroups/*</url-pattern>
<url-pattern>/Inbox/*</url-pattern>
<url-pattern>/integrationCommandProxy</url-pattern>
<url-pattern>/integrationResponse</url-pattern>
<url-pattern>/integrationResponseProxy</url-pattern>
<url-pattern>/integrationWebBasedCommand</url-pattern>
<url-pattern>/keepAlive</url-pattern>
<url-pattern>/launch/*</url-pattern>
<url-pattern>/PublicQueue/*</url-pattern>
<url-pattern>/putContent/*</url-pattern>
<url-pattern>/QuickSearch/*</url-pattern>
<url-pattern>/signingServlet/*</url-pattern>
<url-pattern>/transport/*</url-pattern>
<url-pattern>/upload/*</url-pattern>
<url-pattern>/vwsimsoapservlet</url-pattern>
<url-pattern>/vwsoaprouter</url-pattern>
<url-pattern>/Workflows/*</url-pattern>   Move the closing comment tag from 
here to the location indicated at the beginning of this example. 

</web-resource-collection>

c. Locate the section <auth-constraint>, comment the wildcard (*) role-name as noted in the 
file comments.

<auth-constraint>
<!-- <role-name>*</role-name> -->
<!-- For WebSphere 6, use the role-name line below instead of the wildcard role 
above.-->

<role-name>All Authenticated</role-name>

<!-- For WebSphere 6, add this security-role element below the login-config 
element (below).
   <security-role>

   <description>All Authenticated</description>
   <role-name>All Authenticated</role-name>

   </security-role>
                -->

</auth-constraint>

                
d. Locate the end of the </login-config> element, and add the All Authenticated users role-

element after the closing tag.

<security-role>
<description>All Authenticated</description>
<role-name>All Authenticated</role-name>

</security-role>

e. Search for the first instance of a <security-constraint> tag, and add the following <security-
constraint> tag before that tag.

IMPORTANT  Enter the following information as single lines without line breaks.  

<security-constraint>
<web-resource-collection>

<web-resource-name>action</web-resource-name>
<description>Define the non-secured resource</description>
<url-pattern>/P8BPMWSBroker/*</url-pattern>

</web-resource-collection>
</security-constraint>

3. Save your changes to web.xml and close the file.
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4. If your site uses SSO, continue on with “(SSO Only) To edit web.xml for SSO (optional)” on 
page 231. Otherwise continue with “To configure Application Engine (WebSphere)” on page 232.

(SSO Only) To edit web.xml for SSO (optional)

NOTE  Perform this procedure only if your site uses SSO with a proxy server. You must use this 
procedure to modify web.xml to enable SSO. 

1. Open web.xml for editing.

2. At the end of web.xml, comment out the <login-config> element, as follows:

<!--
<login-config>

<auth-method>FORM</auth-method>
<realm-name>AE Workplace</realm-name>
<form-login-config>

<form-login-page>/ContainerLogin.jsp</form-login-page>
<form-error-page>/ContainerError.jsp</form-error-page>

</form-login-config>
</login-config>
-->

3. As needed, set the ssoProxyContextPath, ssoProxyHost, ssoProxyPort, and ssoProxySSLPort. 

These parameter values are used to modify one or more elements of the native URL that 
Workplace sees on a request. Wherever the value of an SSO proxy host element in the URL 
request is different from the equivalent information for the host where Workplace is deployed,  
you must set the corresponding sso<proxy host element> parameter for that element in the 
URL to the value for the SSO proxy host. 

The default settings are (in bold):

<init-param>
<param-name>ssoProxyContextPath</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxyHost</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxyPort</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxySSLPort</param-name>
<param-value></param-value>

</init-param>

In general, the init parameters must be configured as follows:

• ssoProxyContextPath: Set the value to the context path of the SSO proxy host URL. This path is 
the path portion of the URL that appears after the server name. The path represents top-level 
access to the Workplace application. 

For example, if the Workplace deployment host URL is 
http://deploy_server:2809/Workplace and the SSO proxy host URL is 
http://sso_proxy_server.domain.com/fn/Workplace, then use the following values:
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<param-name>ssoProxyContextPath</param-name>
<param-value>/fn/Workplace</param-value>

• ssoProxyHost: Set the value to the SSO proxy host server name. Typically, this value is a full 
domain-qualified host name. 

For example, if the host URL where Workplace is deployed is 
http://deploy_server/Workplace and the corresponding SSO proxy host URL is 
http://sso_proxy_server/Workplace, then use the following values:

<param-name>ssoProxyHost</param-name>
<param-value>sso_proxy_server</param-value>

• ssoProxyPort: Set the value to the http port on the SSO proxy host. 

For example:

<param-name>ssoProxyPort</param-name>
<param-value>80</param-value>

• ssoProxySSLPort: Set the value to the https port on the SSO proxy host, if defined or used to 
access Workplace pages. 

For example:

<param-name>ssoProxySSLPort</param-name>
<param-value>443</param-value>

4. Save your changes to web.xml and close the file.

To configure Application Engine (WebSphere) 

1. In the administrative console, set JVM settings for JAAS login configuration and memory 
settings.

a. Navigate to Servers > Application Servers > server_name > Java & Process Management > 
Process Definition > Java Virtual Machine. 

In the Java Virtual Machine settings, set the JAAS login entry in the Generic JVM 
argument field to the following (do not enter the line breaks):

-Djava.security.auth.login.config=AE_install_path\CE_API\config
\jaas.conf.WebSphere

where AE_install_path is your installation path. Your path might be slightly different 
depending on the version of your client installations, or whether you have chosen a custom 
path for installation. Verify the location of the file and specify the install path location 
before you enter the path.

IMPORTANT  (Windows only) The path cannot contain a space. You must use 8.3-notation 
for the install path portion of the full JAAS login entry.

If your AE_install_path is:

C:\Program Files\FileNet\AE

use: 

C:\Progra~1\FileNet\AE
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IMPORTANT  Do not copy and paste the text from this guide into the field in the console 
because hidden formatting can cause problems with the entry. Use a paste special option 
in a text editor to remove formatting first, or type the entry into the field.

b. Set the Initial and Maximum Heap Size.

Refer to your application server vendor recommendation for Initial and Maximum heap size 
values. For IBM-specific recommendations, see the IBM FileNet P8 Platform Performance 
Tuning Guide. To download this guide from the IBM support page, see “Access IBM FileNet 
documentation, compatibility matrices, and fix packs” on page 20.

c. Save your changes.

2. (For installations with Content Engine and Application Engine collocated on the WebSphere 
server, but in different WebSphere profiles) Create an additional JVM property for different 
WebSphere profiles.

Perform the following steps on both the Content Engine profile and the Application Engine 
profile:

a. In the Java Virtual Machine settings, click Custom Properties > New. 

b. In the Name field, enter the following name:

com.ibm.websphere.orb.uniqueServerName

c. Set the Value to true.

d. Save your changes.

3. Verify that Application Integration installation is enabled.

a. In the Environment area, in Virtual Hosts, navigate to default_host (or the host your 
application is deployed under).

b. Click MIME Types.

c. Verify that MIME type is set to application/octet-stream or use the following steps to set it.

i. Click New.

ii. In the MIME Type field, enter application/octet-stream.

iii. In the Extension(s) field, enter exe. Click OK.

iv. Click Apply, click Save.

d. Save your changes.

4. Configure Lightweight Third Party Authentication (LTPA).

NOTE  Skip this step if your Application Engine and Content Engine are located on the same 
application server.

a. On the Content Engine application server, do the following:

NOTE  If you are already using LTPA with your Content Engine application server, you only 
need to copy the key file to the Application Engine server. Skip to Step xii.
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i. Log in to the administrative console.

ii. Navigate to Security > Secure administration, applications, and infrastructure.

iii. From the right side of the panel, select Authentication Mechanisms and expiration.

iv. Enter a value for the timeout that is larger than the default. 

For example, if the timeout value is set to 120 minutes, the LTPA key expires. Users 
will not be able to log in to Workplace after having been logged in for 2 hours.

v. Save your changes.

vi. In the box titled "Cross-cell single sign-on,” enter a password to create the LTPA 
password.

NOTE  For password restrictions, see the WebSphere documentation. If you have 
already configured Content Engine for LTPA, use the existing password for the 
Application Engine steps.

vii. Enter a path for the Key File Name. For example, /opt/LTPA/ltpa_key_name.

viii. Click Export Keys. Verify that the following message is displayed: The keys were 
successfully exported to the file ltpa_key_name.

ix. Click Import Keys.

x. Click OK, and then click Save changes to the Master Configuration.

xi. Stop and restart WebSphere.

xii. Copy the key file from Content Engine server location you specified to a directory on 
the Application Engine server. For example, /opt/LTPA/ltpa_key_name.

b. On the Application Engine server WebSphere administrative console, do the following steps:

i. Navigate to Security > Secure administration, applications, and infrastructure.

ii. From the right side of the panel, select Authentication Mechanisms and expiration.

iii. Enter a value for the timeout that is larger than the default. 

For example, if the timeout value is set to 120 minutes, the LTPA key expires. Users 
will not be able to log in to Workplace after having been logged in for 2 hours. Save 
your changes.

iv. In the box titled cross-cell single sign-on, enter the LTPA password you created for 
Content Engine. Confirm the password.

v. Specify the path for the key file that you copied to the Application Engine server. For 
example, /opt/LTPA/ltpa_key_name.

vi. Click Import Keys. Verify that the following message is displayed: The keys were 
successfully imported from the file ltpa_key_name.

vii. Save your changes.

5. Configure Lightweight Directory Access Protocol (LDAP).
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NOTE  Skip this step if your Application Engine and Content Engine are located on the same 
application server.

a. Navigate to Security > Secure administration, applications, and infrastructure.

b. Disable security using the following Security settings:

– Turn off (clear) Enable Administrative Security flag.

– Turn off (clear) Enable application security flag.

– Turn off (clear) Java 2 Security.

c. From the Active Authentication Mechanism drop down list, select LTPA (Light weight Third 
Party Authentication).

d. From the bottom of the panel, in the box titled "available realm definitions," select 
Standalone LDAP registry and click Configure.

e. Configure the LDAP provider to exactly match the corresponding settings on the Content 
Engine application server.

– Primary administrative user name

– Select “Automatically generated server identity."

– Type

– Host

– Port

– Base distinguished name (DN)

– Bind distinguished name (DN)

– Bind password

f. Configure the Advanced Lightweight Directory Access Protocol (LDAP) user registry 
settings to exactly match the corresponding settings from the Content Engine application 
server. 

– User filter

– Group Filter

– User ID map

– Group member ID map

– Certificate map mode

– Certificate filter

g. Save these settings.

h. Next to "Available realm definitions," make sure "Standalone LDAP registry" is still selected, 
and click Set as current.

i. Re-enable the following Security settings:
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– Turn on (check) Enable Administrative Security flag.

– Turn on (check) Enable application security flag.

– Turn off (clear) Java 2 Security.

NOTE  The IBM FileNet P8 Platform uses LDAP-based security, and does not support Java 
2 security. Enabling Java 2 security can cause unexpected behavior.

j. Save your changes to the master configuration.

k. Test the connection on the Standalone LDAP registry page.  If the test fails, correct the error 
before proceeding.  If it passes, click OK to return to the previous page.

6. If you do not plan to perform the procedure to configure the server ports, stop and restart 
WebSphere before continuing on to deploy Application Engine.

7. Continue with “To configure the server ports” on page 236.

To configure the server ports

This configuration is not required but is recommended.

1. Stop the WebSphere server.

2. Make a backup copy of serverindex.xml located in:

WAS_HOME\profiles\default\config\cells\machine_nameNode01Cell\nodes\
machine_nameNode01\ 

3. Edit the serverindex.xml file for each node. The file has the same endpoints for each node 
on the server, and you need to perform the edit for each node.

Locate the <specialEndpoints> section, and change the port numbers for the three SSL 
listener addresses to “0” as shown here:

<specialEndpoints xmi:id="NamedEndPoint_1155689929072" 
endPointName="SAS_SSL_SERVERAUTH_LISTENER_ADDRESS">
  <endPoint xmi:id="EndPoint_1155689929072" host="host_name" port="0"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint_1155689929073" 
endPointName="CSIV2_SSL_SERVERAUTH_LISTENER_ADDRESS">
  <endPoint xmi:id="EndPoint_1155689929073" host="host_name" port="0"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint_1155689929074" 
endPointName="CSIV2_SSL_MUTUALAUTH_LISTENER_ADDRESS">
  <endPoint xmi:id="EndPoint_1155689929074" host="host_name" port="0"/>
</specialEndpoints>

4. Save and close the serverindex.xml file.

5. Restart WebSphere.

Deploy the Workplace application. See “Deploy Application Engine (WebSphere)” on page 246.
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Task 5b: Configure Application Engine (WebLogic)
This topic covers the configuration of your Application Engine application (Workplace) on 
WebLogic. Perform the following high-level steps in the order listed, using the referenced detailed 
procedures for each step.

1. If you are using SSO, edit web.xml. See “To edit web.xml for SSO (optional)” on page 237.

2. Modify the application server startup script. See “To modify the application server startup script” on 
page 238.

3. Configure Application Engine. See “To configure Application Engine (WebLogic)” on page 241.

4. Modify config.xml to support passing user credentials to clients such as Application 
Integration and WebDAV. See “To enable passing user credentials to client applications (WebLogic)” 
on page 242.

To edit web.xml for SSO (optional)

NOTE  Perform this procedure only if your site uses SSO with a proxy server. You must modify 
web.xml to enable SSO. 

1. Make a backup copy of web.xml.

AE_install_path/Workplace/WEB-INF/web.xml

2. Edit web.xml.

a. Set the parameter perimeterChallengeMode to true, as in:

<init-param>
<param-name>perimeterChallengeMode</param-name>
<param-value>true</param-value>

</init-param>

b. As needed, set the ssoProxyContextPath, ssoProxyHost, ssoProxyPort, and 
ssoProxySSLPort. 

These parameter values are used to modify one or more elements of the native URL that 
Workplace sees on a request. Wherever the value of an SSO proxy host element in the 
URL request is different from the equivalent information for the host where Workplace is 
deployed, then you must set the corresponding sso* parameter for that element in the URL 
to the value for the SSO proxy host. 

The default settings are (in bold):

<init-param>
<param-name>ssoProxyContextPath</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxyHost</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxyPort</param-name>
<param-value></param-value>

</init-param>
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<init-param>
<param-name>ssoProxySSLPort</param-name>
<param-value></param-value>

</init-param>

In general, the init parameters above should be configured as follows:

• ssoProxyContextPath: Set the value to the context path of the SSO proxy host URL. 
This is the path portion of the URL that appears after the server name, and which 
represents top-level access to the Workplace application. 

For example, if the Workplace deploy host URL is  
http://deploy_server:2809/Workplace and the SSO proxy host URL is 
http://sso_proxy_server.domain.com/fn/Workplace, then use the following:

<param-name>ssoProxyContextPath</param-name>
<param-value>/fn/Workplace</param-value>

• ssoProxyHost: Set the value to the SSO proxy host server name. Typically, this will be 
a full domain-qualified hostname. 

For example, if the host URL where Workplace is deployed is  
http://deploy_server/Workplace and the corresponding SSO proxy host URL is 
http://sso_proxy_server/Workplace, then use the following:

<param-name>ssoProxyHost</param-name>
<param-value>sso_proxy_server</param-value>

• ssoProxyPort: Set the value to the http port on the SSO proxy host. 

For example: 

<param-name>ssoProxyPort</param-name>
<param-value>80</param-value>

• ssoProxySSLPort: Set the value to the https port on the SSO proxy host, if defined 
and/or used to access Workplace pages. 

For example:

<param-name>ssoProxySSLPort</param-name>
<param-value>443</param-value>

3. Save your changes to web.xml and close the file.

To modify the application server startup script

1. Stop the WebLogic application server if running.

2. Make a backup copy of the application server startup script.

Back up startWebLogic.cmd for Windows or startWebLogic.sh for UNIX. 

NOTE  If you are not using a WebLogic domain, backup startWLS.cmd for Windows or 
startWLS.sh for UNIX.

a. Edit the MEM_ARGS variable. 

Adjusting this setting prevents the application server from running out of memory, a 
condition in which users would not be able to log in to Workplace.
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NOTE  If the MEM_ARGS variable doesn't exist, add it to the startup script. 

• For all systems except those using JRockit JAVA.

Append the following to the MEM_ARGS variable:

–XX:MaxPermSize=sizem

where size is the value, in MB, of the MaxPermSize. 

Refer to your application server vendor's recommendation for Initial and Maximum 
heap size values. For IBM specific recommendations, see the IBM FileNet P8 Platform 
Performance Tuning Guide. To download this guide from the IBM support page, see 
“Access IBM FileNet documentation, compatibility matrices, and fix packs” on page 20.

• For systems using JRockit JAVA.

Append the following to the MEM_ARGS variable:

–Xgc:gencon

b. If your application server uses the IBM JVM, edit the JAVA_OPTIONS variable (to improve 
performance).

UNIX

Immediately before the following line in startWebLogic.sh:

SAVE_JAVA_OPTIONS=$JAVA_OPTIONS

insert this line (without a carriage return):

JAVA_OPTIONS=”$JAVA_OPTIONS -Dprogram.name=$PROGNAME 
-Dfilenet.pe.peorb.pool.min=2 -Dfilenet.pe.peorb.pool.max=5”

Windows

Immediately before the following line in startWebLogic.cmd:

set SAVE_JAVA_OPTIONS=%JAVA_OPTIONS%

insert this line (no carriage return):

set JAVA_OPTIONS=%JAVA_OPTIONS% -Dprogram.name=%PROGNAME% 
-Dfilenet.pe.peorb.pool.min=2 -Dfilenet.pe.peorb.pool.max=5

c. Configure JAAS login. 

Add one of the following right after the classpath entry for WebLogic. 

CAUTION  Enter the jaas_login entry (bold below) as a single line without line breaks. Do 
not copy and paste the text from this guide because hidden formatting can cause problems 
with the entry. Instead, type the entry into the script. 

NOTE  Your path may be slightly different depending on the version of your client 
installations, or whether you have chosen a custom path for installation. Verify the location 
of the file before you enter the path.

Windows

@REM Jaas Login configuration setting
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set JAAS_LOGIN=%JAAS_LOGIN% -Djava.security.auth.login.config=
”AE_install_path\CE_API\config\jaas.conf.WebLogic”

UNIX

# Jaas Login configuration setting
JAAS_LOGIN=”${JAAS_LOGIN}” -Djava.security.auth.login.config=
”AE_install_path/CE_API/config/jaas.conf.WebLogic”

AIX

# Jaas Login configuration setting
JAAS_LOGIN=”${JAAS_LOGIN}” -Djava.security.auth.login.config=
”AE_install_path/CE_API/config/jaas.conf.WebLogic”
JAAS_LOGIN="${JAAS_LOGIN}” -
Dlogin.configuration.provider=com.ibm.security.auth.login.ConfigFile

d. Add %JAAS_LOGIN% section as indicated in the examples below in bold.

Windows - in the WLS_REDIRECT_LOG settings

If “%WLS_REDIRECT_LOG%”==””(
    echo Starting WLS with line:
    echo %JAVA_HOME%\bin\java %JAVA_VM% %MEM_ARGS% %JAVA_OPTIONS% %JAAS_LOGIN%  
-Dweblogic.Name=%SERVER_NAME% -
Djava.security.policy=%WL_HOME%\server\lib\weblogic.policy %PROXY_SETTINGS% 
%SERVER_CLASS%
    %JAVA_HOME%\bin\java %JAVA_VM% %MEM_ARGS% %JAVA_OPTIONS% %JAAS_LOGIN% -
Dweblogic.Name=%SERVER_NAME% -Dweblogic.management.username=%WLS_USER% -
Dweblogic.management.password=%WLS_PW% -
Djava.security.policy=%WL_HOME%\server\lib\weblogic.policy %PROXY_SETTINGS% 
%SERVER_CLASS%
) else (
echo Redirecting output from WLS window to %WLS_REDIRECT_LOG%
%JAVA_HOME%\bin\java %JAVA_VM% %MEM_ARGS% %JAVA_OPTIONS% %JAAS_LOGIN% -
Dweblogic.Name=%SERVER_NAME% -Dweblogic.management.username=%WLS_USER% -
Dweblogic.management.password=%WLS_PW% -
Djava.security.policy=%WL_HOME%\server\lib\weblogic.policy %PROXY_SETTINGS% 
%SERVER_CLASS% >”%WLS_REDIRECT_LOG%” 2>&1
)

UNIX - in the WLS_REDIRECT_LOG settings

${JAVA_HOME}/bin/java ${JAVA_VM} -version

if [ "${WLS_REDIRECT_LOG}" = "" ] ; then
        echo "Starting WLS with line:"
        echo "${JAVA_HOME}/bin/java ${JAVA_VM} ${MEM_ARGS} ${JAVA_OPTIONS} -
Dweblogic.Name=${SERVER_
NAME} -Djava.security.policy=${WL_HOME}/server/lib/weblogic.policy  
${PROXY_SETTINGS} ${SERVER_CLASS
}"
        ${JAVA_HOME}/bin/java ${JAVA_VM} ${MEM_ARGS} ${JAVA_OPTIONS} 
${JAAS_LOGIN} -Dweblogic.Name=${S
ERVER_NAME} -Djava.security.policy=${WL_HOME}/server/lib/weblogic.policy 
${PROXY_SETTINGS} ${SERVER_
CLASS}
else
        echo "Redirecting output from WLS window to ${WLS_REDIRECT_LOG}"
        ${JAVA_HOME}/bin/java ${JAVA_VM} ${MEM_ARGS} ${JAVA_OPTIONS} 
${JAAS_LOGIN} -Dweblogic.Name=${S
ERVER_NAME} -Djava.security.policy=${WL_HOME}/server/lib/weblogic.policy 
${PROXY_SETTINGS} ${SERVER_
CLASS}  >"${WLS_REDIRECT_LOG}" 2>&1
fi
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3. Save and close the server startup script.

To configure Application Engine (WebLogic)

1. (If you selected Container-Managed Authentication during the installation) Enable trust between 
WebLogic domains for the Content Engine domain and the Application Engine domain.

Do the following on both the Content Engine application server and the Application Engine 
application server.

a. In the WebLogic Administration Console, in the security settings, enter a password for the 
domain. You must enter the same password for both the Content Engine domain and 
Application Engine domain.

b. Save your changes.

c. Restart the server if needed.

d. Repeat this procedure in each domain for which you want to enable trust.

2. (If you selected Container-Managed Authentication during the installation) Configure LDAP 
settings on Application Engine to exactly match the Content Engine settings.

a. Refer to your Content Engine installation worksheet items and the WebLogic Administration 
Console settings for Compatibility Security > Realms for Authentication Provider, users, and 
groups on Content Engine.

Configure the LDAP provider to exactly match the settings from the Content Engine server.

• Group Base DN:

• User Name Attribute:

• Port:

• User Base DN:

• Principal:

• Credential:

• Confirm Credential:

• Host:

• User From Name Filter:

• Group From Name Filter:

b. Restart WebLogic. 

3. Set permissions for the user running the application server.

If the user that will be running the application server is different from the user that installed 
Application Engine, you must give the user read/write permissions on the folder where you 
installed AE (AE_install_path). 

4. Continue with “To enable passing user credentials to client applications (WebLogic)” on page 242.
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To enable passing user credentials to client applications (WebLogic)

Perform this procedure to enable passing user credentials between Application Engine and its 
client applications such as WebDAV and Application Integration. 

CAUTION  If you do not make this change to config.xml, then end users will be prompted to 
enter their user name and password to complete any client operations, such as adding a 
document.

1. Stop the WebLogic server.

2. Make a backup copy of config.xml located in deployment directory.

For example:

BEA_home/bea/user_projects/domains/domain_name/config/config.xml

3. Edit config.xml.

CAUTION  The enforce-valid-basic-auth-credentials entry should be entered as a single line 
without line breaks.  

a. Locate the <security-configuration> section and add the following line to the end of the 
section, just before the </security-configuration> tag:

<enforce-valid-basic-auth-credentials>false</enforce-valid-basic-auth-
credentials>

b. Save your changes to config.xml and close the file.

4. Restart WebLogic.

5. Deploy the Workplace application. See “Deploy Application Engine (WebLogic)” on page 249.
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Task 5c: Configure Application Engine (JBoss)
This topic covers the configuration of your Application Engine application (Workplace) on JBoss. 
Perform the following high-level steps in the order listed, using the referenced detailed procedures 
for each step. 

To modify the application server startup script

1. Stop JBoss if it is running.

2. Make a backup copy of the application server startup script.

UNIX

run.sh

Windows

run.bat

3. Edit the application server startup script Java settings. 

a. Add a line to specify the path to the JDK provided by JBoss, as shown in the following 
example (Windows):

set JAVA_HOME=C:\Program Files\Java\jdk1.5.0_06

NOTE  If your JDK is different from version 1.5.0, substitute your version for the one listed 
above. 

b. Update the JAVA_OPTS memory settings.

Adjusting this setting prevents the application server from running out of memory, a 
condition in which users would not be able to log in to Workplace.

In the JAVA_OPTS line, change the -Xms and -Xmx values (bold) for your configuration.

Example (Windows):

set JAVA_OPTS=%JAVA_OPTS% -Xms128m -Xmx512m 

Refer to your application server vendor's recommendation for Initial and Maximum heap 
size values. For IBM specific recommendations, see the IBM FileNet P8 Platform 
Performance Tuning Guide. To download this guide from the IBM support page, see 
“Access IBM FileNet documentation, compatibility matrices, and fix packs” on page 20.

c. If your application server uses the IBM JVM, edit the JAVA_OPTS variable in the startup 
script immediately after the line in the previous sub-step. This JAVA_OPTS edit improves 
performance.

UNIX

Find the following line in run.sh:

JAVA_OPTS=”$JAVA_OPTS -Dprogram.name=$PROGNAME”
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 5c: Configure Application Engine (JBoss)
To modify the application server startup script

244
and change it to this (without a carriage return):

JAVA_OPTS=”$JAVA_OPTS -Dprogram.name=$PROGNAME 
-Dfilenet.pe.peorb.pool.min=2 -Dfilenet.pe.peorb.pool.max=5”

Windows

Find the following line in run.bat:

set JAVA_OPTS=%JAVA_OPTS% -Dprogram.name=%PROGNAME%

and change it to this (without a carriage return):

set JAVA_OPTS=%JAVA_OPTS% -Dprogram.name=%PROGNAME% 
-Dfilenet.pe.peorb.pool.min=2 -Dfilenet.pe.peorb.pool.max=5

d. Save your edits.

4. Configure JAAS login. 

Add one of the following right after the "$JAVA" $JAVA_OPTS (UNIX) or “%JAVA%” 
%JAVA_OPTS (Windows) entry in the startup script. 

CAUTION  Enter the jaas_login entry (bold below) as a single line without line breaks. Do not 
copy and paste the text from this guide because hidden formatting can cause problems with 
the entry. Instead, type the entry into the script. 

NOTE  Your path may be slightly different depending on the version of your client installations, 
or whether you have chosen a custom path for installation. Verify the location of the file before 
you enter the path.

UNIX

"$JAVA" $JAVA_OPTS -Djava.security.auth.login.config=”/opt/FileNet/AE/CE_API/
config/jaas.conf.JBoss” "-Djava.endorsed.dirs=$JBOSS_ENDORSED_DIRS" -classpath 
"$JBOSS_CLASSPATH" org.jboss.Main $@ 

Windows

"%JAVA%" %JAVA_OPTS% "-Djava.security.auth.login.config=C:\Program 
Files\FileNet\AE\CE_API\config\jaas.conf.JBoss" "-
Djava.endorsed.dirs=%JBOSS_ENDORSED_DIRS%" -classpath "%JBOSS_CLASSPATH%" 
org.jboss.Main %*

5. Save and close the server startup script.

6. Configure LDAP settings on Application Engine to exactly match the Content Engine settings.

a. On the Application Engine server, open login-config.xml, located in JBoss_home/
server/server_name/conf, for editing.

b. Set the <application-policy name="FileNet"> entry identical to the corresponding entry in the 
login-config.xml file on the Content Engine server. 

c. Set the <application-policy name="FileNetP8Engine"> entry identical to the corresponding 
entry in the login-config.xml file on the Content Engine server.

d. Save changes to the login-config.xml file on the Application Engine server.

e. Restart JBoss.
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 5c: Configure Application Engine (JBoss)
To modify the application server startup script

245
7. Set permissions for the user running the application server.

NOTE  On Windows, the following is only required for NTFS formatted partitions 

If the user that will be running the application server is different from the user that installed 
Application Engine, you must give the user read/write permissions on the folder where you 
installed Application Engine (AE_install_path). 

8. (Optional) Disable JBoss logging. 

In development mode, JBoss creates a large number of HTTP Access, “INFO”, “DEBUG” and 
“TRACE” log messages. This can cause unexpected behavior in the deployed IBM FileNet 
software. Using the following procedure, you can limit this type of excessive JBoss logging.

NOTE When logging is disabled, error messages will still be displayed in the JBoss console.

a. Edit the log4j.xml file (JBOSS_home/server/server_name/conf/log4j.xml).

i. Change all threshold values and priority values from "INFO", "DEBUG", or "TRACE" to 
"ERROR".

ii. Delete or comment out the "Preserve messages in a local file" to turn off the server log.

b. To turn off HTTP access logging, open jboss-service.xml with a text editor and delete or 
comment out the "Access logger" section.

Location of jboss-service.xml:

JBoss_Home/server/server_name/deploy/jbossweb-tomcat55.sar/META-INF

c. Open web.xml and change the logVerbosityLevel to "FATAL".

Location of web.xml:

JBoss_Home/server/server_name/deploy/jbossweb-tomcat55.sar/conf 

d.  Restart the JBoss server.

9. Deploy the Workplace application. See “Deploy Application Engine (JBoss)” on page 251.
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Task 6a: Deploy Application Engine (WebSphere)
This topic covers the deployment and start of your Application Engine application (Workplace) on 
WebSphere.

To recreate the WAR or EAR file

Any time that you make changes to files in the /Workplace directory, such as changes to 
web.xml for container-managed authentication, SSO support, or any other edits, you must 
recreate the WAR or EAR file and redeploy your changes. 

NOTE  Before recreating the EAR file, you must also recreate the WAR file. 

• If you will be deploying from a WAR or an EAR file.

a. Verify that all modified /Workplace directory files have been saved.

b. Recreate the app_engine.war file by running create_app_engine_war.sh (UNIX) or 
create_app_engine_war.bat (Windows) from the following location:

AE_install_path/deploy/

• If you will be deploying from an EAR file.

a. Verify that a newly recreated app_engine.war file exists. 

b. Recreate the app_engine.ear file by running create_app_engine_ear.sh (UNIX) or 
create_app_engine_ear.bat (Windows) from the following location:

AE_install_path/deploy/

To deploy Application Engine

1. Log on to the WebSphere administrative console.

2. Navigate to the dialog for installing a new application.

WebSphere 6.1

Expand Applications > Install New Application.

WebSphere 7.0

Expand Applications > New Application > New Enterprise Application.

3. Select the file to deploy.

• (If the administrative console is running locally) Select Local Path and enter or browse to the 
location of the app_engine.war or app_engine.ear file created by the installation program 
(see below for the default path). Do not enter the machine name.

• (If the administrative console is remote) Select Server path and enter the fully-qualified pathname 
to the app_engine.war  or app_engine.ear file. Do not enter the machine name.

AE_install_path/deploy
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4. (WebSphere 6.1) If you are deploying a WAR file, enter the context root. 

Enter Workplace and click Next to proceed to deploying a new application.

NOTE The context root is the name of the application you log in to using the web interface, 
such as: 

http://ApplicationEngineServerName:port#/Context_Root.

5. Complete the dialogs for installing a new application, using the following settings:

Application name: Workplace, or the name you chose to call the application.

WebServer: The server you are planning to use. Verify that your application name is selected 
and associated with the correct WebServer.

virtual host: Choose the default_host.

(WebSphere 7.0) context root: Workplace

6. Save your configuration.

7. Configure the Classloader settings and change the polling interval to a number appropriate for 
your environment.

Change Classloader order to have the classes loaded with parent classloader last.

NOTE  Do this only for the specific web application. Do not change the similar settings for the 
entire application server.

8. In the Manage Modules area, configure the Web Module Classloader setting.

Change Classloader order to have the classes loaded with parent classloader last.

NOTE  Do this only for the specific web application. Do not change the similar settings for the 
entire application server.

9. (WebSphere 6.1) If you are using container-managed authentication, navigate to Enterprise 
Applications > Workplace > Map security roles to users/groups, and verify that the All 
Authenticated column is checked for the “All Authenticated” role.

10. (WebSphere 7.0) If you are using container-managed authentication, navigate to Enterprise 
Applications > Workplace > Security roles to user/group mapping. Select the “All authenticated” 
role and map it to “All Authenticated in Applications realm”.

11. Set permissions for the user running the application server. 

The user that will be running the application server must have read/write permissions on the 
following (default) folders:

WAS_HOME/profiles/default/installedApps/node_name/app_engine_war.ear/
app_engine.war

AE_install_path

12. Save all your changes.
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13. Stop and restart WebSphere.

NOTE To troubleshoot the deployment, check the following log: 

WAS_install_path/AppServer/profiles/profile_name/logs/server_name/
SystemOut.log  

14. Start Workplace (or whatever you named your application) from the administrative console.
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Task 6b: Deploy Application Engine (WebLogic)
This topic covers the deployment of your Application Engine application (Workplace) on 
WebLogic.

To recreate the WAR or EAR file

Any time that you make changes to files in the /Workplace directory, such as changes to 
web.xml for container-managed authentication, SSO support, or any other edits, you must 
recreate the WAR or EAR file and redeploy your changes. 

NOTE  Before recreating the EAR file, you must also recreate the WAR file. 

• If you will be deploying from a WAR file.

a. Verify that all modified /Workplace directory files have been saved.

b. Recreate the app_engine.war file by running create_app_engine_war.sh (UNIX) or 
create_app_engine_war.bat (Windows) from the following location:

AE_install_path/deploy/

• If you will be deploying from an EAR file.

a. Verify that a newly recreated app_engine.war file exists. 

b. Recreate the app_engine.ear file by running create_app_engine_ear.sh (UNIX) or 
create_app_engine_ear.bat (Windows) from the following location:

AE_install_path/deploy/

To deploy  as “Workplace” or custom name using a WAR file

Perform this step only if you are using a WAR file for deployment, and you want to use 
“Workplace” or a custom name for the context root of the application. The context root is part of 
the URI that end users enter to access Workplace. By default, when you deploy from a WAR file, 
the context root is the first part of the WAR filename. 

Rename the app_engine.war file to reflect the name you want to use using the format 
Application Name.war.

Example:

The default app_engine.war will generate the following context root:

http://server_name:port#/app_engine

Renaming the WAR file Workplace.war will generate the following context root:

http://server_name:port#/Workplace

CAUTION  You must rename the WAR file every time you regenerate it. The 
create_app_engine_war.sh/.bat script will by default create a file with the name 
app_engine.war.
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To deploy Application Engine

1. From the WebLogic Administration Console, navigate to the domain you initially created for the 
Application Engine.

2. Prepare the WebLogic Administration Console to deploy the application.

3. Choose whether to deploy from an exploded folder (AE_install_path) or from the WAR or 
EAR file (default: app_engine.war or app_engine.ear in AE_install_path/deploy).

4. Accept the defaults for the deployment, except for the name for the deployment. Use 
“Workplace” instead of “appengine”.

5. Finish the deployment, and save and activate your changes.

NOTE  To verify that the deployment was successful, expand Web Applications. The web 
application Workplace will be listed.

NOTE To troubleshoot the deployment, check the following log: 

WLS_install_path/user_projects/domains/domain_name/servers/server_name/
logs/server_name.log  

6. After deployment is complete, start Workplace (or your custom application name) in the 
WebLogic Administration Console.
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Task 6c: Deploy Application Engine (JBoss)
This topic covers the deployment and start of your Application Engine application (Workplace) on 
JBoss.

To recreate the WAR or EAR file

Any time that you make changes to files in the /Workplace directory, such as changes to 
web.xml, you must recreate the WAR or EAR file and redeploy your changes. 

NOTE  Before recreating the EAR file, you must also recreate the WAR file. 

• If you will be deploying from a WAR file.

a. Verify that all modified /Workplace directory files have been saved.

b. Recreate the app_engine.war file by running create_app_engine_war.sh (UNIX) or 
create_app_engine_war.bat (Windows) from the following location:

AE_install_path/deploy/

• If you will be deploying from an EAR file.

a. Verify that a newly recreated app_engine.war file exists. 

b. Recreate the app_engine.ear file by running create_app_engine_ear.sh (UNIX) or 
create_app_engine_ear.bat (Windows) from the following location:

AE_install_path/deploy/

To deploy  as “Workplace” or custom name using a WAR file

Perform this step only if you are using a WAR file for deployment, and you want to use 
“Workplace” or a custom name for the context root of the application. The context root is part of 
the URI that end users type to access Workplace. By default, when you deploy from a WAR file, 
the context root is the first part of the WAR filename. 

Rename the app_engine.war file to reflect the name you want to use using the format 
Application Name.war.

Example:

The default app_engine.war will generate the following context root:

http://server_name:port#/app_engine

Renaming the WAR file Workplace.war will generate the following context root:

http://server_name:port#/Workplace

CAUTION  You must rename the WAR file every time you regenerate it. The 
create_app_engine_war.sh/.bat script will by default create a file with the name 
app_engine.war.
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To deploy and start Application Engine

1. Stop JBoss, if it is running.

2. Deploy the Workplace application:

To deploy from exploded directory

a. On the JBoss server, copy the /Workplace folder from: 

AE_install_path

to:

JBOSS_home/server/servername/deploy/

b. Append the extension .war to the Workplace folder:

JBOSS_home/server/servername/deploy/Workplace.war

To deploy from a WAR file

On the JBoss server, copy the app_engine.war file from:

AE_install_path/deploy

to:

JBOSS_home/server/servername/deploy/

To deploy from an EAR file

On the JBoss server, copy the app_engine.ear file from: 

AE_install_path/deploy

to:

JBOSS_home/server/servername/deploy/

3. Set permissions for the user running the application server.

If the user that will be running the application server is different from the user that installed 
Application Engine, you must give the user read/write permissions on the following folders:

NOTE  For Windows this is only required for NTFS formatted partitions:

JBOSS_home/server/default/deploy/app_engine.war/.ear

AE_install_path

4. Start the JBoss application server.

5. Verify that the application deployed successfully.

Verify that the server.log file located in JBOSS_home/server/servername/log lists 
deployment of the WAR or EAR file you used.
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Configuration and startup tasks
To configure the IBM FileNet P8 Platform components

NOTE You can perform the following configuration and startup tasks listed below in any order.

• “Set Application Engine bootstrap preferences” on page 254.

• “Create a Process Engine isolated region” on page 259.

• “Create a Process Engine Connection Point” on page 260.

• “Configure the Process Engine connection point for Application Engine” on page 261.

• “Set up Content Engine and client transport SSL security” on page 263.

• “Set up Application Engine SSL security” on page 266.

• “Perform additional configuration tasks” on page 270.

• Familiarize yourself with IBM FileNet P8 system startup and shutdown procedures. See the 
IBM FileNet P8 help topic FileNet P8 Administration > Enterprise-wide Administration > Shutdown 
and Startup. 
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Set Application Engine bootstrap preferences
Bootstrap preferences are a category of site preferences. The first time you sign into Workplace 
after Application Engine installation, the Bootstrap Preferences page opens. 

Bootstrap Preferences
The following six bootstrap preference groups are available the first time you sign in:

• Security Info (required for SSL only)

• User Token Settings

• Preference Settings (required)

• Banner Image

• Application Integration

• Administrator Access Role

For more information, see the IBM FileNet P8 help topic User Help > Actions, preferences, and tools > 
Site Preferences >  Bootstrap preferences.

Enhanced Timezone Detection
In addition to these settings you can also set the useEnhancedTimeZoneDetection parameter to 
accurately detect a client browser's time zone. This setting cannot be modified through the Site 
Preferences page. To enable this feature you must manually modify the bootstrap.properties 
file. For more information, see the IBM FileNet P8 help topic FileNet P8 Administration > Application 
Engine Administration > Key configuration files and logs > bootstrap.properties.

NOTES 

• By successfully signing in to Workplace and saving the bootstrap preferences, you are 
verifying the Application Engine’s basic functionality such as user authentication as well as 
communication and storing of data in Content Engine. 

• In addition to the preferences covered in this topic, more preferences can be set for the 
Workplace application using Workplace Site Preferences. For more information, see the the 
IBM FileNet P8 help topic User Help > Actions, preferences, and tools > Site preferences.

• After the initial bootstrap configuration, users with the Application Engine Administrators role 
can change any of these preferences by signing into Workplace and navigating to Admin > 
Site Preferences > Bootstrap. 

• When you access the bootstrap preference page via the Site Preferences application, an 
additional preference, Guest info (to allow guest sign ins), is also available.

• In a web farm/clustered environment, all Application Engines share site preferences by using 
the same bootstrap.properties file. For more information, see the IBM FileNet P8 Platform 
High Availability Technical Notice. To download this guide from the IBM support page, see 
“Access IBM FileNet documentation, compatibility matrices, and fix packs” on page 20.
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• Bootstrap properties are stored in a separate file from other site preference. The default 
location for this file, bootstrap.properties, is:

AE_install_path/FileNet/Config/AE

• (New installations only) To allow users to create workflows subscriptions, you must configure 
the PWDesigner access role. For more information, see “(New installations only) To enable user 
access to the Workflow Subscription Wizard” on page 258.

To set the bootstrap properties on first login

 For information on parameter values, see the Installation and upgrade worksheet, described in 
“Installation and upgrade worksheet” on page 229 in Plan and Prepare Your Environment for IBM 
FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping     
worksheet file (p8_worksheet.xls), perform the following actions to quickly see only the     
installation properties you must specify for the Application Engine installation program:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select AE bootstrap preferences.

• Click the AutoFilter drop-down arrow in all other column headers and select (All).

1. Sign in to Workplace: 

a. On any computer, open a browser and type:

http://ApplicationEngineServerName:port#/Workplace

NOTE  ApplicationEngineServerName cannot be ‘localhost’ or an IP address.

b. Enter a user name and password, and then click Sign in. The Bootstrap Preferences page 
opens. 

NOTE The user who initially logs in and sets the bootstrap preferences is automatically 
added to the Application Engine Administrators role. For more information, see the IBM 
FileNet P8 help topic User Help > Actions, preferences, and tools > Site preferences >  Access 
Roles preferences. 

2. Enter security info (required for SSL only).

a. Enter the SSL Host and Port information for the SSL server.

b. Enter the Java Server HTTP port.

Use the Security info preference to redirect sign-ins through a Secure Socket Layer (SSL) 
server and to identify a remote Java server. This encrypts the user IDs and passwords when 
they travel over the network. See “Set up Application Engine SSL security” on page 266 for 
instructions on setting up SSL security for one or more Application Engines.

CAUTION  Once you’ve configured SSL, the Site Preferences application also runs under SSL 
to protect the guest account’s user ID and password. This means that when you run Site 
Preferences on an unsecured server that redirects sign-ins to an SSL server, you will be 
editing the Bootstrap preferences of the SSL server (stored in the bootstrap.properties file). 
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This does not affect the General, Object Store, and Shortcut preferences, which are retrieved 
from the preferences file saved in the object store. 

3. Configure user token settings.

User Tokens are used by IBM FileNet P8 applications to launch into each other without the 
need for an additional login. 

a. Select whether or not to create user tokens for your Application Engine (Default: Yes).

b. Select whether or not the application will pick up generated tokens from other applications 
(Default: Yes).

c. Specify a Token timeout interval (1 - 15 minutes).

4. (Required) Specify preference settings.

Preference settings specify the name of the site preference file, its storage location (object 
store), and the documentation server URL(if installed). The site preferences file is checked 
into the object store the first time you log on to Workplace. The site preferences are stored as 
XML data in this file, <Site Preferences for Preferences name>.xml. Use Enterprise 
Manager to access this file, and navigate to Object Stores > Object Store location > 
Root Folder > Preferences.   

NOTE The bootstrap preferences are saved in the bootstrap.properties file, and not in the 
site preferences file.

a. Select an object store from the Object store location choice list. The preferences file will be 
saved in this object store. Workplace users must have access to this object store.

b. Enter a preference file name in the Preferences name field.  

c.  Enter the documentation server URL in the Documentation server field. 

The format of the URL is:

http://DocServerName:port#/ecm_help/

where DocServerName is the name of your Java application server where the 
documentation is installed, 
port# is the port number, 
and ecm_help is the root directory of the documentation web site.

NOTE If no documentation URL is specified, the Workplace Help link will default to 
http://localhost. 

d. Enter the ISRA Interface Servlet URL.

For more information, see “Enable Application Engine to use ISRA” on page 298. 

5. Set Banner Image.

The banner image is the graphic that appears at the upper left -hand side of the Workplace 
application pages. If you have a banner image that you would like to use in place of the 
default, follow this procedure.

a. Copy the new graphic file to the location of your choice on Application Engine in the
 /FileNet/AE/Workplace folder.
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b. In the Path field, type the path (relative to the /Workplace folder) to the new banner graphic 
file.

c. In the Image Width field, type the width of the image (in pixels). 

d. In the Image Height field, type the height of the image (in pixels).

6. Configure Application Integration.

Select No (default), if you do not want users to be prompted to add an email to an object store 
each time the email is sent.

Select Yes, if you want users prompted to add an email to an object store when the email is 
sent.

This preference setting only affects Outlook integration.

7. Add Application Engine Administrators.

Add the users and groups that will perform Application Engine administration tasks to the 
Application Engine Administrators role. 

NOTES 

• The user who initially signs in and sets the bootstrap preferences is automatically added to the 
Application Engine Administrators role. For more information, see the IBM FileNet P8 help topic  
User Help > Actions, preferences, and tools > Site preferences >  Access Roles preferences.

• To modify the access roles after the initial bootstrap configuration, users with the Application 
Engine Administrators role can use the access roles section of the Workplace Site Preferences. 
Launch Workplace and navigate to Admin > Site Preferences > Access Roles. 

8. Click Apply to save your bootstrap settings.

To verify that a single index has been added for Application Name on the site preferences object 
store

To properly index access roles and improve login performance on Application Engine, an index is 
created for Application Name on the object store that contains the Workplace site preferences. 
Verify this index setting after you have successfully configured the bootstrap preferences.

1. On Content Engine, launch the Enterprise Manager.

2. In the left pane, expand the Object Stores folder.

3. Expand the object store node where your preferences are stored. See “(Required) Specify 
preference settings.” on page 256 above.

4. Expand Other Classes and then Custom Object.

5. Right click Access Role and select Properties.

6. Select the Property Definitions tab.

7. Select Application Name and click Edit.

8. On the General tab of the Application Name Properties, verify that the Indexed field shows 
Single Indexed.  
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– If the Indexed field shows Single Indexed., continue at Step 13.

– If the Indexed field shows 'not indexed', continue at Step 9.

9. Click Set/Remove.

10. Select Set and then Single Indexed.

11. Click OK to set the index.  

12. Click OK to apply the change and close the Application Name Properties window.  

13. Click OK to close the Access Role Class Properties window.

(New installations only) To enable user access to the Workflow Subscription Wizard

To allow users to create workflows subscriptions, you must configure the PWDesigner access role 
using the Workplace Site Preferences, and give the users appropriate access rights to the 
workflow subscriptions classes. You can perform these steps in any order, and you must perform 
both steps any time you need to add or remove users.

1. Assign users as members of the PWDesigner access role. See the IBM FileNet P8 help topic 
User Help > Actions, preferences, and tools > Site preferences >  Access Roles preferences.

2. Run the security script wizard,and load the workplacescript.xml file to add accounts to the 
Workflow Designer role. 

For more information about how to use the Security Script wizard to assign the Workflow 
Designer role to user or group accounts, see the IBM FileNet P8 help topic FileNet P8 
Administration > Content Engine Administration > Content Engine Wizard Help > Security Script.

For more information about the workplacescript.xml file and how roles are defined in the 
Enterprise Manager, see the IBM FileNet P8 help topic FileNet P8 Administration > Content 
Engine Administration > Managing Security > Security Script Wizard.
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Create a Process Engine isolated region
Process Engine communicates to its database using a connection point.  Each connection point is 
associated with an isolated region.  In this task you will create an isolated region. In “Create a 
Process Engine Connection Point” on page 260 you will define a connection point to this isolated 
region.

To create a Process Engine isolated region

1. Start Enterprise Manager by double-clicking the FileNet Enterprise Manager SnapIn on the 
desktop, or by navigating to Start > All Programs > FileNet P8 Platform > Enterprise Manager 
SnapIn. Log on as a GCD administrator.

2. Connect to the FileNet P8 domain you created in “Establish the FileNet P8 domain and Global 
Configuration Data (GCD)” on page 109.

3. Right-click PE Region ids > New PE Region ids.

4. Click Next on the Specify a Site screen to select a site named initial site.

5. Enter the DNS name for the Process Engine server. 

6. Enter the region ID.

7. Modify the communication port if needed. This communication port must match that entered in 
the Process Task Manager for the communication port in “Configure Process Task Manager” on 
page 201.

8. Click Next when done.

9. Enter the password for the isolated region.  This password must match that entered in the 
Process Task Manager for the isolated region in “Configure Process Task Manager” on page 201.

10. Click OK on the Confirmation Window.

11. Click Finish to finish create a new region for Process Engine.
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Create a Process Engine Connection Point
A connection point identifies a specific isolated region of the workflow database, and gives it a 
name that workflow-related applications use to access the region.  Follow these procedures to 
create a connection point.

To create a Process Engine connection point

1. Start Enterprise Manager by double-clicking the FileNet Enterprise Manager SnapIn on the 
desktop, or by navigating to Start > All Programs > FileNet P8 Platform > Enterprise Manager 
SnapIn. Log on as a GCD administrator.

2. Connect to the FileNet P8 domain you created in “Establish the FileNet P8 domain and Global 
Configuration Data (GCD)” on page 109.

3. Right-click PE Connection Points > New PE Connection Points.

4. Enter a Process Engine Connection Point name and click Next.

NOTE Process Engine Connection Point names must not contain whitespace characters.

5. Choose the region which is created in “Create a Process Engine isolated region” on page 259, and 
click Next.

6. Click Finish to finish creating the Connection Point.

7. Click OK.
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Configure the Process Engine connection point for 
Application Engine
Before users can access tasks and work items from Workplace, you must configure the 
connection point on the Application Engine. Make sure that you have already completed these 
Tasks:

• “Create a Process Engine isolated region” on page 259

• “Create a Process Engine Connection Point” on page 260

To configure the connection point

1. Sign in to Workplace as an Application Engine Administrator: 

a. On any computer, open a browser and navigate to:

http://ApplicationEngineServerName:port#/Workplace

b. Sign in using the same account that you used to set the bootstrap preferences. 

2. Click Admin.

3. Click Site Preferences.

4. Under General Settings > Tasks, select a Process Engine Connection Point from the drop-down 
list.

5. Click Apply.

6. Click Exit.

CAUTION  Performing Step 7 in an existing environment will destroy all data in the existing 
region.

7. (For new installations only) Initialize the isolated region.

a. Click Admin.

b. Click Process Configuration Console.

NOTE If your computer does not have the appropriate Java Runtime Environment (JRE) 
installed, you will be prompted to download the JRE at this point; follow the prompts to 
complete the download. During the installation process, click the Browser tab and enter 
the following settings: 

• Clear the Internet Explorer option.

• If you will be using Netscape 6.0, select the Netscape option. 

c. Right-click the icon or name of the isolated region you want to initialize, and select Connect 
from the context menu. 

d. Click Action.
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e. Click Initialize Isolated Region. 

f. Click Yes at the prompt asking if you want to continue. 

g. Close the Process Configuration Console.

8. In Workplace, click Tasks to confirm that Application Engine is communicating with Process 
Engine. 

9. Sign out of Workplace. 
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Set up Content Engine and client transport SSL 
security
Configuring SSL enables secure communications between the Content Engine and the directory 
service, as well as between Content Engine clients and the Content Engine server. In addition, 
setting up Content Engine SSL provides secure authentication for Process Engine.

CAUTION  IBM strongly recommends enabling SSL for the Content Engine and Process Engine 
web services. Authentication over these two web services is usually performed by providing 
username and password credentials. If these web services are not configured to run over an SSL 
connection, clear text passwords will be sent across the network. (However, this is not true when 
Kerberos-based authentication is used. In the P8 4.5 release, Kerberos authentication is available 
only for the Content Engine web service.) The option not to use SSL over these two web services 
is provided primarily for development systems or other non-production systems where the security 
provided by SSL may not be required.

For access to the Content Engine through the EJB transport (IIOP or T3 protocol), an SSL 
connection is necessary to provide privacy for data sent across the network, but user passwords 
would not be compromised if SSL were not used. While it is preferable to use SSL with the EJB 
transport (IIOP or T3 protocol), it is not a requirement.

NOTES:

• The Content Engine web service is used:

– By all clients of the Content Engine 4.5 .NET API

– By all clients of the Content Engine 4.5 COM Compatibility API (CCL)

– By the Enterprise Manager tool

– By the Content Engine 3.5.2 to 4.5.0 Upgrade tool

– By the Process Engine, when making calls to the Content Engine to retrieve user and 
group information

– By the Component Manager, running on the Application Engine, which is an integral 
component for BPM Process Orchestration framework

– By customer and 3rd party tools written against the CE 3.5 web service API, including 
Altien Document Manager and the Sharepoint integration done by Vorsite.

• Certain Java applications (written against the Content Engine 3.5.x Java API or the Content 
Engine 4.5 Java API) may use the Content Engine web service transport, but typically they 
would use EJB transport (IIOP or T3 protocol).

• The IBM FileNet Application Engine server will use only the EJB transport to communicate 
with the Content Engine in the P8 4.5 release. 

• The Process Engine web service is used by customer and third-party applications to write 
runtime applications (typically step processor applications) against the Process Engine.  The 
Process Engine Java API does not make use of the Process Engine web service.
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To enable SSL for Content Engine

NOTE In the steps below, a server certificate certificate will be added to the Directory Services 
server (for authentication).  In addition, the CA certificate will be added in two different locations 
on the Content Engine server (the JDK path location is for authorization).  Follow the steps closely 
to ensure that the proper certificate is added to each of the three locations.

1. Obtain and install a server certificate and a CA certificate on the directory service. These 
certificates are available from third-party certificate authorities, such as VeriSign, or you can 
generate your own certificates if you have the necessary certificate management software 
installed. 

2. Enable SSL on the directory service and set the SSL port number. The default SSL port number 
is 636; however, if you have more than one directory service that is using SSL on the server, you 
may need to use a non-default port number. See your directory server documentation for 
instructions.

3. On the Content Engine server, add the CA certificate to the application server keystore, if it does 
not already contain it.

4. On the Content Engine server, add the CA certificate to the JDK (Java) keystore, if it does not 
already contain it. You can use the default key store, in Step a, or create a custom location, in 
Step b.

a. To use the JDK default java key store, do the following:

i. Determine the java version your application server uses and the JAVA_HOME location.

ii.  Use the keytool to import the CA certificate to the Java keystore at 
%JAVA_HOME%\jre\lib\security\cacerts.

iii. To improve security, change the default password.

b. To use your own key store (rather than the JDK default key store), do the following:

i. Add the following system parameters to the Java command line in your application 
server’s startup script:

-Djavax.net.ssl.trustStore=path_to_your_keystore_file
-Djavax.net.ssl.trustStorePassword=password_of_your_keystore

ii.  Use the Java keytool to import the CA certificate to your own keystore.

5. Use Enterprise Manager to enable SSL for Content Engine and set the port number to match the 
SSL port on the directory server, as described in “To enable SSL between Enterprise Manager and 
the directory service” on page 265.

6. Obtain another server and CA certificate for the Content Engine.

7. Create a custom identity keystore on the Content Engine server, and add the server certificate 
to the custom keystore.
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8. Using the application server administration tool, enable SSL and point to the custom identity 
keystore. Directions vary by application server type; see your application server documentation 
for detailed procedures.

NOTE  (WebLogic only) The name in your certificate must match the host name specified in 
your WebLogic application server. If the name in the certificate is fully qualified (for example, 
Host1.filenet.com), the same fully qualified host name must appear in the Host field 
(WebLogic > Authentication Provider > Active Directory tab > Host field).

9. Configure clients to use a particular URL for connecting to Content Engine based on the 
application server type and the client transport (protocol) type. The following table provides 
details:

NOTE The port values in the table above are default values. If you change the port that your 
application server listens on, you must also change the port number used by the Content 
Engine client.

To enable SSL between Enterprise Manager and the directory service

1. Launch Enterprise Manager and log on as a GCD administrator.

2. In the tree view, right-click the root node and choose Properties.

3. In the Enterprise Manager Properties dialog box, click the Directory Config. tab, select a 
directory service, and click Modify.

4. In the General tab of the Modify Directory Configuration dialog box, set the Is SSL Enabled 
parameter to True and modify the port number appropriately.

5. Click OK in each open dialog box.

Protocol SSL Port App Server Sample URL

HTTP no 7001 WebLogic http://mycorp.com:7001/wsi/FNCEWS40DIME/

HTTPS yes 7002 WebLogic https://mycorp.com:7002/wsi/FNCEWS40DIME/

T3 (IIOP) no 7001 WebLogic t3://mycorp.com:7001/FileNet/Engine

T3S (IIOP) yes 7002 WebLogic t3s://mycorp.com:7002/FileNet/Engine

HTTP no 9080 WebSphere http://mycorp.com:9080/wsi/FNCEWS40DIME/

HTTPS yes 9403 WebSphere https://mycorp.com:9403/wsi/FNCEWS40DIME/

IIOP no 2809 WebSphere iiop://mycorp.com:2809/FileNetEngine

IIOP yes 9443 WebSphere iiop://mycorp.com:9443/FileNetEngine
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Set up Application Engine SSL security
This topic describes how to configure an Application Engine to direct sign-ins through a Secure 
Socket Layer (SSL) https connection. It assumes that Application Engine(s) have already been 
installed.

IBM FileNet Application Engine supports the following methods of configuring an SSL 
environment:

• Full SSL support - A single Application Engine server, where all of the software is running 
under SSL.

• One server SSL redirect - One Application Engine server set up to redirect logon attempts on 
the non-SSL port to the SSL port.

• Two server SSL redirect - Two Application Engine servers, where one is SSL-enabled, and the 
other redirects users to the SSL-enabled Application Engine server to log on.

To set up full SSL support on a single Application Server

1. Enable SSL on the application server that runs Application Engine (see your SSL 
documentation).

2. Test the SSL connection by signing into Workplace using one of the following URLs:

https://Application_Engine_server_name:SSL port/Workplace

The entire sign-in process will be handled by the SSL-enabled host.

For more information about SSL port numbers, see “IBM FileNet P8 Port Numbers” in the Plan 
and Prepare Your Environment for IBM FileNet P8 Platform guide.

To set up SSL redirect on a single Application Engine server

1. Enable SSL on the application server that runs Application Engine (see your SSL 
documentation).

2. Sign in to Workplace: 

a. On any computer, open a browser and type the following URL address:

http://Application_Engine_server_name:port#/Workplace

b. Sign in as a user with Application Engine Administrator access role privileges. For more 
information, see the IBM FileNet P8 help topic  User Help > Actions, preferences, and tools > 
Site preferences >  Access Roles preferences.

3. Set bootstrap preferences:

a. Navigate to Admin Site Preferences > Bootstrap.

b. Set the Security info Site Preference SSL Host:Port to identify the alias host name and port 
number.

Use the IP address of the Application Engine server for the SSL Host entry.

For more information, see “Enter security info (required for SSL only).” on page 255.
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c. Click Apply to save your bootstrap settings.

4. Update the base URL:

a. Navigate to Admin > Site Preferences > Refresh.

b. Enter the Workplace Base URL value in the provided field. The URL must contain a valid host 
name, and not contain “localhost" or an IP number. For example, http://myserver:7001/Workplace

For more information, see the IBM FileNet P8 help topic  User Help > Actions, preferences, and 
tools > Site preferences > Refresh preferences.

c. Click Refresh to update the base URL.

d. Click Exit to close Site Preferences.

5. Sign out of Workplace, and close your browser.

6. Test the SSL connection by signing into Workplace using the following URL:

http://Application_Engine_server_name:non-SSL port/Workplace

NOTE  You will be redirected to the SSL-enabled port for sign in, then back to the non-SSL 
enabled port after sign-in is complete. Before sign-in, you should receive a warning that you 
are accessing pages over a secure connection (unless you turned this dialog box off), and 
then Workplace will open.

To set up SSL redirect on two Application Engine servers

1. Install Application Engine on both computers so that both Application Engines use the same 
bootstrap.properties file and site preferences file (the Setup program will prompt you for a 
shared location).

During setup of the first Application Engine, create a share on the folder where the 
bootstrap.properties file is installed (the \WEB-INF folder). Then during setup of the 
second Application Engine, specify the shared location from the first installation. The 
bootstrap.properties file must already exist when specifying a shared location. See 
“Setup WebLogic clusters” or “Setup WebSphere clones” in the IBM FileNet P8 Platform High 
Availability Technical Notice for specific instructions. To download this guide from the IBM 
support page, see “Access IBM FileNet documentation, compatibility matrices, and fix packs” on 
page 20.

CAUTION  The system clocks on the two Application Engine servers must be synchronized to 
within the Token time-out interval. For more information, see the IBM FileNet P8 help topic 
User Help > Actions, preferences, and tools > Site preferences > Bootstrap Preferences > User token 
settings. 

2. Copy the UTCryptokeyFile.properties file.

For SSL redirect to work, each Application Engine must use the same User Token 
cryptographic key file. 
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After installing the second Application Engine, copy the UTCryptoKeyFile.properties file 
from the first Application Engine server to the same location on the second Application Engine 
server. 

NOTE  IBM recommends copying the file over a secure link.

3. Enable SSL on the application server that you are using for the SSL-enabled Application Engine 
(see your SSL documentation).

4. Sign in to Workplace on the non-SSL enabled Application Engine.

a. On any computer, open a browser and type:

http://ApplicationEngineServerName:port#/Workplace

b. Sign in as a user with Application Engine Administrator access role privileges. For more 
information, see the IBM FileNet P8 help topic  User Help > Actions, preferences, and tools > 
Site preferences >  Access Roles preferences.

5. Set bootstrap preferences:

a. Navigate to Admin > Site Preferences > Bootstrap.

b. Set the Security info Site Preference SSL Host:Port to identify the alias host name and port 
number.

For more information, see “Enter security info (required for SSL only).” on page 255.

c. Click Apply to save your bootstrap settings.

6. Update the base URL:

a. Navigate to Admin > Site Preferences > Refresh.

b. Enter the Workplace Base URL value in the provided field. The URL must contain a valid host 
name, and not contain localhost or an IP number. For example, http://myserver:7001/Workplace

For more information, see the IBM FileNet P8 help topic  User Help > Actions, preferences, and 
tools > Site preferences > Refresh preferences.

c. Click Refresh to update the base URL.

d. Click Exit to close Site Preferences.

7. Sign out of Workplace, and close your browser.

8. Test the SSL connection by signing into Workplace using the following URL:

http://Application_Engine_server_name:non-SSL port#/Workplace

NOTE  You will be redirected to the SSL-enabled server for sign in, then back to the non-SSL 
enabled server after sign-in is complete. Before sign-in, you should receive a warning that you 
are accessing pages over a secure connection (unless you turned this dialog box off), and 
then Workplace will open.
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Using Java Applets in an SSL Environment
If you are using a Java applet in an SSL environment, you may experience an 
SSLHandshakeException because the appropriate certificate does not exist on your computer. 
Follow the instructions in the the IBM FileNet P8 help topic User Help > Using Workplace > Basics > 
Use Java applets to resolve this issue.
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Perform additional configuration tasks
Once you have completed the Installation Tasks, your core IBM FileNet P8 system will be up and 
running. Below is a list of additional configuration tasks you should complete (or at least review) to 
prepare the system for general use. Except where noted, the links go to the IBM FileNet P8 Help, 
and start from the Contents panel in:

<Documentation URL, in the form http://webserver:port#/ecm_help>/_start_here.htm 

• Configure Content Federation Services for Image Services Guidelines. Refer to the IBM 
FileNet P8 Content Federation Services for Image Services Guidelines. To download this 
guide from the IBM support page, see “Access IBM FileNet documentation, compatibility matrices, 
and fix packs” on page 20.

• Configure Application Engine to set the file types you want to open in a browser window rather 
than using the Image Viewer. Refer to FileNet P8 Administration > Application Engine 
Administration > Key configuration files and logs > content_redir.properties file.

• Set site preferences for the Workplace application. Refer to User Help > Actions, preferences, 
and tools > Site preferences.

• Design searches and/or search templates for Workplace users. Refer to User Help > Actions, 
preferences, and tools > Tools > Search Designer > About Search Designer.

• Design publishing templates for Workplace users. Refer to User Help > Actions, preferences, and 
tools > Tools > Publishing Designer > About Publishing Designer.

• Configure security for publishing. Refer to User Help > Actions, preferences, and tools > Tools > 
Publishing Designer > Security > Specify publication document security.

• Configure automatic workflow launch. Refer to FileNet P8 Administration > Content Engine 
Administration > Events and subscriptions > Concepts: workflow subscriptions.

• Create and configure the object stores that will contain business objects, folders, documents, 
workflow definitions, searches, and other objects. Refer to FileNet P8 Administration > Content 
Engine Administration > Object stores > How to... > Create object store.

• Define document classes and folders and set security for each class. Refer to FileNet P8 
Administration > Content Engine Administration > Classes > Concepts.

• Review and, if necessary, edit the security of the network shared folders containing any file 
stores created for the object store. Refer to FileNet P8 Administration > Content Engine 
Administration > Content storage > File storage areas.

• Configure Process Engine for automatic startup. Refer to FileNet P8 Administration > Enterprise-
wide Administration > Process Task Manager > Process Engine > Process Service > Start and stop 
Process Service > Configure the Process Service for automatic startup (Windows).

• Configure email notification. Refer to FileNet P8 Administration > Process Engine Administration > 
Workflow administration tasks > Coordinating workflow design > Email notification.

NOTE Process Engine supports localized email notification. For details on configuring this, 
see the IBM FileNet P8 Non-English Support Guide. To download this document from the IBM 
FileNet support Web site, see “Access IBM FileNet documentation, compatibility matrices, and fix 
packs” on page 20.
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



 Perform additional configuration tasks 271
• Set Process Engine runtime options. Refer to User Help > Integrating workflow > Process 
Configuration Console > VWServices > View or modify VWService properties > Set runtime options.

• Set the default date/time mask for the Process Service. Refer to Process Engine > Process Task 
Manager > Process Service > Configuring Process Service > General properties.

• Create content cache area. Refer to FileNet P8 Administration > Content Engine Administration > 
Content storage > Content cache areas > How to... > Create content cache.

• Create additional authentication realms. Refer to FileNet P8 Administration > Enterprise-wide 
Administration > FileNet P8 Security > How to > Configure for multiple realms.

• Define additional isolated regions. Refer to User Help > Integrating workflow > Process 
Configuration Console > Isolated regions.

• For each isolated region:

– Define workflows. Refer to User Help > Integrating workflow > Process Designer.

– Configure event logging options. Refer to User Help > Integrating workflow > Process 
Configuration Console > Isolated regions > View or modify isolated region properties > Configure 
event logging options.

– Configure step processors. Refer to User Help > Integrating workflow > Process Configuration 
Console > Isolated regions > View or modify isolated region properties >Configure custom step 
processors.

– Define and configure work queues. Refer to User Help > Integrating workflow > Process 
Configuration Console > Queues > Configuring work queues.

– Define and configure component queues. Refer to User Help > Integrating workflow > Process 
Configuration Console > Queues > Configuring component queues.

– Define and configure workflow rosters. Refer to User Help > Integrating workflow > Process 
Configuration Console > Queues > Rosters. 
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Optional installation tasks
To install optional IBM FileNet P8 components

NOTE You can install the additional or optional IBM FileNet P8 components listed below in any 
order.

• “Install and Configure IBM FileNet publishing components” on page 273.

• “Enable the Process Engine Component Integrator” on page 274.

• “Install an Additional Instance of Enterprise Manager” on page 277.

• “Configure Tivoli Storage Manager integration with Content Engine” on page 282.

• “Create additional file storage areas” on page 278.

• “Install IBM FileNet Deployment Manager” on page 286.

• “Install Application Integration” on page 288. 

• “Install File Tracker” on page 292.

• “Deploy multiple Application Engine instances” on page 295.

• “Enable Application Engine to use ISRA” on page 298.

• “Install and Configure IBM FileNet System Manager” on page 303.

• “Modify an Autonomy K2 server configuration” on page 304.

• “Install the COM compatibility layer (CCL)” on page 314.
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Install and Configure IBM FileNet publishing 
components
Install the IBM FileNet Rendition Engine to establish publishing capabilities. For instructions, see 
the IBM FileNet Rendition Engine Installation and Upgrade Guide at FileNet P8 Documentation > 
FileNet P8 System Installation > Rendition Engine Installation and Upgrade. 
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Enable the Process Engine Component Integrator
Via the Component Integrator functionality included in the IBM FileNet P8 Platform, a step in a 
workflow can access properties of documents, folders, and other objects in an object store. Using 
this functionality requires configuration on both Application Engine and Process Engine servers, 
as described in this task. 

As a post-installation task, you will also have to define workflows that incorporate Content Engine 
(CE) operations in order to use the out-of-the-box Component Integrator functionality. For further 
details on defining such workflows, see the IBM FileNet P8 help topic Steps > Component Steps > 
General Properties > Using Content Engine (CE) operations in a workflow.

Once the software is installed, users can extend the out-of-the-box Component Integrator 
functionality so that a workflow step can interact with an external entity such as a Java object or 
Java Messaging Service (JMS) messaging system. For further information, see the IBM FileNet 
P8 help topic Developing Process Applications > Developing Work Performers / Component Integrator 
Operations > Developing Component Integrator-Based Workflow Applications.

To specify the user name and password for the Java adaptor (on an Application Engine server)

1. Sign in to Workplace.

If you defined the Process Engine Configuration Group on the Security tab of Process Task 
Manager (when completing “Configure Process Task Manager” on page 201), you must sign in as 
a member of either that group or the Process Engine Administrators Group, which was also 
defined on the Security tab, in order to complete the following steps.

2. In Workplace, click Admin and then click Process Configuration Console.

NOTE If your computer does not have the appropriate Java Runtime Environment (JRE) 
installed, you will be prompted to download the JRE at this point; follow the prompts to 
complete the download. During the installation process, click the Browser tab and clear the 
Internet Explorer option.

For further information about the JRE download, click Help in Process Configuration Console, 
click Process Reference on the help page toolbar, and see the IBM FileNet P8 help topic 
Concepts > Java Runtime Environment (JRE). 

3. Select the Isolated Region icon that corresponds to the isolated region you initialized in “Create 
a Process Engine isolated region” on page 259.  

4. Right-click the CE_Operations component queue and select Properties.

5. On the Adaptor tab of the displayed dialog box, enter a user name and password that will be 
used for identification and permissions for both Process Engine (PE) and potentially any 
external systems that will be accessed. By default, the user name and password are set to 
Administrator and <no password>, respectively.  If you choose to use another user name and 
password, they must already exist in the directory service.

For additional information about the fields on the Adaptor tab, click the Help button. To use the 
out-of-the-box functionality, it is necessary to modify only the user name and password fields.

6. Click OK and commit the changes.
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To configure and start the Component Manager (on an Application Engine server)

Execute Step 1 below if Application Engine is configured to use maximum strength encryption. The 
JRE used to run the Process Task Manager that contains the Component Manager (which uses 
JDK 1.4.x) must be updated with Unlimited Strength Jurisdiction Policy Files. Otherwise proceed 
to Step 2 below. 

1. Install unlimited strength JAR files.

NOTE Perform this step only if you are using JDK 1.4 or higher and have selected the Create 
unlimited strength keys option in the Application Engine User Security and/or User Token 
Security steps of the Application Engine Setup program. Failure to perform the step will cause 
EncryptionException messages or other errors indicating that a Java Security API provider for 
Blowfish is not available. The EncryptionException is caused by the wrong versions of (or 
absence of) required JAR files that provide unlimited strength security policy files in a Sun 
JDK 1.4 or higher environment. 

For more information, see the IBM FileNet P8 help topic FileNet P8 Administration > Application 
Engine Administration > Application Engine Security.

a. Obtain the JDK version-specific unlimited strength JAR files, as follows: 

• For the IBM JDK, obtain the IBM unlimited jurisdiction policy files from the IBM web 
site (http://www.ibm.com/developerworks/java/jdk/security).

• For the Sun JDK, obtain the Sun unlimited strength policy files from the Sun product 
web site (http://java.sun.com/j2se/). 

CAUTION  Make sure you install JAR files specific to the JDK version you are using.

b. Install the files into the JRE's /jre/lib/security folder by replacing files with the same 
names. 

c. Restart the application server.

2. Start Process Task Manager on the Application Engine server.

Launch the Process Task Manager by running one of the following command files from the 
AE_install_path/FileNet/AE/Router directory, depending on your operating system: 

UNIX

routercmd.sh

Windows 

routercmd.bat

NOTE  If the port number assigned to Component Manager conflicts with the port number 
required by another application or service running on the Application Engine server, then 
Process Task Manager will not start up as expected. See “IBM FileNet P8 ports” on page 280 for 
details on how to resolve this condition.

3. Select Component Manager in the left pane (also referred to as the feature pane).
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4. Right-click and select New to define a new connection point.  You will be prompted to enter the 
Content URI, Service Username, and Service Password to authenticate to the Content Engine 
server.  

5. Enter or modify the component properties as appropriate. For details, see the IBM FileNet P8 
help topic FileNet P8 Administration > Enterprise-wide Administration > Process Task Manager > 
Application Engine > Component Manager > Configure the Component Manager -> General.

NOTE In an environment configured for single sign-on (SSO), do not use the SSO server name 
in the URL, even if Process Task Manager displays it by default.

6. Click Start on the toolbar.

To specify connection between Process Engine and Component Manager (on a Process Engine 
server)

1. On the Process Engine server, start Process Task Manager as follows, depending on your 
operating system:

Windows

Select Start > Programs > FileNet P8 Platform > Process Engine > Process Task Manager.

UNIX

Enter the following command on the command line:

vwtaskman 

2. Select Process Engine in the left pane (also referred to as the feature pane).

3. In the Component Manager connection section, select the Server Connections tab.

4. In the Host field, enter the host name of the Application Engine server where Component 
Manager is running.

5. In the Event Port field, enter the port that the Component Manager listens to for incoming 
events. The default is 32773. The port number you enter must match the number you entered in 
Step 3 of “To configure and start the Component Manager (on an Application Engine server)” on 
page 275.
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Install an Additional Instance of Enterprise Manager
Do this task only if you want to install an instance of Enterprise Manager in addition to the one you 
installed in “Install FileNet Enterprise Manager” on page 34.

CAUTION  Do not install Enterprise Manager 4.5 or the COM Compatibility Clients API on any 
machine running the 3.5.x version, at least until the Content Engine 4.5 upgrade is complete. 
Otherwise, you will no longer be able to run Enterprise Manager 3.5.x against any remaining 3.5.x 
object stores. You may need to use Enterprise Manager to prepare for upgrading the 3.5.x object 
stores.

NOTE  You can install Enterprise Manager only on a Windows machine, and only using the 
Windows version of the Content Engine installation media.

To install an additional instance of Enterprise Manager, 

1. If you have not already done so, install Microsoft .NET Framework 2.0 and Web Services 
Enhancements (WSE) 3.0. Enterprise Manager on the Windows machine where you are going 
to install Enterprise Manager.

2. Do a silent or interactive installation of Enterprise Manager as shown in “Install FileNet Enterprise 
Manager” on page 34.

3. Install any service packs, fix packs and/or interim fixes required. To determine whether such 
additional software updates are needed, contact your service representative.
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Create additional file storage areas
Perform this task to create additional file storage areas for existing object stores. To create 
additional fixed storage areas, navigate instead to the IBM FileNet P8 help topic System 
Administration > Content Engine Administration > Content storage > Fixed storage areas.

Complete the following procedures for each file storage area you want to create.

To create a file storage area

1. Prepare a location for the file storage area, as shown in “Prepare storage areas for object 
stores” in Plan and Prepare Your Environment for IBM FileNet P8, and then continue at Step 2.

2. Start Enterprise Manager.

3. Select a FileNet P8 domain and log on as an administrator of the object store in which you will 
create a file storage area.

4. Right-click the Storage Areas node and then choose New Storage Area.

5. When the Create a Storage Area wizard opens, perform the following steps:

In this screen... Perform this action...

Welcome Click Next to proceed with creating the storage area.

Specify a site Select a site with which to associate the storage area, and then click 
Next.

Name and 
Describe the 
Storage Area

Specify values for the following parameters and then click Next.

• Name

Enter a name that is unique within the specified object store. The 
name is required and must start with a letter. The storage area name 
can have up to 64 characters (upper or lowercase letters, numbers, 
spaces, and symbols). When selecting a name for the storage area, 
ensure that the name does not contain the following characters:

asterisk (*), backslash (\), forward slash (/), comma (,), colon (:), 
semicolon (;), single quote ('), double quote ("), pound sign (#), 
question mark (?), less than (<), greater than (>), or pipe symbol (|).

• Description

Explain what type of documents the storage area will contain, identify 
its purpose, or provide other useful information. You can change the 
default description that mirrors the name. The description can have 
up to 255 characters and is optional.

• Existing Name

This window identifies the names of existing storage areas within the 
specified object store. It can remind you of naming conventions or 
help you choose a unique name. This list box is not selectable.
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Specify the 
Storage Area 
Type

Choose the file storage area type, and then click Next.

Specify File 
Storage Area 
Directory

Type, or browse to, the path of the shared directory (on a local or remote 
Windows or UNIX file server) where you prepared a storage area in 
Step 1, and then click Next. 

In this screen... Perform this action...
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Select the Size 
Parameters of 
the Storage 
Area

Specify values for the following parameters, and then click Next:

• Directory Structure

Select Small if you are creating a file storage area for a small 
development type of system. Select Large if you are creating a file 
storage area in a production environment. This setting cannot be 
changed after the storage area is created.

Small structures have two directory levels, 23 nodes at each level, for 
a total of 529 directories at the 2nd level. Content is stored only at 
the 2nd level.

Performance does not appreciably degrade on Windows NTFS file 
systems as the number of files increases. On UNIX file storage areas 
on network access devices (NAS), however, the number of files per 
directory does matter. As a rule of thumb, a small file storage area on 
such a device should have no more than one million files, or about 
2,000 files per directory.

Large structures have a third directory level of 23 nodes, for a total of 
12,167 directories at the 3rd level. Content is stored only at the 3rd 
level.

• Maximum Size

Identifies the maximum reserved space (in megabytes) for all content 
elements in the storage area. For example, if maximum size is 5000 
(the default), the storage area does not accept new content elements 
until the total size is reduced below this size.

• Maximum Number of Elements

Identifies the maximum number of content elements allowed in the 
storage area. For example, if maximum number is 2500 (the default), 
the storage area does not accept new content elements until the total 
number of content elements is reduced below this number.

• Delete Method

Specifies the method used when removing content element files from 
the storage area. Available options are:

– Standard -- Deletes the file.

– Destructive -- Fills the file with zeros, then deletes it.

– Purge -- Writes over the file three times with various patterns, 
then deletes it.

In this screen... Perform this action...
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To verify the file storage area

1. Log on to the machine where Content Engine Server is installed.

2. List the contents of the fsa1 directory you created or designated on the file server in one of the 
following procedures:

• UNIX “To configure a UNIX-based file server” on page 59 in Plan and Prepare Your 
Environment for IBM FileNet P8

• Windows “To configure Windows-based Content Engine Server to talk to a Windows file server via 
CIFS” on page 61 in Plan and Prepare Your Environment for IBM FileNet P8

• Windows “To configure a Windows-based file server for a UNIX client using NFS” on page 60 in 
Plan and Prepare Your Environment for IBM FileNet P8

3. Verify that fsa1 contains an XML file, named fn_stakefile, and two subdirectories, content 
and inbound.

NOTE On UNIX machines, the content and inbound subdirectories must be in the same file 
system.

4. Verify that fsa1 has the ownership and access permissions you specified.

5. Assign the new storage area as the default storage location for one of your document classes. 
See the IBM FileNet P8 help topic System Administration > Content Engine Administration > 
Content storage > File storage areas for more information.

Specify Storage 
Policy

Select an option button for a storage policy options, and then click Next:

• Create Storage Policy 

Create a storage policy with a similar name as the file storage area 
directory name and map it to the storage area. Edit the value in the 
text box as needed.

• Map storage area to existing Storage Policies 

Add this storage area to one or more storage policies. Select the 
desired storage policies with the check boxes. This option is disabled 
if the are no available storage policies. 

• Do not create a new storage policy

Do not add the storage area to any storage policies. A warning is 
displayed if you select this option.

Completing the 
Create a 
Storage Area 
Wizard

This window lists the values you assigned to the newly created storage 
area. Click Finish.

NOTE A document's class specifies where its content is stored.

In this screen... Perform this action...
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Configure Tivoli Storage Manager integration with 
Content Engine
To prepare a Tivoli Storage Manager (TSM) fixed content device and storage area, complete the 
following procedures:

• “To create or validate Tivoli Storage Manager properties” on page 282 creates or validates the 
properties needed for TSM integration with Content Engine

• “To create a Tivoli Storage Manager fixed content device” on page 283 creates the fixed content 
device that accesses the DR550 storage system

• “To create a Tivoli Storage Manager fixed storage area” on page 284 creates the staging area 
where Content Engine uploads content prior to migrating it to the TSM server and creates the 
storage area where retention periods are defined.

To create or validate Tivoli Storage Manager properties

1. Log on to the Tivoli Storage Manager console.

2. Run console commands to create or validate the values of the properties shown in the following 
subsections. These are the properties you will need to specify when creating a TSM fixed 
content device.

Refer to System Administration > Content Engine Administration > Content storage > Fixed storage 
areas > About IBM Tivoli Storage Manager and DR550 in the IBM FileNet P8 online help, for 
additional information on these properties.

Data Retention Protection Flag
Verify whether data retention protection is enabled on your TSM server (that is, the query status) 
and note the Archive Retention Protection value, which will correspond to the Archive Protection 
Flag on the fixed content device.

Node Name
Create a node name on the TSM server that is configured to have the proper read/write access to 
the appropriate server storage and is allowed to make multiple connections to the TSM server. 
This node name will be used by Content Engine to establish all client connections to the TSM 
server for a particular fixed content device and corresponds to the fixed content device node 
name.

PASSEXP
The client node name you created above should have a password associated with it. You can 
modify the password expiration for client nodes associated with Content Engine to be different 
from your normal user password expiration.

MAXSESSIONS
The maximum number of simultaneous client sessions to the TSM Server. The DR550 has a hard 
limit of 100 MAXSESSIONS. So, if not already configured this way, increase the value of this 
property to its maximum.
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TXNGROUPMAX
The number of files transferred as a group between TSM commit points. Content Engine commits 
all content elements for a document in one TSM transaction. If your documents can contain a 
large number of content elements, consider increasing this parameter on the TSM server. The 
typical default for this parameter is 256 with a maximum allowed value of 65000.

Management Classes
Management classes are policies that determine how TSM manages objects, including the object 
retention policy. Create the management classes as described in the System Administration > 
Content Engine Administration > Content storage > Fixed storage areas > About IBM Tivoli Storage 
Manager and DR550 in the IBM FileNet P8 online help.

To create a Tivoli Storage Manager fixed content device

1. Log on to FileNet Enterprise Manager and start the New Fixed Content Device wizard.

2. Choose the IBM Tivoli Storage Manager fixed content device type.

3. Provide the parameter values requested in the wizard. Refer to System Administration > Content 
Engine Administration > Content storage > Fixed storage areas > How to... > Create fixed content 
device in the IBM FileNet P8 online help for more information on the parameters. The following 
subsections discuss some of these parameters.

Fixed Content Provider Pool Properties
The Fixed Content Provider (FCP) pool controls the number of concurrent connections made to 
the TSM server using the FCP pool properties on the Tivoli Fixed Content Device (FCD).

• Each FCP instance maintains a separate, long-lived connection to the TSM server which 
corresponds to a session on the TSM server.

• The default FCP Pool Max In Use value for the Tivoli FCD is 30 for each CE server. When this 
value is multiplied by the number of CE servers connected to the same TSM Server (the 
DR550, for example), it should not exceed the MAXSESSIONS setting on that TSM Server.

• When the FCP Pool Max In Use value is reached on a particular Content Engine server, 
requests for documents on the TSM server will block up to the FCP Pool Max Wait value (the 
default is 5 seconds). After this period, the TSM server returns an error to indicate that all 
connections to the TSM server are in use and that the user should try the request again later.
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TSM Configuration Properties
The following table provides an example of the properties that relate to your TSM Server and TSM 
Client installations:

To create a Tivoli Storage Manager fixed storage area

1. Create the path to the location where you want Content Engine to stage uploaded documents 
prior to migrating them to the fixed content device. Example: /opt/FileNet/storage/
tsmstorage.

All Content Engine servers in a farm must be able to access this path.

Property Description

Configuration Files Share The directory containing the TSM options files, referenced 
whenever you create or alter a fixed content device.

Example: /opt/FileNet/storage

In a Content Engine server farm, this directory must be accessible 
by all CE servers in the farm using this exact path.

Archive Protection Flag Must match the Archive Retention Protection setting on your TSM 
server.

Example: True

Node Name Must match the node name you created on the TSM server for the 
Content Engine to establish its client connections to the TSM 
server for this particular FCD.

Example: FNCE001

Filespace Name The name used by TSM server for archiving Content Engine 
objects. You don’t need to create anything in advance on the TSM 
server in order to use this name.

The name may have any value as long as it begins with a forward 
slash ("/").

Example: /FileNetP8

DSMI Directory Corresponds to the TSM client installation directory containing the 
dsm.sys file. 

If your Content Engine server is running on UNIX, this property is 
required. 

If your Content Engine server is running on Windows, leave this 
property blank. 

Example: /usr/tivoli/tsm/client/ba/bin
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2. Start FileNet Enterprise Manager.

3. Start the Storage Area wizard to create a fixed storage area for your TSM fixed content device.

4. Set the property values as shown in the following table. For more information on these 
properties, refer to System Administration > Content Engine Administration > Content storage > File 
storage areas > How to... > Create storage area in the IBM FileNet P8 online help.

Property Description

Fixed Content Device Select the fixed content device you created in “To create a Tivoli 
Storage Manager fixed content device” on page 283.

Staging Area Path The location where you Content Engine will stage uploaded 
documents prior to migrating them to the fixed content device.

Management Class The management class corresponds to retention period you 
want applied to documents stored in this storage area. The 
wizard queries the TSM server to determine the available 
management classes.
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Install IBM FileNet Deployment Manager
IBM FileNet Deployment Manager works with FileNet Enterprise Manager to deploy test systems 
into full production. Use the procedure in this topic to install the IBM FileNet Deployment Manager 
interactively or silently on a Windows machine.

NOTE FileNet Deployment Manager runs only on Windows.

To install IBM FileNet Deployment Manager

1. On the machine where you will install FileNet Deployment Manager, log on as a member of the 
Local Administrators group or the Power Users group.

2. If you have not already done so, install Microsoft .NET Framework 2.0 and Web Services 
Enhancements (WSE) 3.0 on the machine.

3. Access the Content Engine installation software.

4. Start the FileNet Deployment Manager installation. For information on parameter values, see 
“Installation and upgrade worksheet” on page 229 in Plan and Prepare Your Environment for IBM 
FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls), perform the following steps to quickly see 
only the installation properties you must specify for the Content Engine installation 
program:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select CE installer.

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Installation."

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

• To install interactively:

i. Run the following command in the software package:

P8CE-4.5.0-WIN.EXE

ii. Complete the program installation wizard using the following table:

In this screen... Perform this action...

Welcome Click Next to proceed with the Deployment Manager installation.

NOTE Click Previous at any time to make changes in previous 
screens. Click Cancel to exit the program.

Software 
License 
Agreement

Review and accept the license agreement, and then click Next.
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• To install silently:

i. Open the CE_silent_install.txt file in the software package for editing.

ii. Set the parameter values in the CE_silent_install.txt file for your site. Be sure to 
set the CHOSEN_INSTALL_FEATURE_LIST parameter value to:

Tools

If you want to also install FileNet Enterprise Manager on this machine, select .NET 
Clients as well:

DotNetClients,Tools

iii. Set the LAUNCH_CM value to 0.

iv. Save your edits.

v. Run the following command in the software package:

P8-CE-4.5.0-WIN.EXE -f CE_silent_install.txt -i silent

NOTE To start FileNet Deployment Manager, choose Start > All Program > FileNet P8 Platform 
> P8 Deployment Manager.

Choose 
Components

Select the Tools check box, clear the other check boxes, and then 
click Next.

NOTE Selecting Tools also selects FileNet Configuration Manager 
and FileNet Content Engine Upgrader for installation.

Choose Install 
Path

Specify the path where you want Deployment Manager to be 
installed, and then click Next.

Specify 
Documentation 
URL

If you haven’t already specified the URL for accessing IBM FileNet 
P8 documentation from Enterprise Manager and other IBM 
FileNet P8 components, do so now. Click Next.

Review Pre-
Installation 
Summary

Verify your component selection, and click Install to start installing 
Deployment Manager.

In this screen... Perform this action...
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Install Application Integration
Install Application Integration if you want to integrate IBM FileNet Workplace with your Microsoft 
Office applications and Outlook. Complete the following procedure on each machine that will use 
Workplace Application Integration.

NOTE You cannot collocate Workplace Application Integration with clients running IDM Desktop 
Application Integration.

Verify that the client machine meets the platform requirements documented in the IBM FileNet P8 
Hardware and Software Requirements. To download this guide from the IBM support page, see 
“Access IBM FileNet documentation, compatibility matrices, and fix packs” on page 20.

To install the Application Integration software interactively

1. Log onto the client machine using an account that has Administrator privileges.

2. Sign in to Workplace.

3. Click Author, and then click General Tools.

4. Scroll down and click Download Application Integration for Microsoft Office, and then do one of 
the following:

• Click Open to run the program from its current location.

• Click Save. In the Save As dialog box, find a location on your machine in which to download and 
save the ApplicationIntegration.exe file locally, and then click Save. Once the file is saved to your 
hard drive, double-click the file to run the installer.

The Welcome Wizard dialog box for Application Integration appears. Another Welcome dialog 
box appears.

5. Click Next.

6. Read the license agreement, and then select I accept the terms to the license agreement, and 
then click Next. If you do not accept the license agreement, you cannot continue with the install. 

7. Do the following:

• Select the applications you want to integrate, and then click Next.

NOTE  The Application Integration Toolkit Components option is required to use 
Application Integration. 

• Under Install to, the default installation path is displayed. Click Change to specify a different 
location on the Change Current Destination Folder dialog box, and then click OK. Click Next.

NOTE  You may see two default installation paths - one for Microsoft Office and Outlook, 
and another for the Toolkit Components. The Toolkit Components path only appears when 
the system on which you are installing Application Integration has the Toolkit Components 
currently installed. You cannot modify the Toolkit Components installation path.
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8. Enter the server name, port number and application name that defines the Workplace address. 
The server name is the name of the web server running Workplace, port number is the web 
server’s assigned port, application is the directory where you installed the IBM FileNet 
Workplace application files.

Check Server uses secure connection (SSL) if you are running full SSL to encrypt all 
communication with Workplace. 

NOTE  You can also leave these fields blank and enter the information when you log on to 
Workplace Application Integration.

9. Click Next.

10. Click Install.

11. After the install is complete, click Finish to complete the setup process.

To install the Application Integration software silently

1. Log onto the client machine using an account that has Administrator privileges.

2. Sign in to Workplace.

3. Click Author, and then click General Tools.

4. Scroll down and click Download Application Integration for Microsoft Office, and then click 
Save. In the Save As dialog box, find a location on your machine in which to download and save 
the ApplicationIntegration.exe file locally, and then click Save.

5. Open a DOS command window and change the current directory to the one where 
ApplicationIntegration.exe resides.

6. Type the following at the command line: 

ApplicationIntegration.exe /s/v"/qn <additional msi arguments included in string> 
LICENSE_ACCEPTED=true"

Use the /s switch to launch the execution silently and include the /qn switch in the msi string to make 
msi run silently.

Refer to the following optional command line values you can also use. Append the values 
within the string containing the msi arguments. For example:

ApplicationIntegration.exe /s/v"/qn /L*v C:\temp\AppIntSetup.txt 
LICENSE_ACCEPTED=true"
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To verify your Workplace Application Integration installation

1. Start Microsoft Word. 

2. From the File menu, click FileNet P8, click Open Document, and then click Select Item. The 
Logon dialog box opens. 

3. Log on using any valid domain account. The available object stores in your environment are 
displayed.

NOTE  If you did not enter the Workplace Address information in Step 8 in the procedure “To 
install the Application Integration software interactively” on page 288, enter the server name, port 
number and application name that defines the Workplace address. The server name is the 
name of the web server running Workplace, port number is the web server’s assigned port, 
application is the directory where you installed the IBM FileNet Workplace application files. 

Command Line Values Installs

ADDLOCAL=ALL All Features

ADDLOCAL=ALL  
REMOVE=OutlookIntegrationFeature 

Office Only

ADDLOCAL=ALL  
REMOVE=OfficeIntegrationFeature

Outlook Only

ADDLOCAL=ALL 
REMOVE=OutlookIntegrationFeature,
OfficeIntegrationFeature

Core Only

Command Line Values Settings

HOST=<host name> Enter the name of the web server running Workplace.

PORT=<port number> Enter the web server’s assigned port number.

APPLICATION=<application name> Enter the directory in which you installed the Workplace 
application files.

SERVER_CONNECTION=1 Set Application Integration to use an https connection

SERVER_CONNECTION=0 Set Application Integration to use http connection. This is 
the default if this parameter is not passed.

/L*v C:\temp\AppIntSetup.txt Verbose installation log and specify log location.
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Check Server uses secure connection (SSL) if you use a full SSL to encrypt all communication 
with Workplace. Do not select this option if you use a SSL redirect during logon. 

4. Close all dialog boxes and close Microsoft Word.

To uninstall or modify Workplace Application Integration

1. From the Start menu, click Settings, and then click Control Panel.

2. Click Add/Remove Programs, and then click FileNet Workplace Application Integration 4.0.

3. Do one of the following:

• Click Remove, and then click Yes to confirm you want to uninstall Workplace Application 
Integration.

• Click Change to access maintenance tasks, and then click Next. You can modify, repair, or remove 
Application Integration using the maintenance tasks.

Do one of the following:

– Select Modify to add or remove integration with Microsoft applications from your 
previous install. For example, if you have both Microsoft Office and Outlook installed, 
you can remove one of the applications using this option. The Custom Setup dialog 
box appears, where you highlight the option you want to add or remove. Click Next, 
and then click Install. Click Finish to complete the process.

– Select Repair to re-install Workplace Application Integration to repair installation 
errors, and then click Next. Click Install to start the repair process. Click Finish to 
complete the process.

– Select Remove to remove Workplace Application Integration from your system, and 
then click Next. Click Remove. Once the application is removed from your system, click 
Finish to complete the process.

To silently uninstall Workplace Application Integration

1. Open a command prompt.

2. Enter the following command to uninstall Workplace Application Integration:

msiexec.exe /X{35907B7D-02E2-490C-8F3B-54C4E3729D90} /qn
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Install File Tracker
Install File Tracker if you want to use the Workplace file tracking feature without installing 
Application Integration. Complete the following procedure on each machine that will use 
Workplace File Tracker.

NOTES  

• If you have already installed or upgraded to Application Integration 3.5.1-002 or higher, then 
the File Tracker feature has already been installed. Do not perform this procedure if you 
already installed a version of Application Integration that includes File Tracker, including 
Application Integration 4.0. 

• If you have already installed Application Integration 3.5.1-001 or earlier, upgrade it to 4.0 plus 
the latest fix pack, and this will include the File Tracker installation. For details about the 
upgrade process, see “Upgrade Application Integration and File Tracker” on page 605.

Verify that the client machine meets the platform requirements documented in the IBM FileNet P8 
Hardware and Software Requirements. To download this guide from the IBM support page, see 
“Access IBM FileNet documentation, compatibility matrices, and fix packs” on page 20.

To install the File Tracker software interactively

1. Log on to the client machine using an account that has Administrator privileges. 

2. Sign in to Workplace.

3. Click Author, and then click General Tools.

4. Scroll down and click Download File Tracker and do one of the following:

• Click Open to run the program from its current location.

• Click Save. In the Save As dialog box, find a location on your machine in which to download and 
save the FileTracker.exe file locally, and then click Save. Once the file is saved to your hard drive, 
double-click the file to run the installer.

The Welcome Wizard dialog box for File Tracker appears. Another Welcome dialog box 
appears.

5. Click Next.

6. Read the license agreement, and then select I accept the terms to the license agreement, and 
then click Next. If you do not accept the license agreement, you cannot continue with the install. 

7. Do one of the following:

• Click Change if you want to install File Tracker to a different location. Specify the location to which 
you want to install File Tracker, and then click OK. Click Next.

• Click Next to accept the default location.

8. Click Install.

9. After the install is complete, click Finish to complete the setup process.
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10. (On Vista using Internet Explorer 7.0 only) Add the Workplace URL to the browser security tab.

a. In the Internet Explorer 7.0 browser, click Tools > Internet Options. Click the Security tab.

b. Select Trusted Sites, and click the Sites button.

c. Add the Workplace URL and click Add.

d. Click OK, and OK again to save changes.

To install the File Tracker software silently

1. Log on to the client machine using an account that has Administrator privileges and sign in to 
Workplace.

2. Click Author, and then click General Tools.

3. Scroll down and click Download File Tracker and click Save. In the Save As dialog box, find a 
location on your machine in which to download and save the FileTracker.exe file locally, and then 
click Save.

4. Open a DOS command window and change the current directory to the one where 
FileTracker.exe resides.

5. Type the following at the command line:

FileTracker.exe /s /v"/qn <additional msi arguments included in string> 
LICENSE_ACCEPTED=true"

NOTE Use the /s switch to launch the execution silently and include the /qn switch in the msi string to 
make msi run silently. In addition, be aware of spaces specified between switches in the above 
example. Using the correct spacing ensures a successful silent install.

Refer to the following optional command line values you can also use. Append the values 
within the string containing the msi arguments.

For example:

FileTracker.exe /s /v"/qn /L*v C:\temp\FileTrackerSetup.txt LICENSE_ACCEPTED=true"

6. (On Vista using Internet Explorer 7.0 only) Add the Workplace URL to the browser security tab 
as follows:

a. In the Internet Explorer 7.0 browser, click Tools > Internet Options. Click the Security tab.

b. Select Trusted Sites, and click the Sites button.

c. Add the Workplace URL and click Add.

Command Line Values Settings

/L*v C:\temp\FileTrackerSetup.txt Verbose installation log and specific log location.

NOTE If you intend to specify a log location, create the 
directory before running the silent install. If the directory is 
not created ahead of time, the install will fail.
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d. Click OK, and OK again to save changes.

To uninstall Workplace File Tracker

1. From the Start menu, click Settings, and then click Control Panel.

2. Click Add/Remove Programs, and then click FileNet Workplace File Tracker.

3. Click Remove, and then click Yes to confirm you want to uninstall Workplace File Tracker.

To silently uninstall Workplace File Tracker

1. Open a command prompt.

2. Enter the following command to uninstall Workplace File Tracker:

msiexec.exe /X{4291FBBC-C585-43ED-9416-5F22D8C6FEE9} /qn
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Deploy multiple Application Engine instances
This topic covers deployment of multiple instances of Workplace on a single application server. 
Each deployment of Workplace must use the same Content Engine, Process Engine, and 
connection point. Each deployment of Workplace may use different Site Preference settings and 
may provide access to different object stores.

NOTES 

• The following procedure assumes that you have already installed Application Engine and 
performed the following configuration tasks according to your application server type:

– “Configure Application Engine (WebSphere)” on page 228

– “Configure Application Engine (WebLogic)” on page 237

– “Configure Application Engine (JBoss)” on page 243

• When deploying multiple instances of Workplace, make copies of all the Workplace 
configuration and working files. Each instance of Workplace will use separate configuration, 
deploy, download, upload, and Workplace files. Leave the default installed files unmodified.

• For more information on how to deploy and manage multiple identical applications, see your 
application server documentation. 

To deploy a second instance of the Workplace application

1. Make a copy of the /FileNet/Config/AE directory, including all of its contents, for each 
instance you plan to deploy. 

For example, if you are deploying two instances, you would create:

install_path/FileNet/Config/AE1

install_path/FileNet/Config/AE2

2. Make copies of the upload and download directories in the <install_path>/FileNet/AE 
directory. 

For example, you would create:

install_path/FileNet/AE/Download1

install_path/FileNet/AE/Upload1

install_path/FileNet/AE/Download2

install_path/FileNet/AE/Upload2

3. Make a copy of the deploy directory and all of its contents for each Workplace instance. 

For example, you would create:

install_path/FileNet/AE/deploy1

install_path/FileNet/AE/deploy2
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4. Make a copy the Workplace directory and all of its contents for each Workplace instance. 

For example, you would create:

install_path/FileNet/AE/Workplace1

install_path/FileNet/AE/Workplace2

5. Navigate to each custom copied Workplace web.xml instance and update the path for the 
configuration directory, upload directory, and download directory locations.

For example, in the install_path/FileNet/AE/Workplace1/WEB-INF/web.xml, you would 
make the following changes (in bold):

<context-param>
<param-name>configurationDirectory</param-name>
<param-value>/opt/FileNet/Config/AE1</param-value>

 </context-param>
 
<context-param>

<param-name>uploadDir</param-name>
<param-value>/opt/FileNet/AE/Upload1</param-value>

 </context-param>
 <context-param>

<param-name>downloadDir</param-name>
<param-value>/opt/FileNet/AE/Download1</param-value>

 </context-param>

To deploy each additional Workplace instance as an EAR file

NOTE Perform the following steps for each custom Workplace instance you plan to deploy.

1. Modify the application.xml file located in the copied deploy directories, as follows:

a. Open each instance of the application.xml file, for example, <install_path>/
FileNet/AE/deploy1/META-INF/application.xml.

b. Change the <display-name> and the <context-root> elements to your custom name, for 
example, Workplace1 (shown in bold, below).

<display-name>Workplace1</display-name>
<description>FileNet Application Engine</description>

<module>
<web>

<web-uri>app_engine.war</web-uri>
<context-root>Workplace1</context-root>

</web>
</module>

2. In the create_app_engine_war file, change the install_home path and the deploy directory to 
match your custom names.

For example, you would make the following changes, shown in bold:

install_home=”/opt/FileNet/AE/Workplace1”

"${install_home}/../_AEjvm/bin/jar" -cf "${install_home}/../deploy1/app_engine.war"*
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3. In the create_app_engine_ear file, set the install home, deploy directory, and EAR file to 
match your custom names.

For example, you would make the following changes, shown in bold:

install_home="/opt/FileNet/AE/Workplace1"
cd "${install_home}/../deploy1"
"${install_home}/../_AEjvm/bin/jar" -cvf "${install_home}/../deploy1/
app_engine1.ear" META-INF *.war

4. Delete the existing app_engine.war and app_engine.ear files.

5. Create your custom WAR and EAR files by running the create_app_engine_war and then the 
create_app_engine_ear files.

6. Deploy the EAR file for each custom Workplace instance according to the procedures for your 
application server type, as presented in the following topics:

• “Deploy Application Engine (WebSphere)” on page 246

• “Deploy Application Engine (WebLogic)” on page 249

• “Deploy Application Engine (JBoss)” on page 251

7. Install any service packs, fix packs and/or interim fixes required. To determine whether such 
additional software updates are needed, contact your service representative.
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Enable Application Engine to use ISRA
Image Services Resource Adapter (ISRA) is a J2EE connector to the FileNet Image Services (IS) 
libraries. Using ISRA, Workplace users can view IS documents and their associated annotations 
in the FileNet P8 Image Viewer and, if they have the appropriate permissions, update the 
annotations.

To enable Workplace users to view documents using ISRA, the following steps must be 
completed:

• Install Application Engine. 

• Install FileNet ISRA. 

For information on installing, configuring and deploying FileNet ISRA, refer to the Image 
Services Resource Adapter documentation in the FileNet ISRA installation package. 

TIP Use the Sample Application shipped with FileNet ISRA to confirm that the ISRA 
installation was successful.

WARNING In an ISRA upgrade situation, take care to use the same library name (JNDI connection 
factory name) that has been previously set in the ISRA install. Changing this variable can cause 
conflicts when accessing documents.

• Install the Application Engine ISRA Servlet and take the following into account:

– Install and deploy ISRA before installing and deploying the ISRA Servlet. 

– Deploy the ISRA Servlet on the same application server as FileNet ISRA.

– You need not necessarily install the ISRA Servlet on the Application Engine server. See 
“ISRA SSL Support” on page 298 for details that might affect your collocation plans.

• Configure Workplace Site Preferences.

ISRA SSL Support
The following table details supported SSL configurations for ISRA.

SSL Configuration SSL Support

ISRA Servlet and Application Engine Collocated. 
Application Engine configured for SSL logon 
redirect to a non-local host.

Supported

ISRA Servlet and Application Engine Collocated. 
Application Engine Configured for SSL logon 
redirect to a local host.

Supported

ISRA Servlet and Application Engine Collocated. 
Application Engine and ISRA Servlet running 
under SSL.

Not Supported
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



 Enable Application Engine to use ISRA
Install and Deploy the Application Engine ISRA Servlet

299
Install and Deploy the Application Engine ISRA Servlet   
Use the procedure in this topic to install and deploy the ISRA Servlet on the operating systems 
supported by Application Engine by running the associated ISRA setup program found in the 
Application Engine software package.

To install and deploy the Application Engine ISRA Servlet

The FileNet P8 Application Engine installation software contains the ISRA servlet installation 
programs for the supported P8 AE operating systems.

1. Log on to the application server using the following account, depending on your operating 
system:

UNIX

User account with write access to the /bin directory and read, write, and execute access to 
the directory where you plan to install ISRA Servlet.

Windows

A member of the local Administrators group or as a user account with equivalent permissions.

2. Stop the application server if it is running.

3. Access the ISRA installation package, and start the following Application Engine ISRA Servlet 
setup program, depending on your operating system:

UNIX

AE-ISRA-Servlet-4.0.2.0-operating_system.bin

Windows

AE-ISRA-Servlet-4.0.2.0-WIN.exe

ISRA Servlet remote from Application Engine. 
Application Engine configured for SSL logon 
redirect to a non-local host.

Supported

ISRA Servlet remote from Application Engine. 
Application Engine configured for SSL logon 
redirect to a local host.

Supported

ISRA Servlet remote from Application Engine. 
Application Engine running under SSL, ISRA 
Servlet not running under SSL. 

Supported

ISRA Servlet remote from Application Engine.  
Application Engine and ISRA Servlet running 
under SSL.

Not Supported

SSL Configuration SSL Support
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4. Complete the installation program screens. For information on parameter values, see “Installation 
and upgrade worksheet” on page 229 in Plan and Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping     
worksheet file (p8_worksheet.xls), perform the following actions to quickly see only the     
installation properties you must specify for the ISRA servlet installation program:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column 
header and select ISRA installer.

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, 
and specify: Setup Type contains "Installation."

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

5. Check the file AE_ISRA_Servlet_install_log-4_0_2_0.txt, located in the 
AE_israservlet_install path\FileNet directory, to see if any errors occurred during the 
installation.

6. Install unlimited strength JAR files.

Perform this step only if the following are true:

• You selected the option to create Strong keys in the Application Engine User Token Security step 
of the Application Engine installation. 

• Application Engine ISRA Servlet is deployed on a different application server than Application 
Engine. 

CAUTION If these conditions are true, failure to perform this step causes an 
EncryptionException when you log on to the IS server. 

7. (WebSphere and WebLogic only) Start the application server.

8. Deploy AE_israservlet_install_path/FileNet/ApplicationEngineISRAServlet/
ae_isra.war in the same way you deployed the app_engine.war file for Workplace.

9. (JBoss only) Start the application server.

10. Verify the Application Engine ISRA Servlet is installed and deployed correctly, as follows. This 
step launches a diagnostic tool that does the verification. 

a. Open your web browser.

b. Enter the URL for the Application Engine ISRA Servlet, for example:

http://ApplicationEngineISRAServlet_servername:port/
ApplicationEngineISRAServlet/ISRA

NOTE ApplicationEngineISRAServlet is the default context root. If you specified a different 
name for the context root when deploying the Application Engine ISRA Servlet, change the 
URL to match your configuration.

If the ISRA Servlet is set up correctly, a congratulations message displays, for example: 

Congratulations! ISRA Interface Servlet is configured at this URL.

WcmApiConfigFile = D:\ISRAInterface\jsp\WEB-INF\WcmApiConfig.properties
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WcmApiConfig file exists

CryptoKeyFile/UserToken = C:\Program 
Files\FileNet\Authentication\UTCryptoKeyFile.properties

CryptoKeyFile/UserToken exists 

FileNet ISRA classes are in the classpath

com.filenet.is.ra.cci.FN_IS_CciConnectionSpec 

Configure Workplace Site Preferences
Use the following procedure to enable the Image Services external service and set the ISRA 
Interface Servlet URL in Workplace Site Preferences. The Application Engine setup installs the 
pre-configured Image Services external service, which includes the parameterized values 
necessary to access FileNet IS libraries from Workplace.

To configure Workplace Site Preferences for ISRA Servlet support

1. Sign in to Workplace as a user having the Application Engine Administrators access role. 

2. Launch Site Preferences as follows:

a. Select Admin.

b. Select Site Preferences.

3. Enable the pre-configured Image Services external service, as follows:

a. Select External Services from the left options list.

b. Select Modify for the Image Service, located under External Reference Services.

The External Reference Service Settings site preference page displays. 

c. Under General Information, locate Show on Select File page and change the value to Show.

d. Accept the setting.

4. Set the ISRA Interface Servlet URL as follows:

a. Select Bootstrap.

b. Under Preferences Settings, set the value of ISRA Interface Servlet URL. For example:

http://servername:port/ApplicationEngineISRAServlet/ISRA

NOTE ApplicationEngineISRAServlet is the default context root. If you specified a different 
name for the context root when deploying the Application Engine ISRA Servlet, change the 
URL to match your configuration.

c. Accept the setting.

d. Exit Site Preferences.
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Log On to Image Services Using an LDAP Account
To log on to the Image Services library using your LDAP account, configure ISRA and Image 
Services for LDAP authentication. 

NOTE If the LDAP account with which you accessed Workplace is not valid for the Image Services 
library, or if LDAP authentication is not configured, you will be prompted to log on to the Image 
Services library.

For information on configuring LDAP authentication for ISRA, refer to the ISRA Installation and 
Deployment Guide. For information on configuring LDAP authentication for Image Services, refer 
to the Image Services System Tools Reference Manual.

Access IS Library Documents
For information about accessing IS library documents, see User Help > Actions, preferences and 
tools > Actions > Documents > Add a document (Workplace).
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Install and Configure IBM FileNet System Manager
Content Engine, Application Engine, and Process Engine install, by default, the necessary 
software required for the System Manager performance component. To use System Manager, 
enable associated components and install IBM FileNet Dashboard to perform related configuration 
procedures to enable System Manager. Installing Dashboard is not necessary if you currently 
have IBM FileNet System Monitor installed.

Refer to the following IBM FileNet P8 help topic FileNet P8 Documentation > FileNet P8 Administration 
> Enterprise-wide Administration > System Manager for instructions on how to enable the associated 
System Manager components.

Refer to the documentation provided with IBM FileNet Dashboard for instructions on how to use 
Dashboard.
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Modify an Autonomy K2 server configuration

Add additional K2 Administration Servers

You will likely need to install additional Autonomy K2 Administration Servers to handle the 
indexing load. The Master Administration Server is the main hub for configuring all the servers you 
install. The additional servers are managed through the K2 Dashboard that is installed with the 
Master Administration Server.

NOTE  A K2 Master Administration Server must be installed before you add additional K2 
Administration Servers.

To install additional Autonomy K2 Administration Servers on Windows

1. Access the host machine and log on as k2_os_user. For details on required accounts and related 
permissions, see “Accounts for Content Search Engine” on page 92 in Plan and Prepare Your 
Environment for IBM FileNet P8.

NOTE  Ensure k2_os_user has administrator privileges on this machine.

2. Set the JAVA_HOME environment variable as follows:

a. Open the System control panel.

b. Click the Advanced tab.

c. Click Environment Variables.

d. Click New under System Variables.

e. Set the variable information as follows:

Variable name: JAVA_HOME

Variable value: Java (JDK) install path

NOTE  The installer will not allow you proceed with the installation until the JAVA_HOME 
environment variable is set.

3. Start the Content Search Engine installation using your Installation and Upgrade Worksheet. For 
information on the Content Search Engine parameter values, see “Installation and Upgrade 
Worksheet” in Plan and Prepare Your Environment for IBM FileNet P8.

HINT  With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls), perform the following steps to quickly see only 
the installation properties you must specify for the Content Search Engine installation 
program:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select CSE Installer.

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Installation."

– Click the AutoFilter drop-down arrow in all other column headers and select (All).
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• To install interactively:

i. Access the IBM FileNet Content Search Engine installation package and execute the 
P8CSE-4.5.0-WIN.EXE file. 

ii.  Complete the installation program wizard using the following table:

In this screen... Perform this action...

JAVA_HOME Not 
Set

This screen will appear only if you have not set the 
JAVA_HOME environment variable on the machine.

Click Cancel to exit the installation program and set the 
required environment variable.

NOTE  The installer will not allow you to continue until you set 
the environment variable.

Click Next to continue.

JAVA_HOME for K2 
Server

Enter the path to the supported Java (JDK) installation and 
click Next to continue.

Welcome Click Next to proceed with the installation.

NOTE Click Previous at any time to make changes in previous 
screens. Click Cancel to exit the program.

Software License 
Agreement

Review and accept the license agreement.

Click Next to continue.

Specify Content 
Search Engine 
Installation Path

Specify the directory in which you want to install Content 
Search Engine. The installation program will create any 
specified directories that do not already exist.

Click Next to continue.

Select Autonomy 
K2 Server Type

Choose whether to install a Master Administration Server 
(required for first-time installation) or an Administration 
Server.

Click Next to continue.

Specify 
Administration 
Server Information

This screen will appear only if you selected Administration 
Server on the Select Autonomy K2 Server Type screen.

Enter the host name and port for the Administration Server.

Click Next to continue.
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



 Modify an Autonomy K2 server configuration
To install additional Autonomy K2 Administration Servers on UNIX

306
• To install silently

i. Access the IBM FileNet Content Search Engine installation package and edit the 
CSE_silent_install.txt file to reflect the appropriate responses for your installation.

ii. Launch the Content Search Engine installer by executing the following command:

P8CSE-4.5.0-WIN.EXE -f CSE_silent_install.txt -i silent

NOTE  The following two Autonomy K2 services will be installed and started on your machine 
after the installation is complete:

• Verity K2 6.2.1 Administration Server service.

• Verity K2 Administration Web Server service (Tomcat server).

4. Review the following Content Search Engine log files for installation errors. The files are located 
in the verity directory of the install path:

• cse_install_path\verity\cse_install_log_4_5_0.txt

• cse_install_path\verity\vconfig.log

To install additional Autonomy K2 Administration Servers on UNIX

NOTE  Most processes for the Autonomy K2 software will run as k2_os_user. However, the 
vspget process must run as root. For details on required accounts and related permissions, see 
“Accounts for Content Search Engine” on page 92 in Plan and Prepare Your Environment for IBM 
FileNet P8.

1. Access the host machine and log on as a user with root privileges.

Specify Master 
Administration 
Server Information

Enter the host name and server port for the Master 
Administration Server.

NOTE  If you are installing a K2 Administration Server, the 
Master Administration Server must already be installed.

Click Next to continue.

K2 Operating 
System User 
Account

Enter the k2_os_user log in information and the name of the 
domain on which this K2 server communicates with the 
Content Engine.

Click Next to continue.

Review Pre-
installation 
Summary

Verify your component selections, and click Install to start 
installing software.

Install Complete Click Done to complete the installation.

In this screen... Perform this action...
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2. Enter the following commands to set the vspget program’s setuid bit such that the service runs 
as root:

chown root /verity install path/k2/_platform/bin/vspget

chmod u+s /verity install path/k2/_platform/bin/vspget 

Replace _platform with the following directory, according to your environment: 

3. Log off the machine.

4. Log on to the machine as k2_os_user.

5. Set the following environment variable and place the entry in the .profile file for 
k2_os_user.

JAVA_HOME=java_(JDK)_install_path/jdkversion

export JAVA_HOME

6. Start the Content Search Engine installation using your Installation and Upgrade Worksheet. For 
information on the Content Search Engine parameter values, see “Installation and Upgrade 
Worksheet” in Plan and Prepare Your Environment for IBM FileNet P8.

HINT  With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls), perform the following steps to quickly see only 
the installation properties you must specify for the Content Search Engine installer:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select CSE Installer.

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Installation."

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

• To install interactively (X-Terminal must be installed):

i. Access the IBM FileNet Content Search Engine installation package and execute the 
appropriate installation program:

Platform Directory

HPUX _hpux

AIX _rs6k43

Solaris _ssol26

Linux _ilnx21

Platform Command

HPUX P8CSE-4.5.0-HPUX.BIN

AIX P8CSE-4.5.0-AIX.BIN

Solaris P8CSE-4.5.0-SOL.BIN

Linux P8CSE-4.5.0-LINUX.BIN
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ii.  Complete the installation program wizard using the following table:

In this screen... Perform this action...

JAVA_HOME Not 
Set

This screen will appear only if you have not set the 
JAVA_HOME environment variable on the machine.

Click Cancel to exit the installation program and set the 
required environment variable.

NOTE  The installer will not allow you to continue until you set 
the environment variable.

JAVA_HOME for K2 
Server

Enter the path to the supported Java (JDK) installation and 
click Next to continue.

Welcome Click Next to proceed with the installation.

NOTE Click Previous at any time to make changes in previous 
screens. Click Cancel to exit the program.

Software License 
Agreement

Review and accept the license agreement.\

Click Next to continue.

Specify Content 
Search Engine 
Installation Path

Specify the directory in which you want to install Content 
Search Engine. The installation program will create any 
specified directories that do not already exist.

Click Next to continue.

Select Autonomy 
K2 Server Type

Choose whether to install a Master Administration Server 
(required for first-time installation) or an Administration 
Server.

Click Next to continue.

Specify 
Administration 
Server Information

This screen will appear only if you selected Administration 
Server on the Select Autonomy K2 Server Type screen.

Enter the host name and server port for the Administration 
Server.

Click Next to continue.

Specify Master 
Administration 
Server Information

Enter the host name and server port for the Master 
Administration Server.

NOTE  If you are installing a K2 Administration Server, the 
Master Administration Server must already be installed.

Click Next to continue.

K2 Operating 
System User 
Account

Enter the k2_os_user log in information and click Next to 
continue.
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• To install silently

i. Access the IBM FileNet Content Search Engine installation package and edit the 
CSE_silent_install.txt file to reflect the appropriate responses for your 
installation.

ii. Execute one of the following commands, based on your operating system:

NOTE  The following two Autonomy K2 services will be installed and started on your machine 
after the installation is complete:

• Verity K2 6.2.1 Administration Server service.

• Verity K2 Administration Web Server service (Tomcat server).

7. Review the following Content Search Engine log files for installation errors. The files are located 
in the verity directory of the install path:

• cse_install_path/verity/cse_install_log_4_5_0.txt

• cse_install_path/verity/vconfig.log

8. Set the following environment variables and place the entries in the .profile file for 
k2_os_user.

HP-UX

PATH=$PATH:/verity_install_path/k2/_hpux/bin

export PATH

SHLIB_PATH=$SHLIB_PATH:/verity_install_path/k2/_hpux/bin

export SHLIB_PATH

Review Pre-
installation 
Summary

Verify your component selections, and click Install to start 
installing software.

Install Complete Click Done to complete the installation.

Platform Command

HPUX P8CSE-4.5.0-HPUX.BIN -f CSE_silent_install.txt -i silent

AIX P8CSE-4.5.0-AIX.BIN -f CSE silent install.txt -i silent

Linux P8CSE-4.5.0-LINUX.BIN -f CSE_silent_install.txt -i 
silent

Solaris P8CSE-4.5.0-SOL.BIN -f CSE_silent_install.txt -i silent

In this screen... Perform this action...
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AIX

PATH=$PATH:/verity_install_path/k2/_rs6k43/bin

export PATH

LIBPATH=$LIBPATH:/verity_install_path/k2/_rs6k43/bin

export LIBPATH

Solaris

PATH=$PATH:/verity_install_path/k2/_ssol26/bin

export PATH

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/verity_install_path/k2/_ssol26/bin

export LD_LIBRARY_PATH

Linux

PATH=$PATH:/verity_install_path/k2/_ilnx21/bin

export PATH

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/verity_install_path/k2/_ilnx21/bin

export LD_LIBRARY_PATH

To start or stop the Autonomy K2 Services on UNIX

To manually start or stop the Autonomy K2 services, use the following commands, according to 
your environment:

HP-UX

Start services:

nohup /verity_install_path/k2/_hpux/bin/k2adminstart &

Stop services:

/verity_install_path/k2/_hpux/bin/k2adminstop

AIX

Start services:

nohup /verity_install_path/k2/_rs6k43/bin/k2adminstart &

Stop services:

/verity_install_path/k2/_rs6k43/bin/k2adminstop

Solaris

Start services:

nohup /verity_install_path/k2/_ssol26/bin/k2adminstart &

Stop services:

/verity_install_path/k2/_ssol26/bin/k2adminstop
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Linux

Start services:

nohup /verity_install_path/k2/_ilnx21/bin/k2adminstart &

Stop services:

/verity_install_path/k2/_ilnx21/bin/k2adminstop

To start or stop the Autonomy K2 Services on UNIX

To manually start or stop the Autonomy K2 services, use the following commands, according to 
your environment:

HP-UX

Start Services:

nohup /verity_install_path/k2/_hpux/bin/k2adminstart &

Stop Services:

/verity_install_path/k2/_hpux/bin/k2adminstop

AIX

Start Services:

nohup /verity_install_path/k2/_rs6k43/bin/k2adminstart &

Stop Services:

/verity_install_path/k2/_rs6k43/bin/k2adminstop

Solaris

Start Services:

nohup /verity_install_path/k2/_ssol26/bin/k2adminstart &

Stop Services:

/verity_install_path/k2/_ssol26/bin/k2adminstop

Linux

Start Services:

nohup /verity_install_path/k2/_ilnx21/bin/k2adminstart &

Stop Services:

/verity_install_path/k2/_ilnx21/bin/k2adminstop

Configure Additional K2 Administration Servers

If you add additional K2 Index Servers or Search Servers to an existing configuration, you must 
enable them through Enterprise Manager to utilize them.
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1. Log on to Enterprise Manager as the GCD Administrator and expand the Enterprise Manager 
tree.

2. Open the Index Area folder.

3. Right-click the index area that you want to add the new services to and select Properties.

4. Enable the new Search Servers as follows:

a. Click Edit Search Servers.

b. In the Search Servers Available pane, highlight any servers you want to enable for this index 
area and click Add to add the server to the Search Servers Selected list.

c. Click OK to save the settings and enable the new servers.

5. Enable the new Index Servers as follows:

a. Click Edit Index Servers.

b. In the Index Servers Available pane, Highlight any servers you want to enable for this index 
area and click Add to add the server to the Index Servers Selected list.

c. Click OK to save the settings and enable the new servers.

Move K2 Servers to new hardware
To move K2 Master Administration Server software to new hardware

To move an existing installation of the Autonomy K2 Master Administration server configuration, 
the installation must be imaged and then restored on the new hardware. If any details of the new 
configuration do not match the previous configuration, the configuration will not work.

1. Back up your Autonomy K2 Master Administration Server configuration.

2. Configure the new machine.

3. Restore your Autonomy K2 Master Administration Server installation.

To move K2 Administration Server software to new hardware

Follow this procedure to maintain your existing configuration on new hardware. Alternatively, you 
can remove the server from your configuration (see procedure below) and then create a new 
configuration after installing the K2 Administration Server software.

To move your existing configuration to new hardware, your new hardware must be configured the 
same as the previous machine. All drives and shares must be named the same and each server 
must have the same host name and IP addresses.

1. Take careful note of all aspects of your current Content Search Engine configuration. Record 
all share names, host names, server ports, and IP addresses. Record the server names and 
ports of all configured server services in the K2 Dashboard, and their locations.

2. If collections are stored on this machine, make a backup copy.
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3. Set up your new hardware and ensure the machine host name and IP address match your 
previous configuration.

4. Follow the Add Additional K2 Administration Servers procedure above to install the K2 
Administration Server software on the new machine. 

5. Create the services for this machine in the K2 Master Administration Server dashboard and 
ensure all server services are named the same as your previous configuration and ensure all 
servers created in the Autonomy K2 Dashboard are named the same and configured for the 
same ports.

NOTE  You can change the ports, but if you do so you'll need to reboot the CE server(s). The 
names of the search servers, index servers and brokers may not be changed for any items 
referenced by an index area on the CE.

6. Restore the collections to the same Root Dir Path (as specified in the index area properties) 
as before. If the collections are no longer available, mark those collections as unavailable, and 
then run a reindexing job on those collections. Otherwise copy/restore those collections via 
whatever tool you used to save them.

7. Modify the appropriate directory path entries in the Verity.cfg file.

To remove K2 Administration Servers from your Content Search Engine configuration 

1. If collections were stored on the machine you want to remove:

a. Determine which K2 Server will hold the collections.On that machine, create a new 
collections directory and temp directory and assign the appropriate permissions. For details, 
see “Create a Content Search Engine collections directory” on page 162.

NOTE  See the index area properties (Root Dir Path) for the collections location for the 
appropriate index area.

b. Modify the appropriate directory path entries in the verity.cfg file.

c. Move the collections to the new location.

2. Modify the index area to use the index servers and search servers of the machine to which the 
collections were moved.

3.  Access the K2 Dashboard and remove the appropriate K2 Administration server from the 
dashboard configuration.
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Install the COM compatibility layer (CCL)
The option to install the COM compatibility layer is available as part of the IBM FileNet Content 
Engine installer.

To install the COM Compatibility Layer (CCL) from the IBM FileNet Content Engine installer

1. In the Choose Components dialog, select .NET Client, then click Next.

2. In the .NET API COM Compatibility Layer (CCL) Server URL dialog, enter a valid URL for the 
CCL (for example, http://localhost:9080/wsi/FNCEWS40MTOM/). Note that if you do not enter a 
valid URL, the CCL will not be installed.

If you do not install the CCL during the initial installation, you have the option of installing later by 
running the CE installer again. You can also install the CCL anytime by using the Configuration 
Manager tool.



 Upgrade and configure IBM FileNet P8 Platform 315

IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE

Upgrade and configure IBM FileNet P8 Platform

This section contains the following tasks:

• “Upgrade IBM FileNet P8 documentation” on page 317

• “Upgrade and configure Content Engine and Content Search Engine” on page 325

• “Upgrade and configure Process Engine” on page 497

• “Upgrade and configure Application Engine” on page 543

• “Upgrade add-on components” on page 604
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Upgrade IBM FileNet P8 documentation
Peform the tasks in this section to upgrade your IBM FileNet P8 documentation installation. See 
the following topics:

• “Overview” on page 317

• “Refresh IBM FileNet P8 documentation without uninstalling” on page 318

• “Update IBM FileNet P8 documentation by uninstalling and reinstalling” on page 319

• “Update help search index” on page 322

• “Start and verify IBM FileNet P8 documentation web site” on page 324
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Overview
There are two methods available for updating an existing IBM FileNet P8 Documentation 
installation:

• “Refresh IBM FileNet P8 documentation without uninstalling” on page 318

Use this option if you have IBM FileNet P8 3.5.x or 4.0.x documentation installed without any 
expansion product help.

• “Update IBM FileNet P8 documentation by uninstalling and reinstalling” on page 319

Use this option if you have IBM FileNet P8 3.5.x or 4.0.x documentation installed with 
expansion product help included (for example, Process Analyzer, Process Simulator, IBM 
FileNet P8 eForms, Content Federation Services, or Records Manager).

Optionally, as of the IBM FileNet P8 4.5 documentation release, you can install and index web-
posted auxiliary documentation, such as the IBM FileNet P8 Release Notes, to have it 
included in the same search functionality. For a complete list of such documentation, see 
"Gather auxiliary documentation" in the Plan and Prepare Your Environment for IBM FileNet 
P8 guide.

NOTES 

• As of the IBM FileNet P8 4.0 release, you can deploy the IBM FileNet P8 documentation on a 
Content Engine server because it, like the Application Engine server, is a J2EE application 
server. If you are an existing 3.5.x customer and wish to install the 4.5 documentation on a 
Content Engine server or a new application server, you must perform a new installation rather 
than an upgrade. Therefore, use the install instructions in the following topic:

– “Install IBM FileNet P8 Platform documentation (All)” on page 23

• The refresh procedure assumes the following:

– You wish to replace the 3.5.x or 4.0.x documentation at the existing location with updated 
files.

– You are familiar with your application server’s procedures for reinstalling or redeploying 
web site applications.

• Before updating any IBM FileNet P8 documentation, review the IBM FileNet P8 Hardware and 
Software Requirements for the required software versions and updates for third-party 
software. To download this guide from the IBM support page, see “Access IBM FileNet 
documentation, compatibility matrices, and fix packs” on page 20.

• Although some versions of BEA WebLogic support deployment of WAR-file-based web 
applications, you cannot deploy ecm_help.war on this application server platform. You must 
instead use the fully expanded IBM FileNet P8 documentation directory (ecm_help) structure. 
Otherwise, the searches within the IBM FileNet P8 documentation will not work and you will 
receive null pointer errors.
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• In environments where Windows NTFS is used, there is a 256 character limit on file and 
directory names (directory depth). When trying to delete an existing IBM FileNet P8 
documentation web site, you might encounter access denied errors. See Microsoft Knowledge 
Base article http://support.microsoft.com/?kbid=320081 for more information.

• Before installing the latest IBM FileNet P8 documentation, be sure to back up your existing 
IBM FileNet P8 documentation web site according to your site and application server 
procedures. This precaution will allow you to restore the IBM FileNet P8 documentation web 
site quickly if for any reason you have to back out of or delay your IBM FileNet P8 software 
upgrade.

• If you install any IBM FileNet P8 expansion products as part of your upgrade (for example, 
Process Analyzer, Process Simulator, IBM FileNet P8 eForms, Content Federation Services, 
or Records Manager), be aware that:

– You must copy the associated help for all expansion products onto the updated IBM 
FileNet P8 documentation server.

– You must update the index for the help Search feature as documented below. This action 
ensures that searches return all expected results. If you add help for other expansion 
products later, you must re-run the procedure below for updating the help Search index.

– You must also update the help Search index if you update the installed IBM FileNet-based 
help that you have customized or translated as part of your own application development. 

• Any time you update the documentation search index, a backup of the files in the existing 
Index/core directory will be automatically copied to the Index/IndexOld subdirectory. You 
can reapply these backed-up files to the core subdirectory (after first removing the new files 
created there) if you need to return to your previous indexed state.

• Depending on your operating system (Windows or UNIX) and application server version 
(WebSphere, WebLogic, or JBoss), some screens will be slightly different than those 
documented in the procedures listed below.

Refresh IBM FileNet P8 documentation without 
uninstalling
You can refresh an existing IBM FileNet 3.5.x or 4.0.x P8 documentation installation by simply 
copying the newer documentation files over the existing files, and then reindexing for Search.

Use this option only if you have IBM FileNet 3.5.x or 4.0.x documentation installed without any 
expansion product help.

NOTES

• If you have FileNet 3.5.x or 4.0.x documentation installed with expansion product help 
included, use the procedure “Update IBM FileNet P8 documentation by uninstalling and reinstalling” 
on page 319.

• This refresh procedure requires that you copy the expanded ecm_help directory from the IBM 
FileNet P8 Documentation package over the existing documentation. This stipulation applies 
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to all application servers, even those, such as WebSphere, that required a WAR file for initial 
deployment of the existing 3.5.x or 4.0.x documentation.

To refresh the IBM FileNet P8 documentation without first uninstalling

1. Stop the application server (or IBM FileNet P8 documentation site) on which the existing 
documentation is deployed so that no processes can access the documentation.

2. On the IBM FileNet P8 documentation application server, locate the deployed IBM FileNet P8 
documentation directory, and back up (or copy to a safe location) the files located in:

UNIX

deployment_path/ecm_help/search/index/core

Windows

deployment_path\ecm_help\search\index\core

3. Locate the 4.5 IBM FileNet P8 Platform documentation package from the installation software.

4. Copy the expanded ecm_help directory from the package over the deployed ecm_help 
directory.

5. Download the latest web-posted updates of installation and upgrade guide PDFs for the IBM P8 
Platform and various expansion products. Optionally, also download any auxiliary 
documentation to the ecm_help/installation/web directory on the IBM FileNet P8 Platform 
documentation server. Check the documentation page on the IBM Information Management 
support page on www.ibm.com for the latest versions of these guides. See “Access IBM FileNet 
documentation, compatibility matrices, and fix packs” on page 20 for details.

6. Continue as follows:

• If you added expansion product documentation, you will need to update the search index. Go on to 
the procedure in the following topic, “Update help search index” on page 322.

• If you have no further documentation to install, and you did not install any expansion products, 
then go on to the procedure in the topic “Start and verify IBM FileNet P8 documentation web site” 
on page 324.

Update IBM FileNet P8 documentation by uninstalling 
and reinstalling
Use this option if you have IBM FileNet P8 3.5.x or P8 4.0.x documentation installed with 
expansion product help included, for example: Process Analyzer, Process Simulator, IBM FileNet 
P8 eForms, Content Federation Services, or Records Manager.
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The following procedures explain how to completely remove an existing IBM FileNet P8 
documentation site from the application server before rebuilding the site. Follow the procedure for 
you application server type:

• “To update the IBM FileNet P8 documentation on WebSphere application servers” on page 320

• “To update the IBM FileNet P8 documentation on WebLogic application servers” on page 321

• “To update the IBM FileNet P8 documentation on JBoss application servers” on page 321

To update the IBM FileNet P8 documentation on WebSphere application servers

1. Verify the WebSphere application server is running, and then start the WebSphere 
administrative console.

2. From the WebSphere administrative console, Uninstall the existing documentation site.

3. From the initial install location, delete the IBM FileNet P8 documentation installed files, leaving 
the ecm_help directory in place.

4. Copy the IBM FileNet P8 ecm_help.war file from the IBM FileNet P8 documentation package to 
an appropriate location on the local hard drive.

5. From the WebSphere administrative console, deploy the ecm_help.war file using ecm_help as 
the Context Root.

6.  For each expansion product, copy the expanded ecm_help directory from the package over the 
deployed ecm_help directory.

NOTE  Repeat this step for each of your expansion products. You can copy more than one 
expansion product documentation set to the documentation application server (for example, 
FileNet P8 eForms and FileNet Content Federation Services). When you are finished, you end 
up with one ecm_help directory structure containing the core documentation set and one or 
more sets of expansion product documentation files. 

7. Download the latest web-posted updates of installation and upgrade guide PDFs for the IBM P8 
Platform and various expansion products. Optionally, also download any auxiliary 
documentation to the ecm_help/installation/web directory on the IBM FileNet P8 Platform 
documentation server. Check the documentation page on the IBM Information Management 
support page for the latest versions of these guides. See “Access IBM FileNet documentation, 
compatibility matrices, and fix packs” on page 20 for details.

8. Restart the IBM FileNet P8 documentation site.

9. Continue as follows:

• If you have added expansion products you will need to update the search index add on 
documentation for expansion products, go on to the procedure in the following topic, “Update help 
search index” on page 322.

• If you have no further documentation to install, then go on to the procedure in the topic “Start and 
verify IBM FileNet P8 documentation web site” on page 324.
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To update the IBM FileNet P8 documentation on WebLogic application servers

1. Verify the WebLogic application server is running, and then start the WebLogic Administration 
Console.

2. From the WebLogic Administration Console, Stop the existing documentation site and Delete the 
IBM FileNet P8 documentation files, leaving the ecm_help directory in place. 

3. Copy the ecm_help directory structure from the IBM FileNet P8 documentation package to the 
location of the original IBM FileNet P8 documentation.

4. For each expansion product, copy the expanded ecm_help directory from the package over the 
deployed ecm_help directory.

NOTE  Repeat this step for each of your expansion products. You can copy more than one 
expansion product documentation set to the documentation application server (for example, 
FileNet P8 eForms and FileNet Content Federation Services). When you are finished, you end 
up with one ecm_help directory structure containing the core documentation set and one or 
more sets of expansion product documentation files. 

5. Download the latest web-posted updates of installation and upgrade guide PDFs for the IBM 
FileNet P8 Platform and various expansion products. Optionally, also download any auxiliary 
documentation to the ecm_help/installation/web directory on the IBM FileNet P8 Platform 
documentation server. Check the documentation page on the IBM Information Management 
support page for the latest versions of these guides. See “Access IBM FileNet documentation, 
compatibility matrices, and fix packs” on page 20 for details.

6. From the WebLogic Administration Console, restart the IBM FileNet P8 documentation site.

7. Continue as follows:

• If you have added expansion product documentation, you will need to update the search index. Go 
on to the procedure in the following topic, “Update help search index” on page 322.

• If you have no further documentation to install, then go on to the procedure in the topic “Start and 
verify IBM FileNet P8 documentation web site” on page 324.

To update the IBM FileNet P8 documentation on JBoss application servers

1. Shut down the JBoss application server.

2. From the initial install location, delete the IBM FileNet P8 documentation installed files, leaving 
the ecm_help directory in place.

3. Delete the temporary working directory for the IBM FileNet P8 Platform documentation from the 
JBoss_home/server/server_name/work/jboss.web/localhost directory.

4. Access the IBM FileNet P8 Platform documentation package.

5. Copy the ecm_help directory from the package to the existing location on the application server 
(from where you just removed the old version of the directory).

6. For each expansion product, copy the expanded ecm_help directory from the package over the 
deployed ecm_help directory.
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NOTE  Repeat this step for each of your expansion products. You can copy more than one 
expansion product documentation set to the documentation application server before 
continuing (for example, Process Analyzer, Process Simulator, IBM FileNet P8 eForms, 
Content Federation Services, or Records Manager) so you end up with one ecm_help 
directory containing multiple sets of expansion product files added to it.

7. Download the latest web-posted updates of installation and upgrade guide PDFs for the IBM 
FileNet P8 Platform and various expansion products. Optionally, also download any auxiliary 
documentation to the ecm_help/installation/web directory on the IBM FileNet P8 Platform 
documentation server. Check the documentation page on the IBM Information Management 
support page on www.ibm.com for the latest versions of these guides. See “Access IBM FileNet 
documentation, compatibility matrices, and fix packs” on page 20 for details.

8. Continue as follows:

• If you have added expansion products you will need to update the search index. Go on to the 
procedure in the following topic, “Update help search index” on page 322.

• If you have no further documentation to install, then go on to the procedure in the topic “Start and 
verify IBM FileNet P8 documentation web site” on page 324.

Update help search index
Perform this procedure to update the Search index after you have installed all the IBM FileNet P8 
Platform and expansion product documentation on a supported application server.

To update the help Search index

NOTE  Perform this procedure only if you refreshed the core documentation, or you have installed 
expansion product (or customized application) help or auxiliary documentation onto your IBM 
FileNet P8 documentation application server. Otherwise, skip to “Start and verify IBM FileNet P8 
documentation web site” on page 324.

1. Make sure that the server on which the documentation is deployed/installed is stopped, and that 
no processes are accessing the documentation.

2. Make sure you have copied the help for all your various expansion products, or optionally 
downloaded updated documentation and auxiliary documentation, to a designated application 
server location containing the IBM FileNet P8 help. Otherwise, you will have to repeat this 
procedure if you add new help later.

3. Open a command prompt or terminal on the application server.

4. From the command line, navigate to the search subdirectory under your ecm_help root 
directory.
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5. If it has not been done already, modify the search-indexing script file that is appropriate for your 
operating system as follows:

UNIX

Add execute permissions (chmod 755) on the indexFiles.sh file because it is set to read-only 
in the documentation package.

Windows

Set permissions on the indexFiles.bat file, because it is set to read-only in the documentation 
package.

6. Using a text editor, open the search-indexing script file that is appropriate for your operating 
system:

UNIX

indexFiles.sh

Windows

indexFiles.bat

7. If necessary for your environment, set the JAVA_HOME variable in the script file with the path to 
your Java Runtime Environment (JRE) installation location.

NOTE The Java JRE installation subdirectory can be user-defined, so substitute your actual 
location, as appropriate.

8. Save your changes and close the text editor.

9. From the ecm_help/search directory, run the updated search-indexing script file that is 
appropriate for your server operating system: 

UNIX

indexFiles.sh

Window 

indexFiles.bat

NOTE As you run the search-indexing script file, you might notice periodic Parse Abort errors. 
You can ignore these error conditions, as they are benign and do not affect the overall 
indexing process.

10. Go on to the procedure in the next topic “Start and verify IBM FileNet P8 documentation web site” 
on page 324.
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Start and verify IBM FileNet P8 documentation web site
Perform this procedure after you have updated (and, if necessary, reindexed) the IBM FileNet P8 
documentation on a supported application server.

To verify the IBM FileNet P8 documentation web site

1. Start the IBM FileNet P8 documentation server. Use the appropriate instructions provided with 
your application server.

2. Verify that the application server and the new IBM FileNet P8 documentation web site are 
running. From your web browser, access the URL for your web environment, using your 
documentation server name, and port number, as in these examples:

WebSphere

http://yourdocserver:9080/ecm_help/

WebLogic

http://yourdocserver:7001/ecm_help/

JBoss

http://yourdocserver:8080/ecm_help/

The help system opens.

NOTE Apply the URL for your application server when it is time to configure the online help 
location for the various IBM FileNet P8 components, either while running installation programs 
or later via site preferences settings (for example, in Workplace or Workplace XT).
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Upgrade and configure Content Engine and 
Content Search Engine
Complete the following upgrade tasks that apply to your existing version (3.5.x or 4.0.x) of Content 
Engine and Content Search Engine.

For upgrades from 3.5.x

1. To complete the pre-upgrade configuration, complete Task 1 on page 327.

2. To install and upgrade Content Engine software, complete Task 2a on page 333.

3. To upgrade standalone instances (if any) of FileNet Enterprise Manager, complete Task 3 on 
page 342.

4. To install Content Engine software updates that have become available since the initial release 
of version 4.5, complete Task 4 on page 344.

5. To install ECM Centera SDK library files, complete Task 10 on page 416 only if Centera fixed 
content devices will be in your upgraded IBM FileNet P8 environment, and Centera fixed content 
devices are not in your existing environment.

6. To configure upgraded Content Engine instances, complete Task 5a on page 345.

7. To install the latest Content Search Engine Client files on Content Engine servers, complete 
Task 6 on page 390.

8. To install the latest Process Engine Client files on Content Engine servers, complete Task 7 on 
page 391.

9. To deploy the Content Engine instances, complete Task 8 on page 395.

10. If you will have Tivoli Storage Manager fixed content devices, complete one of the following 
tasks, depending on the type of application server where you have deployed Content Engine:

• To install Tivoli Storage Manager client (WebSphere), complete Task 9a on page 409.

• To install Tivoli Storage Manager client (WebLogic), complete Task 9b on page 411.

• To install Tivoli Storage Manager client (JBoss), complete Task 9c on page 414.

11. To complete the Content Engine post-deployment steps, complete Task 11 on page 420.

12. To configure storage devices, complete Task 13 on page 424.

13. To establish the FileNet P8 domain and Global Configuration Data (GCD), complete Task 14 on 
page 427.

14. To create the object store data sources for your existing object stores, complete Task 15 on page 
435.

15. To upgrade Content Search Engine software from version 3.5.x, complete Task 16a on page 451.

16. To upgrade Content Engine data, complete Task 17 on page 480.

17. To complete the upgrade of Content Search Engine software from version 3.5.x, do Task 18 on 
page 494.
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For upgrades from 4.0.x

1. To verify that all P8 activity has completed, complete Task 1 on page 327

2. To upgrade ECM Centera SDK library files, complete Task 10 on page 416 only if Centera fixed 
content devices will be in your upgraded IBM FileNet P8 environment, and either of the following 
conditions apply:

• Centera fixed content devices are not in your existing environment.

• Centera fixed devices are in your existing environment, your existing version of Content Engine is 
4.0, and you have not installed any fix packs.

3. To upgrade Content Engine software, complete Task 2b on page 337.

4. To install Content Engine software updates that have become available since the initial release 
of version 4.5, complete Task 4 on page 344.

5. To install ECM Centera SDK library files, complete Task 10 on page 416 only if Centera fixed 
content devices will be in your upgraded IBM FileNet P8 environment, and Centera fixed content 
devices are not in your existing environment.

6. To configure upgraded Content Engine instances, complete Task 5b on page 380.

7. To install the latest Content Search Engine Client files on Content Engine servers, complete 
Task 6 on page 390.

8. To install the latest Process Engine Client files on Content Engine servers, complete Task 7 on 
page 391.

9. To deploy upgraded Content Engine instances, complete Task 8 on page 395.

10. If you will have Tivoli Storage Manager fixed content devices, complete one of the following 
tasks, depending on the type of application server where you have deployed Content Engine:

• To install Tivoli Storage Manager library paths (WebSphere), complete Task 9a on page 409.

• To install Tivoli Storage Manager library paths (WebLogic), complete Task 9b on page 411.

• To install Tivoli Storage Manager library paths (JBoss), complete Task 9c on page 414.

11. Complete Task 12 on page 423 if you are staging your IBM FileNet P8 upgrade over a period of 
time and not upgrading one or more of the other IBM FileNet P8 server components at this 
time.

12. To upgrade standalone instances (if any) of FileNet Enterprise Manager, complete Task 3 on 
page 342.

13. To upgrade Content Search Engine software from version 4.0.x, complete Task 16b on page 470.

14. To upgrade Content Engine data, complete Task 17 on page 480.
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Task 1: Complete pre-upgrade Content Engine 
configuration
The procedures in this topic prepare Content Engine for an upgrade from its current version: 3.5.x 
or 4.0.x. Each procedure title indicates whether it applies to upgrades from 3.5.x, 4.0.x, or both.

To verify that all in-progress event actions have finished (3.5.x or 4.0.x)

1. Start Enterprise Manager if it is not already running.

2. In each object store to be upgraded, perform the following substeps:

a. In the left pane, under the object store icon, right-click the Search Results folder, and 
choose New Search.

b. In the Content Engine Query Builder dialog box, choose QueueItem from the Select From 
Table list.

c. Retain all default settings and click OK. (Click Yes at the prompt for a WHERE clause.)

3. If any event items exist in the queue, you will see them in the Query Status dialog box. To 
remove unwanted items, perform the following substeps:

a. Set up the same search as in Step 2; but this time select the Delete Objects check box in the 
Action tab of the Search dialog box, before clicking OK. 

b. Click OK again to confirm the deletion.

To verify that publishing requests have been completed (3.5.x or 4.0.x)

1. Start Enterprise Manager if it is not already running.

2. In each object store to be upgraded, perform the following steps:

a. Expand the Publishing folder and click Queue and choose View > All requests.

b. Verify that the queue (right pane) of publishing requests is empty. If the queue is not empty, 
do the following:

i. Wait until all publish requests in the In Queue state or In Work state are processed.

ii. If any publish requests are in the In Error state, contact your publishing administrator for 
the appropriate action to take (such as retrying after correcting the error or just deleting 
the item).

3. In the left pane, under the object store icon, right-click the Search Results folder, and choose 
New Search.

4. In the Content Engine Query Builder dialog box, choose PublishRequest from the Select From 
Table list.

5. Retain all default settings and click OK, and then click Yes at the prompt for a WHERE clause.

6. Delete any publishing requests displayed in the Query Status window.
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To verify that all in-progress Content Engine transactions involving content files have finished 
(3.5.x only)

Before upgrading Content Engine, you must verify that all pending content transactions, indexing 
requests, and fixed-content migration requests have completed. Use the Content Resource 
Manager utility, as shown in the following steps.

CAUTION All transactions and requests must have completed before you upgrade Content Engine; 
otherwise the upgrade will fail.

1. On each machine where Content Engine 3.5.x is installed, complete the following steps, using 
the Windows Services program (in the Windows Computer Management snap-in):

a. Start File Store Service if it is not already running.

b. Stop Object Store Service and Content Cache Service.

2. On a machine where Content Engine 3.5.x is installed, start the ce_install_path\RMU.exe 
utility.

3. In the Content Resource Manager Utility window, complete the following steps:

a. Navigate to Statistics > Transactions and note the values of Total prepared phase 1, Total 
committed, and Total aborted.

b. Navigate to Statistics > Can't Do Queue and note the value of Current items in the can't do 
queue.

c. Add the values of Total committed and the Total aborted. If the sum equals the value of Total 
prepared phase 1, and the value of Current items in the can't do queue is zero, then all 
content transactions have completed.

d. Navigate to Indexing Service > Index Control. If the value of Current index queue files is 
zero, then all pending indexing requests have completed.

e. Navigate to Fixed Content > Migration Queuing. If the value of Current number in queue is 
zero, then all fixed-content migration requests have completed.

4. If all activity checked in Step 3 has completed, then stop File Store Service on each machine 
where Content Engine 3.5.x is installed, and continue at “To stop and disable all Content-Engine-
related services on all servers in the FileNet P8 domain (3.5.x only)” on page 329; otherwise, 
complete the following steps:

a. Exit from the Content Resource Manager utility.

b. Wait a few minutes, and then return to Step 1 on page 328.

To update the trace log file location (4.0.x only)

If you changed the path to the application server (for example, by upgrading the application server 
software) after deploying version 4.0.x of Content Engine, you must now update the location of the 
trace log file, p8_server_trace.log; otherwise, trace logging will go to the wrong location, or 
the file will not get created at all.

To update the trace log file location, perform the following steps:
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1. Start Enterprise Manager by double-clicking the FileNet Enterprise Manager icon on the 
desktop, or by choosing Start > All Programs > FileNet P8 Platform > Enterprise Manager.

2. Navigate to the level (domain, site, virtual server, or server instance) at which trace logging is 
configured, right-click the node at that level, and choose Properties.

3. Click the Trace Control tab, and perform the following substeps:

a. If the current value of the Log File Output Location parameter is not consistent with the 
version of the application server, edit the value as needed.

The following table shows default locations (at the server instance level) for the trace log 
file, starting at install_root, the installation path for the application server.

b. Click OK.

To stop and disable all Content-Engine-related services on all servers in the FileNet P8 domain 
(3.5.x only)

1. On each machine where version 3.5.x of Content Engine Server software is installed, log on with 
local administrator permissions.

2. Stop and disable the following services using the Windows Services program (in the Windows 
Computer Management snap-in):

• Apache2

• Content Engine Content Cache Service

• Content Engine File Store Service

• Content Engine Object Store Service

• FileNet Publishing HTML Plug-in Service

• FileNet Publishing PDF Plug-in Service

• Process Services Manager

• Wasp Server for Java

3. Right-click the Apache services monitor in the Windows system tray and click Exit.

Application
Server Type

Path to Trace Log File

WebSphere install_root/profiles/profile_name/FileNet/server_name/
p8_server_trace.log

WebLogic install_root/user_projects/domains/domain_name/FileNet/
server_name/p8_server_trace.log

JBoss install_root/bin/FileNet/server_name/p8_server_trace.log
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To verify the directory permissions on file stores (3.5.x only)

• If the application server on which Content Engine Server 4.5 is to be deployed is running on 
Windows, then give the following users write permission to the root directory where a 3.5.x file 
store is located. (This procedure is necessary to allow conversion to a 4.5 file storage area 
during upgrade.)

– The user running the Upgrader tool (config_mgr_user)

– The user running the application server (ce_appserver_admin). For WebSphere on 
Windows, this user is a service log-on account)

 For details on required accounts and related permissions, see “Accounts for Content Engine upgrade” 
on page 193 in Plan and Prepare Your Environment for IBM FileNet P8.

To update the Vital Product Data (VPD) script (4.0.x and Solaris only)

Perform the following steps only if Content Engine Server is at version 4.0.1 on a Solaris machine, 
a non-root user installed the current version of Content Engine Server, and a different non-root 
user will upgrade Content Engine Server to version 4.5:

1. Navigate to the $HOME/InstallShield//Universal/FileNet/CE/Gen1/_vpddb/ directory.

2. Create a backup of the vpd.script file and then edit the vpd.script file as follows:

a. Change all instances of $REG_CE_LOCATIONS$ to the same Content Engine Server 
installation directory. For example,

/opt/FileNet/ContentEngine

b. Change all the occurrences of $40Installeruser$ to the same Content Engine Server 
installation directory. For example,

/opt/FileNet/ContentEngine

c. Save your edits.

To create the webSphereDefaultIsolationLevel custom property (4.0.x and WebSphere only)

Perform this procedure only if all the following conditions apply to your IBM FileNet P8 
environment:

• Content Engine is deployed on WebSphere.

• Your database type is DB2 or Microsoft SQL Server.

• You intend to upgrade Content Engine from version 4.0.1.

This procedure creates the webSphereDefaultIsolationlevel custom property, which needs to exist 
for the GCD XA and non-XA data sources before you can upgrade Content Engine to version 4.5.

1. Log on to the WebSphere administrative console.

2. Navigate to Resources > JDBC > Data sources.

3. Click the GCD non-XA data source (for example, FNGCDDS)
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4. In the Configuration tab, click Custom properties under Additional Properties.

5. Click New, and create a property as follows:

a. Set the name to webSphereDefaultIsolationLevel.

b. Set the value to 2.

c. Set the type to java.lang.String.

6. Click Apply and save your changes to the Master configuration.

7. Perform Step 4 through Step 6 for the GCD XA data source (for example, FNGCDSXA).

To verify permissions on the Engine-DS.xml file (4.0.x and JBoss only)

If you deployed Content Engine Server 4.0.x on JBoss application server, perform the following 
steps:

1. Navigate to the directory containing the Engine-DS.xml file. The typical location for this file is:

UNIX

/opt/FileNet/ContentEngine/lib

Windows

C:\Program Files\FileNet\ContentEngine\lib

2. Ensure that the Engine-DS.xml file has both read and write permissions.

To back up the database (3.5.x or 4.0.x)

1. Use your existing database backup solution to back up the Content Engine object store 
databases. 

2. Back up the GCD.

• For upgrades from 4.0.x, backup the GCD database. FNGCDDB is the default name of the GCD 
database. 

• For upgrades from 3.5.x, make a backup copy of the 3.5.2 GCD file. The default location is 
C:\Program Files\FileNet\Content Engine\sysconfig\sysinit\sysinit.dat. 

To shut down CFS Exporter (CFS 4.0 only)

If your system includes Content Federation Services (CFS) 4.0.x, you must shut down the CFS 
Exporter before upgrading Content Engine to 4.5. Leave the Exporter shut down until you upgrade 
CFS to 4.5. Refer to the IBM FileNet Content Federation Services Installation and Upgrade Guide 
for instructions.

To verify that object store names do not conflict with reserved words (3.5.x and 4.0.x)

Verify completion of the task in the topic "FileNet P8 Administrator upgrade tasks" in Plan and 
Prepare Your Environment for IBM FileNet P8 that describes how you must change any class or 
property names in 3.5.x or 4.0.x object stores that are the same as any of the names listed in the 
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reserved word appendix, as the upgrade tool will check for naming conflicts and require you to 
change the names before proceeding. See “New Content Engine classes and properties” on page 702 
for the list of names.
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Task 2a: Upgrade Content Engine software from 3.5.x
If you are upgrading from Content Engine 3.5.x on Windows, you can upgrade and continue to use 
Windows, or you can migrate your Content Engine to UNIX. In either case, you must prepare the 
Content Engine application for deployment and then upgrade the object store data. 

Migrating your Content Engine version 3.5.x on a Windows server to Content Engine version 4.5 
on UNIX requires a new installation of Content Engine on your UNIX machine. You also need 
access to a Windows machine to install and run FileNet Enterprise Manager and the Upgrader 
tool.

Use a procedure in this topic to install or upgrade the following Content Engine components 
interactively or silently:

• Content Engine Server

• Configuration Manager

• .NET Clients (including FileNet Enterprise Manager)

• Content Engine Upgrader

• FileNet Deployment Manager

If the Content Engine installer detects an existing Content Engine installation, the software will be 
upgraded. 

On UNIX-based or Windows-based application servers, you can install Content Engine Server, 
Configuration Manager, or both. The remaining components require a Windows-based machine. 

Install the .NET Clients software only on machines where you intend to run either the FileNet 
Enterprise Manager administrative client or a customized client application.

The Content Engine Upgrader is required only to upgrade Content Engine and Content Search 
Engine data from an earlier version.

The FileNet Deployment Manager is an optional component that you can use to deploy test 
systems into full production. See the IBM FileNet P8 help topic Application Deployment > Get Started 
with FileNet Deployment Manager for details.

The application server must be the Deployment Manager node (WebSphere) or the Administrator 
node (WebLogic) if you are installing in a managed environment.

To install or upgrade Content Engine

1. Log on to the application server as ce_install_user. For details on required accounts and related 
permissions, see “Accounts for Content Engine upgrade” on page 193 in Plan and Prepare Your 
Environment for IBM FileNet P8.

2. Access the Content Engine software package.

3. (Red Hat Linux only) On the machine where you are going to run the Content Engine installation 
program, install the shared library libstdc++.so.5:

a. Access the Red Hat 5 installation software.
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b. Install the package compat-libstdc++-33-3.2.3-61.i386.rpm, which contains the 
necessary shared library libstdc++.so.5.

4. Start the Content Engine installation. For information on parameter values, see “Installation and 
upgrade worksheet” on page 229 in Plan and Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls), perform the following actions to quickly see 
only the installation properties you must specify for the Content Engine installation 
program:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select CE Installer.

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Upgrade."

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

• To install interactively:

i. Run one of the following commands in the software package, depending on your 
operating system:

ii. Complete the installation program wizard using the following table:

Platform Command

AIX P8CE-4.5.0-AIX.BIN

HPUX P8CE-4.5.0-HPUX.BIN

HPUXi P8CE-4.5.0-HPUXI.BIN

Linux P8CE-4.5.0-LINUX.BIN

Solaris P8CE-4.5.0-SOL.BIN

Windows P8CE-4.5.0-WIN.EXE

zLinux P8CE-4.5.0-ZLINUX.BIN

In this screen... Perform this action...

Welcome Click Next to proceed with the installation.

NOTE Click Previous at any time to make changes in previous 
screens. Click Cancel to exit the program.

Software License 
Agreement

Review and accept the license agreement, and then click 
Next.
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• To install silently:

i. Open the CE_silent_install.txt file in the software package for editing.

ii. Set the parameter values in the CE_silent_install.txt file for your site.

Choose 
Components

(Windows only)

Set the Install Set value to Content Engine and choose the 
components you want to install:

• Content Engine Server

Choose this component to install the Content Engine and 
Configuration Manager software on this machine.

• .NET Clients and FileNet Enterprise Manager

Choose both components if you want to administer 
Content Engine from this machine.

• Tools

Choose Tools to install Configuration Manager, 
Deployment Manager, and Content Engine Upgrader 
software on this machine.

NOTE If you choose Content Engine Server, you don’t 
need Tools unless you also want Deployment Manager 
and Content Engine Upgrader on this machine.

Click Next to continue.

Choose Install Path Specify the directory where you want to install Content 
Engine. If the directory (or its parent) does not exist, the 
program will create it. Click Next to continue.

Specify 
Documentation 
URL

Optionally specify the URL for the IBM FileNet P8 
documentation that you deployed in “Install IBM FileNet P8 
Platform documentation (All)” on page 23, and then click Next.

.NET API COM 
Compatibility Layer 
(CCL) URL

(Windows only)

Specify a URL for the .NET API COM Compatibility Layer if 
you intend to configure CCL for a custom COM-based FileNet 
P8 application, and then click Next.

Review Pre-
Installation 
Summary

Verify your component selections, and click Install to start 
installing software.

Installation 
Complete

Click Done.

In this screen... Perform this action...
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For information on the Content Engine parameter values, see “Installation and upgrade 
worksheet” on page 229 in Plan and Prepare Your Environment for IBM FileNet P8.

iii. Run one of the following commands in the software package, depending on your 
operating system:

5. Check for errors in the ce_install_log_4_5_0.txt Content Engine error log file.

6. If you are migrating to UNIX, repeat Step 1 through Step 5 on a Windows machine to install 
FileNet Enterprise Manager and the Upgrader tool. Both programs are required to complete 
the upgrade.

7. Continue at “Upgrade FileNet Enterprise Manager” on page 342.

Platform Command

AIX P8CE-4.5.0-AIX.BIN -f CE_silent_install.txt –i silent

HPUX P8CE-4.5.0-HPUX.BIN -f CE_silent_install.txt –i silent

HPUXi P8CE-4.5.0-HPUXI.BIN -f CE_silent_install.txt –i silent

Linux P8CE-4.5.0-LINUX.BIN -f CE_silent_install.txt –i silent

Solaris P8CE-4.5.0-SOL.BIN -f CE_silent_install.txt –i silent

Windows P8-CE-4.5.0-WIN.EXE -f CE_silent_install.txt –i silent

zLinux P8CE-4.5.0-ZLINUX.BIN -f CE_silent_install.txt –i silent
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Task 2b: Upgrade Content Engine software from 4.0.x
Use the procedure in this topic to upgrade Content Engine version 4.0.x to version 4.5. On UNIX-
based application servers, you will upgrade Content Engine Server and install Configuration 
Manager. On Windows-based application servers, you will upgrade or install anew some or all of 
the following components.

• Content Engine Server

• Configuration Manager

• .NET Clients (including FileNet Enterprise Manager)

• Content Engine Upgrader

• FileNet Deployment Manager

NOTE FileNet Deployment Manager is used to migrate system data from a test environment to a 
production environment. See the IBM FileNet P8 help topic Application Deployment > Get Started 
with FileNet Deployment Manager for details.

CAUTION You must upgrade components that are in your existing installation, and you can install 
new components as well.

To upgrade Content Engine software from 4.0.x

1. Log on to the application server as ce_upgrade_user, the user who installed the current version 
of Content Engine.

If the user who installed the current version is different than the user who will install the new 
version, make sure that you have completed the steps in “Assign directory permissions for 
Content Engine upgrade for 4.0.x to 4.5 on UNIX” on page 186 in Plan and Prepare Your 
Environment for IBM FileNet P8. That topic also contains information on changing the 
installation user.

Continue with one of the following steps:

• For AIX, where the root user installed CE 4.0.x, and ce_upgrade_user is non-root, continue at 
Step 2.

• All others, continue at Step 5.

2. (AIX only) Shut down the application server.

3. (AIX only) Start the Content Engine uninstall.

• To uninstall interactively

i. Navigate to the _uninst2 directory in the current version of Content Engine and run the 
following command to uninstall it:

uninstaller.bin

ii. Wait until the uninstall completes before continuing.
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 2b: Upgrade Content Engine software from 4.0.x
To upgrade Content Engine software from 4.0.x

338
• To uninstall silently:

i. Navigate to the _uninst2 directory in the current Content Engine installation.

ii. Either edit the CE_silent_uninstall.txt sample response file or record your own response 
file. To record a response file, run the following command:

CAUTION Do not specify a path to the response file within the Content Engine install 
directory; if you do this, the file will be deleted.

./uninstaller.bin -options -record path_to_response_file

iii. Run the uninstall program.

./uninstaller.bin -options path_to_response_file -silent

iv. Wait until the uninstall completes before continuing.

4. (AIX only) Uninstall Content Search Engine Client Updater.

5. Make a back up copy of the ce_install_path/servers.xml file in a temporary location, such 
as /tmp.

6. (Windows only) Navigate to the ContentEngine directory and give Full Control permission to 
the user who will install the new version of Content Engine.

7. Log off the Content Engine Server machine, and log back on as ce_upgrade_user, the user who 
will install the new version.

8. Copy the new version of the Content Engine software package to a temporary location on the 
the application server, such as /tmp (UNIX) or C:\Temp (Windows) and set the current 
directory to that location.

9. Start the Content Engine upgrade (which will uninstall the current version if needed). For 
information on parameter values, see “Installation and upgrade worksheet” on page 229 in Plan 
and Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls), perform the following actions to quickly see 
only the installation properties you must specify for the Content Engine installation 
program:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select CE Installer.

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Upgrade."

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

• To upgrade interactively:
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i. Run one of the following commands in the software package, depending on your 
operating system, and then follow the instructions on the wizard screens:

ii. Complete the installation program wizard using the following table:

Platform Command

AIX P8CE-4.5.0-AIX.BIN

HPUX P8CE-4.5.0-HPUX.BIN

HPUXi P8CE-4.5.0-HPUXi.BIN

Linux P8CE-4.5.0-LINUX.BIN

Solaris P8CE-4.5.0-SOL.BIN

Windows P8CE-4.5.0-WIN.EXE

zLinux P8CE-4.5.0-ZLINUX.BIN

In this screen... Perform this action...

Welcome Click Next to proceed with the installation.

NOTE Click Previous at any time to make changes in previous 
screens. Click Cancel to exit the program.

Software License 
Agreement

Review and accept the license agreement, and then click 
Next.

Choose 
Components

(Windows only)

Set the Install Set value to Content Engine and choose the 
components you want to install:

• Content Engine Server

Choose this component to install the Content Engine and 
Configuration Manager software on this machine.

• .NET Clients and FileNet Enterprise Manager

Choose both components if you want to administer 
Content Engine from this machine.

• Tools

Choose Tools to install Configuration Manager, 
Deployment Manager, and Content Engine Upgrader 
software on this machine.

NOTE If you choose Content Engine Server, you don’t 
need Tools unless you also want Deployment Manager 
and Content Engine Upgrader on this machine.

Click Next to continue.
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• To upgrade silently:

i. Run one of the following commands in the software package, depending on your 
operating system:

Choose Install Path Specify the directory where you want to install Content 
Engine. If the directory (or its parent) does not exist, the 
program will create it. Click Next to continue.

Specify 
Documentation 
URL

Optionally specify the URL for the IBM FileNet P8 
documentation that you deployed in “Install IBM FileNet P8 
Platform documentation (All)” on page 23, and then click Next.

.NET API COM 
Compatibility Layer 
(CCL) URL

(Windows only)

Specify a URL for the .NET API COM Compatibility Layer if 
you intend to configure CCL for a custom COM-based FileNet 
P8 application, and then click Next.

Review Pre-
Installation 
Summary

Verify your component selections, and click Install to start 
installing software.

Installation 
Complete

Selecting the Launch Configuration Manager check box will 
automatically start Configuration Manager, the tool for 
configuring Content Engine.

WARNING Do not select the check box if version 4.0.x of 
Content Engine is a cluster deployment, or a non-cluster 
Network Deployment (WebSphere only). In this case you 
must edit the servers.xml file first (see “Edit the servers.xml 
file” on page 381), and then manually start Configuration 
Manager.

Click Done.

Platform Command

AIX P8CE-4.5.0-AIX.BIN -f CE_silent_install.txt –i silent

HPUX P8CE-4.5.0-HPUX.BIN -f CE_silent_install.txt –i silent

HPUXi P8CE-4.5.0-HPUXI.BIN -f CE_silent_install.txt –i silent

Linux P8CE-4.5.0-LINUX.BIN -f CE_silent_install.txt –i silent

Solaris P8CE-4.5.0-SOL.BIN -f CE_silent_install.txt –i silent

Windows P8-CE-4.5.0-WIN.EXE -f CE_silent_install.txt –i silent

zLinux P8CE-4.5.0-ZLINUX.BIN -f CE_silent_install.txt –i silent

In this screen... Perform this action...
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10. Check for errors in the Content Engine error log file ce_install_path/
ce_install_log_4_5_0.txt, where ce_install_path is the installation path to Content Engine.

11. Copy the servers.xml file from its temporary location back to its previous location if you 
performed Step 2 on page 337.

12. Continue at “Upgrade FileNet Enterprise Manager” on page 342.
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Task 3: Upgrade FileNet Enterprise Manager
If you did not upgrade FileNet Enterprise Manager as part of a Content Engine upgrade, perform 
the following procedure to upgrade FileNet Enterprise Manager interactively or silently.

To upgrade FileNet Enterprise Manager

1. On the machine where you will upgrade FileNet Enterprise Manager, log on as a member of the 
Local Administrators group or the Power Users group.

2. Access the Content Engine software package.

3. Start the FileNet Enterprise Manager installation. For information on parameter values, see 
“Installation and upgrade worksheet” on page 229 in Plan and Prepare Your Environment for IBM 
FileNet P8

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls), perform the following steps to quickly see 
only the installation properties you must specify for the Content Engine installation 
program:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select CE installer.

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Upgrade."

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

The wizard will uninstall the current version of the software and install the new version in the 
same location.

• To install interactively:

i. Run the following command in the software package:

P8CE-4.5.0-Win.exe

ii. Complete the installation program wizard using the following table:

In this screen... Perform this action...

Welcome Click Next to proceed with the installation.

NOTE Click Previous at any time to make changes in previous 
screens. Click Cancel to exit the program.

Software License 
Agreement

Review and accept the license agreement, and then click 
Next.

Choose 
Components

Set the Install Set value to Content Engine, select the check 
boxes for .NET Clients and FileNet Enterprise Manager, and 
clear all the other check boxes. Click Next to continue.
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• To install silently:

i. Open the silent_installer.properties file in the software package for editing.

ii. Set the parameter values in the silent_installer.properties file for your site. Be 
sure to set the CHOSEN_INSTALL_FEATURE_LIST parameter value to:

DotNetClients,AdminTools

iii. Save your edits.

iv. Run the following command in the software package:

P8-CE-4.5.0-WIN.EXE -f silent_installer.properties

Choose Install Path Specify the directory where you want to install FileNet 
Enterprise Manager. If the directory (or its parent) doesn’t 
exist, the program will create it. Click Next to continue.

Specify 
Documentation 
URL

Optionally specify the URL for the IBM FileNet P8 
documentation that you deployed in “Install IBM FileNet P8 
Platform documentation (All)” on page 23, and then click Next.

.NET API COM 
Compatibility Layer 
(CCL) URL

Specify a URL for the .NET API COM Compatibility Layer if 
you intend to configure CCL for a custom COM-based FileNet 
P8 application, and then click Next.

Review Pre-
Installation 
Summary

Verify your component selections, and click Install to start 
installing FileNet Enterprise Manager.

Installation 
Complete

Click Done.

In this screen... Perform this action...
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Task 4: Install Content Engine software updates
Perform the procedure in this topic for each Content Engine instance to install software updates, 
fix packs or interim fixes.

To install the Content Engine software updates

1. For instructions on how to obtain the latest Content Engine software updates, see “Access IBM 
FileNet documentation, compatibility matrices, and fix packs” on page 20.

2. Open the readmes for the Content Engine software updates and perform the installation 
procedures in the readmes on each Content Engine instance.

If you installed an instance into a managed environment, perform the procedure on the 
Deployment Manager node (WebSphere) or the Administrator node (WebLogic).

3. Continue at one of the following topics:

• If you are upgrading from version 3.5.x, continue at “Configure Content Engine instances 
upgraded from 3.5.x” on page 345.

• If you are upgrading from version 4.0.x and do not need to upgrade your Process Engine client 
files to 4.5, continue with “Configure Content Engine instances upgraded from 4.0.x” on page 380.
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Task 5a: Configure Content Engine instances 
upgraded from 3.5.x
You will configure and deploy all of your Content Engine application instances with the new 
Configuration Manager tool. Configuration Manager prepares the Content Engine application for 
deployment on the application server. A single Content Engine application application instance 
equates to one deployed applcation on your application server. 

You first provide and apply information about your Content Engine application environment, and 
then later deploy the application. You can configure multiple instances before deploying any of 
them, or you can configure and deploy one instance at a time. This topic provides the 
configuration steps for one instance. Repeat the steps as need for additional  instances in your 
environment.

You use Configuration Manager to configure the following information for the Content Engine 
application instance:

• Application server properties

• Java Database Connectivity (JDBC) data source properties

• Directory service (LDAP) provider

• Content Engine bootstrap properties

TIPS

• (WebSphere only) For best results, configure no more than one Content Engine instance in a 
WebSphere profile.

• Use the command line version of Configuration Manager if either of these conditions is true:

– Your system is Novell SUSE Linux Enterprise 9. You can configure Content Engine only 
with the command line.

– You need an accessible software version of Configuration Manager for people with 
disabilities to use.

• To avoid having to perform the Content Engine deployment task multiple times, perform the 
deployment after you install the Process Engine Client files. Configuration Manager can 
deploy a Content Engine application any time after you configure the other properties for your 
environment. However, you must also perform the deployment task after you install or update 
the Process Engine Client files on the Content Engine server. The Process Engine Client files 
are required if you set up Process Engine in your IBM FileNet P8 environment.
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Grant permissions to the Configuration Manager user
Complete the following procedure to grant the file and directory permissions required by 
config_mgr_user, the user who will run Configuration Manager.

To grant permissions to the Configuration Manager user

1. Log on to the application server where you installed Content Engine as ce_install_user. For 
details on required accounts and related permissions, see “Accounts for Content Engine upgrade” 
on page 193 in Plan and Prepare Your Environment for IBM FileNet P8.

2. Navigate to ce_install_path/tools/configure, which contains both the command line and 
graphical user interfaces of Configuration Manager, where ce_install_path is the path in 
which you installed Content Engine.

3. Grant config_mgr_user execute permission (UNIX) or read & execute permission (Windows) on 
the executable file of the interface of Configuration Manager you intend to use:

• To enable use of the graphical user interface, grant permission to one of the following files in the 
configuration/CMUI directory:

UNIX

cmui

Windows

cmui.exe

• To enable use of the command line interface, grant permission to one of the following files in the 
configuration directory:

UNIX 

configmgr.sh

Windows 

configmgr.bat

4. Grant write permission to the directory where you want Configuration Manager to place the 
configuration XML files it will generate.

If you are not going to specify this directory when you run Configuration Manager, grant write 
permission on the default directory, ce_install_path/tools/configure/profiles.

5. Log off the Content Engine application server, and log back on as config_mgr_user, the 
Configuration Manager user.
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Configure instances using the graphical user interface
In this subtopic you will configure a Content Engine application on an application server using the 
graphical user interface version of Configuration Manager. Use the information in your installation 
worksheet to specify the values for the parameters required to configure Content Engine. For more 
information, see “Installation and upgrade worksheet” on page 229 of Plan and Prepare Your 
Environment for IBM FileNet P8.

For more information on the properties and values you set in the Configuration Manager, roll your 
mouse over the property name to view the tool tip help for the property. Refer to the appendix 
“Configuration Manager user interface reference” on page 645 for complete information on using the 
graphical user interface.

To set the GUI password save option (optional)

• By default, Configuration Manager does not save passwords that you enter in the graphical 
user interface. That is, each time you start Configuration Manager and open a saved profile, 
you will need to specify any passwords required by the tasks and for the application server 
properties. For more information on password handling and how to change the password save 
setting, see “Handling passwords in Configuration Manager” on page 643.

To start Configuration Manager

Complete one of the following steps, depending on the operating system that runs on the machine 
where you installed Content Engine:

UNIX

• Run the following command:

ce_install_path/tools/configure/CMUI/cmui

Windows

• Complete one of the following actions:

– Double-click the FileNet Configuration Manager desktop shortcut. 

– Select Start > All Programs > IBM FileNet P8 Platform > FileNet Configuration Manager. 

– Run ce_install_path\tools\configure\CMUI\cmui.exe.
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To create a configuration profile

• Start the Create New Configuration Profile wizard by selecting File > New Configuration 
Profile, and use the information in your worksheet to specify the values for the parameters in 
the wizard screens. For more information, see “Installation and upgrade worksheet” on page 229 
of Plan and Prepare Your Environment for IBM FileNet P8.

In this screen... Perform this action...

Configuration Profile 
Information

• Provide the following information for the profile:

– Enter a name for the profile. The name must be valid as 
a directory name for your operating system. 
Configuration Manager will create a directory with the 
profile name for storing the configuration files 
associated with this profile. For more information of 
profiles, see “Configuration profile concepts” on page 639 in 
the Configuration Manager reference appendix.

– Specify the directory for the profile. Either type in the full 
path to the profile directory or click Browse to locate the 
directory. The default path is 
ce_install_path/tools/configure/profiles, 

where ce_install_path is the location where Content 
Engine is installed.

• Click Next.

• Choose an application server type for the profile. Select 
WebSphere, JBoss, or WebLogic, and then click Next.

NOTE  If you click Finish instead of Next, you will need to 
come back later to supply the required application server 
properties before you can run the configuration tasks.

• Continue at one of the following screens:

– “Set Application Server Properties for WebSphere” on 
page 349

– “Set Application Server Properties for JBoss” on page 350

– “Set Application Server Properties for WebLogic” on 
page 350
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Set Application Server 
Properties for 
WebSphere

This screen is displayed only if you selected WebSphere in the 
previous screen. 

• Provide the following information for the application server:

– Select the application server version from the list.

– Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the 
directory. 

– Enter the application server administrator user name. 
Use the directory service user account that has been 
assigned the application server administrative role. This 
account is used to manage the application server 
domain/profile, to configure the data sources and 
connection pools for the Global Configuration Database 
(GCD), and to deploy the Content Engine application. If 
Administrative Security is already enabled, use an 
existing administrative user account.

– Enter the application server administrative password. 
The password will be encrypted for you. For more 
information on passwords,  see “Handling passwords in 
Configuration Manager” on page 643.

– Enter the application server SOAP port number.

– Enter the name of the WebSphere application server 
cell where Content Engine will be deployed.

– If you have already configured WebSphere to use 
certificates, clear the “Do not use SSL certificates for 
server communications” check box. Otherwise, leave the 
check box selected. 

IMPORTANT  If you select this check box, your 
WebSphere settings for communicating with other 
servers, such as Application Engine, will change.

• Click Next.

• Continue with “Select the tasks that you want included in the 
Configuration Profile” on page 351.

In this screen... Perform this action...
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Set Application Server 
Properties for JBoss

This screen is displayed only if you selected JBoss in the 
previous screen. 

• Provide the following information for the application server:

– Select the application server version from the list.

– Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the 
directory. 

– Enter the name of the JBoss application server name 
where Content Engine will be deployed.

• Click Next.

• Continue with “Select the tasks that you want included in the 
Configuration Profile” on page 351.

Set Application Server 
Properties for WebLogic

This screen is displayed only if you selected WebLogic in the 
previous screen.

• Provide the following information for the application server:

– Select the application server version from the list.

– Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the 
directory. 

– Enter the application server administrator user name. 
Use the directory service user account that has been 
assigned the application server administrative role. This 
account is used to manage the application server 
domain/profile, to configure the data sources and 
connection pools for the Global Configuration Database 
(GCD), and to deploy the Content Engine application. If 
Administrative Security is already enabled, use an 
existing administrative user account.

– Enter the application server administrative password. 
The password will be encrypted for you. For more 
information on passwords,  see “Handling passwords in 
Configuration Manager” on page 643.

– Enter the application server SOAP port number.

– Enter the machine name or the IP address of the local 
host for the application server host. 

– Enter the fully qualified path to the WebLogic application 
server user projects directory, or click Browse to locate 
the directory.

In this screen... Perform this action...
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 5a: Configure Content Engine instances upgraded from 3.5.x
To configure a Content Engine instance using the Configuration Manager graphical user interface

351
The profile you created is displayed as an icon in the profile pane (left-hand pane), along with  
icons for the tasks you selected.

To configure a Content Engine instance using the Configuration Manager graphical user interface

You will complete the configuration tasks in this procedure to prepare the Content Engine 
application instance for deployment on the application server. You will complete the deploy task 
later in “Deploy Content Engine instances” on page 78.

You can perform the configuration tasks in any order, and you do not need to complete work on 
one configuration task before starting another. You can save your edits, switch between tasks, 
close the tasks, and reopen tasks as needed. 

1. Start or stop the application server, depending on its type:

WebSphere and WebLogic

Start the application server if it is not already running.

JBoss

Stop the application server.

2. Refer to your installation worksheet to specify the values for the properties required for Step 3 
through Step 5. For more information, see “Installation and upgrade worksheet” on page 229 of 
Plan and Prepare Your Environment for IBM FileNet P8.

Set Application Server 
Properties for WebLogic 
(continued)

– Enter the WebLogic application server domain name 
where Content Engine will be deployed.

– Enter the name of the WebLogic application server 
name where Content Engine will be deployed.

• Click Next.

• Continue with “Select the tasks that you want included in the 
Configuration Profile” on page 351.

Select the tasks that you 
want included in the 
Configuration Profile

• Select the tasks that you want to include in this profile. For a 
new Content Engine installation, you need to complete all 
four configuration tasks: 

– Configure JDBC Data Sources

– Configure LDAP

– Configure Bootstrap

– Deploy Application.

• Click Finish to create the profile and save the application 
server properties.

In this screen... Perform this action...
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HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), complete the following actions to quickly see only the 
properties you must specify for Configuration Manager:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select one of these Configuration Manager options:

– CM: Configure JDBC Data Sources

– CM: Configure LDAP

– CM: Configure Bootstrap Properties

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify Setup Type contains "Installation".

• Click the AutoFilter drop-down arrow in all other column headers and select (All).

3. Provide property values for the JDBC data sources for the Global Configuration Database 
(GCD).

a. If your configuration profile is not open in Configuration Manager, open the profile you 
created earlier in “To create a configuration profile” on page 348.

b. Right-click Configure JDBC Data Sources in the profile pane, and select Edit Selected Task. 

c. Provide the property values for your database, using the appropriate table for your database 
type:

DB2® for Linux, UNIX, Windows

In this field... Provide this information...

JDBC driver name Select “DB2 Universal JDBC Driver” from the list. The 
remaining properties and values that you need to supply for 
your data source configuration depend on the type of driver 
that you select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the Global Configuration Database (GCD) 
tablespace or database. For example, FNGCDDS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the Global Configuration Database (GCD) tablespace 
or database. For example, FNGCDDSXA.

Database server name The host name of the machine where the database software 
is installed.

Database port number The port number used by the DB2 database instance in 
which you create tablespaces for the Global Configuration 
Database (GCD) and object stores.

Database name The name of the Global Configuration Database (GCD) 
database. 
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DB2 for z/OS®

Database user name The name of the DB2 Global Configuration Database (GCD) 
tablespace user.

Database password The password for the DB2 Global Configuration Database 
(GCD) tablespace user. The tool encrypts the password for 
you.

Enter the password again in the Confirm field.

JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the Global 
Configuration Database (GCD) and do not want the 
Configuration Manager tool to create them for you, leave 
this field blank and clear the Task enabled check box.

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the Global 
Configuration Database (GCD) and do not want the 
Configuration Manager tool to create them for you, leave 
this field blank and clear the Task enabled check box.

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step e. The default is 
enabled.

In this field... Provide this information...

JDBC driver name Select “DB2 for z/OS Universal JDBC Driver” from the list. 
The remaining properties and values that you need to supply 
for your data source configuration depend on the type of 
driver that you select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the Global Configuration Database (GCD) 
tablespace or database. For example, FNGCDDS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the Global Configuration Database (GCD) tablespace 
or database. For example, FNGCDDSXA.

In this field... Provide this information...
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Database server name The host name of the machine where the database software 
is installed.

Database port number The port number used by the DB2 database instance in 
which you create tablespaces for the Global Configuration 
Database (GCD) and object stores.

Database name The name of the Global Configuration Database (GCD) 
database instance name. 

Database user name The name of the DB2 Global Configuration Database (GCD) 
tablespace user.

Database password The password for the DB2 Global Configuration Database 
(GCD) tablespace user. The tool encrypts the password for 
you.

Enter the password again in the Confirm field.

JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the Global 
Configuration Database (GCD) and do not want the 
Configuration Manager tool to create them for you, leave 
this field blank and clear the Task enabled check box.

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the Global 
Configuration Database (GCD) and do not want the 
Configuration Manager tool to create them for you, leave 
this field blank and clear the Task enabled check box.

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step e. The default is 
enabled.

In this field... Provide this information...
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MS SQL Server

In this field... Provide this information...

JDBC driver name Select “Microsoft JDBC Driver 2005” from the list. The 
remaining properties and values that you need to supply for 
your data source configuration depend on the type of driver 
that you select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the Global Configuration Database (GCD) 
tablespace or database. For example, FNGCDDS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the Global Configuration Database (GCD) tablespace 
or database. For example, FNGCDDSXA.

Database server name The host name of the machine where the database software 
is installed.

Database port number The port number used by the SQL Server database instance 
in which you create databases for the Global Configuration 
Database (GCD) and object stores.

Database name The name of the Global Configuration Database (GCD) 
database for SQL Server.

Database user name The name of the SQL Server user with administrative rights 
to the Global Configuration Database (GCD) database.

Database password The password for the SQL Server user with administrative 
rights to the Global Configuration Database (GCD) 
database. The tool encrypts the password for you.

Enter the password again in the Confirm field.

JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the Global 
Configuration Database (GCD) and do not want the 
Configuration Manager tool to create them for you, leave 
this field blank and clear the Task enabled check box.
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Oracle

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the Global 
Configuration Database (GCD) and do not want the 
Configuration Manager tool to create them for you, leave 
this field blank and clear the Task enabled check box.

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step e. The default is 
enabled.

In this field... Provide this information...

JDBC driver name Select “Oracle JDBC Driver” from the list. The remaining 
properties and values that you need to supply for your data 
source configuration depend on the type of driver that you 
select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the Global Configuration Database (GCD) 
tablespace or database. For example, FNGCDDS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the Global Configuration Database (GCD) tablespace 
or database. For example, FNGCDDSXA.

Database server name The host name of the machine where the database software 
is installed.

Database port number The port number used by the Oracle database instance in 
which you create tablespaces for the Global Configuration 
Data (GCD) and object stores.

Database name The SID of the Oracle database containing the Global 
Configuration Database (GCD) tablespace.

Database user name The name of the Oracle Global Configuration Database 
(GCD) tablespace owner.

Database password The password for the Oracle Global Configuration Database 
(GCD) tablespace owner. The tool encrypts the password 
for you.

Enter the password again in the Confirm field.

In this field... Provide this information...
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JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the Global 
Configuration Database (GCD) and do not want the 
Configuration Manager tool to create them for you, leave 
this field blank and clear the Task enabled check box.

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the Global 
Configuration Database (GCD) and do not want the 
Configuration Manager tool to create them for you, leave 
this field blank and clear the Task enabled check box.

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step e. The default is 
enabled.

In this field... Provide this information...
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Oracle RAC

In this field... Provide this information...

JDBC driver name Select “Oracle JDBC Driver (RAC support)” from the list. The 
remaining properties and values that you need to supply for 
your data source configuration depend on the type of driver 
that you select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the Global Configuration Database (GCD) 
tablespace or database. For example, FNGCDDS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the Global Configuration Database (GCD) tablespace 
or database. For example, FNGCDDSXA.

Database server name 
RAC node 1

The host name of the machine where the database software 
is installed for node 1.

Database port number 
RAC node 1

The port number used by the Oracle database instance in 
which you create tablespaces for the Global Configuration 
Data (GCD) and object stores.

Database server name 
RAC node 2

The host name of the machine where the database software 
is installed for node 2.

Database port number 
RAC node 2

The port number used by the Oracle database instance in 
which you create tablespaces for the Global Configuration 
Data (GCD) and object stores.

Database service name The SID of the Oracle database containing the Global 
Configuration Database (GCD) tablespace.

Oracle RAC retries The number of retries for Oracle RAC.

Oracle RAC delay The amount of delay for Oracle RAC.

Database user name The name of the Oracle Global Configuration Database 
(GCD) tablespace owner.

Database password The password for the Oracle Global Configuration Database 
(GCD) tablespace owner. The tool encrypts the password 
for you.

Enter the password again in the Confirm field.
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d. Select File > Save to save your changes.

e. Apply the JDBC property settings by right-clicking Configure JDBC Data Sources in the 
profile pane, and select Run Task. Running the configuration task can take a few minutes. 
The task execution status messages are displayed in the Console pane below the JDBC task 
properties.

TIP  You can check the completion status of a task by right-clicking Configure JDBC Data 
Sources in the profile pane, and select Check Task Status.

f. Close the Configure JDBC Data Sources task pane.

IMPORTANT  In this step, you created the Global Configuration Database (GCD) data sources. 
You will create the initial object store data sources later in “Create the data sources for an object 
store” on page 117.

4. Provide property values for the LDAP provider:

a. Right-click Configure LDAP in the profile pane, and select Edit Selected Task. 

b. Provide the property values for your LDAP provider, using the appropriate table for your 
provider.

JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the GCD and 
do not want the Configuration Manager tool to create them 
for you, leave this field blank and clear the Task enabled 
check box.

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the Global Configuration Database (GCD). The file name 
must end with -ds.xml. For example, gcd-ds.xml. 

If you have already created data sources for the GCD and 
do not want the Configuration Manager tool to create them 
for you, leave this field blank and clear the Task enabled 
check box.

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step e. The default is 
enabled.

In this field... Provide this information...
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Tivoli Directory Server

In this field... Provide this information...

Directory service 
provider type

Select “Tivoli Directory Server” from the list. The remaining 
properties and values that you need to supply for your LDAP 
configuration depend on the type of provider that you select.

Directory service server 
host name

The directory server host name. The short name, full name, 
or IP address of the system that hosts the directory service. 

Directory service port 
number

The port number configured on the directory server host for 
communicating with the directory server.

Directory service bind 
user name

The fully qualified distinguished name of the LDAP bind 
user for authenticating to Tivoli Directory Server.

Directory service bind 
user password

The password used by the LDAP bind user to authenticate 
to the directory server. The tool encrypts the password for 
you.

Enter the password again in the Confirm field.

User base distinguished 
name

The fully qualified distinguished name of the container for 
starting a user search in Tivoli Directory Server. For example, 
ou=FileNet,dc=FNCE.

User filter The filter used by the bind user when searching for users in 
a directory server. For example, (cn={0}).

Group base 
distinguished name

JBoss only. The distinguished name of the container for 
starting a group search in a directory server. For example, 
cn=users,dc=mydomain.

Group filter The filter used by the bind user when searching for groups 
in a directory server. For example, (member={1}).

User name attribute WebSphere and WebLogic. The attribute by which a user 
logs on to Tivoli Directory Server. For example, cn.

Group attribute An attribute in a Tivoli Directory Server entry that identifies 
the group. For example, cn.

Administrative console 
user name

WebSphere only. A user account that has access to log on 
to the application server administration console. If your site 
uses a Federated LDAP registry, this account name must be 
a unique user across all federated realms. 

WebSphere LDAP 
repository type

WebSphere only. The WebSphere Application Server LDAP 
repository type. Valid values are: StandaloneLDAP / 
FederatedLDAP.
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Federated Repository 
virtual realm name

WebSphere only. The name of the WebSphere Application 
Server Federated Repositories virtual realm.  The default 
name is defaultWIMFileBasedRealm.

Overwrite existing 
repository

WebSphere only. Select this check box to overwrite any 
existing LDAP repository entries. Clear this check box to 
preserve any existing LDAP repository entries. This setting 
is valid only when the Standard deployment type is selected 
for the WebSphere LDAP repository type field. The default is 
clear (do not overwrite).

Set as current active 
user registry

WebSphere only. This setting specifies whether to set the 
LDAP repository as the active user registry. When set to 
true, the LDAP information will be used to configure the 
active user registry.

Script WebSphere and WebLogic. The fully qualified path to the 
LDAP configuration task script. The task script filename 
depends on the application server type selected.

WebSphere Application Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWSLDAP.tcl  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWSLDAP.tcl.

WebLogic Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWLLDAP.py  or  
c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWLLDAP.py.

Temporary Directory WebSphere and WebLogic. The fully qualified path to a 
temporary directory to be used by the configuration task. 
For example, /opt/FileNet/ContentEngine/tools/
configure/tmp  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp.

SSL enabled WebSphere and WebLogic. This setting specifies whether 
Secure Sockets Layer (SSL) is enabled or disabled. Select 
the check box to enable SSL. Clear the check box to  
disable SSL. The default is disabled.

In this field... Provide this information...
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Active Directory

Kerberos support JBoss only. Select the Kerberos support check box if 
Kerberos authentication is used. Clear the check box if 
Kerberos authentication is not used. The default is Kerberos 
not supported.

Task enabled Select the Task enabled check box to execute the configure 
LDAP task later in Step d. The default is enabled.

In this field... Provide this information...

Directory service 
provider type

Select “Active Directory” from the list. The remaining 
properties and values that you need to supply for your LDAP 
configuration depend on the type of provider that you select.

Directory service server 
host name

The directory server host name. The short name, full name, 
or IP address of the system that hosts the directory service. 

Directory service port 
number

The port number configured on the directory server host for 
communicating with the directory server.

Directory service bind 
user name

The fully qualified distinguished name of the LDAP bind 
user for authenticating to Active Directory.

Directory service bind 
user password

The password used by the LDAP bind user to authenticate 
to the directory server. The tool encrypts the password for 
you.

Enter the password again in the Confirm field.

User base distinguished 
name

The fully qualified distinguished name of the container for 
starting a user search in Active Directory. For example, 
ou=FileNet,dc=FNCE.

User filter The filter used by the bind user when searching for users in 
Active Directory. For example, (sAMAccountName={0}).

Group base 
distinguished name

JBoss only. The distinguished name of the container for 
starting a group search in a directory server. For example, 
cn=users,dc=mydomain.

Group filter The filter used by the bind user when searching for groups 
in a directory server. For example, (member={1}).

User name attribute WebSphere and WebLogic. The attribute by which a user 
logs on to Tivoli Directory Server. For example, cn.

Group attribute An attribute in a Tivoli Directory Server entry that identifies 
the group. For example, cn.

In this field... Provide this information...
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Administrative console 
user name

WebSphere only. A user account that has access to log on 
to the application server administration console. If your site 
uses a Federated LDAP registry, this account name must be 
a unique user across all federated realms. 

WebSphere LDAP 
repository type

WebSphere only. The WebSphere Application Server LDAP 
repository type. Valid values are: StandaloneLDAP / 
FederatedLDAP.

Federated Repository 
virtual realm name

WebSphere only. The name of the WebSphere Application 
Server Federated Repositories virtual realm.  The default 
name is defaultWIMFileBasedRealm.

Overwrite existing 
repository

WebSphere only. Select this check box to overwrite any 
existing LDAP repository entries. Clear this check box to 
preserve any existing LDAP repository entries. This setting 
is valid only when the Standard deployment type is selected 
for the WebSphere LDAP repository type field. The default is 
clear (do not overwrite).

Set as current active 
user registry

WebSphere only. This setting specifies whether to set the 
LDAP repository as the active user registry. When set to 
true, the LDAP information will be used to configure the 
active user registry.

Script WebSphere and WebLogic. The fully qualified path to the 
LDAP configuration task script. The task script filename 
depends on the application server type selected.

WebSphere Application Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWSLDAP.tcl  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWSLDAP.tcl.

WebLogic Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWLLDAP.py  or  
c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWLLDAP.py.

Temporary Directory WebSphere and WebLogic. The fully qualified path to a 
temporary directory to be used by the configuration task. 
For example, /opt/FileNet/ContentEngine/tools/
configure/tmp  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp.

In this field... Provide this information...
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ADAM or AD LDS

SSL enabled WebSphere and WebLogic. This setting specifies whether 
Secure Sockets Layer (SSL) is enabled or disabled. Select 
the check box to enable SSL. Clear the check box to  
disable SSL. The default is disabled.

Kerberos support JBoss only. Select the Kerberos support check box if 
Kerberos authentication is used. Clear the check box if 
Kerberos authentication is not used. The default is Kerberos 
not supported.

Task enabled Select the Task enabled check box to execute the configure 
LDAP task later in Step d. The default is enabled.

In this field... Provide this information...

Directory service 
provider type

Select “ADAM or AD LDS” from the list. The remaining 
properties and values that you need to supply for your LDAP 
configuration depend on the type of provider that you select.

Directory service server 
host name

The directory server host name. The short name, full name, 
or IP address of the system that hosts the directory service. 

Directory service port 
number

The port number configured on the directory server host for 
communicating with the directory server.

Directory service bind 
user name

The fully qualified distinguished name of the LDAP bind 
user for authenticating to ADAM or AD LDS.

Directory service bind 
user password

The password used by the LDAP bind user to authenticate 
to the directory server. The tool encrypts the password for 
you.

Enter the password again in the Confirm field.

User base distinguished 
name

The fully qualified distinguished name of the container for 
starting a user search in ADAM or AD LDS. For example, 
ou=FileNet,dc=FNCE.

User filter The filter used by the bind user when searching for users in 
a directory server. For example, (cn={0}).

Group base 
distinguished name

JBoss only. The distinguished name of the container for 
starting a group search in a directory server. For example, 
cn=users,dc=mydomain.

Group filter The filter used by the bind user when searching for groups 
in a directory server. For example, (member={1}).

In this field... Provide this information...
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User name attribute WebSphere and WebLogic. The attribute by which a user 
logs on to Tivoli Directory Server. For example, cn.

Group attribute An attribute in a Tivoli Directory Server entry that identifies 
the group. For example, cn.

Administrative console 
user name

WebSphere only. A user account that has access to log on 
to the application server administration console. If your site 
uses a Federated LDAP registry, this account name must be 
a unique user across all federated realms. 

WebSphere LDAP 
repository type

WebSphere only. The WebSphere Application Server LDAP 
repository type. Valid values are: StandaloneLDAP / 
FederatedLDAP.

Federated Repository 
virtual realm name

WebSphere only. The name of the WebSphere Application 
Server Federated Repositories virtual realm.  The default 
name is defaultWIMFileBasedRealm.

Overwrite existing 
repository

WebSphere only. Select this check box to overwrite any 
existing LDAP repository entries. Clear this check box to 
preserve any existing LDAP repository entries. This setting 
is valid only when the Standard deployment type is selected 
for the WebSphere LDAP repository type field. The default is 
clear (do not overwrite).

Set as current active 
user registry

WebSphere only. This setting specifies whether to set the 
LDAP repository as the active user registry. When set to 
true, the LDAP information will be used to configure the 
active user registry.

Script WebSphere and WebLogic. The fully qualified path to the 
LDAP configuration task script. The task script filename 
depends on the application server type selected.

WebSphere Application Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWSLDAP.tcl  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWSLDAP.tcl.

WebLogic Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWLLDAP.py  or  
c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWLLDAP.py.

In this field... Provide this information...
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eDirectory

Temporary Directory WebSphere and WebLogic. The fully qualified path to a 
temporary directory to be used by the configuration task. 
For example, /opt/FileNet/ContentEngine/tools/
configure/tmp  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp.

SSL enabled WebSphere and WebLogic. This setting specifies whether 
Secure Sockets Layer (SSL) is enabled or disabled. Select 
the check box to enable SSL. Clear the check box to  
disable SSL. The default is disabled.

Kerberos support JBoss only. Select the Kerberos support check box if 
Kerberos authentication is used. Clear the check box if 
Kerberos authentication is not used. The default is Kerberos 
not supported.

Task enabled Select the Task enabled check box to execute the configure 
LDAP task later in Step d. The default is enabled.

In this field... Provide this information...

Directory service 
provider type

Select eDirectory from the list. The remaining properties and 
values that you need to supply for your LDAP configuration 
depend on the type of provider that you select.

Directory service server 
host name

The directory server host name. The short name, full name, 
or IP address of the system that hosts the directory service. 

Directory service port 
number

The port number configured on the directory server host for 
communicating with the directory server.

Directory service bind 
user name

The fully qualified distinguished name of the LDAP bind 
user for authenticating to eDirectory.

Directory service bind 
user password

The password used by the LDAP bind user to authenticate 
to the directory server. The tool encrypts the password for 
you.

Enter the password again in the Confirm field.

User base distinguished 
name

The fully qualified distinguished name of the container for 
starting a user search in eDirectory. For example, 
ou=FileNet,dc=FNCE.

User filter The filter used by the bind user when searching for users in 
a directory server. For example, (cn={0}).

In this field... Provide this information...
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Group base 
distinguished name

JBoss only. The distinguished name of the container for 
starting a group search in a directory server. For example, 
cn=users,dc=mydomain.

Group filter The filter used by the bind user when searching for groups 
in a directory server. For example, (member={1}).

User name attribute WebSphere and WebLogic. The attribute by which a user 
logs on to Tivoli Directory Server. For example, cn.

Group attribute An attribute in a Tivoli Directory Server entry that identifies 
the group. For example, cn.

Administrative console 
user name

WebSphere only. A user account that has access to log on 
to the application server administration console. If your site 
uses a Federated LDAP registry, this account name must be 
a unique user across all federated realms. 

WebSphere LDAP 
repository type

WebSphere only. The WebSphere Application Server LDAP 
repository type. Valid values are: StandaloneLDAP / 
FederatedLDAP.

Federated Repository 
virtual realm name

WebSphere only. The name of the WebSphere Application 
Server Federated Repositories virtual realm.  The default 
name is defaultWIMFileBasedRealm.

Overwrite existing 
repository

WebSphere only. Select this check box to overwrite any 
existing LDAP repository entries. Clear this check box to 
preserve any existing LDAP repository entries. This setting 
is valid only when the Standard deployment type is selected 
for the WebSphere LDAP repository type field. The default is 
clear (do not overwrite).

Set as current active 
user registry

WebSphere only. This setting specifies whether to set the 
LDAP repository as the active user registry. When set to 
true, the LDAP information will be used to configure the 
active user registry.

In this field... Provide this information...
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Sun Java Directory Server

Script WebSphere and WebLogic. The fully qualified path to the 
LDAP configuration task script. The task script filename 
depends on the application server type selected.

WebSphere Application Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWSLDAP.tcl  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWSLDAP.tcl.

WebLogic Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWLLDAP.py  or  
c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWLLDAP.py.

Temporary Directory WebSphere and WebLogic. The fully qualified path to a 
temporary directory to be used by the configuration task. 
For example, /opt/FileNet/ContentEngine/tools/
configure/tmp  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp.

SSL enabled WebSphere and WebLogic. This setting specifies whether 
Secure Sockets Layer (SSL) is enabled or disabled. Select 
the check box to enable SSL. Clear the check box to  
disable SSL. The default is disabled.

Kerberos support JBoss only. Select the Kerberos support check box if 
Kerberos authentication is used. Clear the check box if 
Kerberos authentication is not used. The default is Kerberos 
not supported.

Task enabled Select the Task enabled check box to execute the configure 
LDAP task later in Step d. The default is enabled.

In this field... Provide this information...

Directory service 
provider type

Select “Sun Java Directory Server” from the list. The 
remaining properties and values that you need to supply for 
your LDAP configuration depend on the type of provider that 
you select.

In this field... Provide this information...
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Directory service server 
host name

The directory server host name. The short name, full name, 
or IP address of the system that hosts the directory service. 

Directory service port 
number

The port number configured on the directory server host for 
communicating with the directory server.

Directory service bind 
user name

The fully qualified distinguished name of the LDAP bind 
user for authenticating to Sun Java Directory Server.

Directory service bind 
user password

The password used by the LDAP bind user to authenticate 
to the directory server. The tool encrypts the password for 
you.

Enter the password again in the Confirm field.

User base distinguished 
name

The fully qualified distinguished name of the container for 
starting a user search in Sun Java Directory Server. For 
example, ou=FileNet,dc=FNCE.

User filter The filter used by the bind user when searching for users in 
a directory server. For example, (cn={0}).

Set as current active 
user registry

WebSphere only. This setting specifies whether to set the 
LDAP repository as the active user registry. When set to 
true, the LDAP information will be used to configure the 
active user registry.

Script WebSphere and WebLogic. The fully qualified path to the 
LDAP configuration task script. The task script filename 
depends on the application server type selected.

WebSphere Application Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWSLDAP.tcl  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWSLDAP.tcl.

WebLogic Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWLLDAP.py  or  
c:\Program 
Files\FileNet\ContentEngine\tools\configure\scr
ipts
\configureWLLDAP.py.

Temporary Directory WebSphere and WebLogic. The fully qualified path to a 
temporary directory to be used by the configuration task. 
For example, /opt/FileNet/ContentEngine/tools/
configure/tmp  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp.

In this field... Provide this information...
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c. Select File > Save to save your changes.

d. Apply the LDAP property settings by right-clicking Configure LDAP in the profile pane, and 
select Run Task. Running the configuration task can take a few minutes. The task execution 
status messages are displayed in the Console pane below the LDAP task properties.

TIP  You can check the completion status of the task by right-clicking Configure LDAP in 
the profile pane, and select Check Task Status.

e. Close the Configure LDAP task pane.

5. Provide property values for Content Engine bootstrap.

a. Right-click Configure Bootstrap Properties in the profile pane, and select Edit Selected 
Task. 

b. Provide the bootstrap property values, using the following table.

SSL enabled WebSphere and WebLogic. This setting specifies whether 
Secure Sockets Layer (SSL) is enabled or disabled. Select 
the check box to enable SSL. Clear the check box to  
disable SSL. The default is disabled.

Kerberos support JBoss only. Select the Kerberos support check box if 
Kerberos authentication is used. Clear the check box if 
Kerberos authentication is not used. The default is Kerberos 
not supported.

Task enabled Select the Task enabled check box to execute the configure 
LDAP task later in Step d. The default is enabled.

In this field... Provide this information...

Content Engine EAR 
path

The fully qualified path to the Content Engine EAR file that 
was installed by the Content Engine installation program. For 
example, /opt/FileNet/ContentEngine/lib/Engine-ws.ear  or  
c:\Program Files\FileNet\ContentEngine\lib\Engine-ws.ear.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the Global Configuration Database (GCD) 
tablespace or database. For example, FNGCDDSXA.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the Global Configuration Database (GCD) tablespace 
or database. For example, FNGCDDSXA.

In this field... Provide this information...
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c. Select File > Save to save your changes.

d. Apply the bootstrap property settings by right-clicking Configure Bootstrap Properties in the 
profile pane, and select Run Task. Running the configuration task can take a few minutes. 
The task execution status messages are displayed in the Console pane below the bootstrap 
properties.

TIP  You can check the completion status of the task by right-clicking Configure Bootstrap 
Properties in the profile pane, and select Check Task Status.

Bootstrapped EAR 
directory

The name of a subdirectory that will store the EAR file that 
contains the Content Engine bootstrap information. The 
bootstrap information is needed for creating the GDC and 
for starting Content Engine. Specify the directory relative to 
the ce_install_path/lib directory. For example, to specify /
opt/FileNet/ContentEngine/lib/bootstrap, enter "bootstrap".

Bootstrap user name The name of a directory server user that accesses the 
Global Configuration Database (GCD) data sources. Use 
only the short name of the bind user defined by the LDAP 
user attribute. For example, 'administrator'.

Bootstrap password The password for the directory server user that accesses the 
Global Configuration Data (GCD) data sources. The tool 
encrypts the password for you.

Master key A word or phrase of any length that is used to encrypt 
sensitive Global Configuration Database (GCD) entries. The 
tool encrypts the password for you.

The master key is used to configure the GCD settings for 
the Content Engine bootstrap settings. Store the master key 
in a secure location, as it is not retrievable. You will have to 
specify it later any time you access the GCD with 
applications built with non-FileNet APIs. 

Web Services HTTP port The Content Engine Web Services HTTP port number. The 
Content Engine Web Service (CEWS) is an industry 
standards-conformant SOAP interface to the FileNet 
Content Engine. It allows applications to access most of the 
functionality available through the Content Engine APIs. 
The default is 9080. For a cluster deployment, this port 
number must be the same value on each server in the 
cluster. 

Task enabled Select the Task enabled check box to execute the configure 
LDAP task in Step d.The default is enabled.

In this field... Provide this information...
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e. Close the Configure Bootstrap task pane.

6. Continue at “Install the latest Content Search Engine Client files on Content Engine servers” on 
page 390.

Configure instances using the command line interface
In this subtopic you will configure a Content Engine instance on a given application server using 
the command-line version of Configuration Manager. Configuring a Content Engine instance 
involves four major steps (repeat the steps to configure another instance):

• Generate the configuration XML files that contain the properties and values used to perform 
various tasks required to configure the environment for a Content Engine instance. See 
“Generate the configuration XML files for a Content Engine instance” on page 372.

• Edit the configuration XML files by inserting your site’s properties and values. See “Edit the 
configuration XML files for a Content Engine instance” on page 375.

• Execute the configuration XML files you edited. See “Execute the configuration XML files for a 
Content Engine instance” on page 377.

• Check that the configuration XML files that you executed have resulted in a correct 
configuration of the Content Engine instance. See “Check the completion status of Content 
Engine configuration tasks” on page 378.

If you are deploying multiple Content Engine instances on the same machine, you will need to 
generate, edit, and deploy a complete set of configuration files for each instance. Store the 
configuration files for each instance in a separate directory.

You can navigate through the steps above by generating all the configuration XML files before 
editing, executing, or verifying any of them; or you can generate, edit, execute, and verify one file 
at a time.

NOTE This subtopic refers to Configuration Manager as configmgr. When you run the tool, 
substitute configmgr.sh (on UNIX) or configmgr.bat (on Windows) in place of configmgr, 
depending on your operating system.

Generate the configuration XML files for a Content Engine instance
The following table lists the configuration XML files that you will generate using Configuration 
Manager:

File Name Description

configurejdbc.xml Settings for configuring JDBC connections to the databases 
used by Content Engine. You will need to generate, edit, and 
execute the configure the JDBC task once for the data source 
for the Global Configuration Data (GCD).

configureldap.xml Settings for connecting to and searching within a directory 
server

configurebootstrap.xml Settings for creating the Global Configuration Data (GCD) and 
starting Content Engine

deployapplication.xml Settings for deploying a Content Engine instance
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You can generate the configuration XML files, in either of two ways:

• Run the tool multiple times, generating one configuration XML file at a time.

• Run the tool once to generate a “parent” file, configureapplicationserver.xml, and 
automatically generate all the configuration XML files. The parent file points to the individual 
configuration XML files.

Running the tool also generates the applicationserver.xml file (used in several configuration 
tasks). Subsequent executions of the tool will not overwrite applicationserver.xml.

To generate configuration XML files

1. Set the current directory to ce_install_path/tools/configure.

2. At the command prompt, run Configuration Manager to generate the configuration XML files all 
at once (Step a) or one at a time (Step b).

See “Configuration Manager command-line reference” on page 695 for details on Configuration 
Manager syntax.

a. To generate all the configuration files at once with a parent configuration file, run the 
following command. Do not type any line breaks when you type the command.

where:

app_server_type is WebSphere, WebLogic, or JBoss.

db_type specifies the type of database to be used by Content Engine and must be one of 
the following: mssql, oracle, oracle_rac, db2, or db2zos.

ldap_type specifies the type of directory service repository Content Engine uses for 
authenticating users and must be one of the following: activedirectory, adam, edirectory, 
sunjava, or tivoli. The adam option applies to both Microsoft ADAM and AD LDS. 

deploy_type  specifies the type of Content Engine deployment. The value must be one of 
the following: standard, cluster, or netdeploy (network deployment). Specify standard if 
you are deploying Content Engine to a standalone (that is, a server that is neither 
managed nor clustered) WebSphere, WebLogic, or JBoss application server. Specify 
cluster if you are deploying Content Engine to a WebSphere, WebLogic, or JBoss 
application server cluster. Specify netdeploy if you are deploying Content Engine to a 

configureapplicationserver.xml Parent file of the above listed configuration XML files that 
points to each configuration file. This file is created only if you 
generate all the configuration files at once instead of 
individually.

applicationserver.xml Settings for the application server, including the location of 
the application server software and the name of the server. 
This file is generated when any other configuration file is 
generated (either all at once or individually) and is used by all 
of the configuration tasks.

File Name Description
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managed WebSphere application server instance (using Network Deployment for 
managing individual servers that are not necessarily in a cluster).

-path mypath is optional and specifies the path to where the generated configuration XML 
files will be placed. If you are deploying multiple Content Engine instances on the same 
machine, you will need to specify a separate directory for each instance.

For example, the following command generates all the configuration XML files for a 
standard WebSphere deployment using Tivoli Directory Server and DB2 in the  
ce_install_path/tools/configure/wstdb2 path:

configmgr generateConfig -appserver WebSphere -db db2 -ldap tivoli 
-deploy standard -task ConfigureApplicationServer -path wstdb2

Continue at “Edit the configuration XML files for a Content Engine instance” on page 375.

b. To generate a single configuration XML file, run the command in one of the following 
substeps:

• To generate the configurejdbc.xml file and the applicationserver.xml file:

configmgr generateConfig -appserver app_server_type -db db_type 
-ldap ldap_type -deploy deploy_type -task ConfigureJDBC -path mypath

• To generate the configureldap.xml file and the applicationserver.xml file:

configmgr generateConfig -appserver app_server_type -db db_type 
-ldap ldap_type -deploy deploy_type -task ConfigureLDAP -path mypath

• To generate the configurebootstrap.xml file and the applicationserver.xml file:

configmgr generateConfig -appserver app_server_type -db db_type 
-ldap ldap_type -deploy deploy_type -task ConfigureBootstrap [-path mypath]

where:

app_server_type is WebSphere, WebLogic, or JBoss.

db_type specifies the type of database to be used by Content Engine and must be one of 
the following: mssql, oracle, oracle_rac, db2, or db2zos.

ldap_type specifies the type of directory service repository Content Engine uses for 
authenticating users and must be one of the following: activedirectory, adam, edirectory, 
sunjava, or tivoli. The adam option applies to both Microsoft ADAM and AD LDS. 

deploy_type  specifies the type of Content Engine deployment. The value must be one of 
the following: standard, cluster, or netdeploy (network deployment). Specify standard if 
you are deploying Content Engine to a standalone (that is, a server that is neither 
managed nor clustered) WebSphere, WebLogic, or JBoss application server. Specify 
cluster if you are deploying Content Engine to a WebSphere, WebLogic, or JBoss 
application server cluster. Specify netdeploy if you are deploying Content Engine to a 
managed WebSphere application server instance (using Network Deployment for 
managing individual servers that are not necessarily in a cluster).

-path mypath is optional and specifies the path to where the generated configuration XML 
files will be placed. If you are deploying multiple Content Engine instances on the same 
machine, you will need to specify a separate directory for each instance.
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For example, the following command generates only the configureJDBC.xml file for a 
standard WebSphere deployment using Tivoli Directory Server and DB2 in the  
ce_install_path/tools/configure/wstdb2 path:

configmgr generateConfig -appserver WebSphere -db db2 -ldap tivoli -deploy
standard -task ConfigureJDBC -path wstdb2

Repeat Step b to generate one of the other configuration XML files, or continue at “Edit the 
configuration XML files for a Content Engine instance” on page 375. 

You will eventually need to generate each of the configuration XML files (JDBC, LDAP, and 
bootstrap) to configure a Content Engine instance.

Edit the configuration XML files for a Content Engine instance
Perform the following procedure for each file you generated in “Generate the configuration XML files 
for a Content Engine instance” on page 372 to insert your site’s properties and values. Use the 
information in your worksheet to specify the values for the parameters required to configure Content 
Engine. For more information, see “Installation and upgrade worksheet” on page 229 of Plan and 
Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following actions to quickly see only the 
properties you must specify for Configuration Manager:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select one of these Configuration Manager options:

– CM: Set Application Server properties

– CM: Configure JDBC Data Sources

– CM: Configure LDAP

– CM: Configure Bootstrap Properties

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify: Setup Type contains "Upgrade".

• Click the AutoFilter drop-down arrow in all other column headers and select (All).

To edit values in the configuration XML files

1. Use a text editor or XML editor to open one of the following configuration XML files that you 
generated in “Generate the configuration XML files for a Content Engine instance” on page 372:

• configurejdbc.xml

• configureldap.xml

• configurebootstrap.xml

• applicationserver.xml

If you generated all the files at once with the ConfigureApplicationServer task in “Generate the 
configuration XML files for a Content Engine instance” on page 372, you will also have generated 
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the deployapplication.xml file. You will open this file for editing in “Deploy upgraded Content 
Engine instances” on page 395.

2. Make the following changes to each XML configuration file:

a. Replace each occurrence of ****INSERT VALUE**** with a value appropriate for your site. 
Refer to the descriptions in the file for more information.

b. Verify that the default values for the remaining properties are correct for your site. 

TIP If you previously specified values in the configureldap.xml file to add a realm to a 
federated repository, and want to put an additional realm in the repository, replace the 
previous values with the values for the additional realm.

c. Set the <TaskEnabled> value to true in any configuration XML file you edit if you want to run 
the configuration task in “Execute the configuration XML files for a Content Engine instance” on 
page 377.

3. (Optional, WebSphere only) If you have previously created XA and non-XA data sources that 
you want to use for the Global Configuration Data (GCD) database, make the following edits:

a. In the configurejdbc.xml file, set the <TaskEnabled> value to false to avoid creating 
another pair (XA and non-XA) of data sources.

b. In the configurebootstrap.xml file, set the <JDBCDataSourceXAFileName> and 
<JDBCDataSourceFileName> values to the XA and non-XA JNDI names, respectively, 
associated with the GCD database.

4.  (Optional) Encrypt any passwords that you need to insert into the file by running the password 
encryption utility (see “To encrypt a password for Configuration Manager” on page 700), and then 
copy the encrypted value into the file. It is a best practice to encrypt the passwords for the 
following accounts:

• The application server administrator account used in the applicationserver.xml file.

• The database administrator account used in the configurejdbc.xml file.

• The LDAP provider service principal account used in the configureldap.xml file.

• The master key—a word or phrase for encrypting sensitive FileNet P8 Global Configuration Data 
(GCD) entries—used in the configurebootstrap.xml file.

IMPORTANT  Any password you do not encrypt will be stored and sent as clear text. 

5. Save your edits.

6. Perform one of the following:

• Repeat Step 1 through Step 5 of this procedure for any other configuration XML file that you have 
not yet edited.

• Continue at “Execute the configuration XML files for a Content Engine instance” on page 377 to 
execute a configuration XML file(s) you have edited.

• Return to “Generate the configuration XML files for a Content Engine instance” on page 372 to 
generate additional configuration XML files.
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 5a: Configure Content Engine instances upgraded from 3.5.x
To execute the configuration XML file settings

377
Execute the configuration XML files for a Content Engine instance

After you have generated and edited the configuration XML files for a Content Engine instance, 
you need to apply the settings by executing the tasks. 

• Any task with the <TaskEnabled> element value set to false will not run (see Step 2 on page 
376 in “To edit values in the configuration XML files” on page 375).

• If you are executing tasks for a profile that was created or edited in the Configuration Manager 
GUI, verify that the XML files contain values for the required passwords. See “Handling 
passwords in Configuration Manager” on page 643 for more information.

To execute the configuration XML file settings

1. (WebSphere only) Start the application server if it is not already running.

2. Set the current directory to ce_install_path/tools/configure.

3. At the command prompt, run Configuration Manager to execute the configuration XML files all at 
once (Step a) or one at a time (Step b). See “Configuration Manager command-line reference” on 
page 695 for command syntax details.

When running the tool, the -path mypath parameter is optional and specifies where you 
placed the configuration XML file. If you do not specify a path, the file must be in 
ce_install_path/tools/configure/profiles.

a. To execute all the configuration files at once with a parent configuration file, run the following 
command.

configmgr execute -task ConfigureApplicationServer -path mypath

where -path mypath is optional and specifies the path to the generated configuration XML 
files. 

NOTES 

• To execute all tasks at once, you must have generated all the files at once with the 
ConfigureApplicationServer task in “Generate the configuration XML files for a Content 
Engine instance” on page 372.

• If you did not enable the deployment task in the deployapplication.xml file, the tool 
will display an informational message indicating that the deployment did not occur. In 
which case, you will complete the deployment in “Deploy upgraded Content Engine 
instances” on page 395.

b. To execute a single configuration XML file, type and run the command in one of the following 
substeps. You can execute the files in any order.

• To execute the configurejdbc.xml file:

configmgr execute -task ConfigureJDBC -path mypath

• To execute the configureldap.xml file:

configmgr execute -task ConfigureLDAP -path mypath
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• To execute the configurebootstrap.xml file:

configmgr execute -task ConfigureBootstrap -path mypath

where -path mypath is optional and specifies the path to the generated configuration XML 
files. 

TIP  If you generated a complete set of XML files, but want to execute the files individually, 
you only need to execute the three files listed above. You cannot execute the 
applicationserver.xml file or the ConfigureApplicationServer.xml file. The values 
in the applicationserver.xml file are used to identify the application server for the 
other execution tasks. The ConfigureApplicationServer.xml file is a parent file that 
lists the tasks to execute when you execute all the configuration files at once.

Repeat Step b to execute one of the other configuration XML files, or continue at “Check the 
completion status of Content Engine configuration tasks” on page 378. 

You will eventually need to execute each of the configuration XML files to complete the 
configuration of a Content Engine instance.

IMPORTANT You must run the ConfigureJDBC task at least 2 times to configure the 
minimum data sources. First enter the Global Configuration Database (GCD) data source 
values, save, and run the task. Then, enter the object store data source values, save, and 
run the task again. You will need to edit and run the ConfigureJDBC task once for each 
additional object store.

4. Continue at “Check the completion status of Content Engine configuration tasks” on page 378.

Check the completion status of Content Engine configuration tasks
Use the procedure in this subtopic to verify that one or more Content Engine configuration tasks 
that you executed in “Execute the configuration XML files for a Content Engine instance” on page 377 
have completed. You can check the status of all the tasks you executed or just check individual 
tasks.

Checking the completion status does not validate the information in the XML files.

To check the status of a Content Engine configuration

1. At the command prompt, run Configuration Manager to check the status of the configuration 
tasks all at once (Step a) or one at a time (Step b).

When running the tool, the -path mypath parameter is optional and specifies where you 
placed the configuration XML file. If you do not specify a path, the file must be in 
ce_install_path/tools/configure/profiles.

See “Configuration Manager command-line reference” on page 695 for command syntax details.

a. To check the status of all the configuration tasks at once, run the following command:

configmgr checkStatus -task ConfigureApplicationServer -path mypath

NOTE To check the status of all tasks at once, you must have generated all the files at 
once with the ConfigureApplicationServer task in “Generate the configuration XML files for a 
Content Engine instance” on page 372.

Continue at Step 3.
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 5a: Configure Content Engine instances upgraded from 3.5.x
To check the status of a Content Engine configuration

379
b. To check the completion status of a single configuration task, run the tool in one of the 
following substeps. 

• To check the status of the ConfigureJDBC task using the configuration file in the 
specified path:

configmgr checkStatus -task ConfigureJDBC -path mypath

• To check the status of the ConfigureLDAP task using the configuration file in the 
specified path:

configmgr checkStatus -task ConfigureLDAP -path mypath

• To check the status of the ConfigureBoostrap task using the configuration file in the 
specified path:

configmgr checkStatus -task ConfigureBootstrap -path mypath

If you performed Step b, repeat the step to check the status of any other configuration tasks you have 
executed; otherwise, continue at Step 2.

2. Continue at one of the following procedures, as needed; otherwise, continue at Step 3.

• If you have any other configuration tasks to execute, continue at “Execute the configuration XML 
files for a Content Engine instance” on page 377.

• If you have any other configuration XML files to generate, continue at “Generate the configuration 
XML files for a Content Engine instance” on page 372.

• If you want to add a realm to a federated repository, continue at “Edit the configuration XML files for 
a Content Engine instance” on page 375.

3. Continue at “Install the latest Content Search Engine Client files on Content Engine servers” on 
page 390.
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Task 5b: Configure Content Engine instances 
upgraded from 4.0.x
To configure the upgraded content engine instances, complete the procedures in this topic. 

• “Grant directory permissions to the Configuration Manager user” on page 380

• “Edit the servers.xml file” on page 381

• “Review Configuration Manager reference topics” on page 382

• Configure one or more upgraded instances of Content Engine on an application server, using 
one of these methods:

– “Configure upgraded instances using a graphical user interface” on page 382

– “Configure upgraded instances using a command line” on page 387

NOTE On a machine that runs Novell SUSE Linux Enterprise 9, you can configure Content Engine 
only from a command line.

Grant directory permissions to the Configuration Manager user
Perform the following procedure to grant the file and directory permissions required by 
config_mgr_user, the user who will run Configuration Manager. For details on required accounts and 
related permissions, see “Accounts for Content Engine upgrade” on page 193 in Plan and Prepare Your 
Environment for IBM FileNet P8.

To grant directory permissions to the Configuration Manager tool user

1. Log on to the application server where you installed Content Engine as ce_install_user. For 
details on required accounts and related permissions, see “Accounts for Content Engine” on 
page 71 in Plan and Prepare Your Environment for IBM FileNet P8.

2. Grant the following permissions to config_mgr_user, the Configuration Manager user:

• Execute permission on the following file:

UNIX

 ce_install_path/tools/configure/configmgr.sh

Windows

 ce_install_path/tools/configure/configmgr.bat

where ce_install_path is the path where you installed Content Engine.

• Write permission to the directory where you want the Configuration Manager tool to place the 
configuration XML files it will generate.

NOTE If you are not going to specify this directory when you run the tool, grant write 
permission on the default directory, ce_install_path/tools/configure/profiles.
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3. Grant config_mgr_user execute permission (UNIX) or Read & Execute permission (Windows) on 
the executable file of the interface of Configuration Manager you intend to use:

• To enable use of the graphical user interface, grant the permission to one of the following files:

UNIX

cmui

Windows

cmui.exe

• To enable use of the command line interface, grant permission to one of the following files:

UNIX

configmgr.sh

Windows

configmgr.bat

4. Grant write permission to the directory where you want Configuration Manager to place the 
configuration XML files it will generate.

If you are not going to specify this directory when you run Configuration Manager, grant write 
permission on the default directory, ce_install_path/tools/configure/profiles.

5. Log off the Content Engine application server and log back on as config_mgr_user, the 
Configuration Manager user. For details on required accounts and related permissions, see 
“Accounts for Content Engine” on page 71 in Plan and Prepare Your Environment for IBM 
FileNet P8.

Edit the servers.xml file
If you upgraded Content Engine from version 4.0.x of a cluster deployment, or a non-cluster 
Network Deployment (WebSphere only), perform the procedure in this subtopic to edit the 
servers.xml file; otherwise, skip this subtopic.

To edit the servers.xml file

1. On the Content Engine Server machine, navigate to the ce_install_path/FileNet/
ContentEngine directory, which contains the servers.xml file.

2. Use the following syntax to edit the settings for the Content Engine server:

<server name="WS/Deployment_Manager_profile_name/cell_name/cluster_name" 
deployment="Cluster" version="4.0.x-xxxx" 
ear="path_to_existing_40x_boostrapped_EAR_file\Engine-ws.ear">

where you would:

• Add the attribute deployment="Cluster".

• Change the name attribute by entering your cluster name for the cluster_name variable (replacing 
the server name).
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• Verify that the path to the EAR file is valid. The path should point to the EAR file deployed to the 
cluster. 

3. Save the servers.xml file.

Review Configuration Manager reference topics
If you are new to Configuration Manager, refer to the appendix “Configuration Manager reference” on 
page 638 for complete information on using Configuration Manager before starting the procedures 
in this topic. The “Configuration Manager reference” appendix includes the following information:

• An overview of Configuration Manager, which contains details on:

– Configuration profiles and configuration tasks.

– Differences between the graphical user interface and command-line interface versions.

• Details on handling passwords in Configuration Manager.

• The Configuration Manager user-interface reference, which contains:

– An introduction to the windows, toolbars, menus, and commands.

– Procedures for working in Configuration Manager to start and stop Configuration Manager, 
to create, open, or save a profile, to run tasks, to check task status, and to view the logs.

• The Configuration Manager command-line reference with syntax, commands, and parameters.

Refer to the appendix “Configuration Manager reference” on page 638 for complete information on 
using Configuration Manager.

To configure the Content Engine upgrade instances, continue with one of the following topics:

• “Configure upgraded instances using a graphical user interface” on page 382

• “Configure upgraded instances using a command line” on page 387

Configure upgraded instances using a graphical user interface
In this subtopic you will configure a Content Engine Server instance on an application server 
using the graphical user interface version of Configuration Manager.

Refer to the appendix “Configuration Manager user interface reference” on page 645 for complete 
information on using the graphical user interface.

NOTE If you need an accessible version of Configuration Manager, use the command line 
interface instead of the GUI. See “Configure upgraded instances using a command line” on page 387.

To start Configuration Manager

• Run one of the following commands, depending on the operating system that runs on the 
machine where you installed Content Engine:

UNIX

ce_install_path/tools/configure/CMUI/cmui
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Windows

Perform one of the following actions:

• Double-click the FileNet Configuration Manager desktop shortcut. 

• Select Start > All Programs > IBM FileNet P8 Platform > FileNet Configuration Manager. 

• Run ce_install_path\tools\configure\CMUI\cmui.exe.

To create an upgrade configuration profile

• Start the Create Upgrade Configuration Profile wizard, by selecting File > Create Upgrade 
Configuration Profile or by clicking the wizard icon in the tool bar, and use the information in 
your worksheet to specify the values for the parameters in the wizard screens. For more 
information, see “Installation and upgrade worksheet” on page 229 of Plan and Prepare Your 
Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following actions to quickly see only the 
properties you must specify for Configuration Manager:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column 
header and select “CM: Set Application Server Properties”.

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, 
and specify: Setup Type contains "Upgrade."

In this screen... Perform this action...

Upgrade Profile Path • Provide the following information for the profile, and click 
Next.

– Enter a name for the profile. The name must be valid as 
a directory name for your operating system. 
Configuration Manager will create a directory with the 
profile name for storing the configuration files 
associated with this profile. For more information of 
profiles, see “Configuration profile concepts” on page 639 in 
the Configuration Manager reference appendix.

– Specify the path for the profile. Either type in the full path 
to the profile directory or click Browse to locate the 
directory. The default path is ce_install_path/tools/
configure/profiles, where ce_install_path is the 
location where Content Engine is installed.
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Upgrade Configuration 
Profile Creation 
Summary

• Review the summary information, and click Next.

• Continue at one of the following screens:

– “Set Application Server Properties for WebSphere” on 
page 384

– “Set Application Server Properties for JBoss” on page 385

– “Set Application Server Properties for WebLogic” on 
page 385

Set Application Server 
Properties for 
WebSphere

This screen is displayed only if you selected WebSphere in the 
previous screen. 

Provide the following information for the application server, and 
click Finish.

• Select the application server version from the list.

• Enter the fully qualified path to the application server 
installation directory, or click click Browse to locate the 
directory. 

• Enter the application server administrator user name. Use 
the directory service user account that has been assigned 
the application server administrative role. This account is 
used to manage the application server domain/profile, to 
configure the data sources and connection pools for the 
GCD, and to deploy the Content Engine application. If 
Administrative Security is already enabled, use an existing 
administrative user account.

• Enter the application server administrative password. The 
password will be encrypted for you. For more information on 
passwords,  see “Handling passwords in Configuration 
Manager” on page 643.

• Enter the application server SOAP port number.

• Enter the name of the WebSphere application server cell 
where Content Engine will be deployed.

• If you have already configured WebSphere to use 
certificates, clear the “Do not use SSL certificates for server 
communications” check box. Otherwise, leave the check box 
selected. 

NOTE  Selecting this check box will change your 
WebSphere settings for communicating with other servers, 
such as Application Engine.

In this screen... Perform this action...
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Set Application Server 
Properties for JBoss

This screen is displayed only if you selected JBoss in the 
previous screen. 

Provide the following information for the application server, and 
click Finish.

• Select the application server version from the list.

• Enter the fully qualified path to the application server 
installation directory, or click click Browse to locate the 
directory. 

• Enter the name of the JBoss application server name where 
Content Engine will be deployed.

Set Application Server 
Properties for WebLogic

This screen is displayed only if you selected WebLogic in the 
previous screen.

Provide the following information for the application server, and 
click Finish.

• Select the application server version from the list.

• Enter the fully qualified path to the application server 
installation directory, or click click Browse to locate the 
directory. 

• Enter the application server administrator user name. Use 
the directory service user account that has been assigned 
the application server administrative role. This account is 
used to manage the application server domain/profile, to 
configure the data sources and connection pools for the 
GCD, and to deploy the Content Engine application. If 
Administrative Security is already enabled, use an existing 
administrative user account.

• Enter the application server administrative password. The 
password will be encrypted for you. For more information on 
passwords,  see “Handling passwords in Configuration 
Manager” on page 643.

• Enter the application server SOAP port number.

• Enter the machine name or the IP address of the local host 
for the application server host. 

• Enter the fully qualified path to the WebLogic application 
server user projects directory, or click Browse to locate the 
directory.

In this screen... Perform this action...
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If more than one instance of Content Engine Server is installed on the machine, Configuration 
Manager will create one parent directory using the profile name you specified and a 
subdirectory of the parent for each instance. The profile you create will be displayed as an 
icon in the left-hand pane, along with icons for Upgrade Bootstrap and Deploy Application. 

To configure the upgraded Content Engine instance

1. Open the Upgrade Bootstrap properties. Right-click Upgrade Bootstrap in the profile pane, and 
select Edit Selected Task.

2. Specify the parameter values in the right pane of the window, using the appropriate information 
from your installation and upgrade worksheet.  For more information, see “Installation and 
upgrade worksheet” on page 229 of Plan and Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following actions to quickly see only the 
properties you must specify for Configuration Manager:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select “CM: Upgrade Bootstrap”.

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify: Setup Type contains “Upgrade”.

Provide the bootstrap property values, using the following table.

Set Application Server 
Properties for WebLogic 
(continued)

• Enter the WebLogic application server domain name where 
Content Engine will be deployed.

• Enter the name of the WebLogic application server name 
where Content Engine will be deployed.

In this field... Provide this information...

Content Engine EAR 
path

The fully qualified path to the Content Engine EAR file that was 
installed by the Content Engine installation program. For 
example, /opt/FileNet/ContentEngine/lib/Engine-ws.ear  or  
c:\Program Files\FileNet\ContentEngine\lib\Engine-ws.ear.

Deployed Content Engine 
EAR path

The location of the deployed Content Engine EAR file.

In this screen... Perform this action...
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3. Select File > Save to save your changes.

4. Apply the bootstrap property settings by right-clicking Upgrade Bootstrap in the profile pane, 
and selecting Run Task. Running the configuration task can take a few minutes. The task 
execution status messages are displayed in the Console pane below the bootstrap properties.

TIP  You can check the completion status of the task by right-clicking Upgrade Bootstrap in the 
profile pane, and selecting Check Task Status.

5. Continue at “Install the latest Content Search Engine Client files on Content Engine servers” on 
page 390.

Configure upgraded instances using a command line
In this subtopic you will configure an upgraded Content Engine instance on a given application 
server using the command-line version of the Configuration Manager tool. Configuring an 
upgraded instance involves the following major steps (repeat the steps to configure another 
instance):

1. Generate the upgradebootstrap.xml file that contain the properties and values used to 
configure the environment for an upgraded Content Engine instance. 

2. Execute the upgradebootstrap.xml file.

3. Verify that the executed upgradebootstrap.xml file has resulted in a correct configuration of 
the Content Engine instance.

You can navigate through the steps above by generating all the upgradebootstrap.xml files, 
one for each Content Engine instance, before editing, executing, or verifying any of them; or you 
can generate, edit, execute, and verify one upgradebootstrap.xml file at a time.

Bootstrapped EAR 
directory

The name of a subdirectory that will store the EAR file that 
contains the Content Engine bootstrap information. The 
bootstrap information is needed for creating the GDC and for 
starting Content Engine. Specify the directory relative to the 
ce_install_path/lib directory. For example, to specify /opt/
FileNet/ContentEngine/lib/bootstrap, enter "bootstrap".

Task enabled Turn on the Task enabled check box to execute the upgrade 
bootstrap task in Step 4.The default is enabled.

In this field... Provide this information...
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To configure the upgraded Content Engine instance (command line)

1. Log on to the Content Engine Server machine as config_mgr_user, the Configuration Manager 
user. For details on required accounts and related permissions, see “Accounts for Content Engine 
upgrade” on page 193 in the Plan and Prepare Your Environment for IBM FileNet P8 guide.

2. Set the current directory to ce_install_path/tools/configure, where:

ce_install_path is the path where you installed Content Engine.

As an example, ce_install_path might be /opt/FileNet/ContentEngine.

3. At a command prompt, run the following Configuration Manager command interactively, or 
silently (without prompts) by appending the flag -silent, to generate the 
upgradebootstrap.xml file.

configmgr generateConfig -task upgrade -path mypath

where -path mypath is optional and specifies the path to where the generated configuration 
XML files will be placed.

The upgrade.xml file and one directory named for each existing Content Engine instance is 
created in this location.

4. (WebSphere or WebLogic only) Set the application server administrator properties:

a. Navigate to the Content Engine instance directory located in the directory you specified for 
mypath in the previous step, and open the applicationserver.xml file for editing.

b. In the ApplicationServerAdminUsername element, set the <value> element content to the 
user name of the application server console administrator, as follows:

<property name=”ApplicationServerAdminUsername”>
<value>administrator_user_name</value>

</property>

c. In the ApplicationServerAdminPassword element, set the <value> element content to the 
password of the application server console administrator, as follows:

<property name=”ApplicationServerAdminPassword”>
<value>administrator_password</value>

</property>

d. Save your edits.

e. Repeat Step a thru Step d as needed to edit the application server properties for each 
Content Engine instance directory that was created.

5. At a command prompt, run Configuration Manager interactively, or silently (without prompts) by 
appending the flag -silent to the command, to execute the upgradebootstrap.xml file.

configmgr execute -task upgrade -path mypath

where mypath specifies the path where the tool will find the upgradebootstrap.xml file.
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6. At a command prompt, run Configuration Manager interactively, or silently (without prompts) by 
appending the flag -silent to the command, to check the completion status of the execute 
task.

configmgr checkStatus -task upgrade -path mypath

7. Continue at “Install the latest Content Search Engine Client files on Content Engine servers” on 
page 390.
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Task 6: Install the latest Content Search Engine Client 
files on Content Engine servers
To install the latest Content Search Engine Client files, perform the following procedure on all 
application server machines where Content Engine Server is to be deployed.

IMPORTANT  Your Content Search Engine Client version must match your Content Search Engine 
server version unless otherwise noted in the FileNet P8 Compatibility Matrix.

To install the latest Content Search Engine Client files

1. Locate the Content Search Engine fix pack software for your Content Engine platform. For 
example, if Content Engine runs on Windows, locate the fix pack software that runs on Windows. 
For instructions on how to obtain the latest Content Search Engine Client files, see “Access IBM 
FileNet documentation, compatibility matrices, and fix packs” on page 20.

2. Open the readme file for the latest IBM FileNet P8 Content Search Engine 4.5.0 fix pack and 
perform the installation procedures in the Content Search Engine Client section of the file.

3. Continue at “Install the latest Process Engine Client files on Content Engine servers” on page 75.



Task 7: Install the latest Process Engine Client files on Content Engine servers
To install the Process Engine Client files

391
Task 7: Install the latest Process Engine Client files on 
Content Engine servers
To install the Process Engine Client files, perform the following steps on all application server 
machines where Content Engine Server has been upgraded and is to be deployed.

IMPORTANT Your Process Engine Client version must match your Process Engine server version, 
unless otherwise noted in the FileNet P8 Compatibility Matrix. Install the latest 4.5 Process 
Engine Client files as documented in this topic only when you are ready to upgrade Process 
Engine servers to 4.5. 

In a staged upgrade from 4.0, you might run upgraded Content Engine 4.5 servers with Process 
Engine 4.0 servers for some period of time. In this case, install the latest 4.0 Process Engine 
Client files. For detailed instructions, see the latest 4.0 version of the IBM FileNet P8 Installation 
and Upgrade Guide on the IBM Web site.

To install the Process Engine Client files

1. On the machine where Content Engine is to be deployed, log on as ce_upgrade_user.

2. Access the Process Engine Client install software from the Process Engine installation software. 
The version of the install software must match the version of Process Engine.

3. Expand the (TAR or ZIP) Process Engine Client install software.

4. Shut down all instances of Enterprise Manager (EM) and any other Content Engine client 
applications, such as Application Engine.

5. The expanded install software contains the Process Engine Client installation program specific 
to the operating system on the machine where Content Engine will be deployed. You can run the 
program either interactively (using the install wizard) or silently.

Depending on your application server type, the installation program will update one of the 
following bootstrap EAR files, at the (example) location shown in the following table:

NOTE The Process Engine Client installation program creates a backup of the previous 
Process Engine Client files. For example, on Windows you can find this backup at 
C:\Program Files\FileNet\PEClient\Backup\CE.

Application Server Example Path to Bootstrap EAR File

WebSphere /opt/FileNet/ContentEngine/lib/cell_name/node_name/
WS_server_name/Engine-ws.ear

WebLogic /opt/FileNet/ContentEngine/lib/WL_domain_name/
Admin_server_name/Engine-wl.ear

JBoss /opt/FileNet/ContentEngine/lib/JB_server_name/
Engine-jb.ear
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To run the program interactively, run one of the commands in the table below, depending on 
the operating system and follow the wizard instructions:

6. Complete the Process Engine client install screens, as follows:

Operating System Install Program

AIX P8PE-CLIENT-4.5.0-AIX.BIN

HPUX P8PE-CLIENT-4.5.0-HPUX.BIN

HPUXi P8PE-CLIENT-4.5.0-HPUXI.BIN

Linux P8PE-CLIENT-4.5.0-LINUX.BIN

Solaris P8PE-CLIENT-4.5.0-SOL.BIN

Windows P8PE-CLIENT-4.5.0-WIN.EXE

zLinux P8PE-CLIENT-4.5.0-ZLINUX.BIN

In this screen... Perform this action...

Welcome to Process 
Engine Client Installer

Click Next to proceed with the installation.

NOTE Click Previous at any time to make changes in previous 
screens. Click Cancel to exit the program.

Specify Installation 
Location

Choose the destination directory for Process Engine Client log 
files and uninstallation files. Accept the default location or click 
Browse to change the location.  

Select FileNet P8 
Applications

Select Content Engine from the list of products to install 
Process Engine client files for.

Click Next to continue.

Content Engine 
Installation Path

Enter the full path to the Application Engine installation 
location. The defaults are as follows:

UNIX

/opt/FileNet/ContentEngine

Windows

C:\Program Files\FileNet\ContentEngine

Click Next to continue.
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To run the program silently, perform the following steps:

a. In the expanded install software, open the file PEClient_silent_install.txt and edit it 
as follows:

i. Change the Variable_CheckboxCE line to the following:

-V Variable_CheckboxCE="true"

ii. Save your edit.

b. Run one of the commands in the following table to perform the silent install:

Specify the EAR file to 
update

Specify the Content Engine EAR file to update with the new 
Process Engine client files. Default paths are:

UNIX

/opt/FileNet/ContentEngine/lib/

Windows

C:\Program Files\FileNet\ContentEngine\lib\

Specify the file that was bootstrapped during Configuration 
Manager configuration steps.

Valid options for the EAR file are:

• Engine-jb.ear

• Engine-jbc.ear

• Engine-wl.ear

• Engine-ws.ear

Stop running BPM 
software

If the installer detects running BPM software components, click 
Next to stop the software and continue with the installation.

Review Pre-Installation 
Summary 

Verify your component selections, and click Install to start 
installing Process Engine Client.

Operating System Install Program

AIX P8PE-CLIENT-4.5.0-AIX.BIN -silent -options 
"PEClient_silent_install.txt" 

HPUX P8PE-CLIENT-4.5.0-HPUX.BIN -silent -options 
"PEClient_silent_install.txt" 

HPUXi P8PE-CLIENT-4.5.0-HPUXI.BIN -silent -options 
"PEClient_silent_install.txt"

Linux P8PE-CLIENT-4.5.0-LINUX.BIN -silent -options 
"PEClient_silent_install.txt" 

In this screen... Perform this action...
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Solaris P8PE-CLIENT-4.5.0-SOL.BIN -silent -options 
"PEClient_silent_install.txt" 

Windows P8PE-CLIENT-4.5.0-WIN.EXE -silent -options 
"PEClient_silent_install.txt" 

zLinux P8PE-CLIENT-4.5.0-ZLINUX.BIN -silent -options 
"PEClient_silent_install.txt" 

Operating System Install Program
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Task 8: Deploy upgraded Content Engine instances
To deploy an upgraded instance of Content Engine, complete the procedures in this topic after you 
have completed the configure tasks in one of the following topics:

• For upgrades from 3.5.x, “Configure Content Engine instances upgraded from 3.5.x” on page 345.

• For upgrades from 4.0.x, “Configure Content Engine instances upgraded from 4.0.x” on page 380.

If you have configured all your instances, you can deploy all of them in this topic. Alternatively, if 
you configured only one of your instances, you can deploy it in this topic and then return to 
“Configure Content Engine instances upgraded from 3.5.x” on page 345 or “Configure Content Engine 
instances upgraded from 4.0.x” on page 380 to configure another instance.

To deploy a Content Engine instance, complete the procedures in one of the following subtopics:

• “Deploy upgraded instances using a graphical user interface” on page 395

• “Deploy upgraded instances using a command line” on page 406

Use the command line version of Configuration Manager if either of these conditions is true:

– Your system is Novell SUSE Linux Enterprise 9. You can configure Content Engine only 
with the command line.

– You need an accessible software version of Configuration Manager for people with 
disabilities to use.

Deploy upgraded instances using a graphical user interface
In this subtopic you will deploy an upgraded Content Engine Server instance on an application 
server using the graphical user interface version of Configuration Manager. Use the information in 
your installation worksheet to specify the values that are required to configure Content Engine. For 
more information, see “Installation and upgrade worksheet” on page 229 of Plan and Prepare Your 
Environment for IBM FileNet P8.

For more information on the properties that you set in the Configuration Manager, roll your mouse 
over the property name to view the tool tip help for the property. Refer to the appendix 
“Configuration Manager user interface reference” on page 645 for complete information on using the 
graphical user interface.

To deploy a Content Engine instance (graphical user interface)

1. Log on to the application server where you installed the Content Engine software as 
config_mgr_user, the Configuration Manager user. For details on required accounts and related 
permissions, see “Accounts for Content Engine upgrade” on page 193 in Plan and Prepare Your 
Environment for IBM FileNet P8.

2. Start or stop the application server, depending on its type:

WebSphere and WebLogic

Start the application server if it is not already running.
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JBoss

Stop the application server.

3. Start Configuration Manager by completing one of the following steps:

UNIX

ce_install_path/tools/configure/CMUI/cmui

 where ce_install_path is the path to the Content Engine Server software.

Windows

Complete one of the following actions:

• Double-click the FileNet Configuration Manager desktop shortcut. 

• Select Start > All Programs > IBM FileNet P8 Platform > FileNet Configuration Manager. 

• Run ce_install_path\tools\configure\CMUI\cmui.exe.

 where ce_install_path is the path to the Content Engine Server software.

4. Refer to your installation worksheet to specify the values for the properties required for your new 
profile. For more information, see “Installation and upgrade worksheet” on page 229 of Plan and 
Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), complete the following actions to quickly see only the 
properties you must specify for Configuration Manager:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select “CM: Deploy Application”.

• Click the AutoFilter drop-down arrow in all other column headers and select (All).

5. If you upgraded your application server and then redeployed Content Engine before upgrading it 
to version 4.5 before upgrading Content Engine from version 4.0.x to 4.5, click the Update 
Application Server Properties icon and correct any obsolete parameter values for your 
application server type. 

6. Select File > Open Configuration Profile.

7. In the Open Configuration Profile wizard, enter the path to the profile for the Content Engine 
instance that you configured in “Configure Content Engine instances upgraded from 3.5.x” on 
page 345 or in “Configure Content Engine instances upgraded from 4.0.x” on page 380, or click 
Browse to locate the profile directory, and then click Finish.

8. Right-click the Deploy Application task in the profile pane (left pane), and select Edit Selected 
Task.

9. Provide the property values for your deployment, using the appropriate table for your 
deployment type:
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WebSphere Standard 

In this field... Provide this information...

Deployment type Select “Standard” from the list. The remaining properties that are 
displayed depend on the type of deployment that you select.

Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
ws.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
ws.ear

Content Engine 
Application name

The Content Engine application name as it will appear in the 
application server (for example, in an administration console). 
The application name is subject to application server naming 
constraints. For WebSphere Application Server, each 
application in a cell must have unique name. The default is 
FileNetEngine. 

Application server name The name of the WebSphere Application Server where Content 
Engine will be deployed.

Application server node The name of the WebSphere Application Server node where 
Content Engine will be deployed.

Script The fully qualified path to the deploy configuration task script. 
The task script filename depends on the application server type 
selected. For example: 

UNIX

/opt/FileNet/ContentEngine/tools/configure/scripts
/deployWSApplication.tcl

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\deployWSApplication.tcl
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WebSphere Cluster 

Temporary directory The fully qualified path to a temporary directory to be used by 
the configuration task. For example:

UNIX

/opt/FileNet/ContentEngine/tools/configure/tmp 

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp

Task enabled Select the Task enabled check box to execute the deploy 
application task later in Step 11. The default is enabled.

Continue with Step 10 on page 406.

In this field... Provide this information...

Deployment type Select “Cluster” from the list. The remaining properties that are 
displayed depend on the type of deployment that you select.

Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
ws.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
ws.ear

Content Engine 
Application name

The Content Engine application name as it will appear in the 
application server (for example, in an administration console). 
The application name is subject to application server naming 
constraints. For WebSphere Application Server, each 
application in a cell must have unique name. The default is 
FileNetEngine. 

Application server cluster 
name

The name of the WebSphere Application Server cluster where 
Content Engine will be deployed.

In this field... Provide this information...
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WebSphere Network Deployment 

Script The fully qualified path to the deploy configuration task script. 
The task script filename depends on the application server type 
selected. For example: 

UNIX

/opt/FileNet/ContentEngine/tools/configure/scripts
/deployWSApplication.tcl

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\deployWSApplication.tcl

Temporary directory The fully qualified path to a temporary directory to be used by 
the configuration task. For example:

UNIX

/opt/FileNet/ContentEngine/tools/configure/tmp 

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp

Task enabled Select the Task enabled check box to execute the deploy 
application task later in Step 11. The default is enabled.

Continue with Step 10 on page 406.

In this field... Provide this information...

Deployment type Select “Network Deployment” from the list. The remaining 
properties that are displayed depend on the type of deployment 
that you select.

In this field... Provide this information...
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Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
ws.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
ws.ear

Content Engine 
Application name

The Content Engine application name as it will appear in the 
application server (for example, in an administration console). 
The application name is subject to application server naming 
constraints. For WebSphere Application Server, each 
application in a cell must have unique name. The default is 
FileNetEngine. 

Application server name The name of the WebSphere Application Server where Content 
Engine will be deployed.

Application server node The name of the WebSphere Application Server node where 
Content Engine will be deployed.

Script The fully qualified path to the deploy configuration task script. 
The task script filename depends on the application server type 
selected. For example: 

UNIX

/opt/FileNet/ContentEngine/tools/configure/scripts
/deployWSApplication.tcl

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\deployWSApplication.tcl

In this field... Provide this information...
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Temporary directory The fully qualified path to a temporary directory to be used by 
the configuration task. For example:

UNIX

/opt/FileNet/ContentEngine/tools/configure/tmp 

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp

Task enabled Select the Task enabled check box to execute the deploy 
application task later in Step 11. The default is enabled.

Continue with Step 10 on page 406.

In this field... Provide this information...
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JBoss Standard 

JBoss Cluster 

In this field... Provide this information...

Deployment type Select “Standard” from the list. The remaining properties that are 
displayed depend on the type of deployment that you select.

Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
jb.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
jb.ear

Kerberos support This setting specifies whether Kerberos 
authentication is used. Select the Kerberos support 
check box if Kerberos authentication is used. Clear 
the check box if Kerberos authentication is not 
used. The default is Kerberos not supported.

Task enabled Select the Task enabled check box to execute the deploy 
application task later in Step 11. The default is enabled.

Continue with Step 10 on page 406.

In this field... Provide this information...

Deployment type Select “Standard” from the list. The remaining properties that are 
displayed depend on the type of deployment that you select.
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WebLogic Standard 

Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
jbc.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
jbc.ear

Keepers support This setting specifies whether Kerberos 
authentication is used. Select the Kerberos support 
check box if Kerberos authentication is used. Clear 
the check box if Kerberos authentication is not 
used. The default is Kerberos not supported.

Task enabled Select the Task enabled check box to execute the deploy 
application task later in Step 11. The default is enabled.

Continue with Step 10 on page 406.

In this field... Provide this information...

Deployment type Select “Standard” from the list. The remaining properties that are 
displayed depend on the type of deployment that you select.

Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
wl.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
wl.ear

In this field... Provide this information...
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WebLogic Cluster 

Content Engine 
Application name

The Content Engine application name as it will appear in the 
application server (for example, in an administration console). 
The application name is subject to application server naming 
constraints. For WebSphere Application Server, each 
application in a cell must have unique name. The default is 
FileNetEngine. 

Script The fully qualified path to the deploy configuration task script. 
The task script filename depends on the application server type 
selected. For example: 

UNIX

/opt/FileNet/ContentEngine/tools/configure/scripts
/deployWLApplication.py

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\deployWLApplication.py

Temporary directory The fully qualified path to a temporary directory to be used by 
the configuration task. For example:

UNIX

/opt/FileNet/ContentEngine/tools/configure/tmp 

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp

Task enabled Select the Task enabled check box to execute the deploy 
application task later in Step 11. The default is enabled.

Continue with Step 10 on page 406.

In this field... Provide this information...

Deployment type Select “Cluster” from the list. The remaining properties that are 
displayed depend on the type of deployment that you select.

In this field... Provide this information...
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Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
wl.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
wl.ear

Content Engine 
Application name

The Content Engine application name as it will appear in the 
application server (for example, in an administration console). 
The application name is subject to application server naming 
constraints. For WebSphere Application Server, each 
application in a cell must have unique name. The default is 
FileNetEngine. 

Script The fully qualified path to the deploy configuration task script. 
The task script filename depends on the application server type 
selected. For example: 

UNIX

/opt/FileNet/ContentEngine/tools/configure/scripts
/deployWLApplication.py

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\deployWLApplication.py

Temporary directory The fully qualified path to a temporary directory to be used by 
the configuration task. For example:

UNIX

/opt/FileNet/ContentEngine/tools/configure/tmp 

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp

In this field... Provide this information...
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10. Select File > Save.

11. Right-click the Deploy Application task in the left pane, and select Run Task.

Running the deploy task may take a few minutes. The task execution status messages are 
displayed in the Console pane below the deploy application properties.

12. (Upgrades from version 4.0.1 only) If you have more Content Engine instances to upgrade from 
version 4.0.1 on this machine, complete the following substeps:

a. Open the profile you created for the instance in “Configure Content Engine instances upgraded 
from 4.0.x” on page 380.

b. Choose the subdirectory profile for that instance.

c. Repeat Step 5 through Step 12.

13. If you have Tivoli Storage Manager fixed content devices, continue at one of the following; 
otherwise, continue at “Complete Content Engine post-deployment steps” on page 420.

• “Install Tivoli Storage Manager client and add native API library paths (WebSphere)” on page 409

• “Install Tivoli Storage Manager client and add native API library paths (WebLogic)” on page 411

• “Install Tivoli Storage Manager client and add native API library paths (JBoss)” on page 414

Deploy upgraded instances using a command line
In this subtopic you will deploy an upgraded Content Engine instance on a given application 
server using the command-line version of Configuration Manager. See “Configuration Manager 
command-line reference” on page 695 for syntax details.

To deploy a Content Engine instance (command line interface)

1. If you haven’t already done so, log on to the application server machine as config_mgr_user, the 
Configuration Manager user. For details on required accounts and related permissions, see 
“Accounts for Content Engine upgrade” on page 193 in Plan and Prepare Your Environment for 
IBM FileNet P8.

2. Start or stop the application server, depending on its type:

WebSphere and WebLogic

Start the application server if it is not already running.

JBoss

Task enabled Select the Task enabled check box to execute the deploy 
application task later in Step 11. The default is enabled.

Continue with Step 10 on page 406.

In this field... Provide this information...
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 8: Deploy upgraded Content Engine instances
To deploy a Content Engine instance (command line interface)

407
Stop the application server.

3. If you upgraded your application server and then redeployed Content Engine before upgrading it 
to version 4.5 before upgrading Content Engine from version 4.0.x to 4.5, complete the following 
substeps:

a. Open the applicationserver.xml file for editing.

b. Correct any obsolete parameter values for your application server type.

c. Save your edits.

4. Edit the deployapplication.xml file that you generated in “Configure instances using the command 
line interface” on page 372 (version 3.5.x) or in “Configure upgraded instances using a command 
line” on page 387 (version 4.0.x). Refer to the descriptions in the XML file and your installation 
worksheet for more information. For more information, see “Installation and upgrade worksheet” on 
page 229 of Plan and Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls), complete the following actions to quickly 
see only the properties you must specify for Configuration Manager:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select “CM: Deploy Application”.

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Upgrade."

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

5. Set the current directory to ce_install_path/tools/configure, where ce_install_path 
is the path where you installed Content Engine.

As an example, ce_install_path might be /opt/FileNet/ContentEngine.

6. At a command prompt, execute the deployapplication.xml file by running Configuration 
Manager either interactively, or silently (without prompts) by appending the flag -silent to the 
command:

configmgr execute -task DeployApplication -path mypath

where mypath specifies the path where the upgrade.xml file is located.This is the same path 
that you specified when you configure the upgraded Content Engine instance in “Configure 
instances using the command line interface” on page 372 (version 3.5.x) or in “Configure upgraded 
instances using a command line” on page 387 (version 4.0.x).

7. At the command prompt, check the completion status of the deployapplication.xml file by 
running Configuration Manager either interactively, or silently (without prompts) by appending 
the flag
-silent to the command:

configmgr checkStatus -task DeployApplication -path mypath

8. If you have more upgraded Content Engine instances to deploy on this machine, repeat Step 3 
through Step 7.
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9. If you have Tivoli Storage Manager fixed content devices, continue at one of the following; 
otherwise, continue at “Complete Content Engine post-deployment steps” on page 420.

• “Install Tivoli Storage Manager client and add native API library paths (WebSphere)” on page 409

• “Install Tivoli Storage Manager client and add native API library paths (WebLogic)” on page 411

• “Install Tivoli Storage Manager client and add native API library paths (JBoss)” on page 414
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Task 9a: Install Tivoli Storage Manager client and add 
native API library paths (WebSphere)
If Tivoli Storage Manager fixed content devices will be in your IBM FileNet P8 environment, 
complete the following procedures on each application server where Content Engine is deployed. 

NOTE If you used Tivoli Storage Manager with version 3.5.x of Content Engine, you must still 
complete these procedures.

To install Tivoli Storage Manager client

1. Download the Tivoli Storage Manager client software from the IBM Support site http://www-
01.ibm.com/support/docview.wss?uid=swg24019757.

2. Complete the platform-specific installation instructions included with each Tivoli Storage 
Manager client download package.

(UNIX only) Record the path where you install Tivoli Storage Manager client because you will 
need to specify the path as the DSMI directory when you create a Tivoli fixed content device in 
FileNet Enterprise Manager. If you are installing Tivoli Storage Manager client on multiple 
UNIX hosts, the installation path must be the same on each host. 

On AIX, install Tivoli Storage Manager client at /usr/tivoli/tsm/client/ba/bin.

To copy the Tivoli Storage Manager API library files to additional servers

• If you are running a Content Engine server farm, copy the entire tsm100 directory structure 
from the Content Engine installation directory to each of the servers in the farm. It is a best 
practice to use the same directory structure on each server in the farm. The following are 
example paths:

UNIX

/opt/FileNet/ContentEngine/tsm100

Windows

C:\Program Files\FileNet\ContentEngine\tsm100

To create a shared library definition for Tivoli Storage Manager native API library files

1. Log on to the WebSphere administrative console.

2. Create a shared library definition according to the type of deployment (standalone or clustered), 
the version of WebSphere, and the operating system on which WebSphere runs. For the 
detailed procedure on creating the shared library, visit this web site:

http://www-01.ibm.com/software/webservers/appserv/was/library/

a. Specify a Node scope for the library.

b. In a server farm, if you installed the tsm100 directory in different locations, choose Server 
scope and add a Shared Library entry for each server in your server farm.
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c. Provide a name for the shared library, for example TSMAPLIB.

d. In the Classpath field, specify the full path to the TsmJavaApi.jar file (substituting your 
own path if it differs from the default shown here for your operating system):

UNIX

/opt/FileNet/ContentEngine/tsm100/TsmJavaApi.jar

Windows

C:\Program Files\FileNet\ContentEngine\tsm100\TsmJavaApi.jar

e. In the Native Library Path, specify the full path to the tsm100 directory (substitute your own 
path if it differs from the ones shown below):

UNIX

/opt/FileNet/ContentEngine/tsm100

Windows

C:\Program Files\FileNet\ContentEngine\tsm100

f. Save your changes to the master configuration.

g. Navigate to the FileNetEngine application and click the Shared library references link.

h. Under the Available box, select the shared library you created earlier (for example, 
TSMAPILIB) and click the right arrow to move it to the Selected box.

i. Click OK twice to return to the FileNetEngine page and save changes to the master 
configuration.
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Task 9b: Install Tivoli Storage Manager client and add 
native API library paths (WebLogic)
If Tivoli Storage Manager fixed content devices will be in your IBM FileNet P8 environment, 
complete the following procedures on each application server where Content Engine is deployed.

NOTE If you used Tivoli Storage Manager with version 3.5.x of Content Engine, you must still 
complete these procedures.

To install Tivoli Storage Manager client

1. Download the Tivoli Storage Manager client software from the IBM Support site http://www-
01.ibm.com/support/docview.wss?uid=swg24019757.

(UNIX only) Record the path where you install Tivoli Storage Manager client because you will 
need to specify the path as the DSMI directory when you create a Tivoli fixed content device in 
FileNet Enterprise Manager. If you are installing Tivoli Storage Manager client on multiple 
UNIX hosts, the installation path must be the same on each host. 

On AIX, install Tivoli Storage Manager client at /usr/tivoli/tsm/client/ba/bin.

To copy the Tivoli Storage Manager API library files to additional servers

• If you are running a Content Engine server farm, copy the entire tsm100 directory structure 
from the Content Engine installation directory to each of the servers in the farm. It is a best 
practice to use the same directory structure on each server in the farm. The following are 
example paths:

UNIX

/opt/FileNet/ContentEngine/tsm100

Windows

C:\Program Files\FileNet\ContentEngine\tsm100

To create a shared library definition for Tivoli Storage Manager native API library files

1. Open in an edit window the WebLogic script that sets up the domain environment. The following 
are example paths to this script:

UNIX

/opt/bea/user_projects/domains/base_domain/bin/setDomainEnv.sh

Windows

C:\bea\user_projects\domains\base_domain\bin\setDomainEnv.cmd

2. Edit the WebLogic script by adding the lines shown below before the line in which the 
WL_HOME variable is set. Substitute your version identifier in place of weblogic92 as 
appropriate. There is no carriage return after any line that ends with ‘/’ or ‘\’.

AIX
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TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
LIBPATH=${LIBPATH}:${TSMAPILIB}
EXT_POST_CLASSPATH=${EXT_POST_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export LIBPATH EXT_POST_CLASSPATH
WL_HOME="/opt/bea/weblogic92"
export WL_HOME

HP-UX

TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
SHLIB_PATH=${SHLIB_PATH}:${TSMAPILIB}
EXT_POST_CLASSPATH=${EXT_POST_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export SHLIB_PATH EXT_POST_CLASSPATH
WL_HOME="/opt/bea/weblogic92"
export WL_HOME/opt/bea/user_projects/domains/base_domain/bin/
setDomainEnv.sh

Linux

TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
LD_LIBRARY_PATH=${LD_LIBRARY_PATH}:${TSMAPILIB}
EXT_POST_CLASSPATH=${EXT_POST_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export LD_LIBRARY_PATH EXT_POST_CLASSPATH
WL_HOME="/opt/bea/weblogic92"
export WL_HOME

Solaris

TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
LD_LIBRARY_PATH=${LD_LIBRARY_PATH}:${TSMAPILIB}
EXT_POST_CLASSPATH=${EXT_POST_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export LD_LIBRARY_PATH EXT_POST_CLASSPATH
WL_HOME="/opt/bea/weblogic92"
export WL_HOME

Solaris (64-bit)

TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
LD_LIBRARY_PATH_64=${LD_LIBRARY_PATH_64}:${TSMAPILIB}
EXT_POST_CLASSPATH=${EXT_POST_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export LD_LIBRARY_PATH_64 EXT_POST_CLASSPATH
JAVA_OPTIONS="${JAVA_OPTIONS} -d64"
export JAVA_OPTIONS
WL_HOME="/opt/bea/weblogic92"
export WL_HOME

Windows

set TSMAPILIB=C:\Program Files\FileNet\ContentEngine\tsm100
set PATH=%PATH%;%TSMAPILIB%
set EXT_POST_CLASSPATH=%EXT_POST_CLASSPATH%;%TSMAPILIB%\TsmJavaApi.jar
set WL_HOME=C:\bea\weblogic92

3. If you are using WebLogic Node Manager to start and stop WebLogic Managed Servers in a 
clustered environment, you must enable Node Manager to use the appropriate start script:

a. Open for editing the node manager configuration file WL_HOME/common/nodemanager/
nodemanager.properties.

b. Set the StartScriptEnabled property to true (default is false).
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c. Set the StartScriptName to match the script name used by Node Manager to start the 
managed server, depending on your operating system:

UNIX

StartScriptName=startManagedWebLogic.sh

Windows

StartScriptName=startManagedWebLogic.cmd

NOTE If the managed server is not on the same machine as the WebLogic Administration 
Server and you have an alternate script matching the name of the Managed Server in the 
domain bin directory, make sure to specify that script name instead of the more generic 
"startManagedWebLogic" script.

4. Save your edits in nodemanager.properties and restart the Node Manager.
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Task 9c: Install Tivoli Storage Manager client and add 
native API library paths (JBoss)
If Tivoli Storage Manager fixed content devices will be in your IBM FileNet P8 environment, 
complete the following procedures on each application server where Content Engine is deployed. 

NOTE If you used Tivoli Storage Manager in version 3.5.x, you must still complete these 
procedures.

To install Tivoli Storage Manager client

1. Download the Tivoli Storage Manager client software from the IBM Support site http://www-
01.ibm.com/support/docview.wss?uid=swg24019757.

(UNIX only) Record the path where you install Tivoli Storage Manager client because you will 
need to specify the path as the DSMI directory when you create a Tivoli fixed content device in 
FileNet Enterprise Manager. If you are installing Tivoli Storage Manager client on multiple 
UNIX hosts, the installation path must be the same on each host. 

On AIX, install Tivoli Storage Manager client at /usr/tivoli/tsm/client/ba/bin.

To copy the Tivoli Storage Manager API libraries to additional servers

• If you are running a Content Engine server farm, copy the entire tsm100 directory structure 
from the Content Engine installation directory to each of the servers in the farm. It is a best 
practice to use the same directory structure on each server in the farm. The following are 
example paths:

UNIX

/opt/FileNet/ContentEngine/tsm100

Windows

C:\Program Files\FileNet\ContentEngine\tsm100

To create a shared library definition for Tivoli Storage Manager native API library files

1. Open in an edit window the JBoss startup script that sets up the domain environment:

UNIX

run.sh

Windows

run.bat

2. Edit the startup script by adding the following lines at the start of the script:

• AIX

TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
LIBPATH=${LIBPATH}:${TSMAPILIB}
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JBOSS_CLASSPATH=${JBOSS_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export LIBPATH JBOSS_CLASSPATH

• HP-UX

TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
SHLIB_PATH=${SHLIB_PATH}:${TSMAPILIB}
JBOSS_CLASSPATH=${JBOSS_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export SHLIB_PATH JBOSS_CLASSPATH

• Linux

TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
LD_LIBRARY_PATH=${LD_LIBRARY_PATH}:${TSMAPILIB}
JBOSS_CLASSPATH=${JBOSS_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export LD_LIBRARY_PATH JBOSS_CLASSPATH

• Solaris

TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
LD_LIBRARY_PATH=${LD_LIBRARY_PATH}:${TSMAPILIB}
JBOSS_CLASSPATH=${JBOSS_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export LD_LIBRARY_PATH JBOSS_CLASSPATH

• Solaris (64-bit)

TSMAPILIB=/opt/FileNet/ContentEngine/tsm100
LD_LIBRARY_PATH=${LD_LIBRARY_PATH}:${TSMAPILIB}
JBOSS_CLASSPATH=${JBOSS_CLASSPATH}:${TSMAPILIB}/TsmJavaApi.jar
export LD_LIBRARY_PATH JBOSS_CLASSPATH
JAVA_OPTS="${JAVA_OPTS} -d64"
export JAVA_OPTS

• Windows

set TSMAPILIB=C:\Program Files\FileNet\ContentEngine\tsm100
set PATH=%PATH%;%TSMAPILIB%
set JBOSS_CLASSPATH=%JBOSS_CLASSPATH%;%TSMAPILIB%\TsmJavaApi.jar
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Task 10: Install or update ECM Centera SDK library 
files
Perform the procedure in this task to update ECM Centera SDK library files only if Centera fixed 
content devices will be in your upgraded IBM FileNet P8 environment, and either of the following 
conditions apply:

• Centera fixed content devices are not in your existing environment.

• Centera fixed devices are in your existing environment, your existing version of Content 
Engine is 4.0, and you have not installed any fix packs.

To install EMC Centera SDK version 3.2 library files

1. Log on to the Content Engine Server machine with a user account that has the appropriate 
permissions to create folders and install files. 

2. The Centera directory in the Content Engine software package or in the latest P8CE-4.5.0-xxx 
fix pack contains the Centera SDK version 3.2 installation files. As shown in the following table, 
copy the appropriate directory to a location on the Content Engine Server machine, such as 
/tmp (UNIX) or C:\Temp (Windows).

3. On the Content Engine Server machine, navigate within the Centera directory (at its copied 
location) to the install subdirectory, which contains the installer script.

4. Run the installer script corresponding to the operating system on the Content Engine Server 
machine. On UNIX, the installer script will prompt you for the install directory. On Windows, 
specify the install directory, such as C:\Centera_SDK, on the command line. 

UNIX

install.sh

Windows

install.bat C:\Centera_SDK

Operating System Directory To Be Copied

AIX, Solaris, Windows Copy the entire Centera directory

Linux Depending on your version of gcc, copy one of 
the following directories:

Centera/gcc3.3

Centera/gcc4

HP-UX 11i v1 (11.11) Copy Centera/11i-v1-11.11

HP-UX 11i v2 (11.23) Copy Centera/11iv1-11.23
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5. The installer script creates both 32-bit and 64-bit library directories, and puts them in a default 
installation directory, depending on your operating system (as shown in the following table). 
Accept or change the default when prompted by the script.

To configure EMC Centera SDK environment variables for version 3.2

1. Locate the sample setup script on the Content Engine installation media. The file name of the 
sample setup script depends on your operating system:

UNIX

setCenteraLibPath.sh

Windows

setCenteraLibPath.bat

2. Modify the sample setup script as indicated in the following table:

Note that the CENTERA_LIB_PATH variable needs to point to the sample script, not just the 
installation directory that contains the script.

For example, if you have a 64-bit AIX system, and you change the destination installation path 
(install_path in the table below) from:

/usr/local/Centera_SDK (the default)

to:

/usr/local/Centera/SDK3.2.607

then change the installation path of the AIX script to:

/usr/local/Centera/SDK3.2.607/lib/64

Operating 
System

Subdirectories of extracted 
EMC Centera SDK Directory

Description

AIX, 
Solaris, 
and 
Windows

lib lib has the native 
library files that are to 
be installed.

Linux ../gcc3.3/lib

../gcc4/lib

HP-UX ../11i-v1-11.11/lib

HP-UXi ../11i-v1-11.13/lib
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Note that the actual location is appended with either lib/32 or lib/64 because the 
installation script creates both 32-bit and 64-bit library directories, and places them inside the 
lib directory. 

Operating System Script Revisions

AIX From:

CENTERA_LIB_PATH=/usr/local/Centera_SDK/lib/32
LIBPATH=$LIBPATH:$CENTERA_LIB_PATH
export LIBPATH

to:

CENTERA_LIB_PATH=install_path/lib/32

or:

CENTERA_LIB_PATH=install_path/lib/64

Solaris From:

CENTERA_LIB_PATH=/opt/Centera_SDK/lib/32
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$CENTERA_LIB_PATH
export LD_LIBRARY_PATH

to:

CENTERA_LIB_PATH=install_path/lib/32
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$CENTERA_LIB_PATH
export LD_LIBRARY_PATH

or:

CENTERA_LIB_PATH=install_path/lib/64
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$CENTERA_LIB_PATH
export LD_LIBRARY_PATH

Linux From:

CENTERA_LIB_PATH=/usr/local/Centera_SDK/lib/32 
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$CENTERA_LIB_PATH
export LD_LIBRARY_PATH

to:

CENTERA_LIB_PATH=install_path/lib/32
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$CENTERA_LIB_PATH
export LD_LIBRARY_PATH

or:

CENTERA_LIB_PATH=install_path/lib/64
LD_LIBRARY_PATH=$LD_LIBRARY_PATH:$CENTERA_LIB_PATH
export LD_LIBRARY_PATH
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3. Copy the modified script text into one of the application server startup scripts shown in the 
following table, or save the updated script and call it from the application server startup script.

4. Continue at “Complete Content Engine post-deployment steps” on page 420.

HP-UX
HP-UXi

From:

CENTERA _LIB_PATH=/opt/Centera_SDK/lib/32 
SHLIB_PATH=$SHLIB_PATH:$CENTERA_LIB_PATH 
export SHLIB_PATH

to:

CENTERA _LIB_PATH=install_path/lib/32
SHLIB_PATH=$SHLIB_PATH:$CENTERA_LIB_PATH 
export SHLIB_PATH

or:

CENTERA _LIB_PATH=install_path/lib/64
SHLIB_PATH=$SHLIB_PATH:$CENTERA_LIB_PATH 
export SHLIB_PATH

Windows From:

set CENTERA _LIB_PATH=C:\Centera_SDK\lib\32
set PATH=%PATH%;%CENTERA_LIB_PATH%

to:

set CENTERA_LIB_PATH=install_path\lib\32
set PATH=%PATH%;%CENTERA_LIB_PATH%

or:

set CENTERA_LIB_PATH=install_path\lib\64
set PATH=%PATH%;%CENTERA_LIB_PATH%

Application Server Startup Script (UNIX) Startup Script (Windows)

WebSphere setupCmdLine.sh setupCmdLine.cmd

WebLogic setDomainEnv.sh setDomainEnv.cmd

JBoss run.sh run.cmd

Operating System Script Revisions
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Task 11: Complete Content Engine post-deployment 
steps
Perform one of the following post-deployment procedures in this topic, depending on your 
application server type:

• “To complete post-deployment steps (WebSphere)” on page 420

• “To complete post-deployment steps (WebLogic)” on page 421

• “To complete post-deployment steps (JBoss)” on page 421

Then perform the following procedures:

• “To verify the deployment of Content Engine” on page 421

• “To verify the trace log file location” on page 422

To complete post-deployment steps (WebSphere)

1. If you are upgrading from version 3.5.x and you are using federated user repositories, perform 
the following substeps; otherwise, continue at Step 2.

a. Using the WebSphere administrative console, navigate to Security > Secure administration, 
applications, and infrastructure and click Configure.

b. If you have not already done so, specify a unique user (short name) for the Primary 
administrative user name.

NOTE This name must exist in one of the realms and must be unique.

c. Specify the Server user identity. You can specify Automatically generated server identity, or 
specify one that exists in one of the repositories.

NOTE This name must exist in one of the realms and must be unique.

d. Save your changes to the master configuration.

2. If you are upgrading from version 3.5.x, enable administrative security (if it is not already 
enabled) and application security before creating a FileNet P8 domain; otherwise, continue at 
Step 3.

NOTE If you want to enable WebSphere application or administrative security, you must do so 
manually. The deployment of Content Engine does not enable or check these settings.

CAUTION You must disable Java2 security; otherwise, Content Engine will not be able to start 
or process requests.

3. Restart the WebSphere application server where Content Engine is deployed, as follows:

• For a standalone server, stop and start the application server.

• For a WebSphere network deployment, stop and start the application server where Content 
Engine is deployed, including the Deployment Manager and all managed nodes.

• For a cluster, stop and start the cluster.
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4. Continue at “To verify the deployment of Content Engine” on page 421.

To complete post-deployment steps (WebLogic)

1. Restart the WebLogic application server (to reinitialize the WebLogic cache) where Content 
Engine is deployed, as follows:

• For a standalone server, stop and start the application server.

• For a cluster, stop and start the cluster.

2. Continue at “To verify the deployment of Content Engine” on page 421.

To complete post-deployment steps (JBoss)

1. If you are upgrading Content Engine from version 3.5.x, and your directory server type is 
Windows Active Directory, perform the following substeps; otherwise continue at Step 2:

a. Make a backup of JBOSS_HOME/server/all/conf/login-config.xml file

b. Open the login-config.xml for editing.

c. Locate the following line inside the scope of the <login-module> XML element at the 
beginning of the file:

<login-module code="org.jboss.security.auth.spi.LdapExtLoginModule”
              flag="sufficient">

d. Add the following line immediately after the line you located in Step c:

<module-option name="java.naming.referral">follow</module-option>

e. Save your edit.

2. Start the JBoss application server.

3. Continue at “To verify the deployment of Content Engine” on page 421.

To verify the deployment of Content Engine

1. Verify the state of Content Engine deployment by browsing to the following web page:

 http://server:port/FileNet/Engine

where:

server is the host name of the machine where Content Engine Server is deployed.

port is the WSI port used by the application server where Content Engine Server is deployed. 
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Example web page addresses are shown in the following table:

2. Verify that the web page contains the build and version number of Content Engine and its 
associated JAR files, and an indication that no errors occurred.

NOTE It is a best practice to bookmark the web page address in your browser.

3. If you upgraded Content Engine from version 4.0.x, continue at “To verify the trace log file location” 
on page 422; otherwise, continue at “Install the latest Content Engine Client files on other IBM 
FileNet P8 servers (for staged upgrades)” on page 423.

To verify the trace log file location

Perform the following steps to check the path to the trace log file, p8_server_trace.log.

1. Start Enterprise Manager by double-clicking the FileNet Enterprise Manager Administration Tool 
icon on the desktop, or by choosing Start > All Programs > IBM FileNet P8 Platform > FileNet 
Enterprise Manager Administration Tool.

2. Navigate to the level (domain, site, virtual server, or server instance) at which trace logging is 
configured, right-click the node at that level, and choose Properties.

3. Click the Trace Control tab, and perform the following substeps:

a. If the current value of the Log File Output Location parameter is not consistent with the 
version of the application server, edit the value as needed. 

The following table shows default locations, at the server instance level, for the trace log 
file, starting at install_root, the installation path for the application server.

b. Click OK.

Application Server Type Web Page Address

WebSphere  http://server:9080/FileNet/Engine

WebLogic  http://server:7001/FileNet/Engine

JBoss  http://server:8080/FileNet/Engine

Application
Server Type

Path to Trace Log File

WebSphere install_root/profiles/profile_name/FileNet/server_name/
p8_server_trace.log

WebLogic install_root/user_projects/domains/domain_name/FileNet/
server_name/p8_server_trace.log

JBoss install_root/bin/FileNet/server_name/p8_server_trace.log
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 12: Install the latest Content Engine Client files on other IBM FileNet P8 servers (for staged upgrades) 423

IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE

Task 12: Install the latest Content Engine Client files on 
other IBM FileNet P8 servers (for staged upgrades)
When you upgrade Content Engine Server software, you must also upgrade the associated 
Content Engine Client files installed on other machines running IBM FileNet P8 components, for 
example, on Process Engine and Application Engine servers. In a standard upgrade of your IBM 
FileNet P8 system, you would install these client files in the course of upgrading each respective 
component.

However, if you are staging your IBM FileNet P8 upgrade over a period of time and not upgrading 
one or more of the other IBM FileNet P8 components at this time, you must still perform the 
Content Engine Client install on the other component machines. In this case, use the following 
topics in the sections for the other components:

• “Upgrade the Content Engine Client files on Process Engine servers” on page 519

• “Install the latest Content Engine Client files on Application Engine servers” on page 564

NOTES  

• You will have this same client-installation requirement for any expansion products that use 
Content Engine Client files, such as:

– Workplace XT

– Records Manager

– Business Process Framework

• You must redeploy any components that are web-application-server based, such as 
Application Engine, Workplace XT, and Records Manager, after you upgrade the Content 
Engine Client files on the associated machines.



Task 13: Configure storage devices for upgrades from 3.5.x
To prepare file store devices when migrating to UNIX

424
Task 13: Configure storage devices for upgrades from 
3.5.x
Perform the procedures in this topic to prepare your storage devices when upgrading from 
Content Engine version 3.5.x.

To prepare file store devices when migrating to UNIX

• Install and configure  your choice of software to permit the Content Engine UNIX server to 
mount your existing version 3.5.x file store devices. 

To prepare NetApp SnapLock Volumes for the upgrade

If your existing FileNet P8 domain includes a SnapLock fixed content device, complete the 
following procedure. Perform this procedure for each of your NetApp filers (network-attached 
appliances for data storage) to allow access to your fixed content via NFS instead of, or in addition 
to, CIFS.

1. Check the prerequisites.

a. Check the IBM FileNet P8 Hardware and Software Requirements to verify your NetApp filers 
use the version of the Data ONTAP operating system that is supported in version 4.5 of IBM 
FileNet P8. To download this guide from the IBM support page, see “Access IBM FileNet 
documentation, compatibility matrices, and fix packs” on page 20.

For information on accessing and configuring your NetApp filers, consult the following 
Data ONTAP manuals:

• System Administration Guide

• Software Setup Guide

• File Access and Protocols Management Guide

b. Make sure you are licensed to use NFS to access your NetApp filers.

2. Set the security style of a NetApp storage volume to enable support for NFS clients.

Each qtree (virtual subvolume of a storage volume) has exactly one of the security styles 
(scheme for setting security on files and directories in the qtree) shown in the following table:

Security Style Description

UNIX UNIX file permission attributes. Only NFS clients can create files and 
directories in a UNIX qtree.

NTFS Windows access control lists. Only CIFS clients can create files and 
directories in an NTFS qtree.

Mixed Both UNIX and NTFS security styles. Only one security style at a time is 
allowed. The current style is that of the last client to modify it.
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Since all pre-4.0.0 versions of IBM FileNet P8 support only CIFS, all NetApp storage volumes 
used by Content Engine Server use NTFS security style, which you must change to UNIX or 
Mixed. Specify the Mixed style for qtrees that must service requests for both NFS and CIFS 
clients during the upgrade process; otherwise, specify UNIX style.

For each qtree, perform the following steps to specify the security style:

a. Access the Data ONTAP administrative console (see the ONTAP System Administration 
Guide for information on administrative access methods).

b. Run the qtree command as in the following example, which sets the UNIX security style on 
the qtree /vol/vol1/sa1 of NetApp filer NAFiler the security style to UNIX:

telnet NAFiler
qtree security /vol/vol1/sa1 unix

After the qtree command executes, all files created by Content Engine Server on a UNIX 
platform will have UNIX security attributes.

3. Map UNIX users and groups to Window equivalents.

Because version 3.5.x of Content Engine Server support CIFS, rather than NFS, all existing 
files on a NetApp volume have NTFS security attributes; and the users and groups with 
access rights to these files are defined by Windows.

To allow version 3.5.x files to remain accessible, you must create a mapping between the new 
UNIX account for version 4.5 of Content Engine Server and the old Windows account for 
version 3.5.x.

Each NetApp filer has its own configuration file, /etc/usermap.cfg, to map between 
Windows user names and equivalent UNIX user names. A UNIX user attempting to access a 
file having NTFS security attributes uses usermap.cfg to determine if a mapping exists 
between the UNIX account and an equivalent Windows account. If the mapping exists, the 
access checks on the target file will use the Windows account.

Each usermap.cfg entry has the following format:

[IP_qualifier:] Windows_name [direction] [IP_qualifier:] UNIX_name

The meaning of each element in the entry is shown in the following table:

Element Meaning

IP_qualifier Qualifies the name according to the source address of the requester 

Windows_name The name of the Window user or group in domain name format (for 
example, DomainName\UserName). The Windows name must be in the 
Windows domain that the NetApp filer is configured to use when 
authenticating Windows users.
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For example, the following steps define a mapping on a NetApp filer between FNCE_OS_User 
(the Windows user account under which version 3.5.x of Content Engine Server executes) and 
FNCE_UNIX_User (the UNIX user account under which version 4.5 of Content Engine Server 
executes).

a. Log on to the machine where version 3.5.x of the Content Engine is installed.

b. Connect to the root volume on the target NetApp filer using the Administrator account. 

By default, the NetApp filer root volume is accessible from a Windows client as a CIFS 
share named C$), as in the following example (where NAFiler is the host name of the 
target NetApp filer at your site.

C\> net use n: \\NAFiler\C$ /user:NAFiler1\Administrator

c. Edit /etc/usermap.cfg by adding the following stanza:

CEDomain\FNCE_OS_User => FNCE_UNIX_User

d. Edit /etc/passwd by adding the following stanza:

FNCE_UNIX_User:CEServers:205:7100::/home/FNCE_UNIX_User:

Continue at “Upgrade FileNet Enterprise Manager” on page 342.

UNIX_name The name of a UNIX user or group. The name must be defined in the file 
or directory service that the NetApp filer uses to authenticate UNIX 
users. In many cases this will be the local /etc/passwd (for users) or /
etc/group (for groups).

If it is a group, it may be necessary to also define it in an NIS repository 
or an LDAP directory server, depending on how the filer is configured. 

In either case the UID (UNIX user ID) must be identical to the UID of the 
user under which the Content Engine Server is executing.

Direction The direction of the mapping, either <= or =>. 

<=:  Maps UNIX_name to Windows_name

=>:  Maps Windows_name to UNIX_name

Element Meaning
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Task 14: Establish the FileNet P8 domain and Global 
Configuration Data (GCD) for 3.5.x upgrade
Perform the procedures in this topic only if you are upgrading from Content Engine version 3.5.x.

With Content Engine installed and deployed, you will use Enterprise Manager to create a FileNet 
P8 domain.

To create a FileNet P8 domain

NOTE If you run Enterprise Manager as a limited user account, you cannot update the Base URL 
for the FileNet P8 Platform help files field in the General tab of the Enterprise Manager properties 
dialog box.

1. Start Enterprise Manager by double-clicking the FileNet Enterprise Manager Administration Tool 
icon on the desktop, or by choosing Start > All Programs > IBM FileNet P8 Platform > FileNet 
Enterprise Manager Administration Tool.

2. Work through the screens in the following table. The initial values displayed in the screens are 
default values that you must change to match your site. Refer to your installation worksheet for 
the values for your site. For information, see “installation and upgrade worksheet” in Plan and 
Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to quickly see only the 
installation properties you must specify for the Create FileNet P8 domain wizard:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select “EM: Create FileNet P8 domain.”

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Upgrade”.

– Click the AutoFilter drop-down arrow in all the other column headers and select (All).

In this screen... Perform this action...

FileNet P8 
Logon

Click Add to create a FileNet domain.

NOTE For subsequent logons to Enterprise Manager, you can access an 
existing FileNet P8 domain by clicking Connect.
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3. Continue at “To configure directory service authentication” on page 429.

Add Domain 
Configuration

Provide the following information, and then click OK.

• Nickname - A name (not part of any credentials) for connecting to 
Content Engine.

• Connection - http

• Server - The host name of the machine where the Deployment 
Manager (WebSphere) or Administrative Server (WebLogic) runs.

NOTE In a non-managed application server environment (such as a 
JBoss cluster, or a standalone WebSphere or WebLogic), specify the 
host name for just one of the application servers. You can configure 
Enterprise Manager connections to the other non-managed 
application servers.

• Port - The port number appropriate for you application server. For 
example:

– 9080 (WebSphere)

– 7001 (WebLogic)

– 8080 (JBoss)

NOTE In a non-managed application server environment (such as a 
JBoss cluster, or a standalone WebSphere or WebLogic), specify the 
port number for just one of the application servers.

• Path - wsi/FNCEWS40MTOM

• URL - http://server:port/wsi/FNCEWS40MTOM where server and port 
are the values you specified above.

• Username - The value you specified for the bootstrap user name in 
Configuration Manager (see ce_bootstrap_admin in Plan and Prepare 
Your Environment for IBM FileNet P8).

• Password - The password for the bootstrap user.

• Remember password - Select the check box if you want to avoid 
typing the password each time you log on as the bootstrap user. (The 
password will be encrypted.)

• Use integrated login - Select the check box if you want Kerberos 
authentication for the bootstrap user.

In this screen... Perform this action...
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To configure directory service authentication

NOTE For multi-realm authorization, run the Create a Directory Configuration wizard once for each 
realm. Refer to FileNet P8 Administration > Enterprise-wide Administration > FileNet P8 Security > How 
to > Configure for multiple realms.

1. In the FileNet P8 dialog box, click Connect.

2. In the Create P8 Domain screen, enter the name for a new FileNet P8 domain and click 
Continue to start the Create a Directory Configuration wizard.

If an error occurs, check the application server log file on the machine where Content Engine 
is deployed:

3. Work through the screens in the following table. The initial values displayed in the screens are 
default values that you must change to match your site.

The configuration parameters required by the Create a Directory Configuration wizard are in 
many cases the same as those you provided to Configuration Manager when you configured 
LDAP in “Configure Content Engine instances” on page 37.

Refer also to the topic for your directory service within the IBM FileNet P8 help topic System 
Administration > Enterprise-wide Administration > FileNet P8 Security > Directory service providers.

Refer to your installation worksheet for the values for your site. For information, see 
“installation and upgrade worksheet” in Plan and Prepare Your Environment for IBM FileNet 
P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to quickly see only the 
installation properties you must specify for the Create a Directory Configuration wizard:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select “EM: Create a Directory Configuration.”

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Upgrade."

– Click the AutoFilter drop-down arrow in all the other column headers and select (All).

Application 
Server Type

Path to Log File

WebSphere WAS_install_path/AppServer/profiles/profile_name/logs/
server_name/SystemOut.log

WebLogic WLS_install_path/user_projects/domains/domain_name/servers/
server_name/logs/server_name.log

JBoss JBOSS_DIST/server/server_name/log/server_name.log
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In this screen... Perform this action...

Welcome Click Next to proceed.

Select Type and 
Name Directory 
Configuration

Provide the following information, and then click Next.

• Type - The type of directory server you specified in Configuration 
Manager

• Display Name - A name (unique across all FileNet P8 domains in a 
forest) for the new directory configuration

• Existing Names - The names of existing directory configurations 
within the domain to help you choose a unique display name.

Select General 
Directory 
Configuration 
Properties

Provide the following information, and then click Next.

• Host - The name or IP address of the host where the Windows domain 
controller is installed. In a forest environment, the Windows domain names 
must be distinct if name you specify must be unique within each.

• Port - The LDAP port number (389, by default).

• Directory Service User - Fully qualified distinguished name of 
ce_service_user, the directory service bind user you specified when you 
configured LDAP using Configuration Manager.

• Password - Password of the directory service user.

• Is SSL Enabled - True or False.

The following parameters apply only to Active Directory:

• Connection Timeout - Specifies the Active Directory Service provider 
connection timeout in milliseconds. The default is 500 milliseconds. If the 
connection is across a WAN, consider increasing the value.

• Return Name as DN - Specifies format in which Active Directory 
returns user or group names:

– True - Return in Distinguished Name format

– False - Return in User Principal Name format (default choice)
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 14: Establish the FileNet P8 domain and Global Configuration Data (GCD) for 3.5.x upgrade
To configure directory service authentication

431
Select User 
Directory 
Configuration 
Properties

Provide the following information, and then click Next.

• Base DN - Base distinguished string to use in LDAP user searches.

• User Search Filter - LDAP search filter for finding user names.

• User Display Name Attribute - The display name for a user object 
generated by the authentication provider:

Active Directory, Active Directory LDS, IBM Tivoli Directory 
Server, Novell eDirectory

cn (by default)

Sun Java System Directory Server

uid 

• User Short Name Attribute - The name you use to log in:

Active Directory, Active Directory LDS, IBM Tivoli Directory 
Server, Novell eDirectory

cn (by default)

Sun Java System Directory Server

uid 

In this screen... Perform this action...
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 14: Establish the FileNet P8 domain and Global Configuration Data (GCD) for 3.5.x upgrade
To configure permissions for a FileNet P8 domain

432
4. In the Configure New Domain Permissions message box, click OK to acknowledge that the 
directory configuration is complete but remains in restricted mode. The Configure New Domain 
Permissions wizard automatically starts (if you are in Enterprise Manager for the first time and 
have not defined any GCD administrators). Continue at “To configure permissions for a FileNet P8 
domain” on page 432.

To configure permissions for a FileNet P8 domain

1. Work through the screens in the Configure New Domain Permissions wizard, as shown in the 
following table.

For information on the GCD administrators, see “Installation and upgrade worksheet” in Plan 
and Prepare Your Environment for IBM FileNet P8.

Select Group 
Directory 
Configuration 
Properties

Provide the following information, and then click Next.

• Group Base DN - Base distinguished string to use in LDAP group 
searches.

• Group Search Filter - LDAP search filter for finding group names.

• Group Display Name Attribute - cn, by default.

• Group Short Name Attribute - cn, by default.

• Group Membership Search Filter - The search filter for group membership 
queries.

The following parameter applies only to Active Directory.

• Search Cross Forest Group Membership:

– True - Enables cross-forest group membership searches.

– False - Disables such searches (the default).

The following parameter applies to all directory server types but has no effect for 
Active Directory LDS, which does not support cross-domain memberships:

• Restrict membership to configured realms:

– Select the check box to restrict group lookups for a user to 
configured realms only. (The user’s group memberships in 
unconfigured realms are ignored).

– Clear the check box to prevent a user with memberships in 
unconfigured realms from logging on (the system cannot look up 
all group memberships). [Deleted the following (last) paragraph in 
this table cell.]

In this screen... Perform this action...
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HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to quickly see only the 
installation properties you must specify for the Configure New Domain Permissions wizard:

– Click the AutoFilter drop-down arrow in the “Installation or Configuration Program” 
column header, and select “Configure New Domain Permissions.”

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Upgrade."

– Click the AutoFilter drop-down arrow in all the other column headers and select (All).

2. In the Configure New Domain Permissions message box, click OK.

To set the Statement Cache Size value for the GCD database

If you are using Microsoft SQL Server 2005 JDBC Driver or Oracle JDBC Driver, you need to set 
the Statement Cache Size parameter value to 0 for each data source you created to access the 
GCD database, as shown in the following steps:

1. Access the page containing the Statement Cache Size parameter:

WebSphere

Navigate to the WebSphere administrative console page containing the field Statement Cache 
Size property. For example, in WebSphere 6.1.x, navigate to Resources > JDBC Providers > 
JDBC_provider > Data sources > data_source > WebSphere Application Server data source 
properties.

WebLogic

Navigate in the tree view of WebLogic Administration Console to FNCEDomain > Services > 
JDBC > Data Sources > Data_Source_Name > Connection Pool.

2. Set the Statement Cache Size to 0 and save your change.

In this screen... Perform this action...

Welcome Click OK to proceed.

Specify 
Domain 
Administrators

Click Add to load the Select Users and Groups dialog box that lets you add 
users and groups to the list of GCD administrators.

(Optional) Click Remove to remove the Content Engine system user 
(ce_bootstrap_admin in Plan and Prepare Your Environment for IBM 
FileNet P8).

Click Next.

Completing the 
New Domain 
Permissions 
Wizard

Click Finish.
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To enable the Image Services dispatcher for CFS-IS

If Content Federation Services for Image Services (CFS-IS) is part of your version 3.5.x system, 
enable the Image Services dispatcher, as follows:

1. If it is not already running, start Enterprise Manager by double-clicking the FileNet Enterprise 
Manager icon on the desktop, or by choosing Start > All Programs > FileNet P8 Platform > 
Enterprise Manager.

2. Right-click the Enterprise Manager root node in the tree view and choose Properties.

3. Click the IS Import Agent tab, select the Enable Dispatcher check box, and then click OK.
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Task 15:  Create the data sources for an object store
Each object store in your site requires its own distributed (XA) and non-distributed (non-XA) JDBC 
data sources. When you completed “Configure Content Engine instances upgraded from 3.5.x” on 
page 345, you created the JDBC data sources for the Global Configuration Database (GCD). 
Complete either of the procedures in this topic to use Configuration Manager to create the pair 
(XA and non-XA) of data sources for the initial object store. (You can use the same procedures to 
create data sources for subsequent object stores.)

For each additional object store, you must create an another pair of data sources, using the 
procedures in this topic. You can create these data sources after you have confirmed your Content 
Engine configuration.

NOTE Configuration Manager will not create a new data source with the same name as that of an 
existing data source. If you want to reuse the name of an existing data source for an object store, 
manually delete the existing data source before creating the new data source. Refer to your 
application server documentation for more information.

Refer to the information in your installation worksheet to complete the procedures in this topic. For 
more information, see “Installation and upgrade worksheet” on page 229 of Plan and Prepare Your 
Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), complete the following steps to quickly see only the 
installation properties you must specify for creating JDBC data sources:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select one of these Configuration Manager options:

– CM: Set Application Server properties

– CM: Configure JDBC Data Sources

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify: Setup Type contains "Installation."

• Click the AutoFilter drop-down arrow in all other column headers and select (All).

To create the data sources using the graphical user interface to Configuration Manager

1. If you have not done so already, log on to the machine where you installed Content Engine as 
ce_install_user. For details on required accounts and related permissions, see “Accounts for 
Content Engine” on page 71 in Plan and Prepare Your Environment for IBM FileNet P8.

2. Start the GUI version of Configuration Manager by running one of the following commands, 
depending on the operating system on the machine where you installed Content Engine:

UNIX

ce_install_path/tools/configure/CMUI/cmui
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Windows

Complete one of the following actions:

• Double-click the FileNet Configuration Manager desktop shortcut. 

• Select Start > All Programs > IBM FileNet P8 Platform > FileNet Configuration Manager. 

• Run ce_install_path\tools\configure\CMUI\cmui.exe.

3. Refer to your installation worksheet to specify the values for the properties required for your new 
object store data source profile. For more information, see “Installation and upgrade worksheet” on 
page 229 of Plan and Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), complete the following actions to quickly see only the 
properties you must specify for Configuration Manager:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select one of these Configuration Manager options:

– CM: Set Application Server properties

– CM: Configure JDBC Data Sources

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify: Setup Type contains "Installation."

• Click the AutoFilter drop-down arrow in all other column headers and select (All).
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4. Start the Create New Configuration Profile wizard by choosing File > New Configuration Profile 
or by clicking the wizard icon in the tool bar.

In this screen... Complete this action...

Configuration Profile 
Information

• Provide the following information for the profile:

– Enter a name for the profile. The name must be valid as 
a directory name for your operating system. 
Configuration Manager will create a directory with the 
profile name for storing the configuration files 
associated with this profile. For more information of 
profiles, see “Configuration profile concepts” on page 639 in 
the Configuration Manager reference appendix.

– Specify the path for the profile. Either type in the full path 
to the profile directory or click Browse to locate the 
directory. The default path is ce_install_path/tools/
configure/profiles, where ce_install_path is the 
location where Content Engine is installed.

• Choose an application server type for the profile. Select 
WebSphere, JBoss, or WebLogic.

If you click Finish instead of Next, you will create a default 
profile instead of a profile for just the Configure JDBC task. 
You will need to come back later to supply the required 
application server properties before you can run the 
configure JDBC task. 

• Click Next.

• Continue at one of the following screens:

– “Set Application Server Properties for WebSphere” on 
page 438

– “Set Application Server Properties for JBoss” on page 439

– “Set Application Server Properties for WebLogic” on 
page 440
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Set Application Server 
Properties for 
WebSphere

This screen is displayed only if you selected WebSphere in the 
previous screen. 

• Provide the following information for the application server:

– Select the application server version from the list.

– Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the 
directory. 

– Enter the application server administrator user name. 
Use the directory service user account that has been 
assigned the application server administrative role. This 
account is used to manage the application server 
domain/profile, to configure the data sources and 
connection pools for the object store, and to deploy the 
Content Engine application. If Administrative Security is 
already enabled, use an existing administrative user 
account.

– Enter the application server administrative password. 
The password will be encrypted for you. For more 
information on passwords,  see “Handling passwords in 
Configuration Manager” on page 643.

– Enter the application server SOAP port number.

– Enter the name of the WebSphere application server 
cell where Content Engine will be deployed.

– If you have already configured WebSphere to use 
certificates, clear the “Do not use SSL certificates for 
server communications” check box. Otherwise, leave the 
check box selected. 

NOTE  Selecting this check box will change your 
WebSphere settings for communicating with other 
servers, such as Application Engine.

• Click Next.

• Continue with “Select the tasks that you want included in the 
Configuration Profile” on page 440.

In this screen... Complete this action...
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Set Application Server 
Properties for JBoss

This screen is displayed only if you selected JBoss in the 
previous screen. 

• Provide the following information for the application server:

– Select the application server version from the list.

– Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the 
directory. 

– Enter the name of the JBoss application server name 
where Content Engine will be deployed.

• Click Next.

• Continue with “Select the tasks that you want included in the 
Configuration Profile” on page 440.

In this screen... Complete this action...
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Set Application Server 
Properties for WebLogic

This screen is displayed only if you selected WebLogic in the 
previous screen.

• Provide the following information for the application server:

– Select the application server version from the list.

– Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the 
directory. 

– Enter the application server administrator user name. 
Use the directory service user account that has been 
assigned the application server administrative role. This 
account is used to manage the application server 
domain/profile, to configure the data sources and 
connection pools for the object store, and to deploy the 
Content Engine application. If Administrative Security is 
already enabled, use an existing administrative user 
account.

– Enter the application server administrative password. 
The password will be encrypted for you. For more 
information on passwords,  see “Handling passwords in 
Configuration Manager” on page 643.

– Enter the application server SOAP port number.

– Enter the machine name or the IP address of the local 
host for the application server host. 

– Enter the fully qualified path to the WebLogic application 
server user projects directory, or click Browse to locate 
the directory.

– Enter the WebLogic application server domain name 
where Content Engine will be deployed.

– Enter the name of the WebLogic application server 
name where Content Engine will be deployed.

• Click Next.

• Continue with “Select the tasks that you want included in the 
Configuration Profile” on page 440.

Select the tasks that you 
want included in the 
Configuration Profile

• Select only the Configure JDBC Data Sources task. Clear 
the check box for all other tasks. 

• Click Finish to create the profile and save the application 
server properties.

In this screen... Complete this action...
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The profile you created is displayed as an icon in the profile pane (left-hand pane), along with 
the Configure JDBC Data Sources icon.

5. Provide property values for the JDBC data sources for the object store.

a. Right-click Configure JDBC Data Sources in the profile pane, and select Edit Selected Task. 

b. Provide the property values for your database, using the appropriate table for your database 
type:

DB2® for Linux®, UNIX®, Windows®

In this field... Provide this information...

JDBC driver name Select “DB2 Universal JDBC Driver” from the list. The 
remaining properties and values that you need to supply for 
your data source configuration depend on the type of driver 
that you select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the object store tablespace or database. 
For example, FNOS1DS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the object store tablespace or database. For example, 
FNOS1DSXA.

Database server name The host name of the machine where the database software 
is installed.

Database port number The port number used by the DB2 database instance in 
which you create tablespaces for the object stores.

Database name The name of the object store database. 

Database user name The name of the DB2 object store tablespace user.

Database password The password for the DB2 object store tablespace user. The 
tool encrypts the password for you.

Enter the password again in the Confirm field.

JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the object store. The file name must end with -ds.xml. For 
example, os1-ds.xml. 
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DB2® for z/OS®

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the object store. The file name must end with -ds.xml. For 
example, os1-ds.xml. 

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step 6. The default is 
enabled.

In this field... Provide this information...

JDBC driver name Select “DB2 for z/OS Universal JDBC Driver” from the list. 
The remaining properties and values that you need to supply 
for your data source configuration depend on the type of 
driver that you select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the object store tablespace or database. 
For example, FNOS1DS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the GCD tablespace or database. For example, 
FNOS1DSXA.

Database server name The host name of the machine where the database software 
is installed.

Database port number The port number used by the DB2 database instance in 
which you create tablespaces for the GCD and object 
stores.

Database name The name of the GCD database instance name. 

Database user name The name of the DB2 GCD tablespace user.

Database password The password for the DB2 GCD tablespace user. The tool 
encrypts the password for you.

Enter the password again in the Confirm field.

In this field... Provide this information...
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JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the GCD. The file name must end with -ds.xml. For 
example, gcd-ds.xml. 

If you have already created data sources for the GCD and 
do not want the Configuration Manager tool to create them 
for you, leave this field blank and clear the Task enabled 
check box.

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the GCD. The file name must end with -ds.xml. For 
example, gcd-ds.xml. 

If you have already created data sources for the GCD and 
do not want the Configuration Manager tool to create them 
for you, leave this field blank and clear the Task enabled 
check box.

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step 6. The default is 
enabled.

In this field... Provide this information...
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MS SQL Server

In this field... Provide this information...

JDBC driver name Select “Microsoft JDBC Driver 2005” from the list. The 
remaining properties and values that you need to supply for 
your data source configuration depend on the type of driver 
that you select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the GCD tablespace or database. For 
example, FNOS1DS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the GCD tablespace or database. For example, 
FNOS1DSXA.

Database server name The host name of the machine where the database software 
is installed.

Database port number The port number used by the SQL Server database instance 
in which you create databases for the GCD and object 
stores.

Database name The name of the GCD database for SQL Server.

Database user name The name of the SQL Server user with administrative rights 
to the GCD database.

Database password The password for the SQL Server user with administrative 
rights to the GCD database. The tool encrypts the password 
for you.

Enter the password again in the Confirm field.

JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the GCD. The file name must end with -ds.xml. For 
example, gcd-ds.xml. 

If you have already created data sources for the GCD and 
do not want the Configuration Manager tool to create them 
for you, leave this field blank and clear the Task enabled 
check box.
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Oracle

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the GCD. The file name must end with -ds.xml. For 
example, gcd-ds.xml. 

If you have already created data sources for the GCD and 
do not want the Configuration Manager tool to create them 
for you, leave this field blank and clear the Task enabled 
check box.

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step 6. The default is 
enabled.

In this field... Provide this information...

JDBC driver name Select “Oracle JDBC Driver” from the list. The remaining 
properties and values that you need to supply for your data 
source configuration depend on the type of driver that you 
select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the GCD tablespace or database. For 
example, FNOS1DS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the GCD tablespace or database. For example, 
FNOS1DSXA.

Database server name The host name of the machine where the database software 
is installed.

Database port number The port number used by the Oracle database instance in 
which you create tablespaces for the Global Configuration 
Data (GCD) and object stores.

Database name The SID of the Oracle database containing the GCD 
tablespace.

Database user name The name of the Oracle GCD tablespace owner.

Database password The password for the Oracle GCD tablespace owner. The 
tool encrypts the password for you.

Enter the password again in the Confirm field.

In this field... Provide this information...
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Oracle RAC

JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the GCD. The file name must end with -ds.xml. For 
example, gcd-ds.xml. 

If you have already created data sources for the GCD and 
do not want the Configuration Manager tool to create them 
for you, leave this field blank and clear the Task enabled 
check box.

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the GCD. The file name must end with -ds.xml. For 
example, gcd-ds.xml. 

If you have already created data sources for the GCD and 
do not want the Configuration Manager tool to create them 
for you, leave this field blank and clear the Task enabled 
check box.

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step 6. The default is 
enabled.

In this field... Provide this information...

JDBC driver name Select “Oracle JDBC Driver (RAC support)” from the list. The 
remaining properties and values that you need to supply for 
your data source configuration depend on the type of driver 
that you select.

JDBC data source name The JNDI name of the non-XA JDBC data source 
associated with the object store tablespace or database. 
For example, FNOS1DS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated 
with the object store tablespace or database. For example, 
FNOS1DSXA.

Database server name 
RAC node 1

The host name of the machine where the database software 
is installed for node 1.

Database port number 
RAC node 1

The port number used by the Oracle database instance in 
which you create tablespaces for the object stores.

Database server name 
RAC node 2

The host name of the machine where the database software 
is installed for node 2.

In this field... Provide this information...
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c. Select File > Save to save your changes.

6. Apply the JDBC property settings by right-clicking Configure JDBC Data Sources in the profile 
pane, and select Run Task. Running the configuration task can take a few minutes. The task 
execution status messages are displayed in the Console pane below the bootstrap properties.

TIP  You can check the completion status of a task by right-clicking Configure JDBC Data 
Sources in the profile pane, and select Check Task Status.

7. (Oracle and JBoss only) Continue at “To edit XA data source XML files” on page 450.

8. (WebSphere only) Stop and start WebSphere Application Server.

9. Continue at “Upgrade Content Search Engine software from 3.5.x” on page 451.

Database port number 
RAC node 2

The port number used by the Oracle database instance in 
which you create tablespaces for the object stores.

Database service name The SID of the Oracle database containing the object store 
tablespace.

Oracle RAC retries The number of retries for Oracle RAC.

Oracle RAC delay The amount of delay for Oracle RAC.

Database user name The name of the Oracle object store tablespace owner.

Database password The password for the Oracle object store tablespace owner. 
The tool encrypts the password for you.

Enter the password again in the Confirm field.

JDBC data source file 
name

The JDBC data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the object store. The file name must end with -ds.xml. For 
example, os1-ds.xml. 

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with 
the object store. The file name must end with -ds.xml. For 
example, os1-ds.xml.

Task enabled Select the Task enabled check box to execute the configure 
JDBC Data Sources task later in Step 6. The default is 
enabled.

In this field... Provide this information...
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To create the data sources using the command-line interface to Configuration Manager

1. If you have not done so already, log on to the machine where you installed Content Engine as 
ce_install_user. For details on required accounts and related permissions, see “Accounts for 
Content Engine” on page 71 in Plan and Prepare Your Environment for IBM FileNet P8.

2. Set the current directory to ce_install_path/tools/configure, where:

ce_install_path is the path where you installed Content Engine.

3. Generate the configurejdbc.xml file and the applicationserver.xml file by running the 
following command:

configmgr generateConfig -appserver app_server_type -db db_type -ldap 
ldap_type -deploy deploy_type -task ConfigureJDBC -path mypath

where:

app_server_type is WebSphere, WebLogic, or JBoss.

db_type specifies the type of database to be used by Content Engine and must be one of the 
following: mssql, oracle, oracle_rac, db2, or db2zos.

ldap_type specifies the type of directory service repository Content Engine uses for 
authenticating users and must be one of the following: activedirectory, adam, edirectory, 
sunjava, or tivoli. The adam option applies to both Microsoft ADAM and AD LDS. 

deploy_type  specifies the type of Content Engine deployment. The value must be one of the 
following: standard, cluster, or netdeploy (network deployment). Specify standard if you are 
deploying Content Engine to a standalone (that is, a server that is neither managed nor 
clustered) WebSphere, WebLogic, or JBoss application server. Specify cluster if you are 
deploying Content Engine to a WebSphere, WebLogic, or JBoss application server cluster. 
Specify netdeploy if you are deploying Content Engine to a managed WebSphere application 
server instance (using Network Deployment for managing individual servers that are not 
necessarily in a cluster).

-path mypath is optional and specifies the path to where the generated configuration XML files 
will be placed. If you are deploying multiple Content Engine instances on the same machine, 
you will need to specify a separate directory for each instance.

4. Use a text editor or XML editor to open the applicationserver.xml file and edit it as follows:

a. Refer to the appropriate parameter information from your installation and upgrade worksheet 
for the following steps. For information on the parameter values, see “Installation and 
upgrade worksheet” on page 229 in Plan and Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls), complete the following steps to quickly see 
only the installation properties you must specify for your application server:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select “CM: Set Application Server properties.”

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Installation."
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• Click the AutoFilter drop-down arrow in all other column headers and select (All).

b. Replace each occurrence of ****INSERT VALUE**** with a value appropriate for your site. 
Refer to the descriptions in the file for more information.

c. Verify that the default values for the remaining properties are correct for your site. 

d. (Optional) Encrypt the password for the application server administrative user by running the 
password encryption utility (see “Encrypt passwords” on page 700), and then copy the 
encrypted value into the file. 

CAUTION Any password you do not encrypt will be stored and sent as clear text.

e. Save your edits.

5. Use a text editor or XML editor to open the configurejdbc.xml file and edit it as follows:

a. Refer to the appropriate parameter information from your installation and upgrade worksheet 
for the following steps. For information on the parameter values, see “Installation and 
upgrade worksheet” on page 229 in Plan and Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls), complete the following steps to quickly see 
only the installation properties you must specify for creating JDBC data sources:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select “CM: Create JDBC data sources.”

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Installation."

• Click the AutoFilter drop-down arrow in all other column headers and select (All).

b. Replace each occurrence of ****INSERT VALUE**** with a value appropriate for your site. 
Refer to the descriptions in the file for more information.

c. Verify that the default values for the remaining properties are correct for your site. 

d. Set the <TaskEnabled> value to true so you can run the configuration task in Step 6.

e. (Optional) Encrypt the password for the user of the database associated with the data 
sources you are creating by running the password encryption utility (see “Encrypt passwords” 
on page 700), and then copy the encrypted value into the file. 

CAUTION Any password you do not encrypt will be stored and sent as clear text.

f. Save your edits.

6. Execute the configurejdbc.xml file by running the following command:

configmgr execute -task ConfigureJDBC -path mypath

where -path mypath is optional and specifies the path to the configureJDBC.xml file.

7. Check the completion status by running the following command:

configmgr checkStatus -task ConfigureJDBC -path mypath

where -path mypath is optional and specifies the path to the configureJDBC.xml file.
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8. (Oracle and JBoss only) Continue at “To edit XA data source XML files” on page 450.

9. (WebSphere only) Stop and start WebSphere Application Server.

10. Continue at “Create the initial object store” on page 133.

To edit XA data source XML files

ConSelectfiguration Manager puts the following <mbean> tag into the XML file for each XA data 
source it creates when the database type is Oracle and the application server type is JBoss:

<mbean code="org.jboss.resource.adapter.jdbc.vendor.OracleXAExceptionFormatter"
    name="jboss.jca:service=OracleXAExceptionFormatter">
<depends optional-attribute name="TransactionManagerService">

jboss:service=TransactionManager
</depends>

</mbean>

At this point, if you have created an XA data source for the GCD in “Configure Content Engine 
instances upgraded from 3.5.x” on page 345 and have not manually created any XA data sources, only 
one XA data source XML file contains an <mbean> tag.

Because exactly one XA data source XML file must contain an <mbean> tag, you need to remove 
the tag from the XML file for the XA data source you have just created in this topic, or for any XA 
data source you create later; otherwise, you will not be able to create an associated object store.

Complete the following steps to remove the <mbean> tag from the XA data source XML file:

1. Navigate to the directory containing all the XA data source XML files. For example, if JBoss is 
installed on a UNIX machine and the JBoss server name is server1, the directory is typically 
JBOSS_HOME/server/server1/deploy.

2. Find the XML file for the XA data source you created in this topic and open it for editing. For 
example, if the XA data source is named FNDS1, the XML file name is FNDS1XA-ds.xml.

3. Find and delete the <mbean> tag from the XML file.

4. Save your edits.

5. Continue at “Upgrade Content Search Engine software from 3.5.x” on page 451.
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Task 16a: Upgrade Content Search Engine software 
from 3.5.x
Follow this task to upgrade the Content Search Engine software and related data from 3.5.x to 
4.5.x.

If you used the full-text search feature (CBR) in 3.5.x, you must install and configure the new 4.5 
Content-Search Engine (Autonomy K2) software. The 3.5.x content-search indexes must be 
upgraded to 4.5.x index areas, now called K2 collections.

As of the 4.0 release of P8 Platform, the full-text search feature was removed as a built-in function 
of the Content Engine. Instead, the remote, Autonomy K2 Content Search Engine software is 
installed and configured through Enterprise Manager to enable full-text searching.

To upgrade Content Search Engine from version 3.5.x to 4.5.x, you will install and configure the 
Autonomy K2 product and then upgrade the existing indexes in conjunction with the upgrade of 
Content Engine data as part of the overall upgrade of the Content Engine.

Production environment upgrades
Upgrade of Content Search Engine and related Content Engine data must occur as an in-place 
upgrade. As such, the data is migrated to 4.5.x and is no longer usable in the previous version of 
the P8 Platform.

The 3.5.x index areas are upgraded at the same time as the Content Engine data is upgraded, 
through the Content Engine upgrader tool. When the upgrader tool runs, specific changes are 
made to the GCD, in relation to Content-Based Retrieval, to facilitate the installation of the new 
Autonomy K2 product. The tool also uses the existing Verity information to create the Verity 
Domain Configuration, including new locale requirements, for the Autonomy K2 product.

To perform an upgrade in a migration scenario, create a duplicate of your P8 system by performing 
a backup and then a restore. Using the restored system, complete the migration from 3.5.x to 
4.5.x. This will leave the original production environment untouched while testing is performed on 
the new system.

When you’re ready to migrate the production environment to the current version, back up the 
system and then perform the in-place upgrade on the production environment.

Content Search Engine software upgrade

The Autonomy K2 software must be installed on each machine that is part of your Content Search 
Engine configuration. You must designate one machine in the configuration as the Master 
Administration Server. The Master Administration Server can be used as a standalone Content 
Search Engine, or additional K2 Administration Servers can be added. All K2 Administration 
servers are configured and controlled through the K2 Dashboard of the Master Administration 
server.

The Autonomy K2 software that underlies IBM FileNet P8 Content Search Engine has many 
inherent features that you might want to configure that are not discussed in the IBM FileNet 
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documentation. For details, see the Autonomy documentation that is installed with the Autonomy 
K2 Master Administration Server located at:

http://Master Administration Server hostname:9990/verity_docs/

The Autonomy documentation set is not searchable from the IBM FileNet P8 Help but it does have 
its own internal index and search functionality.

CAUTION  Although the K2 Dashboard provides you with documentation for, and direct interfaces 
to, the K2 collections, IBM FileNet requires that you use Enterprise Manager to manage 
collections associated with Content Search Engine index areas (for example, to add and remove 
index areas).

NOTES

• Autonomy K2 was previously known as Verity, and you will see Verity still used in many of the 
interfaces described in the following procedures.

• If your Content Engine runs on Windows, then the machines in your Content Search Engine 
configuration must run on Windows. If your Content Engine runs on UNIX, then the machines 
in your Content Search Engine configuration must run on UNIX, but it to doesn’t have to be the 
same UNIX type.

• Where machine name variables are required, IP addresses will not validate. A valid name 
must be entered.

• If you unimport the style set, the original files will be deleted from your system. In this 
scenario, if you wish to re-import the style set, you will need to recover it from your installation 
package. In order to avoid this situation, you can either enter a unique name for the Style Set 
Alias during the initial Content Search Engine (Autonomy K2) installation, or make a backup 
copy of the original style set. If you enter a unique name for the style set during installation, 
ensure you use that name when you configure Content Engine for Content-Based Retrieval.

• Stop word files can be used to increase performance by about 30%. You can put a file named 
style.stp into the stylefiles directory to list words you do not want full-text indexed (for 
example, short words such as a, the, and). However, using a stop word file also prevents 
searching on these words. See the K2 documentation for more details. To create a stop word 
file you can typically copy a file named vdk30.stp from either the main K2 install directory or 
the foreign language locales package over to the main stylefile directory, and then rename it to 
style.stp. You must do this copy operation before you create collections.

Indexing is case-sensitive, so the style.stp file should include capitalized versions of words in 
the stop word list in addition to the lower-case version. For example, use “the”, “The” and 
“THE” if you think all of these would be encountered on a search.

Install Content Search Engine on Windows
Use this procedure to install and configure IBM FileNet P8 Content Search Engine, an optional 
component based on the Autonomy K2 product.

Install the Autonomy K2 software on each machine in your Content Search Engine configuration. 
You must complete a K2 Master Administration Server software installation before you can add 
any additional K2 Administration Server installations. The Master Administration Server’s 
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dashboard is the central control point for configuring all additional Administration Servers that are 
part of the Content Search Engine configuration.

You must designate each installation as either a Master Administration Server software 
installation or an Administration Server software installation.

CAUTION Only one K2 Master Administration Server can be installed for each Content Engine 
Domain.

To install Autonomy K2 on Windows

1. Access the host machine and log on as k2_os_user. For details on required accounts and related 
permissions, see “Accounts for Content Search Engine” on page 92 in Plan and Prepare Your 
Environment for IBM FileNet P8.

NOTE  Ensure k2_os_user has administrator privileges on this machine.

2. Set the JAVA_HOME environment variable as follows:

a. Open the System control panel.

b. Click the Advanced tab.

c. Click Environment Variables.

d. Click New under System Variables.

e. Set the variable information as follows:

Variable name: JAVA_HOME

Variable value: Java (JDK) install path

NOTE  The installer will not allow you proceed with the installation until the JAVA_HOME 
environment variable is set.

3. Start the Content Search Engine installation, choosing either the interactive or silent steps 
below, For information on the Content Search Engine parameter values to specify in the 
installation, see “Installation and Upgrade Worksheet” in Plan and Prepare Your Environment 
for IBM FileNet P8.

HINT  With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls), perform the following steps to quickly see only 
the installation properties you must specify for the Content Search Engine installation 
program:

– Click the AutoFilter drop-down arrow in the "FileNet P8 Component” column header 
and select CSE (Windows).

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header, and select CSE Installer.

– Click the AutoFilter drop-down arrow in all other column headers and select (All).
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• To install interactively:

i. Access the IBM FileNet Content Search Engine installation package and execute the 
P8CSE-4.5.0-WIN.EXE file. 

ii.  Complete the installation program wizard using the following table:

In this screen... Perform this action...

JAVA_HOME Not 
Set

This screen will appear only if you have not set the 
JAVA_HOME environment variable on the machine.

Click Cancel to exit the installation program and set the 
required environment variable.

NOTE  The installer will not allow you to continue until you set 
the environment variable.

Click Next to continue.

JAVA_HOME for K2 
Server

Enter the path to the supported Java (JDK) installation and 
click Next to continue.

Welcome Click Next to proceed with the installation.

NOTE Click Previous at any time to make changes in previous 
screens. Click Cancel to exit the program.

Software License 
Agreement

Review and accept the license agreement.

Click Next to continue.

Specify Content 
Search Engine 
Installation Path

Specify the directory in which you want to install Content 
Search Engine. The installation program will create any 
specified directories that do not already exist.

Click Next to continue.

Select Autonomy 
K2 Server Type

Choose whether to install a Master Administration Server 
(required for first-time installation) or an Administration 
Server.

Click Next to continue.

Specify 
Administration 
Server Information

This screen will appear only if you selected Administration 
Server on the Select Autonomy K2 Server Type screen.

Enter the host name and port for the Administration Server.

Click Next to continue.
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• To install silently

i. Access the IBM FileNet Content Search Engine installation package and edit the 
CSE_silent_install.txt file to reflect the appropriate responses for your installation.

ii. Launch the Content Search Engine installer by executing the following command:

P8CSE-4.5.0-WIN.EXE -f CSE_silent_install.txt -i silent

NOTE  The following two Autonomy K2 services will be installed and started on your machine 
after the installation is complete:

• Verity K2 6.2.1 Administration Server service.

• Verity K2 Administration Web Server service (Tomcat server).

4. Review the following Content Search Engine log files for installation errors. The files are located 
in the verity directory of the install path:

• cse_install_path\verity\cse_install_log_4_5_0.txt

• cse_install_path\verity\vconfig.log

5. Continue at “Configure Content Search Engine” on page 460.

Install Content Search Engine on UNIX
You must install the K2 Master Administration Server software first. The Master Administration 
Server’s dashboard is the central control point for configuring Content Search Engine for single-
server or multi-server installations.

Specify Master 
Administration 
Server Information

Enter the host name and server port for the Master 
Administration Server.

NOTE  If you are installing a K2 Administration Server, the 
Master Administration Server must already be installed.

Click Next to continue.

K2 Operating 
System User 
Account

Enter the k2_os_user login information and the name of the 
Verity domain on which this K2 server communicates with the 
Content Engine.

Click Next to continue.

Review Pre-
installation 
Summary

Verify your component selections, and click Install to start 
installing software.

Install Complete Click Done to complete the installation.

In this screen... Perform this action...
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You must designate each installation as either a Master Administration Server software 
installation or an Administration Server software installation.

CAUTION Only one K2 Master Administration Server can be installed for each Content Engine 
domain.

To install Content Search Engine on UNIX

NOTE  Most processes for the Autonomy K2 software will run as k2_os_user. However, the 
vspget process must run as root. For details on required accounts and related permissions, see 
“Accounts for Content Search Engine” on page 92 in Plan and Prepare Your Environment for IBM 
FileNet P8.

1. Access the host machine and log on as a user with root privileges.

2. Enter the following commands to set the vspget program’s setuid bit such that the service runs 
as root:

chown root /verity install path/k2/_platform/bin/vspget

chmod u+s /verity install path/k2/_platform/bin/vspget 

Replace _platform with the following directory, according to your environment: 

3. Log off the machine.

4. Log on to the machine as k2_os_user.

5. Set the following environment variable and place the entry in the .profile file for 
k2_os_user.

JAVA_HOME=java_(JDK)_install_path/jdkversion

export JAVA_HOME

6. Start the Content Search Engine installation using your Installation and Upgrade Worksheet. For 
information on the Content Search Engine parameter values, see “Installation and Upgrade 
Worksheet” in Plan and Prepare Your Environment for IBM FileNet P8.

HINT  With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls), perform the following steps to quickly see only 
the installation properties you must specify for the Content Search Engine installer:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select CSE Installer.

Platform Directory

HPUX _hpux

AIX _rs6k43

Solaris _ssol26

Linux _ilnx21
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– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Installation."

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

• To install interactively (X-Terminal must be installed):

i. Access the IBM FileNet Content Search Engine installation package and execute the 
appropriate installation program:

ii.  Complete the installation program wizard using the following table:

Platform Command

HPUX P8CSE-4.5.0-HPUX.BIN

AIX P8CSE-4.5.0-AIX.BIN

Solaris P8CSE-4.5.0-SOL.BIN

Linux P8CSE-4.5.0-LINUX.BIN

In this screen... Perform this action...

JAVA_HOME Not 
Set

This screen will appear only if you have not set the 
JAVA_HOME environment variable on the machine.

Click Cancel to exit the installation program and set the 
required environment variable.

NOTE  The installer will not allow you to continue until you set 
the environment variable.

JAVA_HOME for K2 
Server

Enter the path to the supported Java (JDK) installation and 
click Next to continue.

Welcome Click Next to proceed with the installation.

NOTE Click Previous at any time to make changes in previous 
screens. Click Cancel to exit the program.

Software License 
Agreement

Review and accept the license agreement.\

Click Next to continue.

Specify Content 
Search Engine 
Installation Path

Specify the directory in which you want to install Content 
Search Engine. The installation program will create any 
specified directories that do not already exist.

Click Next to continue.

Select Autonomy 
K2 Server Type

Choose whether to install a Master Administration Server 
(required for first-time installation) or an Administration 
Server.

Click Next to continue.
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• To install silently

i. Access the IBM FileNet Content Search Engine installation package and edit the 
CSE_silent_install.txt file to reflect the appropriate responses for your 
installation.

ii. Execute one of the following commands, based on your operating system:

NOTE  The following two Autonomy K2 services will be installed and started on your machine 
after the installation is complete:

• Verity K2 6.2.1 Administration Server service.

• Verity K2 Administration Web Server service (Tomcat server).

Specify 
Administration 
Server Information

This screen will appear only if you selected Administration 
Server on the Select Autonomy K2 Server Type screen.

Enter the host name and server port for the Administration 
Server.

Click Next to continue.

Specify Master 
Administration 
Server Information

Enter the host name and server port for the Master 
Administration Server.

NOTE  If you are installing a K2 Administration Server, the 
Master Administration Server must already be installed.

Click Next to continue.

K2 Operating 
System User 
Account

Enter the k2_os_user log in information and click Next to 
continue.

Review Pre-
installation 
Summary

Verify your component selections, and click Install to start 
installing software.

Install Complete Click Done to complete the installation.

Platform Command

HPUX P8CSE-4.5.0-HPUX.BIN -f CSE_silent_install.txt -i silent

AIX P8CSE-4.5.0-AIX.BIN -f CSE silent install.txt -i silent

Linux P8CSE-4.5.0-LINUX.BIN -f CSE_silent_install.txt -i 
silent

Solaris P8CSE-4.5.0-SOL.BIN -f CSE_silent_install.txt -i silent

In this screen... Perform this action...
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7. Review the following Content Search Engine log files for installation errors. The files are located 
in the verity directory of the install path:

• cse_install_path/verity/cse_install_log_4_5_0.txt

• cse_install_path/verity/vconfig.log

8. Set the following environment variables and place the entries in the .profile file for 
k2_os_user.

HP-UX

PATH=$PATH:/verity_install_path/k2/_hpux/bin

export PATH

SHLIB_PATH=$SHLIB_PATH:/verity_install_path/k2/_hpux/bin

export SHLIB_PATH

AIX

PATH=$PATH:/verity_install_path/k2/_rs6k43/bin

export PATH

LIBPATH=$LIBPATH:/verity_install_path/k2/_rs6k43/bin

export LIBPATH

Solaris

PATH=$PATH:/verity_install_path/k2/_ssol26/bin

export PATH

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/verity_install_path/k2/_ssol26/bin

export LD_LIBRARY_PATH

Linux

PATH=$PATH:/verity_install_path/k2/_ilnx21/bin

export PATH

LD_LIBRARY_PATH=$LD_LIBRARY_PATH:/verity_install_path/k2/_ilnx21/bin

export LD_LIBRARY_PATH

To start or stop the Autonomy K2 Services on UNIX

To manually start or stop the Autonomy K2 services, use the following commands, according to 
your environment:

HP-UX

Start services:

nohup /verity_install_path/k2/_hpux/bin/k2adminstart &

Stop services:

/verity_install_path/k2/_hpux/bin/k2adminstop
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AIX

Start services:

nohup /verity_install_path/k2/_rs6k43/bin/k2adminstart &

Stop services:

/verity_install_path/k2/_rs6k43/bin/k2adminstop

Solaris

Start services:

nohup /verity_install_path/k2/_ssol26/bin/k2adminstart &

Stop services:

/verity_install_path/k2/_ssol26/bin/k2adminstop

Linux

Start services:

nohup /verity_install_path/k2/_ilnx21/bin/k2adminstart &

Stop services:

/verity_install_path/k2/_ilnx21/bin/k2adminstop

Configure Content Search Engine

Use this procedure to configure services required on the K2 Master Administration Server, and on 
additional Administration Servers you may install for IBM FileNet P8 Content Search Engine. All 
servers are configured through the Master Administration Server Dashboard.

NOTES 

• When naming servers you create with this procedure, it is a best practice to indicate the type 
of server you’ve created. Otherwise, when you configure Content Engine through the 
Enterprise Manager, determining which server is which could be confusing. For example, use 
server_name_broker to indicate a Broker Server service.

• Ensure you carefully record the server names, ports and settings that you define. Much of the 
following information will be required later when you configure the IBM FileNet P8 Content 
Engine for Content-Based Retrieval later in this guide.

• A range of ports is recommended in the Verity K2 Dashboard for each service you create. You 
do not have to choose a port number from within that range.

• Repeat the related step in the procedure below to add additional services. Some guidelines 
must be adhered to when adding additional services:

– Multiple brokers can be assigned, so that if one goes down the others will be used. 
However, each broker must have all K2 Servers (search servers) attached that are needed 
to access collections (index areas). The Content Engine Server will not call multiple 
brokers and merge the results.
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– If you add additional Index Servers and K2 Servers (search servers), they will not be 
activated until you enable them through Enterprise Manager. See “Configure Content Engine 
for content-based retrieval” on page 165 for details.

– Each K2 Administration Server must contain a Ticket Server for Content Engine.

– For good stability and performance, Broker Servers must be attached to local Ticket 
Servers for security on each machine.

To configure Content Search Engine

1. Configure the Autonomy K2 Dashboard to use SSL security. The Autonomy K2 Dashboard web 
application, by default, uses a non-SSL web site and sends username and password information 
in plain text. For information on how to modify your Tomcat web applications to use SSL, access 
the following address:

 http://tomcat.apache.org/tomcat-5.5-doc/ssl-howto.html

2. Access the K2 Dashboard by launching your browser and entering:

http://Master Administration Server hostname:9990/verity_dashboard/main.jsp

Use the appropriate values from your installation and upgrade worksheet for the procedures 
that follow.  For more information, see “Installation and upgrade worksheet” on page 229 of Plan 
and Prepare Your Environment for IBM FileNet P8.

HINT  With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to quickly see only the required 
properties:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select “K2 Dashboard”.

– Optional: click the AutoFilter drop-down arrow in the "FileNet P8 Component" column 
header and select “CSE (UNIX)” or “CSE (Windows)", depending on your operating 
system type.

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

3. Create a K2 Index Server, as follows:

a. Click K2 Index Servers under System View.

b. Click Add a K2 Index Server on the K2 Index Server Summary page.

c. Enter the following information on the Configure basic settings for the new K2 Index Server 
page:

• Service Alias: K2 Index Server Alias

• Port: 9960 - 9979 (suggested range)

d. Click Next to continue with the installation.
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e. Enter the following information on the Configure threads for the K2 Index Server page:

• Synchronous Threads: 25

• Asynchronous Threads: 3

• Access Type: Authorized Administrator

f. Click Finish to continue with the installation.

4. Set the Index Server logging properties:

a. Click the Index Server, Under System View, that you want to adjust.

b. Click Edit Properties under Actions.

c. Click the Logging tab.

d. For Status Log Nominal Size, enter the following value:

9000 kilobytes

e. Click Modify.

5. Create a K2 Broker Server:

a. Click K2 Brokers under System View.

b. Click Add a K2 Broker on the K2 Broker Summary page.

c. Enter the following information on the Configure basic settings for the new K2 Broker page:

• Service Alias: K2 Broker Server Alias

• Port: 9900 - 9909 (suggested range)

d. Click Finish.

6. Create a K2 Server (search server) and attach the Broker:

a. Click K2 Servers under System View.

b. Click Add a K2 Server under Actions on the K2 Server Summary page.

c. Enter the following information on the Configure basic settings for the new K2 Server page:

• Service Alias: K2 Server (search server) Alias

• Port: 9920 - 9949 (suggested range)

d. Click Next.

e. Click Next on the Set security options for this service page.

f. Enter the following information on the Attach to K2 Brokers page:

• Select the K2 Brokers that will provide access to this service: Select the K2 Broker you 
created in step 3 from the drop-down menu, server_name_broker.

g.  Click Finish.

7. Import the IBM FileNet Styleset.
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a. Click Collections under System View.

b. Click Manage Style Sets under Actions on the Collection Summary page.

c. Click Import on the Manage Style Sets page (top right).

d. Enter the following information on the Import page:

• Style Set Alias: FileNet_FileSystem_PushAPI

• Gateway Type: --Auto-detect--

• Source Administration Server. If multiple servers are installed, choose the server to 
which you will import the Styleset.

• Source Path:

Windows

install_path\verity\data\stylesets\FileNet_FileSystem_PushAPI

UNIX

 install_path/verity/data/stylesets/FileNet_FileSystem_PushAPI

e. Click Import.

NOTE  The K2 Dashboard displays a notification that the StyleSet Editor web application 
cannot be accessed. This message can be ignored as it relates to a function that is not used 
by IBM FileNet Content Search Engine.

8. Create a K2 Ticket Server.

a. Click K2 Ticket Servers under System View.

b. Click Add a K2 Ticket Server under Actions on the K2 Ticket Server Summary page.

c. Enter the following information on the Configure basic settings for the new K2 Ticket Server 
page:

• Service Alias: K2 Ticket Server Alias

• Port: 9910 - 9919 (recommended range)

d. Click Next.

e. Enter the following information on the Configure the login module to use with this K2 Ticket 
Server page:

• Select which Login Module type to use with this K2 Ticket Server:

NOTE  LDAP Ticket Servers are not currently supported.

– Windows

– UNIX

• Default Domain (Windows only): Enter the domain on which this K2 Server is 
authenticated. 

f. Click Next.
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g. Enter the following information on the Configure the persistent store module to use with this 
K2 Ticket Server page:

• Select the Persistent Store Module type to use with this K2 Ticket Server: Choose File 
and Memory.

h. Click Finish.

i. (Windows only) Specify local login settings:

i. Click Edit Properties.

ii. Click Windows Login Module.

iii. Check Use Local Credentials:.

iv. Check Enable Built-in Groups.

v. Click Modify.

9. Set Autonomy K2 Administration Security.

a. Click the K2 Ticket Server you created.

b. Click Manage Administration Security under Actions.

c. Enter the following information on the Manage Administration Security page:

• Select a K2 Ticket Server to configure for administration security: From the drop-down 
menu, select the K2 Ticket Server you just created.

• User Name: Enter the k2_os_user. For UNIX installs, this is the user you logged in as to 
run the installation. For details on required accounts and related permissions, see 
“Accounts for Content Search Engine” on page 92 in Plan and Prepare Your Environment 
for IBM FileNet P8.

• Password: Enter the authentication password.

• Default Domain (Windows only): Enter the domain on which this user and K2 Server 
are authenticated.

d. Click Modify.

The K2 software will authenticate the user based on the information you entered. If the 
check fails, an error message will indicate what failed and request that you re-enter the 
information.

If administrator access is successful, Autonomy K2 will close the Dashboard and require 
that you log on again as the Dashboard Administrator to complete the configuration.

10. Launch the K2 Dashboard and log on.
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11. Restart K2 services:

a. Under Notifications on the K2 Dashboard Home page, a number of servers are listed as 
requiring a restart. Click Start/Stop this Service to access the settings page and follow the 
instructions listed there. You must perform either a Quick Restart or a Full Restart.

b. Click Home in the top-left corner of the page after each restart to view the remaining 
notifications. Repeat the process until there are no notifications remaining.

12. Enable additional K2 Admin Users (optional).

a. From the K2 Dashboard home page, click Administration Servers.

b. Click Manage K2 Administrative Users.

c. Click Add User on the Manage K2 Administrative Users page.

d. Enter the name of an authenticated user on the directory service that you want to make a K2 
Administrator and click Add.

13. Enable security on the K2 services you have created.

a. From the K2 Dashboard home page, click K2 Ticket Servers.

b. Click your ticket server server_name_ticket_server.

c. Click Manage K2 Broker/K2 Server Security in the Services Secured by this K2 Ticket 
Server section of the page (bottom right).

d. Click the K2 Servers button on the Manage K2 Broker/K2 Server Security page.

e. Click the service you just created which is listed in the window on the right to enable 
security.

CAUTION  If you have a multi-server configuration, numerous services, installed on other 
machines, will be listed also. Select only the service to which you want to attach a broker. 
Brokers must be attached to local ticket servers for Content Search Engine.

f. Click the K2 Brokers button on the Manage K2 Broker/K2 Server Security page.

g. Click the Broker in the window on the right that you want to attach to the local K2 ticket 
server you selected above.

h. Click Modify to save your changes.

14. Restart K2 services, as follows:

a. Click Home in the top left corner of the page.

b. Under Notifications on the Verity K2 Dashboard Home page, a number of servers are listed 
as requiring a restart. Click Start/Stop this Service to access the settings page and follow 
the instructions listed there. You must perform either a Quick Restart or a Full Restart.

Click Home in the top left corner of the page after each restart to view the remaining 
notifications. Repeat the process until there are no notifications remaining.
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To configure services on Administration Servers

Use this procedure to create and configure services on specific Content Search Engine machines 
(Administration Servers), other than the Master Administration Server. Services for all machines 
in your Content Search Engine configuration are configured through the Master Administration 
Server Dashboard.

1. Click Administration Servers under System View.

2. Click the Administration Server to which you want to add services.

3. Click Add a Service under K2 Services on this Administration Server.

4. Select the service you want to add.

5. Follow the instructions and guidelines for the appropriate service in the To configure Content 
Search Engine procedure above to complete the service addition.

Configure Autonomy K2 to upgrade 3.5.x indexes
To create a collections directory

For performance reasons, it is recommended that you create one collections directory for each 
index area you create in IBM FileNet P8 Content Engine. Each collections directory you create 
must be set to provide proper security access. The path to both the collections directory and 
collections temp directory must be entered in the index area properties when you create them. 

Security and communication between Autonomy K2, Content Engine, and the collections directory 
is handled through the user accounts and permissions provided to those accounts. For details on 
required accounts and related permissions, see “Accounts for Content Search Engine” on page 92 and 
the related worksheet. For detailed information on security, see the IBM FileNet P8 help topic 
FileNet P8 Administration > Enterprise-wide Administration > FileNet P8 Security > Authorization > 
Security for integrated components and third-party products > Autonomy K2 Server > Security for 
Autonomy K2 Server.

Collections directory requirements for Content Search Engine

CAUTION  Contrary to information outlined in the Autonomy-supplied documentation set, remote 
collections are not supported for use with IBM FileNet Content Search Engine. Collections must 
be written locally to the Autonomy K2 server. Using a remote-mounted disk that is accessed via the 
network (NFS, PCNFS, or CIFS) will cause stability problems under load and corrupt your 
collections. Any existing configurations that contain non-local collections directories must be re-
configured.

To create a collections directory

1. Create a directory in which you will store collections (VerityIndexArea.RootDirectoryPath). This 
directory must be located on a disk that is local to the Verity server. Set permissions to allow 
access to the k2_os_user.

NOTE  This path must be local to the index server that will be assigned to write collections.
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2. Create a temp directory (VerityIndexArea.TempDirectoryPath) which will be used by the K2 
Index Server and Content Engine Server during operations.

NOTE  This path must be visible to both the Content Engine and the Autonomy K2 servers. 
This means that if the K2 Administration Server and Content Engine are not installed on the 
same machine, they both must be on a network mounted file system.

3. Provide read/write access to the collections directory for Autonomy K2 by entering the full path 
to the location and record the temp collections path.

Windows

a. Open the following K2 configuration file in a text editor (default path shown):

C:\Program Files\filenet\contentengine\verity\k2\common\verity.cfg

b. Modify the next available alias settings by adding the collections path, where new collections 
will be written. For example, change alias6, mapping6, and dirmode6 to the following:

alias6=path1

mapping6=C:\Collections_Directory

dirmode6=wr

c. Modify the next available alias settings by adding an entry for each 3.5.x collections path, 
expressed as UNC, that you want to upgrade. For example, change alias7, mapping7, and 
dirmode7 to the following:

alias7=path2

mapping7=\\CE35_File_storage_share\FS_object_store\index\fs0

dirmode7=wr

Your 3.5.x collections path might point to a file store index or a database index in the 
object store FS_object_store. If you have additional file store indexes or database indexes, 
you will add similar entries for alias8, mapping8, and dirmode8, alias 9, mapping9, and 
dirmode9, and so on.

UNIX

a. Open the following K2 configuration file in a text editor (default path shown):

/opt/verity/k2/common/verity.cfg

b. Modify the next available alias settings by adding the collections path. For example, change 
alias6, mapping6, and dirmode6 to the following:

alias6=path1

mapping6=/Collections_Directory_Path

dirmode6=wr

NOTE  The Collections_Directory_Path must be a local path and not a mount point.

4. Set file store access. Each file store that will be full text indexed must be accessible by the 
Autonomy K2 server that will perform the full text indexing. Permissions on the file store must be 
set the same as the permissions on the collections directories, allowing both the Content Engine 
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Operating System User and the Verity Operating System User to access them. The names of 
the file store directories must also be the same on each server that access the directories.

NOTE  Although we are mapping remote collections, which are not supported, indexing will not 
be run on these indexes. The mapping is used to close the collections.

Windows-specific options

You can configure a read-only Autonomy K2 Administration server which will remotely read 
collections (note that you cannot have a second K2 Administration server that writes the 
collections). To do this, you must map a drive on the read-only Administration server to the file 
system on the Autonomy K2 machine that writes collections.

To do this, share the Autonomy K2 machine’s collections drive (for example, D:\) as some name 
other than D$, because you can't set permissions on D$. For example, set it as DDrive.

Map the D:\ drive on the read-only Autonomy K2 machine to \\servername\DDrive.

Now D:\collections on the read-only Autonomy K2 machine references the same file system as 
the D:\ drive on the Autonomy K2 machine that writes the collections.

By default, the k2admin.exe program on the read-only Autonomy K2 machine runs as a Windows 
service. This is a problem because Windows services can not mount mapped drives.

One solution to this problem is to run the k2admin.exe program from a command line instead, so 
that it doesn’t run as a Windows service. To launch the service manually from a command line on 
a default installation, execute the following command:

C:\Program Files\verity\k2_61\k2\_nti40\bin\k2admin.exe" -cfg "C:\Program 
Files\verity\k2_61\k2\common\verity.cfg

NOTE Only the Verity K2 6.1.1 Administration Server service (k2admin.exe) must be started this 
way. The Verity Administration Web Server may be left as a Windows service.

Another solution is to use a tool like the srvany.exe program (supplied as part of the Windows 
Resource kit) to run a .cmd file that first maps the drives, and then issues the command above to 
start the k2admin.exe service. The command to map drives, using the above example, is:

net use D: \\servername\DDrive

There are also third-party products available that function the same as the svrany.exe program.

Although the svrany.exe program will start the service correctly, it cannot stop the service. You 
must use the Autonomy rcadmin command line tool to stop the service, or use Task Manager and 
stop all the processes that start with the prefix k2.

To use the Autonomy rcadmin program from a command line:

1. Access a command line and type the following command:

rcadmin

2. Enter the following command to log on:

login k2_os_user
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3. Enter the following command to initiate the shutdown:

adminsignal

4. Enter one of the following responses to the Type of Signal query:

• 2 - Shutdown

• 3 - WS Refresh

• 4 - Restart all servers

Completing the upgrade

The remaining steps required to complete an upgrade of Content Search Engine must be 
completed as part of the overall Content Engine upgrade and are outlined at the appropriate 
locations later in this guide.
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 16b: Upgrade Content Search Engine software from 4.0.x
Production environment upgrades

470
Task 16b: Upgrade Content Search Engine software 
from 4.0.x
This task describes how to upgrade the IBM FileNet Content Search Engine software and related 
data from 4.0.x to 4.5.x.

If you used the full-text search feature (CBR) in 4.0.x, to upgrade you must export your current K2 
server configurations on each machine, uninstall Autonomy K2, install the new version of Content-
Search Engine (Autonomy K2) software and then import your saved configuration.

Production environment upgrades
Upgrading of Content Search Engine and related Content Engine data must occur as an in-place 
upgrade. As such, the data is migrated to 4.5.x and is no longer usable in the previous version of 
the P8 Platform.

The 4.0.x index areas are upgraded at the same time as the Content Engine data is upgraded, 
through the Content Engine upgrader tool.

To perform an upgrade in a migration scenario, create a duplicate of your P8 system by performing 
a backup and then a restore. Using the restored system, complete the migration from 4.0.x to 
4.5.x. This will leave the original production environment untouched while testing is performed on 
the new system.

When you’re ready to migrate the production environment to the current version, back up the 
system and then perform the in-place upgrade process on the production environment.

Content Search Engine Upgrade
To upgrade Autonomy K2 Server software on Windows

To upgrade Content Search Engine, perform the following upgrade procedure on all machines 
running Autonomy K2 software. Upgrade the K2 Master Administration Server first, before 
upgrading the K2 Administration Servers.

NOTE  If you have a multi-server configuration, do not start any K2 services until after all 
machines have been upgraded.

1. Access the Autonomy K2 machine and log on as k2_os_user.

2. Access Windows Component Services and stop the two Verity K2 services.

3. Copy the IBM FileNet Content Search Engine installation package to the Autonomy K2 machine.

4. (Master Administration Server only) Open a command window and change directory to the 
location of the IBM FileNet Content Search Engine installation package. Execute the following 
command:

backup_k2.bat “verity_install_path” “temporary_location_path”

Replace “verity_install_path” with the path to the verity folder in the current installation 
path.
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Replace “temporary_location_path” with the location in which you want to temporarily back 
up your Autonomy K2 configuration files, outside of the current installation path. Files from this 
backup will be used to restore your existing configuration after you complete the software 
upgrade.

For example: backup k2.bat “C:\Program Files\FileNet\contentengine\verity” “C:\temp”

5. Access the Windows control panel and run, in reverse order of installation, the uninstall for each 
Autonomy-related entry that is listed in the Add or Remove Programs control panel. Ensure each 
has been executed before continuing.

CAUTION  Order of uninstall is crucial. Some of the entries do not contain any obvious version 
identification and you must click the Change/Remove button and wait for the Autonomy 
uninstaller to launch in order to identify the version number.

NOTE  This will remove only the added Patch, Service Pack and Fix Pack updates and will not 
uninstall the base IBM FileNet Content Search Engine software.

6. Complete the manual uninstall procedure for IBM FileNet Content Search Engine 4.0.x as 
follows:

a. Remove the K2 Dashboard service:

i. From a command window, access the following directory:

C:\Progam Files\Filenet\ContentEngine\verity\appserver\bin

ii. Enter the following command:

service remove k2

b. Remove the Autonomy K2 installation:

i. From a command window, access the following directory:

C:\Progam Files\Filenet\ContentEngine\Verity

ii. Enter the following command:

k2\_nti40\bin\vconfig -cfg "C:\Program 
Files\filenet\contentengine\verity\config.vcnf" -dir "C:\Program 
Files\filenet\contentengine\verity" -verbose -log log.txt -uninstall

The Autonomy K2 Administration Server service and Tomcat application server will be 
uninstalled at the completion of the vconfig command.

7. If collections are stored anywhere in the installation path, move the collections directory 
and the temp directory to a temporary location outside the installation path.

8. Delete the Autonomy K2 software installation directory.
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9. Access the IBM FileNet Content Search Engine installation package and Install the Content 
Search Engine software, using the appropriate values from your worksheet:

HINT  With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to quickly see only the 
installation properties you must specify for the Content Search Engine installation program:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select CE installer.

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Installation."

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

• To install interactively:

i. Access the IBM FileNet Content Search Engine installation package and execute the 
P8CSE-4.5.0-WIN.EXE file. 

ii. Complete the installation program wizard using the following table:

In this screen... Perform this action...

JAVA_HOME Not Set This screen will appear only if you have not set the 
JAVA_HOME environment variable on the machine.

Click Cancel to exit the installation program and set the required 
environment variable.

NOTE  The installer will not allow you to continue until you set 
the environment variable.

JAVA_HOME for K2 
Server

Enter the path to the supported Java (JDK) installation and click 
Next to continue.

Welcome Click Next to proceed with the installation.

NOTE Click Previous at any time to make changes in previous 
screens. Click Cancel to exit the program.

Software License 
Agreement

Review and accept the license agreement.

Click Next to continue.

Specify Content Search 
Engine Installation Path

Specify the directory in which you want to install Content 
Search Engine. The installation program will create any 
specified directories that do not already exist.

Click Next to continue.

Select Autonomy K2 
Server Type

Choose whether to install a Master Administration Server 
(required for first-time installation) or an Administration Server.

Click Next to continue.
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• Silently

i. Access the IBM FileNet Content Search Engine installation package and edit the 
CSE_silent_install.txt file to reflect the appropriate responses for your installation. 
Refer to your installation worksheet.

ii. Launch the Autonomy K2 Master Administration server installer by executing the 
following command:

P8CSE-4.5.0-WIN.EXE -f CSE_silent_install.txt -i silent

CAUTION  Ensure you install to the same path as your previous installation.

10. Review the following Content Search Engine log files for installation errors. The files are located 
in the verity directory of the install path:

• cse_install_path\verity\cse_install_log_4_5_0.txt

• cse_install_path\verity\vconfig.log

11. Access Windows Component Services and stop the two running Verity K2 services.

Specify Administration 
Server Information

This screen will appear only if you selected Administration 
Server on the Select Autonomy K2 Server Type screen.

Enter the host name and server port for the Administration 
Server.

Click Next to continue.

Specify Master 
Administration Server 
Information

Enter the host name and server port for the Master 
Administration Server.

NOTE  If you are installing a K2 Administration Server, the 
Master Administration Server must already be installed.

Click Next to continue.

K2 Operating System 
User Account

Enter the k2_os_user log in information and the name of the 
domain on which this K2 server communicates with the Content 
Engine.

Click Next to continue.

Review Pre-installation 
Summary

Verify your component selections, and click Install to start 
installing software.

Install Complete Click Done to complete the installation.

In this screen... Perform this action...
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12. (Master Administration Server only) Open a command window and change directory to the 
location of the IBM FileNet Content Search Engine installation package. Execute the following 
command:

restore_k2.bat “temporary_location_path” “verity install path”

Replace “temporary_location-path” with the temporary path you entered earlier in this 
procedure when you ran backup k2.bat.

Replace “verity install path” with the path to the verity folder in the Autonomy K2 
installation path. This action will restore your configuration from the backup files.

For example: 

restore k2.bat “C:\temp” “C:\Program Files\FileNet\contentengine\verity”

13. If you moved collections in step 6 above, restore your collections directory and temp 
directory to their original locations.

14. For a single-machine configuration, Access Windows Component Services and start the two K2 
services. For multi-machine configurations, don't start the services until all machines have been 
upgraded.

15. Access the K2 Dashboard and verify that the services from your previous installation are 
restored and running. For Master Administration Servers, delete the temporary directory of the 
backup you ran earlier (“temporary_location_path”).

To upgrade Autonomy K2 Server software on UNIX

To upgrade Content Search Engine, perform the following upgrade procedure on all machines 
running Autonomy K2 software. Upgrade the K2 Master Administration Server first, before 
upgrading the K2 Administration Servers.

NOTE  If you have a multi-server configuration, do not start any K2 services until after all 
machines have been upgraded.

1. Access the Autonomy K2 machine and log on as k2_os_user.

2. Stop the Autonomy K2 Administration Server service and the Tomcat application server. Use the 
following command, according to your environment:

HP-UX

/verity_install_directory/k2/_hpux/bin/k2adminstop

AIX

/verity_install_directory/k2/_rs6k43/bin/k2adminstop

Solaris

/verity_install_directory/k2/_ssol26/bin/k2adminstop

Linux

/verity_install_directory/k2/_ilnx21/bin/k2adminstop

3. Copy the IBM FileNet Content Search Engine installation package to the machine.
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4. (Master Administration Server only) Change directory to the location of the IBM FileNet Content 
Search Engine installation package. Execute the following command:

backup_k2.sh “verity install path” “temporary location path”

Replace “verity_install_path” with the path to the verity folder in the current installation 
path.

Replace “temporary_location_path” with the location in which you want to temporarily back 
up your Autonomy K2 configuration files, outside of the current installation path. Files from this 
backup will be used to restore your existing configuration after you complete the software 
upgrade.

For example, backup k2.sh “/opt/verity” “/opt/temp”.

5. Uninstall all Autonomy K2 Service Packs and Fix Packs.

a. Change directory to verity install path/verity/patches.

b. Execute the patch uninstaller.

• CLI

Execute the following command:

./K2TK_patchUninstall.bin -console

• Interactively (X terminal must be installed)

Launch the K2TK_patchUninstall.bin file and complete the uninstall screens.

NOTE  This will remove only the added Patch, Service Pack and Fix Pack updates and will 
not uninstall the base IBM FileNet Content Search Engine software.

6. Complete the manual uninstall procedure for IBM FileNet Content Search Engine 4.0.x as 
follows:

a. Access the following folder:

verity_install_path/verity/

b. Enter the following command (default install path shown):

k2/platform/bin/vconfig -cfg "/opt/verity/config.vcnf" -dir "/opt/verity" -
verbose -log log.txt -uninstall

Substitute one of the following for platform:

• _ssol26 (Solaris 8.0, 9.0 or 10.0)

• _hpux (HP-UX 11i with -AA compiler flag)

• _rs6k43 (AIX 5.2 and 5.3)

• _ilnx21 (Red Hat Advanced Server 3.0 and 4.0, SUSE 8 and 9)

The Autonomy K2 Administration Server service and Tomcat will be uninstalled at the 
completion of the vconfig command.
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7. If collections are stored anywhere in the installation path, move the collections directory 
and the temp directory to a temporary location outside the installation path.

8. Delete the install directory.

9. If k2_os_user does not have root privileges, log the user off the machine and then log on as a 
user with root privileges.

10. Enter the following commands to set the vspget program’s setuid bit such that the service runs 
as root:

NOTE  Most processes for the Autonomy K2 software will run as k2_os_user. However, the 
vspget process must run as root. For details on required accounts and related permissions, see 
“Accounts for Content Search Engine” on page 92 in Plan and Prepare Your Environment for IBM 
FileNet P8.

chown root /verity install path/k2/_platform/bin/vspget

chmod u+s /verity install path/k2/_platform/bin/vspget 

Replace _platform with the following directory, according to your environment: 

11. If necessary, log the user off the machine and log on again as k2_os_user to complete the 
installation.

12. Access the IBM FileNet Content Search Engine installation package and Install the Content 
Search Engine software, using the appropriate values from your worksheet:

HINT  With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to quickly see only the 
installation properties you must specify for the Content Search Engine installer:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select CE installer.

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Installation."

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

Platform Directory

HPUX _hpux

AIX _rs6k43

Solaris _ssol26

Linux _ilnx21
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• To install interactively (X-Terminal must be installed)

i. Access the IBM FileNet Content Search Engine installation package and execute the 
appropriate installation program:

ii.  Complete the installation program wizard using the following table:

Platform Command

AIX P8CSE-4.5.0-AIX.BIN

HPUX P8CSE-4.5.0-HPUX.BIN

Linux P8CSE-4.5.0-LINUX.BIN

Solaris P8CSE-4.5.0-SOL.BIN

In this screen... Perform this action...

JAVA_HOME Not 
Set

This screen will appear only if you have not set the 
JAVA_HOME environment variable on the machine.

Click Cancel to exit the installation program and set the 
required environment variable.

NOTE  The installer will not allow you to continue until you set 
the environment variable.

JAVA_HOME for K2 
Server

Enter the path to the supported Java (JDK) installation and 
click Next to continue.

Welcome Click Next to proceed with the installation.

NOTE Click Previous at any time to make changes in previous 
screens. Click Cancel to exit the program.

Software License 
Agreement

Review and accept the license agreement.

Click Next to continue.

Specify Content 
Search Engine 
Installation Path

Specify the directory where you want to install Content 
Search Engine. The installation program will create any 
specified directories that do not already exist.

Click Next to continue.

Select Autonomy 
K2 Server Type

Choose whether to install a Master Administration Server 
(required for first-time installation) or an Administration 
Server.

Click Next to continue.
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• Silently

i. Access the IBM FileNet Content Search Engine installation package and edit 
CSE_silent_install.txt to reflect the appropriate responses for your installation. 
Refer to your installation worksheet.

ii. Execute the following command:

./P8CSE-4.5.0-UNIX_type.BIN -f CSE_silent_install.txt -i silent

CAUTION  Ensure you install to the same path as your previous installation.

13. Review the following Content Search Engine log files for installation errors. The files are located 
in the verity directory of the install path:

• cse_install_path/verity/cse_install_log_4_5_0.txt

• cse_install_path/verity/vconfig.log

14. Stop the Verity K2 Administration Server service and the Tomcat service which were 
automatically started by the installer. See step 2 above for instructions.

15. (Master Administration Server only) Change directory to the location of the IBM FileNet Content 
Search Engine installation package. Execute the following command:

restore_k2.sh “temporary_location_path” “verity_install_path”

Specify 
Administration 
Server Information

This screen will appear only if you selected Administration 
Server on the Select Autonomy K2 Server Type screen.

Enter the host name and server port for the Administration 
Server.

Click Next to continue.

Specify Master 
Administration 
Server Information

Enter the host name and server port for the Master 
Administration Server.

NOTE  If you are installing a K2 Administration Server, the 
Master Administration Server must already be installed.

Click Next to continue.

K2 Operating 
System User 
Account

Enter the k2_os_user log in information and click Next to 
continue.

Review Pre-
installation 
Summary

Verify your component selections, and click Install to start 
installing software.

Install Complete Click Done to complete the installation.

In this screen... Perform this action...
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Replace “temporary_location_path” with the temporary path you entered earlier in this 
procedure when you ran the backup k2.sh file.

Replace “verity install path” with the path to the verity folder in the Autonomy K2 
installation path. This action will restore your configuration from the backup files.

For example, restore k2.bat “/opt/temp” “/opt/verity”.

16. If you moved collections in step 6 above, restore your collections directory and temp 
directory to their original locations.

17. For a single-machine configuration, start the K2 services. For multi-machine configurations, 
don't start the services until all machines have been upgraded.

To start the Verity K2 Administration Server service and the Tomcat service, use the follow 
commands, according to your environment:

HP-UX

/verity_install_directory/k2/_hpux/bin/k2adminstart

AIX

/verity_install_directory/k2/_rs6k43/bin/k2adminstart

Solaris

/verity_install_directory/k2/_ssol26/bin/k2adminstart

Linux

/verity_install_directory/k2/_ilnx21/bin/k2adminstart

18. Access the K2 Dashboard and verify that the services from your previous installation are 
restored and running. Delete the temporary directory of the backup you ran earlier 
(“temporary_location_path”).

NOTE  The upgrade of Content Search Engine must be completed as part of the overall Content 
Engine upgrade. The steps are outlined at the appropriate locations later in this guide.

To complete the upgrade, you will enter Autonomy K2 Master Administration Server configuration 
and collections path details into the upgrader tool during the Content Engine upgrade.

Once the Content Engine upgrader tool has been run, the upgrade of Content Search Engine is 
complete.
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Upgrading Content Engine data from version 3.5.x or 4.0.x to 4.5 involves the following major 
steps (detailed later in this task topic), to be done in the order shown:

1. If you did not install Content Engine Upgrader when you upgraded the Content Engine software, 
install the Upgrader tool now. Run the Content Engine installer on a Windows machine, and 
select the Tools option in the Choose Components screen.

For more information on running the Content Engine installer, review the following procedures:

• “To install or upgrade Content Engine” on page 333, for upgrades from 3.5.x

• “To upgrade Content Engine software from 4.0.x” on page 337

2. Upgrade Content Engine data.

a. If you will run the Content Engine Upgrader tool on a computer that does not have Content 
Engine installed, copy the JDBC drivers for your database to the computer where the 
Upgrader tool is installed. See “To install the JDBC drivers” on page 481.

b. Edit the Upgrader tool utility file CE450Upgrader.bat. See “To edit the upgrader utility file” on 
page 481.

c. Run the Upgrader tool from a command line or a graphical interface to upgrade Content 
Engine 3.5.x or 4.0.x items (including the GCD, object stores, file storage areas, etc.) to 
version 4.5.

Even if you plan to run the Upgrader tool using the graphical user interface method, it is 
helpful to first read the command line interface method. Both methods involve the same 
basic steps:

i. Create an XML upgrade status file.

ii. Run the Upgrader tool, driving it from the XML upgrade status file.

See “Command-line interface to the Upgrader tool” on page 489 or “Graphical user interface to 
the Upgrader tool” on page 483.

3. (Upgrades from 3.5.x only) Complete post-upgrade Content Engine configuration.

a. Clear the read-only attribute for NTFS file storage areas.

b. (Optional) Move file storage areas and Content Search areas (collections) from Windows 
machines to UNIX machines.

NOTES

• You do not need to check in checked-out documents before running the Upgrader tool.

• The Upgrader tool must run on a Windows machine with at least 1.5 GB of available memory 
(as indicated by Windows Task Manager).

• If the maximum heap size of the JVM is 1 GB or more, do not run the Upgrader tool on the 
same machine where any other major application is running (such as the database used by 
Content Engine) unless the machine has at least 2 GB of RAM.
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• To upgrade Content Engine 3.5.x or 4.0.x data—object stores, addons, file stores, fixed 
content devices (FCDs), etc.—to version 4.5, you will use the Upgrader tool, which you can 
run interactively, via a graphical user interface (GUI), or silently, via a command line interface 
(CLI). You can also switch between the two methods during the upgrade.

• If you are upgrading an IBM FileNet P8 environment containing a large number of object 
stores, use the following approach: 

– When using the Upgrader tool, upgrade at most 20 object stores at a time.

– If the application server where version 4.5 of Content Engine is deployed is running on a 
32-bit JVM, you should restrict each 4.5 FileNet P8 domain to no more than 50 object 
stores. If the 3.5.x or 4.0.x FileNet P8 domains contain more than 50 object stores, 
consider partitioning them into multiple 4.5 FileNet P8 domains during the upgrade 
process.

– Ensure that 3.5.x and 4.0.x object stores having the same basic set of system objects (for 
file stores, fixed file stores, etc.) are upgraded into the same 4.5 FileNet P8 domain.

• Be aware that the time to upgrade object stores from version 3.5.x depends on the number of 
documents they contain, the database type, and the resources of the machine on which the 
database system runs. If you are upgrading version 3.5.x object stores that contain more than 
a million documents or a million custom objects, the Upgrader tool can take more than an hour 
to complete the upgrade.

• For non-English support relating to collections, refer to IBM FileNet P8 Platform Installing 
Non-English Environments Technical Notice. To download this guide from the IBM support 
page, see “Access IBM FileNet documentation, compatibility matrices, and fix packs” on page 20.

To install the JDBC drivers

Perform this procedure only if you have installed the Upgrader tool on a computer that does not 
have Content Engine installed. For example, if you are upgrading a UNIX system, you must run 
the Upgrader tool on a Windows system to upgrade the Content Engine data. You can install the 
Upgrader tool on Windows without installing all of the Content Engine components.

1. Refer to the IBM FileNet P8 Hardware and Software Requirements for information on the JDBC 
driver file for the database type that you need for the GCD or object stores you will be 
upgrading. To download this guide from the IBM support page, see “Access IBM FileNet 
documentation, compatibility matrices, and fix packs” on page 20.

2. Depending on your database types, copy the appropriate JDBC driver file to a directory on the 
system that has the Upgrader tool installed. For example. copy the file to the C:\jars 
directory.

CAUTION  Do not copy the file to the ...WebSphere\AppServer\lib\ext directory.

To edit the upgrader utility file

1. Edit the ce_install_path/tools/upgrade/CE450Upgrader.bat file to increase the 
minimum and maximum JVM heap sizes. The recommended minimum and maximum JVM 
heap sizes (-Xms and -Xmx) are 512 MB and 1024 MB. If you are upgrading a system that has 
only a few object stores that do not have many custom objects, you can skip this step and use 
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the default settings for  the minimum and maximum heap size arguments in these commands 
(256 MB and 512 MB, respectively).

To increase the minimum and maximum JVM heap sizes, make one of the following edits:

Command line interface (CLI)

Change the line immediately after CLI: to the following (without carriage returns):

java -Xms512m -Xmx1024m -cp "%CLASSPATH%" %JAVA_OPTIONS% -Dwasp.location=".\wasp" 
com.filenet.upgrader.ui.UpgradeUtility %*

Graphical user interface (GUI)

Change the line immediately after GUI: to the following (without carriage returns):

java -Xms512m -Xmx1024m -cp "%CLASSPATH%" %JAVA_OPTIONS% -Dwasp.location=".\wasp" 
com.filenet.upgrader.ui.MainFrame

2. Edit the  ce_install_path/tools/upgrade/CE450Upgrader.bat file to specify the 
database JDBC driver file settings. 

a. Uncomment the set JDBCPATH command for your database type by removing rem from the 
beginning of the statement line.

b. Change YOURDRIVERPATH  to the full path where you installed the appropriate JDBC driver in 
the procedure “To install the JDBC drivers” on page 481. For example, if YOURDRIVERPATH is C:/
jars, use one of the following commands:

DB2 for Windows, Linux, or UNIX

set JDBCPATH=c:/jars/db2jcc.jar;c:jars/db2jcc_license_cu.jar

DB2 for z/OS

set JDBCPATH=c:/jars/db2jcc.jar;c:jars/db2jcc_license_cu.jar;c:jars/
db2jcc_license_cisuz.jar

Oracle 

set JDBCPATH=c:/jars/ojdbc14.jar

SQL Server

set JDBCPATH=c:/jars/sqljdbc.jar

3. Continue at one of the following:

• “Graphical user interface to the Upgrader tool” on page 483

• “Command-line interface to the Upgrader tool” on page 489
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Graphical user interface to the Upgrader tool
The GUI version of the Upgrader tool follows the same task sequence as the command-line 
interface (CLI) version described later in this task topic, but provides an interactive interface, in 
which each step is tied to the next, and in which you can check the accuracy of configuration 
parameters before attempting the actual upgrade.

To run the Upgrader tool

1. Log on to the machine where the Upgrader tool is installed as ce_upgrader_tool_user. For 
details on required accounts and related permissions, see “Accounts for Content Engine upgrade” 
on page 193 of Plan and Prepare Your Environment for IBM FileNet P8.

2. Double-click the icon for CE450Upgrader.bat to start the Upgrader tool.

The first time you run the Upgrader tool, it displays the screen that prompts you for the 
upgrade type (from Content Engine 3.5.2 or 4.0.1). On subsequent starts, the tool displays the 
last screen that you were using. Refer to your installation worksheet for the values for your site. 
For information, see “installation and upgrade worksheet” in Plan and Prepare Your 
Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to quickly see only the 
installation properties you must specify for the CE Upgrader:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" 
column header and select “CE Upgrader.”

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select 
Custom, and specify: Setup Type contains "Upgrade”.

– Click the AutoFilter drop-down arrow in all the other column headers and select (All).

To create a new XML upgrade status file

1. Select the Upgrade type.

2. If you are upgrading from Content Engine 3.5.x, enter the full path to the GCD file 
sysinit.dat. The default version 3.5.x location is ce_install_path\sysconfig\sysinit. 
If needed, click Browse to locate the file.

3. Enter the XML Upgrade Status File full path and file name. If needed, click Browse to select the 
location.

4. Click Begin.

The XML upgrade status file is created in the location you specified, and the Provide Content 
Engine Authentication Information screen is displayed.

To configure authentication, FCD, and object store parameters

1. Specify the Content Engine authentication information:
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a. In the Specify Content Engine Authentication Information screen, specify the following 
values:

• GCD Administrator user name

• GCD Administrator password

• Version 4.5 FileNet P8 domain name

• Server URL. The default is http://server_name:port_number/wsi/FNCEWS40DIME.

b. Click Test to verify the authentication information. A confirmation message is displayed. 
Perform one of the following:

• If the Upgrader tool can connect using the values you supplied, a success message is 
displayed. Click OK to close the message box.

• If the connection validation fails, an error message is displayed. Click OK to close the 
message box, and then edit the field values to correct the problem. Repeat Step b until 
the validation test passes.

c. Click Next. 

The Upgrader screen is displayed, with the Upgrade tab selected. The Upgrade tree in the left 
pane lists the items selected for upgrade. The status of each item is indicated with a colored 
ball. The Upgrade key legend at the bottom of the left pane shows the possible status states: 
Needs Info, Ready, Processing, Done, Failed, or Unsupported. You must supply data for each 
item that is in  Needs Info state before the upgrade can complete.

2. Specify the property values for any fixed content devices that are in Needs Info state.

a. In the Upgrader Tree pane, expand UpgradeItems > CommonGCD > Fixed Content Devices. 
Click the device name to select a fixed content device that is in Needs Info state. The 
properties and values for the FCD are displayed in the right pane in the FCS Settings tab. 

b. Enter the values for the FCD settings properties. Values with an * (asterisk) are required 
values.

NOTES

•  (CFS-IS) Leave the value of the CSMCache parameter blank. You can specify a value 
after the upgrade completes.

For descriptions of these parameters, refer to IBM FileNet P8 help topic FileNet P8 
Administration > Content Engine Administration > FileNet P8 Domain > How to... > View/
modify P8 domain properties > Fixed Content Devices (General tab).

• For SnapLock Fixed Devices where CE 4.5 is on UNIX, ensure you have prepared the 
UNIX NFS mount to the SnapLock device as instructed in “Configure storage devices for 
upgrades from 3.5.x” on page 424. The SnapLock share must be an NTFS share, must be 
mountable as an NFS device, requires proper user mapping. The Root Directory Path, 
SnapLock User Name, and Device Root Directory must reference UNIX information. 

• For Centera devices and where CE 4.5 is installed on a UNIX Server, ensure that new 
Centera shared libraries have been properly installed on the CE 4.5 server as 
instructed in “Install or update ECM Centera SDK library files” on page 416.
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c. Click Save. 

d. Repeat Step a through Step c for each fixed content devices that is in Needs Info state.

3. Specify the property values for any object stores that are in Needs Info state.

a. In the Upgrader Tree pane, expand UpgradeItems > Object Stores. Click the object store 
name to select an item that is in Needs Info state. 

Each object store may have one or more items in Needs Info state. You must supply the 
required values for the Database, GCDObjectStore, P8CoreObjectStoreAddons, 
FileStores, FixedFileStores, and DBStorageArea as needed for each object store. 
FileStores, FixedFileStores, and DBStorageArea are displayed only for object stores that 
have these features enabled. If the object store has CBR (Content Based Retrieval) 
enabled, then selecting the DBStorageArea node presents a panel for entering CBR 
information.

b. Specify the database properties for the selected object store.

i. Click Database. The Database Settings tab opens in the right pane. 

ii. Specify the following values:

• Database user name

• Database password

• Database type

• Database class

• Database URL

The following table shows examples of URLs for each database type:

iii. Click Test to verify the connection to the database. A confirmation message is 
displayed. Perform one of the following:

• If the Upgrader tool can connect using the values you supplied, a success 
message is displayed. Click OK to close the message box.

Database 
Type

URL

DB2 jdbc:db2://db_hostname:port/database_name

The default port is 50000.

MS SQL 
Server

jdbc:sqlserver://db_hostname:port

The default port is 1433.

Oracle jdbc:oracle:thin:@db_hostname:port:Oracle_instance_SID

The default port is 1521.
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 17: Upgrade Content Engine data
To configure authentication, FCD, and object store parameters

486
• If the connection validation fails, an error message is displayed. Click OK to close 
the message box, check that Content Engine is running, and then edit the field 
values to correct the problem. Repeat Step iii until the validation test passes.

c. Specify the Java Naming and Directory Interface (JNDI) properties for the selected object 
store. Click GCDObjectStore to enter the Java naming and Directory Interface (JNDI) 
properties for the selected object store. Specify the following values:

• Local JNDI name (the non-XA value)

• Global JNDI name (the XA value)

d. Specify the File store settings for the selected object store. Click FileStores to expand the 
list of file stores.

i. Click the name of a file store that is in Needs Info state. The File Store Path tab opens in 
the right pane. 

ii. Set the Root path to its UNIX equivalent. For example,
/opt/CE_35_filestore_mount/FS_One.

iii. Click Save if you made any changes.

iv. Repeat Step i through Step iii for each file store.

e. Specify the DBStorageArea content-based retrieval properties for the selected object store.

i. Click DBStorageArea. The Autonomy K2 tab opens in the right pane. 

ii. Specify the following values:

• K2 security user

• K2 security user password

• Style set alias

• Index server names

• K2 brokers

• User domain

• User group

• Server host name for the K2 master administration server

• Server port for the K2 master administration server

• K2 server names

NOTE  To specify multiple Index Server names, K2 Broker Server names, or K2 Server 
names, press Enter after typing each value to bring the cursor to a new line. Do not 
use any other delimiters (such as commas or spaces) to separate your values.
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iii. Click Test to verify the connection to the K2 server. A confirmation message is 
displayed. Perform one of the following:

• If the Upgrader tool can connect using the path you supplied, a success message 
is displayed. Click OK to close the message box.

• If the connection validation fails, an error message is displayed. Click OK to close 
the message box, and then edit the field values to correct the problem. Repeat 
Step iii until the validation test passes.

f. If an object store is not yet ready to upgrade, clear the check box for that object store. The 
selected object store must be in Ready state to be upgraded.

g. Take all object stores selected to upgrade offline. In the right pane, select the Description/
Online/Offline tab, and click Take Offline.

h. Repeat Step 3 as needed until all desired object stores are either in Ready state or disabled 
for the upgrade.

Perform the upgrade
For an item to be qualified for upgrading, two conditions must be met:

• The check box for the corresponding node in the Upgrade Tree pane must be selected.

• The item must be in Ready state.

Each selected check box maps to a yes value of SelectedForUpgrade within the XML upgrade 
status file for the corresponding item.

When you click Start to initiate an upgrade, the icon next to each item in the Upgrade Tree pane 
changes color as its state changes. The color code for these states is indicated in the Upgrade 
Key at the bottom of the Upgrade Tree pane. The icon for any item whose upgrade fails turns red.

As the item upgrade proceeds, its corresponding Status value in the XML upgrade status file 
changes to reflect the current state of the upgrade. The contents of the Log pane also show how 
the upgrade progresses.

If you click Stop, the upgrade will stop after completing the current step for the item being 
upgraded. If an error happens during the upgrade, the corresponding node will be in 
UpgradeFailed state. Before trying again to upgrade an item whose previous upgrade attempt 
failed, perform the following:

1. Fix the error in the item before retrying the upgrade.

2. With the item node selected, click Reset to reset the Status value of the item to 
ReadyToUpgrade.

You can also click Stop if the log indicates a condition that makes it pointless to try to upgrade any 
more of the items selected for upgrade.
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To upgrade items

1. In the Upgrade Tree pane, select the check boxes for all the object stores to be upgraded.

2. Click Start to initiate the upgrade and wait until the log or the color of the icon indicates that the 
upgrade is complete.

3. In the Upgrade Tree pane, select any other object stores to be upgraded, and clear the check 
boxes for all those object stores already upgraded.

4. Click Start to initiate the upgrade. A confirmation message is displayed. Click Yes to proceed 
with the upgrade, or click No to cancel.

As the upgrade proceeds, the success or failure of each item being upgraded is captured in a 
viewable report, which you can view in the Report tab.

This report is the same as that generated by running the command-line version of the 
Upgrader tool.

NOTE  (DB2 only) If a Transaction Log Full exception (SQL ErrorCode -964) occurs during the 
upgrade, it is recommended that you increase LOGSECOND (the maximum number of 
secondary log files) for the database and then repeat this step. 

To change LOGSECOND, run the following command:

UPDATE DATABASE CONFIGURATION FOR db_name USING LOGSECOND n

where n is the new value of LOGSECOND.

If you encounter the exception after the log file counts have been doubled, contact your 
IBM service representative.

5. To view the upgrade report, click the Report tab near the top left of the screen. To save the 
report as an HTML file, click Save in the Report pane.

6. To view the log, click the Log tab near the top left of the screen. To copy the log data to the 
clipboard, click Copy. To clear the log data, click Clear.

7. If the Upgrader tool successfully upgrades every item continue at “Complete Content Search 
Engine upgrade from 3.5.x” on page 494. Otherwise, complete the following steps:

a. Use the information (exception code and stack trace) in the command-line output or the 
log4j file to correct the error.

b. Select the failed item and click Reset on the Description tab, which will change the status of 
the item from UpgradeFailed to ReadyToUpgrade.
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c. If the object store add-on upgrade takes longer than 10 minutes and the upgrade fails with 
exceptions displayed in the upgrade console or log, you need to increase your application 
server timeout settings. Complete the following steps:

i. Increase your application server transaction timeout value. Make a note of your existing 
values before you make changes. Depending on your hardware, you may need to 
increase the timeout value to as much as 6000 seconds.

WebSphere - Navigate to Application Servers > servername > Transaction Services > 
Runtime, and increase the values for Total transaction lifetime timeout and Maximum 
transaction timeout.

WebLogic - Increase the value for Domain > Services > JTA > Timeout Seconds and 
the value for Servers > CEServerInstanceName > Configuration > Tuning > Stuck 
Thread Max Time. Use the same value for both settings.

JBoss - Edit the jboss-service.xml file to set the value for <attribute 
name="TransactionTimeout">.

ii. Restart the application server.

iii. Restart the upgrade for the object store add-ons.

iv. Once the upgrade completes successfully, you can reset the application server timeout 
settings to the previous values.

d. Return to Step 1.

Command-line interface to the Upgrader tool
In this section you will create an XML upgrade status file and run the Upgrader tool using the 
command-line interface (CLI) method.

To create an XML upgrade status file

This procedure interrogates the GCD of the Content Engine 3.5.x installation to produce an XML 
file containing representations of the items that can be upgraded. 

The XML file contains placeholders, which you will need to manually edit, for system settings that 
cannot be derived from the GCD, such as authentication settings. Each placeholder is indicated 
by the character string ‘###’. 

1. Log on to the machine where the Upgrader tool is installed as ce_upgrader_tool_user. For 
details on required accounts and related permissions, see “Accounts for Content Engine upgrade” 
on page 193 of Plan and Prepare Your Environment for IBM FileNet P8.

2. Navigate to the ce_install_path\tools\upgrade directory, which contains 
CE450Upgrader.bat.

3. Note the path GCD_Path to the GCD file sysinit.dat on the Content Engine server machine.

4. Designate a path XML_Path for the XML upgrade status file to be generated in Step 5.

5. Run the following command to create the XML upgrade status file upgrade.xml:
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CE450Upgrader.bat -i”GCD_Path/sysinit.dat” -o”upgrade.xml”

6. Manually edit upgrade.xml as required for your site, as follows:

• Replace each occurrence of the string ‘###’ with information that is appropriate for your site.

• The passwords you specify must be in plain text. The Upgrader tool will encrypt these passwords, 
as well as any other sensitive data, such as passwords in fixed content device parameters.

• A ‘yes’ value of SelectedForUpgrade means you want to upgrade the item; a ‘no’ value means you 
do not want the item to be considered for upgrade.

• The Status attribute values have the meanings shown in the following table:

• An item will be upgraded only if its SelectedForUpgrade value is ‘yes’ and its Status value is 
‘ReadyToUpgrade’.

• If you do not want to include Content Search Engine as part of your Content Engine upgrade, you 
need to first unconfigure CBR from the 3.5.x object store using the CE 3.5.x Enterprise Manager 
Administration, and then re-run the Upgrader tool.

7. If no file store or FCD contains full-text (CBR) indexes (Verity collections) to upgrade, then its 
preparation is complete; otherwise continue at Step 8.

8. Enter the information below for the K2 variables in the XML file. Autonomy K2 security account 
information is required.

Status Value Description

NeedsInfo Additional configuration information is needed. Set this field value 
to ReadyToUpgrade only after you have supplied the required 
information. 

ReadyToUpgrade The item will be upgraded if its SelectedForUpgrade value is yes.

UpgradeStarted The Upgrader tool has started upgrading the item.

UpgradeFinished The Upgrader tool has successfully upgraded the item.

UpgradeFailed The Upgrader tool has failed to upgrade the item.

Unsupported Devices (FCDs only) not supported by the Upgrader tool

Parameter Description

UserName K2 Security User

UserPassword K2 Security User password

UserDomain Domain on which the K2 services run

UserGroup K2 Security Group

AdminServerHost
Name

Name of the host on which the K2 Master Administration server is 
installed
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To specify multiple Index Server names, K2 Server names, or K2 Broker Server names, press 
Enter after typing each value to bring the cursor to a new line. Do not use any other delimiters 
(such as commas or spaces) to separate your values.

9. Locate the directories containing collections and set permissions to allow access to the 
following users:

• Content Engine Operating System User

• K2 Operating System User

10. For each directory containing 3.5.x content-search indexes (Verity collections) that you want to 
upgrade to 4.5 index areas (K2 collections), make collections readable by Verity by opening the 
Verity.cfg file and entering the following information:

• alias: Path number that increments for each path you list. 

• mapping: full path to the collections directory.

• dirmode: permission value that you must set to wr (write and read).

a. Open the following Verity configuration file in a text editor:

C:\ProgramFiles\filenet\contentengine\verity\k2\common\verity.cfg

b. Modify the next available alias settings by entering the information listed above for each 
collections directory you will upgrade. 

For example, if the next available settings are number 6 and you want to upgrade 
collections on myserver, located in FileStores\myfilestore\index, you would change alias6, 
mapping6, and dirmode6 to the following:

alias6=path1

mapping6=\\myserver\FileStores\myfilestore\index

dirmode6=wr

AdminServerPort K2 Master Administration Server port

StyleSetAlias FileNet_FileSystem_PushAPIFileNet_FileSystem_PushAPI

K2ServerNames K2 Server names

IndexServerNames K2 Index Server names

Brokers K2 Broker Server names

Parameter Description
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To add another directory, myotherserver\collections\index for example, you would modify 
settings for number 7 as follows:

alias7=path2

mapping7=\\myotherserver\collections\index

dirmode7=wr

NOTE If the upgraded 4.5 Content Engine will be on UNIX, be sure to specify the UNIX 
mount to the 3.5.x content-search indexes. For example,

mapping6=/opt/CE_35_filestore_mount/index

11. Continue at “To run the Upgrader tool using the CLI” on page 492.

To run the Upgrader tool using the CLI

You will now run the Upgrader tool, CE450Upgrader.bat, with the file upgrade.xml you generated 
in “To create an XML upgrade status file” on page 489 as input to drive the actual upgrade. 

Before upgrading an object store, the Upgrader tool takes the object store offline. After upgrading an object 
store, the Upgrader tool updates the corresponding Status value in upgrade.xml.

1. Log on to the machine where the Upgrader tool is installed as ce_upgrader_tool_user. For 
details on required accounts and related permissions, see “Accounts for Content Engine upgrade” 
on page 193 of Plan and Prepare Your Environment for IBM FileNet P8.

2. Navigate to the ce_install_path\tools\upgrade directory, which contains 
CE450Upgrader.bat.

3. (Optional) To see the available options, run the Upgrader tool from a command line, as follows:

CE450Upgrader -h

Notice from the command output that the Upgrader tool supports the following:

• Specify the amount of time (in seconds) for it to wait after taking an object store offline before 
upgrading it (using the -d option).

• Generate an HTML report of the upgrade (using the -r option).

4. Run the Upgrader tool, specifying options shown in Step 3.

As it attempts to upgrade each item, the Upgrader tool sends a status message to the 
command line and to a log4j logging system. If it fails in upgrading an item, the Upgrader tool 
will halt.

5. If the Upgrader tool successfully upgrades every item in Step 4, then continue at “Complete 
Content Search Engine upgrade from 3.5.x” on page 494. Otherwise, complete the following steps:

a. Use the information (exception code and stack trace) in the command-line output or the 
log4j file to correct the error.

b. Edit upgrade.xml by replacing any Status value of UpgradeStarted or UpgradeFailed to 
ReadyToUpgrade.

c. If the failure occurred due to an error after the database upgrade has completed, then 
restore your database from backup.
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6. If the Upgrader tool successfully upgrades every item continue at “Complete Content Search 
Engine upgrade from 3.5.x” on page 494. Otherwise, complete the following steps:

a. Use the information (exception code and stack trace) in the command-line output or the 
log4j file to correct the error.

b. Select the failed item and click Reset on the Description tab, which will change the status of 
the item from UpgradeFailed to ReadyToUpgrade.

c. If the object store add-on upgrade takes longer than 10 minutes and the upgrade fails with 
exceptions noted in the log, you need to increase your application server timeout settings. 

Complete the following steps:

i. Increase your application server transaction timeout value. Make a note of your existing 
values before you make changes. Depending on your hardware, you may need to 
increase the timeout value to as much as 6000 seconds.

WebSphere

Navigate to Application Servers > servername > Transaction Services > Runtime, and 
increase the values for Total transaction lifetime timeout and Maximum transaction 
timeout.

WebLogic 

Increase the value for Domain > Services > JTA > Timeout Seconds and the value for 
Servers > CEServerInstanceName > Configuration > Tuning > Stuck Thread Max Time. 
Use the same value for both settings.

JBoss 

Edit the jboss-service.xml file to set the value for <attribute 
name="TransactionTimeout">.

ii. Restart the application server.

iii. Restart the upgrade for the object store add-ons.

iv. Once the upgrade completes successfully, you can reset the application server timeout 
settings to the previous values.

d. Return to Step 4.
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 18: Complete Content Search Engine upgrade from 3.5.x 494
Task 18: Complete Content Search Engine upgrade 
from 3.5.x
After upgrading Content Engine data and Content Search Engine data, you must create new 
collections and remove old index areas

This procedure covers the minimum setup and configuration steps to get CBR configured and 
running with Autonomy K2 for an upgrade from 3.5.x. For more detail on Content-Based Retrieval 
and Content Engine, see the IBM FileNet P8 help topic Configure CBR found at FileNet P8 
Administration > Content Engine Administration > Content-based retrieval > How to... > Configure CBR.

NOTE  Where machine name variables are required, IP addresses will not validate. In these 
cases, you must enter the host name for the machine.

1. Launch Enterprise Manager and log on as the GCD Administrator.

2. Access each Index Area to be removed and set the status to Closed. For details, see the IBM 
FileNet P8 help topic FileNet P8 Administration > Content Engine Administration > Content-based 
retrieval > How to... > View/change index area status.

NOTE  The Index Areas must be closed first and deleted later because they cannot be deleted 
until after a reindex has completed. Even though remote collections have been mapped, no 
indexing will be run on those Index Areas.

3. Create a new index area for 4.5 Content Search Engine collections. Launch the Create an Index 
Area wizard:

a. In the tree view, expand the Object Stores container.

b. Right-click the object store to which you want add an index area and select New > Index 
Area.

c. Complete the Create an Index Area wizard using the following table:

In this screen... Perform this action...

Welcome Click Next to proceed with the index area creation.

NOTE Click Back at any time to make changes in previous 
screens. Click Cancel to exit the wizard.

Select Index Area 
Site

From the list of available sites, select the site to which the 
index area you are creating will be associated

Click Next to continue.

Name and Describe 
the Index Area

Enter a name and description for the new index area.

Click Next to continue.
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For more information on creating indexes, see the IBM FileNet P8 help topic FileNet P8 
Administration > Content Engine Administration > Content-based retrieval > How to... > Create Verity 
index area.

Enter Index Area 
Verity Directories

Enter the following Content Search Engine information:

• For Template Type, enter the following:

FileNet_FileSystem_PushAPI

• Verity collections directory path, stated as local to the 
CSE machine on which it resides. For example:

Windows

C:\collections

UNIX

opt/collections

• Verity temp directory path, stated as local to the CSE 
machine on which it resides. For example:

Windows

C:\tempdir

UNIX

opt/tempdir

Click Next to continue.

Select Verity 
Search Servers

From the list of available search servers, select at least one 
server to be used for this index area.

Click Next to continue.

Select Verity Index 
Servers

From the list of available index servers, select at least one 
server to be used for this index area.

Click Next to continue.

Completion Screen Review the entries you have selected for this index area and 
click Finish to complete the wizard and create the index area 
with the options you specified.

In this screen... Perform this action...
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4. Enable CBR for class definitions by activating the CBR Enable flag of the class you want 
available for CBR, as follows:

a. Right-click the class you want to configure in the Enterprise Manager tree and click 
Properties.

b.  Select CBR Enabled and click OK.

5. Enable CBR for the class properties you want available for CBR, as follows:

a. Right-click the class you want to configure and click Properties.

b. Click the Property Definitions tab.

c. Click the string property you want to enable for CBR indexing and click Edit.

d. Check CBR Enabled and click OK.

NOTE In the wizard, set the Template Type to FileNet_FileSystem_PushAPI.

6. Reindex to create new collections. For details, see the IBM FileNet P8 help topic FileNet P8 
Administration > Content Engine Administration > Content-based retrieval > How to... > Reindex.

7. Delete the old index areas and reclaim the space. For details, see the IBM FileNet P8 help topic 
FileNet P8 Administration > Content Engine Administration > Content-based retrieval > How to... > 
Remove Verity Index Area.

8. If you are not updating the Process Engine to version 4.5 at this time, ensure you install the 
latest Content Engine 4.5.x client files on the Process Engine server. See “Upgrade the Content 
Engine Client files on Process Engine servers” on page 519.

9. If you're not updating Application Engine Servers to version 4.0.2 at this time, ensure you install 
the latest Content Engine 4.5. client files on the Application Engine server. See “Install the latest 
Content Engine Client files on Application Engine servers” on page 564.
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Upgrade and configure Process Engine
Perform the following tasks to upgrade your Process Engine installation:

1. “Complete pre-upgrade Process Engine configuration” on page 498.

2. Perform the Process Engine upgrade. See one of the following tasks:

– “Upgrade Process Engine interactively” on page 505

– “Upgrade Process Engine silently” on page 512

3. “Upgrade the Content Engine Client files on Process Engine servers” on page 519

4. “Install the latest Process Engine Client files on other IBM FileNet P8 servers (for staged upgrades)” 
on page 525

5. “Complete post-upgrade Process Engine configuration” on page 526

6. “Install Process Engine software updates” on page 542
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Task 1: Complete pre-upgrade Process Engine  
configuration
A number of steps must be completed prior to installing the Process Engine software. The steps 
vary depending on what release you are upgrading from.  

To execute pre-upgrade steps for upgrades from PE 3.5.x
NOTES

• Verify that you have reconciled the Process Engine user security information. See “To prepare 
Process Engine for upgrade” on page 188 of Plan and Prepare Your Environment for IBM FileNet 
P8.

• If password complexity verification for Oracle databases has been enabled, it must be 
disabled to upgrade Process Engine but can be re-enabled after the upgrade is complete. 

• Determine when to execute the upgrade SQL script for Oracle databases.This script must be 
run either:

– manually, before running the Process Engine installation program.

or

– automatically, from the Process Engine installation program, allowing the installation 
program to prompt for the sys password for Oracle in an xterm window.

or

– automatically, from the Process Engine installation program, running silently using 
operating system authentication. Use operating system authentication only in a trusted 
environment or when configured with a local database.

See “Process Engine SQL scripts” on page 255 of Plan and Prepare Your Environment for IBM 
FileNet P8 for detailed information on the script and modes of execution.  

• (UNIX only) Verify that the raw partitions used for the SEC database have been expanded to 
64MB.  If the partitions have been expanded, Process Engine installation will automatically 
update the SEC database to use the expanded partitions.

• Purge the event logs and statistic records in the Process Engine database. Clear the event 
logs and statistics records that are no longer required for Process Engine tracker items or 
workflow milestones.  Clearing these items reduces the amount of time required to upgrade 
the Process Engine database.

• If you are using a production Process Analyzer, verify that all Process Engine events have 
been transmitted to Process Analyzer and that the Process Analyzer events have been 
published.  If the events have not been transmitted and published, either before purging from 
the Process Engine database, or before the Process Engine database upgrade, they will not 
be available to the Process Analyzer. 

WARNING  Do not start the Process Task Manager until specifically told to do so.  When you 
start Task Manager, the database is accessed, which should not be done until the database 
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has been upgraded using the procedures in “Complete post-upgrade Process Engine 
configuration” on page 526.

To verify that all Process Engine 3.x events have been transmitted to Process Analyzer 3.x

The steps in this procedure apply only to customers who are using a production Process Analyzer, 
they are not necessary for a simulation Process Analyzer.  If you are not using Process Analyzer, 
proceed to “To purge event logs and statistics records” on page 503. If you are using Process Analyzer 
you must execute these procedures before proceeding to “To purge event logs and statistics records” 
on page 503.

The Process Analyzer gets its data from the Process Engine database. All generated events must 
be transmitted from Process Engine to Process Analyzer before the upgrade.  The following steps 
must be taken to verify that transmission is complete.  Some of these steps must be taken on the 
Process Engine database, some on the Process Engine server using the vwtool utility, and some 
on the Process Analyzer VMAEDM database.  

You will query the Process Analyzer VMAEDM database for a date/time value.  Date/time values 
are stored in the Process Engine and Process Analyzer databases in different formats.  When a 
value has been acquired from the Process Analyzer database, you will use vwtool to convert the 
value to the appropriate format for the Process Engine database. You will then execute a query on 
the Process Engine database using the converted date/time value as one parameter in the SQL 
query.

1. Stop Process Engine applications. These applications include any applications that are 
generating events or running workflows.

2. Keep both Process Engine and Process Analyzer running until all the events from Process 
Engine are transmitted to Process Analyzer.    

3. Execute the following sub-steps to acquire a date/time value from the Process Analyzer 
database and convert it to an appropriate format for the Process Engine database.

a. On the Process Analyzer VMAEDM database, execute the following SQL query:

select InstallDate from X_SchemaInfo

This returns a date and time string, such as 09/11/2006 16:23:59.  This string must be 
converted.

b. On the Process Engine server, start the vwtool utility to convert the Process Analyzer data/
time string to Process Engine format.

c. At the vwtool prompt, type convert, as in:

<vwtool:26>convert

Then press Enter.  The following choice list displays:

t - Time number to string
s - String to time number
e - Error tuple to three part
p - Three part error to error tuple
l - Log event type number to string
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i - User id to user name
n - User name to user id

d. At the Choice? prompt, enter:

     s

and press Enter.  This converts a string to a time number and returns the following 
information to indicate what the current date/time mask is, as in:

     Current System Mask: mm/dd.yyy hh:tt:ss

     Time Mask (CR=system mask):  

e. Press Enter to accept the default mask.

f. When prompted to enter the time string (CR="), type the value that was returned from the 
SQL query executed on Process Analyzer VMAEDM in step a. (for example, 09/11/2006 
16:23:59). Your input must match the format of the current system mask from step d above.  
Then press Enter.  

A string value is returned for the date/time entered, which you must make note of for the 
next set of queries. For example:

Time...[0x4505F00F].........................1158017039 => '09/11/2006 16:23:59'

g. Get a list of all regions on the disk by typing the following at a vwtool prompt:

regions   

h. When prompted, respond by typing:

d

i. For every region, type the following at a vwtool prompt:

reg X

where X is the region number

j. Type the following at the vwtool prompt:

config

k. Locate and make note of the physical table name associated with every event log.  

l. On the Process Engine database, execute a SQL query (such as the following example) to 
verify that no untransmitted events remain in the Process Engine database.  You will query 
for the number of records in every physical table associated with event logs, using the 
names you acquired in the previous step.  Following is an example of the query syntax:

Select count(*) from f_sw.physical table name where F_AEXmitStat = 1 and 
F_TimeStamp > PAInstallDate 

where :

The physical table name was acquired in step k.

The PAInstallDate is the number returned in step f.
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Note that the physical table name must be preceeded by f_sw. in the query.

The query result must be 0. If the queries do not return 0, not all events have been collected, in 
which case Process Engine and Process Analyzer must keep running until all the events are 
transmitted and the queries return 0.

To verify that all Process Analyzer 3.5.x events have been published 

Process Analyzer must publish all the events in its VMAEDM database. Verify that all events have 
been published through the Microsoft Query Analyzer. Query for the number of rows in the 
F_Events table in the VMAEDM database with PAJobId = 0. 

The following is an example of the query on the Process Analyzer database.

Using VMAEDM:

Select count(*) from F_Events where PAJobId = 0

The above query should return 0. If the query returns anything other than 0, then not all events 
have been published.  In that case, you must leave Process Analyzer running until the query 
returns 0.

To purge event logs and statistics records

Before you upgrade Process Engine, use the vwlog utility to reduce the number of event log and 
statistics records in the database. This step is optional, but eliminating some of these records can 
significantly reduce the amount of time necessary for the upgrade to complete. Note that purging 
these records can take a significant amount of time, so plan this activity accordingly. 

Execute the command by logging on as a member of the PE Configuration group.

The following are some examples of vwlog syntax. Do not use the -P option when you purge 
logging records if you are using Process Analyzer. 

vwlog -X -r region number (this command removes the statistics from the specified 
isolated)

The following command will remove all log records from the isolated region. Use this only if all 
workflows have terminated and you no longer need tracking or milestone information.

vwlog -L -r region number (this command removes all log records from the specified 
isolated region)

There are multiple optional parameters for the vwlog utility, allowing selection of log records for 
deletion meeting a number of conditions, such as log records for terminated workflows, for tracker 
related records, and more. See the IBM FileNet P8 help topics under FileNet P8 Administration > 
Process Engine Administraton > Administrative tools > vwlog for additional information.

NOTE If Process Analyzer is installed, you must complete the steps detailed in “To verify that all 
Process Engine 3.x events have been transmitted to Process Analyzer 3.x” on page 499 and “To verify that 
all Process Analyzer 3.5.x events have been published” on page 501 before you purge event logs.  
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To stop all Process Engine-related services and applications 

1. Complete the following procedure:

UNIX

Log on as root. 

Windows

Log on as fnsw.

2. Set the PPM and any routers to manual startup if they are currently configured to autostart.   

3. Stop the following components if they are running:

• Process Simulator

• Process Analyzer

• Custom applications that require a router

• Component Manager 

• Routers - for Application Engines, Content Engine and custom applications

• Content Engine

• Pooled Process Manager (PPM)

• Process Service 

• Process Task Manager

4. Enter the following at a command prompt after the FileNet software is shut down. 

Windows

killfnsw -D -y -S

UNIX 

killfnsw -DAyS or killfnsw -D -A -y -S 

5. (AIX only) Execute the following:

slibclean

6. (UNIX only) Execute the following command to look for any java processes that are still running: 

ps –ef | grep java | grep VW 

Kill any P8-related running java processes.

Proceed to either “Upgrade Process Engine interactively” on page 505 or “Upgrade Process Engine 
silently” on page 512.
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To execute pre-upgrade steps for upgrades from PE 4.0.x 
• IBM recommends that you complete the upgrade of the entire P8 platform and verify 

functionality before upgrading database software.

• If password complexity verification for Oracle databases has been enabled, it must be 
disabled to upgrade Process Engine but can be re-enabled after the upgrade is complete. 

• Determine when to execute the upgrade SQL script for Oracle databases.This script must be 
run in one of the following ways:

– manually, before running the Process Engine installation program.

or

– automatically, from the Process Engine installation program, allowing the installation 
program to prompt for the sys password for Oracle in an xterm window.

or

– automatically, from the Process Engine installation program, running silently using 
operating system authentication. Use operating system authentication only in a trusted 
environment or when configured with a local database.

See “Process Engine SQL scripts” on page 255 of Plan and Prepare Your Environment for IBM 
FileNet P8 for detailed information on the script and modes of execution.  

To purge event logs and statistics records

Before you upgrade Process Engine, use the vwlog utility to reduce the number of event log and 
statistics records in the database. This step is optional, but eliminating some of these records can 
significantly reduce the amount of time necessary for the upgrade to complete. Note that purging 
these records can take a significant amount of time, so plan this activity accordingly. 

Execute the command by logging on as a member of the PE Configuration group.

The following are some examples of vwlog syntax. Do not use the -P option when you purge 
logging records if you are using Process Analyzer. 

vwlog -X -r region number (this command removes the statistics from the specified 
isolated)

The following command will remove all log records from the isolated region. Use this only if all 
workflows have terminated and you no longer need tracking or milestone information.

vwlog -L -r region number (this command removes all log records from the specified 
isolated region)

There are multiple optional parameters for the vwlog utility, allowing selection of log records for 
deletion meeting a number of conditions, such as log records for terminated workflows, for tracker 
related records, and more. See the IBM FileNet P8 help topics under FileNet P8 Administration > 
Process Engine Administraton > Administrative tools > vwlog for additional information.
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To stop all Process Engine-related services and applications

1. Complete the following procedure:

UNIX

Log on as root. 

Windows

Log on as fnsw.  

2. Stop the following components if they are running:

• Process Simulator

• Process Analyzer 

• Component Manager 

• Content Engine 

• Process Service 

• Process Task Manager 

3. Shut down any active windows displaying Process Engine log files. 

4. Enter the following at a command prompt to stop the Process Engine software: 

initfnsw –y stop 

5. Enter the following at a command prompt after the FileNet software is shut down. 

Windows

killfnsw -D -y -S

UNIX

killfnsw -DAyS or killfnsw -D -A -y -S 

6. (AIX only) Execute the following:

slibclean

7. (UNIX only) Execute the following command to look for any java processes that are still running: 

ps –ef | grep java | grep VW 

Kill any P8-related running java processes.

Proceed to either “Upgrade Process Engine interactively” on page 505 or “Upgrade Process Engine 
silently” on page 512.
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Task 2a: Upgrade Process Engine interactively
Interactively upgrade Process Engine software by performing the procedures in this topic that are 
appropriate for your platform. 

You will find references to logging on as the root and fnsw users within the following procedures. 
For all UNIX operating systems, the root user must run in the Bourne or Korn shell and the fnsw 
user must run in the Korn shell.  

Several Process Engine upgrade screens will display only if the upgrade is from Process Engine 
version 3.5.x.  Those screens are noted in the Installation and Upgrade Worksheet.

CAUTION Before starting the Process Engine installation, verify that you have completed the steps 
in the To configure the /etc/hosts file section in the Plan and Prepare Your Environment for IBM 
FileNet P8 guide.

To verify the database connection

Use the procedures in this topic to verify the ability to connect to the database. Execute these 
steps on the database server or the client according to whether the database is local to or remote 
from Process Engine.

To verify the Process Engine database connection (Oracle)

Take the following steps to verify that the Oracle database instance used by Process Engine is 
accessible. How you log on to sqlplus will vary, depending upon how you will choose to execute 
the SQL scripts.  This procedure will verify that you can connect to the Oracle database in the 
same way the Process Engine installation program will.  Make whatever corrections are necessary 
before proceeding.  

1. Execute the following at a command prompt:

su - oracle -c "sqlplus"

2. Enter one of the following commands at the SQLPlus prompt, as follows:

• If the Process Engine pre-installation SQL scripts will be run from the Process Engine installation 
program by prompting for the sys password, type the following command:

sys/password as sysdba 

• If the SQL scripts will be run from the Process Engine installation program by using operating 
system authentication, type the following command:

/ as sysdba 

3. At the prompt, enter the following SQL command:

SQL> select instance_name, host_name, version from v$instance;

The following represents an example of the information returned:

INSTANCE_NAME

----------------
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HOST_NAME

----------------------------------------------------------------

VERSION

-----------------

p8dbshr
HQVWBUCS
10.2.0.2.0

where: 

p8dbshr is the instance ORACLE_SID.

hqvwbucs is the database server name.

10.2.0.2 is the Oracle server version.

To verify the Process Engine database connection (DB2) 

Verify the connection to the DB2 Process Engine database by executing the following commands 
to start a command line processor.

1.  Log on to the DB2 Control Center tool, as follows:

Windows

At a command prompt, start the DB2 Command Line Processor by typing the following command:

db2cmd

and, at the subsequently displayed prompt, enter the following command:

db2

UNIX

Log on as the client instance owner and execute the following at a command prompt:

db2

2. At the DB2 prompt, enter the following command indicating either the database alias or the 
instance name:

connect to database_alias or instance_name user f_sw using f_sw password

where:

database_alias is the Process Engine DB2 for Linux, UNIX and Windows database alias for 
remote databases. For local databases, use the database name. 

instance_name is the Process Engine DB2 for z/OS database name 

f_sw is the Process Engine runtime user, either the default f_sw user or the assigned alias

f_sw password is the runtime user’s password. 
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DB2 will display the database connection information.

The following example shows the database connection command and the information 
returned:

db2 => connect to pedbinst user f_sw using fswpassword

Database Connection Information

Database server        = DB2/AIX64 9.1.0
SQL authorization ID  = F_SW
Local database alias  = PEDBINST

In this example, the database alias is pedbinst, the user is f_sw, and the f_sw user password 
is fswpassword.

To verify the Process Engine database connection (SQL Server)

Take the following steps to verify that the SQL Server database instance used by Process Engine is 
accessible. You will need to know both the Process Engine database and filegroup names. Make whatever 
corrections are necessary before proceeding. 

In this example, the database is VWdb and the filegroup name is vwdata_fg. Both the database name and 
filegroup name must match what was defined when the database MS SQL server was installed and 
configured.

1. Log on as a member of the local Administrators group or a user with equivalent permissions. The user 
you log on as must also be a database administrator.  If the database is remote, the SQL 
connection must also be a trusted connection. 

2. At a command prompt, enter:

osql -E -D DSN

where DSN is the ODBC data source name 

This command puts Process Engine into osql interactive mode.

3. At the osql prompt, enter:

1> use VWdb
2> go

where VWdb is the Process Engine database name 

This command verifies that the Process Engine database has been created. If you get another prompt 
with no error, you are attached to that database. 

4. Verify that the correct Process Engine filegroup was created. At the osql prompt, enter:

1> select substring(groupname,1,20) from sysfilegroups where groupname = 'defined filegroup'
2> go

where defined filegroup is the default filegroup 
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A listing of the Process Engine filegroups will display, for example: 

___________

vwdata_fg

To upgrade the Process Engine software interactively (UNIX)

1. Log on to the server as the root user.

NOTE This user does not need to be a database administrator unless you will be executing the 
SQL scripts from the Process Engine installation program. 

2. Access the Process Engine software package. 

3. From the console, launch the appropriate P8PE-4.5.0-platform.bin installation program.

4. Wait for files to finish unpacking.

5. Complete the Process Engine installation screens using the appropriate information from your 
installation worksheet. Installation program screens may indicate this is an installation, although 
this is an upgrade.

HINT  With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to quickly see only the 
installation properties you must specify for the Process Engine installer:

a. Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column 
header and select PE installer.

b. Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify: Setup Type contains "Upgrade."    

c. Click the AutoFilter drop-down arrow in all other column headers and select (All).

6. Monitor /fnsw/local/logs/wizard to check the progress of the upgrade since the 
installation program will run for several minutes,and its progress, though displayed, might not 
visibly advance for an extended period of time.

7. Reboot when prompted.

8. A number of log files might be generated by the installation. Check for an .log files generated 
when the installation program executed. The files could be in any of the following locations, 
depending upon whether the installation was successful or had errors, and where the 
installation encountered errors. Correct any errors or failures indicated before proceeding to the 
next step.

• /fnsw/local/logs/PE (if the install completes successfully) 

• /fnsw/tmp_installer (if the install has errors)

• /fnsw/local/logs/wizard and other subdirectories under /fnsw/local/logs 

9. Log off as the root user and log on as fnsw (or the alias).    

10. Proceed to “To set the f_maint and f_sw passwords” on page 510.
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To upgrade the Process Engine software interactively (Windows)

1. Log on as a member of the local Administrators group or a user with equivalent permissions. If you 
plan to run the SQL scripts from the Process Engine installation program, the user you log on as must 
also be a database administrator.  See “Specify IBM FileNet P8 accounts” on page 70 of Plan and 
Prepare Your Environment for IBM FileNet P8 for information on requirements for logging on as 
a Windows domain user for Process Engine installation. 

2. Access the Process Engine software package, and start the P8PE-4.5.0-Win.exe installation 
program.

NOTE  To run the Process Engine installation from disk, you must copy the installation files to 
a disk volume where 8.3 name generation is enabled, or if 8.3 name generation is disabled, 
you must copy the installation to a path that uses only short (8.3) names.

When running from disk, either interactively or silently, be aware that the Process Engine 
installation program has a 64-character path limitation when the path is expressed in 8.3 
format. This limitation applies to the IMSInst subdirectory. For example, the original path is:

\\server08\Software\InstallationDisks\FileNet\Release P8 
4.5.0\ProcessEngine\Windows\IMSInst

When expressed in 8.3 format the path might be:

\\server08\Software\INSTAL~1\FileNet\RELEAS~1.0\PROCES~1\Windows\IMSInst

This compressed path is 73 characters long, exceeding the 64-character limit.

3. Complete the Process Engine installation screens using the appropriate information from your 
installation worksheet. Installation program screens may indicate this is an installation, although 
this is an upgrade.   

HINT  With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to quickly see only the 
installation properties you must specify for the Process Engine installer:

a. Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column 
header and select PE installer.

b. Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify: Setup Type contains "Upgrade."    

c. Click the AutoFilter drop-down arrow in all other column headers and select (All).

4. A number of log files might be generated by the installation. Check for an .log files generated 
when the installation program executed. The files could be in any of the following locations, 
depending upon whether the installation was successful or had errors, and where the 
installation encountered errors. Correct any errors or failures indicated before proceeding to the 
next step.

• C:\Program Files\FileNet\PE\PE450_setup.log

• C:\Program Files\FileNet\PE 

• C:\FNSW  
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• Windir\mini_installer.log, Windows Event logs, and log files under \FNSW_LOC\logs  

5. Start the following services:

• IMS ControlService

• Process Engine Services Manager

To set the f_maint and f_sw passwords 

For added security, Process Engine stores an encrypted version of the passwords for the f_sw and 
f_maint users, or their aliases, in a file called rdbup.bin. This is in addition to passwords for 
these users in the Oracle or SQL Server database, or on the operating system where DB2 is 
installed. The encrypted password and the database (Oracle or SQL Server) or operating system 
(DB2) user’s passwords must match. 

To verify that the passwords match, use the following procedure to start the Xdbconnect utility.  
Xdbconnect works only if the passwords in the encrypted file and the database match.  

Use the following procedure to change the passwords for the f_maint and f_sw users after 
upgrading the Process Engine software. For Oracle and SQL Server databases, both the 
encrypted file and the database passwords will be updated.  For DB2, only the encrypted file will 
be updated.   

1. Start the Database Server Connect application by executing the following:

Xdbconnect -r

2. Log on as SysAdmin. The default password is SysAdmin.

3. Change the primary password for the users f_sw and f_maint (or their alias) to match the 
database password (Oracle and SQL Server) or operating system user’s password (DB2).

4. Exit the application. 

To re-enable Oracle Password Complexity Verification

• If, as directed earlier, you disabled the the Oracle Password Complexity Verification feature 
prior to upgrading Process Engine, you can re-enable it now.

To restore any custom modifications for root and fnsw users (UNIX) 

• Process Engine installation creates new versions of a number of files. If the previous versions 
of these files contained any custom settings, edit the new files for the fnsw and root users 
accordingly. Saved files are in .filename.old.nn, where nn is a sequential number. The 
latest saved version will be in the highest numbered file.  The following files are modified by 
the Process Engine installation program:

– .Xdefaults

– .Xresources

– .dbxinit

– .dtprofile
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– .env

– .login

– .mwmrc

– .xinitrc

– .profile

– .cshrc

To edit the /etc/inittab file 

• By default, the Process Engine software starts automatically when you restart the server and 
needs its database started beforehand. If the database is not automatically started on server 
restart, edit the /etc/inittab file on the Process Engine machine to comment out the 
autostart of Process Engine. The following are examples of changes to make.

AIX 

Change:

rcfnsw:2:once:/etc/rc.initfnsw 2>&1 | alog -tboot > /dev/console 2>&1

to read:

#rcfnsw:2:once:/etc/rc.initfnsw 2>&1 | alog -tboot > /dev/console 2>&1

HP-UX

Change:

rcfn:2:once:/etc/rc.initfnsw 2>&1 | alog -tboot > /dev/console 2>&1

to read:

#rcfn:2:once:/etc/rc.initfnsw 2>&1 | alog -tboot > /dev/console 2>&1

Solaris

Change:

fn:3:wait:/bin/sh /etc/rc.initfnsw </dev/console >/dev/console 2>&1

to read:

#fn:3:wait:/bin/sh /etc/rc.initfnsw </dev/console >/dev/console 2>&1

To edit the pe_start file (HP-UX only)

• If the value for the maxdsiz kernel parameter is > 1GB, edit the pe_start file. 

Change:

nohup /usr/ccs/lbin/dldd32 2>&1 >/dev/null    

to read

nohup /usr/ccs/lbin/dldd32 +a 0x70000000 2>&1 >/dev/null

Proceed to “Upgrade the Content Engine Client files on Process Engine servers” on page 519.
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Task 2b: Upgrade Process Engine silently
Silently upgrade Process Engine software by performing one of the following procedures. 

CAUTION Before starting the Process Engine installation, verify that you have completed the steps 
in the To configure the /etc/hosts file section in the Plan and Prepare Your Environment for IBM 
FileNet P8 guide.

To verify the database connection

Use the procedures in this topic to verify the ability to connect to the database. Execute these 
steps on the database server or the client according to whether the database is local to or remote 
from Process Engine.

To verify the Process Engine database connection (Oracle)

Take the following steps to verify that the Oracle database instance used by Process Engine is 
accessible. How you log on to sqlplus will vary, depending upon how you will choose to execute 
the SQL scripts.  This procedure will verify that you can connect to the Oracle database in the 
same way the Process Engine installation program will.  Make whatever corrections are necessary 
before proceeding.  

1. Execute the following at a command prompt:

su - oracle -c "sqlplus"

2. Enter one of the following commands at the SQLPlus prompt, as follows:

• If the Process Engine pre-installation SQL scripts will be run from the Process Engine installation 
program by prompting for the sys password, type the following command:

sys/password as sysdba 

• If the SQL scripts will be run from the Process Engine installation program by using operating 
system authentication, type the following command:

/ as sysdba 

3. At the prompt, enter the following SQL command:

SQL> select instance_name, host_name, version from v$instance;

The following represents an example of the information returned:

INSTANCE_NAME

----------------

HOST_NAME

----------------------------------------------------------------

VERSION
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-----------------

p8dbshr
HQVWBUCS
10.2.0.2.0

where: 

p8dbshr is the instance ORACLE_SID.

hqvwbucs is the database server name.

10.2.0.2 is the Oracle server version.

To verify the Process Engine database connection (DB2) 

Verify the connection to the DB2 Process Engine database by executing the following commands 
to start a command line processor..

1.  Log on to the DB2 Control Center tool, as follows:

Windows

At a command prompt, start the DB2 Command Line Processor by typing the following 
command:

db2cmd

and, at the subsequently displayed prompt, enter the following command:

db2

UNIX

Log on as the client instance owner and execute the following at a command prompt:

db2

2. At the DB2 prompt, enter the following command indicating either the database alias or the 
instance name:

connect to database_alias or instance_name user f_sw using f_sw password

where:

database_alias is the Process Engine DB2 for Linux, UNIX and Windows database alias for 
remote databases. For local databases, use the database name. 

instance_name is the Process Engine DB2 for z/OS database name 

f_sw is the Process Engine runtime user, either the default f_sw user or the assigned alias

f_sw password is the runtime user’s password. 

DB2 will display the database connection information.
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The following example shows the database connection command and the information 
returned:

db2 => connect to pedbinst user f_sw using fswpassword

Database Connection Information

Database server        = DB2/AIX64 9.1.0
SQL authorization ID  = F_SW
Local database alias  = PEDBINST

In this example, the database alias is pedbinst, the user is f_sw, and the f_sw user password 
is fswpassword.

To verify the Process Engine database connection (SQL Server)

Take the following steps to verify that the SQL Server database instance used by Process Engine is 
accessible. You will need to know both the Process Engine database and filegroup names. Make whatever 
corrections are necessary before proceeding. 

In this example, the database is VWdb and the filegroup name is vwdata_fg. Both the database name and 
filegroup name must match what was defined when the database MS SQL server was installed and 
configured.

1. Log on as a member of the local Administrators group or a user with equivalent permissions. The user 
you log on as must also be a database administrator.  If the database is remote, the SQL 
connection must also be a trusted connection. 

2. At a command prompt, enter:

osql -E -D DSN

where DSN is the ODBC data source name 

This command puts Process Engine into osql interactive mode.

3. At the osql prompt, enter:

1> use VWdb
2> go

where VWdb is the Process Engine database name 

This command verifies that the Process Engine database has been created. If you get another prompt 
with no error, you are attached to that database. 

4. Verify that the correct Process Engine filegroup was created. At the osql prompt, enter:

1> select substring(groupname,1,20) from sysfilegroups where groupname = 'defined filegroup'
2> go

where defined filegroup is the default filegroup 

A listing of the Process Engine filegroups will display, for example: 

___________

vwdata_fg
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To upgrade the Process Engine software silently (UNIX)

Take the following steps to silently upgrade Process Engine. 

1. Access the Process Engine software package, and copy the contents to a local temporary 
directory on the local disk. 

2. Edit the PE_silent_install.txt file to reflect the appropriate responses for your system. All 
passwords in the response file must be encrypted. See “Encrypt passwords” on page 700 for 
information on use of the password encryption tool.  

3. Save the edited response file to your temporary directory.

4. Log on as the root user in the Korn shell.  

5. Navigate to the temporary directory on the local disk.

6. Open a command prompt and execute:

P8PE-4.5.0-platform -silent -options PE_silent_install.txt  

7. Monitor /fnsw/local/logs/wizard to check the progress of the upgrade since installation 
will run for several minutes,and its progress, though displayed, might not visibly advance for an 
extended period of time.

8. A number of log files might be generated by the installation. Check for an .log files generated 
when the installation program executed. The files could be in any of the following locations, 
depending upon whether the installation was successful or had errors, and where the 
installation encountered errors. Correct any errors or failures indicated before proceeding to the 
next step.

• /fnsw/local/logs/PE (if the install completes successfully) 

• /fnsw/tmp_installer (if the install has errors)

• /fnsw/local/logs/wizard and other subdirectories under /fnsw/local/logs

9. Log off as the root user and log on as fnsw (or the alias). 

To upgrade the Process Engine software silently (Windows)

1. Access the Process Engine software package, and copy its contents to a temporary directory on 
the local disk. 

2. Edit the PE_silent_install.txt file to reflect the appropriate responses for your system. All 
passwords in the response file must be encrypted. See “Encrypt passwords” on page 700 for 
information on use of the password encryption tool.  

3. Save the edited response file to your temporary directory.

4. Log on as a member of the local Administrators group or a user with equivalent permissions. The user 
you log on as must also be a database administrator.  See “Specify IBM FileNet P8 accounts” on 
page 70 of Plan and Prepare Your Environment for IBM FileNet P8 for information on 
requirements for logging on as a Windows domain user for Process Engine installation.
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5. Open a command prompt and navigate to the temporary directory.  Execute:

P8PE-4.5.0-Win.exe -silent -options PE_silent_install.txt 

6. A number of log files might be generated by the installation. Check for an .log files generated 
when the installation program executed. The files could be in any of the following locations, 
depending upon whether the installation was successful or had errors, and where the 
installation encountered errors. Correct any errors or failures indicated before proceeding to the 
next step.

• C:\Program Files\FileNet\PE\PE450_setup.log

• C:\Program Files\FileNet\PE 

• C:\FNSW  

• Windir\mini_installer.log, Windows Event logs, and log files under \FNSW_LOC\logs  

7. Start the following services:

• IMS ControlService

• Process Engine Services Manager

To set the f_maint and f_sw passwords 

For added security, Process Engine stores an encrypted version of the passwords for the f_sw and 
f_maint users, or their aliases, in a file called rdbup.bin. This is in addition to passwords for 
these users in the Oracle or SQL Server database, or on the operating system where DB2 is 
installed. The encrypted password and the database (Oracle or SQL Server) or operating system 
(DB2) user’s passwords must match. 

To verify that the passwords match, use the following procedure to start the Xdbconnect utility.  
Xdbconnect works only if the passwords in the encrypted file and the database match.  

Use the following procedure to change the passwords for the f_maint and f_sw users after 
upgradinging the Process Engine software. For Oracle and SQL Server databases, both the 
encrypted file and the database passwords will be updated.  For DB2, only the encrypted file will 
be updated.   

1. Start the Database Server Connect application by executing the following:

Xdbconnect -r

2. Log on as SysAdmin. The default password is SysAdmin.

3. Change the primary password for the users f_sw and f_maint (or their alias) to match the 
database password (Oracle and SQL Server) or operating system user’s password (DB2).

4. Exit the application. 

To re-enable Oracle Password Complexity Verification

If, as directed earlier, you disabled the the Oracle Password Complexity Verification feature prior 
to upgrading Process Engine, you can re-enable it now.
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To restore any custom modifications for root and fnsw users (UNIX) 

• Process Engine installation creates a new versions of a number of files. If the previous 
versions of these files contained any custom settings, edit the new files for the fnsw and root 
users accordingly. Saved files are in .filename.old.nn, where nn is a sequential number. 
The latest saved version will be in the highest numbered file.  The following files are modified 
by the Process Engine installation program:

– .Xdefaults

– .Xresources

– .dbxinit

– .dtprofile

– .env

– .login

– .mwmrc

– .xinitrc

– .profile

– .cshrc

To edit the /etc/inittab file 

• By default, the Process Engine software starts automatically when you restart the server and 
needs its database started beforehand. If the database is not automatically started on server 
restart, edit the /etc/inittab file on the Process Engine machine to comment out the 
autostart of Process Engine. The following are examples of changes to make.

AIX 

Change:

rcfnsw:2:once:/etc/rc.initfnsw 2>&1 | alog -tboot > /dev/console 2>&1

to read:

#rcfnsw:2:once:/etc/rc.initfnsw 2>&1 | alog -tboot > /dev/console 2>&1

HP-UX

Change:

rcfn:2:once:/etc/rc.initfnsw 2>&1 | alog -tboot > /dev/console 2>&1

to read:

#rcfn:2:once:/etc/rc.initfnsw 2>&1 | alog -tboot > /dev/console 2>&1

Solaris

Change:

fn:3:wait:/bin/sh /etc/rc.initfnsw </dev/console >/dev/console 2>&1
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to read:

#fn:3:wait:/bin/sh /etc/rc.initfnsw </dev/console >/dev/console 2>&1

To edit the pe_start file (HP-UX only)

• If the value for the maxdsiz kernel parameter is > 1 GB, edit the pe_start file. 

Change:

nohup /usr/ccs/lbin/dldd32 2>&1 >/dev/null    

to read:

nohup /usr/ccs/lbin/dldd32 +a 0x70000000 2>&1 >/dev/null

Proceed to “Upgrade the Content Engine Client files on Process Engine servers” on page 519.
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Task 3: Upgrade the Content Engine Client files on 
Process Engine servers
To install the Content Engine Client files, perform the following steps on all servers where Process 
Engine Server has been upgraded.

IMPORTANT Your Content Engine Client version must match your Content Engine server version, 
unless otherwise noted in the FileNet P8 Compatibility Matrix. Install the latest 4.5 Content Engine 
Client files as documented in this topic only when you are ready to upgrade Content Engine 
servers to 4.5. 

In a staged upgrade from 4.0, you might run upgraded Process Engine 4.5 servers with Content 
Engine 4.0 servers for some period of time. In this case, install the latest 4.0 Content Engine 
Client files. For detailed instructions, see the latest 4.0 version of the IBM FileNet P8 Installation 
and Upgrade Guide on the IBM Web site.

To stop Process Engine software

1. Log on as fnsw or the alias.

2. At a command prompt, enter the following: 

Windows

killfnsw -D -y -S

UNIX

killfnsw -D -A -y -S

3. On AIX, execute:

slibclean

To uninstall Content Engine Client 4.0.x instances

Perform the following procedure to identify and uninstall all Content Engine Client version 4.0.x 
files on a Process Engine Server machine. Repeat the procedure for all other Process Engine 
Server machines.

Depending on the Content Engine Client fix pack versions that you have installed, you may have 
more than one instance of the Content Engine Client 4.0.x installed. Additionally, the version 4.0.x 
Content Engine Client installer supported installing multiple instance of the Content Engine Client 
on the same server. You need to uninstall all instances before upgrading to the 4.5 version of 
Content Engine Client.

1. Locate and uninstall all instances of the Content Engine Client on the Process Engine server.

Windows

a. Select Start > Settings > Control Panel > Add/Remove Programs.

b. Select Content Engine Client Updater or IBM FileNet Content Engine Client Installer, 
depending on the fix pack version of Content Engine Client that is installed. 
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Prior to fix pack P8CE-4.0.1-006: The Content Engine Client is named Content 
Engine Client Updater.

As of  fix pack P8CE-4.0.1-006: The Content Engine Client is named IBM FileNet 
Content Engine Client Installer.

c. Click Change/Remove to start the uninstaller.

d. In the Uninstall IBM FileNet Client Installer screen, click Next.

e. In the Select Components screen, select Complete Uninstall. Click Next.

f. In the Uninstall Complete screen, click Done.

g. Repeat Step b through Step f for each additional instance of Content Engine Client Updater 
or IBM FileNet Content Engine Client Installer listed in Add/Remove Programs.

UNIX

a. Run one of the following commands, depending on the fix pack version of Content Engine 
Client that is installed.

/ce_client_install_path/ClientUpdater/_uninst/uninstaller.bin 

/ce_client_install_path/CEClient/_CEClientuninst/uninstaller 

Prior to fix pack P8CE-4.0.1-006: The Content Engine Client files are in a 
directory called ClientUpdater, and the uninstallation program is .../
ClientUpdater/_uninst/uninstaller.bin.

As of fix pack P8CE-4.0.1-006: The Content Engine Client files are in a 
directory called Content Engine Client and the uninstallation program is .../
CEClient/_CEClientuninst/uninstaller.

b. In the Uninstall IBM FileNet Client Installer screen, click Next.

c. In the Select Components screen, select Complete Uninstall. Click Next.

d. In the Uninstall Complete screen, click Done.

e. Repeat Step a through Step d for each installed instance of Content Engine Client on this 
server.

To install the Content Engine Client files

Refer to the appropriate information from your installation worksheet while performing the following 
steps. For information on the Content Engine parameter values, see ““Installation and upgrade 
worksheet” on page 229 in Plan and Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to quickly see only the 
installation properties you must specify for the Content Engine installation program:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select CE Client installer (UNIX) or CE Client installer (Windows).

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify: Setup Type contains "Upgrade."
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• Click the AutoFilter drop-down arrow in all other column headers and select (All).

1. To download the latest software updates, and to determine which of these updates may be 
required for use with other components and expansion products, contact your service 
representative.

2. Log on to the server where Process Engine is installed as fnsw with these permissions:

• Read and write permission to a temporary directory, such as temp (Windows) or tmp (UNIX), on 
the machine where Process Engine is installed

• Execute permission on the Content Engine Client install software

3. Verify that there is a current backup of Process Engine.  

4. Copy the Content Engine Client install software from the Content Engine installation software to 
the temporary directory, and unzip the software package. The version of the installation software 
must match the version of Content Engine.

• To install the Content Engine client interactively:

i. Access the IBM FileNet Content Engine client update software.

ii. Run one of the commands in the table below, CE_version is the version of Content Engine 
you intend to run, for example, 4.5.0..

iii. Complete the installation program wizard, using the following table. 

Operating System Install Program

AIX P8CE-CLIENT-CE_version-AIX.BIN

HPUX P8CE-CLIENT-CE_version-HPUX.BIN

HPUXi P8CE-CLIENT-CE_version-HPUXI.BIN

Linux P8CE-CLIENT-CE_version-LINUX.BIN

Solaris P8CE-CLIENT-CE_version-SOL.BIN

Windows P8CE-CLIENT-CE_version-WIN.EXE

zLinux P8CE-CLIENT-CE_version-ZLINUX.BIN

In this screen... Perform this action...

Welcome Click Next to proceed with the Content Engine Client 
installation.

NOTE Click Back at any time while running the Content Engine 
Client installer to make changes in any previous screens. Click 
Cancel to exit the Content Engine Client installer.
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Specify Content 
Engine Client 
Installation Path

Specify the complete path where you want the Content Engine 
Client program files installed. The defaults are as follows:

UNIX

/opt/FileNet/Content Engine

Windows

C:\Program Files\FileNet\CEClient

Click Next to continue.

Select FileNet P8 
Applications

Select Process Engine, and click Next to continue.

Process Engine 
Installation Path

Enter the full path to the Process Engine installation location. 
The defaults are as follows:

UNIX

/FNSW

Windows

C:\FNSW

Click Next to continue.

Content Engine 
Application 
Server

Select the Content Engine application server type from the list. 
Valid choices are: 

• WebSphere

• WebLogic

• JBoss

Click Next to continue.

In this screen... Perform this action...
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• To install the Content Engine client files silently:

i. Make a back up copy of the CEClient_silent_install.txt input file.

ii. Open the silent input file in a text editor. Follow the instructions in the silent input file to 
edit the file to reflect the appropriate responses for your update.

Specify URLS for 
EJB Transport

(This screen will 
not display during 
an upgrade.)

Specify the URLS for the Content Engine Enterprise Java Bean 
(EJB) API.

• Content Engine Client Software URL

The URL for the Content Engine Web Services client API. 
This URL will contain the WcmApiConfig.properties file, 
which is required for applications to communicate with 
Content Engine Server, regardless of whether they use the 
EJB or Web Services transport method.

The default is: cemp:iiop//CEServer:2809/FileNet/Engine

• Content Engine upload URL

The upload URL is used for internal processes during EJB 
transport activities.

The default is: cemp:iiop//CEServer:2809/FileNet/Engine

• Content Engine download URL

The download URL is used for internal processes during 
EJB transport activities.

The default is: cemp:iiop//CEServer:2809/FileNet/Engine

Click Next to continue.

Specify URL for 
WSI Transport

The URL for the Content Engine Web Services client API. 
The API contains the WcmApiConfig.properties file, which is 
required for applications to communicate with Content 
Engine Server, regardless of whether they use the EJB or 
Web Services transport method.

The default is: 
cemp:http://CEServer:9080/wsi/FNCEWS40DIME/

Click Next to continue.

Review 
Pre-Installation 
Summary 

Verify your component selections, and click Install to start 
installing Content Engine Client.

In this screen... Perform this action...
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iii. Navigate to the path containing the Content Engine Client installation program, and run 
one of the commands in the following table to perform the silent install, where:

CE_version is the version of Content Engine you intend to run, for example, 4.5.0.

 path is the path that contains the installation program.

5.

Operating 
System

Install Program

AIX P8CE-CLIENT-CE_version-AIX.BIN -f path/CECLIENT.AIX/  
CEClient_silent_install.txt -i silent

HPUX P8CE-CLIENT-CE_version-HPUX.BIN -f path/CEClient.HPUX/ 
CEClient_silent_install.txt -i silent

HPUXi P8CE-CLIENT-CE_version-HPUXI.BIN -f path/CEClient.HPUXI/
CEClient_silent_install.txt -i silent

Linux P8CE-CLIENT-CE_version-LINUX.BIN -f path/CEClient.Linux/
CEClient_silent_install.txt -i silent

Solaris P8CE-CLIENT-CE_version-SOL.BIN -f path/CEClient.Solaris/
CEClient_silent_install.txt -i silent

Windows P8CE-CLIENT-CE_version-WIN.EXE -f path\CEClient.Windows\ 
CEClient_silent_install.txt -i silent

zLinux P8CE-CLIENT-CE_version-ZLINUX.BIN -f path/CEClient.zLinux/
CEClient_silent_install.txt -i silent
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Task 4: Install the latest Process Engine Client files on 
other IBM FileNet P8 servers (for staged upgrades)
When you upgrade Process Engine server software, you must also upgrade the associated 
Process Engine Client files installed on other machines running IBM FileNet P8 components, for 
example, on Content Engine and Application Engine servers. In a standard upgrade of your IBM 
FileNet P8 system, you would install these client files in the course of upgrading each respective 
component.

However, if you are staging your IBM FileNet P8 upgrade over a period of time and not upgrading 
one or more of the other IBM FileNet P8 components at this time, you must still perform the 
Process Engine Client install on the other component machines. In this case, use the following 
topics in the sections for the other components:

• “Install the latest Process Engine Client files on Content Engine servers” on page 391

• “Install the Latest Process Engine Client files on Application Engine servers” on page 571

NOTES  

• You will have this same client-installation requirement for any expansion products that use 
Process Engine Client files, such as:

– Workplace XT

– Records Manager

– Business Process Framework

• You must redeploy any components that are web-application-server based, such as Content 
Engine, Application Engine, Workplace XT, and Records Manager after you upgrade the 
Content Engine Client files on the associated machines.
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Task 5: Complete post-upgrade Process Engine 
configuration
You must perform the following additional procedures to complete the upgrade of all Process 
Engine data and objects. Perform the procedures in one of the following two subtopics, depending 
on the starting point of  your upgrade:

“Complete the upgrade from Process Engine 3.5.x” on page 526

“Complete the upgrade from Process Engine 4.0.2-001, 4.0.3, or higher” on page 538 

Complete the upgrade from Process Engine 3.5.x 
The format of the event log files changed in the 4.0 release.  As a part of this upgrade, several 
SQL scripts must be executed for SQL Server and DB2 databases only. 

CAUTION Throughout this procedure there are multiple software restarts.  Execute all restarts as 
documented. Do not start or restart Process Task Manager or other IBM FileNet software unless 
specifically told to do so.  When you restart Process Task Manager it accesses the database, 
which should not be done until the database has been upgraded. 

To execute steps on a UNIX operating system, the terminal must support X Windows and the 
DISPLAY environment variable must be set.

SQL Server Client software is required on the Process Engine server to execute a number of SQL 
scripts documented in this topic if the database is a remote SQL Server. The SQL Server Client 
software can be removed from the Process Engine server after the Process Engine database has 
been successfully upgraded to the 4.5 release.

To update the Process Engine database objects

After you have updated the Process Engine software, you must update the Process Engine 
database objects.

1. UNIX

Log on as fnsw.

Windows

Log on as a local administrator.

2. (Windows only) Ensure that the Process Engine services are started:

• IMS ControlService

• Process Engine Services Manager

3. (Windows only) Enable the redirection of log messages to the Image Services error log. This 
redirection logs messages to the Image Services error log as well as to the default Windows 
Event Log. When you enable this redirection, you can monitor the progress of the database 
object upgrade in a command window. 
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To enable the redirection, change the LogToFiles value from 0 to 1 for the following registry 
key.

HKEY_LOCAL_MACHINE > SOFTWARE > FileNET > IMS > CurrentVersion

4. Restart the Process Engine software by entering the following at a Windows command prompt 
or UNIX command line.

 initfnsw -y restart

5. If you are using a SQL Server database, proceed to Step 6.  If you are using a DB2 database, 
proceed to Step 7.  If you are using an Oracle database, proceed to Step 8.

6. (SQL Server only)  Edit and run the \fnsw\mssql\vwmssql35to40_pre1.bat file.  Database 
schema changes will be made to vwnotify and vwpending database tables.  

a. Save the file to the same directory as vwmssql35to40_pre1a.bat.

b. Change the values in the file as appropriate for your system. The content of the 
vwmssql35to40_pre1.bat file looks like this:

osql /U sa /P /n /d VWdb /h-1 /i vwmssql35to40_pre1.sql

Change the values for your system to:

osql /D DSN /U sa /P sa /n /d VWdb /h-1 /i vwmssql35to40_pre1.sql 
/o pre1a.log  

where:

/D indicates the following variable is your ODBC data source name (DSN).

/U indicates the following variable is the administrator user name in the Process Engine 
database.

/P indicates the following variable is the administrator user’s password in the Process 
Engine database.

/d indicates the following variable is the Process Engine database name.

Optionally, you can add an output file /o pre1a.log.  Otherwise, all output goes only to the 
screen.

c. Run the vwmssql35to40_pre1a.bat file.

d. Proceed to Step 8.

7. (DB2 only)  Edit and run the \fnsw\DB2\vwdb2_35to40_pre1.bat file on Windows or  
\fnsw\DB2\vwdb2_35to40_pre1.sh on UNIX platforms.  Database schema changes will be 
made to vwnotify and vwpending database tables.

a. Copy the file to the same directory as vwdb2_35to40_pre1a.bat or 
vwdb2_35to40_pre1a.sh.

b. Change the values in the file as appropriate for your system to: 

db2 connect to database_name user PE runtime user using  password
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where:

database_name is your Process Engine DB2 database name

PE runtime user is the Process Engine runtime user (f_sw)

password is the Process Engine runtime user password in the Process Engine database

c. Run the vwdb2_35to40_pre1a.bat under from the DB2 command line processor on 
Windows, or run vwdb2_35to40_pre1a.sh from a command prompt on UNIX. 

d. Proceed to Step 8.

8. Initiate the database Process Engine schema changes by executing the following command:

vwtool

and then complete the following substeps:

a. Choose Yes when a message is presented indicating that an upgrade is required. 

b. Turn on tracking for database access and transfer when prompted as to whether you want to 
initiate tracking to capture the changes make to a trace file.

NOTE A number of messages will scroll to the window.  Do not choose X in response to the 
prompt as this will terminate the current vwtool command and return an error.  

c. Type exit to end vwtool when the upgrade is complete.

When vwtool starts, it automatically checks the Process Engine database level, updates 
the schema accordingly, and creates two additional scripts.

SQL Server

fnsw\mssql\vwmssql35to40_post1.sql  

fnsw\mssql\vwmssql35to40_post2.sql

DB2 

fnsw\DB2\vwdb2_35to40_post1.sql  

fnsw\DB2\vwmdb2_35to40_post2.sql  

CAUTION If the upgrade fails at this point, you must restore the Process Engine database 
backup.  

See the Image Services error log to monitor the progress of the updates and ensure that 
no errors occur.

Check the logs to verify that messages similar to the following are captured: 

2006/10/17 16:23:43.261  <fnsw> VW/Process  (14952) ... [INFO]
VW: Database upgrade successful to version 46, please follow instructions to perform 
the next step.

2006/10/17 16:23:43.303  <fnsw> VW/Process  (14952) ... [INFO]
VW: Must restart software to complete upgrade procedure

Please follow the upgrade documentation to continue with the upgrade procedures.
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You must:

1. Restart the Process Engine software.
2. Configure the Process Engine connection to the Content Engine.
3. Run vwtool to continue the upgrade procedure.

Ignore messages designated as SERIOUS if they are in combination with a successful 
message for that upgrade, especially if all process IDs are the same for all the errors and 
INFO messages.  

9. Exit vwtool when you get a message that the procedure is complete.  

10. Do a backup of the Process Engine database.  This backup can serve as a checkpoint, should 
an error occur later that requires a database restore. 

11. Restart the Process Engine software.  At a Windows command prompt, or UNIX command line, 
type the following:

    initfnsw -y restart

To update the Process Engine security

Before updating the Process Engine security, ensure the following is true:

• Your directory server is running and correctly configured.

• Content Engine 4.0 or 4.5 is running.  

NOTE When the Process Task Manager starts, a message will be presented indicating that routers 
must be migrated.  Routers will be migrated in “To migrate routers and update isolated regions” on 
page 531 as a part of completing Process Engine configuration changes.  The message can be 
ignored now.

1. Update the information on the Process Task Manager Security / General tab, as follows:

a. Start Process Task Manager as follows, depending on your operating system: 

Windows

Select Start > Programs > FileNet P8 Platform > Process Engine > Process Task Manager.

UNIX

Enter the following command on the command line:

vwtaskman

b. Verify that Process Engine is running. To start it, right-click your Process Engine server in 
the feature pane and choose Start from the Action menu.

c. Select the Process Engine in the feature pane and select the Security tab to configure the 
General settings. 

Provide the pe_service_user and password, the pe_admin_group and the optional 
pe_config_group.  See the IBM FileNet P8 help topic FileNet P8 Administration > Enterprise-
wide Administration > Process Task Manager > Process Engine > Configure the Process Engine > 
Security for details on the user and groups.  
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NOTE The service user name should be entered as a short name, not a distinguished 
name. 

d. Click Apply.

NOTE  If you get an error applying security settings, click Close on the message, correct 
the problem if noted, and repeat Step 1 on page 529. 

Additional information is available in: 

Windows

 \fnsw_loc\logs\TM_daemon\PEDirectoryServerConnectionDebug.txt

UNIX

/fnsw/local/logs/TM_daemon/PEDirectoryServerConnectionDebug.txt

e. Click OK to close the dialog box indicating that you must run vwtool.  

f. Exit Process Task Manager.  

2. Run vwtool and choose Yes when a message is presented indicating that an upgrade is 
required.  

This step moves all existing user environment records from the 3.5.x format to the 4.5 format.

a. Turn on tracing when prompted. 

b. Choose No in response to the question to override until you have carefully evaluated all 
users who's environment records did not migrate properly.  If you are certain that all 
unmigrated users are no longer valid Process Engine users, that is, they have no Process 
Engine work, then you can override these errors and complete this part of the upgrade. 
Once you choose to override these errors, there is no way to recover the user environment 
records for any users not migrated to 4.5.  Any Process Engine work for unmigrated users is 
lost. Choose Yes to ignore errors and force the completion of the upgrade only after you 
have resolved any outstanding problems.  

As user environment records are moved, information is logged to the Image Services error 
log. When vwtool finishes, it will display messages on the screen indicating whether or not 
the migration was successful, how many users were migrated, and how many users were 
not migrated. 

If all users did not successfully migrate to the 4.5 format, you will need to look at the 
messages in the error log and resolve the problems.  Examples of the types of resolution 
required could include the need to fix a problem with the configuration of the Content 
Engine and its application server's access to the directory server or the need to create 
users in the underlying directory server itself.

c. Address any errors that occurred execute vwtool again. You might be prompted to ignore 
issues related to the user environment record upgrades.   

NOTE If vwtool fails with a shared memory error, follow Step 3 through Step 6 in “(Windows only) 
To configure contiguous free memory for Process Engine” on page 538 to set a hardcoded shared 
memory address, setting the address to 0x122300000. After setting and verifying the address, 
execute Step 2 again.
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3. Check the error log to verify that the database version number has been updated to 52.  This 
update will happen only after either successful migration of all environment records or all errors 
have been intentionally overridden.   

4. At a Windows command prompt, or UNIX command line, type the following to restart the 
Process Engine software:

    initfnsw -y restart

To migrate routers and update isolated regions

Use the following required sub-procedures to convert all routers to connection points, and assign 
passwords to any existing isolated regions:

To remove existing routers in Process Task Manager

1. On the Process Engine and Application Engine servers, use Process Task Manager to view, and 
make note of, the general properties of each Process Router: 

• Process Router name 

• Process Engine 

• Isolated region 

2. Delete each Process Router, as follows. 

NOTE You can do this immediately or wait until the corresponding connection points are 
created. The Process Routers displayed in Process Task Manager are not used and have no 
effect on the system other than to cause a warning message on Process Task Manager 
startup. Once all Process Routers have been deleted and Process Task Manager has been 
restarted, the Process Router node no longer appears. 

a. Select the Process Router you want to delete. 

b. Select Delete from the Action menu.

c. Repeat Step a and Step b until you have deleted all Process Routers.

To configure new regions in Enterprise Manager

1. Start Enterprise Manager 4.5.  

2. Right-click PE Region ids > New PE Region ids.

3. Specify an isolated region for each unique Process Engine / isolated region combination. (If you 
have more than one Process Router pointing to the same Process Engine / isolated region 
combination, you will identify only one Process Engine Region ID.) 

For this Process Engine Region ID property... Use the value from this Process Router 
property...

DNS name or IP address of the Process Engine Process Engine

Region number Isolated region
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4. Assign a password for each region as you create it.  Make note of the password you assign. You 
will need to enter that password in the steps that follow for assigning the password to regions in 
Process Task Manager. The passwords must match.

5. Navigate to the PE Connection Points node, start the wizard, and create new connection points 
for each region.

6. Close Enterprise Manager.

To configure new regions in Process Task Manager

1. Start Process Task Manager on the Process Engine server as follows, depending on your 
operating system: 

Windows

Select Start > Programs > FileNet P8 Platform > Process Engine > Process Task Manager.

UNIX

Enter the followng command on the command line:

vwtaskman 

The terminal must support X Windows and the DISPLAY environment variable must be set.

2. Select Process Engine in the feature pane.

3. Right-click on the Regions folder, select New to create a new region.

4. Select the Security Settings sub-tab to set a region password.

NOTE The password must match the password that you entered when creating a Process 
Engine Region in Step 4 on page 532 (in the previous procedure). 

After you have entered all parameters, click Apply and restart the Process Service when 
prompted.  If errors are returned, additional information is available in the following file: 

Windows 

\fnsw_loc\logs\TM_daemon\PEDirectoryServerConnectionDebug.txt

UNIX 

/fnsw/local/logs/TM_daemon/PEDirectoryServerConnectionDebug.txt

To update email notification

If you’re using email notification, do the following to enable email notification:

1. Add a language pack for the Default Authoring Locale.

See the IBM FileNet P8 help topic FileNet P8 Administration > Process Engine Administration > 
Workflow administration tasks > Coordinating workflow design > Enable Email notification for 
information on adding a language pack for the Default Authoring Locale. 

NOTE Process Engine supports localized email notification. For details on configuring this, 
see the IBM FileNet P8 Non-English Support Guide. To download this document from the IBM 
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FileNet support Web site, see “Access IBM FileNet documentation, compatibility matrices, and fix 
packs” on page 20.

2. Verify that the Default Authoring Locale is correct (it has defaulted to the operating system's 
locale). 

To update all isolated regions 

Use the following procedure to update isolated regions, namely to perform a transfer of the 
upgrade.cdl file.

1. Restart the Process Engine software by typing the following at a command line:

    initfnsw -y restart

2. Change directories to the following location of the upgrade.cdl file, depending on your 
operating system:

Windows

\fnsw_loc\sd 

UNIX

/fnsw/local/sd 

3. Initiate a transfer on all working isolated regions by entering the following command:

vwtfer -o upgrade.cdl -r All 

where:

-r All indicates all regions and All is case sensitive

At the prompt, log on as a user who is a member of the PEAdministrators group.

(SQL Server and DB2 only) To run post-upgrade scripts 

If your Process Engine database is either SQL Server and DB2, use the following sub-procedures 
to run two post-upgrade scripts. For each database type, the first script copies records from 
archived event-log tables to the new 4.5 version of the tables, and the second script deletes the 
archived log tables, thereby saving database space. 

Because no such scripts are available for Oracle databases, skip to the procedure “To back up the 
database and restart software” on page 535, which applies to all database types.

(SQL Server)To run post-upgrade scripts 

1. Edit and run the \fnsw\mssql\vwmssql35to40_post1.bat file, as follows:

a. Save the vwmssql35to40_post1.bat file to the same directory as 
vwmssql35to40_post1a.bat.

b. Change the values in the vwmssql35to40_post1a.sql file as appropriate for your system. 
The contents of the file look like this:

osql /U sa /P /n /d VWdb /h-1 /i vwmssql35to40_post1.sql
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Change the values for your system to:

osql /D DSN /U σα /P sa /n /d VWdb /h-1 /i vwmssql35to40_post1.sql /o post1a.log

where:

/D indicates the following variable is your ODBC data source name (DSN).

/U indicates the following variable is the administrator user name in the Process Engine 
database.

/P indicates the following variable is the administrator user’s password in the Process 
Engine database.

/d indicates the following variable is the Process Engine database name.

/o indicates the following variable is the optional post1a.log output file. If you choose to 
eliminate this entry, output displays to the screen only.

c. Run the vwmssql35to40_post1a.bat file.

2. Delete archived event log tables by editing and running vwmmql35to40_post2.bat.

a. Change the values in the vwmssql35to40_post2a.sql file as appropriate for your system. 
The contents of the file looks like this:

osql /U sa /P /n /d VWdb /h-1 /i vwmssql35to40_post2.sql

Change the values for your system to:

osql /D DSN /U sa /P sa /n /d VWdb /h-1 /i vwmssql35to40_post2.sql /o post2a.log

where:

/D indicates the following variable is your ODBC data source name (DSN).

/U indicates the following variable is the administrator user name in the Process Engine 
database.

/P indicates the following variable is the administrator user’s password in the Process 
Engine database.

/d indicates the following variable is the Process Engine database name.

/o indicates the following variable is the optional post2a.log output file. If you choose to 
eliminate this entry, output displays to the screen only.

b. Run the vwmssql35to40_post2a.bat file.

c. Proceed to the procedure “To back up the database and restart software” on page 535.

(DB2) To run post-upgrade scripts 

1. Connect to the DB2 database and run the \fnsw\DB2\vwdb2_35to40_post1.sql file.  

a. Start the DB2 command line processor and log on to the Process Engine database with the 
Process Engine runtime user (f_sw). 

b. Enter the following command in that window:

db2 connect to database_name user PE runtime user using password
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where:

database_name is your Process Engine DB2 database name.

PE runtime user is the Process Engine runtime user (f_sw).

password is the Process Engine runtime user password in the Process Engine database.

c. Run the vwdb2_35to40_post1.sql file by executing the following in the DB2 command line 
processor:

db2 -tvf vwdb2_35to40_post1.sql

2. Connect to the DB2 database and run the \fnsw\DB2\vwmdb2_35to40_post2.sql file, as 
follows: 

a. Start the DB2 command-line processor and log on to the Process Engine database with the 
Process Engine runtime user (f_sw), 

b. Enter the following command in that window: 

db2 connect to database_name user PE runtime user using password

where:

database_name is your Process Engine DB2 database name.

PE runtime user is the Process Engine runtime user (f_sw).

password is the Process Engine runtime user password in the Process Engine database.

c. Run the vwmdb2_35to40_post2.sql file by executing the following in the DB2 command-
line processor:

db2 -tvf vwdb2_35to40_post2.sql

d. Proceed to the procedure “To back up the database and restart software” on page 535.

To back up the database and restart software

1. Back up the Process Engine database. While this backup is not required, it is a best practice. It 
provides a checkpoint that can be used later if a restore is needed in the context of this upgrade.
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2. (Windows only) Start the following services and set them back to automatic startup.

• IMS ControlService

• Process Engine Services Manager 

3. (Windows only) Disable the redirection of log messages to the Windows Event Log by changing 
the LogToFiles value from 1 to 0 for the following registry key:

HKEY_LOCAL_MACHINE > SOFTWARE > FileNET > IMS > CurrentVersion

4. Restart the Process Engine software, as follows:

At a Windows command prompt, or UNIX command line, type the following:

    initfnsw -y restart

(Windows only) To configure contiguous free memory for Process Engine 

Use the following procedure to configure the largest available contiguous free memory block. If 
you fail to perform this procedure, the system will not allocate shared memory at some point 
during normal execution and will cease to function correctly. 

If you have already created the registry key, reset the value based on the information acquired 
here.

1. Start vwtool at a command prompt, and log on using the pe_service_user.

2. Use the processmap command to find the largest contiguous free memory area, as in:

<vwtool:1>processmap

This command returns the following output:

Process Id (CR=this vwtool process):

Press Return (CR) to get the process map for this process, as in the following example, where 
the process ID is 2592:

C:\FNSW\BIN\vwtool.exe (ID:2592)

Address    Attrib         Size    Owner
=======    ======         ====     =====

00000000   Free          65536
00010000   Private       12288
00013000   Free          53248
00020000   Private         4096

(pages of memory addresses omitted here)

7FFDE000   Private        4096
7FFDF000   Private        4096
7FFE0000   Private        65536

C:\FNSW\BIN\vwtool.exe (ID:2592)

Largest FREE block found: 453873664 bytes at address 0x4B577000
Rounded up to a 64K boundary, free block address 0x4B580000
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In this example, 0x4B580000 is the address you will need in the next step. In some cases you 
might see only the line referencing the largest free block because the value is already at a 64K 
boundary.

3. Start regedit from the Windows Start > Run command and perform the following steps to create 
a DWORD value for IS StartShmAddress, using the address noted in step 2 as follows:

a. Navigate to the following regedit key: 

HKEY_Local_Machine\Software\FileNet\IMS\CurrentVersion\ 

b. Create a new DWORD value named:

StartShmAddress 

c. Enter or verify the following in the Edit DWORD Value Screen:

Value name =  StartShmAddress

Value data = address of largest free memory block  

From the example above the value will be 4B580000.

Base is hexadecimal.

d. Click OK.  

e. Exit from regedit.

4. Restart the Process Engine software.

5. Verify the setting you just applied for the shared memory address by executing the following at a 
command prompt:

ipc_tool -A

The following is an example of the information that is returned.  

Image Services software shared memory segment limit: 129 segments
Current configured segment size: 0x01000000 bytes (16 MB)
Before allocating shared memory for Image Services, the SysV library
performs a test to determine the system shared memory limit.  This test
can be used as a reference for performance tuning.  The test results vary
depending on the amount of memory in use by other processes.  The actual
amount of shared memory available during operation may be less.  The test
results are:

   Successfully attached to 27 segments
   Successfully obtained 432 MB of shared memory

The following table displays the number of shared memory segments currently
in use by Image Services.  Segment #0 (called the address manager) is small.
The other segment(s) contain the actual Image Services data.  Note that
running ipc_tool will force the creation of segments #0 and #1 even when no
other Image Services process is up.
Shared Memory Address Manager Information

    Address     Shm id          Creator

Enter <space> to continue, 'q' to quit:
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  0 0x4b580000  FNSHM_464d0000  Shared address manager

  1 0x4c580000  FNSHM_464a0000  FileNet server software

Total Image Services shared memory allocated: 16 MB

(This does not include segment #0)

NOTE The First shared memory address above 0x4B580000 is the value you would check for 
this example.

6. Exit ipc_tool. If the shared memory address is correct, proceed to the next installation task. If 
the value is not correct, verify Step 1 through Step 4 above before proceeding.

Complete the upgrade from Process Engine 4.0.2-001, 4.0.3, or higher
Perform the following steps to update a Process Engine database to version 4.5. A database 
update will take place automatically by restarting the software.  

To update the database to version 4.5

1. Run the following command to restart the Process Engine: 

initfnsw -y restart 

2. Check the Image Services error logs to verify that messages similar to the following are 
captured: 

2008/04/17 16:23:43.261 fnsw VW/Process (14952) ... [INFO]

VW: Database upgrade successful to version 52 please follow instructions to perform the next 
step

2008/04/17 16:23:43.303 fnsw VW/Process (14952) ... [INFO] 

VW: Must restart software to complete upgrade procedure

Ignore messages designated as SERIOUS if they are in combination with a message 
indicating a successful upgrade, especially if all process IDs are the same for all errors and 
INFO messages. 

3. Proceed to “(Windows only) To configure contiguous free memory for Process Engine” on page 538.

(Windows only) To configure contiguous free memory for Process Engine 

Use the following procedure to configure the largest available contiguous free memory block. If 
you fail to perform this procedure, the system will not allocate shared memory at some point 
during normal execution and will cease to function correctly. 

If you have already created the registry key, reset the value based on the information acquired 
here.

1. Start vwtool at a command prompt, and log on using the pe_service_user.

2. Use the processmap command to find the largest contiguous free memory area, as in:

<vwtool:1>processmap
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This command returns the following output:

Process Id (CR=this vwtool process):

Press Return (CR) to get the process map for this process, as in the following example, where 
the process ID is 2592:

C:\FNSW\BIN\vwtool.exe (ID:2592)

Address    Attrib         Size    Owner
=======    ======         ====     =====

00000000   Free          65536
00010000   Private       12288
00013000   Free          53248
00020000    Private          4096

(pages of memory addresses omitted here)

7FFDE000   Private        4096
7FFDF000   Private        4096
7FFE0000    Private           65536

C:\FNSW\BIN\vwtool.exe (ID:2592)

Largest FREE block found: 453873664 bytes at address 0x4B577000
Rounded up to a 64K boundary, free block address 0x4B580000

In this example, 0x4B580000 is the address you will need in the next step. In some cases you 
might see only the line referencing the largest free block because the value is already at the 
64 Kb boundary.

3. Start regedit from the Windows Start > Run command and perform the following steps to create 
a DWORD value for IS StartShmAddress, using the address noted in step 2 as follows:

a. Navigate to the following regedit key: 

HKEY_Local_Machine\Software\FileNet\IMS\CurrentVersion\ 

b. Create a new DWORD value named:.  

StartShmAddress 

c. Enter or verify the following in the Edit DWORD Value Screen:

Value name =  StartShmAddress

Value data = address of largest free memory block  

From the example above the value will be 4B580000.

Base is hexadecimal.

d. Click OK.  

e. Exit from regedit.

4. Restart the Process Engine software.
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5. Verify the setting you just applied for the shared memory address by executing the following at a 
command prompt:

ipc_tool -A

The following is an example of the information that is returned.  

Image Services software shared memory segment limit: 129 segments
Current configured segment size: 0x01000000 bytes (16 MB)
Before allocating shared memory for Image Services, the SysV library
performs a test to determine the system shared memory limit.  This test
can be used as a reference for performance tuning.  The test results vary
depending on the amount of memory in use by other processes.  The actual
amount of shared memory available during operation may be less.  The test
results are:

   Successfully attached to 27 segments
   Successfully obtained 432 MB of shared memory

The following table displays the number of shared memory segments currently
in use by Image Services.  Segment #0 (called the address manager) is small.
The other segment(s) contain the actual Image Services data.  Note that
running ipc_tool will force the creation of segments #0 and #1 even when no
other Image Services process is up.
Shared Memory Address Manager Information

    Address     Shm id          Creator

Enter <space> to continue, 'q' to quit:

  0 0x4b580000  FNSHM_464d0000  Shared address manager

  1 0x4c580000  FNSHM_464a0000  FileNet server software

Total Image Services shared memory allocated: 16 MB

(This does not include segment #0)

NOTE The First shared memory address above 0x4B580000 is the value you would check for 
this example.

6. Exit ipc_tool. If the shared memory address is correct, proceed to the next installation task. If 
the value is not correct, verify Step 1 through Step 4 above before proceeding.

To update all isolated regions 

Use the following procedure to update all isolated regions, namely to perform a transfer of the 
upgrade.cdl file.

1. Restart the Process Engine software by typing the following at a command line:

    initfnsw -y restart

2. Change directories to the following location of the upgrade.cdl file, depending on your 
operating system:

Windows

\fnsw_loc\sd 
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UNIX

/fnsw/local/sd 

3. Initiate a transfer on all working isolated regions by entering the following command:

vwtfer -o upgrade.cdl -r All -Y

where -r All indicates all regions

At the prompt, log on as a user who is a member of the PEAdministrators group.
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Task 6: Install Process Engine software updates
Perform the procedure in this topic  for the Process Engine to install software updates (fix pack or 
interim fix). 

To install the Content Engine software updates

1. To obtain the latest Process Engine software updates, and to determine whether additional 
interim fixes are needed, contact your service representative.

2. Open the readmes for the Process Engine software updates and perform the installation 
procedures in the readmes on the Process Engine.
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Upgrade and configure Application Engine
The tasks for upgrading Application Engine vary depending on whether you start from version 
3.5.x or version 4.0.x. You must perform some tasks regardless of your upgrade starting point, as 
indicated in the following steps.

For upgrades from 3.5.x

1. Prepare for the Application Engine upgrade. Perform Task 1 on page 544.

2. Upgrade Application Engine. Perform Task 2a on page 548.

3. Install Application Engine software updates. Perform Task 3 on page 563.

4. Install the Content Engine Client updates. Perform Task 4 on page 564.

5. Install the Process Engine Client updates. Perform Task 5 on page 571.

6. Configure Application Engine according to your application server type:

– Configure for Websphere: Task 6a on page 576

– Configure for WebLogic:Task 6b on page 585

– Configure for JBoss: Task 6c on page 591

7. Manually copy custom Application Engine data. Perform Task 7 on page 594.

8. Deploy Application Engine according to your application server type:

– Deploy on Websphere: Task 8a on page 595

– Deploy on WebLogic: Task 8b on page 598

– Deploy on JBoss: Task 8c on page 600

9. Complete post-upgrade Application Engine configuration. Perform Task 9 on page 602.

For upgrades from 4.0x

1. Prepare for the Application Engine upgrade. Perform Task 1 on page 544.

2. Upgrade Application Engine. Perform Task 2b on page 559.

3. Install Application Engine software updates. Perform Task 3 on page 563.

4. Install the Content Engine Client updates. Perform Task 4 on page 564.

5. Install the Process Engine Client updates. Perform Task 5 on page 571.

6. Manually copy custom Application Engine data. Perform Task 7 on page 594.

7. Deploy Application Engine according to your application server type:

– Deploy on Websphere: Task 8a on page 595

– Deploy on WebLogic: Task 8b on page 598

– Deploy on JBoss: Task 8c on page 600

8. Complete post-upgrade Application Engine configuration. Perform Task 9 on page 602.
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Task 1: Prepare for Application Engine upgrade
This task includes Application Engine upgrade preparation instructions for WebSphere, WebLogic, 
and JBoss (UNIX and Windows). It applies to Application Engine upgrades from both 3.5.x and 
4.0.x versions. 

Before you upgrade Application Engine
• (Upgrades from 3.5.x only) Verify that Content Engine and Process Engine have been 

upgraded. 

• Review the Application Engine details of the guide Plan and Prepare Your Environment for IBM 
FileNet P8 Platform.

• Review the steps needed to retain the AE 3.5.x or 4.0.1 configuration. You will need this 
information if, for any reason, you want to back out of this installation.

• Verify that you have recorded all necessary settings.

(Best practices for backup) If you want to retain your existing Application Engine settings you 
must record all necessary settings before you start the upgrade installation.

– As part of the upgrade you will create backup copies of all important 3.5.x or 4.0.1 
configuration files in “Backup, undeploy, and remove the Workplace web application from the 
J2EE application server.” on page 545. 

– During the upgrade, a number of existing configuration files will be moved to the newly 
created AE_install_path\Config\AE directory. See Table 1, “Configuration files that will 
be moved,” on page 547.

– As part of the upgrade, the installation program automatically creates a backup of your 
existing AE 3.5.x or 4.0.1 configuration files, appending the suffix .old to the file names. 
See Table 2, “Configuration files that will be backed up,” on page 547.

– The existing version 3.5.x or 4.0.1 Actions.xml and web.xml files will be merged with the 
4.0.2 versions during the upgrade installation.

– In addition, all comments added to the Actions.xml file will be lost during the merge. 

• If you have the IBM FileNet P8 eForms expansion product installed, uninstall it.

See the “Removing Software” topic in the IBM FileNet P8 eForms Installation Guide. To 
download this guide from the IBM support page, see “Access IBM FileNet documentation, 
compatibility matrices, and fix packs” on page 20.

To prepare for the Application Engine upgrade

1. Log on to the Application Engine server: 

UNIX

Log on as root.
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Windows

Log on as a member of the local Administrators group or a user with equivalent permissions.

2. (Upgrades from 3.5.x only) Verify that the Process Router is stopped.

NOTE  Although the Application Engine router has been deleted as part of the Process Engine 
upgrade, a local, disconnected instance might be running on your server.

a. Launch the Process Task Manager from AE_install_path/Router:

UNIX

./routercmd.sh

Windows

routercmd.bat

b. Stop the router, if running.

NOTE  This is the router configured and started as part of the FileNet P8 Platform 3.5.x 
installation. For more information, see the FileNet P8 Platform 3.5.x Installation and 
Upgrade Guide task “Start the Process Router.” To download this guide from the IBM 
support page, see “Access IBM FileNet documentation, compatibility matrices, and fix packs” on 
page 20.

c. Exit the Process Task Manager.

3. (Windows only) Using the Windows Task Manager, verify that no javaw.exe processes are 
running. If the applications in the preceding steps stopped correctly, no Application Engine 
related javaw.exe processes should be running.

a. Use Windows Services to stop the Process Application Engine Services Manager Service.   
Select Start > Programs > Administrative Tools > Services. If the Process Application 
Engine Services Manager status is started, then right-click the item and select Stop.

b. If there are still javaw.exe processes running after stopping the Process Application Engine 
Services Manager, use the Windows Task Manager to stop any Application Engine related 
javaw.exe processes.

4. Backup, undeploy, and remove the Workplace web application from the J2EE application server.

During this step you will create a backup copy of the deployed web application containing all 
customized files and all configuration files stored in the WEB-INF directory. 

NOTE  Even though the installer automatically creates a backup of your existing AE 3.5.x or 
4.0.1 configuration files IBM recommends backing up the directories below to get a complete 
backup of your deployed system. You might need to use these files in later steps, such as 
when you copy modified files to the installed Workplace directory and perform the upgrade 
and configuration of Application Engine, to retain your 3.5.x or 4.0.1 settings.

WebSphere

a. Make a backup copy of the deployed Workplace directory (deploy_backup): 

WAS_HOME/profiles/default/installedApps/node_name/app_engine_war.ear/
app_engine.war
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NOTE Your path may vary if you created a new profile or renamed your WAR file.

b. Stop the Workplace application from the WebSphere administrative console.

c. Uninstall the Workplace application from Enterprise Applications. 

d. Save the changes and stop the WebSphere server.

e. Delete the temp Workplace directory (default: app_engine_war) from: 

WAS_HOME/profiles/default/temp/node_name/instance/app_engine.war

WebLogic

a. From the WebLogic Administration Console, stop the Workplace web application module.

b. Make a backup copy of the Workplace folder (deploy_backup):

AE_install_path/Workplace 

c. Delete the Workplace Web Application Module.

d. Stop the WebLogic server.

JBoss

a. Stop the JBoss server.

b. Make a backup copy of the deployed Workplace directory (deploy_backup):

JBoss_HOME/server/default/deploy/Workplace.war 

c. Delete the deployed Workplace directory:

JBoss_HOME/server/default/deploy/Workplace.war

d. Delete the temporary Workplace directory for JBoss:

JBoss_HOME\server\default\work\jboss.web\localhost\Workplace

5. Copy modified files to the installed Workplace directory.

During the upgrade, the configuration files listed in Table 1 on page 547 will be moved from the 
following directory:

AE_install_path/Workplace/WEB-INF 

to

AE_install_path/Config/AE

NOTE  If you have made modifications to any of these files directly in the deployed Workplace 
directory (app_engine.war for WebSphere or Workplace.war for JBoss) in your Filenet P8 
3.5.x or 4.0.1 environment you must copy modified version of these files from the 
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deploy_backup directory to the installed directoryAE_install_path/Workplace/WEB-INF 
before you run the installer. :

NOTE  As part of the upgrade the installation program automatically creates a backup of your 
existing AE 3.5.x or 4.0.1 configuration files, appending the suffix .old to the file names.

The backed up files are located in:

AE_install_path/backup-4_0_2

6. Upgrade and configure the Application Engine software. See “Upgrade Application Engine from 
3.5.x” on page 548.

Table 1: Configuration files that will be moved

• actions.xml

• bootstrap.properties

• ClassFilter.xml

• ConfigurableLabels.xml

• containericons.properties

• content_redir.properties

• customobjecticons.properties

• download_redir.properties

• fnsoap.xml

• icons.properties

• InfoPages.xml

• PagingConfiguration.xml

• PolicyProcessors.xml

• PrimaryViews.xml

• PropertiesPages.xml

• SimpleSearch.xml

• SystemsPropertiesView.xml

Table 2: Configuration files that will be backed up

• actions.xml.old

• ClassFilter.xml.old

• ConfigurableLabels.xml.old

• containericons.properties.old

• content_redir.properties.old

• icons.properties.old

• SystemsPropertiesView.xml.old

• UpdateActions.xml.old

• UpdateClassFilter.xml.old

• UpdateConfigurableLabels.xml.old

• UpdateProps.xml.old

• UpdateSystemPropertiesView.xml.old

• UpdateWeb.xml.old

• web.xml.old
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Task 2a: Upgrade Application Engine from 3.5.x
This topic includes Application Engine installation instructions for all supported application 
servers and operating systems. 

NOTES 

• If you plan to install and use the IBM FileNet Workplace XT product, you do not need to install 
Application Engine.

• Before installing Application Engine, check the latest version of the IBM FileNet P8 4.5 
Release Notes for known issues that might impact this software installation. To download this 
guide from the IBM support page, see “Access IBM FileNet documentation, compatibility matrices, 
and fix packs” on page 20.

• Make sure your installation location meets the requirements specific for Application Engine 
outlined in the IBM FileNet P8 Hardware and Software Requirements. To download this guide 
from the IBM support page, see “Access IBM FileNet documentation, compatibility matrices, and fix 
packs” on page 20.

• Consider whether changing your deployment type is likely.

As a best practice, choose to install Application Engine as if you intend to deploy an EAR file, 
rather than a WAR file, because this choice will produce both an EAR and a WAR file. If you 
decide to change your deployment type from EAR to WAR later, you will be able to use the 
WAR file from the original installation, rather than having to uninstall and reinstall Application 
Engine. 

• (Highly Available installations) To install Application Engine in a web farm or clustered 
environment, follow the instructions in the IBM FileNet P8 Platform High Availability Technical 
Notice. That document outlines the required HA install procedure and references this guide for 
detailed installation and deployment instructions. To download this guide from the IBM support 
page, see  “Access IBM FileNet documentation, compatibility matrices, and fix packs” on page 20.

• To ensure proper functionality and performance install only one instance of Application Engine  
per application server (or virtual machine or WebSphere LPAR). You can, however, deploy 
multiple instances of a single Application Engine version per application server. For details, 
see “Deploy multiple Application Engine instances” on page 295. 

• Before logging on to Workplace for the first time, at least one object store must exist on the 
Content Engine to hold the site preferences. See “Create the initial object store” on page 133 for 
more information.

• If you run the installer to upgrade Application Engine, the installer verifies that the currently 
installed version of Application Engine can be upgraded. See “Prepare for Application Engine 
upgrade” on page 544 for more information. 

• You can install a new Application Engine 4.0.2 server within an existing 4.0.x FileNet P8 
environment if your Content Engine is at version 401.006 or later and your Process Engine is 
at 403-000.001 or later. The Content Engine and Process Engine client files you install on the 
Application Engine must match the version of your Content Engine and Process Engine.
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To install the Application Engine software

1. Log on to the application server, as appropriate for your operating system:

UNIX

Log on as a user with read, write, and execute access to the directory where you plan to install 
Application Engine. 

Windows

Log on as a member of the local Administrators group or a user with equivalent permissions.

2. Start the installation process. 

• To install Application Engine interactively:

i. Access the IBM FileNet Application Engine 4.0.2 installation software. 

ii. Launch the appropriate setup program as specified in the following table, and continue 
with Step 3 on page 550.

• To install Application Engine silently:

i. Locate the IBM FileNet Application Engine 4.0.2 installation software package, and copy 
the appropriate AE_silent_input.txt file to a local directory.

ii. Follow the instructions in the silent input file to edit the file to reflect the appropriate 
responses for your installation. 

For information on parameter values, see “Installation and upgrade worksheet” on 
page 229 in Plan and Prepare Your Environment for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the 
shipping  worksheet file (p8_worksheet.xls), perform the following actions to quickly 
see only the installation properties you must specify for the Application Engine 
installation program:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration 
Program" column header and select AE Installer.

Platform Command

AIX P8AE-4.0.2.0-AIX.bin

HPUX P8AE-4.0.2.0-HPUX.bin

HPUXi P8AE-4.0.2.0-HPUX64.bin

Linux P8AE-4.0.2.0-LINUX.bin

Solaris P8AE-4.0.2.0-SOL.bin

Windows P8AE-4.0.2.0-WIN.exe

zLinux P8AE-4.0.2.0-ZLINUX.bin
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– Click the AutoFilter drop-down arrow in all other column headers and select 
(All).

IMPORTANT  If you are modifying the silent input file to perform an upgrade from AE 
3.5.x to AE 4.0.2 you must modify all instances of AE_install_path in the script as 
follows:

UNIX

Change ../FileNet/AE to ../FileNet

Windows

Change ..\FileNet\AE to ..\FileNet

Change ..\\Filenet\\AE to ..\\FileNet

iii. From a command prompt, navigate to and run the installer:

UNIX

./P8AE-4.0.2.0-operating system.bin -options path_to_edited_input_file/
AE_silent_input.txt -silent

Windows

P8AE-4.0.2.0-Win.exe -options path_to_edited_input_file\AE_silent_input.txt -
silent

NOTE  When installing Application Engine remotely on UNIX, run the installer with the 
standard input stream redirected from /dev/console, for example: 

rsh remote-machine -n P8AE-4.0.2.0-AIX.bin -options AESilentScriptUNIX.txt -
silent < /dev/console 

If you do not add the redirect, the silent intaller will fail with a "process not attached to 
terminal" message and the usage message for the "who" command. 

iv. Continue with Step 4. 

3. Complete the Application Engine Installer screens. For information on parameter values, see 
“Installation and upgrade worksheet” on page 229 in Plan and Prepare Your Environment for IBM 
FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping     
worksheet file (p8_worksheet.xls), perform the following actions to quickly see only the     
installation properties you must specify for the Application Engine installation program:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select AE Installer.

• Click the AutoFilter drop-down arrow in all other column headers and select (All).
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Use the parameters from your installation preparation tasks to complete the installer screens, 
as follows:

In the screen for... Perform this action...

Reading the license 
agreement

NOTE  This screen does 
not appear during a re-
install or an upgrade.

Review and accept the license agreement.

Specifying the 
installation path

For the Installation path field, enter or browse to the location 
where you want to install the Application Engine software 
AE_install_path, or accept the default location:

UNIX

/opt/FileNet/AE/

Windows

C:\Program Files\FileNet\AE\

The installation program installs the Application Engine 
software in this path.

NOTES 

• The installer will use the AE_install_path to place a 
number of other files in default locations. See:

– “Specifying the configuration directory path” on page 555

– “Specifying the log file location” on page 556. 

– “Configuring user token security” on page 557

• On an upgrade the default AE_install_path will be:

UNIX

/opt/FileNet/

Windows

C:\Program Files\FileNet\

• If you select a custom install path, follow the same directory 
structure as seen in a typical install and retain 
the /FileNet/AE part of the path.
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Verifying upgrade

NOTE  This screen 
appears only during an 
upgrade.

The Setup program detects supported older versions of 
Application Engine. 

If the installer reports that no supported version of Application 
Engine exists on your server or if you don’t want to upgrade 
your Application Engine at this time, click Cancel to exit Setup. 

Choosing an application 
server

Select the application server and version from the drop-down 
lists. These choices must match your Content Engine 
application server.

Configuring Content 
Engine API settings

Configure the Content Engine API settings, as follows:

a. Transport method

Select EJB (Enterprise Java Beans) from the drop down 
list.

b. Content Engine Client software URL:

Replace the sample server name and port number 
(CEserver:2809) with the Content Engine server name 
and port number for your Content Engine server.

NOTE To verify the correct port to use, navigate to the 
ports section on the application server where Content 
Engine is deployed and check the 
BOOTSTRAP_ADDRESS port.

NOTE To change the Content Engine name later, or to 
connect to a different Content Engine, edit the 
WcmApiConfig.properties file. For information, see 
the IBM FileNet P8 help topic  FileNet P8 Administration > 
Application Engine Administration > Key configuration files 
and logs.

c. Content Engine upload URL

Replace the sample server name and port number 
(CEserver:2809) with the Content Engine server name 
and port number to use when uploading document 
content to the Content Engine server.

d. Content Engine download URL

Replace the sample server name and port number 
(CEserver:2809) with the Content Engine server name 
and port number for your Content Engine server from 
which to download document content.

In the screen for... Perform this action...
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Choosing deployment file 
type and creation time

Choose to have the wizard create the WAR or EAR file during 
the installation process, or to wait until later.

• Choose Generate a .ear file for deployment if your server 
can deploy an EAR file. Specify an application name for the 
EAR file deployment. The default is Workplace.

• Choose Generate a .war file for deployment if your server 
can deploy a WAR file. 

• Choose Do not generate a deployment file at this time if you 
have additional installation and configuration to perform 
(such as installing Content Engine and Process Engine 
client files and configuring the application server) that will 
require another generation of the WAR or EAR file.

NOTE If you decide to deploy Application Engine as a WAR file 
and later decide to redeploy as an EAR file you must uninstall 
Application Engine and then reinstall the application, selecting 
EAR file deployment. For information, see “Consider whether 
changing your deployment type is likely.” on page 548.

Choosing the 
authentication method

Select the authentication method for use at your site.

• Application-managed authentication uses authentication 
specific to the application and does not share credentials.

• Container-managed authentication provides the ability to 
use single sign-on (SSO) capabilities to share credentials 
between Application Engine and custom applications.

When you select Container-Managed Authentication, Setup 
installs a sample log-in application, and modifies the 
web.xml file to support SSO. You will need to perform 
additional configuration for SSO after Setup is finished.

In the screen for... Perform this action...
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Specifying the 
documentation URL

Enter the documentation server URL, which is where the IBM 
FileNet P8 Platform Documentation is installed.

Your entry must be in the following format:

http://docserver:port#/ecm_help/

where: 

docserver is the name of the Java application server.

port# is the port number.

ecm_help is the root folder of the documentation website. You 
can use multi-part root folders (for example, /docs/ecm_help) 
if your application server supports them.

See “Install IBM FileNet P8 Platform documentation (All)” on page 23 
for more information. 

NOTE For information on how to reconfigure the documentation 
URL after installation is completed, see the IBM FileNet P8 help 
topic  FileNet P8 Administration > Application Engine Administration 
> Key configuration files and logs >  Bootstrap properties.

In the screen for... Perform this action...
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Specifying the 
configuration directory 
path

Accept the default location or browse to the location where you 
want to store the configuration files.

The default location for the configuration files is in a separate 
Config directory one level up from the AE_install_path 
directory selected earlier.

Default location of the configuration directory:

UNIX

/opt/FileNet/Config/

Windows

C:\Program Files\FileNet\Config\

CAUTION  A UNC admin share (for example, \\server\C$) for 
a shared location is not supported. You can use an ordinary file 
share.

NOTES 

• If you select a custom install location, follow the same 
directory structure as seen in a typical install and retain the 
/FileNet/Config/AE part of the path.  

• The configuration files for an EAR file deployment, a web 
farm, or a clustered environment must be located in a 
shared folder that is accesible by all copies of the 
Workplace application. For more information, see the IBM 
FileNet P8 Platform High Availability Technical Notice. To 
download this guide from the IBM support page, see “Access 
IBM FileNet documentation, compatibility matrices, and fix packs” 
on page 20.

Specifying the upload 
location

Provide the upload directory path.

The upload directory is the directory used by Workplace to 
store temporary copies of files uploaded to Workplace. 

Accept the default option or browse for a directory to hold the 
temporary upload files.

CAUTION  A UNC admin share (for example, \\server\C$) for 
a shared upload directory location is not supported. You can 
use an ordinary file share.

In the screen for... Perform this action...
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 2a: Upgrade Application Engine from 3.5.x
To install the Application Engine software

556
Specifying the download 
location

Provide the download directory path.

The download directory is the directory used by Workplace to 
store temporary copies of  files downloaded from Workplace. 

Accept the default option or browse for a directory to hold the 
temporary download files.

CAUTION  A UNC admin share (for example, \\server\C$) for 
a shared download directory is not supported. You can use an 
ordinary file share.

Specifying the log file 
location

Provide the Log files directory path.

The Log file path is the directory used by the installer to store 
the app_engine_install_log_4_0_2.txt log file. 

Accept the default option or browse for a directory.

The default location for the log files is in a separate Logs 
directory one level up from the AE_install_path directory 
selected earlier.

Default location of the logs directory:

UNIX

/opt/FileNet/AE/Logs/

Windows

C:\Program Files\FileNet\AE\Logs\

NOTE  If you select a custom install location, follow the same 
directory structure as seen in a typical install and retain 
the /FileNet/Logs part of the path.  

In the screen for... Perform this action...
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Configuring user token 
security

Configure user token security.

a. If needed, select the check box to create maximum 
strength keys.

By default the installer creates limited strength keys.

b. Enter the number of keys to use, from 1-100. 

NOTE  Security generally increases with the number of 
keys used.

c. Make a note of the user token crypto key path.

The UTCryptoKeyFile.properties file contains the 
user token cryptography key used by IBM FileNet P8 
applications to launch into each other without the need 
for additional login. 

The default location for the User Token Crypto Key file is 
in a separate Authentication directory one level up 
from the AE_install_path directory selected earlier.

Default location of the Authentication directory:

UNIX

/opt/FileNet/Authentication/

Windows

C:\Program Files\FileNet\Authentication\

NOTE  If you select a custom install location it is 
recommended to follow the same directory structure as 
seen in a typical install and retain the /FileNet/
Authentication part of the path.  

CAUTION For multiple applications to pass user tokens to each 
other, each participating application must use the same 
encryption key file. Copy the UTCryptoKeyFile.properties 
file installed with Application Engine to all servers that are 
hosting a token-sharing application.

For information, see the IBM FileNet P8 Developer Help topic 
Developer Help > Workplace Integration and Customization 
Introduction > User Tokens > Configuring Applications to Use Tokens.

Verifying your installation 
selections

Review the list of selections you have made. You may need to 
scroll to see all selections.

Starting the installation Review the installation summary, and click Install.

In the screen for... Perform this action...
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4. View the app_engine_install_log_4_0_2.txt file located, located in AE_install_path/
AE/Logs.

Verify that no errors or failures were logged. Look for the ERROR designation at the start of a 
line. Correct any errors before you proceed.

5. (Optional, UNIX only) Set the the P8TASKMAN_HOME system environment variable.

The Process Engine Client installer will set this variable for you. If you want to specify a 
different location for the client files, you can do so by setting the P8TASKMAN_HOME system 
variable. The default value set by the PE Client installer is:

P8TASKMAN_HOME=AE_install_path/CommonFiles

6. Continue with “Install Application Engine software updates” on page 563.

Completing Application 
Engine setup

Click Finish to complete the installation.

In the screen for... Perform this action...
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Task 2b: Upgrade Application Engine from 4.0.x
This topic includes Application Engine installation instructions for all supported application 
servers, for UNIX and Windows platforms. 

NOTES 

• If you plan to install and use the IBM FileNet Workplace XT product, installing Application 
Engine is not required.

• Before installing Application Engine, check the latest version of the IBM FileNet P8 4.5 
Release Notes for known issues that might impact this software installation. To download this 
guide from the IBM support page, see “Access IBM FileNet documentation, compatibility matrices, 
and fix packs” on page 20.

• Make sure your installation location meets the requirements specific for Application Engine 
outlined in the IBM FileNet P8 Hardware and Software Requirements. To download this guide 
from the IBM support page, see “Access IBM FileNet documentation, compatibility matrices, and fix 
packs” on page 20.

• The installer creates the folder structure and files needed for Application Engine. 

• Switching from WAR file to EAR file deployment.

If a change of deployment type seems likely for your setup in the future, especially if you think 
you might switch from a WAR file to an EAR file deployment, it is easier if you always install 
Application Engine as if you intend to deploy an EAR file. This approach works best because it 
always creates both a WAR and an EAR file, meaning you have a ready WAR file for a switch.

Otherwise, if you deploy Application Engine initially as a WAR file and later decide to redeploy 
as an EAR file, you will have to uninstall Application Engine and then reinstall the application, 
selecting EAR file deployment, to add the required files to your setup.

• (Highly Available installations) To install Application Engine in a web farm or clustered 
environment, follow the instructions in theIBM FileNet P8 Platform High Availability Technical 
Notice. The document outlines the required HA install procedure and references this guide for 
detailed installation and deployment instructions. To download this guide from the IBM support 
page, see  “Access IBM FileNet documentation, compatibility matrices, and fix packs” on page 20.

• To ensure proper functionality and performance, only install one instance of Application 
Engine  per application server (or virtual machine or WebSphere LPAR). You can, however, 
deploy multiple instances of a single Application Engine version per application server, see 
“Deploy multiple Application Engine instances” on page 295. 

• Before logging on to Workplace for the first time, at least one object store must exist on the 
Content Engine to hold the site preferences. See “Create the initial object store” on page 133 for 
more information.

• If you run the installer to upgrade Application Engine, the installer verifies that the currently 
installed version of Application Engine can be upgraded. See “Prepare for Application Engine 
upgrade” on page 544 for more information. 
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To install the Application Engine software

1. Log on to the application server:

UNIX

Log on as a user with read, write, and execute access to the directory where you plan to install 
Application Engine. 

Windows

Log on as a member of the local Administrators group or a user with equivalent permissions.

NOTE  Although the installing user must have write access to the /bin directory, the 
Application Engine installer does not write to that directory.

2. Start the installation process. 

• To install Application Engine interactively:

i. Access the IBM FileNet Application Engine 4.0.2 installation software. 

ii. Launch the appropriate Setup program (P8AE-4.0.2.0-operating_system.bin/
.exe) and continue with Step 3 on page 561 below.

• To install Application Engine silently:

i. Access the IBM FileNet Application Engine 4.0.2 installation software package, and copy 
the AE_silent_input.txt file to a local directory.

ii. Follow the instructions in the silent input file to edit the file to reflect the appropriate 
responses for your installation. 

CAUTION  If you are modifying the silent input file to perform an upgrade from AE 3.5.x 
to AE 4.0.2 you must modify all instances of AE_install_path in the script as follows:

UNIX

Change ../FileNet/AE to ../FileNet

Windows

Change ..\FileNet\AE to ..\FileNet

Change ..\\Filenet\\AE to ..\\Filenet

iii. From a command prompt, navigate to, and execute the installer, then continue with 
Step 4 “View the app_engine_install_log_4_0_2.txt file located, located in 
AE_install_path/Logs.” on page 561. 

UNIX

./P8AE-4.0.2.0-<operating system>.bin -options <path_to_edited_input_file>/
AE_silent_input.txt -silent 

Windows

P8AE-4.0.2.0-Win.exe -options <path_to_edited_input_file>\AE_silent_input.txt 
-silent
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3. Complete the Application Engine Installer screens. For information on parameter values, see 
“Installation and upgrade worksheet” on page 229 in Plan and Prepare Your Environment for IBM 
FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping     
worksheet file (p8_worksheet.xls), perform the following actions to quickly see only the     
installation properties you must specify for the Application Engine installation program:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select AE Installer.

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify: Setup Type contains "Upgrade."

• Click the AutoFilter drop-down arrow in all other column headers and select (All).

In addition to the prompts for system-specific information, you will need to consider the 
following decisions:

• You can choose to deploy Application as a WAR file or an EAR file. If you decide to deploy 
Application Engine as a WAR file and later decide to redeploy as an EAR file you must uninstall 
Application Engine and then reinstall the application, selecting EAR file deployment. For 
information, see “Switching from WAR file to EAR file deployment.” on page 559.

– Additional installation notes:

– To change the Content Engine name later, or to connect to a different Content Engine, 
edit the WcmApiConfig.properties file. For information, see the IBM FileNet P8 help 
topic  FileNet P8 Administration > Application Engine Administration > Key configuration files 
and logs.

– For information on how to reconfigure the Documentation URL after installation is 
completed, see the IBM FileNet P8 help topic  FileNet P8 Administration > Application 
Engine Administration > Key configuration files and logs >  Bootstrap properties.

– The UTCryptoKeyFile.properties file contains the user token cryptography key 
used by IBM FileNet P8 applications to launch into each other without the need for 
additional login. 

CAUTION For multiple applications to pass user tokens to each other, each 
participating application must use the same encryption key file. Copy the 
UTCryptoKeyFile.properties file installed with Application Engine to all servers 
that are hosting a token-sharing application.

For information, see the IBM FileNet P8 Developer Help topic Developer Help > 
Workplace Integration and Customization Introduction > User Tokens > Configuring 
Applications to Use Tokens.

4. View the app_engine_install_log_4_0_2.txt file located, located in AE_install_path/
Logs.

Verify that no errors or failures were logged. Correct any errors before you proceed.
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5. (Optional; UNIX only) Set the the P8TASKMAN_HOME system environment variable.

The Process Engine Client installer will set this variable for you. If you want to specify a 
different location for the client files, you can do so by setting the P8TASKMAN_HOME system 
variable. The default value set by the PE Client installer is:

P8TASKMAN_HOME=AE_install_path/CommonFiles

6. Continue with “Install Application Engine software updates” on page 563.
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Task 3: Install Application Engine software updates
Install any fix packs and interim fixes required for Application Engine.

To install the Application Engine software updates

1. To download the latest software updates, and to determine which of these updates may be 
required for use with other components and expansion products, contact your support 
representative.

2. Open the readmes for any subsequent fix packs or interim fixes (typically optional) and perform 
the installation procedures provided.

3. Install the latest updates for the Content Engine Client and Process Engine Client files using the 
subsequent tasks.
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Task 4: Install the latest Content Engine Client files on 
Application Engine servers
To install the Content Engine Client files, perform the following steps on all servers where 
Application Engine Server has been upgraded and is to be deployed.

IMPORTANT Your Content Engine Client version must match your Content Engine server version, 
unless otherwise noted in the FileNet P8 Compatibility Matrix. Install the latest 4.5 Content Engine 
Client files as documented in this topic only when you are ready to upgrade Content Engine 
servers to 4.5. 

In a staged upgrade from 4.0, you might run upgraded Application Engine 4.0.2 servers with 
Content Engine 4.0 servers for some period of time. In this case, install the latest 4.0 Content 
Engine Client files. For detailed instructions, see the latest 4.0 version of the IBM FileNet P8 
Installation and Upgrade Guide on the IBM Web site.

To uninstall CE Client 4.0.x instances

Perform the following procedure to identify and uninstall all Content Engine Client version 4.0.x 
files on an Application Engine Server machine. Repeat the procedure for all other Application 
Engine Server machines.

Depending on the CE Client fixpack versions that you have installed, you may have more than one 
instance of the CE Client 4.0.x installed. Additionally, the version 4.0.x CE Client installer supported 
installing multiple instance of the CE Client on the same server. You need to uninstall all instances 
before upgrading to the 4.5 version of CE Client.

• Locate and uninstall all instances of the CE Client on the Application Engine server.

Windows

a. Select Start > Settings > Control Panel > Add/Remove Programs.

b. Select Content Engine Client Updater or IBM FileNet Content Engine Client Installer, 
depending on the fixpack version of Content Engine Client that is installed. 

Prior to fix pack P8CE-4.0.1-006: The Content Engine Client is named Content 
Engine Client Updater.

As of  fix pack P8CE-4.0.1-006: The Content Engine Client is named IBM FileNet 
Content Engine Client Installer.

c. Click Change/Remove to start the uninstaller.

d. In the Uninstall IBM FileNet Client Installer screen, click Next.

e. In the Select Components screen, select Complete Uninstall. Click Next.

f. In the Uninstall Complete screen, click Done.

g. Repeat Step b through Step f for each additional instance of Content Engine Client Updater 
or IBM FileNet Content Engine Client Installer listed in Add/Remove Programs.
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UNIX

a. Run one of the following commands, depending on the fixpack version of Content Engine 
Client that is installed.

/ce_client_install_path/ClientUpdater/_uninst/uninstaller.bin 

/ce_client_install_path/CEClient/_CEClientuninst/uninstaller 

Prior to  fix pack P8CE-4.0.1-006: The Content Engine Client files are in a 
directory called ClientUpdater, and the uninstallation program is .../
ClientUpdater/_uninst/uninstaller.bin.

As of  fix pack P8CE-4.0.1-006: The Content Engine Client files are in a 
directory called CEClient and the uninstallation program is .../CEClient/
_CEClientuninst/uninstaller.

b. In the Uninstall IBM FileNet Client Installer screen, click Next.

c. In the Select Components screen, select Complete Uninstall. Click Next.

d. In the Uninstall Complete screen, click Done.

e. Repeat Step a through Step d for each installed instance of CE Client on this server.

To install the 4.5 release or fix pack version Content Engine Client files, perform the following 
procedures on all Application Engine servers. Most steps apply to both new installations and 
updates. However, some noted steps apply only to updates of the Content Engine Client files to a 
previously configured Application Engine installation. Except where noted, these steps apply to 
WebSphere, WebLogic, and JBoss.

To install the Content Engine Client files

Refer to the appropriate information from your installation worksheet while performing the 
following steps. For information about the Content Engine parameter values, see “Installation and 
upgrade worksheet” on page 229 in Plan and Prepare Your Environment for IBM FileNet P8.

HINT Verify that the Data > Filter > AutoFilter command is enabled, as it is by default in the 
shipping worksheet file (p8_worksheet.xls). Do the following steps to quickly see only the 
installation properties you must specify for the Content Engine installation program:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select CE Client installer.

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify: Setup Type contains "Installation."

• Click the AutoFilter drop-down arrow in all other column headers and select (All).

1. To download the latest software updates, and to determine which of these updates might be 
required for use with other components and expansion products, contact your service 
representative.

2. Log on to the server where Application Engine is installed as any user who has the following 
permissions:
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• Read and write permission to a temporary directory, such as temp (Windows) or tmp (UNIX), on 
the machine where Application Engine is installed

• Execute permission on the Content Engine Client install software

3. (For update installations only) Verify that there is a current backup of the Application Engine. 

4. Copy the Content Engine Client install software from the Content Engine installation software to 
the temporary directory. The version of the install software must match the version of Content 
Engine.

5. Expand the (TAR or ZIP) Content Engine Client install software within the temporary directory.

6. (For update installations only) Close all instances of Workplace and any other Application 
Engine client applications. From the application server administrative console, stop and 
undeploy Application Engine.

WebSphere

Stop and undeploy the FileNet Application Engine application.

WebLogic

Stop and undeploy the FileNet Application Engine application.

JBoss

Execute the shutdown command.

7. (WebLogic only) Manually delete the following application server cache directories, substituting 
your domain name in place of mydomain:

WebLogic UNIX

/opt/bea/user_projects/domains/mydomain/servers/AdminServer/tmp/_WL_user/
app_engine

/opt/ bea/user_projects/domains/mydomain/servers/.wlnotdelete

/opt/bea/user_projects/domains/mydomain/servers/AdminServer/cache/
EJBCompilerCache

WebLogic Windows

C:\bea\user_projects\domains\mydomain\servers\AdminServer\tmp\_WL_user\app_
engine

C:\bea\user_projects\domains\mydomain\servers\.wlnotdelete

C:\bea\user_projects\domains\mydomain\servers\AdminServer\cache\EJBCompiler
Cache

8. Start the Content Engine Client install process.

• To install the Content Engine Client interactively:

i. Navigate to the IBM FileNet Content Engine Client software in the temporary directory.
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ii. Run one of the commands in the following table, where CE_version is the version of 
Content Engine you intend to run, for example, 4.5.0.

iii. Complete the installation program wizard, using the following table. 

Operating System Install Program

AIX P8CE-CLIENT-CE_version-AIX.BIN

HPUX P8CE-CLIENT-CE_version-HPUX.BIN

HPUXi P8CE-CLIENT-CE_version-HPUXI.BIN

Linux P8CE-CLIENT-CE_version-LINUX.BIN

Solaris P8CE-CLIENT-CE_version-SOL.BIN

Windows P8CE-CLIENT-CE_version-WIN.EXE

zLinux P8CE-CLIENT-CE_version-ZLINUX.BIN

In this screen... Perform this action...

Welcome Click Next to proceed with the Content Engine Client 
installation.

NOTE Click Back at any time while running the Content Engine 
Client installer to change any previous entries. Click Cancel to 
exit the Content Engine Client installer.

Specify Content 
Engine Client 
Installation Path

Specify the complete path where you want the Content Engine 
Client program files installed. The defaults are as follows:

UNIX

/opt/FileNet/CEClient

Windows

C:\Program Files\FileNet\CEClient

Click Next to continue.

Select FileNet P8 
Applications

Select Application Engine, and click Next to continue.

Application 
Engine 
Installation Path

Enter the full path to the Application Engine installation 
location. The defaults are as follows:

UNIX

/opt/FileNet/AE

Windows

C:\Program Files\FileNet\AE

Click Next to continue.
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Content Engine 
Application 
Server

Select the Content Engine application server type from the list. 
Valid choices are: 

• WebSphere

• WebLogic

• JBoss

Click Next to continue.

Specify URLS for 
EJB Transport

Specify the URLS for the Content Engine Enterprise JavaBeans 
(EJB) API.

• Content Engine Client Software URL

The URL for the Content Engine Web Services client API. 
This URL contains the WcmApiConfig.properties file. 
Applications require this file to communicate with Content 
Engine Server through the EJB method or the Web Services 
transport method.

The default is: cemp:iiop//CEServer:2809/FileNet/Engine

• Content Engine upload URL

The upload URL is used for internal processes during EJB 
transport activities.

The default is: cemp:iiop//CEServer:2809/FileNet/Engine

• Content Engine download URL

The download URL is used for internal processes during 
EJB transport activities.

The default is: cemp:iiop//CEServer:2809/FileNet/Engine

Click Next to continue.

In this screen... Perform this action...
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• To install the Content Engine Client files silently:

i. Make a backup copy of the CEClient_silent_install.txt input file, located in the 
software directory.

ii. Open CEClient_silent_install.txt in a text editor. Follow the instructions in the 
silent input file to edit the entries to reflect the appropriate responses for your install or 
update.

Specify URL for 
WSI Transport

The URL for the Content Engine Web Services client API. 
The API contains the WcmApiConfig.properties file. 
Applications require this file to communicate with Content 
Engine Server, either with the EJB method or the Web 
Services transport method.

The default is: 
cemp:http://CEServer:9080/wsi/FNCEWS40DIME/

Click Next to continue.

Create 
Deployment File

Specify whether the installer creates the deployment file for 
your application. If you have additional configuration to perform, 
you can create the deployment file manually later on. Select 
one of the following choices:

• Have the installer create the file.

• Create the file later.

Click Next to continue.

Review Pre-
Installation 
Summary 

Verify your component selections, and click Install to start 
installing Content Engine Client.

In this screen... Perform this action...
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 4: Install the latest Content Engine Client files on Application Engine servers
To install the Content Engine Client files

570
iii. Navigate to the path containing the Content Engine Client installation program. From 
that directory, run one of the commands in the following table to perform the silent 
install, where:

CE_version is the version of Content Engine you intend to run, for example, 4.5.0.

 path is the path that contains the installation program.

9. Install Process Engine client updates on the Application Engine. Continue at “Install the Latest 
Process Engine Client files on Application Engine servers” on page 571.

NOTE  If you performed this CE Client install task during a staged upgrade of Content Engine, and 
have previously upgraded Application Engine to 4.0.2, your next step is to re-deploy the 
Workplace application. See one of the following topics:

• “Deploy upgraded Application Engine instances (WebSphere)” on page 595

• “Deploy upgraded Application Engine instances (WebLogic)” on page 598

• “Deploy upgraded Application Engine instances (JBoss)” on page 600

Operating 
System

Install Program

AIX P8CE-CLIENT-CE_version-AIX.BIN -f path/CECLIENT.AIX/ 
CEClient_silent_install.txt -i silent

HPUX P8CE-CLIENT-CE_version-HPUX.BIN -f path/CEClient.HPUX/ 
CEClient_silent_install.txt -i silent

HPUXi P8CE-CLIENT-CE_version-HPUXI.BIN -f path/CEClient.HPUXI/
CEClient_silent_install.txt -i silent

Linux P8CE-CLIENT-CE_version-LINUX.BIN -f path/CEClient.Linux/
CEClient_silent_install.txt -i silent

Solaris P8CE-CLIENT-CE_version-SOL.BIN -f path/CEClient.Solaris/
CEClient_silent_install.txt -i silent

Windows P8CE-CLIENT-CE_version-WIN.EXE -f path\CEClient.Windows\ 
CEClient_silent_install.txt -i silent

zLinux P8CE-CLIENT-CE_version-ZLINUX.BIN -f path/CEClient.zLinux/
CEClient_silent_install.txt -i silent
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Task 5: Install the Latest Process Engine Client files on 
Application Engine servers
IMPORTANT Your Process Engine Client version must match your Process Engine server version, 
unless otherwise noted in the FileNet P8 Compatibility Matrix. Install the latest 4.5 Process 
Engine Client files as documented in this topic only when you are ready to upgrade Process 
Engine servers to 4.5. 

In a staged upgrade from 4.0, you might run upgraded Application Engine 4.0.2 servers with 
Process Engine 4.0 servers for some period of time. In this case, install the latest 4.0 Process 
Engine Client files. For detailed instructions, see the latest 4.0 version of the IBM FileNet P8 
Installation and Upgrade Guide on the IBM Web site.

To install the Process Engine Client files, perform the following steps on all Application Engine 
servers.

For both interactive and silent installs, refer to the appropriate information from your installation 
worksheet while performing the following steps. For information on the Process Engine parameter 
values, see “Installation and upgrade worksheet” on page 229 in Plan and Prepare Your Environment 
for IBM FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping 
worksheet file (p8_worksheet.xls), perform the following steps to quickly see only the 
installation properties you must specify for the Process Engine client installation program:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select PE Client installer.

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify: Setup Type contains "Installation."

• Click the AutoFilter drop-down arrow in all other column headers and select (All).

To install the Process Engine client files

1. On the machine where Application Engine is to be deployed, log on as any user who has the 
following permissions:

• Read and write permission to a temporary directory, such as temp (Windows) or tmp (UNIX), on 
the machine where Application Engine is installed

•  Execute permission on the Process Engine Client install software

2. Copy the Process Engine Client install software from the Process Engine installation software to 
the temporary directory. The version of the install software must match the version of Process 
Engine. 

3. Expand the (TAR or ZIP) Process Engine Client install software within the temporary directory. 
The jre.tar file that is packaged with the Process Engine Client installer must be in the same 
directory as the Process Engine Client installer when the installer is run.
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4. The expanded install software contains the Process Engine Client install program specific to the 
operating system on the machine where Application Engine is deployed. Run the program either 
interactively (using the install wizard) or silently.

To run the program interactively, run one of the commands in the table below, follow the wizard 
instructions, and then continue at step 5:  

5. Complete the Process Engine client installer screens, as follows:

Operating System Install Program

AIX P8PE-CLIENT-4.5.0-AIX.BIN

HPUX P8PE-CLIENT-4.5.0-HPUX.BIN

HPUXi P8PE-CLIENT-4.5.0-HPUXI.BIN

Linux P8PE-CLIENT-4.5.0-LINUX.BIN

Solaris P8PE-CLIENT-4.5.0-SOL.BIN

Windows P8PE-CLIENT-4.5.0-WIN.EXE

zLinux P8PE-CLIENT-4.5.0-ZLINUX.BIN

In this screen... Perform this action...

Welcome to Process 
Engine Client Installer

Click Next to proceed with the installation.

NOTE Click Previous at any time to make changes in previous 
screens. Click Cancel to exit the program.

Specify Installation 
Location

Choose the destination directory for Process Engine Client log 
files and uninstallation files. Accept the default location or click 
Browse to change the location.  

Select FileNet P8 
Applications

Select Application Engine as the product for which you would 
like to install Process Engine Client files.

Click Next to continue.

Application Engine 
Installation Path

Enter the full path to the Application Engine installation 
location. The defaults are as follows:

UNIX

/opt/FileNet/AE

Windows

C:\Program Files\FileNet\AE

Click Next to continue.
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To run the program silently, perform the following steps:

a. In the expanded install software, open the file PEClient_silent_install.txt and edit it 
as follows:

i. Change the Variable_CheckboxAE line to the following:

-V Variable_CheckboxAE="true"

ii. Run one of the commands in the following table to perform the silent install:

Specify the URL for the 
Component Manager

Enter the URL that the Component Manager uses to connect to 
the Content Engine using Web Services transport. The default 
is:

http://CEServer:port/wsi/FNCEWS40DIME/

Specify the 
Documentation URL

Enter the URL where the IBM FileNet P8 Platform 
Documentation is installed. Use the following format:

http://docserver:port#/ecm_help

where: 

docserver is the name of the Java web server.
port# is the port number.
ecm_help is the root folder of the documentation web site. You 
can use multi-part root folders, for example, /docs/ecm_help, 
if your application server supports them.

Specify when to create 
the deployment file

Indicate whether to create the WAR or EAR deployment file now 
or later. If you have additional configuration to perform, you can 
create the deployment file manually later. 

Stop running BPM 
software

If the installer detects running BPM software components, click 
Next to stop the software and continue with the installation.

Review Pre-Installation 
Summary 

Verify your component selections, and click Install to start 
installing Process Engine Client.

Operating 
System

Install Program

AIX P8PE-CLIENT-4.5.0-AIX.BIN -silent -options 
"PEClient_silent_install.txt" 

HPUX P8PE-CLIENT-4.5.0-HPUX.BIN -silent -options 
"PEClient_silent_install.txt" 

HPUXi P8PE-CLIENT-4.5.0-HPUXI.BIN -silent -options 
"PEClient_silent_install.txt"

Linux P8PE-CLIENT-4.5.0-LINUX.BIN -silent -options 
"PEClient_silent_install.txt" 

In this screen... Perform this action...
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6. (For Process Engine upgrades from PE 4.0.x to 4.5 only) Add required JAR files to the 
Component Manager library.

a. Launch the Process Task Manager by running one of the following command files from the 
AE_install_path/FileNet/AE/Router directory, depending on your operating system:

UNIX

routercmd.sh

Windows

routercmd.bat

b. In the Process Task Manager console, under Application Engine, Component Manager 
node, select your connection point.

c. Stop the connection point instance.

d. Click the Required libraries tab.

e. Click Add, and browse to /Router/lib.

f. Select the following files to add:

ContentExtendedOps.jar

smtp.jar

Solaris P8PE-CLIENT-4.5.0-SOL.BIN -silent -options 
"PEClient_silent_install.txt" 

Windows P8PE-CLIENT-4.5.0-WIN.EXE -silent -options 
"PEClient_silent_install.txt" 

zLinux P8PE-CLIENT-4.5.0-ZLINUX.BIN -silent -options 
"PEClient_silent_install.txt" 

Operating 
System

Install Program
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7. (For upgrades from 3.5.x only) Configure Application Engine. 

Follow the instructions for your application server to configure Application Engine:

• “Configure Application Engine upgrades from 3.5.x (WebSphere)” on page 576

• “Configure Application Engine upgrades from 3.5.x (WebLogic)” on page 585

• “Configure Application Engine upgrades from 3.5.x (JBoss)” on page 591

8. (For upgrades from 4.0.x only) Continue with “Manually copy custom data” on page 594.

NOTE  If you performed this PE Client install task during a staged upgrade of Process Engine, and 
have previously upgraded Application Engine to 4.0.2, your next step is to re-deploy the 
Workplace application. See one of the following topics:

• “Deploy upgraded Application Engine instances (WebSphere)” on page 595

• “Deploy upgraded Application Engine instances (WebLogic)” on page 598

• “Deploy upgraded Application Engine instances (JBoss)” on page 600
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Task 6a: Configure Application Engine upgrades from 
3.5.x (WebSphere)
To use the Application Engine web application (Workplace), you must first configure the 
application to work with your application server. Use the following procedures to configure 
Workplace. Not all procedures apply to all installations. Do the procedures that apply to your 
installation in the order presented here.

To edit web.xml for container-managed authentication or SSO

NOTE  Perform this procedure only if your site uses WebSphere with container-managed 
authentication or Single Sign-On (SSO). If you are using SSO, you must perform additional 
configuration steps as directed at the end of this procedure. 

1. Make a back-up copy of web.xml.

AE_install_path/Workplace/WEB-INF/web.xml

2. Edit web.xml.

NOTE  Text in bold in the following examples indicates changes made to the original web.xml 
file.

a. Search for the parameter challengeProxyEnabled and set it to false.

  <param-name>challengeProxyEnabled</param-name> 
  <param-value>false</param-value> 

b. Search for the first instance of <web-resource-collection>, and uncomment the url-pattern 
as noted in the file comments. 

<web-resource-collection>
<web-resource-name>action</web-resource-name>
<description>Define the container secured resource</description>
<url-pattern>/containerSecured/*</url-pattern>

      <!--

           Uncomment this section if all resources that require credentials 
must be secured in order to obtain a secured Thread.  If using WebSphere, 
this section must be
           uncommented.
--> Move this commenting tag here from just before the </web-resource- 
collection> closing tag below.

<url-pattern>/containerSecured/*</url-pattern>
<url-pattern>/</url-pattern>
<url-pattern>/author/*</url-pattern>
<url-pattern>/Browse.jsp</url-pattern>
<url-pattern>/eprocess/*</url-pattern>
<url-pattern>/Favorites.jsp</url-pattern>
<url-pattern>/GetPortalSitePreferences.jsp</url-pattern>
<url-pattern>/GetTokenSignIn.jsp</url-pattern>
<url-pattern>/GetUserInformation.jsp</url-pattern>
<url-pattern>/GetUserToken.jsp</url-pattern>
<url-pattern>/HomePage.jsp</url-pattern>
<url-pattern>/IntegrationWebBasedHelp.jsp</url-pattern>
<url-pattern>/is/*</url-pattern>
<url-pattern>/operations/*</url-pattern>
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<url-pattern>/portlets/Author/edit.jsp</url-pattern>
<url-pattern>/portlets/Author/portlet.jsp</url-pattern>
<url-pattern>/portlets/Browse/edit.jsp</url-pattern>
<url-pattern>/portlets/Browse/portlet.jsp</url-pattern>
<url-pattern>/portlets/ExternalUrl/edit.jsp</url-pattern>
<url-pattern>/portlets/ExternalUrl/portlet.jsp</url-pattern>
<url-pattern>/portlets/GroupPageDesign.jsp</url-pattern>
<url-pattern>/portlets/GroupPageSettings.jsp</url-pattern>
<url-pattern>/portlets/Inbox/edit.jsp</url-pattern>
<url-pattern>/portlets/Inbox/portlet.jsp</url-pattern>
<url-pattern>/portlets/MultiPagesDesign.jsp</url-pattern>
<url-pattern>/portlets/OrganizePages.jsp</url-pattern>
<url-pattern>/portlets/PortalPageDesign.jsp</url-pattern>
<url-pattern>/portlets/PortalPageInfo.jsp</url-pattern>
<url-pattern>/portlets/PortletAlias.jsp</url-pattern>
<url-pattern>/portlets/PortletSettings.jsp</url-pattern>
<url-pattern>/portlets/PreviewAndSetup.jsp</url-pattern>
<url-pattern>/portlets/PublicQueue/edit.jsp</url-pattern>
<url-pattern>/portlets/PublicQueue/portlet.jsp</url-pattern>
<url-pattern>/portlets/QuickSearch/edit.jsp</url-pattern>
<url-pattern>/portlets/QuickSearch/portlet.jsp</url-pattern>
<url-pattern>/portlets/Workflows/edit.jsp</url-pattern>
<url-pattern>/portlets/Workflows/portlet.jsp</url-pattern>
<url-pattern>/properties/*</url-pattern>
<url-pattern>/redirect/*</url-pattern>
<url-pattern>/regions/*</url-pattern>
<url-pattern>/Search.jsp</url-pattern>
<url-pattern>/select/*</url-pattern>
<url-pattern>/SelectReturn.jsp</url-pattern>
<url-pattern>/Tasks.jsp</url-pattern>
<url-pattern>/UI-INF/*</url-pattern>
<url-pattern>/utils/*</url-pattern>
<url-pattern>/WcmAdmin.jsp</url-pattern>
<url-pattern>/WcmAuthor.jsp</url-pattern>
<url-pattern>/WcmBootstrap.jsp</url-pattern>
<url-pattern>/WcmCloseWindow.jsp</url-pattern>
<url-pattern>/WcmDefault.jsp</url-pattern>
<url-pattern>/WcmError.jsp</url-pattern>
<url-pattern>/WcmJavaViewer.jsp</url-pattern>
<url-pattern>/WcmObjectBookmark.jsp</url-pattern>
<url-pattern>/WcmPortletHelp.jsp</url-pattern>
<url-pattern>/WcmPortletSearch.jsp</url-pattern>
<url-pattern>/WcmQueueBookmark.jsp</url-pattern>
<url-pattern>/WcmSignIn.jsp</url-pattern>
<url-pattern>/WcmSitePreferences.jsp</url-pattern>
<url-pattern>/WcmUserPreferences.jsp</url-pattern>
<url-pattern>/WcmWorkflowsBookmark.jsp</url-pattern>
<url-pattern>/wizards/*</url-pattern>
<url-pattern>/Author/*</url-pattern>
<url-pattern>/axis/*.jws</url-pattern>
<url-pattern>/Browse/*</url-pattern>
<url-pattern>/ceTunnel</url-pattern>
<url-pattern>/CheckoutList/*</url-pattern>
<url-pattern>/downloadMultiTransferElement/*</url-pattern>
<url-pattern>/ExternalUrl/*</url-pattern>
<url-pattern>/findRecordTarget</url-pattern>
<url-pattern>/formCallback/*</url-pattern>
<url-pattern>/getAnnotSecurity/*</url-pattern>
<url-pattern>/getCEAnnotations/*</url-pattern>
<url-pattern>/getContent/*</url-pattern>
<url-pattern>/getForm/*</url-pattern>
<url-pattern>/getISAnnotations/*</url-pattern>
<url-pattern>/getISAnnotSecurity/*</url-pattern>
<url-pattern>/getISContent/*</url-pattern>
<url-pattern>/getMultiContent/*</url-pattern>
<url-pattern>/getPreview</url-pattern>
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<url-pattern>/getProcessor/*</url-pattern>
<url-pattern>/getRealms/*</url-pattern>
<url-pattern>/getUsersGroups/*</url-pattern>
<url-pattern>/Inbox/*</url-pattern>
<url-pattern>/integrationCommandProxy</url-pattern>
<url-pattern>/integrationResponse</url-pattern>
<url-pattern>/integrationResponseProxy</url-pattern>
<url-pattern>/integrationWebBasedCommand</url-pattern>
<url-pattern>/keepAlive</url-pattern>
<url-pattern>/launch/*</url-pattern>
<url-pattern>/PublicQueue/*</url-pattern>
<url-pattern>/putContent/*</url-pattern>
<url-pattern>/QuickSearch/*</url-pattern>
<url-pattern>/signingServlet/*</url-pattern>
<url-pattern>/transport/*</url-pattern>
<url-pattern>/upload/*</url-pattern>
<url-pattern>/vwsimsoapservlet</url-pattern>
<url-pattern>/vwsoaprouter</url-pattern>
<url-pattern>/Workflows/*</url-pattern>   Move the closing comment tag from 
here to the location indicated at the beginning of this example. 

</web-resource-collection>

c. Locate the section <auth-constraint>, comment the wildcard (*) role-name as noted in the 
file comments.

<auth-constraint>
<!-- <role-name>*</role-name> -->
<!-- For WebSphere 6, use the role-name line below instead of the wildcard role 
above.-->

<role-name>All Authenticated</role-name>

<!-- For WebSphere 6, add this security-role element below the login-config 
element (below).
   <security-role>

   <description>All Authenticated</description>
   <role-name>All Authenticated</role-name>

   </security-role>
                -->

</auth-constraint>

                
d. Locate the end of the </login-config> element, and add the All Authenticated users role-

element after the closing tag.

<security-role>
<description>All Authenticated</description>
<role-name>All Authenticated</role-name>

</security-role>

e. Search for the first instance of a <security-constraint> tag, and add the following <security-
constraint> tag before that tag.

IMPORTANT  Enter the following information as single lines without line breaks.  

<security-constraint>
<web-resource-collection>

<web-resource-name>action</web-resource-name>
<description>Define the non-secured resource</description>
<url-pattern>/P8BPMWSBroker/*</url-pattern>

</web-resource-collection>
</security-constraint>

3. Save your changes to web.xml and close the file.
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4. If your site uses SSO, continue on with “(SSO Only) To edit web.xml for SSO (optional)” on 
page 579. Otherwise continue with “To configure Application Engine (WebSphere)” on page 580.

(SSO Only) To edit web.xml for SSO (optional)

NOTE  Perform this procedure only if your site uses SSO with a proxy server. You must use this 
procedure to modify web.xml to enable SSO. 

1. Open web.xml for editing.

2. At the end of web.xml, comment out the <login-config> element, as follows:

<!--
<login-config>

<auth-method>FORM</auth-method>
<realm-name>AE Workplace</realm-name>
<form-login-config>

<form-login-page>/ContainerLogin.jsp</form-login-page>
<form-error-page>/ContainerError.jsp</form-error-page>

</form-login-config>
</login-config>
-->

3. As needed, set the ssoProxyContextPath, ssoProxyHost, ssoProxyPort, and ssoProxySSLPort. 

These parameter values are used to modify one or more elements of the native URL that 
Workplace sees on a request. Wherever the value of an SSO proxy host element in the URL 
request is different from the equivalent information for the host where Workplace is deployed,  
you must set the corresponding sso<proxy host element> parameter for that element in the 
URL to the value for the SSO proxy host. 

The default settings are (in bold):

<init-param>
<param-name>ssoProxyContextPath</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxyHost</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxyPort</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxySSLPort</param-name>
<param-value></param-value>

</init-param>

In general, the init parameters must be configured as follows:

• ssoProxyContextPath: Set the value to the context path of the SSO proxy host URL. This path is 
the path portion of the URL that appears after the server name. The path represents top-level 
access to the Workplace application. 

For example, if the Workplace deployment host URL is 
http://deploy_server:2809/Workplace and the SSO proxy host URL is 
http://sso_proxy_server.domain.com/fn/Workplace, then use the following values:
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<param-name>ssoProxyContextPath</param-name>
<param-value>/fn/Workplace</param-value>

• ssoProxyHost: Set the value to the SSO proxy host server name. Typically, this value is a full 
domain-qualified host name. 

For example, if the host URL where Workplace is deployed is 
http://deploy_server/Workplace and the corresponding SSO proxy host URL is 
http://sso_proxy_server/Workplace, then use the following values:

<param-name>ssoProxyHost</param-name>
<param-value>sso_proxy_server</param-value>

• ssoProxyPort: Set the value to the http port on the SSO proxy host. 

For example:

<param-name>ssoProxyPort</param-name>
<param-value>80</param-value>

• ssoProxySSLPort: Set the value to the https port on the SSO proxy host, if defined or used to 
access Workplace pages. 

For example:

<param-name>ssoProxySSLPort</param-name>
<param-value>443</param-value>

4. Save your changes to web.xml and close the file.

To configure Application Engine (WebSphere) 

1. In the administrative console, set JVM settings for JAAS login configuration and memory 
settings.

a. Navigate to Servers > Application Servers > server_name > Java & Process Management > 
Process Definition > Java Virtual Machine. 

In the Java Virtual Machine settings, set the JAAS login entry in the Generic JVM 
argument field to the following (do not enter the line breaks):

-Djava.security.auth.login.config=AE_install_path\CE_API\config
\jaas.conf.WebSphere

where AE_install_path is your installation path. Your path might be slightly different 
depending on the version of your client installations, or whether you have chosen a custom 
path for installation. Verify the location of the file and specify the install path location 
before you enter the path.

IMPORTANT  (Windows only) The path cannot contain a space. You must use 8.3-notation 
for the install path portion of the full JAAS login entry.

If your AE_install_path is:

C:\Program Files\FileNet\AE

use: 

C:\Progra~1\FileNet\AE
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IMPORTANT  Do not copy and paste the text from this guide into the field in the console 
because hidden formatting can cause problems with the entry. Use a paste special option 
in a text editor to remove formatting first, or type the entry into the field.

b. Set the Initial and Maximum Heap Size.

Refer to your application server vendor recommendation for Initial and Maximum heap size 
values. For IBM-specific recommendations, see the IBM FileNet P8 Platform Performance 
Tuning Guide. To download this guide from the IBM support page, see “Access IBM FileNet 
documentation, compatibility matrices, and fix packs” on page 20.

c. Save your changes.

2. (For installations with Content Engine and Application Engine collocated on the WebSphere 
server, but in different WebSphere profiles) Create an additional JVM property for different 
WebSphere profiles.

Perform the following steps on both the Content Engine profile and the Application Engine 
profile:

a. In the Java Virtual Machine settings, click Custom Properties > New. 

b. In the Name field, enter the following name:

com.ibm.websphere.orb.uniqueServerName

c. Set the Value to true.

d. Save your changes.

3. Verify that Application Integration installation is enabled.

a. In the Environment area, in Virtual Hosts, navigate to default_host (or the host your 
application is deployed under).

b. Click MIME Types.

c. Verify that MIME type is set to application/octet-stream or use the following steps to set it.

i. Click New.

ii. In the MIME Type field, enter application/octet-stream.

iii. In the Extension(s) field, enter exe. Click OK.

iv. Click Apply, click Save.

d. Save your changes.

4. Configure Lightweight Third Party Authentication (LTPA).

NOTE  Skip this step if your Application Engine and Content Engine are located on the same 
application server.

a. On the Content Engine application server, do the following:

NOTE  If you are already using LTPA with your Content Engine application server, you only 
need to copy the key file to the Application Engine server. Skip to Step xii.
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i. Log in to the administrative console.

ii. Navigate to Security > Secure administration, applications, and infrastructure.

iii. From the right side of the panel, select Authentication Mechanisms and expiration.

iv. Enter a value for the timeout that is larger than the default. 

For example, if the timeout value is set to 120 minutes, the LTPA key expires. Users 
will not be able to log in to Workplace after having been logged in for 2 hours.

v. Save your changes.

vi. In the box titled "Cross-cell single sign-on,” enter a password to create the LTPA 
password.

NOTE  For password restrictions, see the WebSphere documentation. If you have 
already configured Content Engine for LTPA, use the existing password for the 
Application Engine steps.

vii. Enter a path for the Key File Name. For example, /opt/LTPA/ltpa_key_name.

viii. Click Export Keys. Verify that the following message is displayed: The keys were 
successfully exported to the file ltpa_key_name.

ix. Click Import Keys.

x. Click OK, and then click Save changes to the Master Configuration.

xi. Stop and restart WebSphere.

xii. Copy the key file from Content Engine server location you specified to a directory on 
the Application Engine server. For example, /opt/LTPA/ltpa_key_name.

b. On the Application Engine server WebSphere administrative console, do the following steps:

i. Navigate to Security > Secure administration, applications, and infrastructure.

ii. From the right side of the panel, select Authentication Mechanisms and expiration.

iii. Enter a value for the timeout that is larger than the default. 

For example, if the timeout value is set to 120 minutes, the LTPA key expires. Users 
will not be able to log in to Workplace after having been logged in for 2 hours. Save 
your changes.

iv. In the box titled cross-cell single sign-on, enter the LTPA password you created for 
Content Engine. Confirm the password.

v. Specify the path for the key file that you copied to the Application Engine server. For 
example, /opt/LTPA/ltpa_key_name.

vi. Click Import Keys. Verify that the following message is displayed: The keys were 
successfully imported from the file ltpa_key_name.

vii. Save your changes.

5. Configure Lightweight Directory Access Protocol (LDAP).
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NOTE  Skip this step if your Application Engine and Content Engine are located on the same 
application server.

a. Navigate to Security > Secure administration, applications, and infrastructure.

b. Disable security using the following Security settings:

– Turn off (clear) Enable Administrative Security flag.

– Turn off (clear) Enable application security flag.

– Turn off (clear) Java 2 Security.

c. From the Active Authentication Mechanism drop down list, select LTPA (Light weight Third 
Party Authentication).

d. From the bottom of the panel, in the box titled "available realm definitions," select 
Standalone LDAP registry and click Configure.

e. Configure the LDAP provider to exactly match the corresponding settings on the Content 
Engine application server.

– Primary administrative user name

– Select “Automatically generated server identity."

– Type

– Host

– Port

– Base distinguished name (DN)

– Bind distinguished name (DN)

– Bind password

f. Configure the Advanced Lightweight Directory Access Protocol (LDAP) user registry 
settings to exactly match the corresponding settings from the Content Engine application 
server. 

– User filter

– Group Filter

– User ID map

– Group member ID map

– Certificate map mode

– Certificate filter

g. Save these settings.

h. Next to "Available realm definitions," make sure "Standalone LDAP registry" is still selected, 
and click Set as current.

i. Re-enable the following Security settings:
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– Turn on (check) Enable Administrative Security flag.

– Turn on (check) Enable application security flag.

– Turn off (clear) Java 2 Security.

NOTE  The IBM FileNet P8 Platform uses LDAP-based security, and does not support Java 
2 security. Enabling Java 2 security can cause unexpected behavior.

j. Save your changes to the master configuration.

k. Test the connection on the Standalone LDAP registry page.  If the test fails, correct the error 
before proceeding.  If it passes, click OK to return to the previous page.

6. If you do not plan to perform the procedure to configure the server ports, stop and restart 
WebSphere before continuing on to deploy Application Engine.

7. Continue with “To configure the server ports” on page 584.

To configure the server ports

This configuration is not required but is recommended.

1. Stop the WebSphere server.

2. Make a backup copy of serverindex.xml located in:

WAS_HOME\profiles\default\config\cells\machine_nameNode01Cell\nodes\
machine_nameNode01\ 

3. Edit the serverindex.xml file for each node. The file has the same endpoints for each node 
on the server, and you need to perform the edit for each node.

Locate the <specialEndpoints> section, and change the port numbers for the three SSL 
listener addresses to “0” as shown here:

<specialEndpoints xmi:id="NamedEndPoint_1155689929072" 
endPointName="SAS_SSL_SERVERAUTH_LISTENER_ADDRESS">
  <endPoint xmi:id="EndPoint_1155689929072" host="host_name" port="0"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint_1155689929073" 
endPointName="CSIV2_SSL_SERVERAUTH_LISTENER_ADDRESS">
  <endPoint xmi:id="EndPoint_1155689929073" host="host_name" port="0"/>
</specialEndpoints>
<specialEndpoints xmi:id="NamedEndPoint_1155689929074" 
endPointName="CSIV2_SSL_MUTUALAUTH_LISTENER_ADDRESS">
  <endPoint xmi:id="EndPoint_1155689929074" host="host_name" port="0"/>
</specialEndpoints>

4. Save and close the serverindex.xml file.

5. Restart WebSphere.

6. Continue with “Manually copy custom data” on page 594.
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Task 6b: Configure Application Engine upgrades from 
3.5.x (WebLogic)
This topic covers the configuration of your Application Engine application (Workplace) on 
WebLogic. Perform the following high-level steps in the order listed, using the referenced detailed 
procedures for each step.

1. If you are using SSO, edit web.xml. See “To edit web.xml for SSO (optional)” on page 585.

2. Modify the application server startup script. See “To modify the application server startup script” on 
page 586.

3. Configure Application Engine. See “To configure Application Engine (WebLogic)” on page 589.

4. Modify config.xml to support passing user credentials to clients such as Application 
Integration and WebDAV. See “To enable passing user credentials to client applications (WebLogic)” 
on page 590.

To edit web.xml for SSO (optional)

NOTE  Perform this procedure only if your site uses SSO with a proxy server. You must modify 
web.xml to enable SSO. 

1. Make a backup copy of web.xml.

AE_install_path/Workplace/WEB-INF/web.xml

2. Edit web.xml.

a. Set the parameter perimeterChallengeMode to true, as in:

<init-param>
<param-name>perimeterChallengeMode</param-name>
<param-value>true</param-value>

</init-param>

b. As needed, set the ssoProxyContextPath, ssoProxyHost, ssoProxyPort, and 
ssoProxySSLPort. 

These parameter values are used to modify one or more elements of the native URL that 
Workplace sees on a request. Wherever the value of an SSO proxy host element in the 
URL request is different from the equivalent information for the host where Workplace is 
deployed, then you must set the corresponding sso* parameter for that element in the URL 
to the value for the SSO proxy host. 

The default settings are (in bold):

<init-param>
<param-name>ssoProxyContextPath</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxyHost</param-name>
<param-value></param-value>

</init-param>
<init-param>

<param-name>ssoProxyPort</param-name>
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<param-value></param-value>
</init-param>
<init-param>

<param-name>ssoProxySSLPort</param-name>
<param-value></param-value>

</init-param>

In general, the init parameters above should be configured as follows:

• ssoProxyContextPath: Set the value to the context path of the SSO proxy host URL. 
This is the path portion of the URL that appears after the server name, and which 
represents top-level access to the Workplace application. 

For example, if the Workplace deploy host URL is  
http://deploy_server:2809/Workplace and the SSO proxy host URL is 
http://sso_proxy_server.domain.com/fn/Workplace, then use the following:

<param-name>ssoProxyContextPath</param-name>
<param-value>/fn/Workplace</param-value>

• ssoProxyHost: Set the value to the SSO proxy host server name. Typically, this will be 
a full domain-qualified hostname. 

For example, if the host URL where Workplace is deployed is  
http://deploy_server/Workplace and the corresponding SSO proxy host URL is 
http://sso_proxy_server/Workplace, then use the following:

<param-name>ssoProxyHost</param-name>
<param-value>sso_proxy_server</param-value>

• ssoProxyPort: Set the value to the http port on the SSO proxy host. 

For example: 

<param-name>ssoProxyPort</param-name>
<param-value>80</param-value>

• ssoProxySSLPort: Set the value to the https port on the SSO proxy host, if defined 
and/or used to access Workplace pages. 

For example:

<param-name>ssoProxySSLPort</param-name>
<param-value>443</param-value>

3. Save your changes to web.xml and close the file.

To modify the application server startup script

1. Stop the WebLogic application server if running.

2. Make a backup copy of the application server startup script.

Back up startWebLogic.cmd for Windows or startWebLogic.sh for UNIX. 

NOTE  If you are not using a WebLogic domain, backup startWLS.cmd for Windows or 
startWLS.sh for UNIX.

a. Edit the MEM_ARGS variable. 
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Adjusting this setting prevents the application server from running out of memory, a 
condition in which users would not be able to log in to Workplace.

NOTE  If the MEM_ARGS variable doesn't exist, add it to the startup script. 

• For all systems except those using JRockit JAVA.

Append the following to the MEM_ARGS variable:

–XX:MaxPermSize=sizem

where size is the value, in MB, of the MaxPermSize. 

Refer to your application server vendor's recommendation for Initial and Maximum 
heap size values. For IBM specific recommendations, see the IBM FileNet P8 Platform 
Performance Tuning Guide. To download this guide from the IBM support page, see 
“Access IBM FileNet documentation, compatibility matrices, and fix packs” on page 20.

• For systems using JRockit JAVA.

Append the following to the MEM_ARGS variable:

–Xgc:gencon

b. If your application server uses the IBM JVM, edit the JAVA_OPTIONS variable (to improve 
performance).

UNIX

Immediately before the following line in startWebLogic.sh:

SAVE_JAVA_OPTIONS=$JAVA_OPTIONS

insert this line (without a carriage return):

JAVA_OPTIONS=”$JAVA_OPTIONS -Dprogram.name=$PROGNAME 
-Dfilenet.pe.peorb.pool.min=2 -Dfilenet.pe.peorb.pool.max=5”

Windows

Immediately before the following line in startWebLogic.cmd:

set SAVE_JAVA_OPTIONS=%JAVA_OPTIONS%

insert this line (no carriage return):

set JAVA_OPTIONS=%JAVA_OPTIONS% -Dprogram.name=%PROGNAME% 
-Dfilenet.pe.peorb.pool.min=2 -Dfilenet.pe.peorb.pool.max=5

c. Configure JAAS login. 

Add one of the following right after the classpath entry for WebLogic. 

CAUTION  Enter the jaas_login entry (bold below) as a single line without line breaks. Do 
not copy and paste the text from this guide because hidden formatting can cause problems 
with the entry. Instead, type the entry into the script. 

NOTE  Your path may be slightly different depending on the version of your client 
installations, or whether you have chosen a custom path for installation. Verify the location 
of the file before you enter the path.
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Windows

@REM Jaas Login configuration setting
set JAAS_LOGIN=%JAAS_LOGIN% -Djava.security.auth.login.config=
”AE_install_path\CE_API\config\jaas.conf.WebLogic”

UNIX

# Jaas Login configuration setting
JAAS_LOGIN=”${JAAS_LOGIN}” -Djava.security.auth.login.config=
”AE_install_path/CE_API/config/jaas.conf.WebLogic”

AIX

# Jaas Login configuration setting
JAAS_LOGIN=”${JAAS_LOGIN}” -Djava.security.auth.login.config=
”AE_install_path/CE_API/config/jaas.conf.WebLogic”
JAAS_LOGIN="${JAAS_LOGIN}” -
Dlogin.configuration.provider=com.ibm.security.auth.login.ConfigFile

d. Add %JAAS_LOGIN% section as indicated in the examples below in bold.

Windows - in the WLS_REDIRECT_LOG settings

If “%WLS_REDIRECT_LOG%”==””(
    echo Starting WLS with line:
    echo %JAVA_HOME%\bin\java %JAVA_VM% %MEM_ARGS% %JAVA_OPTIONS% %JAAS_LOGIN%  
-Dweblogic.Name=%SERVER_NAME% -
Djava.security.policy=%WL_HOME%\server\lib\weblogic.policy %PROXY_SETTINGS% 
%SERVER_CLASS%
    %JAVA_HOME%\bin\java %JAVA_VM% %MEM_ARGS% %JAVA_OPTIONS% %JAAS_LOGIN% -
Dweblogic.Name=%SERVER_NAME% -Dweblogic.management.username=%WLS_USER% -
Dweblogic.management.password=%WLS_PW% -
Djava.security.policy=%WL_HOME%\server\lib\weblogic.policy %PROXY_SETTINGS% 
%SERVER_CLASS%
) else (
echo Redirecting output from WLS window to %WLS_REDIRECT_LOG%
%JAVA_HOME%\bin\java %JAVA_VM% %MEM_ARGS% %JAVA_OPTIONS% %JAAS_LOGIN% -
Dweblogic.Name=%SERVER_NAME% -Dweblogic.management.username=%WLS_USER% -
Dweblogic.management.password=%WLS_PW% -
Djava.security.policy=%WL_HOME%\server\lib\weblogic.policy %PROXY_SETTINGS% 
%SERVER_CLASS% >”%WLS_REDIRECT_LOG%” 2>&1
)

UNIX - in the WLS_REDIRECT_LOG settings

${JAVA_HOME}/bin/java ${JAVA_VM} -version

if [ "${WLS_REDIRECT_LOG}" = "" ] ; then
        echo "Starting WLS with line:"
        echo "${JAVA_HOME}/bin/java ${JAVA_VM} ${MEM_ARGS} ${JAVA_OPTIONS} -
Dweblogic.Name=${SERVER_
NAME} -Djava.security.policy=${WL_HOME}/server/lib/weblogic.policy  
${PROXY_SETTINGS} ${SERVER_CLASS
}"
        ${JAVA_HOME}/bin/java ${JAVA_VM} ${MEM_ARGS} ${JAVA_OPTIONS} 
${JAAS_LOGIN} -Dweblogic.Name=${S
ERVER_NAME} -Djava.security.policy=${WL_HOME}/server/lib/weblogic.policy 
${PROXY_SETTINGS} ${SERVER_
CLASS}
else
        echo "Redirecting output from WLS window to ${WLS_REDIRECT_LOG}"
        ${JAVA_HOME}/bin/java ${JAVA_VM} ${MEM_ARGS} ${JAVA_OPTIONS} 
${JAAS_LOGIN} -Dweblogic.Name=${S
ERVER_NAME} -Djava.security.policy=${WL_HOME}/server/lib/weblogic.policy 
${PROXY_SETTINGS} ${SERVER_
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CLASS}  >"${WLS_REDIRECT_LOG}" 2>&1
fi

3. Save and close the server startup script.

To configure Application Engine (WebLogic)

1. (If you selected Container-Managed Authentication during the installation) Enable trust between 
WebLogic domains for the Content Engine domain and the Application Engine domain.

Do the following on both the Content Engine application server and the Application Engine 
application server.

a. In the WebLogic Administration Console, in the security settings, enter a password for the 
domain. You must enter the same password for both the Content Engine domain and 
Application Engine domain.

b. Save your changes.

c. Restart the server if needed.

d. Repeat this procedure in each domain for which you want to enable trust.

2. (If you selected Container-Managed Authentication during the installation) Configure LDAP 
settings on Application Engine to exactly match the Content Engine settings.

a. Refer to your Content Engine installation worksheet items and the WebLogic Administration 
Console settings for Compatibility Security > Realms for Authentication Provider, users, and 
groups on Content Engine.

Configure the LDAP provider to exactly match the settings from the Content Engine server.

• Group Base DN:

• User Name Attribute:

• Port:

• User Base DN:

• Principal:

• Credential:

• Confirm Credential:

• Host:

• User From Name Filter:

• Group From Name Filter:

b. Restart WebLogic. 
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3. Set permissions for the user running the application server.

If the user that will be running the application server is different from the user that installed 
Application Engine, you must give the user read/write permissions on the folder where you 
installed AE (AE_install_path). 

4. Continue with “To enable passing user credentials to client applications (WebLogic)” on page 590.

To enable passing user credentials to client applications (WebLogic)

Perform this procedure to enable passing user credentials between Application Engine and its 
client applications such as WebDAV and Application Integration. 

CAUTION  If you do not make this change to config.xml, then end users will be prompted to 
enter their user name and password to complete any client operations, such as adding a 
document.

1. Stop the WebLogic server.

2. Make a backup copy of config.xml located in deployment directory.

For example:

BEA_home/bea/user_projects/domains/domain_name/config/config.xml

3. Edit config.xml.

CAUTION  The enforce-valid-basic-auth-credentials entry should be entered as a single line 
without line breaks.  

a. Locate the <security-configuration> section and add the following line to the end of the 
section, just before the </security-configuration> tag:

<enforce-valid-basic-auth-credentials>false</enforce-valid-basic-auth-
credentials>

b. Save your changes to config.xml and close the file.

4. Restart WebLogic.

5. Continue with “Manually copy custom data” on page 594.
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Task 6c: Configure Application Engine upgrades from 
3.5.x (JBoss)
This topic covers the configuration of your Application Engine application (Workplace) on JBoss. 
Perform the following high-level steps in the order listed, using the referenced detailed procedures 
for each step. 

To modify the application server startup script

1. Stop JBoss if it is running.

2. Make a backup copy of the application server startup script.

UNIX

run.sh

Windows

run.bat

3. Edit the application server startup script Java settings. 

a. Add a line to specify the path to the JDK provided by JBoss, as shown in the following 
example (Windows):

set JAVA_HOME=C:\Program Files\Java\jdk1.5.0_06

NOTE  If your JDK is different from version 1.5.0, substitute your version for the one listed 
above. 

b. Update the JAVA_OPTS memory settings.

Adjusting this setting prevents the application server from running out of memory, a 
condition in which users would not be able to log in to Workplace.

In the JAVA_OPTS line, change the -Xms and -Xmx values (bold) for your configuration.

Example (Windows):

set JAVA_OPTS=%JAVA_OPTS% -Xms128m -Xmx512m 

Refer to your application server vendor's recommendation for Initial and Maximum heap 
size values. For IBM specific recommendations, see the IBM FileNet P8 Platform 
Performance Tuning Guide. To download this guide from the IBM support page, see 
“Access IBM FileNet documentation, compatibility matrices, and fix packs” on page 20.

c. If your application server uses the IBM JVM, edit the JAVA_OPTS variable in the startup 
script immediately after the line in the previous sub-step. This JAVA_OPTS edit improves 
performance.

UNIX

Find the following line in run.sh:

JAVA_OPTS=”$JAVA_OPTS -Dprogram.name=$PROGNAME”
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and change it to this (without a carriage return):

JAVA_OPTS=”$JAVA_OPTS -Dprogram.name=$PROGNAME 
-Dfilenet.pe.peorb.pool.min=2 -Dfilenet.pe.peorb.pool.max=5”

Windows

Find the following line in run.bat:

set JAVA_OPTS=%JAVA_OPTS% -Dprogram.name=%PROGNAME%

and change it to this (without a carriage return):

set JAVA_OPTS=%JAVA_OPTS% -Dprogram.name=%PROGNAME% 
-Dfilenet.pe.peorb.pool.min=2 -Dfilenet.pe.peorb.pool.max=5

d. Save your edits.

4. Configure JAAS login. 

Add one of the following right after the "$JAVA" $JAVA_OPTS (UNIX) or “%JAVA%” 
%JAVA_OPTS (Windows) entry in the startup script. 

CAUTION  Enter the jaas_login entry (bold below) as a single line without line breaks. Do not 
copy and paste the text from this guide because hidden formatting can cause problems with 
the entry. Instead, type the entry into the script. 

NOTE  Your path may be slightly different depending on the version of your client installations, 
or whether you have chosen a custom path for installation. Verify the location of the file before 
you enter the path.

UNIX

"$JAVA" $JAVA_OPTS -Djava.security.auth.login.config=”/opt/FileNet/AE/CE_API/
config/jaas.conf.JBoss” "-Djava.endorsed.dirs=$JBOSS_ENDORSED_DIRS" -classpath 
"$JBOSS_CLASSPATH" org.jboss.Main $@ 

Windows

"%JAVA%" %JAVA_OPTS% "-Djava.security.auth.login.config=C:\Program 
Files\FileNet\AE\CE_API\config\jaas.conf.JBoss" "-
Djava.endorsed.dirs=%JBOSS_ENDORSED_DIRS%" -classpath "%JBOSS_CLASSPATH%" 
org.jboss.Main %*

5. Save and close the server startup script.

6. Configure LDAP settings on Application Engine to exactly match the Content Engine settings.

a. On the Application Engine server, open login-config.xml, located in JBoss_home/
server/server_name/conf, for editing.

b. Set the <application-policy name="FileNet"> entry identical to the corresponding entry in the 
login-config.xml file on the Content Engine server. 

c. Set the <application-policy name="FileNetP8Engine"> entry identical to the corresponding 
entry in the login-config.xml file on the Content Engine server.

d. Save changes to the login-config.xml file on the Application Engine server.

e. Restart JBoss.
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



Task 6c: Configure Application Engine upgrades from 3.5.x (JBoss)
To modify the application server startup script

593
7. Set permissions for the user running the application server.

NOTE  On Windows, the following is only required for NTFS formatted partitions 

If the user that will be running the application server is different from the user that installed 
Application Engine, you must give the user read/write permissions on the folder where you 
installed Application Engine (AE_install_path). 

8. (Optional) Disable JBoss logging. 

In development mode, JBoss creates a large number of HTTP Access, “INFO”, “DEBUG” and 
“TRACE” log messages. This can cause unexpected behavior in the deployed IBM FileNet 
software. Using the following procedure, you can limit this type of excessive JBoss logging.

NOTE When logging is disabled, error messages will still be displayed in the JBoss console.

a. Edit the log4j.xml file (JBOSS_home/server/server_name/conf/log4j.xml).

i. Change all threshold values and priority values from "INFO", "DEBUG", or "TRACE" to 
"ERROR".

ii. Delete or comment out the "Preserve messages in a local file" to turn off the server log.

b. To turn off HTTP access logging, open jboss-service.xml with a text editor and delete or 
comment out the "Access logger" section.

Location of jboss-service.xml:

JBoss_Home/server/server_name/deploy/jbossweb-tomcat55.sar/META-INF

c. Open web.xml and change the logVerbosityLevel to "FATAL".

Location of web.xml:

JBoss_Home/server/server_name/deploy/jbossweb-tomcat55.sar/conf 

d.  Restart the JBoss server.

9. Continue with “Manually copy custom data” on page 594.
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Task 7: Manually copy custom data
If your custom data was not retained in the upgrade you must manually copy the data from the 
version 3.5.x or 4.0.1 backup files (deploy_backup) to the upgraded files.

NOTE  You must also copy any data you want to retain if you have made any custom add-ons or 
modifications to the Application Engine installation being upgraded and chose not to keep these 
changes after the upgrade. You should manually copy any other custom data you want to retain to 
the upgraded files listed in “Prepare for Application Engine upgrade” on page 544.

When you have completed the manual copy of your custom data, deploy the Workplace 
application using one of the following tasks:

• “Deploy upgraded Application Engine instances (WebSphere)” on page 595

• “Deploy upgraded Application Engine instances (WebLogic)” on page 598

• “Deploy upgraded Application Engine instances (JBoss)” on page 600
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Task 8a: Deploy upgraded Application Engine 
instances (WebSphere)
This topic covers the deployment and start of your Application Engine application (Workplace) on 
WebSphere.

To recreate the WAR or EAR file

Any time that you make changes to files in the /Workplace directory, such as changes to 
web.xml for container-managed authentication, SSO support, or any other edits, you must 
recreate the WAR or EAR file and redeploy your changes. 

NOTE  Before recreating the EAR file, you must also recreate the WAR file. 

• If you will be deploying from a WAR or an EAR file.

a. Verify that all modified /Workplace directory files have been saved.

b. Recreate the app_engine.war file by running create_app_engine_war.sh (UNIX) or 
create_app_engine_war.bat (Windows) from the following location:

AE_install_path/deploy/

• If you will be deploying from an EAR file.

a. Verify that a newly recreated app_engine.war file exists. 

b. Recreate the app_engine.ear file by running create_app_engine_ear.sh (UNIX) or 
create_app_engine_ear.bat (Windows) from the following location:

AE_install_path/deploy/

To deploy Application Engine

1. Log on to the WebSphere administrative console.

2. Navigate to the dialog for installing a new application.

WebSphere 6.1

Expand Applications > Install New Application.

WebSphere 7.0

Expand Applications > New Application > New Enterprise Application.

3. Select the file to deploy.

• (If the administrative console is running locally) Select Local Path and enter or browse to the 
location of the app_engine.war or app_engine.ear file created by the installation program 
(see below for the default path). Do not enter the machine name.

• (If the administrative console is remote) Select Server path and enter the fully-qualified pathname 
to the app_engine.war  or app_engine.ear file. Do not enter the machine name.

AE_install_path/deploy
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4. (WebSphere 6.1) If you are deploying a WAR file, enter the context root. 

Enter Workplace and click Next to proceed to deploying a new application.

NOTE The context root is the name of the application you log in to using the web interface, 
such as: 

http://ApplicationEngineServerName:port#/Context_Root.

5. Complete the dialogs for installing a new application, using the following settings:

Application name: Workplace, or the name you chose to call the application.

WebServer: The server you are planning to use. Verify that your application name is selected 
and associated with the correct WebServer.

virtual host: Choose the default_host.

(WebSphere 7.0) context root: Workplace

6. Save your configuration.

7. Configure the Classloader settings and change the polling interval to a number appropriate for 
your environment.

Change Classloader order to have the classes loaded with parent classloader last.

NOTE  Do this only for the specific web application. Do not change the similar settings for the 
entire application server.

8. In the Manage Modules area, configure the Web Module Classloader setting.

Change Classloader order to have the classes loaded with parent classloader last.

NOTE  Do this only for the specific web application. Do not change the similar settings for the 
entire application server.

9. (WebSphere 6.1) If you are using container-managed authentication, navigate to Enterprise 
Applications > Workplace > Map security roles to users/groups, and verify that the All 
Authenticated column is checked for the “All Authenticated” role.

10. (WebSphere 7.0) If you are using container-managed authentication, navigate to Enterprise 
Applications > Workplace > Security roles to user/group mapping. Select the “All authenticated” 
role and map it to “All Authenticated in Applications realm”.

11. Set permissions for the user running the application server. 

The user that will be running the application server must have read/write permissions on the 
following (default) folders:

WAS_HOME/profiles/default/installedApps/node_name/app_engine_war.ear/
app_engine.war

AE_install_path

12. Save all your changes.
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13. Stop and restart WebSphere.

NOTE To troubleshoot the deployment, check the following log: 

WAS_install_path/AppServer/profiles/profile_name/logs/server_name/
SystemOut.log  

14. Continue with Task 9 “Complete post-upgrade Application Engine configuration” on page 602.
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Task 8b: Deploy upgraded Application Engine 
instances (WebLogic)
This topic covers the deployment of your Application Engine application (Workplace) on 
WebLogic.

To recreate the WAR or EAR file

Any time that you make changes to files in the /Workplace directory, such as changes to 
web.xml for container-managed authentication, SSO support, or any other edits, you must 
recreate the WAR or EAR file and redeploy your changes. 

NOTE  Before recreating the EAR file, you must also recreate the WAR file. 

• If you will be deploying from a WAR file.

a. Verify that all modified /Workplace directory files have been saved.

b. Recreate the app_engine.war file by running create_app_engine_war.sh (UNIX) or 
create_app_engine_war.bat (Windows) from the following location:

AE_install_path/deploy/

• If you will be deploying from an EAR file.

a. Verify that a newly recreated app_engine.war file exists. 

b. Recreate the app_engine.ear file by running create_app_engine_ear.sh (UNIX) or 
create_app_engine_ear.bat (Windows) from the following location:

AE_install_path/deploy/

To deploy  as “Workplace” or custom name using a WAR file

Perform this step only if you are using a WAR file for deployment, and you want to use 
“Workplace” or a custom name for the context root of the application. The context root is part of 
the URI that end users enter to access Workplace. By default, when you deploy from a WAR file, 
the context root is the first part of the WAR filename. 

Rename the app_engine.war file to reflect the name you want to use using the format 
Application Name.war.

Example:

The default app_engine.war will generate the following context root:

http://server_name:port#/app_engine

Renaming the WAR file Workplace.war will generate the following context root:

http://server_name:port#/Workplace

CAUTION  You must rename the WAR file every time you regenerate it. The 
create_app_engine_war.sh/.bat script will by default create a file with the name 
app_engine.war.
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To deploy Application Engine

1. From the WebLogic Administration Console, navigate to the domain you initially created for the 
Application Engine.

2. Prepare the WebLogic Administration Console to deploy the application.

3. Choose whether to deploy from an exploded folder (AE_install_path) or from the WAR or 
EAR file (default: app_engine.war or app_engine.ear in AE_install_path/deploy).

4. Accept the defaults for the deployment, except for the name for the deployment. Use 
“Workplace” instead of “appengine”.

5. Finish the deployment, and save and activate your changes.

NOTE  To verify that the deployment was successful, expand Web Applications. The web 
application Workplace will be listed.

NOTE To troubleshoot the deployment, check the following log: 

WLS_install_path/user_projects/domains/domain_name/servers/server_name/
logs/server_name.log  

6. Continue with Task 9 “Complete post-upgrade Application Engine configuration” on page 602.
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Task 8c: Deploy upgraded Application Engine 
instances (JBoss)
This topic covers the deployment and start of your Application Engine application (Workplace) on 
JBoss.

To recreate the WAR or EAR file

Any time that you make changes to files in the /Workplace directory, such as changes to 
web.xml, you must recreate the WAR or EAR file and redeploy your changes. 

NOTE  Before recreating the EAR file, you must also recreate the WAR file. 

• If you will be deploying from a WAR file.

a. Verify that all modified /Workplace directory files have been saved.

b. Recreate the app_engine.war file by running create_app_engine_war.sh (UNIX) or 
create_app_engine_war.bat (Windows) from the following location:

AE_install_path/deploy/

• If you will be deploying from an EAR file.

a. Verify that a newly recreated app_engine.war file exists. 

b. Recreate the app_engine.ear file by running create_app_engine_ear.sh (UNIX) or 
create_app_engine_ear.bat (Windows) from the following location:

AE_install_path/deploy/

To deploy  as “Workplace” or custom name using a WAR file

Perform this step only if you are using a WAR file for deployment, and you want to use 
“Workplace” or a custom name for the context root of the application. The context root is part of 
the URI that end users type to access Workplace. By default, when you deploy from a WAR file, 
the context root is the first part of the WAR filename. 

Rename the app_engine.war file to reflect the name you want to use using the format 
Application Name.war.

Example:

The default app_engine.war will generate the following context root:

http://server_name:port#/app_engine

Renaming the WAR file Workplace.war will generate the following context root:

http://server_name:port#/Workplace

CAUTION  You must rename the WAR file every time you regenerate it. The 
create_app_engine_war.sh/.bat script will by default create a file with the name 
app_engine.war.
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To deploy and start Application Engine

1. Stop JBoss, if it is running.

2. Deploy the Workplace application:

To deploy from exploded directory

a. On the JBoss server, copy the /Workplace folder from: 

AE_install_path

to:

JBOSS_home/server/servername/deploy/

b. Append the extension .war to the Workplace folder:

JBOSS_home/server/servername/deploy/Workplace.war

To deploy from a WAR file

On the JBoss server, copy the app_engine.war file from:

AE_install_path/deploy

to:

JBOSS_home/server/servername/deploy/

To deploy from an EAR file

On the JBoss server, copy the app_engine.ear file from: 

AE_install_path/deploy

to:

JBOSS_home/server/servername/deploy/

3. Set permissions for the user running the application server.

If the user that will be running the application server is different from the user that installed 
Application Engine, you must give the user read/write permissions on the following folders:

NOTE  For Windows this is only required for NTFS formatted partitions:

JBOSS_home/server/default/deploy/app_engine.war/.ear

AE_install_path

4. Start the JBoss application server.

5. Verify that the application deployed successfully.

Verify that the server.log file located in JBOSS_home/server/servername/log lists 
deployment of the WAR or EAR file you used.

6. Continue with Task 9 “Complete post-upgrade Application Engine configuration” on page 602.
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Task 9: Complete post-upgrade Application Engine 
configuration
Use the procedure in this topic to complete the configuration of upgraded Application Engine 
instances. Actions include modifying a configuration file, verifying Workplace sign-in, setting 
bootstrap preferences, establishing the Process Engine connection point, and verifying the  
version of an associated software integration.

To complete post-upgrade Application Engine configuration 

1. (WebLogic only) If you upgraded from WebLogic 8.1.x to WebLogic 9.x or 10.x, you must set the 
case-sensitivity for the server.

a. From the WebLogic Administration Console, click my_domain.

b. Set Web App Files Case Insensitive to false.

c. Save and activate your changes.

2. If it is not already running, start the Workplace application on your application server.

3. Sign in to Workplace to test your connection.

a. On any computer, open a browser and type:

http://ApplicationEngineServerName:port#/Workplace

b. Enter a user name and password, and click Sign in.

c. If the Bootstrap Preferences page is displayed, you must set the preferences. 

Follow the instructions in “Set Application Engine bootstrap preferences” on page 254 to reset 
your bootstrap properties. Use the notes you made of your bootstrap settings during your 
upgrade preparation to complete this step. 

4. Set the Process Engine Connection Point. 

The Process Router from version 3.5.x has been replaced with the Process Engine 
Connection Point. 

a. In Workplace click Admin.

b. Click Site Preferences.

c. Under General Settings > Tasks, select a Process Engine Connection Point from the drop 
down list.

d. Click Apply and then Exit.

e. Confirm that Application Engine is communicating with Process Engine.

i. In Workplace, click Tasks.

ii. Verify that the Tasks page displays. 

f. Sign out of Workplace. 
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5. (IBM FileNet P8 systems using Image Services Integration only) Verify that you are running a 
supported version of ISRA. 

See the IBM FileNet P8 Hardware and Software Requirements document for details on 
supported ISRA versions. To download this guide from the IBM support page, see “Access IBM 
FileNet documentation, compatibility matrices, and fix packs” on page 20.

For more information on how to upgrade ISRA and configure Image Services Integration, see 
your ISRA documentation and “Upgrade ISRA servlet” on page 615.
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Upgrade add-on components
You must upgrade all of the IBM FileNet P8 Platform core components before upgrading the add-
on components listed in this topic. See “Upgrade and configure IBM FileNet P8 Platform” on page 315 
for the tasks required to upgrade the IBM FileNet P8 Platform core components.

You can upgrade the add-on components in the following list, and any IBM FileNet P8 Platform 
expansion products, in any order, except that you must upgrade Process Analyzer before 
upgrading Process Simulator.

For details and procedures on updating add-on components, see the following topics:

• “Upgrade Application Integration and File Tracker” on page 605.

• “Upgrade IBM FileNet publishing components” on page 608.

• “Upgrade server-side scripts and COM objects” on page 609.

• “Upgrade ISRA servlet” on page 615.
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Upgrade Application Integration and File Tracker
Upgrading to Workplace Application Integration 4.0.0 involves installing the new version on top of 
your existing Workplace Application Integration 3.5.x install. The upgrade installation program 
detects the earlier version and notifies you before proceeding with the upgrade. 

During the upgrade, the installer detects the Microsoft applications that were previously integrated 
with Workplace and retains that configuration. For example, if you had Microsoft Outlook 
integrated with Workplace in the 3.5.x release, Microsoft Outlook is upgraded to 4.0.0 during the 
upgrade installation.

You cannot change your installed components during the upgrade. You can add or remove a 
Microsoft application from Application Integration after the upgrade using your Add/Remove 
Programs application.

Verify your computer meets the platform requirements documented in the IBM FileNet P8 Hardware 
and Software Requirements. To download this guide from the IBM support page, see “Access IBM 
FileNet documentation, compatibility matrices, and fix packs” on page 20.

Upgrade considerations
The procedures for upgrading Application Integration and File Tracker depend on which versions 
are currently installed on the client machine.

• If you upgrade from Application Integration version 3.5.1-001 or earlier, the upgrade to 4.0.0 
will install File Tracker for you.

• If you upgrade from Application Integration version 3.5.1-002 or higher, then these conditions 
apply:

– If you only had Application Integration installed (without File Tracker), then the upgrade to 
4.0.0 will install File Tracker for you.

– If you only had File Tracker installed (without Application Integration), then see “To upgrade 
Workplace File Tracker” on page 606.

– If you had both Application Integration and File Tracker installed, then the order that you 
installed these determines how you upgrade.

• If you installed File Tracker 3.5.1-002 or higher before you installed Application 
Integration, you must upgrade File Tracker before you upgrade Application Integration. 
See “To upgrade Workplace File Tracker” on page 606, and then see “To upgrade Workplace 
Application Integration” on page 606.

• If you installed Application Integration 3.5.1-002 or higher, and later used File Tracker, 
then you only need to upgrade Application Integration.See “To upgrade Workplace 
Application Integration” on page 606

NOTE  If you upgrade from Application Integration version 3.5.1-002 or earlier, there is a change 
in the behavior of entry tempates for adding email. Beginning with version 3.5.1-003, entry 
templates for adding an email are no longer restricted to using the email class or subclass.
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To upgrade Workplace Application Integration

1. Log onto the client machine with Application Integration installed using an account that has 
Administrator privileges. 

2. Sign in to Workplace.

3. Click Author, and then click General Tools.

4. Click Download Application Integration for Microsoft Office. The File Download dialog box for 
your system appears. Do one of the following:

• Click Open to run the program from its current location. 

• Click Save. In the Save As dialog box, find a location on your machine in which to download and 
save the ApplicationIntegration.exe file locally, and then click Save. Once the file is saved 
to your hard drive, double-click the file to run the upgrade installer.

NOTE If you have Workplace Application Integration 3.5.x currently installed, you are 
prompted about the impending upgrade. Click Yes to upgrade to the current version you are 
installing or click No to end the installation. 

5. After the install is complete, click Finish to complete the upgrade process. 

To upgrade Workplace File Tracker

1. Log on to the client machine with File Tracker installed using an account that has Administrator 
privileges. 

2. Sign in to Workplace.

3. Click Author, and then click General Tools.

4. Scroll down and click Download File Tracker and do one of the following:

• Click Open to run the program from its current location.

• Click Save. In the Save As dialog box, find a location on your machine in which to download and 
save the FileTracker.exe file locally, and then click Save. Once the file is saved to your hard 
drive, double-click the file to run the upgrade installer.

5. After the install is complete, click Finish to complete the upgrade process.

To verify your Workplace Application Integration upgrade

1. Start Microsoft Word. 

2. From the File menu, click FileNet P8, point to Open Document, and then select Select Item. The 
Logon dialog box opens. 

3. Log on using any valid domain account. 

4. Click Options to view the Workplace address. The version number appears below the address.

5. Close all dialog boxes and close Microsoft Word.
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To install component software updates

1. To obtain the latest component software updates, and to determine whether additional interim 
fixes are needed, contact your service representative.

2. Open the readmes for the software updates and perform the installation procedures in the 
readmes on the component machine.
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Upgrade IBM FileNet publishing components
If you have IBM FileNet Rendition Engine software currently installed, you can upgrade to the 
latest software version. For instructions, see the IBM FileNet Rendition Engine Installation and 
Upgrade Guide at FileNet P8 Documentation > FileNet P8 System Installation > Rendition Engine 
Installation and Upgrade.
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Upgrade server-side scripts and COM objects
As with Content Engine 3.5.x, you can develop and plug in the following server-side components 
for the 4.x version of Content Engine: event action handlers, lifecycle action handlers, and 
document classifiers. Whereas these components had to be implemented as COM objects or 
scripts for Content Engine 3.5.x, they must be implemented as Java classes in Content Engine 
4.x. Therefore, for Content Engine 4.x, you must convert any event action handlers, lifecycle 
action handlers, and document classifiers that you developed for Content Engine 3.5.x.

This section gives you an idea of the effort involved in converting 3.5.x script-based event action 
handlers to 4.x Java-implemented handlers. For details on developing and deploying event action 
handlers, lifecycle action handlers, and document classifiers, see the Java and .NET Developer's 
Guide and the Java API Reference.

In the following listings, compare the 3.5.x script-based event action handlers to the 
corresponding Java-implemented handlers required for Content Engine 4.x.

File Document Handler
This handler files a document to a specified folder, determined by the event fired on the 
document.

Content Engine 3.5.x JScript Version

function OnEvent (Event, Subscription) 
{
  var doc = Event.SourceObject;
  if ( Event.IsOfClass("CreationEvent")  )
  {
      FileDocInFolder("/Docs", doc);
  }
  else if (Event.IsOfClass("ChangeClassEvent")  )
  {
      FileDocInFolder("/Archives", doc);
  }
}

function FileDocInFolder(otherFolderName, doc)
{
    var os = doc.ObjectStore;
    var rootFld = os.RootFolder;
    var fldSet = new Enumerator(rootFld.SubFolders);
    var subFld;
    for ( ; !fldSet.atEnd(); fldSet.moveNext() )
    {
       subFld = fldSet.item();
       if (subFld.Name == otherFolderName)
       {
          subFld.File(doc, 0, doc.DocumentTitle);
       }
    }
}
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Content Engine 4.x Java Version

import com.filenet.api.constants.*;
import com.filenet.api.constants.DefineSecurityParentage;
import com.filenet.api.core.*;
import com.filenet.api.engine.EventActionHandler;
import com.filenet.api.events.ObjectChangeEvent;
import com.filenet.api.exception.EngineRuntimeException;
import com.filenet.api.exception.ExceptionCode;
import com.filenet.api.util.Id; 

public class FileDocumentAction implements EventActionHandler 
{
  public void onEvent(ObjectChangeEvent event, Id subscriptionId)
        throws EngineRuntimeException
  {    
      Document doc = (Document)event.get_SourceObject(); 
      try 
      {
            if (event.getClassName().equalsIgnoreCase("CreationEvent"))
                FileDocInFolder("/docs", doc);
            else if (event.getClassName().equalsIgnoreCase("ChangeClassEvent"))
                FileDocInFolder("/Archives", doc);
      } 
      catch (Exception e) 
      {
            throw new EngineRuntimeException(ExceptionCode.E_FAILED);
      }
  }

  public void fileDocInFolder(String folderName, Document doc)
  {
      try
      {
            Folder folder = (Folder)doc.getObjectStore().getObject("Folder", folderName);
            ReferentialContainmentRelationship rel = folder.file (doc, 
                        AutoUniqueName.AUTO_UNIQUE, doc.get_Name(),
                       DefineSecurityParentage.DO_NOT_DEFINE_SECURITY_PARENTAGE);
            rel.save(RefreshMode.NO_REFRESH);
      }
      catch (Exception e) 
     {
            e.printStackTrace();
      } 
  }
}
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Log Event Handler
This handler records events to a log file when documents are created.

Content Engine 3.5.x VBScript Version

Public Sub OnEvent (EventObject, Subscription)
  Dim doc, message)
  Set doc = EventObject.SourceObject)
  WriteToLogFile (doc.Name & " was created on: " & Date))
End Sub

Public Sub WriteToLogFile (message))
    Dim fso, ts, logFile)
    Set fso = CreateObject("Scripting.FileSystemObject"))
    Set logFile = fso.CreateTextFile("C:\log.txt"))
    logFile = nothing)
    Set ts = fso.OpenTextFile("C:\log.txt", 8, True))
    ts.Write (message))
    ts.WriteBlankLines (2))
    ts.Close)
    Set fso = Nothing)
    Set ts = Nothing)
End Sub
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Content Engine 4.x Java Version

import java.io.File;
import java.io.FileWriter;
import java.io.IOException;

import com.filenet.api.core.Document;
import com.filenet.api.engine.EventActionHandler;
import com.filenet.api.events.ObjectChangeEvent;
import com.filenet.api.exception.EngineRuntimeException;
import com.filenet.api.exception.ErrorRecord;
import com.filenet.api.exception.ExceptionCode;
import com.filenet.api.util.Id;

public class LogEventAction implements EventActionHandler 
{
    public void onEvent(ObjectChangeEvent event, Id subscriptionId) throws EngineRuntimeException 
    {
        try 
        {
            Document doc = (Document)event.get_SourceObject(); 
            WriteToLogFile(doc.get_Name() + " was created on: " 
               + new java.util.Date() + "\r\n");
        }
        catch (Exception e) {
            ErrorRecord er[] = {new ErrorRecord (e)};
            throw new EngineRuntimeException(e, ExceptionCode.EVENT_HANDLER_THREW, er);

        }
    }

    public void writeToLogFile(String message)
    {
        try
        {
            File outputFile = new File("C:\\log.txt");
            FileWriter out = new FileWriter(outputFile, true); 
            out.write(message);
            out.close();
        }
        catch (IOException e) {
            ErrorRecord er[] = {new ErrorRecord (e)};
            throw new EngineRuntimeException(e, ExceptionCode.EVENT_HANDLER_THREW,er);
        } 
    }
}
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Send eMail Handler
This handler sends an email when a new document has been created.

Content Engine 3.5.x VBScript Version

Public Sub OnEvent (EventObject, Subscription)
  Dim myMail, MessageBody
  Set myMail = CreateObject("CDONTS.NewMail")
  myMail.From = "userl@company.com"
  myMail.To = "sysAdmin@company.com"
  myMail.Subject = "Event Notification--New Document created"
  MessageBody = "A document titled """ & Source.DocumentTitle & """ was Created at " & time & " on " & 
date & "."
  MessageBody = MessageBody + vbCrLf +   Subscription.UserString
  myMail.Body = MessageBody
  myMail.Send
  Set myMail = Nothing
End Sub
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Content Engine 4.x Java Version

import java.util.Date;
import java.util.Properties;

import javax.mail.Message;
import javax.mail.MessagingException;
import javax.mail.Session;
import javax.mail.Transport;
import javax.mail.internet.InternetAddress;
import javax.mail.internet.MimeMessage;

import com.filenet.api.core.*;
import com.filenet.api.engine.EventActionHandler;
import com.filenet.api.events.ObjectChangeEvent;
import com.filenet.api.exception.EngineRuntimeException;
import com.filenet.api.exception.ExceptionCode;
import com.filenet.api.util.Id;

public class EMailAction implements EventActionHandler
{
    public void onEvent(ObjectChangeEvent event, Id subscriptionId) throws EngineRuntimeException
    { 
        Document doc = (Document)event.get_SourceObject(); 
        try 
        {
            Properties props = new Properties();
            props.put("mail.smtp.host", "smtp.company.net");
            props.put("mail.smtp.port", "25");
            Session session = Session.getInstance(props);
            try {
                Message msg = new MimeMessage(session);
                msg.setFrom(new InternetAddress("userl@company.com" ));
                InternetAddress[] address = {new InternetAddress("sysAdmin@company.com" )};
                msg.setRecipients(Message.RecipientType.TO, address);
                msg.setSubject("Test E-Mail through Java");
                msg.setSentDate(new Date());
                msg.setText("Document " + doc.get_Name() + " created with ID " + doc.get_Id());
                Transport.send(msg);
            }
            catch (MessagingException mex) {
                mex.printStackTrace();
            }
        }
        catch (Exception e)
        {
            throw new EngineRuntimeException(ExceptionCode.E_FAILED);
        }
    }
}
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Upgrade ISRA servlet
As part of upgrading FileNet Image Services Resource Adapter (ISRA) software to run with IBM 
FileNet P8, you must do the following:

• Ensure that Application Engine has been upgraded.

• Ensure that existing IBM FileNet ISRA software is installed and configured.

For information on installing, configuring, and deploying FileNet ISRA, refer to the ISRA 
documentation on the IBM FileNet ISRA installation package.

TIP  Use the Sample Application shipped with IBM FileNet ISRA to confirm that the ISRA 
installation was successful.

WARNING  In an ISRA upgrade, take care to use the same library name (JNDI connection 
factory name) that has been previously set in the ISRA install. Changing this variable can 
cause conflicts when accessing documents.

• Do the following, as documented later in this task topic:

– Upgrade the Application Engine ISRA Servlet, taking the following into account:

– The servlet must be deployed on the same application server as FileNet ISRA.

–  The servlet does not need to be collocated with the Application Engine.

– Configure Workplace site preferences for ISRA support.

ISRA SSL Support
The following table details the supported for SSL configurations.

SSL Configuration SSL Support

ISRA Servlet and AE Collocated. AE configured 
for SSL logon redirect to a non-local host.

Supported

ISRA Servlet and AE Collocated. AE Configured 
for SSL logon redirect to a local host.

Supported

ISRA Servlet and AE Collocated. AE and ISRA 
Servlet running under SSL.

Not Supported

ISRA Servlet remote from AE. AE configured for 
SSL logon redirect to a non-local host.

Supported

ISRA Servlet remote from AE. AE configured for 
SSL logon redirect to a local host.

Supported

ISRA Servlet remote from AE. AE running under 
SSL,  ISRA Servlet not running under SSL. 

Supported

ISRA Servlet remote from AE.  AE and ISRA 
Servlet running under SSL.

Not Supported
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To upgrade the Application Engine ISRA Servlet

The FileNet P8 Application Engine installation CDs contain the ISRA servlet installation programs 
for the  supported P8 AE platforms. 

1. Log on to the application server machine:

UNIX 

Log on as a user with write access to the /bin directory and read, write, execute access to the 
directory where you plan to install ISRA Servlet.

Windows

 Log on as a member of the local Administrators group or as a user with equivalent 
permissions.

2. (WebSphere and WebLogic only) Back up and undeploy the ISRA Servlet application on the 
application server.

3. Stop the application server if it is running.

4. (JBoss only) Back up and undeploy the ISRA Servlet application.

5. Access the ISRA installation package, and start the Application Engine ISRA Servlet installation 
(upgrade) program:

UNIX

AE-ISRA-Servlet-4.0.2.0-operating_system.bin

Windows

AE-ISRA-Servlet-4.0.2.0-WIN.exe

6. Complete the installation (upgrade) program screens. For information on parameter values, see 
“Installation and upgrade worksheet” on page 229 in Plan and Prepare Your Environment for IBM 
FileNet P8.

HINT With the Data > Filter > AutoFilter command enabled, as it is by default in the shipping     
worksheet file (p8_worksheet.xls), perform the following actions to quickly see only the     
installation properties you must specify for the ISRA servlet installation program:

– Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column 
header and select ISRA Servlet Installer.

– Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, 
and specify: Setup Type contains "Installation."

– Click the AutoFilter drop-down arrow in all other column headers and select (All).

7. Check the file AE_ISRA_Servlet_install_log-4_0_2_0.txt, located in the 
AE_israservlet_install path/FileNet directory, to see if any errors occurred during the 
installation.
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8. Install unlimited strength jar files. 

Perform this step only if your site is generating or accepting unlimited strength user tokens. 
Your system must be configured as follows:

• The Application Engine ISRA Servlet is deployed on a different application server from the 
Application Engine server.

• The Create unlimited strength key option was selected in the Application Engine User Token 
Security step of the Application Engine installation.

NOTE  Failure to perform the step will cause an EncryptionException when you log in to the IS 
Server. 

9. (WebSphere and WebLogic only) Start the application server.

10. Deploy AE_israservlet_install_path/FileNet/ApplicationEngineISRAServlet/
ae_isra.war in the same way you deployed the app_engine.war file for Workplace.

11. (JBoss only) Start the application server.

12. Verify the Application Engine ISRA Servlet installation. Do the following to use an available 
diagnostic tool to verify that the ISRA Servlet is installed and deployed correctly.

a. Launch your browser.

b. Enter the URL for the Application Engine ISRA Servlet. For example, 

http://ApplicationEngineISRAServlet_servername:port/
ApplicationEngineISRAServlet/ISRA

NOTE ApplicationEngineISRAServlet is the default context root. If you specified a different 
name for the context root when deploying the Application Engine ISRA Servlet, change the 
URL to match your configuration.

If the ISRA Servlet is installed and deployed correctly, a Congratulations message displays. 
For example: 

Congratulations! ISRA Interface Servlet is configured at this URL.

WcmApiConfigFile = D:\ISRAInterface\jsp\WEB-INF\WcmApiConfig.properties

WcmApiConfig file exists

CryptoKeyFile/UserToken = C:\Program 
Files\FileNet\Authentication\UTCryptoKeyFile.properties

CryptoKeyFile/UserToken exists 

FileNet ISRA classes are in the classpath

com.filenet.is.ra.cci.FN_IS_CciConnectionSpec 
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To configure the Workplace site preferences for ISRA support

Application Engine Setup installs a pre-configured external service called Image Service, which 
includes the parameterized values necessary to access FileNet Image Service libraries from 
Workplace. Enable the service by setting the Image Service value in Site Preferences to Show 
(the default is Hide), as described in the following procedure. 

1. Sign in to Workplace as a user having the Application Engine Administrators access role. 

2. Launch Site Preferences as follows:

a. Click Admin.

b. Click Site Preferences.

3. Click External Services from the left options list.

4. Click Modify for the Image Service (under External Reference Services).

The External Reference Service Settings site preference page displays. 

5. Under General Information, locate Show on Select File page and change the value to Show.

6. Click Accept.

7. Click Apply.

To set the ISRA Interface Servlet URL

1. Click Bootstrap.

2. Under Preferences Settings, set the value of ISRA Interface Servlet URL. For example:

http://<servername>:<port>/ApplicationEngineISRAServlet/ISRA

NOTE ApplicationEngineISRAServlet is the default context root. If you specified a different 
name for the context root when deploying the Application Engine ISRA Servlet, change the 
URL to match your configuration.

3. Click Apply.

4. Click Exit to exit the Site Preferences.

To log on to Image Services via LDAP

• To log on to the Image Services library using your LDAP account, configure ISRA and Image 
Services for LDAP authentication. If the LDAP account with which you accessed Workplace is 
not valid for the Image Services library, or if LDAP authentication is not configured, you will be 
prompted to log on to the Image Services library.

For information on configuring LDAP authentication for ISRA, refer to the ISRA Installation 
and Deployment Guide. For information on configuring LDAP authentication for Image 
Services, refer to the Image Services System Tools Reference Manual.
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To access IS library documents

• For informations about accessing IS library documents, see FileNet P8 Help topic User Help > 
Actions, preferences and tools > Actions > Documents > Add a document (Workplace).

To install component software updates

1. To obtain the latest component software updates, and to determine whether additional interim 
fixes are needed, contact your service representative.

2. Open the readmes for the software updates and perform the installation procedures in the 
readmes on the component machine.
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Remove software

This section includes:

• “Remove the IBM FileNet P8 documentation” on page 621

• “Remove Content Engine” on page 623

• “Remove Content Search Engine” on page 625

• “Remove Process Engine (Windows)” on page 627

• “Remove Process Engine (UNIX)” on page 629

• “Remove Application Engine (WebSphere)” on page 630

• “Remove Application Engine (WebLogic)” on page 632

• “Remove Application Engine (JBoss)” on page 633

• “Remove the Application Engine ISRA servlet” on page 635

For instructions on removing the Rendition Engine software, see the IBM FileNet P8 guide FileNet 
P8 Documentation > FileNet P8 System Installation > Rendition Engine Installation and Upgrade.
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Remove the IBM FileNet P8 documentation
The following topic explains how to remove the documentation for the FileNet P8 Platform and its 
expansion products.

NOTE Because of the number of application server configuration possibilities, these examples 
should be used only for reference. Your specific installation directories and application names may 
vary.

To remove the FileNet P8 documentation

NOTE In some Windows installations where NTFS is used for the file system (Not FAT or FAT32), 
there is a known issue with deleting files (and folders) that are longer than 256 characters. For 
example, if you use a default WebSphere installation location, you may encounter an error where 
the FileNet P8 Platform documentation files cannot be properly deleted due to the number of 
characters in the file/folder names. See the Microsoft Knowledge Base article http://
support.microsoft.com/?kbid=320081 for additional information about deleting files (and folders) in 
this environment.

To remove the FileNet P8 documentation from a WebSphere application server

1. Log on to the WebSphere FileNet P8 documentation server.

• UNIX - Log on as a user with delete access to where the FileNet P8 Platform documentation files 
are installed.

• Windows - Log on with a user account that has local Administrative (or Account Operators and 
Server Operators) rights.

2. Verify that the WebSphere server is running.

3. From the WebSphere administrative console (for example, http://localhost:9060/ibm/console), 
Uninstall the FileNet P8 documentation site (for example, ecm_help.war).

4. Delete the entire FileNet P8 documentation folder (for example, ecm_help.war) structure from 
the installation location.

5. Delete any temp folder(s) or log files for the FileNet P8 documentation.

WARNING Do not remove any other FileNet P8 application (for example, Workplace) files that 
are installed on the web application server.

To remove the FileNet P8 documentation from a WebLogic application server

1. Log on to the WebLogic application server.

• UNIX - Log on as a user with delete access to where the ecm_help files are located.

• Windows - Log on with a user account that has local Administrative rights (or Account Operators 
and Server Operators).

2. Verify that the WebLogic server is running.

3. From the WebLogic Server Administration Console (for example, http://<machinename>:7001/
console), Delete the FileNet P8 documentation site (for example, ecm_help).
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4. Delete all folders and files including any temp folder(s) or log files for the FileNet P8 
documentation.

WARNING Do not remove any other FileNet P8 application (for example, Workplace) files that 
are installed on the web application server.

To remove the FileNet P8 documentation from a JBoss application server

1. Log on to the JBoss FileNet P8 documentation server.

• UNIX - Log on as a user with delete access to where the FileNet P8 Platform documentation files 
are installed.

• Windows - Log on with a user account that has local Administrative (or Account Operators and 
Server Operators) rights.

2. Stop the JBoss application server.

3. Delete all folders and files including any temp folder(s) or log files for the FileNet P8 
documentation (for example, ecm_help).

WARNING Do not remove any other FileNet P8 application (for example, Workplace) files that 
are installed on the web application server.
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Remove Content Engine
You can uninstall an entire Content Engine installation or selected Content Engine components.

NOTE Uninstalling Content Engine does not undeploy it. You must use the application server 
console or commands to remove the Content Engine EAR file from the application server.

Use one of the following procedures to uninstall part or all of Content Engine.

To remove part or all of a Content Engine installation using the Windows Control Panel

1. Choose Control Panel > Add/Remove Programs.

2. Highlight P8 Content Engine in the list of currently installed programs and click Change/Remove 
to launch the Uninstall P8 Content Engine program.

3. At the Uninstall Options screen, choose to uninstall some or all Content Engine components. If 
you choose to uninstall all components, continue at Step 5; otherwise continue at Step 4.

4. In the Choose Components screen, choose which components to uninstall.

5. In the Uninstall Complete screen, note the directories and files that cannot be removed by the 
uninstall program and choose whether to have the program restart the machine, or restart it 
manually.

6. Remove the remaining directories and files, as noted in the Uninstall Complete screen.

7. If you want to completely remove all traces of the Content Engine installation, delete the 
C:\Program Files\FileNet directory.

To remove an entire Content Engine installation (UNIX)

1. Navigate to the directory install_path/FileNet/ContentEngine/_ceuninst, created by 
the Content Engine installer.

2. To uninstall Content Engine interactively, run the following command:

ce_uninstaller

To remove Content Engine silently

In silent mode, the uninstaller removes all Content Engine Components.

• To uninstall Content Engine silently, run one of the following commands:

UNIX 

ce_uninstaller -i silent

Windows 

ce_uninstaller.exe -i silent
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To remove data associated with Content Engine

After uninstalling Content Engine, you can remove its associated data, as follows:

1. Use the application server console or command lines to undeploy Content Engine.

2. Use your database tools to drop any databases or tablespaces for the object stores and the 
GCD.

3. Use your LDAP tools to delete users and groups you created in Plan and Prepare Your 
Environment for IBM FileNet P8.

4. Use your operating system commands to delete any directories, users and groups used for 
installing and administering Content Engine; and delete file-storage-area directories containing 
content (for example, documents) and index-area directories (K2 collections).
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Remove Content Search Engine
To completely remove 4.5.x Content Search Engine (Autonomy K2) and collections from your IBM 
FileNet P8 platform installation, you must disable full-text indexing and remove the Autonomy K2 
installations from all servers associated with the Content Engine.

CAUTION  If you remove or disable Autonomy K2 before you disable CBR and full-text indexing in 
Enterprise Manager, your system will be rendered unusable and require considerable 
reconstruction.

NOTES

• This procedure presumes you have a running installation of 4.5.x Content Search Engine and 
that you have existing collections.

• If you intend to remove Content Engine, skip to step 4.

• The paths listed in this procedure assume you have used the suggested install path. If you 
have installed to another location, substitute the path as appropriate.

To remove Autonomy K2 and CBR

1. Launch Enterprise Manager.

2. Disable CBR for any classes that have been enabled for CBR.

a. Right-click the class you want to configure and click Properties.

b. Click the General tab.

c. Clear the CBR Enabled checkbox and click OK.

d. A dialog will ask if you wish to propagate this change to the subclasses of this class, click 
Yes.

e. Repeat this procedure to disable CBR for all classes.

3. Run an index job and re-index any of the following that were previously enabled:

• Document

• Annotation

• Custom Object

• Folder

This will disable all full-text indexing and content-based retrieval settings and will delete any 
associated collections. Once the indexing job is complete, proceed to step 4.
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4. As k2_os_user, log on to each machine in your IBM FileNet Content Search Engine 
configuration, starting with the Master Administration Server, and remove the Autonomy K2 
software installation as follows:

Windows

a. Access the Add or Remove Programs control panel and select IBM FileNet Content Search 
Engine.

b. Click Change/Remove.

UNIX

a. Access opt/verity/appser/bin

b. Stop the Autonomy K2 Administration Server service and the Tomcat application server. Use 
the following command, according to your environment:

HP-UX

/verity_install_directory/k2/_hpux/bin/k2adminstop

AIX

/verity_install_directory/k2/_hpux/bin/_rs6k43/bin/k2adminstop

Solaris

/verity_install_directory/k2/_hpux/bin/_ssol26/bin/k2adminstop

Linux

/verity_install_directory/k2/_hpux/bin/_ilnx21/bin/k2adminstop

c. Change directory to:

 /opt/verity/_cseuninst

d. Execute the following command:

./CSE_uninstaller

5. Delete the install directory.
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Remove Process Engine (Windows)
This task includes Process Engine removal instructions for Windows platforms. 

CAUTION  You must remove the software in the order listed below. If you remove Image Services 
(Step 9) before you remove Process Engine (Step 3)  the Process Engine software will be left in a 
state that will not allow removal with this procedure.

To remove the Process Engine software

1. Stop all of the following components that are running. For procedures and further details, see 
the IBM FileNet P8 help topic  FileNet P8 Administration > Enterprise-wide Administration > 
Shutdown and Startup.

2. Navigate to Control Panel > Add/Remove Programs.

3. Click Remove for the Process Engine application.

4. Click Next at the Welcome screen for Process Engine uninstallation.

5. Click Next to stop FileNet BPM software components.

6. Click Uninstall to confirm you want to remove Process Engine for Windows 4.5.0 installation.

7. Indicate whether you want to reboot now or later.

8. Click Finish after you’ve read the summary information.

9. Click Remove for the FileNet Image Services 4.1.2 software.

10. Enter Yes to confirm you want to remove the Image Services software.

11. Press Enter to continue with the uninstall.

12. Close the Add/Remove snap-in.

13. Close the Control Panel.

Component Server

Process Simulator Process Simulator

Process Analyzer Process Analyzer

Component Manager Application Engine

Application Engine Application Engine

Content Engine Content Engine

Process Service Process Engine

Process Task Manager Process Engine or Application Engine
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CAUTION  (SQL Server only) If you plan to reinstall Process Engine and will configure Process 
Engine to use a different SQL database, you must remove the database that was configured for 
the Process Engine installation. In addition, you must remove the following FileNet user IDs from 
the SQL Server Security folder before you reinstall  Process Engine software: 

• f_sw

• f_maint
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Remove Process Engine (UNIX)
This task includes Process Engine removal instructions for UNIX platforms.

To remove the Process Engine software

1. Stop all of the following components that are running. For procedures and further details, see 
the IBM FileNet P8 help topic  FileNet P8 Administration > Enterprise-wide Administration > 
Shutdown and Startup. 

2. Enter the following after the FileNet software is shut down: 

killfnsw -A -D -y 

3. Log on to the Process Engine server as the root user.

4. On AIX, execute the following:

slibclean

5. If the /fnsw/_pws_uninst2 directory exists, run the following command:

/fnsw/_pws_uninst2/pws_uninstall.bin

Otherwise run:

/fnsw/_pws_uninst/pws_uninstall.bin

6. Follow the prompts on the screen to remove the Process Engine software.

7. At a command prompt, run the following script:

/fnsw/etc/uninstall

The uninstall script shuts down the Process Engine software, removes the software from the /
fnsw directory, and removes the directory structure under /fnsw. The uninstall script removes the 
Process Engine entries in the /etc/services, /etc/system, /etc/inittab and /etc/
devlink.tab files. On an AIX-based Process Engine, the script also removes smit entries. 

Component Server

Process Simulator Process Simulator

Process Analyzer Process Analyzer

Component Manager Application Engine

Application Engine Application Engine

Content Engine Content Engine

Process Service Process Engine

Process Task Manager Process Engine or Application Engine
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Remove Application Engine (WebSphere)
This task includes Application Engine removal instructions for WebSphere on UNIX and Windows 
platforms.

To remove the Application Engine software

1. Log on to the application server.

UNIX

Log on as a user with write access to the /bin directory. 

Windows

Log on as a member of the local Administrators group or a user with equivalent permissions.

2. Log in to the WebSphere administrative console.

3. Uninstall the Workplace application.

a. Stop the Workplace process in the admin console.

b. Uninstall the Workplace application from Enterprise Applications. 

4. Navigate to the /_uninst folder under the Application Engine installation location.

5. Run the uninstall program: 

UNIX

uninstaller.bin

Windows

uninstaller.exe

NOTE For Windows, you can also use Add/Remove Programs from the Control Panel to 
remove the IBM FileNet Application Engine.

On Windows, when you click Next on the Application Engine Uninstaller Welcome screen, the second 
screen asks you to wait while Windows Task Manager service shuts down before continuing the 
uninstall. This can take a few moments. Wait for the shutdown to complete, then complete the uninstall 
wizard from the next screen.

6. Delete the Workplace folder:

WAS_HOME/temp/node_name/application_server_name/Workplace

7. Delete the AE_install_path directory. 

8. (If Application Engine is the only IBM FileNet P8 application installed on the server) Search for 
the vpd.properties file. If it exists, delete it.

WARNING  In the following step, do not remove the system environment variable if any other 
IBM FileNet P8 application is installed on the server.
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9. (UNIX) Remove the P8TASKMAN_HOME system environment variable.

If Application Engine is the only IBM FileNet P8 application running on the server you must 
remove the P8TASKMAN_HOME system environment variable to complete the uninstallation.
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Remove Application Engine (WebLogic)
This task includes Application Engine removal instructions for WebLogic on UNIX and Windows 
platforms.

To remove the Application Engine software

1. Log on to the application server.

UNIX

Log on as a user with write access to the /bin directory. 

Windows

Log on as a member of the local Administrators group or a user with equivalent permissions.

2. Undeploy the Workplace application.

a. Stop the Workplace Web Application Module.

b. Delete the Workplace Web Application Module.

3. Navigate to the /_uninst folder under the Application Engine installation location.

4. Run the uninstall program:

UNIX

uninstaller.bin

Windows

uninstaller.exe

NOTE For Windows, you can also use Add/Remove Programs from the Control Panel to 
remove Application Engine.

On Windows, when you click Next on the Application Engine Uninstaller Welcome screen, the second 
screen asks you to wait while Windows Task Manager service shuts down before continuing the 
uninstall. This can take a few moments. Wait for the shutdown to complete, then complete the uninstall 
wizard from the next screen.

5. Delete the AE_install_path directory. 

6. (If Application Engine is the only IBM FileNet P8 application installed on the server) Search for 
the vpd.properties file. If it exists, delete it.

7. (UNIX) Remove the P8TASKMAN_HOME system environment variable.

If Application Engine is the only IBM FileNet P8 application running on the server you must 
remove the P8TASKMAN_HOME system environment variable to complete the uninstallation.

WARNING  Do not remove the system environment variable if any other IBM FileNet P8 
application is installed on the server.
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Remove Application Engine (JBoss)
This task includes Application Engine removal instructions for JBoss on Linux and Windows 
platforms.

To remove the Application Engine software

1. Log on to the application server:

UNIX

Log on as a user with write access to the /bin directory. 

Windows

Log on as a member of the local Administrators group or a user with equivalent permissions.

2. Shut down JBoss.

3. Navigate to the /_uninst folder under the Application Engine installation location. 

4. Run the uninstall program:

UNIX

uninstaller.bin

Windows

uninstaller.exe

NOTE For Windows, you can also use Add/Remove Programs from the Control Panel to 
remove Application Engine.

On Windows, when you click Next on the Application Engine Uninstaller Welcome screen, the second 
screen asks you to wait while Windows Task Manager service shuts down before continuing the 
uninstall. This can take a few moments. Wait for the shutdown to complete, then complete the uninstall 
wizard from the next screen.

5. (If Application Engine is the only IBM FileNet P8 application installed on the server) Search for 
the vpd.properties file. If it exists, delete it.

6. (UNIX and LINUX) Remove the P8TASKMAN_HOME system environment variable.

If Application Engine is the only IBM FileNet P8 application running on the server you must 
remove the P8TASKMAN_HOME system environment variable to complete the uninstallation.

WARNING  Do not remove the system environment variable if any other IBM FileNet P8 
application is installed on the server.
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7. Remove temporary files and directories.

a. Remove the Workplace.war folder from JBoss_HOME\server\default\deploy\.

b. Remove the Temp working directory for Workplace from 
JBoss_HOME\server\server_name\work\MainEngine\localhost\

8. Delete the AE_install_path directory. 
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Remove the Application Engine ISRA servlet
This task includes Application Engine ISRA Servlet removal instructions for Windows and UNIX 
environments.

NOTE  Since the installed names for the ISRA Servlet are configurable on the supported 
application servers, the information below may not be the same as your environment. Make the 
appropriate name changes as required for your environment.

To remove the Application Engine Servlet software

1. Log on to the application server.

UNIX

Log on as a user with write access to the /bin directory and the directory where ISRA Servlet 
is installed.

Windows

Log on as a user with Administrative rights.

2. Undeploy the ApplicationEngineISRAServlet application. This step is similar to that required to 
undeploy the Workplace application. 

WebSphere

a. Stop the ApplicationEngineISRAServlet process in the Admin console.

b. Uninstall the ApplicationEngineISRAServlet application from Enterprise Applications.

WebLogic

a. Stop the ApplicationEngineISRAServlet Web Application Module.

b. Undeploy or delete the ApplicationEngineISRAServlet Web Application Module.

JBoss

a. Shut down JBoss.

3. Navigate to the /_uninstISRA directory under the ISRA Servlet installation location.

4. Run the uninstall program:

UNIX

uninstall.bin

Windows

uninstall.exe

NOTE For Windows, you can also use Add/Remove Programs from the Control Panel to remove the 
FileNet Application Engine ISRA Servlet.

5. Navigate to the /FileNet directory. If there is no other FileNet software installed under this 
directory, delete the /FileNet directory. If there is some other FileNet software installed under 
this directory, delete only the /ApplicationEngineISRAServlet subdirectory.
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6. (WebSphere only) Delete the following temporary working folders for the Application Engine 
ISRA Servlet:

WAS_Home\WebSphere\AppServer\profiles\default\installedApps\servername\ApplicationE
ngineISRAServlet.ear\
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Appendixes

This appendix section contains the following major topics:

• “Configuration Manager user interface reference” on page 645

• “Configuration Manager command-line reference” on page 695

• “Encrypt passwords” on page 700

• “New Content Engine classes and properties” on page 702

• “Manually redeploy Content Engine” on page 721
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Configuration Manager reference
Configuration Manager is a tool for configuring and deploying new or upgraded instances of the 
Content Engine application on an application server. This reference appendix provides details 
about the tool in the following general topics:

• “Overview of Configuration Manager” on page 639

• “Handling passwords in Configuration Manager” on page 643

• “Configuration Manager user interface reference” on page 645

• “Configuration Manager command-line reference” on page 695
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Overview of Configuration Manager
Configuration Manager prepares the Content Engine application instance for deployment on the 
application server and deploys the application. Configuration Manager creates one or more 
unique Content Engine configuration profiles. Each profile is a collection of information required to 
complete any one of the following actions:

• Configure and deploy a new Content Engine Server instance.

• Configure and deploy an upgraded Content Engine Server instance. 

• Create the JDBC data sources for a Content Engine object store database or tablespace.

Configuration profile concepts
The information for a profile is collected in XML files in the form of properties and values that 
describe the associated configuration and deployment tasks. You must provide values for the 
profile properties that are specific to each configuration at your site, such as the application 
server name. The XML files are stored in a directory that is unique to a given profile. Because the 
profile name is used for the directory name, you must provide a profile name that is a valid 
directory name for your operating system. By default, the profiles are stored in the
ce_install_path/tools/configure/profiles directory, where ce_install_path is the 
location where Content Engine server software is installed.

If needed, you can create multiple profiles, each of which supports a unique Content Engine 
instance. These instances can be located on the same server or on different servers, depending 
on your deployment preferences, the managed or non-managed nature of your application 
servers, and your clustering or high-availability requirements. 

Use the Configuration Manager tool to perform the following tasks that are associated with a 
Content Engine configuration profile:

• Set the application server properties. Content Engine will be deployed as an application on the 
application server. You need to specify the application server type, the software version 
number, the server name, the administrative user name and password, and other settings. The 
application server type determines some of the properties and their default values. All profiles 
include the application server properties. By default, the application server properties are 
stored in the ce_install_path/tools/configure/profiles/myprofile/
applicationserver.xml file, where myprofile is the name of your profile.

You provide the application server properties when you create a profile using the New 
Configuration Profile Wizard, and you can edit the application server properties at any time as 
needed. See “Creating a new profile” on page 651 or “Editing the application server properties” on 
page 662 for detailed procedures.

• Configure the Java Database Connectivity (JDBC) data sources. The JDBC data source 
information is used by Content Engine to connect to Global Configuration Data (GCD) and 
object store databases. The application server uses the JDBC data source information to 
connect Content Engine to the database. You need to specify the JDBC provider type, the 
database name, the database user name and password, and other settings. The JDBC 
provider type determines some of the properties and their default values. When you create a 
new profile for a Content Engine instance, configure the GCD data source settings first. Then 
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create another profile for the object store data source and select only the Configure JDBC 
task for the profile. You will need to create a separate profile for each additional object store 
data source. By default, the JDBC properties are stored in the ce_install_path/tools/
configure/profiles/myprofile/configurejdbc.xml file, where myprofile is the name 
of your profile.

See “Editing the Configure JDBC Data Source task” on page 664 for the procedure to set the JDBC 
data source properties once you have created a profile.

• Configure the directory service (LDAP) provider. Content Engine connects to the directory 
service provider to authenticate users. Because the application server uses the directory 
service information to connect the Content Engine to the directory service provider, you 
cannot skip this task even if you have already configured your application server prior to 
installing Content Engine. You need to specify the directory service provider type, the user 
and group naming conventions for your provider, the directory service user name for the 
Content Engine to use for authentication, and other settings. The LDAP provider type that you 
select determines some of the properties and their default values. By default, the LDAP 
properties are stored in the ce_install_path/tools/configure/profiles/myprofile/
configureldap.xml file, where myprofile is the name of your profile.

See “Editing the Configure LDAP task” on page 669 for the procedure to set the LDAP properties 
once you have created a profile.

• Configure the Content Engine bootstrap settings. The bootstrap information is needed for 
creating the GCD and for starting Content Engine. By default, the bootstrap properties are 
stored in the ce_install_path/tools/configure/profiles/myprofile/
configurebootstrap.xml file, where myprofile is the name of your profile.

See “Editing the Configure Bootstrap Properties settings” on page 680 for the procedure to set the 
bootstrap properties once you have created a profile.

• Deploy the Content Engine application. This action deploys the Content Engine EAR file with 
the JDBC, LDAP, and bootstrap settings on the application server. Any time that you update 
the properties for an existing deployed Content Engine instance or update the Process Engine 
Client files on the Content Engine, you must redeploy for the changes to take effect. By 
default, the deployment properties are stored in the ce_install_path/tools/configure/
profiles/myprofile/deployapplication.xml file, where myprofile is the name of your 
profile. 

NOTE Once the Content Engine application is deployed, you use Enterprise Manager to 
customize Content Engine for your site’s requirements.

See “Editing the Deploy Application task” on page 682 for the procedure to edit the deployment 
properties once you have created a profile.

• Check the status of a particular configuration task. Status messages are displayed when you 
run a task. You can also explicitly display the task status any time after you run the task. See 
“Checking the task status and session logs” on page 693.

• Configure a profile for upgrading an existing Content Engine from version 3.5.x or 4.0.x. 
An upgrade profile includes the Upgrade Bootstrap task and the Deploy Application task.  By 
default, the upgrade bootstrap properties are stored in the ce_install_path/tools/
configure/profiles/myprofile/upgradebootstrap.xml file, and the deployment 
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properties are stored in the ce_install_path/tools/configure/profiles/myprofile/
deployapplication.xml file, where myprofile is the name of your profile.

See “To create a new profile for an upgrade” on page 655 for a detailed procedure.

Using the graphical and command-line user interfaces
Configuration Manager has a graphical user interface (GUI) and a command-line interface (CLI). 
Both versions of the tool create the configuration XML files with the property values specific to 
your site, run tasks to apply your settings, display task status results, and deploy the Content 
Engine application. The GUI version of the tool displays the properties and default values that you 
need to set. When you save your changes in the GUI tool, the configuration XML files are updated 
for you. If you use the CLI version of the tool, you must first generate the configuration XML files 
with the tool, and then manually edit the default values in the files using a text editor. After you 
edit the files, you use Configuration Manager to execute the tasks to apply the saved settings. 
Once you have set the required values, you use either version of Configuration Manager to deploy 
the Content Engine application. 

The configuration XML files that you create with either version of the Configuration Manager tool 
can be used with the other version. For example, you can create the files with the CLI version, and 
then use the GUI version to open the profile, edit the values, and run the configuration tasks. 

NOTE  The GUI version and the CLI version handle passwords differently. For information on how 
to work with passwords in Configuration Manager, see “Handling passwords in Configuration 
Manager” on page 643.

Gathering Configuration Manager values using the Installation and 
Upgrade Worksheet
Refer to “Installation and upgrade worksheet” on page 229 in Plan and Prepare Your Environment for 
IBM FileNet P8 for details on how to gather the values to supply to Configuration Manager.

HINT  To quickly see only the properties you must specify for Configuration Manager in the default 
worksheet file (p8_worksheet.xls), perform the following actions:

• Click the AutoFilter drop-down arrow in the "Installation or Configuration Program" column header 
and select one of these Configuration Manager options:

– CM: Set Application Server Properties

– CM: Configure JDBC Data Sources

– CM: Configure LDAP

– CM: Configure Bootstrap Properties

– CM: Upgrade Bootstrap Properties

– CM: Deploy Application

• Click the AutoFilter drop-down arrow in the "Setup Type" column header, select Custom, and 
specify one of the following, depending on the properties to set:
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• For CM: Set Application Server Properties, specify Setup Type contains "Installation, 
Upgrade".

• For CM: Configure JDBC Data Sources, specify Setup Type contains "Installation".

• For CM: Configure LDAP, specify Setup Type contains "Installation".

• For CM: Configure Bootstrap Properties, specify Setup Type contains "Installation".

• For CM: Upgrade Bootstrap Properties, specify Setup Type contains "Upgrade”.

• For CM: Deploy Application, specify Setup Type contains "Installation, Upgrade".

• Click the AutoFilter drop-down arrow in all other column headers, and select (All).
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Handling passwords in Configuration Manager
To provide the highest possible security, Configuration Manager's default settings do not save 
passwords from the GUI application. The password save setting is controlled by the 
cm.allowPasswordSave key in the application's config.ini file. While the default setting 
provides greater password security, it does require you to reenter all necessary passwords each 
time you start the GUI. When you close Configuration Manager, the passwords are removed from 
memory. When you open Configuration Manager again to run a saved task, you will need to 
reenter each of the following passwords to run the tasks:

• The application server administrator password. Select File > Update Application Server 
Properties to enter the password.

• The database administrator password. Edit the Configure JDBC Data Sources task.

• The directory service bind user password. Edit the Configure LDAP task.

• The bootstrap user password and the master key. Edit the Configure Bootstrap task.

The Configuration Manager command line passes the passwords from an XML configuration file to 
the required application when you execute a task, but does not save or change password entries 
in the XML configuration file. When you edit the XML configuration file, you can enter either an 
encrypted password or a plain text password. However, plain text passwords are not 
recommended. For the procedure to encrypt passwords for the XML file, see “Encrypt passwords” 
on page 700.

If you later use the Configuration Manager GUI to open a profile with an XML configuration file 
that you manually edited, the GUI version reads the passwords in the XML file, and will overwrite 
the existing passwords when you save the file. If the GUI is not configured to save passwords 
(default setting), the passwords in the XML file will be overwritten with a blank entry. If the GUI is 
configured to save passwords, the original values or any changed values are encrypted and saved 
to the XML file.

To change the password save option for the graphical user interface

1. If Configuration Manager is running, close the application.

2. Use a text editor to open the ce_install_path/tools/configure/CMUI/configuration/
config.ini file, where ce_install_path is the location where Content Engine server software is 
installed.

3. Change the setting for cm.allowPasswordSave as follows:

• To save passwords entered in the GUI, use cm.allowPasswordSave=true.

• To not save passwords (default), use cm.allowPasswordSave=false.

4. Save the file.

5. Restart the Configuration Manager GUI.
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Accessing the Configuration Manager log files
Configuration Manager maintains three types of log files:

• The Configuration Manager session log file. The session log contains brief information about 
the tasks that were run in the current session of the Configuration Manager graphical user 
interface (GUI). As you run additional tasks for the same or a different profile, new messages 
are added to the log. The messages in the session log are not time-stamped. When you exit 
Configuration Manager, the session log is cleared. You can view the session log from within 
the GUI, or you can open the session log file in a text editor:

ce_install_path/tools/configure/logs/P8ConfigMgr_Console.log  

For more information on viewing the session log, see “To view the session log” on page 693.

• The Configuration Manager error log. The error log contains details about any error occurring 
during execution of a task. The error messages are time-stamped, and include more 
information than is displayed in the session log. Unlike the session log, the error log is 
cumulative and contains data for more than one session. You can open the error log file in a 
text editor:

ce_install_path/tools/configure/logs/P8Installer_common.log error.

• Task status file. When you run a task in Configuration Manager, the task execution messages 
are displayed in the Console pane (GUI) or on the command line (CLI), and the status 
messages are written to a text file in the following directory:

ce_install_path/tools/configure/profiles/myprofile/status  

The file name is based on the task that was run. You can check the status on a task at any 
time to review the status completion messages. For more information on checking the task 
status from the GUI, see “To check the status of a task” on page 693. For more information on 
checking the task status from the CLI, see “Configuration Manager syntax” on page 695.
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Configuration Manager user interface reference
The Configuration Manager graphical user interface (GUI) lets you create, view, and edit your 
Content Engine configuration profile. You can also make a copy of an existing profile, run 
configuration tasks, view the session logs, and check the status of a particular task. 

NOTE  If you need an accessible version of Configuration Manager, use the command line 
interface instead of the GUI. See “Configuration Manager command-line reference” on page 695.

Starting and stopping Configuration Manager
Configuration Manager is installed by the Content Engine installation program.

To start Configuration Manager

• Run one of the following commands, depending on the operating system that runs on the 
machine where you installed Content Engine:

UNIX

ce_install_path/tools/configure/CMUI/cmui

where ce_install_path is the location where Content Engine server software is installed

Windows

Perform one of the following actions:

– Double-click the FileNet Configuration Manager desktop shortcut. 

– Select Start > All Programs > IBM FileNet P8 Platform > FileNet Configuration Manager. 

– Run ce_install_path\tools\configure\CMUI\cmui.exe.

where ce_install_path is the location where Content Engine server software is installed

To stop Configuration Manager

• Select File > Exit.

If you have not saved your changes, you will be prompted to save them when you exit 
Configuration Manager.
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Configuration Manager window
The initial Configuration Manager window consists of the Content Engine Task View pane on the 
left side, the Task Editor pane on the upper right side, and the Console pane in the lower right 
side. The following table describes each pane:

If you close a pane, you can restore it by using the Window > Show View command.

Pane Description

Content Engine Task View Displays a profile and the tasks for that profile. Only one 
profile can be open at a time.

Task Editor Displays the properties and values for a selected task. 
The Task Editor pane is empty until a specific task is 
selected from the Content Engine Task View pane. Each 
open task is displayed in a separate tab in the Task Editor 
pane. More than one Task tab can be displayed at a time.

Console Displays task execution messages, results from the 
Check Status command, or the session log.
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Main toolbar
The Main toolbar is located just below the menu bar. The Main toolbar contains the following icons 
for working with your profiles:

Icon Command name and Description

Create a Configuration Profile

Click this icon to create a new configuration profile. The current 
configuration profile will be closed, and the New Configuration Profile 
Wizard starts. If the existing open profile has been changed, you will be 
prompted to save your changes.

Create Upgrade Configuration Profile

Click this icon to create a configuration profile for upgrading an existing 
Content Engine server. The current configuration profile will be closed, 
and if there have been changes, you will be prompted to save your 
changes. The New Configuration Profile Wizard starts.

Open a Configuration Profile

Click this icon to open an existing profile. The current configuration 
profile will be closed, and if there have been changes, you will be 
prompted to save your changes. The New Configuration Profile Wizard 
starts.

Update Application Server Properties

Click this icon to view or edit the application server properties for the 
current profile.

Run All Tasks

Click this icon to run all the enabled tasks for the current profile.

Click the down arrow to the right of this icon to select a single task to 
run.

Save

Click this icon to save the current configuration profile settings.

View Configuration Manager Log File

Click this icon to view the Configuration manager session log. The 
session log is cleared when you open Configuration Manager.
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Profile toolbar
The Profile toolbar is located at the upper right of the Content Engine Task View pane. The Profile 
toolbar contains the following icons for working with a selected profile:

Icon Command name and Description

Edit the Selected Task

Click this icon to open the task in the Task Editor pane to view or edit the 
property values for that task.

Run a Single Task

Click this icon to run the selected task.

Check the Status of the Selected Task 

Click this icon to display the task status in the Console pane. The Check 
Status results are the same as shown from the command line.
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Console toolbar
The Console toolbar is located at the upper right of the Console pane. The Console toolbar 
contains the following icons for working with the Console pane:

Icon Command name and Description

Clear Console

Click this icon to clear the display for the currently active tab in the 
Console pane. Clearing the display does not affect any log contents.

Scroll Lock

Click this icon to enable or disable the scroll bars for the currently active 
tab in the Console pane. When the scroll bars are locked, information in 
the console might scroll out of view.

Pin Console

Click this icon to lock or unlock the current console location. When 
pinned (or locked), you cannot move the Console pane to a new location 
or resize the Console pane.

Display Selected Console

Click this icon to select the console tab to display. Select the desired tab 
from the list of recently viewed consoles.

Open Console

Click this icon to new tab with the current Console view. For example, 
you can open a second tab for execution messages for the Deploy 
Application task. 
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Menus and commands

Menu and command names Description

File Provides commands for creating, saving, or opening a 
configuration profile.

New Configuration Profile Creates a new configuration profile. See “Creating a new 
profile” on page 651 for detailed procedures to create a 
profile.

Create Upgrade Configuration 
Profile

Creates a profile for upgrading Content Engine. See 
“Creating a new profile” on page 651 for detailed procedures 
to create a profile.

Open Configuration Profile Opens an existing profile for viewing or editing.

Keyboard shortcut: Ctrl+O

Close Configuration Profile Closes the current configuration profile.

Save Saves your changes to the active task.

Keyboard shortcut: Ctrl+S

Save All Saves your changes to all open tasks.

Keyboard shortcut: Ctrl+Shift+S

Save Copy of Profile As Saves the current profile with a new name or path.

Update Application Server 
Properties

Displays the application server settings for the current 
profile for you to edit. See “Editing the application server 
properties” on page 662 for the detailed procedure to 
update the application server properties for an existing 
profile.

Keyboard shortcut: Ctrl+U

Run All Runs all the tasks in the profile to apply your settings. If 
the Task Enabled setting is turned off for a particular task, 
that task is skipped when you select Run All Tasks.

Keyboard shortcut: Ctrl+R

Exit Closes Configuration Manager.

Window Provides commands that give you access to logs and 
various views of information.

View Log File Displays the session log in the Console pane. The 
session log lists results from tasks that you have run 
since you started Configuration Manager.

Show View Provides a list of views available.Use to restore a view 
that you closed previously. 
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Working with Configuration Manager
The following procedures explain how to use the Configuration Manager commands, icons, and 
panes to work with your profiles and configuration tasks. 

Configuring a Content Engine instance
You must complete the following steps in Configuration Manager to configure a Content Engine 
instance:

1. Create a configuration profile. See “Creating a new profile” on page 651.

2. Edit the configuration tasks included in the profile. See one or more of the following:

• “Editing the Configure JDBC Data Source task” on page 664

• “Editing the Configure LDAP task” on page 669

• “Editing the Configure Bootstrap Properties settings” on page 680

• (Upgrades only) “Editing the Upgrade Bootstrap settings” on page 681

3. Apply the configuration settings by running the tasks. See “Running a task” on page 692.

4. Deploy the application by running the Deploy Application task. Because deployment can take a 
long time, it is a best practice to run the Deploy Application task after you have completed all 
other configuration tasks. See “Editing the Deploy Application task” on page 682.

Creating a new profile
You can create a new configuration profile or a upgrade profile.

To create a new configuration profile

1. Create a new profile using one of these methods:

• Click Create a Configuration Profile in the toolbar.

• Select File > New Configuration Profile.

2. If a profile is already open, the Action Required message box opens. Respond to the messages 
as follows:

a. Click Yes to continue creating a new profile, or click No to cancel. 

b. If you selected Yes and your current profile has any unsaved changes, the Save Resource 
message box opens. Click Yes to save your changes, click No to continue without saving 
your changes, or click Cancel.

Help Provides information about the Configuration Manager 
application.

About Configuration Manager Opens a page that provides the copyright and related 
information about Configuration Manager.

Menu and command names Description
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The Create New Configuration Profile Wizard opens. Use the following table to complete the 
wizard screens:

In this screen... Perform this action...

Configuration Profile 
Information

• Provide the following information for the profile:

– Enter a name for the profile. The name must be valid as 
a directory name for your operating system. 
Configuration Manager will create a directory with the 
profile name for storing the configuration files 
associated with this profile. For more information of 
profiles, see “Configuration profile concepts” on page 639.

– Specify the path for the profile. Either type in the full path 
to the profile directory or click Browse to locate the 
directory. The default path is 
ce_install_path/tools/configure/profiles, 
where ce_install_path is the location where Content 
Engine is installed.

• Click Next.

• Choose an application server type for the profile. Select 
WebSphere, JBoss, or WebLogic, and then click Next.

NOTE  If you click Finish instead of Next, you will need to 
come back later to supply the required application server 
properties before you can run the configuration tasks.

• Continue at one of the following screens:

– “Set Application Server Properties for WebSphere” on 
page 653

– “Set Application Server Properties for JBoss” on page 654

– “Set Application Server Properties for WebLogic” on 
page 654
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Set Application Server 
Properties for 
WebSphere

This screen is displayed only if you selected WebSphere in the 
previous screen. 

• Provide the following information for the application server:

– Select the application server version from the list.

– Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the 
directory. 

– Enter the application server administrator user name. 
Use the directory service user account that has been 
assigned the application server administrative role. This 
account is used to manage the application server 
domain/profile, to configure the data sources and 
connection pools for the GCD, and to deploy the Content 
Engine application. If Administrative Security is already 
enabled, use an existing administrative user account.

– Enter the application server administrative password. 
The password will be encrypted for you. For more 
information on passwords,  see “Handling passwords in 
Configuration Manager” on page 643.

– Enter the application server SOAP port number.

– Enter the name of the WebSphere application server 
cell where Content Engine will be deployed.

– If you have already configured WebSphere to use 
certificates, clear the “Do not use SSL certificates for 
server communications” check box. Otherwise, leave the 
check box selected. 

NOTE  Selecting this check box will change your 
WebSphere settings for communicating with other 
servers, such as Application Engine.

• Click Next.

• Continue with “Select the tasks that you want included in the 
Configuration Profile” on page 655.

In this screen... Perform this action...
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Set Application Server 
Properties for JBoss

This screen is displayed only if you selected JBoss in the 
previous screen. 

• Provide the following information for the application server:

– Select the application server version from the list.

– Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the 
directory. 

– Enter the name of the JBoss application server name 
where Content Engine will be deployed.

• Click Next.

• Continue with “Select the tasks that you want included in the 
Configuration Profile” on page 655.

Set Application Server 
Properties for WebLogic

This screen is displayed only if you selected WebLogic in the 
previous screen.

• Provide the following information for the application server:

– Select the application server version from the list.

– Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the 
directory. 

– Enter the application server administrator user name. 
Use the directory service user account that has been 
assigned the application server administrative role. This 
account is used to manage the application server 
domain/profile, to configure the data sources and 
connection pools for the GCD, and to deploy the Content 
Engine application. If Administrative Security is already 
enabled, use an existing administrative user account.

– Enter the application server administrative password. 
The password will be encrypted for you. For more 
information on passwords,  see “Handling passwords in 
Configuration Manager” on page 643.

– Enter the application server SOAP port number.

– Enter the machine name or the IP address of the local 
host for the application server host. 

– Enter the fully qualified path to the WebLogic application 
server user projects directory, or click Browse to locate 
the directory.

In this screen... Perform this action...
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The profile you created will be displayed as an icon in the left-hand pane, along with icons for 
the tasks for the tasks you selected. The default profile contains the following tasks:

• Configure JDBC Data Sources

• Configure LDAP

• Configure Bootstrap Properties

• Deploy Application

To create a new profile for an upgrade

Use the following procedure to create a profile for upgrading Content Engine. You use the upgrade 
configuration profile to update the existing Content Engine bootstrap properties and deploy the 
updated EAR file. In order to create an upgrade profile, the Content Engine installation program 
must have detected an existing Content Engine installation.

1. Start the Create a Profile Wizard using one of these methods:

• Click Create a Configuration Profile for Upgrade in the toolbar.

• Select File > Create Upgrade Configuration Profile.

Set Application Server 
Properties for WebLogic 
(continued)

– Enter the WebLogic application server domain name 
where Content Engine will be deployed.

– Enter the name of the WebLogic application server 
name where Content Engine will be deployed.

• Click Next.

• Continue with “Select the tasks that you want included in the 
Configuration Profile” on page 655.

Select the tasks that you 
want included in the 
Configuration Profile

• Select the tasks that you want to include in this profile. For a 
new Content Engine installation, you need to complete all 
four configuration tasks: 

– Configure JDBC Data Sources

– Configure LDAP

– Configure Bootstrap

– Deploy Application

• Click Finish to create the profile and save the application 
server properties.

In this screen... Perform this action...
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2. If a profile is already open, the Action Required message box opens. Respond to the messages 
as follows:

a. Click Yes to continue creating a new profile, or click No to cancel. 

b. If you selected Yes and your current profile has any unsaved changes, the Save Resource 
message box opens. Click Yes to save your changes, click No to continue without saving 
your changes, or click Cancel.

3. Complete the wizard screens as follows:

In this screen... Perform this action...

Upgrade Profile Path • Provide the following information for the profil

– Enter a name for the profile. The name must be valid as 
a directory name for your operating system. 
Configuration Manager will create a directory with the 
profile name for storing the configuration files 
associated with this profile. For more information of 
profiles, see “Configuration profile concepts” on page 639.

– Specify the path for the profile. Either type in the full path 
to the profile directory or click Browse to locate the 
directory. The default path is ce_install_path/tools/
configure/profiles, where ce_install_path is the 
location where Content Engine is installed.

• Click Next.

Upgrade Configuration 
Profile Creation 
Summary

• Review the summary information.

• Click Next.

• Continue at one of the following screens:

– “Set Application Server Properties for WebSphere” on 
page 653

– “Set Application Server Properties for JBoss” on page 654

– “Set Application Server Properties for WebLogic” on 
page 654
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Set Application Server 
Properties for 
WebSphere

This screen is displayed only if you selected WebSphere in the 
previous screen. 

Provide the following information for the application server”

• Select the application server version from the list.

• Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the directory. 

• Enter the application server administrator user name. Use 
the directory service user account that has been assigned 
the application server administrative role. This account is 
used to manage the application server domain/profile, to 
configure the data sources and connection pools for the 
GCD, and to deploy the Content Engine application. If 
Administrative Security is already enabled, use an existing 
administrative user account.

• Enter the application server administrative password. The 
password will be encrypted for you. For more information on 
passwords,  see “Handling passwords in Configuration 
Manager” on page 643.

• Enter the application server SOAP port number.

• Enter the name of the WebSphere application server cell 
where Content Engine will be deployed.

• If you have already configured WebSphere to use 
certificates, clear the “Do not use SSL certificates for server 
communications” check box. Otherwise, leave the check box 
selected. 

NOTE  Selecting this check box will change your 
WebSphere settings for communicating with other servers, 
such as Application Engine.

• Click Finish.

In this screen... Perform this action...
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Set Application Server 
Properties for JBoss

This screen is displayed only if you selected JBoss in the 
previous screen. 

Provide the following information for the application server:

• Select the application server version from the list.

• Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the directory. 

• Enter the name of the JBoss application server name where 
Content Engine will be deployed.

• Click Finish.

In this screen... Perform this action...
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The profile you created is displayed as an icon in the left-hand pane with the name that was 
presented in the confirmation screen, along with icons for the Upgrade Bootstrap task and the 
Deploy Application task. 

Set Application Server 
Properties for WebLogic

This screen is displayed only if you selected WebLogic in the 
previous screen.

Provide the following information for the application server:

• Select the application server version from the list.

• Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the directory. 

• Enter the application server administrator user name. Use 
the directory service user account that has been assigned 
the application server administrative role. This account is 
used to manage the application server domain/profile, to 
configure the data sources and connection pools for the 
GCD, and to deploy the Content Engine application. If 
Administrative Security is already enabled, use an existing 
administrative user account.

• Enter the application server administrative password. The 
password will be encrypted for you. For more information on 
passwords,  see “Handling passwords in Configuration 
Manager” on page 643.

• Enter the application server SOAP port number.

• Enter the machine name or the IP address of the local host 
for the application server host. 

• Enter the fully qualified path to the WebLogic application 
server user projects directory, or click Browse to locate the 
directory.

• Enter the WebLogic application server domain name where 
Content Engine will be deployed.

• Enter the name of the WebLogic application server name 
where Content Engine will be deployed.

• Click Finish.

In this screen... Perform this action...
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Opening and closing an existing profile or task
You can save a profile, and open it later to edit the saved settings or to run tasks.

To open an existing profile

You can have one profile open at a time in Configuration Manager.

1. Start the Open Configuration Profile Wizard using one of these methods:

• Click Open a Configuration Profile in the toolbar.

• Select File > Open Configuration Profile.

2. If a profile is already open, the Action Required message box opens. Respond to the messages 
as follows:

a. Click Yes to continue creating a new profile, or click No to cancel. 

b. If you selected Yes and your profile has any unsaved changes, the Save Resource message 
box opens. Click Yes to save your changes, click No to continue without saving your 
changes, or click Cancel.

3. Either type in the full path to the profile directory, or click Browse to select the Profile directory. 
Select the desired profile from the Browse for Directory dialog box, and click OK.

4. Click Finish.

To open a task

More than one task tab can be open at a time in the Task Editor pane.

1. If the profile is collapsed in the Content Engine Task View pane, click + next to the profile name 
to expand it.

2. Use one of the following methods to open the desired task:

• Click the task name in the Content Engine Task View pane, and then click Edit Selected Task in 
the Profile toolbar.

• Double-click the task name in the Content Engine Task View pane. A new tab opens in the Task 
Editor pane for the selected task. You can then view and edit the values displayed in the Task 
Editor pane.

To switch between open tasks in the Task Editor pane

• Click the tab name in the Task Editor pane for the desired task.

To close a profile

• Select File > Close Configuration Profile.

You will be prompted to save any changes when you close a profile. Passwords are removed from 
memory when you close a profile.
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To close a task

1. If the task is not the actively selected task, click the tab name in the Task Editor pane for the 
desired task.

2. Click Close in the tab for the task. 

If you have made changes to the task property settings, the Save Resource message box 
opens. 

3. Respond to the messages as follows:

• Click Yes to save the changes and close the profile.

• Click No to close the profile without saving your changes.

• Click Cancel to cancel. 
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Editing the application server properties
You initially provide the application server properties when you create a new profile. You can open 
the application server properties for editing at any time. The application server properties must be 
set before you run any tasks. You cannot change the application server type for an existing profile.

To edit the application server properties

1. Click Update Application Server Properties in the main toolbar, or select File > Update 
Application Server properties. 

2. Provide values for the application server, using the following table:

In this screen... Provide this information...

Set Application Server 
Properties for 
WebSphere

This screen is displayed only if you selected WebSphere when 
you created the profile. 

• Select the application server version from the list.

• Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the directory. 

• Enter the application server administrator user name, for 
example, ce_appserver_admin. Use the directory service 
user account that has been assigned the application server 
administrative role. This account is used to manage the 
application server domain/profile, to configure the data 
sources and connection pools for the GCD, and to deploy 
the Content Engine application. If Administrative Security is 
already enabled, use an existing administrative user 
account.

• Enter the application server administrative password. The 
password will be encrypted for you. For more information on 
passwords,  see “Handling passwords in Configuration 
Manager” on page 643.

• Enter the application server SOAP port number.

• Enter the name of the WebSphere application server cell 
where Content Engine will be deployed.

• If you have already configured WebSphere to use 
certificates, clear the “Do not use SSL certificates for server 
communications” check box. Otherwise, leave the check box 
selected. 

NOTE  Selecting this check box will change your 
WebSphere settings for communicating with other servers, 
such as Application Engine.
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3. Click Finish.

Set Application Server 
Properties for JBoss

This screen is displayed only if you selected JBoss when you 
created the profile. 

• Select the application server version from the list.

• Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the directory. 

• Enter the name of the JBoss application server name where 
Content Engine will be deployed.

Set Application Server 
Properties for WebLogic

This screen is displayed only if you selected WebLogic when 
you created the profile.

• Select the application server version from the list.

• Enter the fully qualified path to the application server 
installation directory, or click Browse to locate the directory. 

• Enter the application server administrator user name, for 
example, ce_appserver_admin. Use the directory service 
user account that has been assigned the application server 
administrative role. This account is used to manage the 
application server domain/profile, to configure the data 
sources and connection pools for the GCD, and to deploy 
the Content Engine application. If Administrative Security is 
already enabled, use an existing administrative user 
account.

• Enter the application server administrative password. The 
password will be encrypted for you. For more information on 
passwords,  see “Handling passwords in Configuration 
Manager” on page 643.

• Enter the application server SOAP port number.

• Enter the machine name or the IP address of the local host 
for the application server host. 

• Enter the fully qualified path to the WebLogic application 
server user projects directory, or click Browse to locate the 
directory.

• Enter the WebLogic application server domain name where 
Content Engine will be deployed.

• Enter the name of the WebLogic application server name 
where Content Engine will be deployed.

In this screen... Provide this information...
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Editing the Configure JDBC Data Source task
The JDBC data source information is used by Content Engine to connect to Global Configuration 
Data (GCD) and object store databases. You should maintain a separate profile for each data 
source.

To edit the JDBC data source settings

1. Double-click Configure JDBC Data Sources in the Content Engine Task View pane to open the 
task for editing. 

2. Provide the property values for your database, using the appropriate table for your database 
type:

DB2® for Linux, UNIX, Windows

In this field... Provide this information...

JDBC driver name Select “DB2 Universal JDBC Driver” from the list. The remaining 
properties and values that you need to supply for your data 
source configuration depend on the type of driver that you select.

JDBC data source name The JNDI name of the non-XA JDBC data source associated 
with the GCD tablespace or database. For example, FNGCDDS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated with 
the GCD tablespace or database. For example, FNGCDDSXA.

Database server name The host name of the machine where the database software is 
installed.

Database port number The port number used by the DB2 database instance in which 
you create tablespaces for the GCD and object stores.

Database name The name of the GCD or object store database. 

Database user name The name of the DB2 GCD or object store tablespace user.

Database password The password for the DB2 GCD or object store tablespace user. 
The tool encrypts the password for you.

Enter the password again in the Confirm field.

JDBC data source file 
name

The JDBC data source file name for configuring Content Engine 
to communicate with the tablespace associated with the GCD or 
object store. The file name must end with 
-ds.xml. For example, gcd-ds.xml. 

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with the 
GCD or object store. The file name must end with 
-ds.xml. For example, gcd-ds.xml. 
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DB2 for z/OS®

Task enabled Turn on the Task enabled check box to execute the configure 
JDBC Data Sources task later. The default is enabled.

In this field... Provide this information...

JDBC driver name Select “DB2 for z/OS Universal JDBC Driver” from the list. The 
remaining properties and values that you need to supply for your 
data source configuration depend on the type of driver that you 
select.

JDBC data source name The JNDI name of the non-XA JDBC data source associated 
with the GCD or object store tablespace or database. For 
example, FNGCDDS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated with 
the GCD or object store tablespace or database. For example, 
FNGCDDSXA.

Database server name The host name of the machine where the database software is 
installed.

Database port number The port number used by the DB2 database instance in which 
you create tablespaces for the GCD and object stores.

Database name The name of the GCD or object store database instance name. 

Database user name The name of the DB2 GCD or object store tablespace user.

Database password The password for the DB2 GCD or object store tablespace user. 
The tool encrypts the password for you.

Enter the password again in the Confirm field.

JDBC data source file 
name

The JDBC data source file name for configuring Content Engine 
to communicate with the tablespace associated with the GCD or 
object store. The file name must end with 
-ds.xml. For example, gcd-ds.xml. 

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with the 
GCD or object store. The file name must end with -ds.xml. For 
example, gcd-ds.xml. 

Task enabled Turn on the Task enabled check box to execute the configure 
JDBC Data Sources task later. The default is enabled.

In this field... Provide this information...
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MS SQL Server

In this field... Provide this information...

JDBC driver name Select “Microsoft JDBC Driver 2005” from the list. The remaining 
properties and values that you need to supply for your data 
source configuration depend on the type of driver that you select.

JDBC data source name The JNDI name of the non-XA JDBC data source associated 
with the GCD or object store tablespace or database. For 
example, FNGCDDS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated with 
the GCD or object store tablespace or database. For example, 
FNGCDDSXA.

Database server name The host name of the machine where the database software is 
installed.

Database port number The port number used by the SQL Server database instance in 
which you create databases for the GCD and object stores.

Database name The name of the GCD or object store database for SQL Server.

Database user name The name of the SQL Server user with administrative rights to 
the GCD or object store database.

Database password The password for the SQL Server user with administrative rights 
to the GCD or object store database. The tool encrypts the 
password for you.

Enter the password again in the Confirm field.

JDBC data source file 
name

The JDBC data source file name for configuring Content Engine 
to communicate with the tablespace associated with the GCD or 
object store. The file name must end with 
-ds.xml. For example, gcd-ds.xml. 

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with the 
GCD or object store. The file name must end with 
-ds.xml. For example, gcd-ds.xml. 

Task enabled Turn on the Task enabled check box to execute the configure 
JDBC Data Sources task later. The default is enabled.
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Oracle (not RAC support)

In this field... Provide this information...

JDBC driver name Select “Oracle JDBC Driver” from the list. The remaining 
properties and values that you need to supply for your data 
source configuration depend on the type of driver that you select.

JDBC data source name The JNDI name of the non-XA JDBC data source associated 
with the GCD or object store tablespace or database. For 
example, FNGCDDS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated with 
the GCD or object store tablespace or database. For example, 
FNGCDDSXA.

Database server name The host name of the machine where the database software is 
installed.

Database port number The port number used by the Oracle database instance in which 
you create tablespaces for the Global Configuration Data (GCD) 
and object stores.

Database name The SID of the Oracle database containing the GCD or object 
store tablespace.

Database user name The name of the Oracle GCD or object store tablespace owner.

Database password The password for the Oracle GCD or object store tablespace 
owner. The tool encrypts the password for you.

Enter the password again in the Confirm field.

JDBC data source file 
name

The JDBC data source file name for configuring Content Engine 
to communicate with the tablespace associated with the GCD or 
object store. The file name must end with 
-ds.xml. For example, gcd-ds.xml. 

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with the 
GCD or object store. The file name must end with 
-ds.xml. For example, gcd-ds.xml. 

Task enabled Turn on the Task enabled check box to execute the configure 
JDBC Data Sources task later. The default is enabled.
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Oracle RAC

In this field... Provide this information...

JDBC driver name Select “Oracle JDBC Driver (RAC support)” from the list. The 
remaining properties and values that you need to supply for your 
data source configuration depend on the type of driver that you 
select.

JDBC data source name The JNDI name of the non-XA JDBC data source associated 
with the GCD or object store tablespace or database. For 
example, FNGCDDS.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated with 
the GCD or object store tablespace or database. For example, 
FNGCDDSXA.

Database server name 
RAC node 1

The host name of the machine where the database software is 
installed for node 1.

Database port number 
RAC node 1

The port number used by the Oracle database instance in which 
you create tablespaces for the Global Configuration Data (GCD) 
and object stores.

Database server name 
RAC node 2

The host name of the machine where the database software is 
installed for node 2.

Database port number 
RAC node 2

The port number used by the Oracle database instance in which 
you create tablespaces for the Global Configuration Data (GCD) 
and object stores.

Database service name The SID of the Oracle database containing the GCD or object 
store tablespace.

Oracle RAC retries The number of retries for Oracle RAC.

Oracle RAC delay The amount of delay for Oracle RAC.

Database user name The name of the Oracle GCD or object store tablespace owner.

Database password The password for the Oracle GCD or object store tablespace 
owner. The tool encrypts the password for you.

Enter the password again in the Confirm field.

JDBC data source file 
name

The JDBC data source file name for configuring Content Engine 
to communicate with the tablespace associated with the GCD or 
object store. The file name must end with 
-ds.xml. For example, gcd-ds.xml. 

JDBC XA data source file 
name

The JDBC XA data source file name for configuring Content 
Engine to communicate with the tablespace associated with the 
GCD or object store. The file name must end with 
-ds.xml. For example, gcd-ds.xml. 
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c. Select File > Save to save your changes.

To apply the JDBC data source settings

1. Apply the JDBC property settings by right-clicking Configure JDBC Data Sources in the Content 
Engine Task View pane, and selecting Run Task. Running the configuration task can take a few 
minutes. The task execution status messages are displayed in the Console pane below the 
JDBC data source  properties.

2. Close the Configure JDBC Data Sources task pane.

Editing the Configure LDAP task
The LDAP information is used to connect Content Engine to the directory service provider to 
authenticate users. Because the application server uses the directory service information to 
connect the Content Engine to the directory service provider, you cannot skip this task even if you 
have already configured your application server prior to installing Content Engine.

To edit the LDAP settings

1. Double-click Configure LDAP in the Content Engine Task View pane to open the task for editing. 

2. Provide the property values for your LDAP provider, using the appropriate table for your 
provider.

Tivoli® Directory Server

Task enabled Turn on the Task enabled check box to execute the configure 
JDBC Data Sources task later. The default is enabled.

In this field... Provide this information...

Directory service 
provider type

Select “Tivoli Directory Server” from the list. The remaining 
properties and values that you need to supply for your LDAP 
configuration depend on the type of provider that you select.

Directory service server 
host name

The directory server host name. The short name, full name, or 
IP address of the system that hosts the directory service. 

Directory service port 
number

The port number configured on the directory server host for 
communicating with the directory server.

Directory service bind 
user name

The fully qualified distinguished name of the LDAP bind user for 
authenticating to Tivoli Directory Server.

Directory service bind 
user password

The password used by the LDAP bind user to authenticate to 
the directory server. The tool encrypts the password for you.

Enter the password again in the Confirm field.

In this field... Provide this information...
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User base distinguished 
name

The fully qualified distinguished name of the container for 
starting a user search in Tivoli Directory Server. For example, 
ou=FileNet,dc=FNCE.

User filter The filter used by the bind user when searching for users in a 
directory server. For example, (cn={0}).

Group base 
distinguished name

JBoss only. The distinguished name of the container for 
starting a group search in a directory server. For example, 
cn=users,dc=mydomain.

Group filter The filter used by the bind user when searching for groups in a 
directory server. For example, (member={1}).

User name attribute WebSphere and WebLogic. The attribute by which a user logs 
on to Tivoli Directory Server. For example, cn.

Group attribute An attribute in a Tivoli Directory Server entry that identifies the 
group. For example, cn.

Administrative console 
user name

WebSphere only. A user account that has access to log on to 
the application server administration console. If your site uses a 
Federated LDAP registry, this account name must be a unique 
user across all federated realms. 

WebSphere LDAP 
repository type

WebSphere only. The WebSphere Application Server LDAP 
repository type. Valid values are: StandaloneLDAP / 
FederatedLDAP.

Federated Repository 
virtual realm name

WebSphere only. The name of the WebSphere Application 
Server Federated Repositories virtual realm.  The default name 
is defaultWIMFileBasedRealm.

Overwrite existing 
repository

WebSphere only. Select this check box to overwrite any existing 
LDAP repository entries. Clear this check box to preserve any 
existing LDAP repository entries. This setting is valid only when 
the Standard deployment type is selected for the WebSphere 
LDAP repository type field. The default is clear (do not 
overwrite).

Set as current active 
user registry

WebSphere only. This setting specifies whether to set the LDAP 
repository as the active user registry. When set to true, the 
LDAP information will be used to configure the active user 
registry.

In this field... Provide this information...
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Active Directory

Script WebSphere and WebLogic. The fully qualified path to the LDAP 
configuration task script. The task script filename depends on 
the application server type selected.

WebSphere Application Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWSLDAP.tcl  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\configureWSLDAP.tcl.

WebLogic Server example: /opt/FileNet/ContentEngine/
tools/configure/scripts/configureWLLDAP.py  or  
c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\configureWLLDAP.py.

Temporary Directory WebSphere and WebLogic. The fully qualified path to a 
temporary directory to be used by the configuration task. For 
example, /opt/FileNet/ContentEngine/tools/configure/
tmp  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp.

SSL enabled WebSphere and WebLogic. This setting specifies whether 
Secure Sockets Layer (SSL) is enabled or disabled. Select the 
check box to enable SSL. Clear the check box to  disable SSL. 
The default is disabled.

Kerberos support JBoss only. Select the Kerberos support check box if Kerberos 
authentication is used. Clear the check box if Kerberos 
authentication is not used. The default is Kerberos not 
supported.

Task enabled Select the Task enabled check box to execute the configure 
LDAP task later. The default is enabled.

In this field... Provide this information...

Directory service 
provider type

Select “Active Directory” from the list. The remaining properties 
and values that you need to supply for your LDAP configuration 
depend on the type of provider that you select.

Directory service server 
host name

The directory server host name. The short name, full name, or 
IP address of the system that hosts the directory service. 

In this field... Provide this information...
IBM FILENET P8 PLATFORM INSTALLATION AND UPGRADE GUIDE



 Configuration Manager user interface reference
To edit the LDAP settings

672
Directory service port 
number

The port number configured on the directory server host for 
communicating with the directory server.

Directory service bind 
user name

The fully qualified distinguished name of the LDAP bind user for 
authenticating to Active Directory.

Directory service bind 
user password

The password used by the LDAP bind user to authenticate to 
the directory server. The tool encrypts the password for you.

Enter the password again in the Confirm field.

User base distinguished 
name

The fully qualified distinguished name of the container for 
starting a user search in Active Directory. For example, 
ou=FileNet,dc=FNCE.

User filter The filter used by the bind user when searching for users in 
Active Directory. For example, (sAMAccountName={0}).

Group base 
distinguished name

JBoss only. The distinguished name of the container for 
starting a group search in a directory server. For example, 
cn=users,dc=mydomain.

Group filter The filter used by the bind user when searching for groups in a 
directory server. For example, (member={1}).

User name attribute WebSphere and WebLogic. The attribute by which a user logs 
on to Tivoli Directory Server. For example, cn.

Group attribute An attribute in a Tivoli Directory Server entry that identifies the 
group. For example, cn.

Administrative console 
user name

WebSphere only. A user account that has access to log on to 
the application server administration console. If your site uses a 
Federated LDAP registry, this account name must be a unique 
user across all federated realms. 

WebSphere LDAP 
repository type

WebSphere only. The WebSphere Application Server LDAP 
repository type. Valid values are: StandaloneLDAP / 
FederatedLDAP.

Federated Repository 
virtual realm name

WebSphere only. The name of the WebSphere Application 
Server Federated Repositories virtual realm.  The default name 
is defaultWIMFileBasedRealm.

Overwrite existing 
repository

WebSphere only. Select this check box to overwrite any existing 
LDAP repository entries. Clear this check box to preserve any 
existing LDAP repository entries. This setting is valid only when 
the Standard deployment type is selected for the WebSphere 
LDAP repository type field. The default is clear (do not 
overwrite).

In this field... Provide this information...
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Set as current active 
user registry

WebSphere only. This setting specifies whether to set the LDAP 
repository as the active user registry. When set to true, the 
LDAP information will be used to configure the active user 
registry.

Script WebSphere and WebLogic. The fully qualified path to the LDAP 
configuration task script. The task script filename depends on 
the application server type selected.

WebSphere Application Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWSLDAP.tcl  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\configureWSLDAP.tcl.

WebLogic Server example: /opt/FileNet/ContentEngine/
tools/configure/scripts/configureWLLDAP.py  or  
c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\configureWLLDAP.py.

Temporary Directory WebSphere and WebLogic. The fully qualified path to a 
temporary directory to be used by the configuration task. For 
example, /opt/FileNet/ContentEngine/tools/configure/
tmp  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp.

SSL enabled WebSphere and WebLogic. This setting specifies whether 
Secure Sockets Layer (SSL) is enabled or disabled. Select the 
check box to enable SSL. Clear the check box to  disable SSL. 
The default is disabled.

Kerberos support JBoss only. Select the Kerberos support check box if Kerberos 
authentication is used. Clear the check box if Kerberos 
authentication is not used. The default is Kerberos not 
supported.

Task enabled Select the Task enabled check box to execute the configure 
LDAP task later. The default is enabled.

In this field... Provide this information...
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ADAM or AD LDS

In this field... Provide this information...

Directory service 
provider type

Select “ADAM or AD LDS” from the list. The remaining properties 
and values that you need to supply for your LDAP configuration 
depend on the type of provider that you select.

Directory service server 
host name

The directory server host name. The short name, full name, or 
IP address of the system that hosts the directory service. 

Directory service port 
number

The port number configured on the directory server host for 
communicating with the directory server.

Directory service bind 
user name

The fully qualified distinguished name of the LDAP bind user for 
authenticating to ADAM or AD LDS.

Directory service bind 
user password

The password used by the LDAP bind user to authenticate to 
the directory server. The tool encrypts the password for you.

Enter the password again in the Confirm field.

User base distinguished 
name

The fully qualified distinguished name of the container for 
starting a user search in ADAM or AD LDS. For example, 
ou=FileNet,dc=FNCE.

User filter The filter used by the bind user when searching for users in a 
directory server. For example, (cn={0}).

Group base 
distinguished name

JBoss only. The distinguished name of the container for 
starting a group search in a directory server. For example, 
cn=users,dc=mydomain.

Group filter The filter used by the bind user when searching for groups in a 
directory server. For example, (member={1}).

User name attribute WebSphere and WebLogic. The attribute by which a user logs 
on to Tivoli Directory Server. For example, cn.

Group attribute An attribute in a Tivoli Directory Server entry that identifies the 
group. For example, cn.

Administrative console 
user name

WebSphere only. A user account that has access to log on to 
the application server administration console. If your site uses a 
Federated LDAP registry, this account name must be a unique 
user across all federated realms. 

WebSphere LDAP 
repository type

WebSphere only. The WebSphere Application Server LDAP 
repository type. Valid values are: StandaloneLDAP / 
FederatedLDAP.

Federated Repository 
virtual realm name

WebSphere only. The name of the WebSphere Application 
Server Federated Repositories virtual realm.  The default name 
is defaultWIMFileBasedRealm.
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Overwrite existing 
repository

WebSphere only. Select this check box to overwrite any existing 
LDAP repository entries. Clear this check box to preserve any 
existing LDAP repository entries. This setting is valid only when 
the Standard deployment type is selected for the WebSphere 
LDAP repository type field. The default is clear (do not 
overwrite).

Set as current active 
user registry

WebSphere only. This setting specifies whether to set the LDAP 
repository as the active user registry. When set to true, the 
LDAP information will be used to configure the active user 
registry.

Script WebSphere and WebLogic. The fully qualified path to the LDAP 
configuration task script. The task script filename depends on 
the application server type selected.

WebSphere Application Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWSLDAP.tcl  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\configureWSLDAP.tcl.

WebLogic Server example: /opt/FileNet/ContentEngine/
tools/configure/scripts/configureWLLDAP.py  or  
c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\configureWLLDAP.py.

Temporary Directory WebSphere and WebLogic. The fully qualified path to a 
temporary directory to be used by the configuration task. For 
example, /opt/FileNet/ContentEngine/tools/configure/
tmp  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp.

SSL enabled WebSphere and WebLogic. This setting specifies whether 
Secure Sockets Layer (SSL) is enabled or disabled. Select the 
check box to enable SSL. Clear the check box to  disable SSL. 
The default is disabled.

Kerberos support JBoss only. Select the Kerberos support check box if Kerberos 
authentication is used. Clear the check box if Kerberos 
authentication is not used. The default is Kerberos not 
supported.

Task enabled Select the Task enabled check box to execute the configure 
LDAP task later. The default is enabled.

In this field... Provide this information...
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eDirectory

In this field... Provide this information...

Directory service 
provider type

Select eDirectory from the list. The remaining properties and 
values that you need to supply for your LDAP configuration 
depend on the type of provider that you select.

Directory service server 
host name

The directory server host name. The short name, full name, or 
IP address of the system that hosts the directory service. 

Directory service port 
number

The port number configured on the directory server host for 
communicating with the directory server.

Directory service bind 
user name

The fully qualified distinguished name of the LDAP bind user for 
authenticating to eDirectory.

Directory service bind 
user password

The password used by the LDAP bind user to authenticate to 
the directory server. The tool encrypts the password for you.

Enter the password again in the Confirm field.

User base distinguished 
name

The fully qualified distinguished name of the container for 
starting a user search in eDirectory. For example, 
ou=FileNet,dc=FNCE.

User filter The filter used by the bind user when searching for users in a 
directory server. For example, (cn={0}).

Group base 
distinguished name

JBoss only. The distinguished name of the container for 
starting a group search in a directory server. For example, 
cn=users,dc=mydomain.

Group filter The filter used by the bind user when searching for groups in a 
directory server. For example, (member={1}).

User name attribute WebSphere and WebLogic. The attribute by which a user logs 
on to Tivoli Directory Server. For example, cn.

Group attribute An attribute in a Tivoli Directory Server entry that identifies the 
group. For example, cn.

Administrative console 
user name

WebSphere only. A user account that has access to log on to 
the application server administration console. If your site uses a 
Federated LDAP registry, this account name must be a unique 
user across all federated realms. 

WebSphere LDAP 
repository type

WebSphere only. The WebSphere Application Server LDAP 
repository type. Valid values are: StandaloneLDAP / 
FederatedLDAP.

Federated Repository 
virtual realm name

WebSphere only. The name of the WebSphere Application 
Server Federated Repositories virtual realm.  The default name 
is defaultWIMFileBasedRealm.
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Overwrite existing 
repository

WebSphere only. Select this check box to overwrite any existing 
LDAP repository entries. Clear this check box to preserve any 
existing LDAP repository entries. This setting is valid only when 
the Standard deployment type is selected for the WebSphere 
LDAP repository type field. The default is clear (do not 
overwrite).

Set as current active 
user registry

WebSphere only. This setting specifies whether to set the LDAP 
repository as the active user registry. When set to true, the 
LDAP information will be used to configure the active user 
registry.

Script WebSphere and WebLogic. The fully qualified path to the LDAP 
configuration task script. The task script filename depends on 
the application server type selected.

WebSphere Application Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWSLDAP.tcl  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\configureWSLDAP.tcl.

WebLogic Server example: /opt/FileNet/ContentEngine/
tools/configure/scripts/configureWLLDAP.py  or  
c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\configureWLLDAP.py.

Temporary Directory WebSphere and WebLogic. The fully qualified path to a 
temporary directory to be used by the configuration task. For 
example, /opt/FileNet/ContentEngine/tools/configure/
tmp  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp.

SSL enabled WebSphere and WebLogic. This setting specifies whether 
Secure Sockets Layer (SSL) is enabled or disabled. Select the 
check box to enable SSL. Clear the check box to  disable SSL. 
The default is disabled.

Kerberos support JBoss only. Select the Kerberos support check box if Kerberos 
authentication is used. Clear the check box if Kerberos 
authentication is not used. The default is Kerberos not 
supported.

Task enabled Select the Task enabled check box to execute the configure 
LDAP task later. The default is enabled.

In this field... Provide this information...
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Sun Java Directory Server

In this field... Provide this information...

Directory service 
provider type

Select “Sun Java Directory Server” from the list. The remaining 
properties and values that you need to supply for your LDAP 
configuration depend on the type of provider that you select.

Directory service server 
host name

The directory server host name. The short name, full name, or 
IP address of the system that hosts the directory service. 

Directory service port 
number

The port number configured on the directory server host for 
communicating with the directory server.

Directory service bind 
user name

The fully qualified distinguished name of the LDAP bind user for 
authenticating to Sun Java Directory Server.

Directory service bind 
user password

The password used by the LDAP bind user to authenticate to 
the directory server. The tool encrypts the password for you.

Enter the password again in the Confirm field.

User base distinguished 
name

The fully qualified distinguished name of the container for 
starting a user search in Sun Java Directory Server. For example, 
ou=FileNet,dc=FNCE.

User filter The filter used by the bind user when searching for users in a 
directory server. For example, (cn={0}).

Group base 
distinguished name

JBoss only. The distinguished name of the container for 
starting a group search in a directory server. For example, 
cn=users,dc=mydomain.

Group filter The filter used by the bind user when searching for groups in a 
directory server. For example, (member={1}).

User name attribute WebSphere and WebLogic. The attribute by which a user logs 
on to Tivoli Directory Server. For example, cn.

Group attribute An attribute in a Tivoli Directory Server entry that identifies the 
group. For example, cn.

Administrative console 
user name

WebSphere only. A user account that has access to log on to 
the application server administration console. If your site uses a 
Federated LDAP registry, this account name must be a unique 
user across all federated realms. 

WebSphere LDAP 
repository type

WebSphere only. The WebSphere Application Server LDAP 
repository type. Valid values are: StandaloneLDAP / 
FederatedLDAP.

Federated Repository 
virtual realm name

WebSphere only. The name of the WebSphere Application 
Server Federated Repositories virtual realm.  The default name 
is defaultWIMFileBasedRealm.
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Overwrite existing 
repository

WebSphere only. Select this check box to overwrite any existing 
LDAP repository entries. Clear this check box to preserve any 
existing LDAP repository entries. This setting is valid only when 
the Standard deployment type is selected for the WebSphere 
LDAP repository type field. The default is clear (do not 
overwrite).

Set as current active 
user registry

WebSphere only. This setting specifies whether to set the LDAP 
repository as the active user registry. When set to true, the 
LDAP information will be used to configure the active user 
registry.

Script WebSphere and WebLogic. The fully qualified path to the LDAP 
configuration task script. The task script filename depends on 
the application server type selected.

WebSphere Application Server example: /opt/FileNet/
ContentEngine/tools/configure/scripts/
configureWSLDAP.tcl  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\configureWSLDAP.tcl.

WebLogic Server example: /opt/FileNet/ContentEngine/
tools/configure/scripts/configureWLLDAP.py  or  
c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\configureWLLDAP.py.

Temporary Directory WebSphere and WebLogic. The fully qualified path to a 
temporary directory to be used by the configuration task. For 
example, /opt/FileNet/ContentEngine/tools/configure/
tmp  or  c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp.

SSL enabled WebSphere and WebLogic. This setting specifies whether 
Secure Sockets Layer (SSL) is enabled or disabled. Select the 
check box to enable SSL. Clear the check box to  disable SSL. 
The default is disabled.

Kerberos support JBoss only. Select the Kerberos support check box if Kerberos 
authentication is used. Clear the check box if Kerberos 
authentication is not used. The default is Kerberos not 
supported.

Task enabled Select the Task enabled check box to execute the configure 
LDAP task later. The default is enabled.

In this field... Provide this information...
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3. Select File > Save to save your changes.

To apply the LDAP settings

1. Apply the LDAP property settings by right-clicking Configure LDAP in the Content Engine Task 
View pane, and select Run Task. Running the configuration task can take a few minutes. The 
task execution status messages are displayed in the Console pane below the LDAP properties.

2. Close the Configure LDAP task pane.

Editing the Configure Bootstrap Properties settings
The bootstrap information is needed for creating the GCD and for starting Content Engine. 

To edit the bootstrap properties settings

1. Double-click Configure Bootstrap Properties in the Content Engine Task View pane to open the 
task for editing. 

2. Provide the bootstrap property values, using the following table.

In this field... Provide this information...

Content Engine EAR 
path

The fully qualified path to the Content Engine EAR file that was 
installed by the Content Engine installation program. For 
example, /opt/FileNet/ContentEngine/lib/Engine-ws.ear  or  
c:\Program Files\FileNet\ContentEngine\lib\Engine-ws.ear.

JDBC data source name The JNDI name of the non-XA JDBC data source associated 
with the GCD tablespace or database. For example, 
FNGCDDSXA.

JDBC XA data source 
name

The JNDI name of the XA JDBC data source associated with 
the GCD tablespace or database. For example, FNGCDDSXA.

Bootstrapped EAR 
directory

The name of a subdirectory that will store the EAR file that 
contains the Content Engine bootstrap information. The 
bootstrap information is needed for creating the GDC and for 
starting Content Engine. Specify the directory relative to the 
ce_install_path/lib directory. For example, to specify /opt/
FileNet/ContentEngine/lib/bootstrap, enter "bootstrap".

Bootstrap user name The name of a directory server user that accesses the GCD 
data sources. Use only the short name of the bind user defined 
by the LDAP user attribute. For example, 'administrator'.

Bootstrap password The password for the directory server user that accesses the 
Global Configuration Data (GCD) data sources. The tool encrypts 
the password for you.
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3. Select File > Save to save your changes.

To apply the bootstrap properties settings

1. Apply the bootstrap property settings by right-clicking Configure Bootstrap Properties in the 
Content Engine Task View pane, and select Run Task. Running the configuration task can take 
a few minutes. The task execution status messages are displayed in the Console pane below the 
bootstrap properties.

2. Close the Configure Bootstrap properties task pane.

Editing the Upgrade Bootstrap settings
The upgrade bootstrap information is needed for completing an upgrade of Content Engine. 

To edit the upgrade bootstrap properties settings

1. Double-click Upgrade Bootstrap Properties in the Content Engine Task View pane to open the 
task for editing. 

Master key A word or phrase of any length that is used to encrypt sensitive 
GCD entries. The tool encrypts the password for you.

The master key is used to configure the GCD settings for the 
Content Engine bootstrap settings. Store the master key in a 
secure location, as it is not retrievable. You will have to specify 
it later any time you access the GCD with applications built with 
non-FileNet APIs. 

Web Services HTTP port The Content Engine Web Services HTTP port number. The 
Content Engine Web Service (CEWS) is an industry standards-
conformant SOAP interface to the FileNet Content Engine. It 
allows applications to access most of the functionality available 
through the Content Engine APIs. The default is 9080. For a 
cluster deployment, this port number must be the same value 
on each server in the cluster. 

Task enabled Turn on the Task enabled check box to execute the configure 
LDAP task. The default is enabled.

In this field... Provide this information...
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2. Provide the bootstrap property values, using the following table.

3. Select File > Save to save your changes.

To apply the upgrade bootstrap properties settings

1. Apply the bootstrap property settings by right-clicking Upgrade Bootstrap in the Content Engine 
Task View pane, and selecting Run Task. Running the configuration task can take a few 
minutes. The task execution status messages are displayed in the Console pane below the 
upgrade bootstrap properties.

2. Close the Upgrade Bootstrap properties task pane.

Editing the Deploy Application task
Because deploying an application can take time, we recommend that you do not deploy the 
application until after you have installed any dependent files, such as Process Engine client files 
or customized applications for Content Engine. You can edit the deployment property values 
without applying the settings. When you apply the settings, the Content Engine is deployed as an 
application on the application server.

To edit the deploy application task settings

1. Right-click the Deploy Application task in the Content Engine Task View pane, and select Edit 
Selected Task.

2. Provide the property values for your deployment, using the appropriate table for your application 
server and deployment type (standard, network deployment, or cluster):

In this field... Provide this information...

Content Engine EAR 
path

The fully qualified path to the Content Engine EAR file that was 
installed by the Content Engine installation program. For 
example, /opt/FileNet/ContentEngine/lib/Engine-ws.ear  or  
c:\Program Files\FileNet\ContentEngine\lib\Engine-ws.ear.

Deployed Content Engine 
EAR path

The location of the deployed Content Engine EAR file (the EAR 
file that was deployed before the upgrade).

Bootstrapped EAR 
directory

The name of a subdirectory that will store the EAR file that 
contains the upgraded Content Engine bootstrap information. 
The bootstrap information is needed for creating the GDC and 
for starting Content Engine. Specify the directory relative to the 
ce_install_path/lib directory. For example, to specify 
/opt/FileNet/ContentEngine/lib/bootstrap, enter "bootstrap".

Task enabled Turn on the Task enabled check box to execute the upgrade 
bootstrap task later. The default is enabled.
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WebSphere Standard 

In this field... Provide this information...

Deployment type Select “Standard” from the list. The remaining properties and 
values that you need to supply depend on the type of deployment 
that you select.

Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
ws.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
ws.ear

Content Engine 
Application name

The Content Engine application name as it will appear in the 
application server (for example, in an administration console). 
The application name is subject to application server naming 
constraints. For WebSphere Application Server, each 
application in a cell must have unique name. The default is 
FileNetEngine. 

Application server name The name of the WebSphere Application Server where Content 
Engine will be deployed.

Application server node The name of the WebSphere Application Server node where 
Content Engine will be deployed.

Script The fully qualified path to the deploy configuration task script. 
The task script file name depends on the application server 
type selected. For example: 

UNIX

/opt/FileNet/ContentEngine/tools/configure/scripts
/deployWSApplication.tcl

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\deployWSApplication.tcl
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WebSphere Cluster 

Temporary directory The fully qualified path to a temporary directory to be used by 
the configuration task. For example:

UNIX

/opt/FileNet/ContentEngine/tools/configure/tmp 

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp

Task enabled Turn on the Task enabled check box to execute the deploy 
application task later. The default is disabled (do not execute).

In this field... Provide this information...

Deployment type Select “Cluster” from the list. The remaining properties and 
values that you need to supply depend on the type of deployment 
that you select.

Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
ws.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
ws.ear

Content Engine 
Application name

The Content Engine application name as it will appear in the 
application server (for example, in an administration console). 
The application name is subject to application server naming 
constraints. For WebSphere Application Server, each 
application in a cell must have unique name. The default is 
FileNetEngine. 

Application server cluster 
name

The name of the WebSphere Application Server cluster where 
Content Engine will be deployed.

In this field... Provide this information...
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WebSphere Network Deployment 

Script The fully qualified path to the deploy configuration task script. 
The task script file name depends on the application server 
type selected. For example: 

UNIX

/opt/FileNet/ContentEngine/tools/configure/scripts
/deployWSApplication.tcl

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\deployWSApplication.tcl

Temporary directory The fully qualified path to a temporary directory to be used by 
the configuration task. For example:

UNIX

/opt/FileNet/ContentEngine/tools/configure/tmp 

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp

Task enabled Turn on the Task enabled check box to execute the deploy 
application task later. The default is disabled (do not execute).

In this field... Provide this information...

Deployment type Select “Network Deployment” from the list. The remaining 
properties and values that you need to supply depend on the 
type of deployment that you select.

In this field... Provide this information...
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Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
ws.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
ws.ear

Content Engine 
Application name

The Content Engine application name as it will appear in the 
application server (for example, in an administration console). 
The application name is subject to application server naming 
constraints. For WebSphere Application Server, each 
application in a cell must have unique name. The default is 
FileNetEngine. 

Application server name The name of the WebSphere Application Server where Content 
Engine will be deployed.

Application server node The name of the WebSphere Application Server node where 
Content Engine will be deployed.

Script The fully qualified path to the deploy configuration task script. 
The task script file name depends on the application server 
type selected. For example: 

UNIX

/opt/FileNet/ContentEngine/tools/configure/scripts
/deployWSApplication.tcl

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\deployWSApplication.tcl

In this field... Provide this information...
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Temporary directory The fully qualified path to a temporary directory to be used by 
the configuration task. For example:

UNIX

/opt/FileNet/ContentEngine/tools/configure/tmp 

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp

Task enabled Turn on the Task enabled check box to execute the deploy 
application task later. The default is disabled (do not execute).

In this field... Provide this information...
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JBoss Standard 

JBoss Cluster 

In this field... Provide this information...

Deployment type Select “Standard” from the list. The remaining properties and 
values that you need to supply depend on the type of deployment 
that you select.

Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
jb.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
jb.ear

Kerberos support This setting specifies whether Kerberos 
authentication is used. Select the Kerberos support 
check box if Kerberos authentication is used. Clear 
the check box if Kerberos authentication is not 
used. The default is Kerberos not supported.

Task enabled Turn on the Task enabled check box to execute the deploy 
application task later. The default is disabled (do not execute).

In this field... Provide this information...

Deployment type Select “Standard” from the list. The remaining properties and 
values that you need to supply depend on the type of deployment 
that you select.
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WebLogic Standard 

Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
jbc.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
jbc.ear

Kerberos support This setting specifies whether Kerberos 
authentication is used. Select the Kerberos support 
check box if Kerberos authentication is used. Clear 
the check box if Kerberos authentication is not 
used. The default is Kerberos not supported.

Task enabled Turn on the Task enabled check box to execute the deploy 
application task later. The default is disabled (do not execute).

In this field... Provide this information...

Deployment type Select “Standard” from the list. The remaining properties and 
values that you need to supply depend on the type of deployment 
that you select.

Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
wl.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
wl.ear

In this field... Provide this information...
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WebLogic Cluster 

Content Engine 
Application name

The Content Engine application name as it will appear in the 
application server (for example, in an administration console). 
The application name is subject to application server naming 
constraints. For WebSphere Application Server, each 
application in a cell must have unique name. The default is 
FileNetEngine. 

Script The fully qualified path to the deploy configuration task script. 
The task script file name depends on the application server 
type selected. For example: 

UNIX

/opt/FileNet/ContentEngine/tools/configure/scripts
/deployWLApplication.py

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\deployWLApplication.py

Temporary directory The fully qualified path to a temporary directory to be used by 
the configuration task. For example:

UNIX

/opt/FileNet/ContentEngine/tools/configure/tmp 

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp

Task enabled Turn on the Task enabled check box to execute the deploy 
application task later. The default is disabled (do not execute).

In this field... Provide this information...

Deployment type Select “Cluster” from the list. The remaining properties and 
values that you need to supply depend on the type of deployment 
that you select.

In this field... Provide this information...
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Bootstrapped EAR path The fully qualified path to the bootstrapped Content Engine 
EAR file that was created by the configure bootstrap task. For 
example:

UNIX

 /opt/FileNet/ContentEngine/lib/bootstrap/Engine-
wl.ear 

Windows

c:\Program 
Files\FileNet\ContentEngine\lib\bootstrap\Engine-
wl.ear

Content Engine 
Application name

The Content Engine application name as it will appear in the 
application server (for example, in an administration console). 
The application name is subject to application server naming 
constraints. For WebSphere Application Server, each 
application in a cell must have unique name. The default is 
FileNetEngine. 

Script The fully qualified path to the deploy configuration task script. 
The task script file name depends on the application server 
type selected. For example: 

UNIX

/opt/FileNet/ContentEngine/tools/configure/scripts
/deployWLApplication.py

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\script
s
\deployWLApplication.py

Temporary directory The fully qualified path to a temporary directory to be used by 
the configuration task. For example:

UNIX

/opt/FileNet/ContentEngine/tools/configure/tmp 

Windows

c:\Program 
Files\FileNet\ContentEngine\tools\configure\tmp

Task enabled Turn on the Task enabled check box to execute the deploy 
application task later. The default is disabled (do not execute).

In this field... Provide this information...
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3. Select File > Save.

To deploy the application

1. Right-click the Deploy Application task in the left pane, and select Run Task.  Running the 
deployment task will take a few minutes. The task execution status messages are displayed in 
the Console pane below the Deploy Application task properties.

2. Close the Deploy Application properties task pane.

Running a task
You can run each task individually or run all tasks at once. In order to run a task, you must have 
selected the Task enabled check box for a specific task when you edited the task properties.

To run all the tasks in the profile

Use this procedure to run all tasks in a profile that have been enabled at once. Only the tasks that 
have the Task enabled check box selected will be run. Disabled tasks will not be run.

1. If the profile is collapsed in the Content Engine Task View pane, click + next to the profile name 
to expand it.

2. To run all the tasks in a profile at once, use one of the following methods to run the Run All 
Tasks command:

• Click Run All Tasks in the Content Engine Task View pane toolbar.

• Select File > Run All.

The Console pane displays the task execution messages.

NOTE  Task execution will fail if you have not entered passwords correctly during the current 
Configuration Manager session. See “Handling passwords in Configuration Manager” on page 643 
for more information.

To run a single task

You can run each task individually. Use this procedure to run a selected task that has been 
enabled. In order to run the task, you must have selected the Task enabled check box for a 
specific task when you edited the task properties.

1. If the profile is collapsed in the Content Engine Task View pane, click + next to the profile name 
to expand it.

2. Use one of the following methods to run the Run a Task command:

• Click the down arrow just to the right of the Run All Tasks icon in the Main toolbar, and then select 
the task that you want to run.

• Click the task name in the Content Engine Task View pane to select the task. Click Run a Task in 
the Profile toolbar.

• Right-click the task name in the Content Engine Task View pane, and select Run Task from the 
context menu.
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The Console pane displays the task execution messages.

NOTE  Task execution will fail if you have not entered passwords correctly during the current 
Configuration Manager session. See “Handling passwords in Configuration Manager” on page 643 
for more information.

Checking the task status and session logs
Task execution messages are displayed in the console pane when you run a task, and you can 
view the status of a specific task at any time. You can also view the Configuration Manager 
session log for information about the tasks that were run in the current session of Configuration 
Manager.

To check the status of a task

1. If the profile is collapsed in the Content Engine Task View pane, click + next to the profile name 
to expand it.

2. Use one of the following methods to run the Check Status command:

• Click the task name in the Content Engine Task View pane, and then click Check Status in the 
Content Engine Task View pane toolbar.

• Right-click the task name in the Content Engine Task View pane, and select Check Task Status 
from the context menu.

3. The console pane opens with the status listed for the selected task. 

The following table lists the status results and their descriptions. 

To view the session log

The session log contains information about the tasks that were run in the current session of 
Configuration Manager. As you run additional tasks for the same or a different profile, new 
messages are added to the log. When you exit Configuration Manager, the session log is cleared.

1. Run at least one task.

2. Use one of the following methods to run the View Log command:

• Click View Configuration Manager Log File in the Main toolbar.

• Select Window > View Log.

Status Result Description

COMPLETED The task ran successfully.

INCOMPLETE The task is incomplete.

NO STATUS AVAILABLE The task has not been run.

FAILED The task failed to complete. Additional information 
about the failure is displayed.
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The current session log is displayed in the Console pane. 

3. Running a task will replace the displayed session log with the current task status. To redisplay 
the session log, repeat Step 2 as needed.

Saving your changes to a task or profile
You can save your settings at any time.

To save your changes to the task settings

Save changes to the currently open task using one of these methods:

• Click Save in the toolbar.

• Select File > Save.

cmui.ini parameters
When you install Configuration Manager, the path to the directory that contains the Java binary to 
be used to launch the graphical user interface is added to the 
ce_install_path/tools/configure/CMUI/cmui.ini file. 

Windows example

-vm
C:\Program Files\FileNet\ContentEngine\_cejvm/bin

UNIX example

-vm
/opt/FileNet/ContentEngine/_cejvm/bin
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Configuration Manager command-line reference
Configuration Manager can be run from a command line or from a graphical user interface. This 
section covers the command-line version of Configuration Manager.

Running Configuration Manager
How you invoke Configuration Manager from the command line depends on the operating system 
of the host machine where you run it:

NOTE In the following subtopics, substitute configmgr.sh or configmgr.bat in place of configmgr.

Configuration Manager syntax
Configuration Manager uses the following syntax patterns:

• To generate a configuration XML file:

configmgr generateConfig -appserver app_server_type -db db_type -ldap ldap_type 
-deploy deploy_type -task task_name [-path mypath] [-silent]

• To execute a configuration task:

configmgr execute -task task_name [-path mypath] [-silent]

• To check the status of a configuration task that you have executed:

configmgr checkStatus [ -task taskname ] [-path mypath]

• To display a description of the settings for a configuration task:

configmgr describe -task taskname

The command names (generateConfig, execute, checkStatus, describe) are case sensitive; the 
parameter values (task_name, app_server_type, etc.) are not.

Command descriptions
The Configuration Manager commands are as follows:

checkStatus

The checkStatus command checks whether the results of executing a configuration XML file are 
correct.

execute

The execute command executes a configuration XML file. Typically, you will edit a configuration 
XML file (to insert your site-specific properties and values) before executing it.

Operating System File Name

UNIX configmgr.sh

Windows configmgr.bat
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describe

The describe command displays a description of what each task does.

generateConfig

The generateConfig command generates a configuration XML file, which depends on the task you 
specify in the command line.

Parameter descriptions
The Configuration Manager parameters are as follows:

-appserver app_server_type

The appserver_type value specifies the type of application server and must be one of the following: 
WebSphere, WebLogic, or JBoss.

-db database_type

The database_type value specifies the type of database to be used by Content Engine and must 
be one of the following: mssql, oracle, oracle_rac, db2, or db2zos. This parameter applies only to 
the generateConfig command.

-deploy deploy_type

The deploy_type value specifies the type of Content Engine deployment and applies only to the 
generateConfig command. The value must be one of the following: standard, cluster, or netdeploy 
(network deployment). 

Specify standard if you are deploying Content Engine to a standalone (that is, a server that is 
neither managed nor clustered) WebSphere, WebLogic, or JBoss application server 

Specify cluster if you are deploying Content Engine to a WebSphere, WebLogic, or JBoss 
application server cluster

Specify netdeploy if you are deploying Content Engine to a managed WebSphere application 
server instance (using Network Deployment for managing individual servers that are not 
necessarily in a cluster). 

-ldap ldap_type

The ldap_type value specifies the type of directory service repository Content Engine uses for 
authenticating users and must be one of the following: activedirectory, adam, edirectory, sunjava, 
or tivoli. The adam option applies to both Microsoft ADAM and AD LDS. This parameter applies 
only to the generateConfig command.
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-task task_name

task_name specifies which task to perform. Each task has one or more associated configuration 
XML files. The following table lists the tasks you can perform, the affected configuration XML files, 
and the contents of the files:

Task Name Configuration XML File Task Description or 
Contents of Configuration 
XML File

ConfigureApplicationServer configureapplicationserver.xml Parent configuration task 
that generates a complete 
set of configuration files. The 
parent XML file identifies the 
location of the following files: 

• configurebootstrap.xml

• configurejdbc.xml

• configureldap.xml

• deployapplication.xml

ConfigureBootstrap configurebootstrap.xml Settings for the Content 
Engine bootstrap on the 
application server. The 
bootstrap information is 
needed for creating the 
Global Configuration Data 
(GCD) and for starting 
Content Engine.

ConfigureJDBC configurejdbc.xml Settings for configuring 
JDBC data source 
connections to the Global 
Configuration Data (GCD) 
and object store databases 
that Content Engine uses.

ConfigureLDAP configureldap.xml Settings for connecting to 
and searching within a 
directory server for 
authenticating Content 
Engine users.

ConfigureDotNetAPI none Configures the Content 
Engine .Net API for client 
use.

ConfigureDotNetClient none Configures the Content 
Engine .NET API client and 
FileNet Enterprise Manager.
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NOTE The task_name parameter is not case sensitive. For example, you can enter 
ConfigureApplicationServer, Configureapplicationserver, or ConFiGureApplicationServer for the 
task_name.

-path mypath

The -path mypath entry is optional and specifies the path to the configuration XML files that the 
Configuration Manager generates, executes, or verifies, as follows:

• If mypath is an absolute path name (that is, a path that begins at the root directory), 
Configuration Manager uses mypath.

• If mypath is a relative path (that is, a path that does not begin at the root directory) or just a 
single directory name, Configuration Manager uses the following path:

CE_install_path/tools/configure/profiles/mypath

• If you omit -path mypath, Configuration Manager uses the following path:

CE_install_path/tools/configure/profiles

DeployApplication deployapplication.xml Settings for deploying the 
Content Engine instance on 
the application server.

RegisterEM none Settings for registering or 
unregistering FileNet 
Enterprise Manager from the 
Windows Registry.

Upgrade upgrade.xml Parent configuration that 
identifies the location of the 
UpgradeApplicationServer, 
and UpgradeBootstrap 
configuration XML files

UpgradeApplicationServer upgradeapplicationserver.xml Settings for upgrading 
Global Configuration Data 
(GCD) and starting Content 
Engine.

UpgradeBootstrap upgradebootstrap.xml Settings for the Content 
Engine bootstrap on the 
application server. The 
bootstrap information is 
needed for creating the 
Global Configuration Data 
(GCD) and for starting 
Content Engine.

Task Name Configuration XML File Task Description or 
Contents of Configuration 
XML File
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NOTE If you are deploying multiple Content Engine instances on the same machine, you will need 
to generate, edit, and deploy a complete set of configuration files for each instance. Store the 
configuration files for each instance in a separate directory.

-silent

The -silent parameter is optional. When -silent is specified, then no prompts or informational 
messages are displayed. Failure messages are displayed as needed. If the configuration XML file 
to be generated already exists, then the task fails if the silent switch is selected.

Configuration examples
This section provides examples for commands using the syntax described earlier.

• Generate all configuration files at once

The following command generates all the configuration XML files for a standard WebSphere 
deployment using Tivoli Directory Server and DB2 in the ce_install_path/tools/
configure/wstdb2 path:

configmgr generateConfig -appserver WebSphere -db db2 -ldap tivoli 
-deploy standard -task ConfigureApplicationServer -path wstdb2

• Generate only the configurejdbc.xml file

The following command generates only the configurejdbc.xml file for a standard 
WebSphere deployment using Tivoli Directory Server and DB2 in the ce_install_path/
tools/configure/wstdb2jdbc path:

configmgr generateConfig -appserver WebSphere -db db2 -ldap tivoli 
-deploy standard -task ConfigureJDBC -path wstdb2jdbc

• Execute only the configurejdbc.xml file

The following command executes the configurejdbc.xml file for a standard WebSphere 
deployment using Tivoli Directory Server and DB2 in the ce_install_path/tools/
configure/wstdb2jdbc path:

configmgr execute -task ConfigureJDBC -path wstdb2jdbc

• Check the status of the ConfigureJDBC task:

The following command checks the status of the ConfigureJDBC task in the 
ce_install_path/tools/configure/wstdb2jdbc path:

configmgr checkStatus -task ConfigureJDBC -path wstdb2jdbc
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Encrypt passwords
Several passwords are required to configure IBM FileNet P8 components. To accommodate your 
security requirements, you can encrypt these passwords, as follows, before you enter them into 
the resource files.

To encrypt a password for Configuration Manager

Configuration Manager and the encryption tool run only on Windows.

1. Navigate to ce_install_path/tools/configure, where ce_install_path is where 
Content Engine is installed. 

2. Run one of the following commands to generate the encrypted password:

Windows

encryptpassword.bat passwordtoencrypt

UNIX

encryptpassword.sh passwordtoencrypt

where passwordtoencrypt is the password you want to encrypt.

3. An encrypted password is generated and displayed. Copy the encrypted password and paste 
into the appropriate property in the XML configuration file.

To encrypt a password for Process Engine

1. The encryption tool is located on the installation media for Process Engine software, in the Tools 
directory. Copy the following files from the Tools directory to a local drive:

• fnencryptutils - an executable .jar file

• RunEncryptApp - a batch file

2. Run one of the following executable files to invoke the application:

Windows

RunEncryptApp.bat

UNIX 

RunEncryptApp.sh

NOTE Before running the file, be sure Java is installed and its location is in your PATH 
environment variable.

3. Enter the appropriate values for the user name and password. 

4. Reenter the password to confirm it.

5. Click Generate.
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6. An encrypted password will be generated and displayed in the encrypted password field.

7. Copy and paste this password into the appropriate configuration file.
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New Content Engine classes and properties
This appendix lists the new classes and properties that have been added to Content Engine in the 
4.0.0 and 4.5.0 release. If you have previously defined any classes or properties in a 3.5.x or 4.0.x 
object store with names that are the same as any of the class or property names listed here, it will 
not be possible to upgrade the object store to 4.5.0. The upgrade tool will check for naming 
conflicts and require you to change the names before proceeding. 

Consider the following upgrade scenarios:

• If you are upgrading from 3.5.x to 4.5.x, you must resolve conflicts between your 3.5.x names 
and the 4.0.0 names, as well as any conflicts between 3.5.x and 4.5.0 names. Consult the lists 
in both of the following sections:

– “New in Content Engine 4.0.0 (since 3.5.0)” on page 703

– “New in Content Engine 4.5.0 (since 4.0.0)” on page 716

• If you are upgrading from 4.0.x to 4.5.0, you must resolve conflicts between your 4.0.0 names 
and the 4.5.0 names. See the following section.

– “New in Content Engine 4.5.0 (since 4.0.0)” on page 716
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New in Content Engine 4.0.0 (since 3.5.0)

New Content Engine classes in 4.0.0
The following table displays the new class names in Content Engine 4.0.0. To ensure successful 
upgrade, resolve any conflicts between your 3.5.x object store class names and the new names.

* Indicates that the class name was added in IBM FileNet P8CE-4.0.1-005 fix pack.

Class Symbolic Name Class ID

AddOnInstallationRecord Add On Installation Record

AsyncProcessingConfiguration Async Processing Configuration

CenteraSiteSettings Centera Site Settings

CodeModule Code Module

ComponentRelationship Component Relationship

ContentCacheArea Content Cache Area

ContentCacheConfiguration Content Cache Configuration

ContentConfiguration Content Configuration

DatabaseStorageArea Database Storage Area

DirectoryConfiguration Directory Configuration

DirectoryConfigurationAD Directory Configuration AD

DirectoryConfigurationADAM Directory Configuration ADAM

DirectoryConfigurationCA* Directory Configuration CA

DirectoryConfigurationIBM Directory Configuration IBM

DirectoryConfigurationNovell Directory Configuration Novell

DirectoryConfigurationSunOne Directory Configuration SunOne

Domain Domain

EntireNetwork EntireNetwork

FileStorageArea File Storage Area

FixedStorageArea Fixed Storage Area

Group Group

ImageServicesClassDescription Image Services Class Description
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ImageServicesImportAgentConfiguration Image Services Import Agent 
Configuration

ImageServicesPropertyDescription Image Services Property Description

ImageServicesSiteSettings Image Services Site Settings

IndexArea Index Area

IndexJob Index Job

IndexJobClassItem Index Job Class Item

IndexJobCollectionItem Index Job Collection Item

IndexJobItem Index Job Item

IndexJobSingleItem Index Job Single Item

PEConnectionPoint [IsolatedRegion gone] PE Connection Point

PublishCompleteEvent Publish Complete Event

PublishRequestEvent Publish Request Event

PublishingConfiguration Publishing Configuration

Realm Realm

RenditionEngineConnection Rendition Engine Connection

SecurityPrincipal Security Principal

ServerCacheConfiguration Server Cache Configuration

ServerInstance Server Instance

Site Site

SiteSettings Site Settings

StorageArea Storage Area

SubsystemConfiguration Subsystem Configuration

TakeFederatedOwnershipEvent Take Federated Ownership Event

TraceLoggingConfiguration Trace Logging Configuration

UpgradeAddOn Upgrade Add On

User User

Class Symbolic Name Class ID
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New Content Engine properties in 4.0.0
The following table displays the new property names in Content Engine 4.0.0. To ensure 
successful upgrade, resolve any conflicts between your 3.x object store property names and the 
new names.

* Indicates that the property name was added in IBM FileNet P8CE-4.0.1-005 fix pack.

VerityCollection Verity Collection

VerityDomainConfiguration Verity Domain Configuration

VerityIndexArea Verity Index Area

VerityServerConfiguration Verity Server Configuration

VirtualServer Virtual Server

Property Symbolic Name Property Name

AbandonedContentCleanupInterval Abandoned Content Cleanup Interval

AbandonedDBContentCleanupInterval Abandoned Database Content Cleanup Interval

ActiveDirectorySiteDNS Active Directory Site DNS

AddOn Add On

AddOnInstallationRecords Add On Installation Records

AddOns Add Ons

AddOnName Add On Name

AllRealms All Realms

AllowFederatedDeletes Allow Federated Deletes

AllowsContentToBeCached Allows Content To Be Cached

AllowsDelete Allows Delete

APITraceFlags API Trace Flags

AppenderNames Appender Names

AsynchronousProcessingTraceFlags Asynchronous Processing Trace Flags

AuditedDeletePrefix Audited Delete Prefix

BaseClassIDs Base Class IDs

BatchDelay Batch Delay

Class Symbolic Name Class ID
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BlobReadAheadSize Blob Read Ahead Size

BlobWriteCollisionsAvoidanceFlag Blob Write Collisions Avoidance Flag

BrokerPort Broker Port

FPPoolBufferSize Buffer Size

CacheStatus Cache Status

CanAcceptForwardedRequests Can Accept Forwarded Requests

CanForwardRequests Can Forward Requests

CBRLocale CBR Locale

CBRTraceFlags CBR Trace Flags

CFSDaemonTraceFlags CFS Daemon Trace Flags

ChildComponent Child Component

ChildDocuments Child Documents

ChildRelationships Child Relationships

ChildVersionSeries Child Version Series

ClassDefinition Class Definition

ClosureDate Closure Date

FPPoolClusterNonAvailTime Cluster Nonavailable Time

CodeModule Code Module

CodeModuleCacheEntryTTL Code Module Cache Entry TTL

CodeModuleCacheMaxFileSpace Code Module Cache Maximum File Space

CodeModuleCacheMaxMemory Code Module Cache Maximum Memory

CodeModuleTraceFlags Code Module Trace Flags

CollectionName CollectionName

ComponentCascadeDelete Component Cascade Delete

ComponentPreventDelete Component Prevent Delete

ComponentRelationshipType Component Relationship Type

ComponentSortOrder Component Sort Order

CompoundDocumentState Compound Document State

Property Symbolic Name Property Name
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ConcurrentReaders Concurrent Readers

ConnectionState Connection State

ConnectionTimeout Connection Timeout

ContentCacheArea Content Cache Area

ContentCacheAreas Content Cache Areas

ContentCacheTraceFlags Content Cache Trace Flags

ContentElementCount Content Element Count

ContentElementKBytes Content Element Kbytes

ContentElementsCreated Content Elements Created

ContentElementsDeleted Content Elements Deleted

ContentQueueMaxWorkerThreads Content Queue Max Worker Threads

ContentStorageTraceFlags Content Storage Trace Flags

ContentTempDirectoryRoot Content Temp Directory Root

CSMCache CSM Cache

CurrentUser Current User

DatabaseContentUploadBufferSize Database Content Upload Buffer Size

DatabaseServerPort Database Server Port

DatabaseTraceFlags Database Trace Flags

DynamicGroupMemberAttribute* Dynamic Group Member Attribute

FPPoolDefaultCollisionAvoidance Default Collision Avoidance

DefaultISDocumentClass Default IS Document Class

DefaultRetentionDays Default Retention Days

DefaultRetentionPassThrough Default Retention Pass Through

DefaultSite Default Site

DeleteMethod Delete Method

DeviceAddress Device Address

DeviceRootDirectory Device Root Directory

DirectoryConfigurations Directory Configurations

Property Symbolic Name Property Name
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DirectoryServerHost Directory Server Host

DirectoryServerPassword Directory Server Password

DirectoryServerPort Directory Server Port

DirectoryServerProviderClass Directory Server Provider Class

DirectoryServerType Directory Server Type

DirectoryServerUserName Directory Server User Name

DirectoryStructure Directory Structure

DispatcherEnabled Dispatcher Enabled

DispatcherWaitInterval Dispatcher Wait Interval

DistinguishedName Distinguished Name

DNSName DNS Name

DocumentsPerBatch Documents Per Batch

Domain Domain

DomainID Domain ID

DynamicGroupObjectClass* Dynamic Group Object Class

EJBForwardingEndpoint EJB Forwarding Endpoint

EJBTraceFlags EJB Trace Flags

Email Email Address

EmbeddedDataThreshold Embedded Data Threshold

FPPoolEnableMulticlusterFailover Enable Multicluster Failover

EncryptionAlgorithm Encryption Algorithm

EngineTraceFlags Engine Trace Flags

ErrorCode Error Code

EventsTraceFlags Events Trace Flags

ExpiredBatchSelectionSize Expired Batch Selection Size

FixedContentDevice Fixed Content Device

FixedContentDevices Fixed Content Devices

FixedContentProviderTraceFlags Fixed Content Provider Trace Flags

Property Symbolic Name Property Name
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FolderCacheMaxAgeDelta Folder Cache Maximum Age Delta

FolderCacheMaxEntries Folder Cache Maximum Entries

FolderCacheReapFrequency Folder Cache Reap Frequency

FromVersions From Versions

FullTextRowDefault Full Text Row Default

FullTextRowMax Full Text Row Max

GCDCacheTTL GCD Cache TTL

GCDTraceFlags GCD Trace Flags

GroupBaseDN Group Base DN

GroupDisplayNameAttribute Group Display Name Attribute

GroupMembershipSearchFilter Group Membership Search Filter

GroupNameAttribute Group Name Attribute

GroupSearchFilter Group Search Filter

Groups Groups

ImageServicesClassDescriptions Image Services Class Descriptions

ImageServicesClassName Image Services Class Name

ImageServicesDataType Image Services Data Type

ImageServicesPropertyDescriptions Image Services Property Descriptions

ImageServicesPropertyName Image Services Property Name

ImplementationClass Implementation Class

ImportAgentRetryCount Import Agent Retry Count

InboundFileNameCacheMaxEntries Inbound File Name Cache Maximum Entries

IndexArea Index Area

IndexAreas Index Areas

IndexItems Index Items

IndexationID Indexation ID

InitiatingUser Initiating User

InlineContentRetrievalLimit Inline Content Retrieval Limit

Property Symbolic Name Property Name
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InstallationDate Installation Date

InstallationReport Installation Report

Installer Installer

IsCBREnabled Is CBR Enabled

ISDomainName IS Domain Name

IsFederatedOnly [IsolatedRegion gone] Is Federated Only

ISOrganization IS Organization

ISPassword IS Password

IsSSLEnabled Is SSL Enabled

ISTempDir IS Temporary Directory

ISUserName IS User Name

JNDIDataSource JNDI DataSource

JNDIXADataSource JNDI XA DataSource

JobAbortRequested Job AbortRequested

JobStatus Job Status

LabelBindValue Label Bind Value

LeaseDuration Lease Duration

LocalDomain Local Domain

MarkingSetCacheEntryTTL Marking Set Cache Entry TTL

MarkingSetCacheMaxEntries Marking Set Cache Maximum Entries

MarkingSets Marking Sets

MarkingUseGranted Marking Use Granted

MaxBatchSize Max Batch Size

MaxCollections Max Collections

MaxInMemoryElementState Max In Memory Element State

MaxInMemoryQueueItems Max In Memory Queue Items

MaxObjectsPerCollection Max Objects Per Collection

MaxReaderSemaphoreWaitTime Max Reader Semaphore Wait Time

Property Symbolic Name Property Name
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FPPoolMaxConnections Maximum Connections

MaximumContentElements Maximum Content Elements

MaxResolutionBatchSize Maximum Resolution Batch Size

MaximumRetentionDays Maximum Retention Days

MaximumSizeKBytes Maximum Size Kbytes

MaximumTimeToLive Maximum Time To Live

MemberOfGroups Member Of Groups

MetadataTraceFlags Metadata Trace Flags

MinimumRetentionDays Minimum Retention Days

FPPoolMulticlusterDeleteStrategy Multicluster Delete Strategy

FPPoolMulticlusterExistsStrategy Multicluster Exists Strategy

FPPoolMulticlusterQueryStrategy Multicluster Query Strategy

FPPoolMulticlusterReadStrategy Multicluster Read Strategy

FPPoolMulticlusterWriteStrategy Multicluster Write Strategy

MyRealm My Realm

NeverDeleteClipsOrContent Never Delete Clips Or Content

NoWorkDelay No Work Delay

NumImportAgents Num Import Agents

ObjectSecurityCacheEntryTTL Object Security Cache Entry TTL

ObjectSecurityCacheMaxEntries Object Security Cache Maximum Entries

ObjectStores Object Stores

FPOpenStrategy Open Strategy

OptimizationInterval Optimization Interval

OriginalObject Original Object

OriginalOrdinal Original Ordinal

OutputLocation Output Location

ParentComponent Parent Component

ParentDocuments Parent Documents

Property Symbolic Name Property Name
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ParentRelationships Parent Relationships

PartialResolutionChunkSize PartialResolutionChunkSize

PEConnectionPoints PE Connection Points

PersistenceType Persistence Type

PoolAddress Pool Address

FPPoolPrefetchSize Prefetch Size

PreloadOnCreate Preload On Create

Prerequisites Prerequisites

PrivilegedSettability Privileged Settability

PruneAmount Prune Amount

PruneThresholdContentElements Prune Threshold Content Elements

PruneThresholdSizeKBytes Prune Threshold Size KBytes

PublicKey Public Key

PublishRequestType Publish Request Type

PublishStyleTemplate Publish Style Template

PublishTraceFlags Publish Trace Flags

PublishingStatus Publishing Status

QueueItemDatabaseTimeout Queue Item Database Timeout

QueueItemMaxDispatchers Queue Item Max Dispatchers

QueueItemRetryCount Queue Item Retry Count

ReferencingActions Referencing Actions

RegionPassword Region Password

RenameFileRetryAttempts Rename File Retry Attempts

RenditionEngineConnection Rendition Engine Connection

RenditionEngineConnections Rendition Engine Connections

RenditionEnginePassword Rendition Engine Password

ResourceStatus Resource Status

ResourceString Resource String

Property Symbolic Name Property Name
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RetentionPeriod Retention Period

RetrievalRetryAttempts Retrieval Retry Attempts

FPPoolRetryCount Retry Count

FPPoolRetrySleep Retry Sleep

ReturnNameAsDN Return Name As DN

RollFwdBatchRetryAttempts Roll Forward Batch Retry Attempts

RootDirectoryPath Root Directory Path

SearchCrossForestGroupMembership Search Cross Forest Group Membership

SearchDynamicGroup* Search Dynamic Group

SearchServersToAttach Search Servers To Attach

SearchTraceFlags Search Trace Flags

SecurityDescCacheMaxEntries Security Descriptor Cache Maximum Entries

SecurityTraceFlags Security Trace Flags

ServerInstances Server Instances

ShortName Short Name

SingleItem Single Item

Site Site

SiteSettings Site Settings

Sites Sites

SnapLockPassword SnapLock Password

SnapLockUserName SnapLock User Name

SSITraceFlags SSI Trace Flags

StagingAreaPath Staging Area Path

StorageArea Storage Area

StorageAreas Storage Areas

SubjectCacheEntryTTL Subject Cache Entry TTL

SubjectCacheMaxEntries Subject Cache Maximum Entries

SubmittedCount Submitted Count

Property Symbolic Name Property Name
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SubsystemConfigurations Subsystem Configurations

TemplateType Template Type

TempDBContentLifetime Temporary Database Content Lifetime

TempDirectoryPath Temp Directory Path

TempFileLifetime Temporary File Lifetime

ThreadCount Thread Count

TimeAllSubmitted Time All Submitted

TimeLastProcessed Time Last Processed

FPPoolTimeout Timeout

TimeOutSeconds Timeout Seconds

ToVersions To Versions

TraceLoggingEnabled Trace Logging Enabled

URIValue URI Value

UserBaseDN User Base DN

UserDisplayNameAttribute User Display Name Attribute

UserDomain User Domain

UserGroup User Group

UserName User Name

UserNameAttribute User Name Attribute

UserPassword User Password

UserSearchFilter User Search Filter

UserTokenCacheEntryTTL User Token Cache Entry TTL

UserTokenCacheMaxEntries User Token Cache Maximum Entries

UserUniqueIDAttribute* User Unique ID Attribute

UserUniqueIDAttributeIsBinary* User Unique ID Attribute Is Binary

Users Users

VerityAdminServerHostname Verity Admin Server Hostname

VerityAdminServerPort Verity Admin Server Port

Property Symbolic Name Property Name
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VerityBrokerName Verity Broker Name

VerityBrokers Verity Brokers

VerityCollections Verity Collections

VerityDomainConfiguration Verity Domain Configuration

VerityIndexServers Verity Index Servers

VerityMasterAdminServerHostname Verity Master Admin Server Hostname

VerityMasterAdminServerPort Verity Master Admin Server Port

VeritySearchServers Verity Search Servers

VersionBindType Version Bind Type

VirtualServer Virtual Server

VirtualServers Virtual Servers

WSITraceFlags WSI Trace Flags

Property Symbolic Name Property Name
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New in Content Engine 4.5.0 (since 4.0.0)

New Content Engine classes in 4.5.0
The following table displays the new class names in Content Engine 4.5.0. To ensure successful 
upgrade, resolve any conflicts between your 3.5.x or 4.0.x object store class names and the new 
names.

Class Symbolic Name Class ID

ReplicationGroup Replication Group

CMODApplicationGroup CMOD Application Group

CMODFixedContentDevice CMOD Fixed Content Device

CMODRepository CMOD Repository

CmTivoliManagementClass Management Class

ContentFederatingRepository Content Federating Repository

DirectoryConfigurationCA Directory Configuration CA

DITARenditionEngineConnection DITA Rendition Engine Connection

DynamicGroupObjectClass Dynamic Group Object Class

ExternalAlias External Alias

ExternalClassAlias External Class Alias

ExternalClassDescription External Class Description

ExternalIdentity External Identity

ExternalParticipant External Participant

ExternalPropertyAlias External Property Alias

ExternalPropertyDescription External Property Description

ExternalRepository External Repository

ImageServicesRepository Image Services Repository

ObjectStoreParticipant Object Store Participant

Replicable Replicable
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New Content Engine properties in 4.5.0
The following table displays the new property names in Content Engine 4.5.0. To ensure 
successful upgrade, resolve any conflicts between your 3.5.x or 4.0.x object store property names 
and the new names.

ReplicableClassDefinition Replicable Class Definition

ReplicationConfiguration Replication Configuration

ReplicationJournalEntry Replication Journal Entry

ReplicationParticipant Replication Participant

Repository Repository

Property Symbolic Name Property Name

AliasDirection Alias Direction

ApplicationGroupNumber Application Group Number

ClassFamily Class Family

ClassIdentity Class Identity

CMODApplicationGroups CMOD Application Groups

CMODLanguage CMOD Language

CMODPassword CMOD Password

CMODPort CMOD Port

CMODServerName CMOD Server Name

CMODTraceLevel CMOD Trace Level

CMODUserName CMOD User Name

DatabaseIndexStorageLocation Database Index Storage Location

DatabaseLOBStorageLocation Database LOB Storage Location

DatabaseTableStorageLocation Database Table Storage Location

DateCheckedIn Date Checked In

DestinationRepository Destination Repository

DITADatabaseTimeout DITA Database Timeout

DITAHome DITA Home

Class Symbolic Name Class ID
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DITAJVMArguments DITA JVM Arguments

DITARenditionEngineConnection DITA Rendition Engine Connection

DITARenditionEngineConnections DITA Rendition Engine Connections

DITAWorkingDirectory DITA Working Directory

DuplicateSuppressionEnabled Duplicate Suppression Enabled

DynamicGroupObjectClass Dynamic Group Object Class

DynamicGroupQueryAttribute Dynamic Group Query Attribute

ExternalAliases External Aliases

ExternalClassDescriptions External Class Descriptions

ExternalObjectIdentity External Object Identity

ExternalPropertyDescriptions External Property Descriptions

ExternalReplicaIdentities External Replica Identities

ExternalRepositories External Repositories

ExternalRepository External Repository

FcpPoolIdleTimeoutSeconds FCP Pool Idle Timout Seconds

FcpPoolMaxInUse FCP Pool Max In Use

FcpPoolMaxWaitSeconds FCP Pool Max Wait Seconds

FcpPoolPreferredSize FCP Pool Preferred Size

FederateInboundContent Federate Inbound Content

GroupUniqueIDAttribute Group Unique ID Attribute

GroupUniqueIDAttributeIsBinary Group Unique ID Attribute Is Binary

HeldUntilDate Held Until Date

IICEConfigurationServerURL Content Integrator URL

InboundBatchSize Inbound Batch Size

InboundBusyWaitInterval Inbound Busy Wait tInterval

InboundDispatcherEnabled Inbound Dispatcher Enabled

InboundIdleWaitInterval Inbound Idle Wait tInterval

LastFailureReason Last Failure Reason

Property Symbolic Name Property Name
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MappableDirection Mappable Direction

MaxInboundWorkers Max Inbound Workers

MaxOutboundWorkers Max Outbound Workers

ObjectStateRecordingLevel Object State Recording Level

ObjectStoreSchemaDB2 Object Store Schema DB2

ObjectStoreSchemaMSSQL Object Store Schema MSSQL

ObjectStoreSchemaOracle Object Store Schema Oracle

OutboundBatchSize Outbound Batch Size

OutboundBusyWaitInterval Outbound Busy Wait tInterval

OutboundDispatcherEnabled Outbound Dispatcher Enabled

OutboundIdleWaitInterval Outbound Idle Wait tInterval

PartnerObjectStore Partner Object Store

PropertyIdentity Property Identity

RegionKey Region Key

ReplicableDirection Replicable Direction

ReplicationData Replication Data

ReplicationGroup Replication Group

ReplicationGroups Replication Groups

ReplicationMode Replication Mode

ReplicationOperation Replication Operation

ReplicationParticipants Replication Participants

ReplicationStatus Replication Status

ReplicationTraceFlags Replication Trace Flags

RestrictMembershipToConfiguredRealms Restrict Membership To Configured Realms

SearchDynamicGroup Search Dynamic Group

SuperclassIdentity Superclass Identity

SupersededAddOnIds Superseded AddOn Ids

TargetObjectStore Target Object Store

Property Symbolic Name Property Name
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TSMApplicationType TSM Application Type

TSMArchiveProtectionFlag TSM Archive Protection Flag

TSMCompressionFlag TSM Compression Flag

TSMConfigurationFilesShare TSM Configuration Files Share

TSMDSMIDirectory TSM DSMI Directory

TSMFileSpaceName TSM File Space Name

TSMManagementClasses TSM Management Classes

TSMMinimumRetention TSM Minimum Retention

TSMMountWaitDuration TSM Mount Wait Duration

TSMNodeName TSM Node Name

TSMOptions TSM Options

TSMOwnerName TSM Owner Name

TSMPassword TSM Password

TSMPort TSM Port

TSMRetentionInitiation TSM Retention Initiation

TSMRetentionPeriod TSM Retention Period

TSMServerAddress TSM Server Address

TSMWriteBufferSize TSM Write Buffer Size

UserUniqueIDAttribute User Unique ID Attribute

UserUniqueIDAttributeIsBinary User Unique ID Attribute Is Binary

Property Symbolic Name Property Name
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Manually redeploy Content Engine
The procedures in this topic explain how to redeploy Content Engine on a standalone server. For 
Content Engine in a clustered environment, see the IBM FileNet P8 High Availability Technical 
Notice. To download this guide from the IBM support page, see “Access IBM FileNet documentation, 
compatibility matrices, and fix packs” on page 20.

Perform the redeployment procedure appropriate for your Content Engine application server type:

• “To redeploy Content Engine on WebSphere 6.1.x” on page 721

• “To redeploy Content Engine on WebSphere 7.x” on page 722

• “To redeploy Content Engine on WebLogic” on page 724

• “To redeploy Content Engine on JBoss” on page 724

To redeploy Content Engine on WebSphere 6.1.x

1. From the WebSphere administrative console, go to Applications > Install New Application. 

2. From the EAR/WAR/JAR module page, in the local or remote file system: 

a. Navigate to the new Engine-ws.ear file. 

b. Click Next. 

c. Accept the defaults, except in step 3 (of the WebSphere administrative console) 
deployment process, select both Engine-init.war and FileNet CE-MP WebService, and 
set their values to default_host.  

3. Save the changes to the master configuration. 

4. Create a new J2C connection factory:

a. Go to Applications > Enterprise Applications > FileNetEngine > Manage Modules > FileNet 
P8 Connector > Resource Adapter> J2C connection factories.

b. If a connection factory already exists, click the factory name, and modify the properties as 
follows. If a connection factory does not exist, click New to create a new J2C connection 
factory, and set the following properties:

Name:  FileNetConnectionFactory 

JNDI Name:  FileNet/Local/ConnectionFactory 

c. Click Apply, then click Save. 

5. Change the following three entries, under Container-managed authentication to "None", and 
click Apply. 

• Container-managed authentication alias 

• Authentication preference 

• Mapping-configuration alias 

6. (Optional) Set the Connection Pool Properties to the following values, and click Apply.
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• Max Connections: 100 

• Min Connections:  10 

7. Save your changes to the master configuration.

8. Change the Class Loading and update detection settings, as follows:

a. Go to Applications > Enterprise Applications > FileNet Engine > Class Loading and update 
detection.

b. Change the polling interval to 3 (seconds).

c. Change the Class loader order to Classes loaded with application class loader first. 

d. Change the WAR class loader policy to Single class loader for application. 

e. Save your changes to the master configuration. 

9. Change Class Loader order.

a. Go to  Applications > Enterprise Applications > FileNetEngine > Manage Modules > FileNet 
CEMP Web Service. 

b. Change the class loader order to Classes loaded with application class loader first. 

c. Click Apply. 

d. Save your changes to the master configuration. 

10. Verify a successful deployment by entering the following into a web browser: 

http://<ce_app_server_machine_name>:<port>/FileNet/Engine

NOTE  The default port is 9080. This port number can be different than the default. Enter the 
port number accordingly.

If the deployment is successful, this action will return a “P8 CEMP Startup:” message.

To redeploy Content Engine on WebSphere 7.x

1. From the WebSphere administrative console, go to Applications > New Application. 

2. Select New Enterprise Application.

3. From the Preparing for the application installation screen, in the Path to the new application 
dialog, navigate to the new Engine-ws.ear file. in the local or remote file system field, and click 
Next.

4. In the How do you want to install the application screen, choose Fast Path, and click Next.

5. In the Select installation options screen, accept all defaults and click Next.  

6. In the Map modules to servers screen, select the following modules:

– Engine-ejb-ws.jar

– Engine-init.war

– FileNet CE-MP Web Service
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– FileNet P8 Connector

Click Next.

7. In the Map virtual hosts for Web modules, select Engine-init.war and FileNet CE-MP Web Server 
and set the Virtual host for each to default_host. Click Next.

8. Review the summary screen and click Finish. 

The deployment process starts.

9. When the deployment process completes, save the changes to the master configuration. 

10. Create a new J2C connection factory:

a. Go to Applications > Enterprise Applications > FileNetEngine > Manage Modules > 
engine.rar > FileNet P8 Connector > Resource Adapter> J2C connection factories.

b. If a connection factory already exists, click the factory name, and modify the properties as 
follows. If a connection factory does not exist, click New to create a new J2C connection 
factory, and set the following properties:

Name:  FileNetConnectionFactory 

JNDI Name:  FileNet/Local/ConnectionFactory 

c. Change the following two entries, under Security settings to "None". 

– Component-managed authentication alias 

– Mapping-configuration alias

– (Under Container-managed Authentication preference 

d. Under Container-managed authentication, chane the authentication preference setting to 
"None". 

e. Click Apply and OK.

11. Save your changes to the master configuration.

12. Change the Class Loading and update detection settings, as follows:

a. Go to Applications > Enterprise Applications > FileNet Engine > Class Loading and update 
detection.

b. Change the polling interval to 0 (seconds).

c. Change the Class loader order to Classes loaded with local class loader first (parent last). 

d. Change the WAR class loader policy to Single class loader for application. 

e. Save your changes to the master configuration. 

13. Change Class Loader order.

a. Go to  Applications > Enterprise Applications > FileNetEngine > Manage Modules > FileNet 
CEMP Web Service. 

b. Change the class loader order to Classes loaded with parent class loader first. 
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c. Click Apply. 

d. Save your changes to the master configuration. 

14. Verify a successful deployment by entering the following into a web browser: 

http://<ce_app_server_machine_name>:<port>/FileNet/Engine

NOTE  The default port is 9080. This port number can be different than the default. Enter the 
port number accordingly.

If the deployment is successful, this action will return a “P8 CEMP Startup:” message.

To redeploy Content Engine on WebLogic

1. Deploy the new Engine-wl.ear file. (On WebLogic 9.2 you will also need to accept the defaults 
for roles, security, and so on.) 

2. Restart Content Engine (the Engine-wl application). 

3. Verify a successful deployment by entering the following into a web browser: 

http://<ce_app_server_machine_name>:<port>/FileNet/Engine

NOTE  The default port number is 7001. This port number can be different than the default. 
Enter the port number accordingly.

If the deployment is successful, this action will return a “P8 CEMP Startup:” message.

To redeploy Content Engine on JBoss

1. Copy the new Engine-jb.ear or the new Engine-jbc.ear file to the server instance deploy 
directory. 

2. Restart the server instance. 

3. Verify a successful deployment by entering the following into a web browser: 

http://ce_app_server_machine_name>:<port>/FileNet/Engine

NOTE  The default port number is 8080. This port number can be different than the default. 
Enter the port number accordingly.

If the deployment is successful, this action will return a “P8 CEMP Startup:” message.
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Index
A
access roles, Application Engine Administrators
257
Application Engine

administrator access roles 257
before you upgrade 544
deploy (JBoss) 251, 252, 600
deploy (WebLogic) 237, 249, 585, 598
deploy (WebSphere) 228, 246, 576, 595
install 207, 548, 559
multiple instances 295
remove (JBoss) 633
remove (WebLogic) 632
remove (WebSphere) 630
remove Workplace 545
upgrade 544

Application Integration
install 288
uninstall 291
upgrade 605
verify installation 290
verify upgrade 606

Autonomy K2, see Content Search Engine

B
banner image, change 256
bootstrap preferences

bootstrap.properties file location 255
configure 254
SSL configuration 255

bootstrap.properties file
location 255
share between Application Engines 267

C
cluster

bootstrap.properties file 254
install generic server 207, 548, 559

cm.allowPasswordSave 643
cmui.ini 694
Component Manager 275
Configuration Manager

console toolbar 649
create new profile 651
create upgrade profile 655
editing the application server properties 662
editing the Configure Bootstrap Properties task
680
editing the Configure JDBC Data Sources task

664
editing the Configure LDAP task 669
editing the Configure Upgrade Bootstrap task
681
editing the Deploy Application task 682
grant user permissions 345
graphical user interface and command line in-
terface 641
GUI reference 643, 645
logs 644
main toolbar 647
menus and commands 650
opening an existing profile 660
passwords 643
profile concepts 639
profile toolbar 648
reference 638
running a task 692
saving changes to a task or profile 694
start and stop 645
viewing the session log 693
window description 646
working in the CM window 646

Configuration manager
overview 638

connection point
configure for Application Engine 261
convert router torouter

see connection point
create for Process Engine 260
migrate process router to 531

container-managed authentication
and SSO for Application Engine 212, 228, 553,
576

Content Engine
remove 623
specify for Application Engine 211, 552
uninstall 623
Upgrader Tool 483
verify installation 140
web service 263

Content Federation Services 331
Content Search Engine

CBR Enabled flag 168, 496
CBR indexing 168, 496
CBR locale 166
class properties 168, 496
collections 152, 460
collections directory 162, 466
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configure content-based retrieval (CBR) 151,
152
FileNet Styleset 154, 462
FileNet_Filesystem_PushAPI 155, 463
K2 Administrative Users 157, 465
K2 Broker Server 166
K2 Dashboard documentation 143, 452
K2 Index Server 153, 461
K2 Search Server 154, 462
K2 Server 154, 462
K2 Ticket Server 155, 463
launch K2 Dashboard 152, 461
set Autonomy K2 Administration Security 156,
464
Verity Domain Config. tab (VDC) 165

Content-Based Retrieval
upgrade 451, 470

content-based retrieval, configure 151, 152
create new profile

Configuration Manager 651
create upgrade profile

Configuration Manager 655

D
Desktop 3.1, collocation issues 288
document

check in (verify new object store) 140
check out (verify new object store) 140
create (verify new object store) 140

documentation
Application Engine configuration 213, 554
configure site preference settings (AE boot-
strap) 256
server upgrade 317
server URL 176, 226, 573
server verification 324

domain
users group 138
Verity (K2) 166

domain, FileNet P8
configure permissions 114, 432
create 109, 427

E
EJB transport 263
Enterprise Manager

enable SSL 265
file storage area 141
install additional 277

F
file storage area

display status 141
specify 135

File Tracker
install 292
uninstall 294
upgrade 605

FileNet P8 documentation
configure for Application Engine help 213, 554
configure for Process Engine help 176, 226,
573
remove 621
upgrade 317

FileNet Styleset, Content Search Engine 154, 462

G
GCD data source 52, 72, 359, 378

I
IIOP protocol 263
Image Services Integration, ISRA 603
installation

configuration and startup tasks 253
optional tasks 272

IP address
Application Engine SSL host 266
Content Search Engine server 143, 452

IS errorlog message redirection (Windows) 193
isolated region, create 259
ISRA

install servlet 299
remove servlet 635
SSL configurations 298
supported version 603
upgrade servlet 616

J
JBoss

deploy Application Engine 251, 252, 600
remove Application Engine 633

JDBC data source 72, 378
JDBC datasource 52, 359

K
K2, see Content Search Engine
Kerberos 263
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M
Microsoft Office, integration install 288
multi-server configuration 295

Application Engine 295
Enterprise Manager 277

O
object store 133

upgrade 488
verify new 140

object store data source 52, 72, 359, 378

P
passwords

Configuration Manager 643
Process Analyzer, upgrade procedure 604
Process Engine

remove 627
remove (UNIX) 629
remove (Windows) 627
start or restart software 526
uninstall 627
update security 529

process router
see connection point

Process Simulator, upgrade procedure 604
Process Task Manager 201
publishing components

install and configure 273
upgrade 608

publishing templates 273

R
realm

configure more than one 271
Content Engine AllRealms property 705
Content Engine MyRealm property 711
Content Engine Realm class 704
object store administrator 138

redirect IS errorlog messages 193
remove

Application Engine (JBoss) 633
Application Engine (WebLogic) 632
Application Engine (WebSphere) 630
Content Engine 623
FileNet P8 documentation 621
fnsw and oracle users from ORA_DBA 192
ISRA servlet 635
Process Engine (UNIX) 629

Process Engine (Windows) 627
Rendition Engine 273, 608
requirements for hardware and software 317
restore custom modifications 192, 510, 517

S
security

info preference, SSL 255
SSL, set up for Application Engine 266
SSL, set up for Content Engine 263
update for PE 529

silent install
Process Engine (AIX) 188, 515

Site preference settings
documentation URL 256
name and location 256

SSL
Java applets 269
security info preference 255
set up for Application Engine 266
set up for Content Engine 263

SSO
Application Engine (WebSphere), container-
managed authentication 228, 576
edit configuration files, Application Engine (We-
bLogic) 237, 585
edit configuration files, Application Engine
(WebSphere) 231, 579

Statement Cache Size 116, 433
subfolder, create, (verify new object store) 140
symmetric encryption, unlimited strength .jars 275
System Manager 303

T
T3 protocol 263

U
uninstall, see remove
UNIX

remove Process Engine 629
unlimited strength encryption (symmetric encryp-
tion) 275
upgrade

Application Engine 544
Application Engine, additional tasks 602
Application Integration 605
Content-Based Retrieval 451, 470
documentation 317
File Tracker 605
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ISRA Servlet 615
publishing components 608
silent, Content Engine 481

upgrade profile
Configuration Manager 655

Upgrader Tool, Content Engine 483
User Token

configure 256
Crypto key file path (AE) 216, 557

UTCryptoKeyfile.properties 216, 557

V
Verity K2, see Content Search Engine
VistaPubDir shared folder for publishing 273
vwlog 501, 503
vwtool 499

W
web farm

bootstrap.properties file 254
install generic server 207, 548, 559

web services
Content Engine 263
Process Engine 263

Web Services 3.1, collocation issues 288
web.xml

edit for Application Engine SSO (WebLogic)
237, 585
upgrade Application Engine 544

WebLogic
deploy Application Engine 237, 249, 585, 598
remove Application Engine 632

WebSphere
deploy Application Engine 228, 246, 576, 595
remove Application Engine 630

Windows
remove Process Engine 627

Workplace
Application Integration, collocation issues 288
Application Integration, install 288
Application Integration, upgrade 605
configure SSL access to 266
define workflow features for users 271
deployment in farm or cluster 214, 555
design publishing templates for users 270
design searches for users 270
directory, back up for upgrade 544
enable access to tasks and work items 261
enable for access to IS documents 298, 615

File Tracker install 292
File Tracker upgrade 605
remove 545, 630, 632
set bootstrap properties 254
set documentation server URL 256
set SSO proxy parameters for 237, 585
specify Application Engine administrators 257
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Notices
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available in
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program,
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can send
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in
any manner serve as an endorsement of those Web sites. The materials at those Web sites are not part of
the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without
incurring any obligation to you.
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Licensees of this program who wish to have information about it for the purpose of enabling: (i) the
exchange of information between independently created programs and other programs (including this
one) and (ii) the mutual use of the information which has been exchanged, should contact:
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Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries.
Consult your local IBM representative for information on the products and services currently available i
your area. Any reference to an IBM product, program, or service is not intended to state or imply that
only that IBM product, program, or service may be used. Any functionally equivalent product, program
or service that does not infringe any IBM intellectual property right may be used instead. However, it is
the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or
service.

IBM may have patents or pending patent applications covering subject matter described in this
document. The furnishing of this document does not grant you any license to these patents. You can sen
license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property
Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such
provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION
PROVIDES THIS PUBLICATION “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS
OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF
NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some
states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this
statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically
made to the information herein; these changes will be incorporated in new editions of the publication.
IBM may make improvements and/or changes in the product(s) and/or the program(s) described in thi
publication at any time without notice.

BM Corporation
46A/G4
55 Bailey Avenue
an Jose, CA 95141-1003
.S.A.

uch information may be available, subject to appropriate terms and conditions, including in some cases,
ayment of a fee.

he licensed program described in this document and all licensed material available for it are provided
y IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or
ny equivalent agreement between us.

ny performance data contained herein was determined in a controlled environment. Therefore, the
esults obtained in other operating environments may vary significantly. Some measurements may have
een made on development-level systems and there is no guarantee that these measurements will be the
ame on generally available systems. Furthermore, some measurements may have been estimated through
xtrapolation. Actual results may vary. Users of this document should verify the applicable data for their
pecific environment.

nformation concerning non-IBM products was obtained from the suppliers of those products, their
ublished announcements or other publicly available sources. IBM has not tested those products and
annot confirm the accuracy of performance, compatibility or any other claims related to non-IBM
roducts. Questions on the capabilities of non-IBM products should be addressed to the suppliers of

hose products.

ll statements regarding IBM’s future direction or intent are subject to change or withdrawal without
otice, and represent goals and objectives only.

his information contains examples of data and reports used in daily business operations. To illustrate
hem as completely as possible, the examples include the names of individuals, companies, brands, and
roducts. All of these names are fictitious and any similarity to the names and addresses used by an
ctual business enterprise is entirely coincidental.

OPYRIGHT LICENSE:

his information contains sample application programs in source language, which illustrate programming
echniques on various operating platforms. You may copy, modify, and distribute these sample programs

any form without payment to IBM, for the purposes of developing, using, marketing or distributing
pplication programs conforming to the application programming interface for the operating platform for
hich the sample programs are written. These examples have not been thoroughly tested under all

onditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these
rograms.
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Trademarks
Trademarks

 

IBM, the IBM logo, and ibm.com are trademarks or registered trademarks of International Business
Machines Corporation in the United States, other countries, or both. If these and other IBM trademarked
terms are marked on their first occurrence in this information with a trademark symbol (® or ™), these
symbols indicate U.S. registered or common law trademarks owned by IBM at the time this information
was published. Such trademarks may also be registered or common law trademarks in other countries. A
current list of IBM trademarks is available on the Web at ″Copyright and trademark information″ at
www.ibm.com/legal/copytrade.shtml.

Java and all Java-based trademarks are trademarks of Sun Microsystems, Inc. in the United States, other
countries, or both.

Microsoft, Windows, and Windows NT are trademarks of Microsoft Corporation in the United States,
other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Linux is a registered trademark of Linus Torvalds in the United States, other countries, or both.

Other company, product, and service names may be trademarks or service marks of others.
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